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Introduction

Accounts Receivable handles all your receivables record keeping and reporting needs, regardless of the 
size and complexity of your business.

You can use Accounts Receivable to set up and maintain your customer accounts, enter or import 
transactions from various sources, and print invoices. You can track account and transaction details on 
screens and printed reports.

You can use Accounts Receivable by itself or as part of an integrated system with other Sage 300 
programs. You can also transfer Accounts Receivable data to and from spreadsheet and database 
programs.

You can integrate Accounts Receivable with the following Sage 300 programs:

 l General Ledger and Financial Reporter.

 l Order Entry.

 l Project and Job Costing.

Depending on your purchase agreement, some features described in this guide may not be available 
in your product.

The Accounts Receivable User's Guide contains the following chapters:

 l Chapter 1: Setting Up Accounts Receivable

Set up records and specify options that determine how Accounts Receivable processes transactions 
and interacts with other Sage 300 modules.

 l Chapter 2: Setting Up and Maintaining Customer Records

After setting up processing records, such as the billing cycles and interest profiles that you assign to 
customer records, you can add customer records to Accounts Receivable.

You use icons in the A/R Customers folder to add customer group, national account, customer, ship-to 
location, and recurring charge records.

 l Chapter 3: Entering and Posting Accounts Receivable Transactions

Use Accounts Receivable transaction entry screens to record, edit, post, and inquire on the following 
types of transactions:
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 l Invoices, debit notes, credit notes

 l Receipts

 l Refunds

 l Adjustments

 l Chapter 4: Periodic Processing in Accounts Receivable

Use Accounts Receivable Periodic Processing screens to perform tasks that are part of your regular 
period-end procedures, such as clearing history, creating general ledger batches, and deleting inactive 
records.

 l Chapter 5: Importing and Exporting Accounts Receivable Data

You can import and export a variety of Accounts Receivable records and transactions in a number of 
common formats.

 l Chapter 6: Printing Accounts Receivable Reports

Use Accounts Receivable report screens to print setup reports and analytical reports.

 l Appendix A: Accounts Receivable Screen Guides

Learn how to find and use Sage 300 screens. Each screen guide includes navigation information, field 
help, and a list of tasks you can use the screen to perform.

 l Appendix B: Accounts Receivable Security Authorizations

If security is turned on for your Sage 300 system, the system administrator must assign users security 
authorization for Accounts Receivable screens.

This appendix describes the authorizations you can assign to Accounts Receivable users.

 l Appendix C: Data Entry Tools, Tips, and Shortcuts

Use these tools and shortcuts to speed up data entry in Sage 300.

 l Appendix D: Support and Resources

Find support and resources to help get Sage 300 up and running quickly.

2Sage 300 2023 Accounts Receivable User's Guide



Chapter 1: Setting Up Accounts 
Receivable

Use Accounts Receivable Setup screens to set up records and options that determine how Accounts 
Receivable:

 l Processes transactions.

 l Interacts with General Ledger and other Sage 300 modules.

Setting Up Accounts Receivable
This topic lists all the steps for setting up a new Accounts Receivable ledger.

Before You Start

 1. Install Sage 300 programs in the following order:       

 a. System Manager (including Bank Services and Tax Services).

 b. General Ledger (if you intend to use it).

 c. Accounts Receivable.

 2. Create a system database and a company database.

 3. Choose company-wide options in Common Services.

 4. Activate Bank and Tax Services, and add information about the bank accounts, taxes, and 
currencies used in your accounts receivable system.

 5. Add receivables control accounts to your general ledger chart of accounts.

Step 1: Activate Accounts Receivable, select options, and add records

 1. Activate the Accounts Receivable program for your data.

See the System Manager help for instructions.

 2. Use the A/R Options screen and the A/R G/L Integration screen to specify how your receivables 
system will operate.

 3. Design coding schemes for your Accounts Receivable records.
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 4. Add records and print setup reports. For more information, see:     

 l "A/R Account Sets Screen" (page 491)

 l "A/R Billing Cycles Screen" (page 495)

 l "A/R Distribution Codes Screen" (page 498)

 l "A/R Dunning Messages Screen" (page 500)

 l "A/R Interest Profiles Screen" (page 510)

 l "A/R Payment Codes Screen" (page 543)

 l "A/R Items Screen" (page 513)

 l "A/R Optional Fields Screen" (page 519)

 l "A/R Salespersons Screen" (page 545)

 l "A/R Terms Screen" (page 549)

Step 2: Add customers

For more information, see:

 l "A/R Customer Groups Screen" (page 350)

 l "A/R National Accounts Screen" (page 361)

 l "A/R Customers Screen" (page 376)

 l "A/R Ship-To Locations Screen" (page 443)

 l "A/R Recurring Charges Screen" (page 425)

Step 3: Transfer Your Accounting Data to Accounts Receivable

 1. Enter year-to-date and current transactions.

 2. Print batch listings.

 3. Post the batches and print posting journals.

 4. Enter historical totals (statistics) for customers, customer groups, national accounts, items, and 
salespersons (optional).

 5. Print other reports.

Step 4: Design the formats for your preprinted forms

Design and test formats for printing invoices, credit notes, debit notes, deposit slips, statements, letters, 
and labels, or adapt the sample formats to print on your own forms.

For more information, see "Customizable Formats for Printed Accounts Receivable Forms" (page 57).
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Accounts Receivable Options
The options you select on the A/R Options screen determine how your Accounts Receivable system 
operates and the types of data that it stores and displays. You can change most of these options after 
setup, as needed.

About Accounts Receivable Options

You use the A/R Options screen to select or to change options that determine how your Accounts 
Receivable system processes transactions and stores information about your customers:

 l Specify contact information for a company for the Accounts Receivable administration.

 l Specify whether or not you process transactions in multiple currencies.

 l Specify whether or not to:

 l Require batch listings.

 l Invoice recurring charges.

Note: At any time, you can change the option to invoice recurring charges. If you clear this option 
after you have defined recurring charges, Accounts Receivable retains the records, so they are 
available if you select the option again.

 l Use retainage accounting.

 l Edit imported batches.

 l Specify the types of statistics you keep and the reporting periods you use for statistics.

 l Specify the number of days to keep comments in customer records.

 l Select options for entering and printing invoices.

 l Assign the default payment code, transaction type, and bank code for your company.

 l Select options for:

 l Printing deposit slips.

 l Editing receipt batches.

 l Entering adjustments in receipt batches.

 l Listing documents during receipt entry.

 l Change the document numbers you assign to invoices, interest invoices, credit notes, debit notes, 
receipts, prepayments, unapplied cash, recurring charges, and adjustment transactions.

 l Specify the aging periods to use for customer statements and the Aged Trial Balance report.

 l Specify how to age credit notes, debit notes, prepayments, and unapplied cash.
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 l Enter dunning messages.

 l Specify whether or not to print statements for accounts with zero balances.

Note: You use the A/R G/L Integration screen to select options that govern the interaction between 
Accounts Receivable and General Ledger, including when and how General Ledger transactions are 
processed. For more information, see "A/R G/L Integration Screen" (page 503).

Changing Options

You can change the settings and information on the A/R Options screen, with the following exceptions 
and restrictions:

 l You can select the Multicurrency option at any time, but you cannot turn it off after you select it 
and save the change.

 l You can change the type of year (fiscal or calendar) and period by which you accumulate statistics, 
but you should do so only at year end. If you change either method partway through a year, the 
statistics already accumulated will be incorrect or in the wrong period.

 l You can turn off the Retainage Accounting option only if there are no unposted batches that 
include retainage and there are no outstanding retainage amounts.

 l You cannot change some options while other Accounts Receivable screens are open, or if other 
users are working with the Accounts Receivable database.

About Multicurrency Accounting in Accounts Receivable

You can set up Accounts Receivable to process transactions in more than one currency.

To enable multicurrency processing, you select the Multicurrency option for Accounts Receivable. You 
also set up account sets for all the currencies you use, assigning a single currency to each account set. 
Then, you assign each customer to an account set that uses the customer's currency. 

For more information about how to set up multicurrency in Accounts Receivable, see "Setting Up a 
Multicurrency Accounts Receivable System" (page 13).

Processing Multicurrency Transactions

Accounts Receivable displays the customer's currency when you add transactions for the customer. You 
enter all transaction amounts in invoice and adjustment batches in the customer's currency. You can 
enter receipts from the customer in any currency.

You process multicurrency transactions the same way you process single-currency transactions. With 
each transaction entry, you can accept or change the exchange rate for converting transaction details 
from the customer's currency to the Accounts Receivable functional (home) currency. You do not need to 
enter currency information unless you want to change exchange rate information supplied for a 
transaction from the Currency tables in Common Services.
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In a multicurrency Accounts Receivable system, you can:

 l Enter and post transactions in all the currencies used by your customers and your company.

 l Import transaction batches from multicurrency and single-currency applications and non-Sage 300 
programs (provided they all use the same functional currency).

 l Revalue Accounts Receivable transactions at current exchange rates, either provisionally or to 
create transactions for the unrealized exchange gain and loss general ledger accounts.

 l Create batches of General Ledger transactions that you can post in both multicurrency and single-
currency Sage 300 General Ledger applications.

About Retainage Accounting

You can use Accounts Receivable to account for retainage (or a "holdback") that   occurs when your 
customer withholds a percentage of an invoiced amount,   usually by mutual agreement or according to a 
statute (such as a Builders   Lien Act).

Before you can process retainage in Accounts Receivable, you must:

 l Set the Retainage Accounting option on the Processing tab of the A/R Options screen.

 l Specify retainage settings for customers on the Retainage tab of the A/R Options screen. For more 
information, see "A/R Options Screen" (page 523).

 l Specify a retainage account for each account set in your Accounts Receivable system. For more 
information, see "A/R Account Sets Screen" (page 491).

Retainage Document Numbering

Accounts Receivable assigns the next available invoice, credit note, or debit note batch number to the 
retainage batch. 

If you use a separate numbering system for retainage documents, the program assigns the next 
retainage invoice, retainage debit note, or retainage credit note number displayed on the Retainage tab 
on the A/R Options screen.

Scheduled Reminders

You assign a schedule for processing retainage on the Retainage tab of the A/R Options screen.

If you assign a schedule  that includes a reminder to users, Accounts Receivable can remind users to 
process retainage transactions when they are due. 

Users can then process the retainage transactions directly from the Reminder List in Common Services, 
rather than from the A/R Create Retainage Batch screen. For more information about using schedules 
and reminders, see the System Manager help.
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Optional Fields

Accounts Receivable inserts on retainage documents any optional fields and values specified on original 
invoices, credit notes, and debit notes when you create a retainage batch. You do not specify optional 
fields and values separately for a retainage batch.

About Keeping Statistics

You can keep statistics for:

 l Customers

 l Customer groups

 l National accounts

 l Items

 l Salespersons

Note: By default, statistics are kept for customers, customer groups, and national accounts. To keep 
item and salesperson statistics, you must select the corresponding Keep Statistics options on the 
Processing tab of the A/R Options screen.

For each set of statistics, you can specify:

 l Whether or not statistics are editable

 l Whether or not to include tax amounts in statistical totals

 l The type of year and period by which to display and report statistics

For more information about options for statistics, see "A/R Options Screen" (page 523).

Customer Statistics

Accounts Receivable keeps period statistics for customers, customer groups, and national accounts (if 
you use them), including the monetary total and number of invoices, receipts, discounts, credit notes, 
debit notes, adjustments, write-offs, interest charges, returned checks, and paid invoices. Data is 
displayed and reported by the period you specify for the Period Type option on the Processing tab of the 
A/R Options screen.

Accounts Receivable also keeps activity statistics for customers and national accounts, including:

 l The amount and date of the highest balance in the current and previous years.

 l The largest invoice in the current and previous years.

 l The last invoice, payment, credit note, debit note, adjustment, write-off, interest charge, and 
returned check.

 l The total invoices paid, total days to pay, and average days to pay.
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Use the A/R Customer Groups, A/R National Accounts, and A/R Customers screens to review the 
statistics.

Item and Salesperson Statistics

You can choose whether or not to keep item and salesperson statistics. If you turn off statistics for items 
or salespersons, Accounts Receivable stops collecting them, although it retains figures already in the 
system until you clear them using the A/R Clear Statistics screen.

Note: If you turn on the statistics options again, you will have a gap in the statistical information.

If you do not keep item and salesperson statistics, there will be no statistical information on the A/R Items 
screen or the A/R Salespersons screen, and the A/R Item Sales History and A/R Salesperson Statistics 
reports will show only zeros.

If you select the Keep Statistics option for items or salespersons, Accounts Receivable keeps the 
following statistics for the type of year and period you specify on the A/R Options screen:

 l Item statistics:

 l Totals of sales, returns, costs, and gross margins.

 l Numbers of items sold and returned.

 l Number of sales of each item.

 l Date of the last invoice posted for each item number.

 l Salesperson statistics:

 l Total amount and number of invoices, receipts, credit notes, debit notes, discounts, and 
write-offs posted to each salesperson number.

You can review statistics on the A/R Items screen and the A/R Salespersons screen.

Updating Statistics

Accounts Receivable updates statistics automatically each time you post batches.

If you set up your Accounts Receivable system partway through a fiscal year, you may want to edit 
statistics so that you can enter figures for previous periods of the current year or for previous years.

Occasionally, you may also want to edit a particular statistic because unusual circumstances have 
exaggerated the amount. For example, if a single invoice remains unpaid for a long period on an 
otherwise satisfactory account, you could adjust the figure in the Total Number Of Days To Pay field to 
more accurately reflect the customer's paying habits.

If you edit a customer's statistics, you should make the same changes to the statistics for the customer 
groups and national accounts to which the customer belongs.
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About Specifying Document Order in Receipt Entry

You can control the order in which open documents appear in selection lists when you are applying 
receipts in Receipt Entry. (Open documents are invoices and debit notes that are not yet paid or credit 
notes that have not been applied.)

By default, open documents are displayed by document number. To change the order, use the Default 
Order Of Open Documents option on the Transactions tab of the A/R Options screen.

You can choose to display open documents for each customer account by:

 l Document Number. Documents are listed by document number, beginning with the lowest 
document number for each transaction type.     

Assign document prefixes that will list documents in the order you prefer. For example, to see open 
invoices first, use an invoice prefix that will come first in alphabetical and ASCII order. 

The following prefixes list invoices first, followed by interest invoices, credit notes, debit notes, 
prepayments, unapplied cash, and adjustments:

Prefix Document Type

IN Invoice

INT Interest invoice

NCR Credit note

NDR Debit note

PP Prepayment

UC Unapplied cash

XADJ Adjustment

Sample Document Prefixes

 l Purchase Order Number. Documents that contain the same purchase order number are listed 
together, beginning with the lowest purchase order number and the earliest document number.

 l Due Date. Invoices, credit notes, and debit notes are listed by their due dates, beginning with the 
document with the oldest (earliest) due date.

 l Order Number. Documents are listed by the order numbers entered with the invoices, credit notes, 
and debit notes, beginning with the lowest order number.

 l Document Date. Documents are listed by document date, beginning with the oldest date.

 l Current Balance. Documents are listed by outstanding balance, beginning with the smallest 
amount.
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About Document Numbers for Invoices, Debit Notes, and Credit Notes

A unique number is assigned to each document you add to an invoice batch. The number is a 
combination of:

 l A prefix that identifies the transaction type.

 l A number that is assigned sequentially, starting with the number you specify.

You can enter separate prefixes and document numbers for invoices, credit notes, debit notes, interest 
invoices, and recurring charge invoices.

You can also enter prefixes and numbers for prepayment and unapplied-cash documents (on the 
Numbering tab of the A/R Options screen).

You can also enter your own document numbers with each invoice, credit note, or debit note you add on 
the A/R Invoice Entry screen, ignoring the numbers that Accounts Receivable assigns. The only 
restrictions are that document numbers can contain no more than 15 characters and each number must 
be unique.

You may be able to continue using your current numbering scheme. At any time, you can also specify 
different prefixes and next numbers on the A/R Options screen for Accounts Receivable to assign. 
However, you cannot make a change that would create duplicate document numbers.

Prefixes, Length, and Next Numbers

You can use up to six characters for each prefix. Each prefix must be unique, to prevent duplicate 
document numbers.

You can set the length of these numbers using a maximum of 22 characters, including prefixes, in 
document numbers.

If you do not enter prefixes and document numbers, Accounts Receivable automatically assigns 1 as the 
first document number and uses the following prefixes for documents:

Document Type Prefix

Invoice IN

Credit note CN

Debit note DN

Interest invoice INT
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Document Type Prefix

Recurring charge invoice RC

Receipt PY

Prepayment PP

Unapplied Cash UC

Adjustment AD

Refund RF

Default Document Prefixes

If you use separate numbering for retainage, you can also specify the prefixes and next numbers for 
retainage documents. Accounts Receivable uses the following prefixes as defaults:

Document Type Prefix

Retainage invoice RIN

Retainage credit note RCN

Debit note RDN

Default Prefixes for Retainage 
Documents

Sequence Numbers

When you add a transaction in the Invoice Entry, Receipt Entry, Quick Receipt Entry, or Adjustment Entry 
screens, Accounts Receivable assigns a document number based on the prefixes and document 
numbers specified for the type of transaction on the A/R Options screen. 

Numbers assigned to each type of document can go as high as 999999999, and then they are 
automatically reset to 1.

If you use the assigned number, Accounts Receivable updates the Next Number for the transaction type 
on the A/R Options screen.

You can also enter your own document numbers when adding transactions. If you do, the information on 
the A/R Options screen is not updated, even if you use the same number as the program would have 
assigned.
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Changing the Next Document Number

If you want to change the next number to assign on the A/R Options screen to a lower number, you may 
want to change the prefix for the document type, to prevent Accounts Receivable from assigning the 
same document number twice to a customer.

Important! You cannot post two documents with identical document prefixes and numbers.

Selecting Accounts Receivable Processing Options

You can select or change options that determine how your Accounts Receivable system processes 
transactions and stores information about your customers.

Before You Start

 l Make sure that you understand the impact the options have on Accounts Receivable processing. 
For more information, see "A/R Options Screen" (page 523).

 l Make sure that no other users are using Accounts Receivable and that no other Accounts 
Receivable screens are open on your computer.

To set options for Accounts Receivable:

 1. Open Accounts Receivable > A/R Setup >        Options.

 2. Click the tab that contains the options you want to change.

 3. Make your changes.

 4. Click Save.     

Note: If any other Accounts Receivable screens are open, most changes on the A/R Options screen 
cannot be saved.

After changing options

 l Print the Options report. For more information, see "Printing the A/R Options Report" (page 320).

Setting Up a Multicurrency Accounts Receivable System

You can set up Accounts Receivable to process transactions in more than one currency.
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To set up Accounts Receivable to use multiple currencies:

 1. In Common Services:     

 a. On the Company Profile screen, select the Multicurrency option for the company and select 
a default rate type.

 b. On the Currency screens, add any currency codes you need for Accounts Receivable, and 
enter rates for the currencies you use.       

Tip: When you install Sage 300, you also install a large set of currency codes that use 
standard international abbreviations. Check the list to determine whether you need to add any 
codes.

For more information, see the System Manager help.

 2. On the A/R Options screen, select the Multicurrency option.

 3. On the A/R Account Sets screen, add at least one account set for each currency you want to use in 
Accounts Receivable. 

For each account set, you enter the currency code and the numbers of your exchange gain and loss 
general ledger accounts, as well as the other general ledger account numbers required in an account 
set. For more information, see "Adding or Modifying Account Sets" (page 22).

 4. On the A/R Interest Profiles screen, add interest records that include a minimum interest charge 
and annual interest rate for each currency used by the customers you will assign to a particular 
interest profile. For more information, see "Adding or Modifying Interest Profiles" (page 34).

 5. On the A/R Items screen, add pricing information for all the currencies and units of measure in 
which you sell each item. For more information, see "Adding or Modifying an Item" (page 38).

 6. When you create customer groups, select the rate type for the group and enter a credit limit in each 
of the currencies used by the national accounts and customers you will assign to the group. For 
more information, see "Adding, Modifying, and Deleting Customer Groups" (page 64).

 7. If you create national accounts, select an account set that uses the currency of the account, then 
enter the credit limit amount in that currency. Also, enter a rate type for converting amounts in the 
customer currency to the functional currency. For more information, see "Adding, Modifying, and 
Deleting National Accounts" (page 70).

 8. When you add customer records, assign each record to the account set that uses the customer's 
currency. If a customer is part of a national account, the account set and currency are specified by 
the national account, and you cannot change them. For more information, see "Adding and 
Modifying Customer Records" (page 85).

When you enter outstanding transactions to set up your customer account balances, you automatically 
enter them in the appropriate currencies.
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You can enter statistics for customers, customer groups, and national accounts in either the functional 
currency or the customer currency. Statistics for salespersons and items are entered only in functional 
currency.

You specify a default account set for each customer group. When you later assign a customer to a 
customer group, the account set assigned to the group is assigned to the customer. You can change the 
account set for individual customers.

Integration with General Ledger
You select options on the A/R G/L Integration screen to:

 l Control how Accounts Receivable interacts with General Ledger

 l Specify the types of information to send with the transactions you send to General Ledger from 
Accounts Receivable.

About Using Accounts Receivable with General Ledger

If you use Sage 300 General Ledger, Accounts Receivable creates batches of general ledger 
transactions in General Ledger and displays and validates General Ledger account numbers in Accounts 
Receivable.

If your General Ledger data is in the same directory as Accounts Receivable, separate batches are 
automatically created for invoices, receipts, and adjustments, and you can specify whether to add new 
transactions to existing batches or create all-new batches each time you post. If your Sage 300 General 
Ledger system is at another location, Accounts Receivable creates all general ledger transactions in a 
single batch that you can import into General Ledger.

Note: If a fiscal period is locked for General Ledger but not for Accounts Receivable, you can create 
batches for General Ledger during posting or using the Create G/L Batch screen (depending on 
Accounts Receivable's G/L Integration settings). When you try to post transactions to a locked period in 
General Ledger, however, the transactions are placed in an error batch. You can avoid this situation if 
you create and post General Ledger batches for outstanding Accounts Receivable transactions before 
locking a period for General Ledger.

The G/L Transactions report and the summary at the end of each Accounts Receivable posting journal list 
the general ledger accounts that will be debited and credited with receivables transactions when you post 
the Accounts Receivable batch of general ledger entries in General Ledger.

You specify the type of reference and description to include with each unconsolidated General Ledger 
transaction on the A/R Options screen.
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If you select the Keep History option on the A/R Options screen, you can also drill down from 
transactions in Sage 300 General Ledger to originating transactions in Accounts Receivable and, if you 
use Order Entry, to originating transactions in Order Entry.

General Ledger Accounts Used in Accounts Receivable

Accounts Receivable uses the following general ledger accounts:

 l Receivables Control

 l Bank

 l Payment Discounts

 l Prepayment Liability

 l Write-Offs

 l Interest Income

 l Retainage Control (if you use retainage accounting)

 l Accounts you assign to distribution codes or enter with transactions

Tip: When entering account numbers in Accounts Receivable, use theFinder  to ensure that the 
account numbers you enter exist in your General Ledger.

Multicurrency Ledgers

If you use multicurrency accounting, Accounts Receivable also uses General Ledger’s exchange gain 
and loss accounts.

Accounts Receivable creates transactions for these accounts when you revalue multicurrency 
transactions at new exchange rates, or post receipts and credit notes at different rates from those used 
for the documents being paid or credited.

Selecting General Ledger Integration Options for Accounts Receivable

If you use Sage 300 General Ledger, Accounts Receivable creates batches of general ledger 
transactions in General Ledger and displays and validates General Ledger account numbers in Accounts 
Receivable. You can change options that control how Accounts Receivable integrates with General 
Ledger.
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Before You Start

 l Make sure no one else is using Accounts Receivable. You can update some information while 
others are using Accounts Receivable (such as the receivables department phone number and 
contact person), but most options can be changed only if no one else is using the system.

 l Become familiar with the G/L integration options you want to change. For more information, see 
"A/R G/L Integration Screen" (page 503).

To change G/L integration options:

 1. Open Accounts Receivable > A/R Setup >        G/L Integration.

 2. On the Integration tab, change options that determine how and when to process general ledger 
batches.

 3. On the Transactions tab, change the information that is included with general ledger transactions. 
For more information, see "Assigning Information to G/L Transaction Fields" (page 17).

 4. Click Save, and then click Close.

After changing integration options

 l Print the G/L Integration report. For more information, see "Printing the A/R G/L Integration Report" 
(page 316).

Assigning Information to G/L Transaction Fields

You can specify the type of information to use in the transaction description, detail reference, detail 
description, and detail comment fields for general ledger transactions. This information also appears on 
Accounts Receivable posting journals and on General Ledger’s Journal Entry screen and reports. More...

For each field, you can assign up to five pieces of information (segments) from Accounts Receivable 
transactions to use in G/L transactions.

The segments you can select depend on the type of transaction to which you are assigning information 
and whether the information is for the transaction header or the details. This ensures that the information 
passed to General Ledger is relevant for each type of transaction. For example, you can assign the ship-
to information from invoice details to any of the General Ledger fields.

When you create general ledger transactions, if no data exists in the source transaction field, the field will 
be blank in the general ledger transaction. For example, if you assigned the original transaction 
description to the G/L Entry Description field, but there is no description for a particular entry, the field will 
be blank in the G/L transaction.
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Before You Start

 l Make sure no other users are working with Accounts Receivable and that no Accounts Receivable 
screens are open.

To assign information to a G/L field:

 1. Open Accounts Receivable > A/R Setup >        G/L Integration.

 2. On the Transactions tab, do one of the following:     

 l Double-click a G/L field.

 l Select a G/L field, and then click Open.

The A/R G/L Integration Detail screen appears.

 3. In the Transaction Type field, enter the type of transaction entry or detail.     

The information changes in the G/L Transaction Field field and the list on the left (Choose segments 
from list), consistent with the selected transaction type.

 4. In the G/L Transaction Field field, select the G/L field to which you are assigning information.

 5. Select a separator and assign segments. More...

 a. In the Segment Separator field, select a character to separate segments of information.        

Note: The separator is used only if you assign more than one segment.

 b. Select a segment from the Choose segments from list, and then click Include.        

The selected segment appears in the Segments currently used list, and in the Example field.

Notes: 
 l You can assign a maximum of five segments to a G/L field.

 l If the combined length of the segments and separators exceeds 60 characters, the 
assigned information is truncated when the transaction is posted.

 l If you use Project and Job Costing, the list of available segments includes the names 
used in that program for contract levels (for example, Contract, Project, and Category).

 6. Click Save, and then click Close to return to the A/R G/L Integration screen.

Setting Up and Maintaining Processing Records
Before adding customer records to Accounts Receivable, you must set up account sets, billing cycles, 
interest profiles, payment terms, and customer groups. 

If you want to assign salespersons to customer records, you must also set up salesperson records. 
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In addition, if you use Sage 300 Transaction Analysis and Optional Field Creator, you must also set up (in 
Common Services) the optional fields you want to assign to Accounts Receivable records.

About Accounts Receivable Coding Schemes

Before you can use Accounts Receivable, you must add sets of codes to identify the account sets, billing 
cycles, distribution codes, salespersons, customers, and other records you will add to your system. You 
should take the time to design sensible coding schemes for each type of code you require, before you 
start assigning codes to records.

If you already have a system for most of these codes, you may be able to continue with the same system. 
Check the following list to see whether each code type allows for the number and type of characters used 
in your previous system.

Code Name Maximum Number of Characters

Account set code 6 digits and letters

Billing cycle code 6 digits and letters

Distribution code 6 digits and letters

Interest profile code 6 digits and letters

Receipt type code 6 digits and letters

Salesperson code 8 digits and letters

Terms code 6 digits and letters

Item number 16 digits, letters, symbols, blank spaces

Customer group code 6 digits and letters

National account number 12 digits, letters, symbols, blank spaces

Customer number 12 digits, letters, symbols, blank spaces

Ship-to location code 6 digits, letters, symbols

Recurring charge code 15 digits, letters, symbols, blank spaces

Codes Used in Accounts Receivable

If you are designing new codes, you should assign codes that make it easy to identify each record type 
and that list records in the order you want them to appear on reports and in Finder screens.
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Each code is a unique set of letters, symbols, and digits. For example, each of the following could be a 
valid customer number:

 l A1

 l 123

 l A01

 l A-01

 l 123A

 l AB1234

 l AB 1234

To simplify codes, we recommend that you:

 l Use the same number of characters in all codes of the same record type.

 l Where permitted, define codes of at least three characters (to allow for future expansion).

 l Use a numbering system that is significant for your business, such as a geographical region or 
division or vertical market.

 l If possible, use only numbers (not letters or symbols), for consistency of sorting.

Sorting Order of Codes

Accounts Receivable sorts codes on screens and reports in a specific order, which you should take into 
consideration when designing codes.

The program reads codes from left to right, and uses the following sequence to put them in order:

[Blank] ! " # $ % & ' ( ) * + , - . / 0 1 2 3 4 5 6 7 8 9 : ; < = > ? @ A B C D E F G H I J K L M N O P Q R S T U V 
W X Y Z [ \ ] ^ _ ` a b c d e f g h i j k l m n o p q r s t u v w x y z { | } ~

Shorter codes are listed before longer codes.

Codes containing fewer than the maximum number of permitted characters are left-justified in Accounts 
Receivable Finders, and on screens and reports.

The codes listed in the introduction to this topic would be sorted by the program into the following order:

 l 123

 l 123A

 l A-01

 l A01

 l A1
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 l AB 1234

 l AB1234

About Importing Setup Records

If you have an accounts receivable system other than Sage 300, you may be able to transfer records from 
it directly into Sage 300 Accounts Receivable by importing them.

For more information, see "About Importing and Exporting Accounts Receivable Records" (page 271)

Account Sets

An account set is a group of general ledger account numbers, including the receivables control account, 
to which customers' transactions are distributed.

You must create at least one account set before you can add customer records.

About Account Sets

An account set is a group of general ledger account numbers. You assign an account set to each 
customer and national account to specify the general ledger accounts to which the customer's 
transactions are distributed:

 l Receivables control

 l Payment discounts

 l Prepayment liability

 l Retainage control

 l Write-offs

You must create at least one account set before you can add customer records.

You can change the accounts in the account set at any time.

By default, the account set for a customer group is assigned to customer and national account records in 
the group (for example, when you add a new customer to a customer group, or change a customer's 
group). However, you can change the account set for a customer.

Multicurrency Account Sets

Multicurrency account sets identify the customer's currency and general ledger exchange gain and loss 
accounts, as well as an account for rounding differences arising from multicurrency transactions. You can 
change the account set for a multicurrency customer or national account only to another set that uses the 
same currency.
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Note: Member customers of national accounts can use a different account set than that used by the 
national account. However, both the national account and the customer must use the same currency.

If you use multicurrency accounting, you assign a currency code to each account set to identify the 
currency used by the customers you will assign to the set. Once you save (add) an account set, you 
cannot change its currency.

Multicurrency account sets include the same accounts as other account sets, as well as the accounts to 
which you post gains and losses that result when you revalue Accounts Receivable transactions at new 
exchange rates.

The general ledger accounts you assign to multicurrency account sets depend on the type of currency 
information you require in your general ledger. For example, you might use a separate receivables 
control account for each currency, but use the same numbers for the rest of the accounts in all your 
account sets.

If you use the same account number for all exchange gains and losses, the balance in that general ledger 
account is the net exchange gain or loss on receivables transactions.

Adding or Modifying Account Sets

You create account sets to specify the general ledger accounts to which customer transactions are 
distributed.

Before You Start

 l Decide on the code for a new account set you want to add.

 l Determine the general ledger account numbers to assign to a new account set you want to add.More...

You need to know the numbers to use for these general ledger accounts:

 l Receivables control

 l Receipt discounts

 l Prepayment liability

 l Write offs

 l Retainage (if you use retainage accounting)

If you use multicurrency accounting, you also need to know the currency code for each account set that 
does not use the functional currency, as well as the numbers for all the exchange gains and losses 
accounts, and an exchange rounding account.
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 l Make sure that an account set you plan to delete is not assigned to any customer records 
(including customer groups, national accounts, and customers).

To add a new account set:

 1. Open Accounts Receivable > A/R Setup >        Account Sets.

 2. In the Account Set Code field, enter a unique code, using up to six characters, to identify the 
account set.

 3. In the Description field, enter a description of the account set.

 4. Enter the general ledger account numbers that make up the account set. More...

If you use Sage 300 General Ledger with your Accounts Receivable database, a Finder  appears 

beside each general ledger account field. 

Click the Finder or press F5 to display a list of general ledger account numbers. Highlight the account 
you want, then press Enter to insert it in a field.

In a multicurrency account set that does not use the functional currency, you must also enter the 
currency code and account numbers for the exchange gain, exchange loss, and exchange rounding 
accounts.

Important! You cannot change the currency code for an account set after you add the set.

 5. Click Add.

To edit an account set:

 1. Open Accounts Receivable > A/R Setup >        Account Sets.

 2. Select the account set you want to change.

 3. Make your changes.

Note: If you use multicurrency accounting, you cannot change the currency code assigned to an 
account set.

 4. Click Save.

To delete a terms code:

 1. Open Accounts Receivable > A/R Setup >        Account Sets.

 2. Select the account set you want to delete.

23Sage 300 2023 Accounts Receivable User's Guide



Note: You can delete an account set only if it is not assigned to customer records (including customer 
groups, national accounts, and customers).

 3. Click Delete.

After adding or modifying an account set

 l Print and file the Account Sets report. For more information, see "Printing the A/R Account Sets 
Report" (page 310).

Billing Cycles

A billing cycle specifies a time interval at which you perform some type of processing (such as charging 
interest, issuing statements, or printing reports) for groups of customers.

Example: You can process some customer accounts on a monthly basis, and others quarterly.

About Billing Cycles

You must create at least one billing cycle before you can add customer records.

By default, the billing cycle for a customer group is assigned to customer and national account records in 
the group (for example, when you add a new customer to a customer group, or change a customer's 
group). However, you can change the billing cycle for a customer.

Note: National account customers use the national account's billing cycle. You can change a 
customer's billing cycle only by changing the billing cycle for the corresponding national account.

Keeping Track of Billing Dates

Accounts Receivable keeps track of the date when you last printed statements and posted interest 
invoices for each cycle (if you printed statements or processed interest by billing cycle). When you use 
the Year End screen, Accounts Receivable warns you if you have not completed processing of interest 
invoices by billing cycle.

The information displayed for each billing cycle includes the last dates when statements were printed and 
interest invoices were posted. Accounts Receivable enters these dates automatically when you print 
statements by billing cycle and post interest invoices that were created by billing cycle.

Adding or Modifying Billing Cycles

You create a billing cycle to specify a time interval at which you perform some type of processing (such as 
charging interest, issuing statements, or printing reports) for groups of customers.
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Note: When you print statements by billing cycle or post interest or recurring charges that you created 
by billing cycle, Accounts Receivable enters the date in the corresponding Statements Last Printed, 
Interest Last Invoiced, or Recurring Charges Last Invoiced field.

Before You Start

 l Decide on a code for each new billing cycle you want to add.

 l If you are deleting a billing cycle, make sure it is not assigned to any customer records (including 
customer groups, national accounts, and customers). If you want to delete a billing cycle that is 
assigned to a customer record, first assign a different billing cycle to the customer group, national 
account, or customer, or delete those records also.

To add a billing cycle:

 1. Open Accounts Receivable > A/R Setup >        Billing Cycles.

 2. Enter a code to identify the billing cycle, and then enter a description for the billing cycle.

 3. In the remaining fields, enter the frequency of the billing cycle (in days), the "remit to" person, and 
the address to which customers should direct their payments.

 4. Click Add.

To edit a billing cycle:

 1. Open Accounts Receivable > A/R Setup >        Billing Cycles.

 2. Enter the code for the billing cycle you want to change.

 3. Make your changes.

 4. Click Save.

To delete a billing cycle:

 1. Open Accounts Receivable > A/R Setup >        Billing Cycles.

 2. Enter the code for the billing cycle you want to delete.

 3. Click Delete.

After adding or modifying a billing cycle

 l Print and file the Billing Cycles report. For more information, see "Printing the A/R Billing Cycles 
Report" (page 311).
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 l If you changed the billing cycle codes assigned to customers, groups, or national accounts, you 
may also want to print new copies of the Customer List, Customer Group List, and National 
Account List for the records you changed. For more information, see:       

 l "Printing a List of Customers" (page 287)

 l "Printing the A/R Customer Group List Report" (page 284)

 l "Printing the A/R National Accounts Report" (page 304)

Distribution Codes

Distribution codes are a quick method of specifying the revenue, inventory, and cost of goods sold 
general ledger accounts to which you distribute sales transactions.

About Distribution Codes

You can define as many distribution codes as you need to represent the various combinations of general 
ledger accounts to which you post sales data.

If you create an item list, you can use distribution codes to assign account numbers to items when you 
create item records.

You can also use distribution codes if you do not use an item list. In this case, each distribution code 
identifies only a general ledger revenue account. When entering non-item transactions, you can either 
select the appropriate distribution code or select the number of the revenue account to use.

You also assign a distribution code to each invoice detail you enter in a recurring charge record.

Inventory and Cost Of Goods Sold Accounts

If you will assign a distribution code to an item record and you want to create transactions for inventory, 
and cost of goods sold, enter numbers for all three general ledger accounts (revenue, inventory, and cost 
of goods sold).

If you will use the distribution code for creating summary invoices (invoices that do not use item numbers 
for invoice detail entry), enter the general ledger account number only for the revenue account. Accounts 
Receivable does not create transactions for inventory and cost of goods sold from summary invoices.

Adding or Modifying Distribution Codes

Distribution codes let you specify the revenue, inventory, and cost of goods sold general ledger accounts 
to which you post data from sales transactions, rather than having to manually enter those general ledger 
codes.

26Sage 300 2023 Accounts Receivable User's Guide



Before You Start

 l Decide on the distribution codes to use.

 l If you are adding a new distribution code, determine the general ledger accounts to assign to it. (If 
necessary, add the general ledger accounts you want to assign.)

You assign the following general ledger accounts to distribution codes:

 l Revenue.

 l Inventory (used only with an item list).

 l Cost of goods sold (used only with an item list).

 l If you are deleting a distribution code:

 l Make sure the code is not assigned to any item records. (You cannot delete a distribution 
code if it is assigned to any items.)

 l Post any outstanding batches containing transactions that use the code you want to delete. 
Although you can post these batches later, you must enter a new code.

To add a distribution code:

 1. Open Accounts Receivable > A/R Setup >        Distribution Codes.

 2. In the Distribution Code field, enter a new distribution code.

 3. In the Description field, enter a description of the code.

 4. In the General Ledger Account fields, enter the account numbers to which to post transactions that 
use the distribution code. More...

If you do not use items in Accounts Receivable, enter the number for the revenue account only. If you 
plan to use the distribution code with an item list, you must enter numbers for all three accounts.

If you use Sage 300General Ledger with your Accounts Receivable database, you can click the Finder 

 or press F5 to display a list of general ledger account numbers. Highlight the account you want, 

then press Enter to insert it in a field. 

 5. Specify a default discount status for the distribution code. More...

Your choice for the distribution code appears as the default discount status when you use the 
distribution code in an invoice, credit note, debit note, or recurring charge detail.

 6. Click Add.
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To edit a distribution code:

 1. Open Accounts Receivable > A/R Setup >        Distribution Codes.

 2. Enter the distribution code you want to change.

 3. Make your changes.

Notes: 
 l If you make a distribution code inactive, you can no longer assign it to items or use it in 

summary invoices.

 l Changing the general ledger account numbers assigned to a distribution code has no 
effect on existing transactions that use the distribution code. If you want to use the new 
account numbers with the transactions, you must edit the documents to enter the new 
account numbers.

 4. Click Save.

To delete a distribution code:

 1. Open Accounts Receivable > A/R Setup >        Distribution Codes.

 2. Enter the distribution code you want to delete.

 3. Click Delete.

After adding or modifying a distribution code

 l Print and file the Distribution Codes report. For more information, see "Printing the A/R Distribution 
Codes Report" (page 313).

Dunning Messages

You can print messages, such as reminders about overdue accounts, notices of sales, or other 
information, on statements for your customers.

Dunning messages are optional. If you use the same messages for all your statements, you add the 
messages on the Statements tab of the A/R Options screen. However, if you want to use more than one 
set of messages, you add as many sets as you need using the A/R Dunning Messages screen. You can 
then select a dunning message code when you print customer statements.

Adding or Modifying Dunning Messages

You can add a different dunning message for each period into which you age customer accounts, 
including the current (not due) period. When producing a statement for a customer, Accounts Receivable 
uses the message you specify for the period that contains the oldest balance in the customer’s account. 
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Before You Start

 l Decide on the code to identify the messages.

To add a set of dunning messages:

 1. Open Accounts Receivable > A/R Setup >        Dunning Messages.

 2. Enter a code to identify the set of messages you are adding.

 3. Enter a description of the message set, such as a comment about when to use the messages.

 4. For each aging period, enter a message to print on customer statements. 

Accounts Receivable prints the message relating to the customer’s oldest outstanding transaction or 
balance.

Note: If you age by document date instead of due date, you should enter the same message for both 
the current period and the first aging period, because accounts selected for the first aging period are 
not likely to be overdue.

 5. Click Add.

To edit a set of dunning messages:

 1. Open Accounts Receivable > A/R Setup >        Dunning Messages.

 2. Enter the code for the dunning message you want to change.

 3. Make your changes.

 4. Click Save.

To delete a set of dunning messages:

 1. Open Accounts Receivable > A/R Setup >        Dunning Messages.

 2. Enter the code for the dunning message you want to delete.

 3. Click Delete.

After adding or modifying a set of dunning messages

 l Print and file the Dunning Messages report. For more information, see "Printing the A/R Dunning 
Messages Report" (page 314).

E-mail Messages

You use the A/R E-mail Messages screen to create standard messages to send with e-mailed 
statements, letters, and invoices.
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Adding or Modifying an E-mail Message

If you often send e-mail messages with the same content, you can save yourself time by creating a 
standard e-mail message.

You identify each e-mail message with a unique 16-character Message ID code. When you select 
Customer as the Delivery Method on the Statements/Letters/Labels screen and on the A/R Invoices 
screen, you can select the code for the message you want to send with the statement, letter, invoice, or 
receipt confirmation.

Tip: You can use variables in the E-mail Subject field and the body of the e-mail message to insert 
customer or company specific information in the e-mail. For more information, see "E-mail Message 
Variables" (page 31).

Before You Start

 l Decide on the message ID code to identify the e-mail message.

To create a message that you can use with e-mailed statements, letters, or invoices:

 1. Open Accounts Receivable > A/R Setup >        E-mail Messages.

 2. Select the Message Type (statement, invoice, or letter).

 3. In the Message ID field, enter a code to identify the message.

 4. In the Description field, enter a description for the message.

 5. In the E-mail Subject field, enter the subject line you want to use for the e-mail message.

 6. Enter the body of the e-mail message.

 7. Click Add.

To edit an e-mail message:

 1. Open Accounts Receivable > A/R Setup >        E-mail Messages.

 2. Enter the code for the e-mail message you want to change.

 3. Make your changes.

 4. Click Save.

To delete an e-mail message:

 1. Open Accounts Receivable > A/R Setup >        E-mail Messages.

 2. Enter the code for the e-mail message you want to delete.

 3. Click Delete.
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After adding or modifying an e-mail message

 l Print the E-mail Message report. For more information, see "Printing the A/R E-mail Messages 
Report" (page 315).                     

E-mail Message Variables

A variable is a string of characters in an e-mail message that is replaced with a specific term or value 
when the message is sent.

Example: In an e-mail message to a company where the customer contact is specified as Ron Black, 
the line "Dear $CUSTOMER_CONTACT" will be replaced with "Dear Ron Black" when the message is 
sent.

Common E-mail Message Variables

You can use the following common variables in all e-mail messages. 

Value to Insert E-mail Message Variable

Company contact $COMPANY_CONTACT

Company name $COMPANY_NAME

Customer ID $CUSTOMER_ID

Customer contact $CUSTOMER_CONTACT

Customer name $CUSTOMER_NAME

Fax number $COMPANY_FAX

Telephone number $COMPANY_PHONE

Common E-mail Message Variables

Statements and Letters

The following variables are available only for statements and letters:

Value to Insert E-mail Message Variable

Statement balance $STATEMENT_BALANCE

Statement and Letter E-mail Message Variables
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Value to Insert E-mail Message Variable

Outstanding balance $OUTSTANDING_BALANCE

Statement date $STATEMENT_DATE

Cutoff date $CUTOFF_DATE

Interest Profiles

You use interest profiles to specify how to charge interest on overdue accounts.

You must add at least one interest profile to Accounts Receivable before you can add customer records, 
and you must assign an interest profile to each customer.

About Interest Profiles

You must add at least one interest profile to Accounts Receivable before you can add customer records, 
and you must assign an interest profile to each customer. If you do not charge interest to customers, 
assign them to an interest profile with 0 (zero) as the annual rate.

You can set up as many interest profiles in Accounts Receivable as you need for the ways and rates with 
which you assess interest charges. For information about how Accounts Receivable calculates interest 
on outstanding documents or balances, see "About Calculating Interest Charges" (page 33).

By default, the interest profile for a customer group is assigned to customer and national account records 
in the group (for example, when you add a new customer to a customer group, or change a customer's 
group). However, you can change the interest profile for a customer in the customer record.

Note: National account customers use the national account's interest profile. You can change a 
customer's interest profile only by changing the interest profile for the corresponding national account.

Numbering Interest Invoices

Use the Numbering tab on the A/R Options screen to specify a prefix for interest invoice numbers. For 
example, you might enter a prefix of INT. This prefix identifies interest charges on invoices, statements, 
and reports.

You can also specify the number to assign to the next interest invoice. Accounts Receivable then 
automatically increases this number by 1 for subsequent interest invoices.

Multicurrency Interest Profiles

If you use multicurrency accounting, you must specify a minimum interest charge and annual interest rate 
for each currency used by the customers assigned to a particular interest profile.
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About Calculating Interest Charges

For overdue accounts, you can calculate interest charges based on:

 l Each document individually.

 l The total outstanding balance.

Note: Balance-forward accounts are always charged interest on overdue balances.

Calculating Interest by Document

When you charge interest by document, interest is calculated separately for each overdue document or 
scheduled payment. Documents are overdue when they are outstanding beyond their due dates, plus 
any grace days you allow in the interest profile.

The interest calculation includes all:

 l Invoices.

 l Unapplied debit and credit notes.

 l Unapplied cash.

 l Unapplied prepayments.

 l Interest invoices (if you selected Compound Interest in the interest profile).

If interest was charged previously, interest charges are calculated for the period from the date interest 
was last charged to the Run Date you enter in the Create Interest Batch screen. Otherwise, interest 
charges are calculated from the document due date to the Run Date.

Interest charges on an overdue invoice are calculated by multiplying the overdue amount by the annual 
interest rate and the number of days in the period, then dividing the result by 365 (or 366 in a leap year):

(overdue invoice amount) * (annual rate) * (number of days overdue) / 

365

Because the interest calculation also includes credit notes, unapplied cash, and prepayments, the net 
interest may be negative. If the interest calculated is negative, no interest is charged or credited.

Calculating Interest by Balance

When you charge interest by overdue balance, interest is calculated in the same way for both balance-
forward and open-item customers.

If any document is overdue beyond the grace period specified in the interest profile (in the Charge 
Interest On Accounts [ ] Days Overdue field), interest is charged on the total overdue balance from the 
date of the oldest overdue document. Current documents are not included in the calculation.
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Interest charges are calculated for the period from the due date of the oldest outstanding document to the 
Run Date you entered in the Create Interest Batch screen, unless interest has already been charged 
during that period. If interest has been charged previously, interest charges are calculated for the period 
from the date interest was last charged to the Run Date.

Interest charges for the period are calculated by multiplying the net overdue balance as of the Run Date 
by the annual interest rate and by the number of days in the period, then dividing the result by 365 (or 366 
in a leap year):

(net balance) * (annual rate) * (number of days in the interest period) 

/ 365

The net overdue balance includes all:

 l Overdue invoices.

 l Overdue debit notes.

 l Overdue adjustments.

 l Overdue interest invoices (if you selected Compound Interest in the interest profile).

 l Unapplied credit notes.

 l Unapplied cash receipts.

 l Unapplied prepayments.

If the net balance is negative, no interest is charged or credited.

Adding or Modifying Interest Profiles

You create interest profiles to specify details about interest you charge customers.

Before You Start

 l Decide on the code to identify each interest profile.

 l Be sure your general ledger contains the account you want to assign as the interest income 
account in Accounts Receivable interest profiles.

 l If you have a multicurrency ledger, you must also determine the:

 l Code for each currency that uses the interest profile.

 l Minimum interest charge and annual interest rate for each currency you use with the 
interest profile.
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To add an interest profile:

 1. Open Accounts Receivable > A/R Setup >        Interest Profiles.

 2. In the Interest Profile field, enter a code to identify the interest profile.

 3. In the Description field, enter a description of the interest profile.

 4. In the Interest Income Acct. field, enter the number of the general ledger account to which you 
post revenue from interest charges.

 5. In the Calculate Interest By field, specify whether to charge interest on each overdue document or 
on overdue account balances.

 6. Specify the number of days an account must be overdue before you charge interest.

 7. If you round up interest charges to a minimum amount, select the Round Up To Minimum option. 
Do not select the option if you have no minimum interest charge or if you charge interest as 
calculated, regardless of the amount.

 8. If you include previous interest charges in the overdue total on which you charge interest (that is, 
you charge interest on interest), select the Compound Interest option.

 9. Enter the currency code or codes (if you use multicurrency accounting) that you want to use with 
the interest profile.

You must enter an annual interest rate for each currency you assign to the interest profile. You can also 
enter a minimum interest charge for each currency.

 10. Enter the minimum amount you charge as interest. Enter 0 (zero) if you charge interest as 
calculated, regardless of the amount.

If you use multicurrency accounting, enter the minimum interest charge for each currency you use with 
the interest profile.

 11. Enter the annual rate at which you charge interest for the interest profile. For example, to enter a 
nominal annual rate of 10 percent, enter "10".

If you use multicurrency accounting, enter an annual interest rate for each currency.

 12. Click Add.

To edit an interest profile:

 1. Open Accounts Receivable > A/R Setup >        Interest Profiles.

 2. Enter the code for the interest profile you want to change.

 3. Make your changes.

 4. Click Save.

35Sage 300 2023 Accounts Receivable User's Guide



To delete an interest profile:

 1. Open Accounts Receivable > A/R Setup >        Interest Profiles.

 2. Enter the code for the interest profile you want to delete.

 3. Click Delete.

After adding or modifying an interest profile

 l Print and file the Interest Profiles Report. For more information, see "Printing the A/R Interest 
Profiles Report" (page 317).

Items

You use the A/R Items screen to:

 l Create a list of the items you sell, so you can use item numbers when filling out invoice details.

 l Specify the item cost, so invoicing will create transactions for inventory and cost of goods sold 
accounts.

 l Specify a default distribution code or the particular accounts to update when you use an item in a 
transaction.

 l Specify the tax authorities and tax classes for items, to simplify tax calculation on invoices.

About Accounts Receivable Items

Adding item records in Accounts Receivable lets you set up a price list of the items you sell to customers 
or the fees you charge clients. Item numbers also make invoice entry faster: when you enter an item 
number on an invoice, information from the item record (such as the unit of measure and unit price) is 
automatically displayed.

You may want to add item records to Accounts Receivable even if you use other Sage 300 programs to 
print invoices and track inventory. For example, you might use Accounts Receivable to invoice service 
charges or other non-inventory items that are not included in your Inventory Control price list. You also 
need an item list if you want to produce job-related item invoices for certain types of projects in Project 
and Job Costing.

Before adding item records to Accounts Receivable, develop a logical scheme for assigning item 
numbers. Consider the order in which you want to group items, such as to list them on reports. Each item 
number can contain up to 16 characters, including numbers, letters, dashes, and other keyboard 
characters.

General Ledger Accounts for Items

You can assign revenue, inventory, and cost of goods sold accounts to an item in the following ways:
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 l Assign the item a distribution code that includes the accounts.

Note: If you change the accounts used in a distribution code, item records that use the distribution 
code are immediately updated with the changes.

 l Specify the accounts directly in the item record.

Tip: If you want to reuse some of the accounts and the discount status from a distribution code, 
assign the distribution code to the item record. Then clear the code, and change the information.

When you post a transaction that uses an item number, general ledger transactions are created for the 
revenue, inventory, and cost of goods sold accounts assigned to the item record.

Setting Up Non-Inventory Items

For non-inventory items, such as service charges and fees, enter zero as the cost, so that no general 
ledger transactions are created for the inventory and cost of goods sold accounts when you invoice these 
items.

You can enter a commodity number for each item, for your own reference.

For each item, you enter pricing information, including:

 l Unit of measure.

 l Item cost.

 l Item price.

 l Tax base (the amount on which you calculate tax, usually the item price).

If you use the option to keep item statistics, figures in the item record are automatically updated for:

 l Sales.

 l Returns.

 l Cost of goods sold.

 l Gross margin.

 l Total quantities sold.

 l Last date on which an invoice was posted with the item number.

Entering Item History

You can enter item statistics when setting up Accounts Receivable. 

Before you can enter statistics, you must select the Allow Edit Of Statistics option for items on the 
A/R Options screen. 

Using the A/R Items screen, you can then enter totals of:

37Sage 300 2023 Accounts Receivable User's Guide



 l Sales

 l Returns

 l Cost of goods sold

 l Margin

 l Total quantity sold

 l Date of last invoice

You can enter the figures for each of the periods in the current year to date and in the previous years for 
which you keep transaction details.

Because item statistics are updated automatically when you post transactions, you may want to turn off 
the Allow Edit Of Statistics option or assign security to the A/R Options screen to prevent accidental 
changes.

Multicurrency Ledgers

If you use multicurrency accounting, you can enter pricing information for each currency in which you sell 
an item.

You also enter tax information, including the authorities that tax the item, its tax class, and whether tax 
amounts are included in the item price.

Adding or Modifying an Item

You can create a record for each item you sell. These item records can be used in various ways (for 
example, to set up a price list of the items you sell to customers or the fees you charge clients).

Note: When you post item details, Accounts Receivable creates transactions for the revenue, 
inventory, and cost of goods sold general ledger accounts assigned to the items.

Before You Start

 l Decide on the item number scheme. For more information, see "About Accounts Receivable Coding 
Schemes" (page 19).

 l Add the distribution codes you want to assign to items. For more information, see "Adding or 
Modifying Distribution Codes" (page 26).

 l If you want to add year to date or prior year statistics with items, select the Keep Item Statistics 
option and the Allow Edit of Statistics option for items on the A/R Options screen.

 l Before you can use an item number on an invoice, you must enter at least one unit of measure in 
which you sell the item, and you should also assign the applicable tax authorities and classes to 
item records.
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To add an item record:

 1. Open Accounts Receivable > A/R Setup >        Items.

 2. In the Item Number field, enter a new code to identify the item, press Tab, and then enter a 
description for the item.

 3. On the Item tab:     

 a. Enter the commodity number to use for value-added tax reporting. If you do not use 
commodity numbers, leave the field blank or enter a reference of your own.

 b. Enter the distribution code that identifies the revenue, inventory, and cost of goods sold 
general ledger accounts to which you distribute transaction amounts posted for the item.        

Alternatively, you can use the General Ledger Account fields to enter the individual accounts to 
update when you use the item in transactions. 

Tip: To reuse some of the accounts and the discount status from an existing distribution code, 
insert the distribution code in the item record. Then clear the code, and enter the General 
Ledger accounts you want to use.

 c. If you offer discounts on the item, select Discountable option.

When you use the item code in a detail line on the A/R Invoice Entry screen, the detail uses the 
Discountable status from the item record, unless you change the distribution code for the detail 
later.

 d. Enter an optional comment, such as usage guidelines or special handling instructions.       

Note: If you select the Use Item Comment As Default option on the A/R Options screen, you 
can display the comments when entering invoices for the item.

 4. On the Pricing tab:     

 a. Enter each unit of measure you use for the item. More...

Enter the name or description of the unit in which you sell the item, such as EACH, DOZEN, or 
BOX. Add a line for each unit of measure you want to use.

Be careful when entering the unit of measure. Check your entry before you leave the Unit Of 
Measure field, because you cannot change it later. If you need to change a unit of measure, you 
must add a new line with the correct unit of measure, then delete the incorrect line, as follows:

 i. Press Insert to start a new line.

 ii. Enter the correct unit of measure and the other information for the line.

 iii. Select the incorrect line, and then press Delete to delete it.
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 b. For each unit of measure, enter the item cost and the item price.       

If you use multicurrency accounting:

 l Enter each cost and price in the currency you specified for the line.

 l Enter the code for each currency in which you sell the item, then enter pricing 
information for the currency. Remember to include the code for the functional 
currency and to enter units of measure and prices for each currency you specify.

When adding non-inventory items, such as consulting fees or delivery charges, enter 0 (zero) as 
the cost, so that Accounts Receivable does not create entries for the inventory and cost of goods 
sold general ledger accounts when you post transactions using the item numbers.

 c. If the tax authority does not charge tax on the price or cost, specify an alternate tax base. More...

Enter the amount on which to calculate tax for the item and unit. If you charge tax on the item 
price or cost, you do not need to enter an amount in this column.

 5. If taxes apply to sales of the item, use the Tax Status tab to specify the tax authorities, and, for 
each tax authority, the:     

 l Tax class.

 l Tax included status. If tax amounts are included in item prices for the tax authority and 
class, set the Tax Included status to Yes. (Double-click the Tax Included field, or press any 
key when the field is selected.)       

Note: You can select this option only if the Allow Tax In Price option is selected for the Tax 
Authority, in Tax Services.

 6. Click Add.

To edit an item record:

 1. Open Accounts Receivable > A/R Setup >        Items.

 2. In the Item Number field, enter the code for the item record you want to change.

 3. Make your changes.

 4. Click Save.

To delete an item record:

 1. Open Accounts Receivable > A/R Setup >        Items.

 2. In the Item Number field, enter the code for the item record you want to delete.

 3. Click Delete.
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After adding or modifying an item record

 l Print the Items list. Check the items you added or changed, and then file the report.  For more 
information, see "Printing the A/R Items Report" (page 318).

 l If you have added a large group of item numbers, check data integrity through Administrative 
Services and make a backup copy of your data.

Optional Fields

Optional fields are available if you have purchased and activated Sage 300 Transaction Analysis and 
Optional Field Creator, a separately licensed package.

Accounts Receivable optional fields let you customize your Accounts Receivable system by letting you 
store an unlimited amount of additional information with customer records and transaction details.

About Optional Fields in Accounts Receivable

Optional fields provide an additional means of analyzing receivables data. You can include optional field 
information when you print lists of customers, national accounts, customer groups, ship-to locations, and 
recurring charges.

In addition, you can select statements, letters, labels, aging reports, and reports of customer transactions 
by optional fields. When you use optional fields as selection criteria, Accounts Receivable prints 
information only for customers that use optional fields and values that fall within the specified ranges.

If you use exactly the same optional fields in Accounts Receivable and General Ledger, General Ledger 
can retain the optional field information sent with transactions that you generate in Accounts Receivable. 
(Optional field settings let you filter the optional field information that is passed to General Ledger.)

You can use an unlimited number of optional fields in Accounts Receivable. However, you must first 
define optional fields for your Sage 300 system using the Optional Fields screen in Common Services. 
For more information about setting up optional fields in Common Services, see the System Manager 
help.

Once you have set up optional fields for your Sage 300 system, you use the A/R Options screen in the 
A/R Setup folder to define optional fields for use with the following Accounts Receivable records and 
transactions:

 l Customers, national accounts, and customer groups.

 l Ship-to locations.

 l Invoices (including interest, retainage, and recurring charge invoices).

 l Invoice details.

 l Adjustments (including write-off adjustments).

41Sage 300 2023 Accounts Receivable User's Guide



 l Receipts.

 l Revaluation.

You can assign customer optional fields to customer records in Accounts Receivable. For more 
information, see:

 l "A/R Customers Screen" (page 376)

 l "A/R National Accounts Screen" (page 361)

 l "A/R Customer Groups Screen" (page 350)

 l "A/R Ship-To Locations Screen" (page 443)

 l "A/R Recurring Charges Screen" (page 425)

You can assign optional fields set up for use in transaction entry screens to particular transactions. For 
more information, see:

 l "About Entering Optional Fields on Adjustment Transactions" (page 143)

 l "About Entering Optional Fields on Invoices" (page 156)

 l "About Entering Optional Fields on Receipts" (page 196)

Optional Fields on Customers Screens

Optional customer fields that are marked for automatic insertion appear on the Optional Fields tabs on 
new customer, national account, and customer group records.

Default values for optional fields appear in records, as follows, for:

 l Customer Groups. The value entered in the Optional Fields record appears.

 l National Accounts. If no default value is specified for a particular optional field in the customer 
group record, the program displays the default value assigned to the optional field on the 
A/R Optional Fields screen.

 l Customers. Optional fields and values that you assign to a national account appear as defaults on 
the Optional Fields tab for any new customer records you add to the national account.     

If a customer belongs to a national account, Accounts Receivable displays the optional fields and their 
default values (if any) from the national account record.

If both the national account record and the customer group record specify a default value for an optional 
field, the value from the national account record is used.

If the customer does not belong to a national account, the program displays the optional fields specified 
for the customer group to which the customer belongs.

You can accept or change the default values that appear for optional fields in customer group, national 
account, customer, and ship-to location records.
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Note: The Value Set field alerts you whether a seemingly blank optional field has an automatically 
inserted—but "blank"—default value. If it has a blank value, the Value Set field displays Yes. (You 
cannot tell whether an optional field has a blank default value, or no value, just by looking at the Value 
field.)

Similarly, ship-to location optional fields that are marked for automatic insertion appear on the Optional 
Fields tab of new ship-to location records.

The Recurring Charges setup screen uses the same optional fields set up for the Invoice Entry screen. 
(The screens you use to create transactions automatically use the optional fields set up for the type of 
transactions they generate.)

Validating Optional Field Entries

Optional fields may use validation, which limits the values that can be entered in the fields.

 l If the optional field is validated, you must specify a value that is defined for the optional field in 
Common Services.     

Note: If the optional field allows blanks, you can leave the value field blank.

 l If the optional field is not validated, you can enter any value that is consistent with the type of field 
(such as yes/no, text, number, date, or amount), providing the value you enter does not exceed the 
length permitted for the field. You can also leave the field blank.

Note: When you specify a value that is defined in Common Services, the description for the value is 
also displayed.

Note: The data you enter in optional fields in a customer record appears for the customer on the 
A/R Invoice Entry screen if you use exactly the same optional fields for customers as for invoices.

About Passing Optional Field Values to General Ledger

Accounts Receivable passes to General Ledger optional field information posted with invoices, receipts, 
and adjustments if:

 l You use the same optional fields for the invoices, invoice details, receipts, or adjustments as are 
defined for transaction details for the affected accounts.

 l You specify in the optional field settings that optional field information will be passed to general ledger 
for the affected accounts.

To see the accounts that are affected when you post a certain kind of transaction, select an optional 
field you created for that type, then click the Settings button.
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Note: Different accounts are affected by invoice documents and invoice details. Invoice optional 
fields and invoice details optional fields are therefore passed separately to the General Ledger 
accounts.

For more information about optional field settings, see "A/R Optional Field Settings Screen" (page 522).

Accounts Receivable can also pass optional field information to Project and Job Costing for job-related 
invoices. For more information, see "About Optional Fields for Job-Related Transactions" (page 44).

About Optional Fields for Job-Related Transactions

On job-related invoices, debit notes, and credit notes, if the optional fields for the document details match 
the optional fields used in Project and Job Costing, the values from the contract appear as defaults, as 
follows:

 l For time and materials projects:     

 l For basic contracts, values from matching optional fields used by the project category 
appear.

 l For standard contracts, values from matching optional fields used by the project resource 
appear.

 l For fixed price projects that use a Completed Project or Project Percentage Complete accounting 
method, values from matching optional fields used by the project appear.

 l For fixed price projects that use a Billings and Costs or Accrual-Basis accounting method, values 
from matching optional fields used by the project category appear.

 l For cost plus projects that use a Completed Project, Total Cost Percentage Complete, or Labor 
Hours Percentage Complete accounting method, values from matching optional fields used by the 
project appear.

 l For cost plus project that use a Billings and Costs, Accrual-Basis, or Category Percentage 
Complete accounting method, values from matching optional fields used by the project category 
appear.

If the invoice detail optional fields do not match those used in Project and Job Costing, the values from 
the optional field setup records appear.

You can change the default value that appears for an optional field, as follows:

 l If the optional field is validated, you must specify a value that is defined for the optional field in 
Common Services.     

Note: If the optional field allows blanks, you can leave the value field blank.

 l If the optional field is not validated, you can enter any value that is consistent with the type of field 
(such as yes/no, text, number, date, or amount), providing the value you enter does not exceed the 
length permitted for the field. You can also leave the field blank.
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Note: When you specify a value that is defined in Common Services, the description for the value is 
also displayed.

The optional field information is passed to Project and Job Costing when you post job-related invoices if:

 l You selected the Project and Job Costing Billings/Costs setting for the optional field in the optional 
field setup record.

 l The invoice details optional fields match the optional fields defined for Project and Job Costing 
billings.

Adding or Modifying Optional Fields

Note: Optional fields are available if you use Transaction Analysis and Optional Field Creator.

Optional Fields let you store custom information with records and transactions. 

Before You Start

 l Make sure that the optional field you want to use in Accounts Receivable is set up for system-wide 
use in Common Services.

 l If an optional field you want to delete is assigned to a record or a transaction, edit the record or 
transaction to remove the optional field, or post the batch that contains the transaction.

To set up an optional field for use in Accounts Receivable:

 1. Open Accounts Receivable > A/R Setup >        Optional Fields.

 2. In the Optional Fields For field, select the type of record or transaction for which you are defining 
the optional field. More...

You can set up optional fields for use in the following types of records or transactions:

 l Customers, customer groups, and national accounts (if you use national accounts).

 l Ship-to locations.

 l Invoices (associated with document headers).

 l Invoice details.

 l Adjustments.

 l Receipts.

 l Revaluation.

 l Refunds.
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 3. Select the optional field code (or codes) you want to use for the selected type of record or 
transaction. The program displays the description for the optional field. More...

You can define an unlimited number of optional fields for each type of record or transaction, providing 
the optional fields are set up in Common Services for use in your system.

Note: If you want to retain optional field information from Accounts Receivable transactions when you 
create batches for General Ledger, you must use the same optional fields for transactions in 
Accounts Receivable as you use in General Ledger.

 4. If you want to specify a default value for the optional field:

 a. Enter Yes in the Value Set field. (To change the setting, double-click the field.)

Note: The Value Set field alerts the data entry clerk that a seemingly blank optional field 
actually has an entry. By looking at the Value field, you cannot tell whether it has a "blank" 
default value or no value at all.

 b. In the Default Value field, specify the default value to display in the optional field. More...

You can change the default value that appears for an optional field, as follows:

 l If the optional field is validated, you must specify a value that is defined for the 
optional field in Common Services.     

Note: If the optional field allows blanks, you can leave the value field blank.

 l If the optional field is not validated, you can enter any value that is consistent with the 
type of field (such as yes/no, text, number, date, or amount), providing the value you 
enter does not exceed the length permitted for the field. You can also leave the field 
blank.

Note: When you specify a value that is defined in Common Services, the description for the 
value is also displayed.

 5. Double-click the Required field to indicate whether the optional field must be used in the records and 
transactions for which it is created. More...

During data entry, if an optional field is required and does not have a default value, you must fill in the 
field before you can proceed. If the optional field has a default value, you can accept the value that 
appears or assign a different one.

Note: If you make an optional field a required field, the Auto Insert field changes to Yes.

 6. To set the optional field to be included on new records or transactions on the screen for which you 
are defining the optional field, enter Yes in the Auto Insert field. (To change the setting in this field, 
double-click the field.)
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 7. If the optional field you are defining is for a transaction, click Settings to open the A/R Optional 
Field Settings screen, on which you can specify additional settings for the optional field. More...

The A/R Optional Field Settings screen lists all the groups of accounts that are affected when you post 
transactions of the type for which you are defining the optional field. Use this screen to specify:

 l The General Ledger accounts to which optional field information is passed when you post 
transactions that include the optional field.

 l Whether optional field information for job related transactions is passed to Project and Job 
Costing. (If you use Project and Job Costing and you want Accounts Receivable to update 
contracts in Project and Job Costing, select the Billings/Costs option.)

If the optional fields in the posted transactions match the optional fields defined for billings in Project 
and Job Costing, the optional field information is sent to that program.

 8. Click Add (or Save).

To edit an optional field:

 1. Open Accounts Receivable > A/R Setup >        Optional Fields.

 2. In the Optional Fields For field, select the type of record or transaction for which you want to edit 
the optional field. More...

You can set up optional fields for use in the following types of records or transactions:

 l Customers, customer groups, and national accounts (if you use national accounts).

 l Ship-to locations.

 l Invoices (associated with document headers).

 l Invoice details.

 l Adjustments.

 l Receipts.

 l Revaluation.

 l Refunds.

 3. Make the changes you need on the table.

Note: You can change the default value and Auto Insert status for an optional field at any time. If the 
field is validated, however, you must select a value that is defined for the optional field in Common 
Services.

 4. If the optional field you are editing is for a transaction, click Settings to open the A/R Optional Field 
Settings screen, where you can specify additional settings for the optional field. More...
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The A/R Optional Field Settings screen lists all the groups of accounts that are affected when you post 
transactions of the type for which you are defining the optional field. Use this screen to specify:

 l The General Ledger accounts to which optional field information is passed when you post 
transactions that include the optional field.

 l Whether optional field information for job related transactions is passed to Project and Job 
Costing. (If you use Project and Job Costing and you want Accounts Receivable to update 
contracts in Project and Job Costing, select the Billings/Costs option.)

If the optional fields in the posted transactions match the optional fields defined for billings in Project 
and Job Costing, the optional field information is sent to that program.

 5. Click Save.

Note: Changes you make to an optional field affect only records or transactions added after you 
make the change.

To delete an optional field:

 1. Open Accounts Receivable > A/R Setup >        Optional Fields.

 2. In the Optional Fields For field, select the type of record or transaction for which you want to 
delete the optional field.

 3. Select the optional field you want to delete.

 4. Click Delete.

After adding or modifying an optional field

 l Print the Optional Fields report to check the new record information and to update your printed 
records. For more information, see "Printing the A/R Optional Fields Report" (page 319).

Payment Codes

You can enter all types of payments in Accounts Receivable, including cash, checks, credit cards, and 
the other ways that your customers pay you, or that you refund customers. Accounts Receivable uses the 
payment code you enter during receipt entry or refund entry to add information automatically about the 
type of payment.

Your Accounts Receivable system must contain at least one payment code before you can add receipt or 
refund transactions.

Adding or Modifying Payment Codes

You can define a code for each method of payment you accept (for example, cash, check, or credit card).
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Before You Start

 l Decide on the codes to use for all the types of payments you process. For more information, see 
"About Accounts Receivable Coding Schemes" (page 19).

 l Determine the payment method for each payment code—cash, check, credit card, or other.       

If you use Payment Processing, the SPS Credit Card payment type lets you define payment codes you 
will use for Paya credit card transactions. To process a credit card payment for a transaction in Paya, 
you must select a payment code with the SPS Credit Card payment type for the transaction. 

 l If you plan to make a payment code inactive, assign another payment code to any unposted 
receipt transactions that use the code.

 l If you want to delete a payment code, make sure it is not assigned to any unposted receipt 
transactions or customers.

To add a payment code:

 1. Open Accounts Receivable > A/R Setup >        Payment Codes.

 2. In the Payment Code field, enter a new payment code, and then press Tab.

 3. Specify details for the payment code. For more information, see "A/R Payment Codes Screen" (page 
543).

 4. Click Add.

To edit a payment code:

 1. Open Accounts Receivable > A/R Setup >        Payment Codes.

 2. In the Payment Code field, select the payment code you want to change.

 3. Make your changes.     

 4. Note: Before you can make a payment code inactive, you must assign another payment code to any 
unposted receipt transactions that use the inactive payment code.

 5. Click Save.

To delete a payment code:

 1. Open Accounts Receivable > A/R Setup >        Payment Codes.

 2. In the Payment Code field, select the payment code you want to delete.
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 3. Click Delete.     

Notes: 
 l Before you can delete a payment code that is assigned to an unposted receipt transaction, 

you must first assign a different payment code to the transaction, or delete the transaction.

 l Before you can delete a payment code that is assigned to a customer, you must first 
assign a different payment code to the customer.

After adding or modifying payment codes

 l Print and file the Payment Codes report. For more information, see "Printing the A/R Payment 
Codes Report" (page 321).

 l If you change the payment method for a payment code, the change is not automatically made in 
existing unposted transactions. You must edit and save unposted transactions to register changes 
in payment methods, so that the transactions are correctly recorded on deposit slips.

Salespersons

You can add a record in Accounts Receivable for each of your salespeople, then use the salesperson 
code to identify the person on transactions and reports. 

You also use the A/R Salesperson screen to specify sales targets and up to five commission rates for 
each salesperson, and to track information for salespeople.

About Sales Splits

You can assign up to five salesperson numbers to each customer record and ship-to location, specifying 
the percentage of the customer’s transactions to apply to each salesperson record. When you enter a 
customer number on the A/R Invoice Entry screen, the salesperson information for the specified 
customer appears automatically. If you do not assign salespersons to customer records, you can still 
specify salespersons and percentages when you enter invoices.

Adding or Modifying Salesperson Records

You can create records of your salespersons in Accounts Receivable, which you can use to define 
commission rates, among other things.
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Before You Start

 l If you are adding a salesperson record:

 l Decide on the salesperson code.

 l If you want to add prior year statistics for your sales staff, on the A/R Options screen, select 
the Allow Edit of Statistics option for salespersons.

 l Post batches containing salesperson codes you want to delete, or change the salespersons for 
the transactions.

To add a salesperson record:

 1. Open Accounts Receivable > A/R Setup >        Salespersons.

 2. In the Salesperson Code field, enter a new code to identify the salesperson, and then press Tab.

 3. Enter the salesperson's name as you want it to appear on Accounts Receivable screens and 
reports.

 4. In the Employee Number field, enter the employee number assigned to the salesperson in your 
company’s payroll records. This is an optional field, so you can leave it blank or enter other 
information in it.

 5. In the Annual Sales Target field, enter the sales target or quota for the salesperson in the current 
year. If you do not assign sales targets, you can leave this field showing zeroes.

 6. If necessary, add statistics for the salesperson for prior periods. More...

Enter the year and period for which you want to enter statistics, and then for each transaction type:

 l In the Amount field, enter the total amount processed for the salesperson during the 
selected year and period.

 l In the Count field, enter the total number processed for the salesperson during the selected 
period.

 7. Click Add.

To edit a salesperson record:

 1. Open Accounts Receivable > A/R Setup >        Salespersons.

 2. In the Salesperson Code field, enter the code for the salesperson record you want to change.

 3. Make your changes.

Note: If you make a salesperson code inactive, you can no longer assign it to customer records or 
transactions.

 4. Click Save.
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To delete a salesperson record:

 1. Open Accounts Receivable > A/R Setup >        Salespersons.

 2. In the Salesperson Code field, enter the code for the salesperson record you want to delete.

 3. Click Delete.

After adding or modifying a salesperson record

 l Print and file the Salespersons report. For more information, see "Printing the A/R Salespersons 
Reports" (page 321).

 l Update the Sales Split tab of the A/R Customers screen for customers that use salesperson 
information you changed or records you deleted.

 l Edit any unposted documents using the A/R Invoice Entry screen to substitute other salesperson 
codes for the salesperson records you deleted.

About Salesperson Commission Rates

Salesperson commission rates are the rates that Order Entry uses to calculate commissions paid to 
salespersons for their sales orders.

Although you set the option to track sales commissions in Order Entry, you specify whether a particular 
salesperson earns commissions, and their individual commission rates, in Account Receivable. 

Order Entry uses the rates you specify in Accounts Receivable to calculate salesperson commissions if:

 l You select the Commissions Paid option in the salesperson's record.

 l You define rates for each range of sales or margin amounts. You can define up to five rates for 
each salesperson.

 l You track commissions in Order Entry.

 l The category for the Inventory Control item used in an order allows commissions, but uses 
0.00000% as the commission rate. (For more information about inventory item categories, see the 
Inventory Control help.)

You use the Commission tab on the A/R Salespersons screen to specify up to five commission rates, 
together with the range of sales amounts to which each rate applies. For example, a salesperson might 
be paid 2% commission on the first $10,000 of sales per period, and then 5% on sales over $10,000. You 
can edit these rates at any time, but the new rates will affect only future commissions.

You can include sales commission rates for each salesperson on the Salespersons report that you print 
in Accounts Receivable. If you track commissions in Order Entry, you can also print a report of 
commissions earned in Order Entry.
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For an overview of sales commission options, and to find out how commissions are calculated and how to 
print the Salesperson Commission report, see the Order Entry help.

Choosing Commission Options

If you use Sage 300 Order Entry, Accounts Receivable can calculate commissions earned by 
salespersons using the data from invoices and credit notes. You can print this information on the 
Salesperson Commissions report in Order Entry. For more information, see the Order Entry help.

The calculation of sales commissions depends on:

 l Whether you track commissions by sales or margin. If you track commissions by sales, Order 
Entry calculates commissions as a percentage of the sales amount. If you track commissions by 
margin, the calculation is based on the margin amount.     

You specify how to track commissions on the Processing tab of the O/E Options screen in Order Entry.

 l The rates set for the item categories in Inventory Control or the commission rates set for the 
salespersons in Order Entry. This is not a choice on the A/R Options screen. Order Entry uses the 
rate specified in the item category record in Inventory Control unless the rate is 0.00—in which 
case, it will use the salesperson's rates defined in Order Entry.

Setting Up Commissions

To calculate commissions on sales of inventory items, you must set up your system as follows:

 l Select the Track Commissions option on the Processing tab of the O/E Options screen. You must 
also specify the method for calculating commissions (Sales or Margin).

 l Select the Commissions option on the Salesperson Commission Rates screen for each 
salesperson who is paid commissions.

 l Select the Allow Commissions option for each item category on which commissions can be 
earned. (Use the Categories screen in Inventory Control.)

 l Enter commission rates for categories. For more information, see the Inventory Control help.

 l Assign commission percentages to the item categories in Inventory Control and/or to the 
salesperson in Order Entry (on the Salesperson Commission Rates screen).

Assigning Commission Rates to Categories

Each item category in Inventory Control can have a single commission rate. If you want to use a different 
rate, you can change the category for any item when you add it to an order.

Assigning Salesperson Commission Rates

If you use the commission rate structure on the Salespersons screen, you can use up to five rates for 
each salesperson, with each rate applying to a different range of sales amounts (such as to the first 
$5,000, the next $5,000, and so on).
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Adding Salesperson Commission Rates

Although you set the option to track sales commissions in Order Entry, you specify whether a particular 
salesperson earns commissions, and their individual commission rates, in Account Receivable.

Before You Start

 l Add salesperson records using the A/R Salespersons screen.

To add commission rates:

 1. Open Accounts Receivable > A/R Setup >        Salespersons.

 2. Enter the salesperson code.

 3. Select the Paid Commissions option, and then specify a number of commission rates to enter.

 4. Specify up to five rates, and enter the total sales amount up to which each rate applies.

 5. Click Save to record your entries.

Terms

You use the A/R Terms screen to define all the terms Accounts Receivable uses to determine invoice due 
dates, set the rates and eligibility periods of discounts for early payment, and calculate discount bases. 

You assign a terms code to each customer record to set the default terms that appear when you enter 
invoices for the customer.

You must define at least one set of terms before you can add customer records.

About Customer Payment Terms

Payment terms specify various details about an invoice, such as:

 l Due date.

 l Discount rate and period (for early payment), and whether to calculate the discount before or after 
tax.

 l Number of payments in a multiple payment schedule.

Note: You must define at least one set of payment terms before you can add customer records.

Defining Payment Terms

You define sets of payment terms on the A/R Terms screen. For more information, see "A/R Terms 
Screen" (page 549).
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Terms Codes

Each set of payment terms is identified with a terms code. You specify default payment terms for 
customers by assigning a terms code to each customer and customer group.

Notes: 
 l You must assign a terms code to every customer and customer group in Accounts Receivable.

 l By default, the terms code for a customer group is assigned to customers in the group (for 
example, when you add a new customer to a customer group, or change a customer's group). 
However, you can change the terms code for a customer.

Installment Payments

You can use the Multiple Payment Schedule option to allow installment payments. You can set up as 
many installment periods as you need, and you can define installment periods that vary in length.

Discounts

You can offer a discount for early payment, specifying the rate of the discount and the period during 
which it is available. Also, if you charge taxes on sales, you can specify whether to calculate the discount 
on the document total before or after tax.

Standard Due Dates

Standard due dates are similar to "day of the month due," except they do not restrict you to a single due 
date. For example, you can use standard due dates to assign invoices to the 15th or 30th of each month.

You can specify a due date for each of up to four ranges of days on which invoices are issued. You can 
also specify due dates that are one or more months later.

For example, invoices entered between the first and fifteenth of each month may be due on the thirtieth of 
the month, and invoices entered between the fifteenth and the end of the month may be due on the 
fifteenth of the next month.

When you use this option, you can either define discount periods in the same way as for other terms 
options, or you can enter a table of standard discount periods.

Changing Terms for Individual Transactions

When entering a transaction, the terms code for the customer is used by default. However, you can 
change this to any valid terms code. You can also change most of the details of the payment terms, 
including:

 l Due date.

 l Discount rate and period.
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 l Amounts and discount dates for a multiple payment schedule.

Note: You cannot increase the number of installment payments in a payment schedule.

Adding or Modifying Terms Codes

You can specify payment terms for invoices.

Before You Start

 l Determine the following:       

 l Identifying code.

 l Method for calculating the due dates for invoices.

 l Discount periods and percents (if used).

 l You may want to post batches that use terms codes you plan to delete, or edit the invoices to enter 
different terms codes. However, you can post batches that contain deleted terms codes.

To add a terms code:

 1. Open Accounts Receivable > A/R Setup >        Terms.

 2. In the Terms Code field, enter a new identifying code, press Tab, and then enter a description for 
the terms code.

 3. In the Calculate Base for Discount With Tax field, specify whether to include tax amounts in the 
invoice totals on which discount amounts are calculated. More...

 l Included. Select this option if you allow a discount on taxes.

 l Excluded. Select this option if you do not allow a discount on taxes or do not charge taxes to 
your customers.

 4. If you want to allow payment by installments with this code, select the Multiple Payment Schedule 
option.

 5. In the Due Date Type field, select the method by which you calculate invoice due dates. More...

 l Days From Invoice Date. Invoices are due a specific number of days after the invoice date. 
Enter the number of days in the No. of Days column that appears.

 l End Of Next Month. Invoices are due on the last day of the next month.

 l Day Of Next Month. Invoices are due on a specific day in the next month. Enter the due day 
in the Day of Month column.

 l Days From Day Of Next Month. Invoices are due a standard number of days after a specific 
day in the next month. Enter the number of days and the number that represents the day of 
the month.
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 l Due Date Table. Select this option if you use standard due dates for invoices entered within 
specified ranges of days. Complete the table that appears.

 6. If you offer discounts to your customers for early payment, in the Discount Type field, select the 
method you use to calculate the last day on which you allow your customers to take a discount. 
After selecting a discount type, enter discount percentages in the table.

 7. Click Add.

To edit a terms code:

 1. Open Accounts Receivable > A/R Setup >        Terms.

 2. Select the terms code you want to change.

 3. Make your changes.

 4. Click Save.

Note: When you change a terms code, the change is not automatically made in existing unposted 
transactions. You must edit invoice batches to register changes such as new discount percentages 
and dates.

To delete a terms code:

 1. Open Accounts Receivable > A/R Setup >        Terms.

 2. Select the terms code you want to delete.

 3. Click Delete.

After adding or modifying payment terms

 l Print and file the Terms report. For more information, see "Printing the A/R Terms Codes Report" 
(page 323).

 l If necessary, edit any unposted invoices in the A/R Invoice Entry screen to:

 l Change terms information for records you modified.

 l Substitute terms codes for terms records you deleted.

Customizable Formats for Printed Accounts Receivable 
Forms
Accounts Receivable includes standard business forms that you may be able to adapt to print on the 
forms you use. You edit the forms using Crystal Reports, which is available separately.

Before entering or processing transactions, you should set up and test the forms you want to use. More...
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 l You can print invoices, credit notes, and debit notes from the A/R Invoices report. For more 
information, see "A/R Invoices Screen" (page 700).

 l You can print deposit slips from the A/R Deposit Slips report or the A/R Receipt Entry screen. For more 
information, see:

 l "Printing the A/R Deposit Slips Report" (page 337).

 l "A/R Receipt Entry Screen" (page 648).

 l You can print statements, letters, and labels for customers from the A/R Statements/Letters/Labels 
report. For more information, see "A/R Statements / Letters / Labels Report" (page 461).

 l You can print labels for customers or ship-to locations from the A/R Labels report. For more 
information, see "A/R Labels Report" (page 462).

 l You can print refund checks from the A/R Refund Entry screen or the A/R Refund Batch List 
screen. For more information, see:

 l "A/R Refund Entry Screen" (page 676).

 l "A/R Refund Batch List Screen" (page 672).

Accounts Receivable includes Crystal (.RPT) versions of the following printed forms:

File Name Description

ARDINVO.RPT Invoice for laser printer

ARDOTINV.RPT Invoice for dot matrix printer

ARLETT01.RPT Sample letter form

ARINVWWW.RPT Invoice used by e.AR.Inquiry

ARSTMT01.RPT Statement form

ARLBL01.RPT Sample label

ARDPST01.RPT Default deposit slip (includes only cash and check receipts)

ARDPST02.RPT Deposit slip that includes cash, check, and credit card receipts

ARSTMT10.RPT For printing statements on plain paper

ARSTMTPRE.RPT For printing statements on preprinted forms

ARCHK01.RPT Advice-check-advice form for laser printer

Forms Included with Accounts Receivable
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File Name Description

ARCHK01A.RPT Similar to ARCHK01. The check portion is ANSI-compliant. For more 
information, see About Clearing Checks Electronically.

ARCHK11.RPT Check-advice-advice for 11-inch check form

ARCHK11A.RPT Similar to ARCHK11A, in ANSI-compliant format. For more information, 
see About Clearing Checks Electronically.

Modifying Reports

For information about how to customize forms, see the online document Customizing Printed Forms.
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Chapter 2: Setting Up and Maintaining 
Customer Records

After setting up processing records, such as the billing cycles and interest profiles that you assign to 
customer records, you can add customer records to Accounts Receivable.

You use icons in the A/R Customers folder to add the following types of customer records:

 l Customer groups

 l National accounts (optional)

 l Customers

 l Ship-to locations

 l Recurring charges

About Setting Up Customer Records
Accounts Receivable can maintain very detailed records about your     customers, and provides several 
options you can use to customize your records     to match your business requirements.

This section provides an overview to guide you through the customer setup process in Accounts   
Receivable, and directs you to topics that provide more background information about each step.

Add Supporting Records before Setting Up Customers

Before you can add customer records to Accounts Receivable, you must   set up account sets, billing 
cycles, distribution codes, receipt types,   (payment) terms, and other records you company may require. 

If you use optional fields, you must also set up optional fields for   use with customers, customer group, 
and national accounts.

For more   information about any of these tasks, see:

 l "A/R Account Sets Screen" (page 491)

 l "A/R Billing Cycles Screen" (page 495)

 l "A/R Distribution Codes Screen" (page 498)

 l "A/R Dunning Messages Screen" (page 500)
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 l "A/R E-mail Messages Screen" (page 501)

 l "A/R Interest Profiles Screen" (page 510)

 l "A/R Items Screen" (page 513)

 l "A/R Optional Fields Screen" (page 519)

 l "A/R Payment Codes Screen" (page 543)

 l "A/R Salespersons Screen" (page 545)

 l "A/R Terms Screen" (page 549)

General Steps for Setting Up Customers

You take the following steps to set up customer records in Accounts   Receivable:

 1. Decide on the account   type (open item or balance forward) to assign to each customer   record.

For more information, see "About Customer Account Types" (page 78).

 2. Define customer groups   to group customers for reporting purposes and for other   reasons, such as 
by geographical areas.

You must set up at least one customer group before you can add customer records. 

For more information, see "About Customer Groups" (page 61).

 3. If you use National Accounts   Management (an optional package available separately from Sage 
300),   create the national account records you require. 

For example, you might use   National Accounts if you deal with subsidiaries or branches of a company   
and you want to treat the company as one customer for billing, payment,   and collection purposes, but 
ship orders to individual branches separately. 

For more information, see "About National Accounts" (page 66).

 4. Add customer records.

For more information, see "About Accounts Receivable Customers" (page 73).

Customer Groups
Use customer groups to classify your customer records into groups that share similar characteristics, 
such as geographical locations.

About Customer Groups

You must define customer groups before adding customer records. You use customer groups to:
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 l Classify customer records by the characteristics you choose.      

Customer groups are identified by a unique code of up to six characters. For information on creating a 
coding scheme, see "About Accounts Receivable Coding Schemes" (page 19).

 l Set default entries to speed up the task of adding customer records.

 l Select records for processing. 

Tip: You can charge interest or produce   recurring charge invoices for a range of customer groups.

 l Select records for printing.

Tip: You can print statements by customer group.

 l View   year-to-date statistics for an entire group of customers.

You can create as many customer groups as you need. However, you must   define at least one group.

You can change most of   the information in an existing customer group record, except   the customer group 
code.

Default Settings for New Customer and National Account Records

You assign customers and national accounts   to customer groups when you add or change customer and 
national account records.

When you assign a customer to a customer group, Accounts Receivable automatically fills in  the 
following fields with the selections made for the customer   group:

 l Account Type

 l Account Set

 l Interest Profile

 l Terms

 l Billing Cycle

 l Print Statements

 l Tax Group and tax classes  

 l Salespeople

If you use national accounts, these selections also appear as defaults in   new national accounts you 
assign to the customer group.

You can change all the default entries for new customers   and national accounts.
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Most changes you   make to a existing group record affect only new customer and   national account 
records you create and add to the group, later. Only the following changes affect customers and national   
accounts already assigned to the group:

 l Changing the Allow   Edit Of Credit Check option for a customer group. More...

Before changing this   option, make sure that the group’s credit limit is entered as the limit   in all customer 
and national account records that are assigned to the   group.

Important! If you turn off this option, you can no longer change the credit   checks for any of the 
customer and national account records assigned to   the group, and you cannot save changes to the 
records if their credit   limits are higher than the group limit.

 l Changing the Inactive   status for a customer group. More...

If a customer group is inactive, you cannot:

 l Add new customers   or national accounts to the group.

 l Add invoices or other   transactions for customers or national accounts in the group.

Setting Credit Limits for Customers Assigned to a Customer Group

You specify a credit limit for each customer group, which is used when you add new customer records or 
national accounts   to the group.

You also indicate whether to allow different credit limits for the customers   and national accounts assigned 
to the group, or whether the group's customers   and national accounts must all use the same credit limit.

If you use multicurrency   accounting, you enter a credit limit in each of the currencies used by   the 
customers in the group.

Default Optional Fields

If you use optional fields with your system, any optional customer fields   that you set up and marked for 
automatic insertion appear on the Optional   Fields tab in new customer group records. 

You can accept the optional fields that appear or you can delete them,   and you can accept or change any 
default values that appear. You can also   assign additional optional fields that you have set up for 
customers,   national accounts, and customer groups.

If you use the same optional fields for new customers that you assign   to the customer group, the values 
from the customer group appear as defaults   (unless the customer is also assigned to a national account).

Customer Group Statistics

Accounts Receivable keeps statistics for customer groups, and displays   them on the A/R Customer 
Groups screen. You can display the statistics by the   type of year and period specified on the A/R Options 
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screen for customer   statistics.

For each group, Accounts Receivable lists the amount and number of invoices,   receipts, discounts, credit 
notes, debit notes, adjustments, write-offs,   interest charges, returned checks, and paid invoices. It also 
calculates   and displays the total days to pay and average days to pay figures for   the group.

You can edit the statistics in a customer group if you select the Allow   Edit Of (customer) Statistics option 
on the A/R Options screen.

Accumulating Tax Amounts

The totals kept for invoices, credit notes, and debit notes can include   or exclude the tax amounts you post 
with the documents, depending on your   selection for the Include Tax In (customer) Statistics option on 
the A/R Options screen.

Adding, Modifying, and Deleting Customer Groups

You must add at least one customer group before you can add customer   records or national accounts.

Note: Most changes you   make to an existing customer group record affect only new customer and   
national account records created and added to the group after you save your changes. For more 
information, see "About Customer Groups" (page 61).

Before You Start

 l Before adding customer groups, you must create records for the account sets, terms codes, billing 
cycles, interest profiles, salespersons, and optional fields you plan to assign to the customer 
groups.

 l Before you can edit statistics for a customer group, you must select the Allow Edit Of (customer) 
Statistics option on the A/R Options screen.

Note: The Statistics tab appears only after you have   added the record.

 l Before you delete   a customer group that includes customers and national accounts, you must:

 1. Add a customer group   with the code you want to use. 

 2. Reassign the customer records and national accounts in the group   to other groups, or 
delete the customer and national account records.

 3. Enter the group statistics   in the record for the new group.
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To add a customer group:

 1. Open Accounts Receivable > A/R Customers > Customer Groups.

 2. Click the New  button beside the Group Code field.

 3. In the Group Code field, type the code for the new customer group, and then press the Tab key.

 4. Fill in the fields on the Customer Groups screen.

 5. Click Add to add the new group.

 6. To add another   record, repeat steps 2 through   5.

Tip: To add   a customer group that uses information from another customer group, display   the record 
for the group you want to copy, type the new customer group   code in the Group Code field, and then 
press the Tab key.

To edit a customer group record:

 1. Open Accounts Receivable > A/R Customers > Customer Groups.

 2. In the Group Code field,   type the code for the   customer group you want to edit, select it from the 
Finder, or use the   navigation buttons to display the code you need.

 3. Make the changes you need   in the record.

 4. When finished, click Save   to record your changes.

To delete a customer group record:

 1. Open Accounts Receivable > A/R Customers > Customer Groups.

 2. In the Group Code field,   type the code for the   customer group you want to delete, select it from the 
Finder, or use the   navigation buttons to display the code you need.

 3. Click the Delete button. 

 4. If   a message appears asking you to confirm the deletion,   click Yes.

After modifying customer group records

 l Print the Customer Groups   report that contains the type of information you changed. Check the   
information, and then save the report for your files.

 l Update the customer and national account records assigned to the group, as   needed. For 
example, if you specified a new terms code for the customer group   and you want to use the terms 
with all the group’s customers, you must   edit each existing customer record to enter the change 
(or use macros   to update them all).
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National Accounts
Use national accounts if you have customers who are subsidiaries or branch offices of the same 
company. You can then apply checks and other receipts from the national account to the invoices posted 
for the member customers, and print statements for the national account that include all the member 
customers.

About National Accounts

Note: National Accounts Management is available as a separate package for Sage 300.

If you have customers that are subsidiaries or branch offices of a large company, you can use national 
accounts to process a single payment from the head office and apply it to the subsidiary accounts. In one 
step, you can also place a account and all its subsidiaries on hold.

If you want to record invoice payments for all branches through the national account, you add a customer 
record for the national account using the national account number as the customer number.

You can look up and print a report of total statistics from the transactions posted to all the customers in 
each national account, and you can also limit the contents of other Accounts Receivable reports to one or 
more of your national accounts.

When to Use National Accounts

You should use national accounts if you process transactions for a head office and its branches and you 
want to:

 l Accept a single payment from a company and apply it to outstanding invoices for all its branches.

 l Send invoices and statements to the head office, and send orders to the individual branches.

 l Make sure that when you put a head office on hold, Accounts Receivable warns you about the hold 
when you enter invoices for its subsidiaries.

 l Prevent posting further transactions to customers in the national account by assigning Inactive 
status to the national account. 

 l Apply different taxes to transactions for the head office and its branches.

 l Assign the salespeople who are responsible for each national account, and set the default 
salespersons and percentages for the customers you add to the national account.

 l Keep a set of sales and receipt statistics for the national account as a whole, and keep statistics 
separately for the head office and each branch.

 l Set default entries to assign to new customer records you add to the national account.

 l Record a separate comment for each office.
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You enter invoices separately for all the branches (customers) in a national account, but you can receive 
a single receipt (payment) from the head office and apply it to invoices for any of the customers in the 
national account.

To be able to apply receipts to the customers of a national account, you:

 1. Set up a customer record for the national account.

 2. Assign the national account to the customer records for the head office and all its subsidiaries or 
branches.

You can then display and select any of the transactions posted for the account's customers when you 
apply receipts from the national account.

Creating National Accounts

You use the National Accounts screen to define the national accounts you want to use. For each account, 
you specify a unique code of up to 12 characters.

You select a customer group for each national account, and choose the account type, account set, terms 
code, rate type (in multicurrency ledgers), billing cycle, and interest profile that you use for most of the 
national account's customers. 

You can also enter the address to which you send statements and letters for the national account, as well 
as the telephone and fax numbers, and the name of a contact at the head office.

This information appears as the default information in new customer records you add to the account, so 
that the billing address for the customers in the national account is automatically that of the national 
account, unless you change it.

Specifying Billing and Shipping Addresses for National Accounts

If you use Accounts Receivable to print your invoices, the program automatically prints the address from 
the customer record on the invoice.

If you need separate billing and shipping addresses for the head office of the national account and its 
branches, you enter the billing address in the customer record for each branch, then create a ship-to 
location record for each of the other addresses you want to record for a branch.

When you enter invoices for the branches, you select the address (ship-to location) to which you will ship 
the order. Accounts Receivable can then print the national account's billing address on the invoices and 
the selected shipping addresses on any shipping labels you print, provided that the formats you use to 
print invoices and labels include the necessary fields.
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Assigning Credit Limits to National Accounts

You can assign a credit limit to each national account, to help you control the size of the balance the 
company owes you at any time.

If a company already owes you more than its credit limit, Accounts Receivable warns you when you begin 
entering a transaction for the company's head office or any of its branches. Accounts Receivable also 
warns you when you try to save a new invoice or debit memo that will put the balance owing for the 
company over its credit limit. In both cases, you can choose whether to add the transaction or cancel it.

Accounts Receivable also indicates the customers and national accounts that are over their credit limits 
on batch listings.

If you want to modify the credit limit for a national account, you must select the Allow Edit Of Credit 
Check option in the customer group assigned to the account. If you do not select this option, you must 
accept the customer group's credit limit for the national accounts you assign to the group and for the 
customer records you create for the national account.

Keeping Statistics for National Accounts

Accounts Receivable keeps the same types of statistics for national accounts as for customer groups, 
and displays them on the Statistics tab of the National Accounts screen. You can edit and display the 
statistics as described in the previous section for customer group statistics.

Accounts Receivable keeps track of additional statistics for each national account, including the amount 
and date of the highest balance and largest invoice in the current and previous years, and the last 
invoice, receipt, credit note, debit note, adjustment, write-off, interest invoice, and returned check posted 
to the national account. 

The program also calculates the total invoices paid, total days to pay, and average days to pay for the 
account.

Using Optional Fields in National Accounts

If you use optional fields, any optional fields that you set up for automatic insertion in customer group, 
national account, and customer records automatically appear, along with their default values, on the 
Optional Fields tab of new national account records.

You can accept the optional fields that appear or you can delete them, and you can accept or change any 
default values that appear. You can also assign additional optional fields that you have set up for 
customers, national accounts, and customer groups.

Optional field values from the national account appear as defaults on the Optional Fields tab for any new 
customer records you add to a national account if the optional fields in the customer record match those 
used by the national account.
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Placing National Accounts On Hold

If you do not want to post new invoices to a national account, perhaps because there is a dispute about 
the account, you can place the national account on hold. Accounts Receivable then warns you about the 
hold when you enter invoices for customers assigned to the national account. You then decide whether to 
cancel the invoices or enter them.

The option has no effect on credit notes, debit notes, receipts, and prepayments. 

Assigning Inactive Status to National Accounts

When you plan to delete a national account, you can make sure that no further transactions are posted for 
its customers by selecting Inactive as the status for the national account.

Note: You can delete a national account only if no customers are assigned to it and the national 
account balance is zero.

Inactive status allows you to keep a national account in your Accounts Receivable system until you are 
ready to delete it.

Changing Information for National Accounts

You can change most of the information in a national account record at any time, except:

 l You cannot change to a customer group that has an Inactive status.

 l You cannot select Inactive status for a national account if any of its customer accounts has a non-
zero balance.

 l In multicurrency ledgers, you can change the account set for a national account only to a set that uses 
the same currency.

 l You cannot directly change a national account code.  However, you can accomplish the same effect if 
you:

 1. Add a national account with the code you want to use.

 2. Transfer all the customers in the national account to the new national account.

 3. Enter the national account statistics in the record for the new national account.

 4. Delete the national account with the unwanted code.

 5. Create a new national account customer record with a number that is identical to the new 
national account number.

 6. Transfer data from the old customer record to the new national account customer record.

Most changes have an effect only on new customer records you create and assign to the national 
account, later, with these exceptions:
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 l If you change the billing cycle or interest profile for a national account, the same change is 
automatically made to all the customer records assigned to the national account.

 l If you put a national account on hold, you see a warning message when you add invoices for 
customers assigned to the national account.

 l If you assign Inactive status to a national account, you cannot:

 l Add new customers to the national account.

 l Make changes to the customer records assigned to the national account except to change their 
national account number.

 l Add invoices and other transactions for the customers in the national account.

 l Update associated customer  records, as needed, with national account changes that are not 
also made automatically in the customer records. More...

Example: If you change the address of the national account, you must enter the new address in the 
associated customer records if you use the national account address as the billing address for the 
customers. If you change the territory code, account type, credit bureau information, or choice for 
the Print Statements option in a national account, you may also need to make the same changes in 
the customer records.

Adding, Modifying, and Deleting National Accounts

If you use National Accounts Management, you can add, edit, and delete national account records.

For an overview of national accounts, see "About National Accounts" (page 66).

Before You Start

 l Determine the customer group to which to assign the national account.

 l Print the National Accounts report, including the information you plan to change for each account 
you want to modify or delete.                         

For more information, see "Printing the A/R National Accounts Report" (page 304).

 l If you plan to edit national account statistics, select the Allow Edit Of Customer Statistics option 
on the A/R Options screen.

 l Print the statistics report for the national account, depending on the type of statistics you want to 
change.

For more information, see "Printing A/R Period Statistics Reports" (page 305) or "Printing Activity Statistics 

Reports" (page 282).
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 l If you plan to reduce a credit limit for a national account, ensure that none of the customers 
assigned to the account has a credit limit that is higher than the new limit for the national account.

 l If you plan to delete a national account to which customers are assigned, you assign the 
customers to other national accounts or delete the customer records. You cannot delete a national 
account that has customers assigned to it.

To add a national account:

 1. Open Accounts Receivable > A/R Customers > National Accounts.

 2. Click the New  button beside the National Account Number field.

 3. Type the code for the new national account, then press Tab.

 4. Complete the fields on each tab.

 5. When ready, click Add to add the national account.                 

Tip: To define a new national account that uses some of the information entered in the record for 
another national account, display the record for the group you want to copy, type the new national 
account number, and then press the Tab key. Enter any changes you need, then click Add to add the 
new national account.

To edit a national account record:

 1. Open Accounts Receivable > A/R Customers > National Accounts.

 2. Type the code for the national account you want to edit, select it from the Finder, or use the 
navigation buttons to display the code you need.

 3. Make the changes you need in the record.

 4. When finished, click Save to record your changes.

To delete a national account record:

 1. Open Accounts Receivable > A/R Customers > National Accounts.

 2. Type the code for the national account you want to delete, select it from the Finder, or use the 
navigation buttons to display the code you need.

 3. Click the Delete button.

 4. If a message appears asking you to confirm your intention to delete the record, click Yes.
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After adding or modifying national account records

 l Print the National Accounts report, including types of information you changed. Check the report 
to be sure you have made all the changes you require, and then file it.       

For more information, see "Printing the A/R National Accounts Report" (page 304).

Setting Up Multiple Contacts for Customers and National Accounts

If you use the Multiple Contacts (M/T) program, you can set up multiple contacts for a customer or 
national account, and specify which types of document to send to each contact.

Documents are sent to contacts by email.

Important! If you are setting up multiple contacts for the first time, check that your email settings are 
correct on the Company Profile screen in Common Services.

To assign contacts to a customer or national account:

 1. Open Accounts Receivable > A/R Customers > Customers or National Accounts.

 2. In the Customer Number or National Account Number field, specify the customer or national 
account to which you want to assign contacts.

 3. On the Contact tab, in the Multiple Contacts section, assign contacts in the following ways:

 l Assign an existing contact:

 a. Click in the table and then press Insert.

 b. In the Contact Code field, enter the code for the contact.

 l Create and assign a new contact:

 a. Click Create New Contact.

The Contacts screen appears.

 b. Enter information for the new contact.

 c. Click Add, and then close the Contacts screen.

The new contact is saved and is assigned to the customer or national account.

 4. Specify the types of document to send to each contact by double-clicking the document type fields. 
For example, if you double-click the A/R Invoices field, an X appears in the field indicating that A/R 
Invoices will be sent to the contact.

Tip: Use the Show Documents For field to filter the types of document that are shown in the table.

 5. Click Save.
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To edit or view details for a contact:

 1. Open Accounts Receivable > A/R Customers > Customers or National Accounts.

 2. In the Customer Number or National Account Number field, specify a customer or national 
account.

 3. On the Contact tab, in the Multiple Contacts section:

 a. Select a contact in the table, and then click View Contact Details.

The Contacts screen appears.

 b. If you change information for the contact, click Save.

Customers
You must add customer records before you can enter and process transactions in Accounts Receivable.

About Accounts Receivable Customers

When you set up Accounts Receivable, you must transfer all of your existing customer information to 
Sage 300.

General Customer Information

You use the Customers screen to transfer most of your customer information to Accounts Receivable, 
and to maintain information about your customers after setup. More...

You can record background information for the customer, such as:

 l The customer number (the code you use to identify the account).

For more information, see "About Customer Numbers" (page 76).

 l The customer's name, billing address, and phone numbers.

 l An optional "short name," an abbreviation or acronym that represents the customer.

For more information, see "About Short Names" (page 77).

 l Credit information, including a credit rating and a credit limit. 

For more information, see "About Customer Credit Information and Credit Limits" (page 81).

 l The names of the salespeople assigned to the account, and the percentage of the customer's 
transactions you allocate to each salesperson.
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 l A delivery method to use for sending invoices, statements, receipt confirmations, and letters to the 
customer. (If you choose Customer as the Delivery Method when printing invoices, statements, 
and letters, the program uses the delivery method specified in the customer record.)

 l The shipping details (FOB point and ship via details) for the customer. 

For more information, see "A/R Customers Screen" (page 376).

 l Comments, instructions, or other information you want to print on correspondence with the 
customer, display during transaction entry, or keep for other purposes. 

For more information, see "About Customer Comments" (page 79).

 l The date on which you started to do business with the customer.

 l Whether you print statements for the customer when the account is overdue.

 l If you use Sage 300 Transaction Analysis and Optional Field Creator, any additional information 
your company wants to include in optional fields you set up for use with customer records.

Any customer optional fields set up for automatic insertion appear automatically, along with their default 
values, on the Optional Fields tab of new customer records.

For more information, see "About Customer Optional Fields" (page 80)

 l The customer group and national account, if any, to which the customer belongs.

Transaction Processing Information

You also use the Customers screen to identify the ways in which you process transactions for each 
customer. More...

Processing information includes the following:

 l Account type (balance forward or open item). This choice indicates whether you apply receipts 
to the account balance, or treat each transaction as a unique document, and apply receipts to 
specific document numbers.

For more information, see "About Customer Account Types" (page 78).

 l Account set. The account set is the group of general ledger accounts to which the customer's 
transactions are distributed. Each set includes accounts for receivables control, receipt discounts, 
prepayment liability, and write-offs.

If you use multicurrency accounting, the account set also includes unrealized and realized exchange 
gain and loss accounts.

 l Payment terms. You specify a code for the terms you usually allow the customer. Accounts Receivable 
uses terms information to determine the default due date, discount period, and discount amount to 
display when you enter invoices for the customer.
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For more information, see "About Customer Tax Information" (page 79).

 l Interest profile. You specify the method used to calculate the amount of interest to charge when 
the customer's account is overdue. 

For more information, see "About Interest Profiles" (page 32).

 l If you use Payment Processing, you can specify the credit cards you will use to process credit card 
transactions for the customer in Paya.

For more information, see "Adding, Editing, or Deleting a Credit Card for a Customer" (page 89).

 l Tax group, tax authority, tax class, and registration number. If the customer is subject to tax, this 
information tells Accounts Receivable how to calculate tax amounts on the customer's invoices.

For more information, see "About Customer Tax Information" (page 79).

Keeping and Editing Customer Statistics

In addition to the information you enter for each customer, Accounts Receivable automatically adds the 
statistics it collects from all transactions posted to each customer account.

If you use the Allow Edit Of (customer) Statistics option on the A/R Options screen, you can also enter 
these figures when you are setting up a new Accounts Receivable system, and revise them as needed.

For more information, see "About Customer Statistics" (page 82).

Placing a Customer Account On Hold

You can place a customer account on hold when you want to suspend the account temporarily.

Accounts Receivable warns you when you start to enter an invoice for a customer whose account is on 
hold. You can then choose whether to continue entering the invoice.

You can always enter and post invoices, credit notes, debit notes, payments, and prepayments, whether 
a customer account is on hold or not. However, Accounts Receivable does not process recurring charges 
for customers whose records are on hold.

If you place a national account on hold, you also see a warning when you enter an invoice for a customer 
in the national account.

You can place individual customers in a national account on hold, without placing the entire national 
account on hold.

Assigning Inactive Status

You can mark a customer account as inactive by selecting the Inactive option in the customer record.
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Note: You can assign this status to a customer only when the account has a zero balance and no 
outstanding transactions.

When a customer account is inactive, you cannot post further transactions to the account, but you can 
retain the account in your Accounts Receivable system for as long as you need to keep it. When you are 
ready to remove the account, you can use the Delete Inactive Records screen or the Customers screen 
to delete the account.

You can assign Inactive status to member customers in a national account without making the entire 
national account inactive. If a national account is inactive, however, all of its customers are inactive as 
well, and you cannot post transactions to any of the accounts or make changes to customer records in the 
national account.

Using Multiple Addresses for a Customer

If you need to keep more than one address for a customer, such as when you send the customer's orders 
to more than one location, you can define as many additional addresses as you need using the Ship-To 
Locations screen.

You can also designate a primary ship-to location to use as the default when you set up recurring charges 
or create invoices for the customer. Order Entry (if you use it) also uses these details as defaults when 
you create an order for the customer. 

For more information, see "About Ship-To Locations" (page 98)

Creating Records to Invoice Recurring Charges

If you regularly invoice the customer for the same order, such as monthly rent, you can create recurring 
charge records, using the Recurring Charge Setup folder.

For more information, see "About Recurring Charges" (page 93).)

Importing Customer Records

You can import customer records into Accounts Receivable from non-Sage 300 programs, instead of 
entering them in the Customers screen. 

For information, see "About Importing and Exporting Accounts Receivable Records" (page 271).

About Customer Numbers

You use the Customers screen to add customer records. For each new record   you assign a unique 
customer number, up to 12 characters, including letters,   numbers, and symbols. You may be able to 
continue with your present system   of assigning customer numbers. 
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If you do not have a logical method of assigning customer numbers, you   should develop a system before 
you add your customer records to Accounts   Receivable. Your system should let you organize the records 
as you require,   such as alphabetically, by region, and for reporting purposes. The system   should also 
allow for expansion as your business grows. 

If you use national accounts, you should also consider using some portion   of the national account code to 
begin the customer numbers that belong   to the national account. 

For information about assigning customer numbers, see "About Accounts Receivable Coding Schemes" 
(page 19).

About Short Names

You can enter a code or "short name" of up to ten characters for each customer. Short names are a 
means by which you can list customers in alphabetical order or another order on reports, and still include 
the full customer name in the customer record.

Example: 
Assume you have the following four customers. When listed alphabetically, the names appear in this 
order:

 l A. Carson & Co.

 l Bashaw Bulldozing

 l Mr. Stephen Kershaw

 l The Garden Restaurant

If you assign a short name that uses up to the first ten letters of the name by which you want to list the 
accounts, they appear in this order:

Customer Name Short Name

Bashaw Bulldozing BASHAW

A. Carson & Co. CARSON

The Garden Restaurant GARDEN

Mr. Stephen Kershaw KERSHAW

You can also leave spaces, assigning "Craig & Co" as a short name, for example.

When you add a customer record, Accounts Receivable automatically inserts the first ten characters of 
the customer name as the default short name for the record, but you can enter any short name you want 
to use, or not use a short name at all.
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You can print short names on customer statements. You can also use them for a purpose that is 
unrelated to customer names. 

If you designed your customer numbers so that they list customers in alphabetical order (or in another 
order that meets your requirements), you might prefer not to use short names.

About Customer Account Types

Accounts Receivable maintains two types of customer accounts:   

 l Open item

 l Balance forward

You assign an account type for each customer group you define. The selected account type becomes the 
default account type for the customers and national accounts you assign to the group.

You can select a different account type in a customer record, unless the customer is assigned to a 
national account. (You cannot change the account type for members of national accounts.)

Open Item Account Type

In open-item accounts, every customer transaction is kept as a unique current balance and document 
number. Generally, you apply receipts, credit notes, and debit notes to specific outstanding invoices, or 
as prepayments to future invoices. If any amount of a receipt or credit note transaction is unapplied after 
the transaction is posted, you can apply the amount to other transactions for the same customer.

If you enter entire receipts, credit notes, or debit notes on account (without invoice numbers) for open-
item customers, you also later apply the amounts to outstanding customer transactions.

Statements for open-item customers show all outstanding transactions in the account and the opening 
balances net as of the statement date.

Charging Interest

For open-item accounts, you can charge interest on overdue documents or on overdue account 
balances.

Printing Statements

Statements printed for open-item accounts show all outstanding transactions for all periods.

Balance Forward Account Type

With balance-forward accounts, you generally apply receipts, credit notes, and debit notes to the oldest 
customer transactions, in order of transaction date, rather than to specific invoices or other documents.
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If you want to apply a receipt, credit note, or debit note to a specific invoice, you can do so by entering the 
invoice number with the transaction. Accounts Receivable then applies the amount to that invoice, and if 
any excess remains, it is applied to the next oldest customer transaction, regardless of type.

Statements for balance-forward customers show a balance brought forward from previous periods, the 
transactions posted in the current period, and the outstanding balance in each aging period.

Charging Interest

For balance-forward accounts, you can charge interest only on overdue account balances.

Printing Statements

Statements for balance-forward accounts show a total balance forward from previous periods, the 
transactions posted in the current period, and the outstanding balance in each aging period.

About Customer Tax Information

If you charge taxes on sales to customers, you enter all the necessary tax information in the customer 
record. Accounts Receivable automatically calculates all applicable taxes when you enter transactions 
for the customer.

When you specify tax information on the Customers screen, you first select the tax group that includes 
the taxing authorities, classes, and rates that apply in the customer's geographical area.

Then, you select the tax class for each authority that indicates the type of sales on which the authority 
charges tax to the customer.

If the customer has a tax-exemption number or a registration number, such as for the Canadian Goods 
and Services Tax (GST), you also enter it for the corresponding tax class. You can print this number on 
invoices and statements for the customer.

Note: You set up tax groups and other tax information using the Tax Services screens in Common 
Services.)

About Customer Comments

You can enter any number of comments in a customer record.

The text for each comment can be up to 2,500 characters long. For example, you might enter a comment 
about a customer complaint that is being investigated, or about a missing payment. 

When you enter a comment, you can specify a date to follow up on the comment, and take any action that 
is required.
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You can also assign an expiration date for each comment. Accounts Receivable deletes comments 
whose expiration date has passed when you use the Clear History screen to clear comments for the 
customer number.

Tip: To view or edit a comment in a separate screen where you can see the entire comment without 
scrolling, select the comment, and then click the Comment column heading.

Clearing Comments

To make sure that comments are kept current, you assign a number of days for which you will retain 
comments in Accounts Receivable.

When you enter a comment, Accounts Receivable adds this number of days to the comment date, and 
calculates an expiration date.

You use the Default Number Of Days To Keep Comments option on the Customer tab of the 
A/R Options screen to specify the number of days.

When you delete comments using the Clear History screen, comments that have been kept past the 
expiration date are deleted, saving you from having to delete each comment individually from the 
customer records.

Printing Comments

You can print comments on the Customers report.

When you select the Comments option for the report, you can specify a range of follow-up dates for 
which to print comments.

About Customer Optional Fields

When you add a new customer record, optional fields that are set up for automatic insertion in customer 
group, national account, and customer records appear automatically on the Optional Fields tab, along 
with their default values, as follows:

 l If the customer belongs to a national account, and if the optional fields match those used by the 
national account, the values from the national account record appear as defaults.

 l If the customer does not belong to a national account, and if the optional fields match those 
used by the customer group, values from the customer group record appear as defaults.

You can accept the optional fields that appear or you can make the following changes:

 l Delete optional fields.

 l Assign additional optional fields that you have defined for customers, national accounts, and 
customer groups.
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 l Change any default values that appear in the optional fields. More...

You can change the default value that appears for an optional field, as follows:

 l If the optional field is validated, you must specify a value that is defined for the optional field 
in Common Services.     

Note: If the optional field allows blanks, you can leave the value field blank.

 l If the optional field is not validated, you can enter any value that is consistent with the type 
of field (such as yes/no, text, number, date, or amount), providing the value you enter does 
not exceed the length permitted for the field. You can also leave the field blank.

Note: When you specify a value that is defined in Common Services, the description for the value is 
also displayed.

About Customer Credit Information and Credit Limits

You can enter credit information for each customer   record, including the number and rating assigned to 
the customer by a   credit bureau, and a credit limit for the account.

Assigning a Credit Limit to Customer Accounts

Before you assign credit limits to customers, you assign a credit limit for each customer group. This limit   
appears as the default limit for new customers you add to the group.

Editing Credit Information for Customers

If you select the Allow Edit Of Credit Check option for the customer group,   you can enter any credit limit 
you want for the customers in the group.   

If you do not select this option for the customer   group, each national account and customer assigned to 
the group automatically   uses the limit for the group, and you cannot change the amount in individual   
customer records.

Using Credit Limits during Transaction Entry

If a customer's account has exceeded its credit limit, Accounts Receivable   warns you when you begin 
entering a new invoice or debit note for the   customer. You can then choose whether to continue entering 
the transaction.   If you decide to enter it, you can also post it.

Accounts Receivable also warns you when the balance owing for the customer's   national account has 
exceeded its limit, and when you are entering a transaction   that will place the balance for either the 
customer or the national account   over its limit. You can also choose to post the transaction in these 
cases.
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If you create a recurring charge invoice that places a customer or a   national account over its limit, 
Accounts Receivable warns you on the   batch listing you print for the recurring charge batch. You must 
then   choose whether to post the charge or delete it from the batch.

Including Pending Transactions in Credit Checks

You can include transactions from unposted batches when Accounts Receivable   calculates outstanding 
balances for credit checks.

If   you want to include pending transactions from Accounts Receivable,   Order Entry, or third-party 
programs, you must select the   options to include them on the Processing tab of the A/R   Options screen.

About Customer Statistics

Accounts Receivable tracks or calculates the following statistics for each customer, and displays them on 
the Statistics tab of the Customers screen:

 l The amount and number of invoices, receipts, discounts, credit notes, debit notes, adjustments, 
write-offs, interest charges, returned checks, and paid invoices.

 l The total invoices paid, the total days to pay and average days-to-pay figures for the customer.

 l The year-to-date total days to pay and average days to pay.

Note: You can view these statistics by the type of year (fiscal or calendar) and length of period 
specified on the A/R Options screen for customer statistics.

It also displays the following figures for the customer account on the Activity tab:

 l The outstanding balance and outstanding retainage, and the number of open invoices for the 
customer's account.

 l The balance and the date of the last customer statement.

 l The year-to-date amounts and the dates of the highest balance and largest invoice in the current 
and previous years.

 l The amount and date of the last invoice, receipt, credit note, debit note, adjustment, write-off 
transaction, interest charge, returned check, discount, refund, and revaluation processed for the 
customer.

 l The total invoices paid, the total days to pay, and the average days-to-pay.

Editing Customer Statistics

You can edit the statistics in a customer record if the Allow Edit Of (customer) Statistics option is 
selected on the A/R Options screen.
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Note: You cannot change the outstanding balance, outstanding retainage, number of open invoices, 
last statement balance, or last statement date for the account, regardless of the selection for this 
option.

Accumulating Tax Amounts in Statistics

The totals Accounts Receivable keeps for invoices, credit notes, and debit notes can include or exclude 
tax amounts posted with documents, depending on the selection for the Include Tax In (customer) 
Statistics option on the A/R Options screen.

About Customer Credit Cards

General information about a credit card is stored in the Accounts Receivable customer record. This 
information includes the card ID, description, currency, billing information, comments, and whether or not 
the card is the default for the customer.

Credit card details (card number and expiration date) are not stored in the Accounts Receivable customer 
record. 

System Requirements for Adding Credit Cards

Your system must meet the following requirements before you can use this screen to add credit cards:

 l Payment Processing must be installed, activated, and configured to use a Paya merchant account. 

 l Sage Exchange must be installed and running on the workstation you will use to enter the credit 
card information.

 l You must have an active Internet connection.

For information about Payment Processing, Sage Exchange, and Paya, see the Payment Processing 
help.

About Storing Credit Card Information

General information about a credit card is stored in the Accounts Receivable customer record. This 
information includes the card ID, description, processing code, billing information, currency, comments, 
and whether or not the card should be the default for the customer.

Credit card details (card number and expiration date) are not stored in the Accounts Receivable customer 
record. To add or edit these details, you click the Add Card Details or Edit Card Details button on the 
Credit Card Information screen, and then enter the information on the Paya browser form. The 
information is stored in an online "vault" managed by Paya, and is not saved in your company database.
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Note: You can use a saved credit card for a transaction only if the processing code for the card 
matches the processing code for the transaction. For more information about processing codes, see 
the Payment Processing help.

Warning! 
Do not record any card details in the Comments field, including card number, expiration date, and CVV 
number. Storing details in this way can compromise credit card security and may constitute a violation 
of the Payment Card Industry Data Security Standard (PCI DSS). 

If a security breach occurs, merchants that do not comply with PCI DSS may be subject to fines, card 
replacement costs, forensic audits, and other penalties. 

Setting Up Multiple Contacts for Customers and National Accounts

If you use the Multiple Contacts (M/T) program, you can set up multiple contacts for a customer or 
national account, and specify which types of document to send to each contact.

Documents are sent to contacts by email.

Important! If you are setting up multiple contacts for the first time, check that your email settings are 
correct on the Company Profile screen in Common Services.

To assign contacts to a customer or national account:

 1. Open Accounts Receivable > A/R Customers > Customers or National Accounts.

 2. In the Customer Number or National Account Number field, specify the customer or national 
account to which you want to assign contacts.

 3. On the Contact tab, in the Multiple Contacts section, assign contacts in the following ways:

 l Assign an existing contact:

 a. Click in the table and then press Insert.

 b. In the Contact Code field, enter the code for the contact.

 l Create and assign a new contact:

 a. Click Create New Contact.

The Contacts screen appears.

 b. Enter information for the new contact.

 c. Click Add, and then close the Contacts screen.

The new contact is saved and is assigned to the customer or national account.
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 4. Specify the types of document to send to each contact by double-clicking the document type fields. 
For example, if you double-click the A/R Invoices field, an X appears in the field indicating that A/R 
Invoices will be sent to the contact.

Tip: Use the Show Documents For field to filter the types of document that are shown in the table.

 5. Click Save.

To edit or view details for a contact:

 1. Open Accounts Receivable > A/R Customers > Customers or National Accounts.

 2. In the Customer Number or National Account Number field, specify a customer or national 
account.

 3. On the Contact tab, in the Multiple Contacts section:

 a. Select a contact in the table, and then click View Contact Details.

The Contacts screen appears.

 b. If you change information for the contact, click Save.

Adding and Modifying Customer Records

Before You Start

 l Before adding a new customer:

 l Decide on the customer number.

 l Decide on the customer group, national account(if applicable), account set, billing cycle, 
interest profile, terms code, optional fields, and tax group to assign to the customer. More...

Customer groups provide default entries for new customer records, and can be used as 
selection and sorting criteria on various reports. You must assign a customer group to every 
customer record before you can add the record.

If you installed National Accounts Management, you can create national accounts. You must 
create the national account before creating the branch office customer records.

National accounts let you invoice and accept payments from branch offices or the head office of 
multi-branch companies. National accounts specify some entries for associated customer 
records, provide some default entries for new customer records, and can be used as selection 
and sorting criteria on various reports.

If you use multicurrency, you must assign an account set that uses the customer’s currency.
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 l If you use multicurrency accounting, determine the rate type to use if the customer does not 
use the functional currency.

 l Before editing a customer record, note that:

 l You cannot change the customer number. More...

To assign a different number to a customer account, you must:

 1. Create a new customer record.

 2. Post transactions to reduce the balance in the old customer account to zero and 
transfer outstanding and historical invoice and payment information from the old 
account to the new account, customer group, and national account, if any.

 3. Delete the old customer record.

 l You can change the customer name at any time, but you must include a name in each 
customer record.

 l You can change most of the information in a customer record at any time, with these 
restrictions:

 l You cannot edit a customer record if the customer’s group or national account is 
inactive.

 l If you need to change the billing cycle or interest profile, you must change it for the 
national account, using the National Accounts screen. The change affects all the 
customer records that are assigned to the national account.

 l You can change the customer group. When you change the customer group, Accounts 
Receivable preserves the existing entries in the customer record. It does not overwrite any 
other fields. 

Note: You cannot reassign a customer to a customer group that has Inactive status.

 l If you change the account set, statistics for the affected customer groups and national accounts 
will no longer balance. You can edit the statistics to correct the information, but it can be a 
difficult task.

Important! We recommend that you do not change the customer group or account set 
assigned to a customer record to which you have posted transactions. If you make the 
change, you may need to post adjustments to your general ledger for transactions such as 
invoices that were posted to the original account set and payments to the invoices that were 
posted to the new account set.

 l If you have unpaid posted transactions for the customer, you can change the tax group 
assigned to a customer only to another tax group that uses the same currency.
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 l You can remove the national account number from a customer record if the customer’s 
account balance is zero.

 l You can also assign the customer to a different national account, with these restrictions:

 l The customer’s account balance must be zero.

 l You cannot assign a customer to a national account that has Inactive status.

 l If you use multicurrency accounting, you can change a customer’s national account 
only to another national account that uses the same currency as the customer if you 
have posted transactions for the customer.

When you change the national account for a customer, Accounts Receivable overwrites the 
Account Type, Billing Cycle, and Interest Profile fields, which must be identical to those of the 
national account.

 l If you plan to edit customer statistics, you must select the Allow Edit Of (customer) 
Statistics option on the A/R Options screen.

Note: You cannot delete a customer record, or set it inactive, if it has unposted transactions

To add a new customer:

 1. Open Accounts Receivable > A/R Customers > Customers.

 2. Click the New  button beside the Customer Number field.

 3. In the Customer Number field, type the code for the new customer.

 4. Complete the fields on the customer record.

 5. Click Add to add the new customer.

 6. To add another record, repeat steps 2 through 5 to enter information for the new record.     

Tips: 
 l If you want to reuse the information you entered for the previous group, simply type the 

code for the new customer group in the Group Code field, then press the Tab key.

 l If you want to add customer group that uses information from another customer record, 
display the record you want to copy, type the new customer group code, and then press 
the Tab key. Enter any changes you need, then click Add to add the new customer.

To edit or view an existing customer record:

 1. Open Accounts Receivable > A/R Customers > Customers.

 2. In the Customer Number field, type the code for the customer record you want to edit, select it 
from the Finder, or use the navigation buttons to display the code you need.
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 3. Make the changes you need in the record.

Note: If you use Sage CRM integrated with Sage 300, if you change the customer contact name (on 
the Contact tab) you can indicate whether and how to update information in Sage CRM.

 4. When finished, click Save to record your changes.

To delete a customer record:

 1. Open Accounts Receivable > A/R Customers > Customers.

 2. In the Customer Number field, type the code for the customer you want to delete, select it from the 
Finder, or use the navigation buttons to display the code you need.

 3. Click the Delete button.

 4. If a message appears asking you to confirm the deletion, click Yes.

After adding, editing, or deleting customer records

 l Print the A/R Customers report. For more information, see "Printing the A/R Customers Report" 
(page 285).

Changing a Customer's Credit Limit

Before You Start

 l Check the Credit tab on   Customer Groups screen to ensure that the customer group lets you edit 
credit   limits for individual customers. 

 l Decide on the amount of   credit you want to extend to the customer, and whether you want to issue   
warnings if posting a transaction would exceed the credit limit or overdue   limit.

To change the credit limit for a customer:

 1. Open Accounts Receivable > A/R Customers > Customers.

 2. Click the Processing tab.

 3. To change the amount of   credit you extend to the customer, in the Issue Credit Warning When section:

 a. Select the Total Outstanding Balance Exceeds the   Credit Limit Of   option, if it is not 
already selected, and then press the Tab key.

 b. In the amount field,   type the new credit limit.

 4. To change the limits for   overdue transactions, in the Issue Credit Warning When section:      
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 a. Select the A/R Transactions Overdue By option, if it is not already selected, and then press 
the Tab   key.

 b. In the Days or More field, type the number of days by which the customer's transactions   
can be overdue before a warning appears during a credit check.

 c. Press the Tab key.

 d. In the amount field, enter the total amount that transactions can be overdue before 
triggering   a warning.

 e. Click Save, and then click Close.

Tip: You can change the credit limits for a national account in a similar fashion. Display   the national 
account record, and then follow the same steps as for changing a customer's   credit limits.

Adding a Multicurrency Customer

When adding a multicurrency customer, you follow the procedure described in "Adding and Modifying 
Customer Records" (page 85), with some additional conditions, as noted in this topic.

Before You Start

 l Because the account set you assign to a customer record determines the customer's currency, 
you must create an account set for each of the currencies that your customers use.

 l Make sure that interest profiles use the   same currencies as the customers to which you will assign 
the interest profiles.

To add a customer who uses a different currency:

 1. Open Accounts Receivable > A/R Customers > Customers.

 2. Click the New  button beside the Customer Number field.

 3. In the Customer Number   field, type the code for the new customer.

 4. Complete the fields on   the customer record, as usual.

Important! If   you use multicurrency, be sure to choose an account set that uses the   customer's 
currency.

 5. Click Add to add the new   customer.

Adding, Editing, or Deleting a Credit Card for a Customer

General information about a credit card is stored in the Accounts Receivable customer record. This 
information includes the card ID, description, processing code, billing information, currency, comments, 
and whether or not the card should be the default for the customer.
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Credit card details (card number and expiration date) are not stored in the Accounts Receivable customer 
record. To add or edit these details, you click the Add Card Details or Edit Card Details button on the 
Credit Card Information screen, and then enter the information on the Paya browser form. The 
information is stored in an online "vault" managed by Paya, and is not saved in your company database.

Note: You can use a saved credit card for a transaction only if the processing code for the card 
matches the processing code for the transaction. For more information about processing codes, see 
the Payment Processing help.

Before You Start

 l Payment Processing must be installed, activated, and configured to use a Paya merchant 
account. For information about Payment Processing and Paya, see Payment Processing help.

 l Sage Exchange must be installed and running on the workstation you will use to enter the credit 
card information. For information about Sage Exchange, see the Payment Processing help.

 l You must have an active Internet connection.

To add a credit card:

 1. Open Accounts Receivable > A/R Customers > Customers.

 2. Click the Credit Card tab.

Saved credit cards for the customer appear in the table on the Credit Card tab.    

 3. Click the New button.

The Credit Card Information screen appears.

 4. Set up the credit card record.

 a. In the Card ID field, type a short name for the card (for example, VISA).

 b. In the Description field, type a short description (for example, Aeroplan Visa Card).

 c. If you use multiple processing codes, specify a processing code in the Processing Code 
field. (If you use a single processing code, this field is set to read-only and displays the 
processing code.)

The bank and currency associated with the processing code appear in the Bank and Currency 
fields.

 d. If you want this card to be selected by default when you enter Paya card transactions for this 
customer, select the Use This As Default Card option.
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Note: If you use multicurrency accounting, the card is used as the default only for transactions 
where the currency for the transaction matches the currency specified for the processing code 
this card uses.     

 5. Enter billing details for the cardholder.

Tip: When entering billing details, you can select the Same as Customer Address option to fill in 
billing details with name and address information from the customer record.

 6. If you want to add comments about the card, type them in the Comments field.

Important! Do not record credit card details in this field, including card number, expiration date, and 
CVV number. Storing details in this way can compromise credit card security and may constitute a 
violation of the Payment Card Industry Data Security Standard (PCI DSS).   If a security breach 
occurs, merchants that do not comply with PCI DSS may be subject to fines, card replacement costs, 
forensic audits, and other penalties.    

 7. Enter credit card details.

 a. Click the Add Card Details button.

The Paya browser form appears.

 b. Type the card number, select the expiration date, and then click the Submit button.

Paya creates a new entry in its online "vault" system and saves the credit card details. The 
browser form closes, and credit card details appear on the Credit Card Information screen, with 
the first 12 digits of the credit card number replaced with Xs.

 8. Review the information you entered to verify that it is correct, and then click Add.

 9. Click Close to close the screen.

To edit credit card information:

 1. Open Accounts Receivable > A/R Customers > Customers.

 2. Click the Credit Card tab.

Saved credit cards for the customer appear in the table on the Credit Card tab.

 3. Select a credit card, and then click Open.

The Credit Card Information screen appears.

 4. Edit credit card information.

 l To edit general settings and billing details, make your changes on the Credit Card 
Information screen.
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 l To edit the card number or expiration date, click the Edit Card Details button, edit the 
information in the fields on the Paya browser form, and then click Submit to save your 
changes.

 5. Click Save to save your changes.

 6. Click Close to close the screen.

To delete a credit card:

 1. Open Accounts Receivable > A/R Customers > Customers.

 2. Click the Credit Card tab.

 3. Select the credit card record you want to delete, and then click Delete.

Adding or Editing a Customer Comment Using the Customer Inquiry Screen

You can use the Comments tab on the Customer Inquiry screen to enter or edit customer comments. The 
comments are automatically saved in the customer record.

Before You Start

 1. Open Accounts Receivable > A/R Customers > Customer Inquiry.

 2. In the Customer No. field, enter the customer number, and then press Tab.

 3. Click the Comments tab.

To add a new comment:

 1. Click the first blank line on the table.

 2. Double-click in the   Comment column, and then type the comment text in the Comment screen that   
appears.

 3. Click Close to return   to the Comments tab.

 l To change the comment   text, later, double-click in the Comment column, and then edit the 
comment   in the Comment screen.

 l To change the comment   type or the user ID, double-click in the Comment Type or User ID 
column,   and then use the Finder to select a different entry.

 l To change the entry in   a date field, double-click in the date column, and then type the new 
date   or use the calendar icon to select the date.

 l To delete an existing   comment, select the comment line on the table, and then press the 
Delete   key on your keyboard.
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Recurring Charges
Use the A/R Recurring Charges setup screen to create templates for the standard invoices that you send 
to customers at regular intervals, such as charges for monthly rent.

Then, you can process the recurring charges periodically, using the A/R Create Recurring Charges 
Batch, or, if you attached schedules that use reminders you can process the charges directly from the 
Reminder List.

About Recurring Charges

If you have customers to whom you issue standard invoices at regular intervals, such as charges for 
monthly rent, you can define records for the charges and customers, using the A/R Recurring Charges 
setup screen.

This section provides an overview of recurring charges and how they are used in Accounts Receivable. 

For information on the A/R Recurring Charges setup screen, see "A/R Recurring Charges Screen" (page 
425).

For information on creating invoices for recurring charges, see "A/R Create Recurring Charge Batch 
Screen" (page 473).

Recurring Charge Setup Records

You use the Recurring Charge setup screen (available in the Customers folder) to add records for the 
recurring charges you use and to assign them to customers. You can set up recurring charges only if you 
the Process Recurring Charges option is selected on the A/R Options screen.

Tip: You can enter an order number and purchase order number with each recurring charge.

Specifying When to Bill Recurring Charges

You can create charges you intend to apply indefinitely, or you can set them up to stop once you have 
billed a maximum amount or reached a certain date, or once you have generated a certain number of 
invoices.

The schedule you attach to a recurring charge record determines the invoice frequency as well as the day 
on which to bill the charge, so that the charge is invoiced only if you create a recurring charge batch on or 
after that day. 

You can also assign a billing cycle to each charge, and then invoice it at the frequency entered for the 
billing cycle.
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Scheduled Reminders

If you attach a schedule that uses a reminder, System Manager reminds specific or all Sage 300 users to 
create invoices for recurring charges when they are due.

Users can then process the recurring charges directly from the Reminder List in Common Services, 
rather than from the Create Recurring Charge Batch screen. 

For more information about using schedules and reminders, see the System Manager help.

Specifying Limits for a Recurring Charge

To limit the number of times you invoice a recurring charge, you can enter a start date and an expiration 
date for the charge. No invoices are created for the charge prior to its start date or after its expiration date.

You can also specify a maximum amount for a charge. When the maximum amount has been invoiced to 
the customer, no further invoices are created for the recurring charge.

Assigning Payment Terms to Recurring Charges

You enter a terms code for each recurring charge. The code determines the due date for recurring charge 
invoices, as well as the discount percentage and period. You can change any of this information on the 
invoice.

Allocating Recurring Charge Amounts to Salespeople

You can allocate each recurring charge invoice total to up to five salespeople, and enter the percentage 
each salesperson earns of the commission on the recurring charge amount.

Entering Shipping Information for a Recurring Charge

You can assign a ship-to location and enter the shipping method (carrier), FOB point, and any special 
instructions you want to print on the invoices. 

If you use Order Entry, you can select a ship-via code that you have set up in Order Entry, or you can 
enter a code that you maintain elsewhere. 

If you have specified a default ship via code and FOB point in the customer record, Accounts Receivable 
uses that information in the recurring charge record. However, if you have set up a primary ship-to 
location for the customer, Accounts Receivable uses the shipping details, including the ship via code and 
the FOB point, from the primary ship-to location record as the default.

Entering Details for Recurring Charges

You add recurring charge records as invoices, entering as many details as you require. You can enter 
summary details or item details.
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If you select the Calculate Tax option on the Document tab, Accounts Receivable calculates taxes, if 
any, when you create a recurring charge batch.

If you do not select Calculate Tax, you must manually enter:

 l Detail taxes on the Detail Accounts/Taxes screen.

 l Total taxes on the Document Totals screen.

When you enter taxes manually, you must ensure that the total amount you enter for the authority on the 
Document Total screen equals the sum of the detail taxes for each tax authority.

You specify for each recurring charge whether to use item details or summary details when invoices are 
created. Accounts Receivable displays the default invoice type you specified on the A/R Options screen 
as the default for new recurring charge records.

You can distribute each detail of a recurring charge to a different distribution code or general ledger 
revenue account, and you can specify how to calculate taxes for each detail.

You can enter negative details, providing the document total is not negative, and you can add recurring 
charges whose details sum to zero.

Accounts Receivable also lets you enter a comment and optional fields with each recurring charge detail.

Entering Multicurrency Recurring Charges

Because the exchange rates to be used on invoices are unknown, the only rate information you enter 
when you set up the recurring charge is the rate type (on the Document tab).

When you are ready to invoice the customers for the charges, you use the Create Recurring Charge 
Batch screen to create the invoice batch automatically.

Using Optional Fields in Recurring Charge Records

Any invoice optional fields that are set up for automatic insertion appear as defaults on the Optional 
Fields tab when you add a new recurring charge record. 

Any invoice details optional fields set up for automatic insertion appear as defaults with any details you 
add to the recurring charge record.

You can edit the optional field entries, delete them, or add different optional fields that are set up for use 
on invoices or invoice details. 

When you use the Create Recurring Charge Batch screen to process recurring charges, only the optional 
fields and values specified in the recurring charge records are used in the generated recurring charge 
invoices.
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Updating Recurring Charge Records Automatically

To save you time in maintaining your recurring charge records, Accounts Receivable lets you update your 
recurring charges automatically by a percentage or a fixed amount for a range of customers and recurring 
charge records. To update recurring charges automatically, you must select Calculate Tax in the 
recurring charge record.

You update recurring charge records automatically using the Update Recurring Charges screen in the 
Periodic Processing folder. You can update recurring charge records automatically as part of a periodic 
processing routine, or at any other time.

For more information about updating recurring charge records automatically, see "A/R Update Recurring 
Charges Screen" (page 487).

Setting Up a Recurring Charge for a Customer

If you have customers to whom you issue standard invoices at regular intervals, such as charges for 
monthly rent, you can define records for the charges and customers, using the A/R Recurring Charges 
setup screen.

Before You Start

 l Add the customer records for which you are adding recurring charges.

 l Decide on the codes to identify the recurring charges.

 l Determine the start date and expiration date for the charges, and the day of the month on which 
each recurring charge is due to be invoiced.

 l Determine the amount of each detail of the recurring charges.

To create a recurring charge:

 1. Open Accounts Receivable > A/R Customers > Recurring Charges.

For more information, see "A/R Recurring Charges Screen" (page 425).

 2. Enter or select   the recurring charge code you want to use with the new charge.

 3. Enter a description for   the charge code.

 4. Enter or select the number   of the customer to whom the charge applies.

 5. Enter a start date for   the charge, an expiration type, an expiration date (if you selected Specific   
Date as the expiration type), and a maximum amount.
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 6. On the Detail tab:

 a. In the Invoice Type field, specify whether the recurring charge will generate an   item or a 
summary-type invoice.

 b. Click the Account/Tax button.

The Detail Accounts/Taxes screen appears.

 7. Enter details on the Detail Accounts/Taxes screen, as follows:

 a. Click the New  button beside the Line Number field.

 b. Enter the distribution code, description, amount, and the revenue account for the detail.

 c. Enter or edit the tax class and (if the tax authority allows it) the Tax Included status for the 
detail.

 d. When you have finished entering information for the detail, click Add, or click Save after 
changing any information for the detail.

 e. Repeat steps 7a through 7d for each detail you want to include on invoices created for this 
recurring charge.

 f. Click Close when you have finished entering details.

 8. Fill in the remaining  fields and tabs as you would for a regular invoice.

After adding recurring charge records

Print the Recurring Charges report. For more information, see "Printing the A/R Recurring Charges Report" 
(page 307).

Adding or Modifying Recurring Charge Details Using the Detail Accounts/Taxes Screen

The Detail Accounts/Taxes screen presents all the information for a detail in a separate screen so that 
you can see all the fields without having to scroll through the screen. In addition, it displays tax 
information for a selected detail.

To add a  new detail using the Detail Accounts/Taxes screen:

 1. Open Accounts Receivable > A/R Customers > Recurring Charges.

 2. On the Detail tab:

 a. In the Invoice Type field, specify whether the recurring charge will generate an item or a 
summary-type invoice.

 b. Click the Account/Tax button.
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 3. Enter details on the Detail Accounts/Taxes screen, as follows:

 a. Click the New  button beside the Line Number field.

 b. Enter the distribution code, description, amount, and the revenue account for the detail.

 c. Enter or edit the tax class and (if the tax authority allows it) the Tax Included status for the 
detail.

 d. When you have finished entering information for the detail, click Add, or click Save to save 
changes you make after adding the detail.

 e. Repeat steps 3a through 3d for each detail you want to include on invoices created for this 
recurring charge.

 4. Click Close when you have finished entering details.

To view or edit information for an existing detail, do one of the following:

 l On the Detail tab, highlight (select) the detail, and then either click Account/Tax or press the F9 
key.

 l On the Accounts/Taxes screen, use the navigation buttons for the Line Number field to select the 
detail that you want.

After adding or updating recurring charge records

Print the Recurring Charges report. For more information, see "Printing the A/R Recurring Charges Report" 
(page 307).

Ship-To Locations
You use the A/R Ship-To Locations screen to add records for the addresses to which you ship goods to 
your   customers. 

Then, you can use the ship-to location codes on Accounts Receivable invoices, and, if you also use Sage 
300 Order Entry, on orders, shipments, and invoices you process in that program.

About Ship-To Locations

Accounts Receivable can keep an almost unlimited number of ship-to locations for your customers. 

Ship-to locations are the addresses to which customers want you to send the goods they order. You can 
designate   a particular ship-to location as the primary ship-to address for a customer.

You select a ship-to location when you enter invoices or define recurring-charge records for a customer.
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Note: Ship-to locations are used only for shipping goods. Invoices and statements are sent to the 
address entered in the customer record.

If a primary ship-to location exists for a customer:

 l Accounts Receivable uses the shipping details from the primary ship-to location record as the 
default whenever you set up a recurring charge record or create an invoice for the customer.

 l Order Entry also uses the primary ship-to location as the default when you create an order for the 
customer.

Information Stored for Ship-To Locations

You use the A/R Ship-To Locations screen to add shipping addresses for your customers. 

You assign a code to identify each address, then select the code during invoice entry to specify the 
address for the order and to display the shipping method, special instructions, and tax information 
assigned to the address.

Tip: If you use Order Entry, you can select ship-via codes that you have set up in Order Entry.

For each ship-to location, you can enter a shipping method or carrier, an FOB point, special instructions, 
and the tax group that applies at the location. These details appear as default entries when you add 
invoices for the customer and location. At that time, you can use or change the information for the 
particular invoice.

Each ship-to address can also specify the salespeople who share in transactions posted using the code 
for the ship-to address, and the percentage each salesperson receives.

Note: You cannot set a ship-to location inactive or delete it if there are unposted documents that use 
the location.

Customizing Ship-To Location Information

If you want to keep other information in your ship-to location records, you can add unlimited optional 
fields to the screen. 

You define ship-to location optional fields using the Optional Fields screen in the A/R Setup folder.

Any fields that you set up for automatic insertion in ship-to location records appear, along with their 
default values, on the Optional Fields tab of new ship-to location records that you add to your system. 

You use the Optional Fields tab to:

 l Add different ship-to location optional fields, or delete any that are automatically inserted. 

 l Change the optional field values.
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Adding, Modifying, or Deleting a Ship-To Location for a Customer

Ship-to locations are the addresses to which customers want you to send the goods they order. You can 
designate   a particular ship-to location as the primary ship-to address for a customer.

You select a ship-to location when you enter invoices or define recurring-charge records for a customer.

Before You Start

 l Identify the customer number for which to add a shipping location.

 l Decide on the code to use to identify the new ship-to location.

You can change all the information in a ship to record for a customer except the ship to code.

 l If you plan to delete a ship-to location, or set it inactive, make sure it is not used on any unposted 
documents. 

Tip: Assign different ship-to locations on the unposted documents.

To add a ship-to location:

 1. Open Accounts Receivable > A/R Customers > Ship-To Locations.

 2. In the Customer No. field, enter the customer number, and then press Tab.

 3. Click the New button.

A separate A/R Ship-To Locations screen opens, which you use to enter complete details for the new 
ship-to location record.

 4. In the Ship-To Location field, type a unique code to identify the ship-to location, and then press 
the Tab key to move to the next field.

 5. Type a description for the location.

 6. Fill out the fields on each tab.

Information from these fields are used as defaults when you specify the ship-to location code on 
invoices and recurring charge records.

Note: To designate the current ship-to location as the primary one for the customer, select the 
Primary Ship-To option on the Address tab.

 7. When you have finished, click Add.

 8. When you have finished adding ship-to locations, click Close to return to the list of ship-to 
locations, and then click Close again.
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To edit an existing ship-to location:

 1. Open Accounts Receivable > A/R Customers > Ship-To Locations.

 2. In the Customer No. field, enter the customer number, and then press Tab.

 3. Select (highlight) the ship-to location you want to edit, and then click Open.

 4. Make your changes.

Note: If you use multicurrency accounting, you can change the tax group only to a tax group that uses 
the customer’s currency.

 5. Click Save.

 6. When you have finished editing ship-to locations, click Close to return to the list of ship-to 
locations, then click Close again.

To delete a ship-to location:

 1. Open Accounts Receivable > A/R Customers > Ship-To Locations.

 2. In the Customer No. field, enter the customer number, and then press Tab.

 3. Select (highlight) the ship-to location you want to edit.

 4. Click Delete.

After adding, modifying, or deleting ship-to locations

 l Print and file the updated "Printing the A/R Ship-To Locations Report" (page 308).

Looking Up Ship-To Locations for a Customer

To display a list of ship-to locations for a customer:

 1. Open Accounts Receivable > A/R Customers > Ship-To Locations.

 2. In the Customer No. field, enter the customer number, and then press Tab.

To work with a ship-to location record from the list:

 1. Select the location from the list, then do one of the following:

 l Click Open to open the record for editing.

 l Click New to start a new ship-to location record for the customer.

 l Click Delete to delete the ship-to location record.
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 2. When you display a record, you can:     

 l Edit a different location.

Type the ship-to location code, or use the Finder to select it.

Note: You cannot set the ship-to location Inactive   or delete it if there are unposted documents 
that use the location.

 l Start a new ship-to location.       

Click the New  button beside the Ship-To Code field to start a new record.

 l Delete the location.

 a. Enter the code.

 b. Click Delete.

Skip the remaining steps in this section.

Note: You cannot delete a ship-to location if there are unposted documents that use the 
location.

 l View ship-to locations for a different customer.

Type a different customer number, or use the Finder to select it.

 3. Click the tab you want to view or edit.

 4. Click Add or Save to keep any changes you make.

 5. Click Close when you have finished.

Inquiring on Customers
Use the A/R Customer Inquiry screen as a ready reference to all the information that exists for a customer 
in your Sage 300 system.

This section provides examples of how you can use the Customer Inquiry screen to look up different 
types of information for customers.
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Showing and Hiding Tabs on the Customer Inquiry Screen

Before You Start

 1. Open Accounts Receivable > A/R Customers > Customer Inquiry.

 2. In the Customer No. field, enter the customer number, and then press Tab.

Note: 
 l If your system uses security,   you need Transaction History Inquiry authorization to view tabs 

that contain   transaction data.

 l Order Entry tabs are available   only if you are using a compatible version of Sage 300 Order 
Entry.

 l The IC Contract Pricing   tab is available if you are using a compatible version of Inventory 
Control.

To hide Customer Inquiry tabs that you do not normally use:

 1. On   the A/R Customer Inquiry screen, click Settings > Tabs.

 2. On the Tabs screen that   appears:

 a. From the Visible   Tabs list, select the name of the tab you want to hide.

 b. Click Exclude.

 c. Repeat steps a and   b for all the tabs you want to hide.

 d. Click Close to   return to the Customer Inquiry screen.

 3. To save these settings   for next time you use Customer Inquiry, click Settings > Save Settings As 
Defaults.

To display hidden tabs:

 1. On   the A/R Customer Inquiry screen, click Settings > Tabs.

 2. On the Tabs screen:

 a. From the Available  Tabs list, select the name of the tab you want to display.

 b. Click Include.

 c. Repeat steps a and   b for all the tabs you want to display.

 d. Click Close to   return to the Customer Inquiry screen.

 3. To save these settings   for next time you use Customer Inquiry, click Settings > Save Settings As 
Defaults.
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Viewing Posted Documents for a Customer

To view a list of documents posted for a customer:

 1. Open Accounts Receivable > A/R Customers > Customer Inquiry.

 2. In the Customer No. field, enter the customer number, and then press Tab.

 3. If your Accounts Receivable ledger is multicurrency, in the Amounts In field, specify whether to 
display amounts in the customer's currency or in your company's functional currency.     

Tip: When viewing amounts in the customer's currency, if it is different from your functional currency, 
you can also see the exchange rates used to convert the transactions.

 4. Click the Documents tab, and then:     

 a. In the Document Type field, select the type of documents you want to view. More...

You can display invoices, credit notes, debit notes, interest charges, receipts (including 
unapplied cash, prepayments, and miscellaneous receipts), and refunds that have been posted 
to the customer's account.

Apply document transactions and adjustments are not considered documents in Sage 300. They 
do not appear on the Documents tab, but instead:

 l Apply document transactions appear on the Receipts tab.

 l Adjustments appear on the Adjustments tab.

Documents that are not yet posted are listed on the Pending tab.

 b. In the Order By field, specify the order in which to list transactions. More...

You can list transactions in order by one of the following attributes:

 l Document Number

 l Document Date

 l Due Date

 l PO Number

 l Order Number

 l Shipment Number

 l Current Balance

If you select Order Number, PO Number, or Shipment Number in the Order By field, 
transactions that do not include an order number, PO number, or shipment number are listed:

 l In ascending document number order, before transactions that include an order 
number, PO number, or shipment number, if you display the list in ascending order.
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 l In descending document number order, after transactions that include an order 
number, PO number, or shipment number, if you display the list in descending order.

 c. Specify a starting value with which to begin the ordered list of transactions.

 d. If you want to include fully paid transactions and/or pending amounts in the display, select 
the options to include them.

 e. Click the Go  button or press F7 to display documents that match your selections.       

Tips: 
 l Click the Go button whenever you change the display options on the Documents 

tab.

 l Click the Refresh button to update the display with recent changes that you or other 
users may have entered since you selected the current customer. (The Refresh 
button is at the bottom left corner of the screen.)

 f. To view more information about a particular transaction, you select (highlight) the line in the 
top table, and then you can:       

 l Drill down to view the transaction in the original entry screen. For help, see "Drilling 
Down from Customer Inquiry to a Transaction Entry" (page 112).

 l Open the Document Inquiry screen to view all the information available for the 
document in Accounts Receivable. For help, see "Opening Document Inquiry from 
Customer Inquiry" (page 112).

 l View optional fields assigned to the transaction header by double-clicking in the 
Optional Fields column.         

Note: The Optional Fields column appears if you use Sage 300 Transaction Analysis 
and Optional Field Creator. It is available if you select a transaction that uses optional 
fields.

 l Use the middle table on the Documents tab to review distribution details for the 
document you selected. 

Double-click in the Optional Fields column on the second table to view optional fields 
assigned to a particular detail.

Note: The Optional Fields column appears if you use Transaction Analysis and Optional 
Field Creator. It is available if you select a transaction detail that uses optional fields.

 l Use the bottom table to review the adjustments, receipts, refunds, debit notes, and 
credit notes that have been applied to the document. Accounts Receivable displays 
one line of information for each applied transaction.                     
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Double-click in the Ref. Document Number column to display document history for a 
particular applied document.

Looking Up Pending Transactions for a Customer

To view a list of transactions that are pending for a customer:

 1. Open Accounts Receivable > A/R Customers > Customer Inquiry.

 2. In the Customer No. field, enter the customer number, and then press Tab.

Important! If you are looking up pending miscellaneous receipts for an unspecified customer, leave 
the Customer No. field blank.

 3. If your Accounts Receivable ledger is multicurrency, in the Amounts In field, specify whether to 
display amounts in the customer's currency or in your company's functional currency.

 4. Click the Pending   tab, and then:

 a. In the Transaction Type   field, select the type of documents you want to view.      

The Pending tab can list all types of transactions that have been   entered for customer, but which 
are not yet posted, including adjustments,   apply document transactions, and write-offs.

 b. In the Order By field, specify the order in which to list transactions. More...

You can list transactions in order by one of the following attributes:

 l Document Number

 l Transaction Date

 l PO Number

 l Order Number

 l Shipment Number

 l Check/Receipt Number

 l Transaction Type/Batch/Entry Number        

If you select Order Number, PO Number, or Shipment Number in the Order By field, 
transactions that do not include an order number, PO number, or shipment number are listed:

 l In ascending document number order, before transactions that include an order 
number, PO number, or shipment number, if you display the list in ascending order.

 l In descending document number order, after transactions that include an order 
number, PO number, or shipment number, if you display the list in descending order.
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 c. Click the Go  button, or press the F7 key, to display pending transaction that match your 

selections.

Tip: Click the Go button whenever you change the display options on this tab.

 d. Click the Refresh button to update the display with recent changes that you or other users may 
have entered since you selected the current customer. (The Refresh button is at the bottom left 
corner of the screen.)

 e. To view more information about a particular transaction, you select (highlight) the line in the top 
table, and then you can:

 i. Drill down to view the transaction in the original entry screen. See "Drilling Down from 
Customer Inquiry to a Transaction Entry" (page 112).

 ii. Open the Document Inquiry screen to view all the information available for the 
document in Accounts Receivable. See "Opening Document Inquiry from Customer 
Inquiry" (page 112).

 f. Use the table at the bottom the Pending tab to review distribution details for the document 
you selected.

Checking a Customer's Credit Status

To check credit information for a customer:

 1. Open Accounts Receivable > A/R Customers > Customer Inquiry.

 2. In the Customer No. field, enter the customer number, and then press Tab.

 3. In the Customer   No. field, type the customer number or select the customer using the Finder ,   
and then press Tab.

 4. In the Amounts In field,   select the currency in which to display figures. You can choose Customer 
Currency or Functional   Currency. 

You can view amounts in the other currency at any time   by selecting the currency from the Amounts In 
field.

 5. Click the Credit Status   tab.

The information that appears on the Credit Status screen   varies according to:

 l The credit checking   options specified for the customer in the customer record.

 l The credit checking   options specified for the national account in the national account record.

 l Whether any pending   transactions are included in the credit check process.

 6. To check credit   bureau information or to check whether the program will display credit   warnings for 
the customer under certain conditions, click the Tax/Sales   tab.
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Looking Up Customer Receipt Activity

To look up receipts posted for a customer:

 1. Open Accounts Receivable > A/R Customers > Customer Inquiry.

 2. In the Customer No. field, enter the customer number, and then press Tab.

 3. Click the Receipts tab, and then:      

 a. Specify the status of the receipts you want to view.

 b. In the Order By Field, specify whether you want to list receipts by receipt date or by receipt 
number.

 c. Click the arrow  button beside the Order By field to change the display from ascending to 
descending order, or from descending to ascending order.

 d. In the Starting Value field, specify the date or the receipt number with which to begin the 
list, or leave the field blank to include all the receipts that have the specified status. 

The receipts are listed in the top table on the tab. To scroll through the columns, click an arrow at 
one of the lower corners of the screen, or press the Tab key to move from column to column.

 e. Click the Go  button, or press the F7 key on your keyboard.         

Accounts Receivable lists the receipts in the top table on the tab.

 l To scroll through the columns, click an arrow at one of the lower corners of the table, 
or press the Tab key to move from column to column.

 l If you want to display a receipt on the A/R Receipt Entry screen, double-click the 
Check/Receipt No. column in the receipt line.

You can also open the Document Inquiry screen to view all the information available for the 
document in Accounts Receivable. See "Opening Document Inquiry from Customer Inquiry" (page 

112).

 f. To see the documents applied to a particular receipt, select the receipt in the top table.        

Accounts Receivable displays all the documents applied to the receipt in the second table.

Tip: If you change any options on this tab, click the Go  button to update the display.

Viewing a Miscellaneous Receipt for a Non-Accounts-Receivable Customer

Accounts Receivable lets you record the receipt of money that you receive   from occasional customers, 
employees, and others for whom your company   does not maintain a record in Accounts Receivable. You 
process these transactions as miscellaneous receipts, with a blank   customer number.
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To view a miscellaneous receipt for an unspecified customer:

 1. Open Accounts Receivable > A/R Customers > Customer Inquiry.

 2. If there is an   entry in the Customer No. field, select the code, and then press the Delete   key.

 3. Press the Tab key.

 4. In the Amounts In field,   select the currency in which to display figures. 

You can choose Bank Currency   or Functional Currency.

 5. Click the Receipts tab   to see all miscellaneous receipts posted for unspecified customers. 

 6. Click the Pending tab   to see miscellaneous receipts that are not yet posted for these customers.

Looking Up Refund Activity for a Customer

To look up refund activity for a customer:

 1. Open Accounts Receivable > A/R Customers > Customer Inquiry.

 2. In the Customer No. field, enter the customer number, and then press Tab.

 3. Click the Refunds   tab.

 4. In the Refund Status area,   select the reconciliation status of the refunds you want to view.

 5. In the Payment Type area,   select the types of payments used to issue the refunds. 

 6. Click the arrow  button beside the Order By Document No. field if you want to change the list   
order from ascending to descending, or from descending to ascending.

 7. If you selected Check   as the payment type, in the Starting Check No. field, specify a check   
number to start the list of refunds, or accept the default entry to display   all check refunds.

 8. Click the Go  button to display refunds using the selections   you made. 

The program lists the refunds in the top table on the   tab.

 l To scroll through   the columns, click an arrow at one of the lower corners of the table, or   press 
the Tab key to move from column to column.

 l If you want to display   a refund on the A/R Refund Entry screen, where you can view the 
information   that was entered with the posted refund, select the refund line on the   table, and 
then click the Batch/Entry No. column heading.

 l You can also view the refund in the Document Inquiry screen. For more information, see 
"Opening Document Inquiry from Customer Inquiry" (page 112).

 l To see the documents to   which a particular refund was applied, select the refund in the top 
table.

The program displays the applied documents for the   refund in the second table.
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Tip: If you change   any options on this tab, click the Go  button to update the display.

Looking Up Credit Card Information for a Customer

General information about a credit card is stored in the Accounts Receivable customer record. This 
information includes the card ID, description, processing code, billing information, currency, comments, 
and whether or not the card should be the default for the customer.

Credit card details (card number and expiration date) are not stored in the Accounts Receivable customer 
record. To add or edit these details, you click the Add Card Details or Edit Card Details button on the 
Credit Card Information screen, and then enter the information on the Paya browser form. The 
information is stored in an online "vault" managed by Paya, and is not saved in your company database.

Note: You can use a saved credit card for a transaction only if the processing code for the card 
matches the processing code for the transaction. For more information about processing codes, see 
the Payment Processing help.

To look up credit card information for a customer:

 1. Open Accounts Receivable > A/R Customers > Customers.

 2. Click the Credit Card tab.

Saved credit cards for the customer appear in the table on the Credit Card tab.    

After looking up credit card information

 l "Adding, Editing, or Deleting a Credit Card for a Customer" (page 89).                     

Looking Up Account Activity or Period Statistics for a Customer

Before You Start

 1. Open Accounts Receivable > A/R Customers > Customer Inquiry.

 2. In the Customer No. field, enter the customer number, and then press Tab.

 3. Click the Comments tab.

To look up account activity or period statistics   for a customer:

 1. In the Amounts In field,   select the currency in which to display figures. You can choose Customer 
Currency or Functional   Currency. 
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You can view amounts in the other currency at any time   by selecting the currency from the Amounts In 
field.

 2. Click the Activity/Stats   tab.

 3. The top table on the   tab displays account activity for the current year and for the previous   (last) 
year.

 4. The bottom table displays   transaction statistics for the year and period that you specify.

Looking up a Returned Customer Check

When customer payments are reversed in Bank Services, that program sends   information about the 
reversal to Bank Services.

The Customer Inquiry screen in Accounts Receivable   lets you look up information for customer checks 
that have   been reversed in Bank Services.

To look up returned customer checks you have processed in Bank Services:

 1. Open Accounts Receivable > A/R Customers > Customer Inquiry.

 2. In the Customer No. field, enter the customer number, and then press Tab.

 3. If you have a multicurrency   system, in the Amounts In field, specify whether to display the 
information   in your company’s functional currency or in the customer’s currency.

 4. Click the Receipts   tab.

 5. In the Receipt Status   area, select Returned to display returned checks.

 6. In the Order By field,   specify whether to list documents in receipt date order or receipt number   
order.

 7. Click the Go  button.

If you use multicurrency accounting, the program displays   the amount in the bank currency and, 
depending on your selection for the   Amounts In option, it also displays the receipt amount in either your   
functional currency or the customer's currency.

Note: 
When you post a check reversal in Bank Services (for example, for an   NSF check), Accounts 
Receivable automatically enters the amount and number   of returned checks in the activity statistics 
kept with the customer record.

It can also reinstate the corresponding invoice or debit note in the   customer’s account. To make sure 
invoices and debit notes are still available   to reinstate when checks are returned, you cannot clear paid 
invoices   from Accounts Receivable for 45 days after you clear the checks that paid   them in Bank 
Services.
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Opening Document Inquiry from Customer Inquiry

If you have not already opened the Customer Inquiry screen:         

 1. Open Accounts Receivable > A/R Customers > Customer Inquiry.

 2. In the Customer No. field, enter the customer number, and then press Tab.

 3. Display the transaction   of interest on the Documents tab or another transaction-related tab.

To view document history:

 1. On the Documents tab,   or on another transaction-related tab on the Customer Inquiry screen, 
double-click the document   number that you want to look up. 

Note: An Inquiry  button in the heading signifies columns of document   numbers for which you can 

view document history.

The Document Inquiry screen opens, displaying the document   you selected. 

 2. Use the tabs and the drilldown   features on the Document Inquiry screen to display detailed 
information   for the particular document.

Drilling Down from Customer Inquiry to a Transaction Entry

You can use the Customer Inquiry screen to look up various kinds of transactions posted for a customer 
in Accounts Receivable.

This topic explains how to drill down from Customer Inquiry to view a selected transaction on the original 
transaction entry screen. It assumes that you have already opened the Customer Inquiry screen, and 
selected a customer.

Before You Start

 1. Open Accounts Receivable > A/R Customers > Customer Inquiry.

 2. In the Customer No. field, enter the customer number, and then press Tab.

To view a transaction in the original transaction entry screen:

 1. On a transaction-related tab, in the top table, select the transaction line.

 2. Double-click the number that identifies the transaction you want to view.     

You can drill down to any transaction in a column that has a Drilldown  button in the heading, and 

you can drill down to any receipt or refund listed in the top table on the Receipts tab or the Refunds tab.
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Examples: 
 l On the Documents tab:

 l To view an invoice, a debit note, or a credit note in the batch in which it was 
posted, double-click the Batch/Entry number.

 l To view an order or a shipment on the associated Order Entry screen, double-
click the order number or the shipment number.

 l To view a customer payment on the A/R Receipt Entry screen or to view a refund 
on the A/R Refund Entry screen, double-click the check number or receipt number 
in the Check/Receipt No. column.

 l On the Pending tab:

 l To view or edit a transaction that is not yet posted, double-click the transaction 
line.

Creating Customized Lists of Customers
Because it provides a number of criteria to create customer   lists, you can use the A/R Customer List 
screen to produce specialized customer reports, ranging from a simple list of customer numbers and 
names to complex reports that meet unique needs.

This section provides some examples of how you can use the Customer List screen to keep track of your 
customers.

About Using the Customer List Screen to Create Special Reports

The Customer List is a powerful   tool that provides field-level selection and analysis of your customer   
database. You can use up to seven criteria to select customers to include on the   report, plus additional 
criteria based on customers' credit statuses. If you use customer optional fields, you can also use them 
as criteria to   produce custom reports. 

Example: If you use an optional   field to identify preferred customers, you can easily print a list of   
preferred customers. (Very long optional fields may be truncated   on the printed report, particularly if 
they are used with several other   criteria.)

The report includes columns for each of your criteria, in the order   you specified them.

Important! If your Sage 300 system uses security, you must have Transaction History Inquiry   security 
authorization to select criteria for amounts or balances.
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Arranging and Hiding Columns on the Customer List Preview

To rearrange or hide columns on the preview list:

 l To hide a column, left-click the column heading,   and then click Hide on the menu that appears.

 l To move a column, click the column heading,   and then, while holding down the mouse key, drag 
and drop the column in   the position you want it.

Note: The report   includes all the generated columns in the order they were generated. Hiding   or 
reordering columns on the preview list does not change their order   on the report.

Using the Customer List Preview to Inquire on Customers

This topic describes the steps to:

 l Generate a list of customers.

 l Use the generated preview list to perform inquiries on a customer's account.

For an overview of the Customer List,   see "A/R Customer List Screen" (page 404).

For an overview of the Customer List preview,   see A/R Customer List Preview Screen.

Before You Start

 l If you have not already done so, specify criteria and select options for the type of customer list you 
want to generate, and then click the Process button to create a preview list.

Tip: To create a very simple list of all customers, including only the customer number and customer 
name, you do not need to specify any criteria or select any options. 

To display information for a customer on the   Customer List preview screen:

 1. On the generated Customer List Preview list, select the row for the customer whose information 
you want to view.

 2. If you used Comment Follow Up or Comment Expiration as criteria, use the table at the bottom of 
the screen to review a list of comments entered for the selected customer.

 3. To view all the information for the customer on the Customer Inquiry screen, click the Customer No. 
heading. More...

Use the Customer Inquiry screen to:
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 l Look up any and all information entered for a specified customer. More...

Information available in the Customer Inquiry screen includes:

 l Posted and pending (unposted) documents for the customer.

 l Posted receipts, and information about how the receipts were applied.

 l All the information entered in the customer record, including address, contact 
information, processing and invoicing options, optional fields, activity and statistics, 
and comments.

 l Additional information entered for the customer, such as ship-to locations and 
recurring charges.

 l Edit customer comments directly on the Comments tab.

 l Open the customer record and related records for editing. More...

Examples: 
 l To edit a ship-to location record, double-click the ship-to location on the Ship-To tab.

 l To edit a recurring charge record, double-click the recurring charge code on the 
Recurring Charges tab.

 l To edit customer activity or customer statistics, click the Drilldown  button beside 
the Customer No. field.

 l Drill down to view documents in the original entry screen.  More...

Examples: 
 l To display a posted document in a transaction-entry screen, select the transaction 

line on a table on the Documents, Receipts, Refunds, Adjustments, OE Orders, OE 
Invoices, or OE Sales tab, and then click the column heading for the type of 
document.          

Note: These columns have a Drilldown  button in the heading.

 l To view or edit a transaction that is not yet posted, double-click   the transaction line 
on the Pending tab.

 l To view an order or a shipment in the Order Entry module,   double-click the order 
number or the shipment number.

 l To view an item record in the Inventory Control module, double-click an item   number 
on an Order Entry tab or on the IC Contract Pricing tab.
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 l Open the Document Inquiry screen to view detailed information for a particular posted 
document. More... 

 l To view a posted document on the Document Inquiry screen, select the   transaction 
line, and then click the Document No. column heading.

 l To view an unposted document on the Document Inquiry screen, select the transaction 
on the Pending tab, and then click the Document No. column heading.

Note: Columns that open the Document Inquiry screen have an Inquiry  button in the 

heading.

Tip: Leave the Customer Inquiry screen open. When you return to the Customer List, and then 
double-click another customer number, the program refreshes the Customer Inquiry screen for the 
new customer.

 4. To print the customer   list to your usual print destination, click Print.

 5. When you have finished using the preview, click Close to return to the Customer List screen.

Creating a Contact List for Following Up with Customers

This topic describes the steps to:

 l Generate a list of customers   by comment follow-up date, and include customer contact information 
on   the list.

 l Use the Customer List   preview to perform additional inquiries on a customer's account.

Tip: You can modify these steps to include other information you need to   discuss with your customers. 
For example, you can use the Select By fields   to select additional or other criteria, and select Aging, 
Credit Limit,   and Include options to create a completely different report. (The steps   include tips as 
suggestions to guide you.)

For an overview of the Customer List, see "A/R Customer List Screen" (page 404).

For an overview of the Customer List preview, see A/R Customer List Preview Screen.

To create a contact list that you can use to follow up with customers:

 1. Open Accounts Receivable > A/R Customers > Customer List.

 2. If you want to limit the list to a range of customers, or if you simply want to include customer 
number information on the report:
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 a. In the first Select By field in the Customer Range area,  select Customer No.

Tip: If you prefer a report that contains other information, such as customer group or account 
set, specify Customer Group or Account Set instead of—or in addition to—the customer 
number.

 b. Use the From and To fields to specify the first and last customer numbers (or customer 
group codes, or account set codes) for the range that you want to include.

The generated report will include columns of information for all the criteria you select, in the order 
you specify them.

 3. To include comments from customer records, select Comment Follow-Up, and then use the From 
and To fields that appear to specify a range of follow-up dates for the comments you want to 
include on the list.

 4. If the list is for a specific salesperson, select Salesperson, and then specify the same salesperson code 
in the From and To fields.

Alternatively, you can specify a range of salespersons using the From and To fields.

 5. Specify any additional criteria you need in the remaining Select By fields.

Example: To include only customers that have overdue balances, select Overdue Amt. or Func. 
Overdue Amt. as criteria.

If your system uses security, you must have View Transaction History security authorization to select 
criteria for amounts or balances.       

 6. Use the Aging, Credit Limit, and Include options to refine the report. More...

Tips: 
 l If you selected criteria that can be aged (such as Current Due or Overdue Amt.), select 

aging options that determine whether amounts are classified as current or overdue.

 l To select customers based on their credit status, and to include information about 
customers' credit limits, select credit limit options.

 l If you want to include the name, telephone number, and e-mail address for a customer 
contact person, select the Contact Information option.

 l If you specified Comment Follow-Up or Comment Expiration as criteria, and you want to 
include customers whose records have no comments in the specified range of dates, 
select Customers With No Comments.

 l If you want to include customers with no balances, select Customers with Zero 
A/R Balance.
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 7. Click Process to generate a customer list preview.

Tip: If you leave the Customer List Preview screen open, you can refer to it when you contact 
customers, and look up additional information while you speak to them.

 8. To display details for a listed customer on the Customer Inquiry screen, double-click the customer 
number on the preview screen. More...

 l Look up any and all information entered for a specified customer. More...

Information available in the Customer Inquiry screen includes:

 l Posted and pending (unposted) documents for the customer.

 l Posted receipts, and information about how the receipts were applied.

 l All the information entered in the customer record, including address, contact 
information, processing and invoicing options, optional fields, activity and statistics, 
and comments.

 l Additional information entered for the customer, such as ship-to locations and 
recurring charges.

 l Edit customer comments directly on the Comments tab.

 l Open the customer record and related records for editing. More...

Examples: 
 l To edit a ship-to location record, double-click the ship-to location on the Ship-To tab.

 l To edit a recurring charge record, double-click the recurring charge code on the 
Recurring Charges tab.

 l To edit customer activity or customer statistics, click the Drilldown  button beside 
the Customer No. field.
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 l Drill down to view documents in the original entry screen.  More...

Examples: 
 l To display a posted document in a transaction-entry screen, select the transaction 

line on a table on the Documents, Receipts, Refunds, Adjustments, OE Orders, OE 
Invoices, or OE Sales tab, and then click the column heading for the type of 
document.          

Note: These columns have a Drilldown  button in the heading.

 l To view or edit a transaction that is not yet posted, double-click   the transaction line 
on the Pending tab.

 l To view an order or a shipment in the Order Entry module,   double-click the order 
number or the shipment number.

 l To view an item record in the Inventory Control module, double-click an item   number 
on an Order Entry tab or on the IC Contract Pricing tab.

 l Open the Document Inquiry screen to view detailed information for a particular posted 
document. More... 

 l To view a posted document on the Document Inquiry screen, select the   transaction 
line, and then click the Document No. column heading.

 l To view an unposted document on the Document Inquiry screen, select the transaction 
on the Pending tab, and then click the Document No. column heading.

Note: Columns that open the Document Inquiry screen have an Inquiry  button in the 

heading.

Tip: When the Customer Inquiry screen appears, you can leave it open. If you return to the Customer 
List and double-click another customer number, the program refreshes the screen for the new 
customer.

 9. To print the customer list to your usual print destination, click Print.

 10. When you have finished using the preview, click Close to return to the Customer List screen.

Creating a List of Customers for a Marketing Campaign

Sage 300 provides a number of ways to classify and organize your   accounts, and the Customer List 
provides an almost equal number of criteria to assemble customer   information.  

You can create a list of customers by territory, salesperson,   customer group, customer currency, any 
optional field that you have defined   for your customers, or a combination of up to seven criteria.
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These steps show you how to create a list of customers by territory,   salesperson, and customer group, 
which are defined in the sample data.  

Create the list using criteria that are most   useful to you.

Before You Start

 l Determine the criteria   that are relevant for your own marketing campaign or promotion, which   will 
depend on the objective of your campaign, your target market,   and the optional fields and other 
data that you keep for your customers.  

To create a list of customers for a marketing campaign:

 1. Open Accounts Receivable > A/R Customers > Customer List.

 2. In the Customer Range area, use the Select By fields   to specify ranges of territories, 
salespersons, and customer groups that you want to include on the list, as follows:

 a. In the first Select By field, select Territory.

 b. In the From field, type or select the first territory in the range of territories that you want to 
include on the list.

 c. In the To field, type or select the last territory in the range of territories. If your campaign 
focus is on one territory, type the same territory code that you used in the From field.

 d. Repeat steps a, b,   and c for Salespersons and for Customer Groups.

If you create the report for more than one salesperson, the information for each customer will 
print on multiple lines.

Tip: If you would find it more useful to select customers by other criteria, such as the customer 
group or account set, specify Customer Group or Account Set instead of—or in addition to—
the suggested criteria. The generated report will include columns of information for all the 
criteria you select, in the order you specify them.

 3. To print the name, telephone number, and e-mail addresses for customer contacts, select the 
Contact Information option. 

Contact information appears in a separate   line on the report for each customer.

 4. Click Process to generate and display the list.

 5. Check the preview list to ensure that the results are what you expected.

 6. Click Print to send the report to your usual print destination.

 7. Click Close to return to the A/R Customer List screen.

120Sage 300 2023 Accounts Receivable User's Guide



Reviewing Customer Comments on the Customer List Preview

To review customer comments on the Customer List Preview:

 1. Open Accounts Receivable > A/R Customers > Customer List.

 2. Specify criteria for to generate a customer list, including Comment Follow-up or Comment 
Expiration   as selection criteria.

If you need help to create a customer list, follow the instructions in  "Printing a List of Customers" (page 

287),   specifying additional criteria for comments in the Select By fields.

 3. Accept the default range   of comment follow-up or comment expiration dates, or specify a different 
range of   dates using the From and To fields beside these criteria.

 4. If you want to include   customers whose records do not have comment dates within the specified   
range, select the option Include Customers With No Comments.

 5. Click Process.

The Customer List Preview screen appears, displaying two information   tables.

The top table includes the list of customers. The bottom table displays   comments that match your 
criteria.

 6. On the top table, select   the line for a customer whose comments you want to view.

The bottom table on the preview lists comments that   match your criteria for the selected customer.

You can also add   a new comment for a customer   at this point. More...

 a. Click in the Customer   No. column for the customer for whom you want to add a comment.

 b. Click the Customer   No. column heading

The Customer Inquiry screen opens, displaying information   for the selected customer.

On the Customer Inquiry screen:

 i. Click the   Comments tab.

 ii. Click the table on   the Comments tab, and then press the Insert key on your keyboard 
to start   a new line.

 iii. Enter or edit information   for the comment as necessary, including the expiration date, 
follow-up   date, comment type, and user ID. 

 iv. Double-click the Comment   field, and then type the text for the comment on the 
screen that appears.

 v. Click Close to return   to the Customer Inquiry screen.

 vi. Click Close to return   to the Customer List.

 7. If you want to print the   generated list to your usual print destination, click Print.
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About Entering Current and Historical Transactions
You can view statistical information for customer accounts, items, and salespersons for the current year 
and for all the previous years for which you retain this data. You add the information you need during 
setup. Every time you post transactions, the information is automatically updated.

To properly set up your Accounts Receivable system, you must enter and post the current-year opening 
balances in your customer accounts. If you set up partway through a fiscal year, you must also enter and 
post figures for the current year, up to the present date, and all outstanding transactions. If you want to 
display and print reports of previous-year data, you must enter those figures during setup as well.

Entering Opening Balances in Customer Accounts

Once you create customer records, you need to establish your fiscal-year opening balances. You can do 
this by entering all uncompleted invoices from the previous year as well as all receipts, or you can create 
the opening balances in your customer accounts by entering net outstanding balances as invoices in the 
A/R Invoice Entry screen, then posting them to the first date of the current fiscal year.

You can create the invoice batch outside Sage 300 (as a spreadsheet or CSV file, for example) and 
import the batch for posting.

Entering Current-Year Transactions

When you set up an Accounts Receivable system partway through a fiscal year, you must enter the 
transaction data for the current year to date. 

You can use any of the following method to add current-year transactions:

 l Enter data directly in Accounts Receivable.

 l Import data, then post it using one of the following methods:

 l Post all the current-year transactions, one at a time, period by period.     

This method provides full detail for current-year transactions.

 l Post all the transactions for the current period, and the net changes in each customer's 
invoice and receipt totals for each of the earlier periods in the current year.     

This method provides full detail for current-period transactions, and creates accurate balances 
for previous periods in the current year.

 l Post the net changes in each customer's invoice and receipt totals for each of the periods in 
the current year.     

This method produces accurate balances for each account in each period of the current year, but 
does not provide transaction detail for the audit trail reports.
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 l Post the net change between the opening and current balances for each customer account.     

This is the quickest method of entering the data, but it does not provide transaction detail for 
audit trail reports.

Entering Historical (Previous-Year) Data

When you set up a new Accounts Receivable system, you can enter sales history for previous years, 
including figures for customer groups, national accounts, customers, salespersons, and items. 

Note: To enter each type of data, you must select the option to edit statistics on the Processing tab of 
the A/R Options screen.  For more information, see "A/R Options Screen" (page 523).

You can use one of the following method to add  historical data:

 l Enter data directly in Accounts Receivable.

 l Import data.

You can enter the figures by the periods and years specified on the Processing tab of the A/R Options 
screen. For more information, see "A/R Options Screen" (page 523).

You can review the figures on the customer, item, and salesperson screens.

You can also print period statistics reports for customer groups, national accounts, customers, and 
salespersons.

If you do not need historical data right away, you do not have to add it when you set up an Accounts 
Receivable system. Each time you post transactions, the figures are automatically updated.

Entering Customer Statistics for Previous Years

For each customer, customer group, and national account, you can enter the amount and number of:

 l Invoices

 l Payments

 l Discounts

 l Credit notes

 l Debit notes

 l Adjustments

 l Write-offs

 l Interest charges

 l Returned checks

 l Paid invoices

123Sage 300 2023 Accounts Receivable User's Guide



For customers and national accounts, you can also enter the:

 l Amount and date of the highest and lowest balance

 l Largest invoice for the current year and previous year

 l Amount and date of the last:

 l Invoice

 l Payment

 l Credit note

 l Debit note

 l Adjustment

 l Interest charge

 l Returned check

 l Total days to pay

 l Average days to pay

 l Total number of paid invoices

Entering Item Statistics for Previous Years

For each item, unit of measure, and period, you can enter the:

 l Amount and number of sales and returns

 l Total cost of goods sold

 l Total quantity sold per period

 l Date of the last invoice for the item

Accounts Receivable calculates the gross margin for each unit of measure and period by subtracting the 
cost of goods sold from the total sales for the period and unit of measure.

Entering Salesperson Statistics for Previous Years

For each salesperson, you can enter the amount and number of invoices, receipts, credit notes, debit 
notes, discounts, and write-offs that were posted for the salesperson number.
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Chapter 3: Entering and Posting 
Accounts Receivable Transactions

Use Accounts Receivable transaction entry screens to record, edit, post, and inquire on the following 
types of transactions:

 l Invoices, debit notes, credit notes

 l Receipts

 l Refunds

 l Adjustments

Journal Entries Generated by Accounts Receivable
When you post transactions, journal entries are created in general ledger. The journal entries that are 
created vary depending on transaction type.

The following sections include information about the journal entries associated with Accounts Receivable 
transactions.

Invoices

On the G/L Transactions report, invoices are assigned source code AR-IN.

Posted invoices debit the customer's Receivables Control account and credit the general ledger revenue 
account specified with each invoice detail (either directly or by distribution code).

G/L Account Debit Credit

Retainage Control X  

Receivables Control X  

     Revenue and other accounts  X

Journal Entries for Invoices

The entry for a retainage invoice (or debit note) is:
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G/L Account Debit Credit

Receivables Control X  

     Retainage Control  X

Journal Entries for Retainage Invoices

Credit Notes

On the G/L Transactions report, credit notes are assigned source code AR-CR.

Posted credit note transactions debit the general ledger accounts you enter with the document details 
and credit the customer's Receivables Control account.

G/L Account Debit Credit

Revenue and other accounts X  

     Receivables Control  X

     Retainage Control  X

Journal Entries for Credit Notes

The entry for a retainage credit note is:

G/L Account Debit Credit

Retainage Control X  

     Receivables Control  X

Journal Entries for Retainage Credit Notes

Debit Notes

On the G/L Transactions report, debit notes are assigned source code AR-DB.

Posted debit note transactions debit the customer's Receivables Control account and credit the general 
ledger accounts you enter with the debit note details.
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G/L Account Debit Credit

Retainage Control X  

Receivables Control X  

     Revenue and other accounts  X

Journal Entries for Debit Notes

Interest Invoices

On the G/L Transactions report, interest invoices are assigned source code AR-IT.

Posted interest invoice transactions debit the customer's Receivables Control account and credit the 
Interest Income account specified for the interest profile.

G/L Account Debit Credit

Receivables control X  

     Interest income  X

Journal Entries for Interest Invoices

Recurring Charge Invoices

On the G/L Transactions report, recurring charge invoices are assigned source code AR-IN.

Posted recurring charge invoices debit the customer's Receivables Control account and credit the 
general ledger accounts you enter with the invoice details.

G/L Account Debit Credit

Receivables Control X  

     Revenue and other accounts  X

Journal Entries for Recurring Charge Invoices

Receipts

On the G/L Transactions report, receipts are assigned source code AR-PY, and discounts are assigned 
the source code AR-ED.

127Sage 300 2023 Accounts Receivable User's Guide



Receipts debit the Bank account specified for the receipt batch, debit the Sales Discounts account (if a 
discount is taken), and credit the customer's Receivables Control account.

G/L Account Debit Credit

Bank X  

Sales Discounts X  

     Receivables Control  X

Journal Entries for Receipts

Prepayments

On the G/L Transactions report, prepayments are assigned source code AR-PI.

When you post a prepayment, Accounts Receivable debits the amount to the Bank account specified for 
the receipt batch and credits the Prepayment Liability account specified in the customer’s account set.

G/L Account Debit Credit

Bank X  

     Prepayment Liability  X

Journal Entries for Prepayments

Prepayments applied to invoices debit the Prepayment Liability account and credit the customer’s 
Receivables Control account.

G/L Account Debit Credit

Prepayment Liability X  

     Receivables Control  X

Journal Entries for Prepayments Applied to Invoices

Miscellaneous Receipts

On the G/L Transactions report, miscellaneous receipts are assigned source code AR-PY.

Miscellaneous receipts debit the receipt batch Bank account and credit the general ledger accounts 
entered with distribution details in the Miscellaneous Receipt Distribution screen in Receipt Entry.
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G/L Account Debit Credit

Bank X  

     Revenue and other accounts  X

Journal Entries for Miscellaneous Receipts

Unapplied Cash

On the G/L Transactions report, unapplied cash receipts are assigned source code AR-UC.

Unapplied cash receipts debit the Bank account for the receipt batch and credit the customer’s 
Receivables Control account.

G/L Account Debit Credit

Bank X  

     Receivables Control  X

Journal Entries for Unapplied Cash Receipts

Adjustments

On the G/L Transactions report, adjustments are assigned source code AR-AD.

Exchange Gains or Losses

On the G/L Transactions report, exchange gains or losses are assigned source code AR-GL (for 
"gain/loss").

In a multicurrency system, exchange gains or losses result when you revalue or settle an invoice using an 
exchange rate that is different from the rate currently used by the invoice.

During Revaluation

If you revalue an invoice in a source (non-functional) currency at an exchange rate that is different from 
the rate currently used by the invoice, and the changes in the exchange rate increase the value of the 
invoice, the transaction registers a loss. In this situation, the following journal entries are created:
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G/L Account Debit Credit

Exchange Loss (or Unrealized Exchange Loss) X  

     Receivables Control  X

Journal Entry for Exchange Loss Arising from Revaluation

G/L Account Debit Credit

Receivables Control X  

     Exchange Gain (or Unrealized Exchange Gain)  X

Journal Entry for Exchange Gain Arising from Revaluation

If you use the Realized and Unrealized Gain/Loss accounting method for your company, exchange gains 
and losses are considered "unrealized" until the document is paid. Revaluation sends unrealized gain 
and loss transactions to General Ledger as reversing transactions (meaning they are automatically 
reversed at the beginning of the next fiscal period), as follows:

G/L Account Debit Credit

Receivables Control X  

     Unrealized Exchange Loss  X

Reversal of Journal Entry for Unrealized Exchange Loss

G/L Account Debit Credit

Unrealized Exchange Gain X  

     Receivables Control  X

Reversal of Journal Entry for Unrealized Exchange Gain

When you print the Customer Transactions report for the period in which you post the reversing 
revaluation transaction, both transactions appear for the customer. Their net effect on the account 
balance is zero.

If you use the Recognized Gain/Loss accounting method, revaluation exchange gains and losses are not 
reversed.
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Arising on Settlement

If you settle an invoice using an exchange rate that is different from the rate currently used by the invoice, 
and the exchange rate on settling reduces the value of the invoice, the transaction registers a gain.

If posting changes the value of an invoice (for example, through partial payment, full payment, or credit 
note), Accounts Receivable calculates the gain or loss for the portion of the invoice that was changed by 
the posting, and creates gain or loss transactions for the general ledger accounts.

G/L Account Debit Credit

Receivables Control X  

     Exchange Gain (or Realized Exchange Gain)  X

Journal Entry for Exchange Gain on Settlement 

G/L Account Debit Credit

Exchange Loss (or Realized Exchange Loss) X  

     Receivables Control  X

Journal Entry for Exchange Loss on Settlement 

Note: Credit notes and debit notes do not affect gains or losses if they are issued at the exchange rate 
of the original invoice. However, they will generate gains or losses if they are issued at a different rate.

About Locked Fiscal Periods
In Sage 300, fiscal periods are locked separately for each transaction-oriented Sage 300 program.

The system checks the status of a fiscal period for Accounts Receivable when you enter certain dates in 
Accounts Receivable transactions. It also checks the status of the fiscal period for Bank Services when 
you add a receipt or print a refund check.

If the period is locked for Accounts Receivable, you receive a warning, an error message, or no message, 
depending on the setting for the Locked Fiscal Period option on the Company Profile’s Options tab, as 
follows:

 l If the period is locked for Bank Services and the Locked Fiscal Period option is set to Error, you 
receive an error message when you add a receipt or print a refund check. (Otherwise, no warning 
or error appears.)     
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Important! Generally, you should lock a period for Accounts Receivable, Bank Services, and 
Accounts Payable at the same time, to avoid this situation.

 l If a fiscal period is locked for General Ledger but not for Accounts Receivable, you can create 
batches for General Ledger during posting or using the A/R Create G/L Batch screen (depending 
on Accounts Receivable's G/L Integration settings). When you try to post transactions to a locked 
period in General Ledger, however, the transactions will be placed in an error batch.     

Important! You should create and post General Ledger batches for outstanding Accounts Receivable 
transactions before locking a period for General Ledger.

About Importing and Exporting Batches
You can import invoice, receipt, refund, and adjustment batches created in non-Sage 300 programs and 
in remote Sage 300 subledgers. 

Accounts Receivable treats imported batches as regular batches and, if the option to allow editing of 
imported batches is selected on the A/R Options screen, you can edit imported batches using the 
transaction-entry screens.  

You can also export transaction batches from Accounts Receivable to other programs. For example, you 
could export data to a spreadsheet for analysis. You can also export batches of recurring transactions to 
import later.

For more information and instructions on importing and exporting batches, see the following sections in 
the chapter "Importing and Exporting Accounts Receivable Data":

 l "About Importing and Exporting Transactions" (page 272)

 l "Importing Records into Accounts Receivable" (page 274)

 l "Exporting Accounts Receivable Data" (page 274)

About Quick Processing for Credit Card Transactions
If you use Payment Processing, 'quick' processing buttons allow you to process some credit card 
transactions with one click:

 l Quick Pre-authorize. Pre-authorize a credit card payment with one click.

The Quick Pre-authorize button is available on the O/E Order Entry screen.

 l Quick Charge. Process a credit card payment with one click.

The Quick Charge button is available on the following screens:
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 l O/E Prepayments

 l A/R Prepayments

 l A/R Receipt Entry

Note: The Quick Charge button cannot be used to capture a pre-authorized payment.

Before you can use quick processing buttons for a customer, you must:

 l Set up a credit card for the customer with the Use This as Default Card option selected (on the 
A/R Credit Card Information screen).

Also, this default credit card must use the same currency as the customer’s currency. More...

The currency for a credit card is determined by the Processing Code specified for the credit card on the 
A/R Credit Card Information screen.

The currency for a customer is determined by the Account Set specified for the customer on the 
Processing tab of the A/R Customers screen.

 l Specify a payment code for the customer (on the Processing tab of the A/R Customers screen) 
that uses the payment type SPS Credit Card.

Note: When using quick processing buttons, you do not enter any information for transactions. If you 
need full control over transaction details (such as billing information, order totals, and credit card 
details), use the Pre-authorize or Charge buttons instead.

About Batch Processing
Accounts Receivable operates on a batch system, which means that you:

 l Enter the four main types of transactions—invoices, receipts, refunds, and adjustments—into 
batches.     

Batches are groups of transactions that share the same batch number and batch date. Each transaction 
has its own entry number, customer number, date, and details.

For more information, see "Types of Accounts Receivable Batches" (page 134).

 l Print batch listings to check for errors.

 l Post the batches to record the transactions in customer accounts and distribute the amounts to 
general ledger accounts.

 l Print the posting journals and G/L Transactions report as part of your audit trail.     

The batch system for processing transactions provides great flexibility at the batch-entry stage, and tight 
auditing control during and after posting.
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You can have an almost unlimited number of types of batches open at once, depending on available disk 
space. The ability to use several open batches means you can group transactions by salesperson, 
location, date, or any other criteria you find useful.

Types of Accounts Receivable Batches

There are four types of transaction batches in Accounts Receivable:

 l Invoice batches. These batches contain:     

 l Invoices (including interest invoices and retainage invoices).

 l Debit notes.

 l Credit notes.

Notes: 
 l You can enter prepayments in invoice batches, but they are placed in receipt batches and 

are shown on receipt batch listings.

 l In multicurrency ledgers, each invoice batch can contain documents in different 
currencies.

 l Receipt batches. These batches contain:     

 l Receipts (check, cash, or other method).

 l Prepayments.

 l Unapplied cash transactions.

 l Miscellaneous receipts.

 l Transactions that apply previously posted receipts and credit notes to documents in 
customer accounts.

 l Adjustments to specific documents (if you use the Allow Adjustments In Receipt Batches 
option).

Note: In multicurrency ledgers, all receipts in a single receipt batch must be in the same currency, 
and the currency must be accepted by the bank code assigned to the batch.

 l Refund batches. These batches contain refunds (by check or cash) that you issue to customers.

 l Adjustment batches. These batches contain:     

 l Write-off transactions.

 l Corrections to posted transactions.

Note: In multicurrency ledgers, a single adjustment batch can contain transactions in different 
currencies.
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About Assigning and Using Batch Numbers and Entry Numbers

To keep a clear and accurate audit trail, Accounts Receivable automatically   assigns a number to each 
batch and to each entry (transaction) you add   to a batch, starting with 1. You must use the assigned batch 
and entry   numbers. 

A separate numbering sequence is used for each type of batch (invoice,   receipt, and adjustment).

The batch and entry numbers are a permanent part of each transaction   record, and they appear with the 
transactions on Accounts Receivable reports,   such as posting journals and the Customer Transactions 
report.

You can use batch and entry numbers to trace the progress of transactions   through the Accounts 
Receivable system and—if you use the numbers as   the descriptions or references for G/L transactions 
and you do not consolidate transactions during posting in Accounts   Receivable—into your general   ledger.

About Creating Accounts Receivable Batches

You use the A/R Invoice Entry screen, A/R Receipt Entry, A/R Quick Receipt   Entry, and A/R Adjustment 
Entry screens to create batches and enter transactions   directly into them. 

In addition, Accounts Receivable automatically creates batches for you   when you:

 l Use the A/R Create Interest   Batch, A/R Create Recurring Charge Batch, and A/R Create Write-Off 
Batch screens.

 l Create recurring charge   batches from the Reminder List in Common Services.

 l Post transactions that   contain errors. Accounts Receivable posts error-free transactions only,   and 
creates a new batch that contains all the transactions it could not   post. 

 l Import batches from Sage 300 applications at another location or from non-Sage 300 products.

Multicurrency Ledgers

If you have a multicurrency ledger, you can create a new receipt batch   for each currency you want to 
process, or you can enter receipts in any currencies that the specified bank accepts, as you need.

You can also enter a mix of currencies   in invoice and adjustment batches.

About Editing and Deleting Batches

Batches that are not deleted, marked Ready To Post, posted, or partially posted are called open 
batches.

You can edit or delete open batches, depending on the selections for the following processing options on 
the A/R Options screen: 
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 l Allow Edit Of Printed Invoices

 l Allow Edit After Deposit Slip Printed

 l Allow Edit Of Imported Batches

 l Allow Edit Of External Batches

Editing Batches

You can always change most batch header information, regardless of the restrictions you may place on 
batch editing. For example, you can always change dates and descriptions of all open batches, whether 
you created them in Accounts Receivable or imported them from another ledger.

You cannot change the detail type in invoice batches after you add the first invoice detail, and you cannot 
change the bank code in receipt batches after you add the first detail.

If you want to edit or delete a batch that is marked Ready To Post, you must first change the batch status 
to Open on the A/R Batch List screen.

Multicurrency Ledgers

If you use multicurrency accounting, you can always change the exchange rate and rate type for a 
transaction on the Rates tab on the A/R Invoice Entry screen, or using the Rate Overrride screen in the 
other transaction entry screens.

You can also change the rate date on the A/R Invoice Entry screen and on the A/R Receipt Entry and 
A/R Receipt Batch Maintenance screen.

Deleting Entries and Batches

When you delete a batch or an entry in a batch, you cannot reuse its number.

Deleted batches and entries are reported on the batch listing and posting journal for the batch. Deleted 
batches are also reported on the A/R Batch Status report.

Changing Order Entry Batches

If you use Sage 300 Order Entry with Accounts Receivable, you should not delete or change amounts in 
Order Entry batches. If you do, your Accounts Receivable customer records will not match your Order 
Entry records.

Editing Imported Batches

If you need to correct an imported batch, you should delete the batch from Accounts Receivable and 
make the corrections to it in the program where you created the batch, then import it again. This 
procedure ensures that the batch you post in Accounts Receivable contains exactly the same information 
as the batch in your other program.

136Sage 300 2023 Accounts Receivable User's Guide



Tip: To prevent editing of imported batches in Accounts Receivable, do not select the Allow Edit Of 
Imported Batches option on the A/R Options screen.

About Tracking Batches

To check on current batches, print their batch listings or print the A/R Batch Status report for the type of 
batches you want to review. 

To display   batch information on your screen, print the reports using Preview as the   print destination, or 
look up the batches on the A/R Invoice Batch List,   A/R Receipt Batch List, and A/R Adjustment Batch List 
screens.

Batch Statuses

Batches are categorized by their status and their type.

Batch statuses include Open, Ready To Post, Posted, Post In Progress, and Deleted. 

Batch types include Entered, Imported, Recurring (created using the Create Recurring Charge Batch 
screen), Generated  (error batches or batches created using the Create Interest Batch or   Create Write-Off 
Batch screens), or External (created for Accounts Receivable in another Sage 300 program, such   as 
Order Entry or Project and Job Costing).   

Clearing Batch Status Information

To remove information about posted and deleted batches from the Batch   Status report, use the Clear 
Deleted And Posted Batches option on the A/R  Clear History screen.

About Listing Batches

Once you have entered all transactions in a batch, you should print   the batch listing and compare it to 
your source documents to be sure all   transactions were entered correctly. If you find mistakes, edit the 
batch   to correct them, then reprint the batch listing and check it before you   post the batch. 

Notes: 
 l To print a listing for a batch you are working on, use the File > Print command in the batch-entry 

screen.

 l To print listings for a range of batches, use the Batch Listings screen.

 l File the reports as part of your audit trail to batches.

Tip: To make sure listings are printed for each batch before you post it,   select the Force Listing Of All 
Batches option on the A/R Options screen. The   option also prevents you from posting batches you 
edited but did not relist.

137Sage 300 2023 Accounts Receivable User's Guide



About Forcing Listing of All Batches and Deposit Slips

You use the following options on the A/R Options screen to ensure that batch listings and deposit slips 
are printed before you can post the batches:

 l If the Force Listing Of All Batches option is selected, you must print batch   listings for each batch 
you want to post. You must also print a new listing   for each batch you edit.

 l If the Force Printing Of Deposit Slips option is selected, you must print   deposit slips for receipt 
batches that contain deposit slips before you   can post the batches.

 l If the Allow Edit After Deposit Slip Printed option is selected, you can edit receipt batches after 
printing their deposit slips. You do not have to reprint the deposit slips before   posting the batches.  

However, if the Allow Edit After Deposit Slip Printed option is not selected, you cannot edit receipt 
batches after printing their deposit slips.

Important! You should always reprint deposit slips if you change the amounts   in receipt batches, to 
be sure that the total on each deposit slip matches   the total for the corresponding batch.

About Printing Posted Transactions

Each time you post batches, Accounts Receivable creates a journal of the entries from the batches you 
posted together. These posting journals are an essential part of your audit trail, because they provide a 
record of all posted details and of the related general ledger distributions. For more information, see 
"Journal Entries Generated by Accounts Receivable" (page 125).

Important! You should keep your audit trail of posted transactions up to date by printing and filing each 
posting journal as it is created.

You should also print the G/L Transactions report as part of your period-end procedures. You are 
required to print these reports only once, before you close the year. You cannot use the A/R Year End 
screen until you have printed all outstanding posting journals to a printer or a file and created the general 
ledger transaction batch.

If you carefully maintain and identify source documents, and print and file all batch listings, posting 
journals, and other audit trail reports, you will be able to trace any transaction from source to general 
ledger entry.

Adjustments
In Accounts Receivable, you can:

 l Create batches of write-off transactions using the A/R Create Write-Off Batch screen.

 l Enter adjustments individually   using the A/R Adjustment Entry screen.
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 l Adjust specific documents   in the A/R Receipt Entry screen, if the Allow Adjustments In Receipt   
Batches option is selected on the A/R Options screen.

About Adjustment Entry

This section provides an overview of several convenient ways you can adjust transactions and account 
balances in Accounts Receivable. You can:

 l Create batches of write-off transactions using the A/R Create Write-Off Batch screen.

 l Enter adjustments individually using the A/R Adjustment Entry screen.

 l Adjust specific documents in the A/R Receipt Entry screen, if the Allow Adjustments In Receipt 
Batches option is selected on the A/R Options screen.

For information about the A/R Adjustment Entry screen, see "A/R Adjustment Entry Screen" (page 569).

For the steps you take to add an adjustment using the Adjustment Entry screen, see "Adjusting a Posted 
Transaction" (page 142).

Recording Adjustment Information in Bank Services

Accounts Receivable does not send adjustment information to Bank Services. 

Important! If you make any adjustments that affect a bank account, you must add and post an entry in 
Bank Services to adjust the bank account.

Creating Batches of Write-Off Transactions

You use the Create Write-Off Batch screen to produce batches of adjustment transactions when you 
have a number of amounts to write off in various accounts. For example, you might want to write off small 
outstanding balances or transactions in customer accounts that you want to delete. You can also use the 
screen to write off overdue amounts that are not collectible or that are too small to warrant the cost of 
mailing statements and making other collection attempts.

On the Create Write-Off Batch screen, you specify whether to write off overdue or outstanding 
transactions or balances in all or a range of customer accounts. You indicate the types of transactions to 
write off, such as invoices, credit notes, and debit notes. You select transactions by their outstanding 
amounts or by a percentage of their original totals, and by a range of other options, including customer 
number, account set, account type, and numerous other choices.

When you create a write-off batch, you can edit it to make any changes you need, using the 
A/R Adjustment Entry screen. You can also print a batch listing for it and post it as you post any other 
Accounts Receivable adjustment batch. 

Write-off transactions are distributed to the Write-Offs general ledger account specified in each 
customer’s account set. 
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Entering Adjustments Individually

You can enter adjustments, one at a time, in the A/R Adjustment Entry screen, specifying the document 
number to adjust and the general ledger account to debit or credit.

You can also adjust documents that have been completed and cleared from Accounts Receivable or 
enter a general adjustment to an account balance. You enter this type of adjustment as a credit note or 
debit note in the Invoice Entry screen.

When you add an adjustment, Accounts Receivable automatically assigns a document number, 
beginning with 1.

Customer statistics include the total amount and number of adjustments entered for the period, and the 
amount and date of the last adjustment transaction entered. 

Entering Job-Related Adjustments

You can use the Adjustment Entry screen to adjust posted invoices that were created for projects you 
manage using Sage 300 Project and Job Costing. When you select a job-related invoice, job-related 
fields appear that let you specify the contract, project, category, and resource affected.

You can adjust existing details (for example, to change an incorrect project number) and you can add 
details that did not exist on the original invoice.

When you post job-related adjustments, Accounts Receivable:

 l Creates general ledger journal entries to adjust the Accounts Receivable Control account and the 
project's Billings account. For item invoices, it also creates entries for the Work In Progress and 
Inventory Control accounts used in the project's account set.

 l Adjusts the billed amounts for the affected projects in Project and Job Costing. (Note that 
transactions are not moved from one project to another when you post adjustments.)

Adding, Editing, or Deleting an Adjustment Batch

You can use the A/R Adjustment Batch List screen to add a new adjustment batch, or delete an open 
adjustment batch.

You can also use the A/R Adjustment Entry screen to add or delete adjustment batches, and you can use 
it to edit open batches.

Note: To delete a posted batch, or to clear   the data for a deleted batch, use the Clear Deleted And 
Posted   Batches option on the A/R Clear History screen.
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To create an adjustment batch using the Adjustment Batch List screen:

 1. Open Accounts Receivable > A/R Transactions > Adjustment Batch List.

 2. On the Adjustment Batch List, click the New button to create a new batch.

 3. Type a description and a date for the batch.

To create an adjustment batch using the A/R Adjustment Entry screen:

 1. Open Accounts Receivable > A/R Transactions > Adjustment Entry.

 2. Click the New  button beside the Batch Number field.

 3. Enter a date for the new batch, or accept the session date in the field.

 4. Enter a batch description.

 5. Click Save.

To open an existing adjustment batch for editing:

 1. Open Accounts Receivable > A/R Transactions > Adjustment Batch List.

 2. If there is a large number   of adjustment batches, type the number of the batch you want to edit   in the 
Starting Batch Number field, or choose the batch from the Finder. 

Tip: If you have very few adjustment batches, skip this step.

 3. Highlight the batch you   want to open, then click Open.

To delete an open batch:

 1. Open Accounts Receivable > A/R Transactions > Adjustment Batch List.

 2. Type the batch number   or use the Finder to display a list of existing batches, and then select the   
batch you want to delete.

 3. Click the Delete button. 

 4. If you see a message asking you to confirm the deletion, click Yes. 

All transactions in the batch are deleted and the batch is   listed as deleted on the A/R Batch Status 
report. You cannot reuse the batch   number. 
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After adding or opening an adjustment batch

 l You can edit open batches. You cannot edit batches that have Ready  To Post, Posted, or Deleted 
status.

 l Enter adjustments following the instructions in "Adjusting a Posted Transaction" (page 142).

 l Post the adjustment batch using the instructions in "Posting an Adjustment Batch" (page 235).

 l If you do not delete posted batches, you can view them on the A/R Adjustment Batch List screen.

Adjusting a Posted Transaction
 1. Open Accounts Receivable > A/R Transactions > Adjustment Entry.

 2. In the Batch Number field, select or create the adjustment batch to use.

 3. To assign the entry number, click the New  button beside the Entry Number field.

 4. Enter general information for the adjustment entry, including an optional description, the 
adjustment date and posting date, the customer number, and an optional reference.

 5. In the Document Number field, type the document number you want to adjust, or select it using the 
Finder or navigation buttons.

 6. If the document includes a payment schedule, specify the payment number.

 7. In the table, use the Finder for the Adjust Line Number field to select a detail for adjustment.

 8. Include for each detail:                 

 l The distribution code or the general ledger account number.

 l The adjustment amount.                         

 l If you are increasing the amount of an invoice, enter the amount in the credit column.

 l If you are reducing the amount of the invoice, enter the amount in the debit column.

 l If the adjustment is for a job-related document, the contract, project, and category to adjust in 
Project and Job Costing.

 l If you use retainage accounting, retainage information, as necessary.       

For more information, see "About Processing Retainage" (page 161).

 9. Click Add.     

Note: The name of the button changes to Save after you add the entry. If you make changes to the 
adjustment, later, you click Save to record your changes.
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Deleting an Adjustment

To delete an adjustment:

 1. Open Accounts Receivable > A/R Transactions > Adjustment Entry.

 2. Select the batch number for the batch that contains the adjustment entry you want to delete.

 3. In the Entry Number field, type the number of the entry to delete, or use the Finder or the 
navigation buttons to display the entry.

 4. Click Delete. 

 5. If a message appears asking   you to confirm the deletion, click Yes.

About Entering Optional Fields on Adjustment Transactions

Note: Optional fields are available if you use Sage 300 Transaction Analysis and Optional Field 
Creator. For more information, see "About Optional Fields in Accounts Receivable" (page 41).

When you enter a new adjustment transaction, Accounts Receivable displays   any optional fields that are 
set up for automatic insertion in adjustments,   along with their default values. 

The Optional Fields check box on the A/R Adjustment Entry screen shows whether   a selected 
adjustment uses optional fields. (Accounts Receivable sets   this indicator—you   cannot select or clear the 
check box. If you delete all the optional fields   associated with the adjustment, the program resets the 
Optional Fields   indicator.)

Assigning Optional Fields to an Adjustment

To view the optional fields that are used on a selected adjustment,   click the Zoom  button beside the 

Optional Fields check box. The Optional   Fields screen appears, where you can change the values   for 
optional fields that appear as defaults, or delete them. You can also   add any other optional fields that are 
defined for adjustments.

Accounts Receivable assigns default values to adjustment optional fields   as follows:

 l If the optional fields   used on the original document are the same as the adjustment optional   fields, 
the values from the original document appear. 

 l If the customer and adjustment   optional fields are the same, the program displays the values from 
the   customer record. However, if the optional field is also used on the original   document, the value 
from the original document is used.

 l If an adjustment optional   field is not used either on the original document or in the customer 
record,   the program uses the default value specified in the optional field setup   record.

You can change the default value that appears for an optional field,   as follows:
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 l If the optional field   is validated, you must specify a value that is defined for the optional   field in 
Common Services. If the optional field allows a blank, you can   leave the value blank.

 l If the optional field   is not validated, you can select a defined value, or you can enter any   value that 
is consistent with the type of field, providing your entry   does not exceed the length specified for the 
optional field.

Updating General Ledger

When you post an adjustment that includes optional fields, the optional   field information specified for the 
adjustment is included in the journal   entry passed to General Ledger if:

 l You specified in the optional   field setup record that optional field information will be passed to the   
affected General Ledger account. 

 l You used the same optional   fields in the adjustments as you assigned for transaction details in the   
General Ledger account record.

Depending on the settings you chose for the optional field, affected   General Ledger accounts can 
include:

 l Receivables Control

 l Adjustment

 l Prepayment

 l Retainage

 l Exchange Gain (or Realized Exchange Gain)

 l Exchange Loss (or Realized Exchange Loss)

 l Rounding

Invoices, Credit Notes, and Debit Notes
This section describes how to:

 l Create invoice batches.

 l Enter customer invoices, credit notes, and debit notes using the A/R Invoice Entry screen.

 l Calculate tax.

 l Allocate sales amounts to salespersons.

 l Edit exchange rate information.

 l Assign multiple payment schedules to invoices.

 l Enter prepayments with invoices.
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About Invoices, Credit Notes, and Debit Notes

You use the A/R Invoice Entry screen to create new batches for invoices, credit notes, and debit notes. (A 
credit note is an adjustment to a customer's account that decreases the balance of the account, while a 
debit note increases the account balance.) You can add all three document types to a single batch, or use 
separate batches.

With each invoice, credit note, and debit note, you:

 l Enter general invoice information for the document (transaction).

Invoice information includes the customer number, document type and date, shipping location, tax 
group, payment terms, and other data that are the same for the entire document.

 l Add details for the document.

Document details contain information about what the customer purchased, including the price or 
amount of each item. You can have any number of detail lines and amounts on an invoice, credit note, 
or debit note.

With each document, you can also:

 l Enter the payment amounts, dates, and discount information for payment schedules (installment 
payments).

 l Enter data in optional fields.

 l Enter percentages to allocate the document total to up to five salespeople.

 l Enter a prepayment for an invoice.

 l Enter a retainage amount or a percentage, as well as a retainage due date and retainage terms for 
documents that involve a holdback.

 l Select an option to indicate that the document is related to projects you manage using Sage 300 
Project and Job Costing.

 l Enter the contract, project, category, and resource for transactions for job-related details. When 
you post the document, Accounts Receivable updates Project and Job Costing and creates the 
transactions required for General Ledger.

 l Print copies of each document on the preprinted forms you use for invoices, credit notes, and debit 
notes (if you use the Allow Printing Of Invoices option). You can also print these documents after 
they have been posted.

 l If you use Payment Processing, process or void a Paya credit card payment.

If you use multicurrency accounting, you enter amounts in the Invoice Entry screen in the customer's 
currency.

For more information, see the following topics:
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 l "About Applying Credit Notes and Debit Notes to Other Documents" (page 155)

 l "About Assigning Multiple Payments to Invoices" (page 150)

 l "About Calculating Discounts" (page 151)

 l "About Calculating Sales Tax" (page 151)

 l "About Creating General Ledger Transactions for Interest Batches" (page 249)

 l "About Invoice Detail Types" (page 149)

 l "About Entering Invoice Information" (page 146)

 l "About Entering Multicurrency Invoices, Credit Notes, and Debit Notes" (page 154)

 l "About Entering Optional Fields on Invoices" (page 156)

 l "About Entering Prepayments with Invoices" (page 153)

 l "About Entering Sales Splits on Invoices" (page 153)

 l "About Invoicing Interest" (page 247)

 l "About Invoicing Recurring Charges" (page 159)

 l "About Posting Recurring-Charge Batches" (page 233)

 l "About Updating Billing Cycles" (page 167)

 l "About Posting Interest Batches" (page 233)

 l "About Processing Retainage" (page 161)

Editing Unposted Invoices, Credit Notes, and Debit Notes

You also use the Invoice Entry screen to change or correct open invoice batches, including error batches 
created during posting.

If the Allow Edit Of Imported Batches option is selected on the A/R Options screen, you can edit batches 
that were created by other Sage 300 modules or non-Sage 300 programs.

About Entering Invoice Information

Invoices, credit notes, and debit notes contain two types of information:

 l General invoice information

 l Detail information

Invoice Information

Certain information, such as the customer number, document number, and document type, is the same 
for all details in a single invoice, credit note, or debit note. You enter this information on the Document tab 
of the Invoice Entry screen.
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Invoice information for all three types of documents includes:

 l Entry Number.  This is a sequence number that Accounts Receivable assigns to indicate the order 
in which a document was added to a batch. You use entry numbers to select documents for editing 
and to identify documents on Accounts Receivable reports.

 l Customer Number. Identifies the customer and billing address, sets the default tax group and 
payment terms (for invoices), and specifies the currency of the document in multicurrency 
systems.

 l Ship-To Location. (Optional) Specifies the address to which the order is shipped.

 l Document Type. Invoice, Credit Note, Debit Note, or Interest Charge.

 l Document Number. Assigned automatically by Accounts Receivable, using the prefix and next 
number specified on the A/R Options screen for the document type, or you can enter a document 
number. You can use each document number only once.

 l Document Date. Sets the aging date from which the document is aged on statements and reports. 
(You can choose whether to age credit notes and debit notes by document date or treat them as 
current transactions.) Invoices are always aged by due date.

 l Fiscal Year and Period. From the fiscal calendar defined for the company in Common Services. 
Identifies the period to which the document will be posted.

 l Document Description. Appears on the Invoice Batch Listing and the Invoice Posting Journal.

 l Tax Group. Specifies the tax authorities and classes assigned to the customer. Used to calculate 
tax amounts for the document.

 l Purchase Order Number. (Optional) You can sort documents by purchase order number in 
Finders and for receipt application, and you can use the number as the reference or description in 
G/L transaction batches.

 l Order Number. Supplied by Sage 300 Order Entry, if you use it. You can also enter an order 
number. You can sort documents by order number in Finders and for receipt application, and you 
can use the number as the reference or description in G/L transaction batches.

For invoices, you also specify the payment terms, including the due date and discount information. On 
summary documents, you can also indicate whether to calculate tax for the document.

Entering Optional Field Information on Invoices

If you use optional fields, you can also edit or add any optional fields that have been set up for use with 
invoices or invoice details.

For more information, see "About Entering Optional Fields on Invoices" (page 156).

Changing Invoice Information

You can change the following information on the Document tab after you save an invoice:
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 l Document date

 l Document number

 l Description

 l Payment terms and discount information 

 l Purchase order number

 l Order number

 l Ship-to location

 l Tax group

You cannot change the following information:

 l Customer number

 l Document type

Information Entered for Job-Related Invoices

For job-related invoices, debit notes, and credit notes, you also enter the following information for each 
detail:

 l Contract. You must enter a contract number for each detail. You can enter or select only contracts 
with Open or On Hold status. (You cannot process transactions to an account that is On Hold, 
however, if it has never been opened.)

 l Project. You must enter a project for each detail. You can enter or select only projects that are:

 l Assigned to the specified contract.

 l Open, or are on hold but have been previously opened.

 l Have a Billable or No Charge billing type.

 l Not closed to billings.

 l Category. You must specify a category for Time And Material projects, and for cost plus projects where 
the accounting method is Billings And Costs, Category Percentage Complete, or Accrual-Basis.

To enter or select a category, it must use a Billable or No Charge billing type, and it must be assigned to 
the specified project.

You cannot specify categories with details for the following types of projects:

 l Fixed price projects. 

 l Cost plus projects with a Completed Project, Total Cost Percentage Complete or a Labor 
Cost Percentage Complete accounting method.

148Sage 300 2023 Accounts Receivable User's Guide



 l Resource.  For time and material projects, on standard contracts, you must also specify a resource that 
you have attached to the project in Project and Job Costing.

You cannot specify a resource for a basic contract or for a fixed price or cost plus project on a standard 
contract.

 l Date. For time and material projects, enter the date that the cost was incurred.

 l Revenue Account. For most project types and accounting methods, Accounts Receivable displays the 
billings account from the project in the Revenue Account field.

For projects using the Accrual Basis accounting method, the program displays the project's revenue 
account.

You can change the account only for:

 l Time and material projects.

 l Cost plus projects that use the Accrual Basis accounting method.

For all other cost plus projects and for fixed price projects, the program displays the Billings account, 
and you cannot change it.

About Invoice Detail Types

You can enter two types of details in invoice batches, as follows:

 l Summary details. Summary details include just enough information to update your receivables 
records and general ledger revenue account.

 l Item details. Item details include item numbers and update the general ledger revenue, inventory, 
and cost of goods sold accounts.

You select a default detail type in the batch header screen, but you can enter both types of details in a 
single batch. 

Both types of details update the receivables control account assigned to the customer. 

Summary Details

With each summary detail, you enter:

 l Either a distribution code that identifies the revenue general ledger account for the detail, or the 
number of the revenue account.

 l An optional description of the detail.

 l The amount of the detail.

 l An optional comment that you can choose to print on the invoice, credit note, or debit note.
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Item Details

You must create an item list with all items you want to include on invoices before you can enter item 
details. Item records let you update inventory and cost of goods sold general ledger accounts, as well as 
revenue and receivables control accounts. Item details also update statistics in the item records, if you 
use the option to keep item statistics.

With each item detail, you enter:

 l An item number.

 l A unit of measure, such as EACH or DOZEN.

 l An optional description of the detail.

 l The quantity sold or returned.

 l The price per unit of measure.

 l An optional distribution code that identifies the revenue, inventory, and cost of goods sold general 
ledger accounts for the detail. If you do not enter a distribution code, Accounts Receivable uses 
the general ledger account numbers entered in the item record.

 l An optional comment that you can choose to print on the invoice, credit note, or debit note.

When you enter the unit of measure and quantity, Accounts Receivable automatically calculates and 
displays the extended amount (total) for the detail line. You cannot change these two amounts directly.

If you use the Show Item Cost option, you can also see the extended item cost (quantity x unit cost) for 
each detail line. If you use the Use Item Comment As Default option, Accounts Receivable automatically 
displays any comments entered in the item record with details using the item number, but you can 
change the comment, as needed. Select these options on the A/R Options screen.

About Assigning Multiple Payments to Invoices

You can enter invoices that will be paid by a series of payments, or installments. For example, you can 
allow your customer to make   six payments over a certain period to pay a single invoice.

To allow an invoice to be paid in installments, you assign a terms code that includes a multiple payment 
schedule that specifies the required number of payments and a series of due dates spread over the   
desired period (such as six monthly payments).

Multiple payment schedules help you to track the payments for each invoice, and they let you charge 
interest on scheduled payments that are overdue,   rather than on the invoice total. 

Based on the information entered for the terms code, Accounts Receivable   creates a payment schedule 
that divides the invoice total into the specified   number of payments, each with its own due date, payment 
amount, and discount   period. The payment information is displayed on the Payment Schedule tab   of the 
A/R Invoice Entry screen. You can change the payment schedule after you have added   the invoice. 
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Receiving a Scheduled Payment

When you receive a scheduled payment from the customer, you use the   A/R Receipt Entry screen to 
apply the receipt to the particular payment for   the invoice.

Including Payment Schedules on Batch Listings

You can print payment schedules on batch listings by selecting   the Show Schedules option on the 
A/R Batch Listing screen.

About Calculating Discounts

If you offer discounts for early invoice payment, you define a terms code for each of the methods you use 
to calculate discount amounts and discount periods.

Accounts Receivable uses the terms code you specify with an invoice to calculate the discount period 
and amount for the document. 

If you use a terms code that includes multiple payments, Accounts Receivable sets up a payment 
schedule that includes separate discount information for each payment.

You can specify whether an invoice discount applies to a particular detail, or not. To indicate that a detail 
is not subject to the invoice discount, you clear the Discountable option for the detail on the A/R  Detail 
Items/Taxes screen, or select No for the Discountable option on the detail-entry table.

You can change the discount date, discount base, amount, and discount rate at any time until you post 
the invoice.

You must enter a discount date before you can enter an amount or a rate. The discount date determines 
whether a discount is available on the A/R Receipt Entry screen. If a discount is available, Accounts 
Receivable displays the available discount amount and the invoice total net of the discount when you 
apply receipts to the invoice.

You cannot enter a discount amount or percentage if the Discount Date field is blank.

You can also enter a volume discount by entering a negative detail line on an invoice, as long as the 
invoice total is a positive amount.

Note: Discounts do not apply to credit notes and debit notes.

About Calculating Sales Tax

A tax amount is calculated for invoices, credit notes, and debit notes if all of the following conditions are 
true:

 l The customer is subject to tax.

 l The document contains taxable details.
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 l You select the Calculate Tax option.

 l Tax rates are entered for the tax authorities and classes in the Tax Services module.

Changing Tax Amounts

Accounts Receivable uses the tax rates in entered for tax authorities in Tax Services to calculate taxes 
for a document each time you save it. The tax total for each tax class and for the document appear on the 
Totals tab on the A/R Invoice Entry screen.

If you need to change the calculated tax amounts, you can change sales tax rates for the whole system 
by changing tax rates in Tax Services. For information about setting up records for tax authorities and 
entering tax rates, see the Tax Services help.

If you want to change tax amounts for a single document, you can enter the tax amount manually, or you 
can change one of the following on the A/R Invoice Entry screen:

 l The customer’s tax class for the invoice on the Taxes tab.

 l The tax class for a detail using the Detail Accounts/Taxes screen.

In addition, if you specify a ship-to location that is subject to a different tax authority than applies to the 
customer, Accounts Receivable automatically changes to the tax group assigned to the ship-to location. 
You can still choose another tax group, if necessary.

Entering Taxes Manually on Invoices

You can stop Accounts Receivable from calculating tax on invoices, for example, if you need to enter a 
different amount or if you are adding details that already include taxes or are not taxable.

You can also prevent recalculation of tax amounts when you change the tax group or tax classes on 
invoices, credit notes, and debit notes.

Before you can enter taxes manually, you must clear the Calculate Tax option on the Document tab or on 
the Taxes tab.

Allocating Document Tax Amounts to Summary Details

If you clear the Calculate Tax option, additional buttons appear on the Taxes tab:

 l Distribute Taxes. Click this button to prorate the tax you enter and allocate it to invoice details.     

Note: You cannot prorate tax to a tax authority for an invoice detail if the authority uses an exempt tax 
class.

 l Calculate Tax. Click this button to have the program recalculate taxes using the tax base and tax 
class entered for the tax authority on the Taxes tab.
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To view the tax amount allocated to a detail, select the detail on the detail table (on the Document tab), 
and then click the Account/Tax button. The Detail Accounts/Taxes screen appears showing the new tax 
amount calculated for the detail.

About Entering Sales Splits on Invoices

You can assign portions of each transaction total you enter in the Invoice Entry screen to each 
salesperson who is responsible for the customer account or sale. If you track statistics for sales staff, 
Accounts Receivable uses this information to update the statistics when you post the transaction.

To allocate transaction totals to salespersons, use the Sales Split tab in the Invoice Entry screen. You do 
not have to assign salespersons but, if you do, the percentages must total 100.

If you keep salesperson statistics, but do not assign percentages on the Sales Split tab, Accounts 
Receivable adds the transaction total to the statistics for the salesperson assigned to the customer 
record.

Even if you do not keep salesperson statistics in Accounts Receivable, you may want to use this option to 
record who made the sale.

About Entering Prepayments with Invoices

You can enter a prepayment together with the invoice to which it applies using the A/R Invoice Entry 
screen.

When you enter a prepayment using the Invoice Entry screen, you can choose an existing receipt batch 
to contain the prepayment or you create a new receipt batch from within the Invoice Entry screen.

Information you enter with a prepayment includes:

 l Receipt batch number

 l Receipt type (check, cash, credit card, other)

 l Check number or other document reference

 l Receipt amount

 l Date

 l Rate type (multicurrency transaction)

 l Exchange rate (multicurrency transaction)

To enter a prepayment in the A/R Invoice Entry screen, enter and save the invoice details, and then click 
Prepay.

You can also enter prepayments in the A/R Quick Receipt Entry screen and in the A/R Receipt Entry 
screen.
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Entering Credit Card Prepayments

If you use Payment Processing and want to process a credit card prepayment for an invoice, you must:

 l Select a payment code that uses the payment type SPS Credit Card before adding the document. 
To see a list of payment codes and associated payment types, you can click the Payment Code 

Finder .                 

After you select a payment code, the Processing Code field appears, along with a status field that 
informs you whether a credit card transaction has been processed.

 l Select a processing code, which specifies the bank, currency, and merchant account that will be 
used to process the transaction. The bank and currency for the processing code must match the 
bank and currency specified for the current batch and transaction.

About Entering Multicurrency Invoices, Credit Notes, and Debit Notes

This section summarizes the steps you take to add invoices, credit notes, and debit notes in currencies 
other than the functional (home) currency.

If you use multicurrency accounting, you enter amounts in the Invoice Entry screen in the customer's 
currency. When you specify a customer number, the customer's currency code is displayed on the 
Document tab.

You enter multicurrency transactions in the same way as functional-currency transactions. The only extra 
consideration arises if you need to change exchange rates or assign a different tax group to the 
transaction.

If the customer does not use the functional currency, a Rates tab appears on the Invoice Entry screen, 
displaying the currency code, rate type, rate date, and current exchange rate for the document. When you 
enter a credit note or debit note for a specific invoice, the original exchange rate used for the invoice is 
displayed. 

You use the Rates tab to change the rate type, rate date, and exchange rate for the document. You 
cannot change the currency. You enter all amounts in the customer's currency.

Note: You can change the tax group for a document only to another tax group that also uses the 
customer's currency.

Multicurrency Details

You do not enter currency information with details. You enter all detail amounts in the customer's 
currency. Accounts Receivable calculates the functional-currency amount using exchange rates from the 
Currency screens in Common Services. 

154Sage 300 2023 Accounts Receivable User's Guide



Entering Prepayments with Multicurrency Invoices

You enter prepayments in the customer's currency.

After adding and saving invoice details, click the Prepay button to display the Prepayments screen. 

You can create a receipt batch, or you can add the prepayment to an existing receipt batch.

You enter the prepayment amount in the receipt  currency. Accounts Receivable uses the information 
specified for the prepayment on the Rate Override screen to convert the payment amount to the customer 
currency and/or the functional currency, if the bank currency or the customer currency are different from 
the functional currency. (To open the Rate Override screen, you click the Rates button on the 
Prepayment screen.)

When you post multicurrency transactions, Accounts Receivable converts the amounts to the functional 
currency, using the exchange rate information entered with the transaction.

About Applying Credit Notes and Debit Notes to Other Documents

When you enter credit notes and debit notes using the A/R Invoice Entry screen, you can also enter the 
number of the document to which the note applies.

If the note applies to several invoices or is issued on account (for example, as a purchase volume 
rebate), you do not enter an invoice number here. You apply the credit note or "pay" the debit note later, 
using the A/R Receipt Entry screen.

For job-related credit notes and debit notes, if you specify an Apply To document:

 l The credit note or debit note can use only jobs that were used on the apply-to document.

 l The credit note cannot reduce the current outstanding amount or quantity for a detail to less than 
zero.

About Checking Customer Credit During Invoice Entry

Invoice Entry performs a credit check when you enter a document for a customer if one or more credit-
check options are selected in the customer record.

The type of information Accounts Receivable includes during a credit check depends on:

 l The credit-check options specified for the customer.     

 l If the option Total Outstanding Balance Exceeds the Credit Limit is selected, Accounts 
Receivable checks the amount of the invoice, retainage invoice, or debit note you are 
entering against the customer’s outstanding balance and the customer's credit limit.

 l If the option A/R Transactions [ ] Days and Later Exceeds [ ] is selected, Accounts 
Receivable checks the total amount of Accounts Receivable transactions that exceed the 
transaction due dates by a specified number of days or more.        
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Note: Prepayments, unapplied cash, and receipts are always included when calculating the 
aged overdue amount.

 l The credit-check options specified for the national account, if the customer is assigned to a 
national account.

 l The credit-check options selected for Accounts Receivable. 

The outstanding balance can include pending Accounts Receivable transactions, and transactions from 
Order Entry or third-party applications.

Note: Pending transactions are not included in the credit check for the national account, regardless 
of the options you chose for Accounts Receivable.

 l The customer's outstanding balance. If you selected any options to include pending transactions in 
credit checks (on the A/R Options screen), the outstanding balance may include pending 
transactions.

If the credit check determines that the outstanding balance exceeds the credit limit, or that the aged 
transactions exceed the overdue limit, the program displays a Credit Check screen, showing the credit 
problems.

If the customer belongs to a national account for which a credit-check option is selected and the 
customer's account exceeds the credit limit or overdue limit stipulated for the national account, credit 
information for the national account also appears on the Credit Check screen.

About Entering Optional Fields on Invoices

You can use optional fields with Invoice Entry if:

 l You use Transaction Analysis and Optional Field Creator and you have set up system-wide 
optional fields.

 l You set up optional fields for invoices and invoice details. For more information, see "A/R Optional 
Fields Screen" (page 519).

When you start a new invoice, Accounts Receivable uses the optional fields that are marked for 
automatic insertion on invoices and invoice details. You can view or change optional fields, as follows:

 l On the Optional Fields tab of the A/R Invoice Entry screen, you can view or assign optional fields 
for specific invoices. More...

The program displays the optional fields that you set up for automatic insertion, and displays their 
default values, as follows:

 l If you assigned the same optional fields to the customer and ship-to location records as you 
defined for invoices, the optional field values for the ship-to location appear on the Optional 
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Fields tab.

 l If the optional fields in the ship-to location record and the customer record are different from 
each other, the optional field values from the customer record appear as defaults for the 
invoice.

 l If an optional field is defined for invoices, but is not assigned either to the customer or the 
ship-to location, the program displays the value specified for the optional field in the 
Optional Fields record.

Note: You can add or delete optional fields for invoices. However, you can add only optional fields 
that you have defined for invoices on the A/R Optional Fields screen.

 l On the Detail Accounts/Taxes screen (which you open by clicking the Zoom  button beside the 
Optional Fields option on the A/R Invoice Entry detail table), you can view or assign optional fields 
for selected invoice details. More...

When you first enter an invoice, if at least one optional field is set for automatic insertion in invoice 
details, the Optional Fields option is automatically selected. Otherwise, the option is not selected.

Note: The Optional Fields option is set automatically—you cannot change it. If you delete all the 
optional fields associated with the detail, the program resets the Optional Fields option.

You can use the A/R Optional Fields screen to check or change the optional fields that are used for a 
detail. To do this, select the detail, and then do one of the following:

 l Click the Zoom  button beside the field.

 l Press Shift+F9.

Note: You can add or delete optional fields for invoice details. However, you can add only optional 
fields that are defined for invoice details.

You can change the default value that appears for an optional field, as follows:

 l If the optional field is validated, you must specify a value that is defined for the optional field in 
Common Services.     

Note: If the optional field allows blanks, you can leave the value field blank.

 l If the optional field is not validated, you can enter any value that is consistent with the type of field 
(such as yes/no, text, number, date, or amount), providing the value you enter does not exceed the 
length permitted for the field. You can also leave the field blank.

Note: When you specify a value that is defined in Common Services, the description for the value is 
also displayed.
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Optional Fields for Job-Related Details

On job-related invoices, if the optional fields for the invoice details match the optional fields used in 
Project and Job Costing, the values from Project and Job Costing appear as defaults, as follows:

 l Time and materials projects:     

 l For basic contracts, values from matching optional fields used by the project category 
appear.

 l For standard contracts, values from matching optional fields used by the project resource 
appear.

 l Fixed price projects:

 l For projects that use a Completed Project or Project Percentage Complete accounting 
method, values from matching optional fields used by the project appear.

 l For projects that use a Billings and Costs or Accrual-Basis accounting method, values from 
matching optional fields used by the project category appear.

 l Cost plus projects:

 l For projects that use a Completed Project, Total Cost Percentage Complete, or Labor 
Hours Percentage Complete accounting method, values from matching optional fields used 
by the project appear.

 l For projects that use a Billings and Costs, Accrual-Basis, or Category Percentage Complete 
accounting method, values from matching optional fields used by the project category 
appear.

If the invoice detail optional fields do not match those used in Project and Job Costing, the values from 
the optional field setup records appear.

The optional field information is passed to Project and Job Costing when you post job-related invoices if:

 l You selected the Project and Job Costing Billings setting for the optional field in the optional field 
setup record.

 l The invoice details optional fields match the optional fields defined for Project and Job Costing 
billings.

Optional Fields for Retainage Document Details

On retainage documents, the optional fields and values specified on the original documents are used as 
defaults for the related retainage invoices, retainage credit notes, and retainage debit notes, whether you 
enter the retainage documents manually or create them using the A/R Create Retainage Batch screen.

Updating General Ledger

When you post an invoice that includes optional fields, optional field information for invoice headers and 
invoice details is included in the journal entry passed to General Ledger if:
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 l You specified in the optional field setup record that optional field information will be passed to the 
General Ledger account.

 l You used the same optional fields in the invoices and invoice details as you assigned for 
transaction details in the General Ledger account record.

Depending on the settings for the optional field, the accounts can include:

 l For invoice details:     

 l Revenue accounts (both summary and item invoices).

 l Inventory accounts (item invoices).

 l Cost of Goods Sold accounts (item invoices).

 l For invoice headers:     

 l Receivables Control.

 l Retainage Control.

 l Sales Tax.

 l Prepayment Liability.

 l Receipt Discounts.

 l Exchange Gain or Realized Exchange Gain (including rounding).

 l Exchange Loss or Realized Exchange Loss (including rounding).

 l Receipt Entry.

 l Receipts.

About Invoicing Recurring Charges

If you regularly invoice some of your customers for the same charges, such as monthly rent, you can 
automatically create invoices for all or a selection of the charges and customers at once.

The ability to create separate recurring charge batches saves you from having to enter an invoice for 
each recurring charge and customer yourself. It also provides an specific audit trail for the recurring 
charges by assigning them a separate batch type (Recurring).

You use the Recurring Charge setup screen in the Customers folder to add records for the recurring 
charges you use and to assign them to customers. For information about setting up recurring charge 
records, see "About Recurring Charges" (page 93).

When you process recurring charges, Accounts Receivable:

 l Updates the Unposted Total Invoiced, Unposted Number Of Invoices, and Last Generated 
fields in the recurring-charge record each time you use the Create Recurring Charge Batch screen 
to create an invoice for the charge.
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If you subsequently adjust the unposted invoices, Accounts Receivable updates these fields 
accordingly.

 l Updates statistical amounts for the last invoice posted in the recurring-charge record, and it adds 
the invoice amount to the Year To Date Total Invoiced and Year To Date Number Of Invoices 
field when you post the invoices.

 l Accounts Receivable clears the Year To Date totals in the recurring-charge record if you choose 
to clear recurring charge year-to-date statistics at year end.

Invoicing Frequency

The schedule attached to a recurring charge record determines the invoice frequency as well as the day 
on which to bill the charge, so that the charge is invoiced only if you create a recurring charge batch on or 
after that day. 

If the schedule uses a reminder, System Manager reminds specific or all Sage 300 users to create 
invoices for recurring charges. (To find out more about creating schedules and using reminders, see the 
System Manager help.)

If you assigned a billing cycle to a recurring charge, you invoice it at the frequency entered for the billing 
cycle.

Note: Accounts Receivable warns you if you try to process statements before you have created current 
recurring charge invoices.

Creating Recurring Charge Batches

When you are ready to invoice recurring charges, you use the A/R Create Interest Batch screen. You can 
create recurring charge invoices by customer number, customer group, national account, billing cycle, or 
recurring charge code. For more information, see "A/R Create Interest Batch Screen" (page 469).

Terms Used for Recurring Charge Invoices

Recurring charge invoices use the terms code from the recurring charge setup record. If the terms code 
was left blank, the customer's terms are used.

Assigning Document Numbers to Recurring Charge Invoices

When you create a recurring charge batch, Accounts Receivable automatically assigns a document 
number to each invoice. The document numbers use the prefix and start with the next number assigned 
for recurring charges on the Numbering tab of the A/R Options screen.

Accounts Receivable creates invoices for the amounts specified in the selected recurring-charge records.
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When you post a recurring charge invoice, Accounts Receivable checks to ensure that the invoice total 
(including taxes) does not exceed the recurring charge limit. If the invoice exceeds the limit, the invoice is 
not posted and it is placed in an error batch.

You can have as many recurring charge batches as you need in your Accounts Receivable system at a 
time. Accounts Receivable warns you when you create a recurring charge batch while there is another 
unposted recurring charge batch in the system, in case you created the second batch by accident. You 
can edit the batches, print listings for them, and post them in the same way you process other types of 
batches.

Reusing Deleted Recurring Charge Invoice Numbers

If you delete a batch of recurring charge invoices before posting them, Accounts Receivable does not 
automatically reset the next invoice number for recurring charges on the A/R Options screen. To prevent 
gaps in your audit trail of recurring charge invoice numbers, you should change back to the number 
assigned to the first invoice in the deleted batch.

Manually Billing a Recurring Charge

If you accidentally delete a recurring charge invoice, or if you need to create an additional invoice for 
another reason, you can invoice a recurring charge manually. For more information, see "Invoicing a 
Recurring Charge Manually" (page 181).

Reporting Recurring Charge Invoices

Invoices for recurring charges are shown as transaction type RC on all listings and reports in Accounts 
Receivable, and the batch type is Recurring. The G/L Transactions report assigns AR-RC as the source 
code for recurring charge invoices.

When you post a batch of recurring charges, the program adds the recurring-charge amounts to 
customer period-to-date and year-to-date invoice totals. It also updates the last run date in the recurring 
charge record. The same date is entered in the billing cycle record, if you processed the charges by 
billing cycle.

About Processing Retainage

You can use Accounts Receivable to account for retainage (or a "holdback") that   occurs when your 
customer withholds a percentage of an invoiced amount,   usually by mutual agreement or according to a 
statute (such as a Builders   Lien Act).

Before you can process retainage in Accounts Receivable, you must:
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 l Set the Retainage Accounting option on the Processing tab of the A/R Options screen.

 l Specify retainage settings for customers on the Retainage tab of the A/R Options screen. For more 
information, see "A/R Options Screen" (page 523).

 l Specify a retainage account for each account set in your Accounts Receivable system. For more 
information, see "A/R Account Sets Screen" (page 491).

There are two steps in processing retainage:

 1. First, you post an original invoice, debit note or credit note that specifies a holdback (retainage) for 
the document.

 2. Later, you post a separate retainage invoice, debit note, or credit note to invoice the outstanding 
retainage amount.

Entering Original Documents with Retainage

An invoice, debit note, or credit note from which retainage is taken is called an original document in Sage 
300.

You enter the original invoice, debit note, or credit note using the Invoice Entry screen, as usual. To 
indicate that retainage applies to the document, you select the Retainage option. (This option appears 
only if the Retainage Accounting option is selected for your Accounts Receivable system.)

The program then displays the retainage percentage, retention period, retainage rate, and the retainage 
terms from the customer record. Unless the document is job-related, you can change these retainage 
factors for a particular detail or for the document, as follows:

 l Retainage Amount. (specified for a document detail)

To calculate the retainage amount, the program multiples the document amount (or the document total, 
if you include taxes in retainage) by the retainage percentage. You can enter a new retainage amount, if 
necessary. When you enter an amount to replace a calculated amount, the program recalculates the 
retainage percentage.

The retainage amount is subtracted from the document amount (or the document total) to calculate the 
amount due.

 l Retainage Percentage. (specified for a document detail)

The program uses the retainage percentage to calculate the retainage amount.

You can enter a different retainage percentage in the Retainage Percentage (%) field. When you enter a 
new percentage, the program recalculates the retainage amount.

 l Retainage Due Date. (specified for a document detail)
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The program calculates the retainage due date (the date the outstanding retainage is due for invoicing) 
by adding the number of days in the retention period to the original document date. You can enter a 
different due date.

 l Retention Period. (specified for a document detail)

The program uses the retention period to calculate the due date for the retainage document. When you 
change the retention period, the program recalculates the retainage due date, and vice versa.

 l Retainage Rate. (specified for the document on the Retainage tab)

You use this field to specify the method the program will use to determine the exchange rate for the 
retainage document when you eventually process it. 

You can choose one of the following methods:

 l Use Original Document Exchange Rate. Select this option to use the same rate as the 
document you are processing.

 l Use Current Exchange Rate. Select this option to use the rate in effect when you process 
the retainage document invoicing the customer for the outstanding retainage.

 l Retainage Terms. (specified for the document on the Retainage tab)

You can use different terms for retainage documents (used to invoice for outstanding retainage) than 
you used for the original document from which the retainage was taken.

The program displays the code specified for retainage terms in the customer record, but you can 
change the retainage terms for a document, if necessary.

Apply Document Transactions

When you apply original debit notes or credit notes that include retainage using the Invoice Entry screen, 
or when you apply credit notes using the Receipt Entry screen, only the original document balances are 
affected.

Outstanding retainage amounts remain with original documents until you post retainage documents or 
adjustments to clear the outstanding retainage.

Posting Original Invoices, Debit Notes, and Credit Notes

When you post the original retainage document, the program deducts the retainage from the document 
total, and posts the amount to the retainage control account.

Example: You enter an invoice for $10,000 with 10% retainage. The invoice is posted for $9,000 with 
retainage outstanding of $1,000.

The retainage amount remains in the control account until you invoice it in accordance with:
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 l The retention period or retainage due date specified for the invoice.

 l The number of days in advance specified on the A/R Options screen for generating retainage 
documents.

Adjusting Original Documents

You can adjust retainage for existing invoices, debit notes, and credit notes using the A/R Adjustment 
Entry screen, as follows:

 l To change the retainage amount for an original document, you use the detail-entry table to adjust each 
detail or to add a new detail that includes retainage. Enter the amount by which to adjust retainage in 
the retainage debit or retainage credit fields on the table.

You can also add retainage to a document that did not include retainage. You enter the retainage due 
date, as well as the retainage amount, for each detail on the detail-entry table. You also enter retainage 
terms and the retainage exchange rate for the document, if you are adding retainage to a document for 
the first time.

 l You specify retainage terms and the retainage exchange rate option for the whole document on the 
Retainage tab.

Note: If retainage was included on the original document, the program uses the retainage exchange 
rate setting from the original document.

 l If you add a new detail to which retainage applies, the retainage document detail inherits the 
Discountable status from the distribution code used in the adjustment detail.

If you do not use a distribution code in the adjustment detail, the retainage detail is discountable by 
default.

 l You can change both the retainage amount and add or change document details. The program then 
creates two entries: one for the detail adjustment, and the other for the retainage adjustment. It does not 
create a compound entry.

When you post the adjustment, the program adjusts the outstanding retainage account.

No Retainage Calculation for Adjustments

Accounts Receivable does not calculate any retainage on adjustment transactions. You must enter the 
retainage manually, whether you are adding it for the first time, or adjusting existing retainage debits or 
credits from original documents.

When you adjust retainage invoices, debit notes, and credit notes that you processed to clear outstanding 
retainage amounts, the Retainage Debit and Retainage Credit fields do not appear. You can change the 
distribution code, general ledger account, and debit or credit amount using the detail entry table, as you 
do for any adjustment that does not include retainage.
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Note: Because outstanding retainage amounts have already been cleared, no adjustment to 
outstanding retainage is made. The adjustment is to the receivables control account and another 
account, such as an expense account, that you specify.

Invoicing Outstanding Retainage

You invoice for outstanding retainage amounts, or holdbacks, either manually, using the A/R Invoice 
Entry screen, or automatically, using the A/R Create Retainage Batch screen. For more information, see 
"A/R Create Retainage Batch Screen" (page 475).

If you have posted debit notes and credit notes to which retainage applied, you also create retainage 
debit notes and credit notes using the A/R Invoice Entry screen and the A/R Create Retainage Batch 
screen.

Note: Accounts Receivable uses the Summary detail type for processing outstanding retainage.

Invoicing Manually for Retainage

Normally, you would use the A/R Create Retainage Batch screen to invoice periodically for retainage. 
However, Accounts Receivable also lets you process outstanding retainage manually, as you require.

To invoice manually for outstanding retainage, or to manually process a credit note or debit note to clear 
an outstanding retainage amount, you use the Invoice Entry screen.

You enter information for the retainage invoice, credit note, or debit note, as usual. However, to invoice 
for retainage, you must:

 l Select Summary as the detail type. (Retainage documents are summary documents.)

 l Select Retainage Invoice, Retainage Credit Note, or Retainage Debit Note as the document type, 
consistent with the original retainage document for which you are now processing outstanding 
retainage. 

Note: These options are not available if you select Item as the detail type.

Because outstanding retainage remains associated with the original retainage document, you must use a 
retainage invoice if the original document was an invoice, a retainage credit note if the original document 
was a credit note, and a retainage debit note if the original document was a debit note.

Use the Original Document field to specify the original retainage document for which you are processing 
the outstanding retainage.

When you post the retainage invoices, credit notes, or debit notes, the program transfers outstanding 
retainage amounts from the retainage control account to the receivables control account.
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Taxes on Retainage

Tax on retainage is processed according to the Report Tax option selected on the A/R Options screen. 
The option provides the following alternatives:

 l At Time Of Original Document.

If you select this option, the program calculates and reports (posts) tax on retainage when you post an 
original document that includes retainage.

 l As Per Tax Authority.

If you select this option, Accounts Receivable calculates tax when you post an original document, but 
reports (posts) the tax as required by each tax authority. The tax reporting requirements for each tax 
authority are specified by the Report Tax On Retainage Document option in Tax Services. The tax 
authority can specify No Reporting, At Time Of Retainage Document, or At Time Of Original 
Document.

Some tax authorities require you to report tax when you post a retainage document. Others let you 
report tax when you post an original document to which retainage applies.

 l If the tax authority reports tax At Time Of Original Document, the tax amount is calculated 
and the tax tracking reports are updated immediately when you post original documents.

 l If the tax authority reports tax At Time Of Retainage Document, the tax amount is 
calculated when you post the original document, but it is not reported until you post the 
retainage document.

Note: To report tax, the program posts tax amounts to a tax liability account and updates the tax 
tracking reports. The timing of the tax liability on retainage documents depends on the tax authority.

Viewing Retainage Information

You can view retainage information on the following screens and report:

 l Customer Inquiry.

Select a retainage transaction on the Documents tab, then use the following buttons to display 
retainage information:

 l Click the Drilldown  button to open the retainage document in the transaction entry 
screen.

 l Click the Inquiry  button to display information for the retainage document in the 
Document Inquiry screen.

 l Document Inquiry. 

This screen  shows:
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 l The original retainage amount, the outstanding retainage amount, if any, and the retainage 
due date (on the Header tab).

 l The retainage documents used to clear the outstanding retainage amount for the original 
document, if you have processed any (in the bottom table on the Transactions tab).

 l Customers.

The Outstanding Retainage field on the Activity tab of the Customers screen displays the amount of 
retainage outstanding for a selected customer.

 l Aged Retainage Report. 

For more information, see "Printing the A/R Aged Retainage Report" (page 325).

Writing Off Outstanding Retainage Amounts

You use the A/R Create Write-Off Batch Screen to write off small or uncollectible outstanding retainage 
amounts from original retainage invoices, debit notes, or credit notes. For more information, see 
"A/R Create Write-Off Batch Screen" (page 477).

When you write off outstanding retainage, the program creates adjustments to remove balances from the 
retainage control account. A corresponding debit (or credit) to balance the entry is entered to the write-off 
account specified for the customer's account set.

Revaluing Outstanding Retainage Amounts

If you use multicurrency, when you run Revaluation, the program also revalues outstanding retainage 
amounts.

For revalued outstanding retainage, the program creates general ledger entries to adjust the retainage 
control account rather than the receivables control account.

The Revaluation Posting Journal includes a separate section for retainage after the current revaluation 
for each customer.

If you include job-related details on the posting journal, a new retainage section appears on the Summary 
page after the current job details.

About Updating Billing Cycles

When you create and post interest batches by billing cycle, Accounts Receivable enters the posting date 
in the Interest Last Invoiced field in the records for the billing cycles for which you charged interest. Use 
the A/R Billing Cycles screen to view this information.

If you do not charge interest by billing cycle, Accounts Receivable does not enter the posting date in 
billing cycle records.
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Adding, Editing, or Deleting an Invoice Batch

Before You Start

 l Set up the following Accounts Receivable records:

 l Account sets

 l Distribution codes

 l Billing cycles

 l Interest profiles

 l Terms codes

 l Items (if you use an Accounts Receivable item list)

 l Optional fields, if used

 l Salespersons (if you assign salespersons to customers)

 l Customer groups

 l National accounts, if used

 l Customers

 l Ship-to locations, if used

 l Use the Transactions tab on the A/R Options screen to select options for processing invoices, 
credit notes,and debit notes.

 l Use the Numbering tab on the A/R Options screen to enter the prefixes and next numbers to 
assign to documents, if you want Accounts Receivable to assign the numbers automatically.

 l Define the following information in Tax Services and Bank Services:

 l Tax authorities, tax groups, tax classes, and tax rates

 l Bank codes

 l Before adding transactions to an invoice batch:

 l Make sure you have complete information for each document you want to enter, including 
the customer number, document number (if you want to assign your own document 
numbers), date, purchase order number, if any, and sales order number, if any.

 l If you are entering credit notes or debit notes, find out the invoice number to which they 
apply, if any.

 l If you will enter summary details, find out the distribution code or general ledger account 
number for each detail.

 l If you will enter item details, find out the item number, unit of measure, quantity, and price 
for each detail.
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 l In multicurrency ledgers:

 l Update currency information and exchange rates in the Currency screens in 
Common Services.

 l Find out the rate type, rate date, and exchange rate to use for each invoice, credit 
note, debit note, and prepayment.

You can create batches from the A/R Invoice Batch List screen or from the A/R Invoice Entry screen.

To create a new invoice batch using the Invoice Batch List screen:

 1. Open Accounts Receivable > A/R Transactions > Invoice Batch List.

 2. When the screen opens, click New to create a new invoice batch and open the A/R Invoice Entry 
screen, where you can enter the batch date and description, and select the detail type for the 
batch.

To create a new invoice batch using the Invoice Entry screen:

 1. Open Accounts Receivable > A/R Transactions > Invoice Entry.

 2. Click the New  button beside the Batch Number field. 

Accounts Receivable assigns a new batch number.

 3. In the field beside the Batch Number field, type a description for the batch.

 4. Accept the session date in the Batch Date field, or type over the date if you want to change it.       

 5. To view or change the default detail type for the batch:

 a. Click the Zoom  button beside the Batch Number field to open the Batch Information 
screen.

 b. In the Default Detail Type field, select  Item or Summary.

 c. Click Close.

To display an existing invoice batch for editing or deleting:

 1. Open Accounts Receivable > A/R Transactions > Invoice Entry.

 2. Type the batch number in the Batch Number field, or use the  Finder to display a list of existing batches, 
and then select the batch you want from the list.

Tip: You can also click the navigation  buttons for the field to move quickly through the 

batches to display the one you need.
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 3. If you want to delete the batch:

 a. Click the Delete button. 

 b. If you see a message asking you to confirm the deletion, click Yes. 

All transactions in the batch will be deleted and the batch will be listed as deleted on the Batch Status 
report. You cannot reuse the batch number. 

Note: To clear the data for the deleted batch from Accounts Receivable, select the Clear Deleted And 
Posted Batches option when you clear history using the Clear History screen. 

Tip: 
You can also open existing batches from the A/R Invoice Batch List by:

 l Double-clicking a batch.

 l Selecting a batch, and then clicking the Open button.

To view header information for a batch:

 1. Open Accounts Receivable > A/R Transactions > Invoice Entry.

 2. Type the batch number in the Batch Number field, or use the  Finder to display a list of existing batches, 
and then select the batch you want from the list.

 3. Click the Zoom  button beside the Batch Number field to display the A/R Batch Information 
screen .    

Invoicing a Customer

Before You Start

 l Make sure you have complete information for each document you want to enter, including the 
customer number, document number (if you want to assign document numbers manually), date, 
purchase order number, if any, and sales order number, if any.

 l If you plan to enter summary details, find out the distribution code or general ledger account 
number for each detail.

 l If you plan to enter item details, find out the item number, unit of measure, quantity, and price for 
each detail.

 l Find out the rate type, rate date, and exchange rate to use for each invoice, credit note, debit note, 
and prepayment and, if necessary, update the currency information and exchange rates in 
Common Services.
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 l If retainage applies to the document, find out the retainage percentage or retainage amount, 
retention period, retainage due date, retainage terms, and whether to use the exchange rate from 
the original document or the current exchange rate when you process the outstanding retainage.

To add an invoice:

 1. Open Accounts Receivable > A/R Transactions > Invoice Entry.

 2. Select an existing batch using the Batch Number field, or create a new batch.

To create a new batch:

 a. Click the New  button beside the Batch Number field. 

Accounts Receivable assigns a new batch number.

 b. In the field beside the Batch Number field, type a description for the batch.

 c. Accept the session date in the Batch Date field, or type over the date if you want to change 
it.        

To view or change the default detail type for the batch:

 a. Click the Zoom  button beside the Batch Number field to open the Batch Information screen.

 b. In the Default Detail Type field, select  Item or Summary.

Click Close.

 3. Enter header information for the document on the Document tab. More...

Header information includes:

 l A description for the document.

 l Customer number.

 l Whether the document is job-related.

When you select the Job Related option, additional fields appear on the detail entry table and on 
the Detail Accounts/Taxes screen, where you enter job-related information.

 l Whether the document is subject to retainage (a holdback).

The Retainage option appears in Invoice Entry only if you selected the Retainage Accounting 
option for your Accounts Receivable system. When you select the Retainage option, a Retainage 
tab appears, which you use to specify retainage terms for the document.

If you have a multicurrency ledger, you also use the Retainage tab to specify whether to use the 
original exchange rate or the current exchange rate when you produce the retainage document.
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Retainage fields also appear in the detail-entry table where you specify the retainage percentage 
or retainage amount, retention period, and retainage due date for each detail.

 l Ship-to location and a ship via method.

 l Document type.

You can select invoice, credit note, or debit note, and, on a summary invoice, interest, retainage 
invoice, retainage credit note, retainage debit note.

 l Original document.

If you are processing a retainage invoice, debit note, or credit note, specify the original document 
for which you are now processing retainage.

 l Document number (leave, to have the program assign a number to the document).

 l Document number that the current document applies to (for a credit note or debit note).

 l Document date (for aging and statistical purposes).

 l Date to which you want to post the document.

 l Purchase order and sales order numbers.

 l Any special instructions regarding the invoice, credit note, debit note, or interest invoice.

 4. On the Document tab, in the detail table, add summary details or item details. More...

To add summary details:

 a. If this is a job-related document, enter the contract and project, and (as applicable) the 
category and resource.

 b. Enter the distribution code or the general ledger account number. When you move to 
another field, the description for the distribution code or account you enter appears in the 
Description field. You can change the description for the distribution code.

 c. Enter the amount. You can enter a negative amount, but the invoice total cannot be 
negative.

 d. If retainage applies to the document you are adding, enter the retainage percentage or 
amount, the retention period, and the retainage due date for this detail.

 e. Enter an optional comment, and indicate whether to print the comment when you print the 
invoice.

 f. Indicate whether this detail is discountable.

 g. If you use optional fields, click the Optional Fields Zoom button to check, change, or add 
optional fields for the detail.

To add item details:
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 a. If this is a job-related document, enter the contract and project, and (as applicable) the 
category and resource.

 b. Enter the item number, unit of measure, quantity, price, and distribution code. You may 
enter a negative quantity, but the invoice total cannot be negative. If the detail is job-related, 
Accounts Receivable displays as defaults the A/R item number and the unit of measure for 
the specified resource (for standard contracts) or category (for basic contracts).

 c. Enter retainage separately for each detail. If retainage applies to the document you are 
adding, enter the retainage percentage or amount, the retention period, and the retention 
due date for this detail.

 d. Enter an optional comment, and indicate whether to print the comment when you print the 
invoice.

 e. If the document discount applies to this detail, double-click the in the Discountable column, 
if necessary, to change the entry to Yes.

 f. If you use optional fields, click the Optional Fields Zoom  button to check, change, or add 
optional fields for the detail.

Note: You can also add details using the Detail Accounts/Taxes screen. For more information, see 
"Adding a Detail Using the A/R Detail Accounts/Taxes Screen" (page 175).

 5. To check or change the general ledger accounts and taxes for a detail, click the Account/Tax 
button. For more information, see "Editing Taxes on an Invoice, Debit Note, or Credit Note" (page 
175).

 6. To check or edit invoice taxes, click the Taxes tab. For more information, see "Editing Taxes on an 
Invoice, Debit Note, or Credit Note" (page 175).

 7. If this is an invoice from which retainage will be deducted, use the Retainage tab to specify terms 
for the retainage document. 

Note: In a multicurrency ledger, you also specify which rate to use when you process the retainage.

 8. To use different payment terms from those in the customer record, or to edit the payment 
schedule, click the Terms tab. More...

 l In the Terms Code field, for regular invoices, enter the code for the payment terms. 

On retainage invoices, the retainage terms code specified on the original document appears as the 
default. If no retainage terms code was used on the original document, the terms code from the 
customer record appears as the default.

 l If you need to change any discount information for the invoice, you can adjust the discount base, 
the discount percentage, or the calculated discount.

 l If you selected a terms code that uses a multiple payment schedule, a schedule appears on the 
Terms tab. 
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Accounts Receivable calculates a schedule for you, beginning with the document date you enter, but 
you can change the dates on the payment schedule.

 l Check the As Of Date to make sure it is the correct date from which to calculate the due 
date for the first payment. 

The displayed As Of Date is the document date on the Document tab. If you change the As Of 
Date field, Accounts Receivable recalculates the payment schedule.

 l Edit the payment dates and amounts, if needed.

Note: You can edit the amounts, due dates, and discount dates, but you cannot increase the number 
of payments. The number of payments is determined by the terms code.

Be sure to check that the total of the payments in the schedule equals the invoice total.

 9. If you use invoice optional fields, click the Optional Fields tab to view or edit the optional fields 
assigned to this invoice.

 10. To allocate sales to salespersons, or to revise existing information, click the Sales Split tab.

For information about allocating sales, see "Allocating a Sale to Salespersons" (page 179).

 11. If the document does not use the functional currency and you need to change exchange rates, use 
the Rates tab to adjust them.

For more information, see "Editing Exchange Rate Information on an Invoice" (page 180).

 12. Click Add to add this document to the batch.

If you use credit checks for the customer, Accounts Receivable warns you if the customer has exceeded 
their credit limit or has transactions that have been outstanding for too long. (Close the Credit Check 
screen if you receive a warning.) You can edit the transaction, or ignore the warning and save the entry.

 13. If you need to enter a prepayment for an invoice, click Prepay to add it now.     

Note: If you use Payment Processing, you can also use the Prepayments screen to process a credit 
card prepayment.

For more information about prepayments, see "Entering a Prepayment with an Invoice" (page 177).

 14. Click Save.

After adding an invoice

 l Print the invoice.

 l Print the Batch Listing report. Make corrections, if needed, and then reprint the listing for each 
corrected batch.
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Important! If the Force Listing Of All Batches option is selected on the A/R Options screen, you 
must print batch listings before you can post batches. 

 l File the printed report for your audit trail.

Adding a Detail Using the A/R Detail Accounts/Taxes Screen

On the A/R Detail Accounts/Taxes screen, you can view and edit existing details for an invoice, and you 
can also add new details.

To add a detail using the A/R Detail Accounts/Taxes screen:

 1. After filling out header information for a document on the A/R Invoice Entry screen, click the 
Account/Tax button to open the A/R Detail Accounts/Taxes screen.

 2. Beside the Line Number field, click the New  button.

 3. Enter the item number (for item invoices), distribution code, description, amount, and other 
information for the detail. Also, depending on the type of invoice, you can change the following 
accounts:     

 l For item invoices:       

 l Revenue.

 l Inventory.

 l Cost of goods sold.

 l For summary invoices, you can change only the revenue account.

 4. Enter or edit the tax information for the detail.     

If you are entering an invoice with taxes calculated automatically, you can change only the tax class for 
the detail.

If you are entering an invoice for which you are entering taxes manually, you can change the tax class, 
tax base, and tax amount for the detail.

 5. Click Add.              

Note: You can also use the A/R Detail Accounts/Taxes screen to edit an existing detail. If you do this, 
you save your changes by clicking the Save button, which appears in place of the Add button.

Editing Taxes on an Invoice, Debit Note, or Credit Note

You can change tax information and options for existing invoices, debit notes, and credit notes.
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Before You Start

 l On the A/R Invoice Entry screen, display the document whose taxes you want to change.

 l Decide whether you want to enter taxes manually or let Accounts Receivable calculate all taxes for you.
       

Tip: If you want to calculates all taxes automatically when you add or save invoices, you can select 
Calculate Tax Amounts Automatically as the default for Accounts Receivable on the Transactions 
tab of the A/R Options screen. In a multicurrency system, you can also select Calculate Tax 
Reporting Amounts Automatically. You can change the tax calculation method for particular 
invoices.

To change taxes for a document:

 1. With the document displayed on the A/R Invoice Entry screen, click the Taxes tab.

The customer's tax group (from the customer record) is displayed automatically, but you can change it.

 2. If you want to change the tax group for this document, specify a different tax group.     

In a multicurrency ledger, if the tax group does not use the customer’s currency, Tax Reporting fields 
appear. You can change the rate type, rate date, and exchange rate for the tax reporting currency, and 
let Accounts Receivable calculate the Tax Reporting amounts for each authority.

 3. If you want Accounts Receivable to calculate all tax amounts automatically, select Calculate Tax on the 
Taxes tab.

If you want to enter tax amounts manually, and you do not want Accounts Receivable to recalculate 
taxes when you add or save the document:

 a. Clear the following options:     

 l Calculate Tax 

 l Calculate Tax Reporting (if it is available, and you want to enter tax reporting 
information manually for the invoice and its details)

Tip: If you need to recalculate the tax for the document, click the Calculate Tax button. 
Accounts Receivable does not calculate any tax for the invoice unless you click Calculate 
Taxes on the Taxes tab.

 b. To prorate and allocate the total tax amount from the Taxes tab to document details, click 
the Distribute Taxes button.
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 c. If you entered tax reporting amounts manually and you want to calculate the implicit exchange 
rate for the tax reporting currency, click the Derive Rates button.

 4. To change the customer’s tax class for the invoice, use the Finder to select a different class for a 
tax authority.

To change taxes for an invoice detail:

 1. On the Document tab, select the detail line, and then do one of the following:

 l Click Accounts/Taxes.

 l Press F9.

 2. On the A/R Detail Accounts/Taxes screen:     

 a. Change the tax classes assigned to the detail.

 b. Specify whether tax is included in the detail amount.

 c. Enter taxes manually for a detail (if the Calculate Tax option is not selected on the Taxes 
tab).

 d. Click the Taxes tab to check tax amounts for the document and compare the totals on the 
screen with the totals on the source document.

Entering a Prepayment with an Invoice

You can add one prepayment to each invoice you enter in an invoice batch. (You can also enter 
prepayments of specific invoices, purchase orders, or sales orders using either of the receipt entry 
screens.)

When you post a prepayment, Accounts Receivable applies it automatically to a matching invoice only if 
both the prepayment and the invoice are not job-related. If either the prepayment or the invoice is job-
related, the program does not apply the prepayment. 

You apply job-related prepayments manually using an Apply transaction using the A/R Receipt Entry 
screen.

If you use Payment Processing, you can process a credit card prepayment using Paya.

Before You Start

 l Add the invoice the customer is paying. You can add a prepayment only when the Prepay button 
is active, immediately after you add or save an invoice.

 l Identify the receipt batch to use for the prepayment.
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 l If you use Payment Processing, verify that a processing code exists that specifies the bank you 
select for the batch. If no processing code has been set up in Payment Processing that specifies 
the bank you select, you will not be able to process a credit card transaction.

To add a prepayment:

 1. Open Accounts Receivable > A/R Transactions > Invoice Entry.

 2. Select the open batch that contains the invoice, or to which you want to add the invoice.

 3. Do one of the following:

 l Enter the invoice information, and then click Add or Save.

 l Select the existing invoice that the customer is prepaying.

 4. Click Prepay.

The A/R Prepayments screen appears.

 5. In the Batch Number field, enter the number of the receipt batch to use.

Tip: You can create a new receipt batch by clicking the New  button beside the Batch Number 

field.

 6. If you use Payment Processing and want to process a credit card prepayment:     

 a. In the Bank field, specify a bank that matches the bank specified for the processing code 
you will use to process the credit card transaction.       

Note: If no processing code has been set up in Payment Processing that specifies the bank 
you select, you cannot process the credit card transaction.

 b. In the Payment Code field, specify a payment code that uses the payment type SPS Credit 
Card.       

Tip: Click the Payment CodeFinder  to see a list of payment codes and associated 

payment types.

After you select a processing code, the Processing Code field appears, along with a status field 
that displays information about the status of the credit card transaction. If a single processing 
code exists for the bank you selected, that code appears in the Processing Code field.

 c. In the Processing Code field, verify that the default selection is correct, or if no default 
appears, select a processing code that specifies the bank you selected for the batch.

 7. Complete the remaining fields on the screen. For more information, see A/R Prepayments Screen.
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 8. Click Add to add the prepayment.

Tip: To cancel a prepayment, click Close without first clicking Add, then click Yes at the message 
that appears.

 9. Click Close.

After adding the prepayment

 l If you use Payment Processing, click Charge or Quick Charge to process the credit card 
payment. For more information, see "Processing a Credit Card Payment" (page 204).

 l Print receipts. For more information, see "Printing Receipts" (page 342).

 l Print the deposit slips report for the receipt batch. For more information, see "Printing the 
A/R Deposit Slips Report" (page 337).

Allocating a Sale to Salespersons

To allocate a document total to salespersons, or to edit existing allocations:

 1. Open Accounts Receivable > A/R Transactions > Invoice Entry.

 2. Display the batch and the entry.

 l Use the Batch Number field to select the batch, or start a new batch.

 l Use the Entry Number field to start a new invoice or to display an existing entry.

 3. On the Sales Split tab:

 l Enter the salesperson numbers, or choose them from the Finder.

 l To delete a salesperson allocation, select (highlight) the line, then press the Delete key.

 4. Assign a percentage of the document total to each salesperson. Make sure the percentages you 
assign total 100 percent. 

Editing Optional Fields for an Invoice Detail

You can edit invoice detail optional fields.

To change the optional fields for a document detail:

 1. Open Accounts Receivable > A/R Transactions > Invoice Entry.

 2. Display the batch and the invoice you want to edit.
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 3. Select an invoice detail, and then do one of the following:     

 l Click the Zoom  button in the Optional Fields column header.

 l Press Shift+F9.

An Optional Fields screen appears, displaying any invoice details optional fields that are marked for 
automatic insertion.

 4. On the Optional Fields screen, add or delete optional fields for the detail. You can add any optional 
fields that are defined for invoice details.   

You can change the default value that appears for an optional field, as follows:

 l If the optional field is validated, you must specify a value that is defined for the optional field 
in Common Services.     

Note: If the optional field allows blanks, you can leave the value field blank.

 l If the optional field is not validated, you can enter any value that is consistent with the type of 
field (such as yes/no, text, number, date, or amount), providing the value you enter does not 
exceed the length permitted for the field. You can also leave the field blank.

Note: When you specify a value that is defined in Common Services, the description for the value is 
also displayed.

Editing Exchange Rate Information on an Invoice

In a multicurrency ledger, you can change the exchange rate for an invoice if the customer does not use 
the functional currency.

To change exchange rate information on an invoice:

 1. Open Accounts Receivable > A/R Transactions > Invoice Entry.

 2. Display the invoice you want to edit.

 3. On the Rates tab:     

 a. In the Rate Type field, enter the code for the rate type to use to convert the source currency 
to your functional currency.

 b. In the Rate Date field, enter the date to use for selecting the exchange rate.

 c. If the correct exchange rate does not appear in the Exchange Rate field, enter it, and then 
press Tab to record the rate.

Note: The Rates tab appears only in a multicurrency ledger if the customer does not use the 
functional currency.
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Invoicing a Recurring Charge Manually

Use this procedure if you accidentally delete a recurring charge invoice,   or if you need to create an 
additional invoice for some other reason.

To bill manually for a recurring charge:

 1. Open Accounts Receivable > A/R Customers > Recurring Charges.

 2. In the Recurring Charge   Code field, select the code for the type of charge.

 3. In the Customer Number   field, select the customer you want to invoice.

 4. Click the Create Invoice   button.

 5. Fill in the fields on   the Create Invoice screen that appears.

 6. Specify the date for   the invoice. 

 7. Select Next Scheduled   to create an invoice using the next scheduled date

 8. Select Other if you   want to specify a different date (for example, to reproduce an invoice   that you 
accidentally deleted). 

If you select Other, specify the invoice   date in the date field that becomes available.

 9. Specify whether to   create a new batch for the invoice, or add the invoice to an existing invoice   batch. 

If you select Add To An Existing Batch, type the batch number   in the next field or use the Finder to 
select the number.

 10. Click Process to create   the invoice, or click Cancel if you no longer want to create the invoice.

Invoicing Customers for Outstanding Retainage

You can invoice outstanding retainage amounts automatically using the A/R Create Retainage Batch 
screen.
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Notes: 
 l You can also invoice customers individually for outstanding retainage using the A/R Invoice 

Entry screen. Select Retainage Invoice as the document type. For more information, see 
"A/R Invoice Entry Screen" (page 590).

 l If you assign a schedule that uses a reminder on the Retainage tab of the A/R Options screen, 
Accounts Receivable reminds you and other users to process retainage transactions when they 
are due. You can then process the retainage transactions directly from the Reminder List in 
Common Services, rather than from the A/R Create Retainage Batch screen.

 l When you post a retainage document, Accounts Receivable assigns the next available invoice, 
credit note, or debit note number. If you use separate numbering for retainage documents, the 
program assigns the next retainage invoice, retainage credit note, or retainage debit note 
number.

 l Accounts Receivable uses the Summary detail type for processing outstanding retainage.

To create a batch of retainage documents:

 1. Open Accounts Receivable > Periodic Processing > Create Retainage Batch.

 2. Specify the Run Date for this retainage batch.

 3. Specify the types of original retainage documents for which you are now processing outstanding 
retainage.

 4. Choose the type of record by which to select outstanding retainage for processing, and then enter 
the range of records from which to select outstanding retainage.

 5. In the Number Of Days In Advance field, specify the number of days in advance of the retainage 
due date that retainage documents can be created.

 6. Click Process to create the batch.

Accounts Receivable updates the Last Invoiced field on the Retainage tab of the A/R Options screen.

After generating a retainage batch

 l Use the A/R Invoice Entry screen to make any changes to the retainage invoices, debit notes, and 
credit notes.

 l Print a listing of the batch, verify the information, then file the listing. If you need to make 
corrections, reprint the listing after editing the batch. For more information, see "A/R Batch Listing 
Report" (page 693).

 l On the A/R Invoice Batch List screen, select the Ready To Post option for the batch.

 l Post retainage batches using the A/R Invoice Batch List screen or the A/R Post Batches screen.
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Entering a Debit Note or a Credit Note

When you enter credit notes and debit notes using the A/R Invoice Entry screen, you can apply them to 
an existing document.

If the debit note or credit note applies to several   invoices or is issued on account (for example, as a 
purchase volume rebate),   you apply the credit note or "pay" the debit note later, using   the A/R Receipt 
Entry screen. 

Note: 
For job-related credit notes and debit notes, if you specify an Apply To Document:

 l The credit note or debit note can use only jobs that were used on the apply-to document.

 l The credit note cannot reduce the current outstanding amount or quantity for a detail to less   than 
zero.

Before You Start

 l Find out the invoice number   to which the debit note or credit note applies, if any. 

To add a debit note or a credit note:

 1. Open Accounts Receivable > A/R Transactions > Invoice Entry.

 2. Using the Batch Number field, select an existing batch, or create a new batch. More...

To create a new batch:

 a. Click the New  button beside the Batch Number field. Accounts Receivable assigns a 
new batch number.

Accounts Receivable assigns a new batch number.

 b. In the field beside the Batch Number field, type a description for the batch.

 c. Accept the session date in the Batch Date field, or type over the date if you want to change 
it.       

To view or change the default detail type for the batch:

 a. Click the Zoom  button beside the Batch Number field to open the Batch Information screen.

 b. In the Default Detail Type field, select  Item or Summary.

Click Close.
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 3. Enter header information for the document on the Document tab. More...

Header information includes:

 l A description for the document.

 l Customer number.

 l Whether the document is job-related. More...

When you select the Job Related option, additional fields appear on the detail entry table and on 
the A/R Detail Accounts/Taxes screen, where you enter job-related information.

 l Whether the document is subject to retainage (a holdback). More...

The Retainage option appears in Invoice Entry only if you selected the Retainage Accounting 
option for your Accounts Receivable system. When   you select the Retainage option, a Retainage 
tab appears where you   specify the retainage terms for the document.

If you have a multicurrency ledger, you also use the Retainage tab to specify whether to use the 
original exchange rate or the current exchange rate when you produce the retainage document.

Retainage fields also appear in the detail-entry table where you specify the retainage percentage 
or retainage amount, retention period, and retainage due date for each detail.

 l Ship-to location and   a ship via method.

 l Original document number. If you are processing a retainage   credit note or debit note, 
specify the original document for which you   are now processing retainage.

 l Document number. Accept the ***NEW*** entry to have the program assign a number to the 
document.

 l The Apply-To Document (the number for the invoice you are crediting).

 l The document date (for aging and statistical purposes).

 l The posting date. The posting date determines the fiscal year and period to which the 
document is posted in the general ledger.

 l Purchase order and sales order numbers (if known).

 l Any special instructions regarding the credit note or debit note.

Note: In the Document Type field, select Credit Note or Debit Note. If you selected Summary as the 
detail type you can also select Retainage Credit Note or Retainage Debit Note. 

 4. In the detail entry table on the Document tab, add either of the following types of details:

 l Summary details.More...

To add summary details:
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 a. If this is a job-related document, enter the contract and project, and (as applicable) the 
category and resource.

 b. Enter the distribution code or the general ledger account number. When you move to 
another field,   the description for the distribution code or account you enter appears in 
the Description field. You can change the description for the distribution code.

 c. Enter the amount.   You can enter a negative amount, but the invoice total cannot be 
negative.

 d. If retainage applies to the document you are adding, enter the retainage percentage 
or amount, the retention period, and the retainage due date for this detail.

 e. Enter an optional comment, and indicate whether to print the comment when you print 
the debit note or credit note. 

 f. If you use optional   fields, click the Optional Fields Zoom  button to check, change, 
or add   optional fields for the detail.

 l Item details. More...

To add item details:

 a. If this is a job-related document, enter the contract and project, and (as applicable) the 
category and resource.

 b. Enter the item number, unit of measure, quantity, price, and distribution code. You 
may enter a negative quantity, but the invoice total cannot be negative. If the detail is 
job-related, Accounts Receivable displays (as defaults) the   A/R item number and the 
unit of measure for the specified resource (for   standard contracts) or category (for 
basic contracts).

 c. Enter retainage separately for each detail. If retainage applies to the document you 
are adding, enter the retainage percentage or amount, the retention period, and the 
retention due date for this detail.

 d. Enter an optional comment, and indicate whether to print the comment when you print 
the invoice.

 e. Indicate whether the document discount applies to this detail.

 f. If you use optional   fields, click the Optional Fields Zoom  button to check, change, 
or add   optional fields for the detail.

Tip: You can also add details using the A/R Detail Accounts/Taxes screen. For more information, see 
"Adding a Detail Using the A/R Detail Accounts/Taxes Screen" (page 175).

 5. To check or change the general ledger accounts and tax information for a detail, select the detail, 
and then click the Account/Tax button. (Click Close to return to the Invoice Entry screen.)
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 6. To check or change taxes amounts for the invoice, click the Taxes tab.     

For more information, see "Editing Taxes on an Invoice, Debit Note, or Credit Note" (page 175).

 7. On a document from which retainage will be deducted, use the Retainage tab to specify terms for 
the retainage document.

In a multicurrency ledger, you also specify the type of rate to use when you process the retainage.

 8. If you use invoice optional fields, click the Optional Fields tab to view or edit the optional fields 
assigned to this invoice.

 9. To allocate amounts to salespersons, or to revise existing information, use the Sales Split tab.     

For more information, see "Allocating a Sale to Salespersons" (page 179).

 10. If the document does not use the functional currency and you need to adjust exchange 
information, use the Rates tab to adjust them.     

For more information, see "Editing Exchange Rate Information on an Invoice" (page 180).

 11. Click Add to add this document to the batch.

Note: If you use credit checks for the customer, Accounts Receivable warns you if the customer has 
exceeded their credit limit or has transactions that have been outstanding for too long. Close the 
Credit Check screen if you receive a warning. You can edit the transaction, or ignore the warning and 
save the entry.

 12. Click Save.

After entering a debit note or a credit note

 l Print the debit note or credit note.

 l Print the Batch Listing report. Make corrections, if needed, and then reprint the listing for each 
corrected batch.

You must print batch listings before posting batches, if the Force Listing Of All Batches option is 
selected on the A/R Options screen. File the printed reports for your audit trail.

Reversing an Invoice Issued in Error

If you issue an invoice in error, you should process a credit note to back it out of the customer's account 
using the A/R Invoice Entry screen.

Important! Do not enter an adjustment to the invoice in the A/R Adjustment Entry screen, because any 
taxes included on the original invoice will not be reversed.
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To enter a credit note:

 1. Open Accounts Receivable > A/R Transactions > Invoice Entry.

 2. Using the Batch Number field, select an existing batch, or create a new batch. More...

To create a new batch:

 a. Click the New  button beside the Batch Number field. Accounts Receivable assigns a 
new batch number.

Accounts Receivable assigns a new batch number.

 b. In the field beside the Batch Number field, type a description for the batch.

 c. Accept the session date in the Batch Date field, or type over the date if you want to change 
it.       

To view or change the default detail type for the batch:

 a. Click the Zoom  button beside the Batch Number field to open the Batch Information screen.

 b. In the Default Detail Type field, select  Item or Summary.

Click Close.

 3. Enter header information for the document on the Document tab. More...

Header information includes:

 l A description for the document.

 l Customer number.

 l Whether the document is job-related. More...

When you select the Job Related option, additional fields appear on the detail entry table and on 
the A/R Detail Accounts/Taxes screen, where you enter job-related information.

 l Whether the document is subject to retainage (a holdback). More...

The Retainage option appears in Invoice Entry only if you selected the Retainage Accounting 
option for your Accounts Receivable system. When   you select the Retainage option, a Retainage 
tab appears where you   specify the retainage terms for the document.

If you have a multicurrency ledger, you also use the Retainage tab to specify whether to use the 
original exchange rate or the current exchange rate when you produce the retainage document.

Retainage fields also appear in the detail-entry table where you specify the retainage percentage 
or retainage amount, retention period, and retainage due date for each detail.
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 l Original Document. If you are processing a retainage credit note, specify the original 
document for which you are now processing retainage.

 l Document number. Accept the ***NEW*** entry to have the program assign a number to the 
document.

 l The Apply-To Document (the number for the invoice you are crediting).

 l The document date (for aging and statistical purposes).

 l The posting date. The posting date determines the fiscal year and period to which the 
document is posted in the general ledger.

 l Purchase order and sales order numbers.

 l Any special instructions regarding the invoice, credit note, debit note, or interest invoice.

 4. In the detail entry table on the Document tab, add either of the following types of details:

 l Summary details. More...

To add summary details:

 a. If this is a job-related document, enter the contract and project, and (as applicable) the 
category and resource.

 b. Enter the distribution code or the general ledger account number. When you move to 
another field, the description for the distribution code or account you enter appears in 
the Description field. You can change the description for the distribution code.

 c. Enter the amount. You can enter a negative amount, but the invoice total cannot be 
negative.

 d. If retainage applies to the document you are adding, enter the retainage percentage 
or amount, the retention period, and the retainage due date for this detail.

 e. Enter an optional   comment, and indicate whether to print the comment when you print 
the   debit note or credit note. 

 f. If you use optional   fields, click the Optional Fields Zoom  button to check, change, 
or add   optional fields for the detail.

 l Item details. More...

To add item details:

 a. If this is a job-related document, enter the contract and project, and (as applicable) the 
category and resource.

 b. Enter the item number, unit of measure, quantity, price, and distribution code. You 
may enter a negative quantity, but the invoice total cannot be negative. If the detail is 
job-related, Accounts Receivable displays (as defaults)  the A/R item number and the 
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unit of measure for the specified resource (for   standard contracts) or category (for 
basic contracts).

 c. Enter retainage separately for each detail. If retainage applies to the document you 
are adding, enter the retainage percentage or amount, the retention period, and the 
retention due date for this detail.

 d. Enter an optional comment, and indicate whether to print the comment when you print 
the invoice.

 e. Indicate whether the document discount applies to this detail.

 f. If you use optional   fields, click the Optional Fields Zoom  button to check, change, 
or add   optional fields for the detail.

Tip: You can also add details using the A/R Detail Accounts/Taxes screen. For more information, see 
"Adding a Detail Using the A/R Detail Accounts/Taxes Screen" (page 175).

 5. To check or change the general ledger accounts and tax information for a detail, select the detail, 
and then click the Account/Tax button. (Click Close to return to the Invoice Entry screen.)

 6. To check or change taxes amounts for the invoice, click the Taxes tab.     

For more information, see "Editing Taxes on an Invoice, Debit Note, or Credit Note" (page 175).

 7. On a document from which retainage will be deducted, use the Retainage tab to specify terms for 
the retainage document.

In a multicurrency ledger, you also specify the type of rate to use when you process the retainage.

 8. If you use invoice optional fields, click the Optional Fields tab to view or edit the optional fields 
assigned to this invoice.

 9. To allocate amounts to salespersons, use the Sales Split tab.     

For more information, see "Allocating a Sale to Salespersons" (page 179).

 10. If the document does not use the functional currency and you need to adjust exchange 
information, use the Rates tab to adjust them.     

For more information, see "Editing Exchange Rate Information on an Invoice" (page 180).

 11. Click Add to add the document to the batch.

 12. Click Save.

After adding the credit note

Print the A/R Batch Listing report. Make corrections, if needed, and then reprint the listing for each 
corrected batch.
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Note: You must print batch listings before posting batches, if the Force Listing Of All Batches option is 
selected on the A/R Options screen. File the printed reports for your audit trail.

Receipts
You use Accounts Receivable’s versatile Quick Receipt Entry and Receipt Entry screens to enter cash, 
check, credit card, and other receipts directly into Accounts Receivable. 

You can also use the Receipt Entry screen to enter adjustments to selected invoices, credit notes, and 
debit notes while entering customer payments, instead of using the Adjustment Entry screen to record the 
adjustments later.

About Processing Receipts

You use the A/R Receipt Entry screen to:

 l Enter cash, check, credit card, and other receipts directly into Accounts Receivable.

 l If you use Payment Processing, process credit card payments for receipts, prepayments, 
unapplied cash, and miscellaneous receipts.

 l Print deposit slips.

 l Enter adjustments with the documents they adjust, instead of as separate transactions, using 
Adjustment Entry.

You can also use the A/R Quick Receipt Entry screen to:

 l Enter cash, check, credit card, and other receipts directly into Accounts Receivable.

 l Print deposit slips.

This section describes how to:

 l Enter receipts from customers.

 l Apply receipts to outstanding invoices and other documents in your customer accounts.

 l Apply prepayments, credit notes, debit notes, and adjustments to other documents and account 
balances.

 l Process miscellaneous receipts that do not affect any of your customer accounts.

 l Write off amounts and enter other adjustments.

 l Edit receipt batches imported from non-Sage 300 programs. (You can edit these batches only if 
you chose the Allow Edit Of Imported Batches option on the A/R Options screen.)

Entering Deposits and Applying Receipts

Receipt entry involves two main tasks:

190Sage 300 2023 Accounts Receivable User's Guide



 l Entering receipts, which involves entering general information about the receipt.

Note: Receipts entered using the A/R Receipt Entry screen are available also on the Quick Receipt 
Entry screen, and vice versa.

 l Applying receipts, which involves selecting options and entering details you need to apply. You can 
apply:

 l A new receipt or previously posted prepayment or unapplied cash transaction to an invoice, 
a credit note, or a debit note.

 l A credit note to an invoice or a debit note.

You create a receipt batch for each bank account for which you want to enter receipt transactions, 
assigning a bank code to identify the bank. You can add all receipts to the batch before applying the 
deposits to specific invoices, or you can apply receipts as you enter them.

The A/R Quick Receipt Entry screen lets you add the day's receipts to a batch and print a deposit slip to 
be able to take the money to the bank quickly. You can use the A/R Receipt Entry screen, later, to apply 
the receipts to invoices and debit notes.

On the A/R Receipt Entry screen, you can view the details for a receipt on one screen. For more 
information, see A/R Detail Accounts/Taxes Screen (Receipts).

On the A/R Quick Receipt Entry screen, you can view all the receipts in a batch on one screen. For more 
information, see A/R Batch Information Screen (Receipts).

Applying Receipts to Pay Customer Accounts

You use the A/R Receipt Entry screen to apply receipts from your customers to the invoices or other 
documents the customer is paying. You also use this screen to apply credit notes to customer accounts 
and "pay" debit notes.

The A/R Receipt Entry screen lets you apply receipts in several ways so that you can choose the method 
that best matches your requirements. You can:

 l Select posted documents to apply against other documents or account balances.

 l Enter receipts and apply them to the appropriate documents or balances.

 l Apply third-party checks and keep a record of who issued the check.

 l Automatically apply receipts to the appropriate documents or balances.

 l Apply receipts that you manage using Project and Job Costing. For more information, see 
"Applying a Receipt to a Job-Related Invoice" (page 211).

 l If you use Payment Processing, process a credit card payment for a receipt in Paya.
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Entering Prepayments and Unapplied Cash Transactions

When you enter a prepayment in a receipt entry screen, you specify all the information you need to 
deposit the money and post the transaction. You can apply it to the customer's account at a later date.

You can enter all the information Accounts Receivable needs to process prepayments and unapplied 
cash transactions in either the A/R Receipt Entry screen or the A/R Quick Receipt Entry screen.

If you use Payment Processing, you can process a credit card payment for the receipt in Paya.

You can also enter prepayments with their associated invoices in the A/R Invoice Entry screen. Do so if 
you want to apply a prepayment to a specific unposted invoice. If you need to edit the prepayment later, 
however, you must use the A/R Receipt Entry screen.

Note: 
When you post a prepayment, Accounts Receivable applies it automatically to a matching invoice only 
if both the prepayment and the invoice are not job-related.

If either the prepayment or the invoice is job-related, the program does not apply the prepayment. You 
can always apply job-related prepayments manually using an Apply transaction in Receipt Entry, 
however.

Entering Miscellaneous Receipts

You can use the A/R Quick Receipt Entry screen to enter a miscellaneous receipt quickly for inclusion on 
a deposit slip. 

You can use the A/R Receipt Entry screen, later, to distribute the receipt to general ledger accounts. 
When you select or add a miscellaneous receipt on the Receipt Entry screen, Accounts Receivable 
displays a table where you enter account distribution information.

Miscellaneous receipts are sometimes called "cash invoices," because you do not enter an invoice and a 
receipt separately. Also, because the invoice portion is considered fully paid, you do not enter retainage 
or terms information with a miscellaneous receipt.

You can enter miscellaneous receipts for existing customers, as well as for one-time customers who have 
no customer record in Accounts Receivable. 

If you enter a miscellaneous receipt for an existing customer, an invoice is automatically created for the 
customer using the prefix and next number specified for invoices on the A/R Options screen. The receipt 
is immediately applied to this invoice when you post the receipt. 

If the miscellaneous receipt is not for a regular customer, you can leave the customer number blank, and 
simply enter a payer and a reference to identify the source and the reason for the receipt. (Note that if you 
later reverse the receipt in Bank Services, both the receipt and associated invoice are reversed.)
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If you use Project and Job Costing, you can enter job-related information for the invoice. To enter a job-
related miscellaneous receipt, you must enter a customer number.

If you use Payment Processing, you can process a credit card payment for the receipt in Paya.

You use the Document Taxes button to check or change the tax group or other tax information for the 
document.

You use the Accounts/Taxes button to check or change tax information for a selected detail.

When you post a miscellaneous receipt:

 l Taxes are automatically calculated for miscellaneous receipts, and the Tax Tracking report is 
updated.

 l Project and Job Costing is updated with any information you entered in job-related fields.

Multicurrency Ledgers

For a multicurrency batch, you specify a default currency for the batch, which is used as the default for 
the receipts you add to the batch. However, you can change the currency for a particular receipt, and you 
can use a variety of currencies in the same receipt batch. More...

You can specify a different currency for a receipt in the following ways:

 l On the A/R Receipt Entry screen, use the Finder beside the Receipt Amount field to select a 
currency code, or simply type the code in the currency field.

 l On the A/R Quick Receipt Entry screen, select the receipt in the table, and then enter the currency 
code in the Currency field.

To enter different exchange rate information for a particular receipt, select the receipt, click the Rates 
button, and then enter the information in the Rate Override screen.

Assigning Deposit Slip Numbers

Accounts Receivable assigns a unique number to each new deposit slip you enter. The deposit slip 
number is part of your audit trail and you can look it up in the Receipt Batch List screen, to find out 
whether you printed the deposit slip.

The deposit slip number also appears with the receipt transaction in the Document Inquiry screen and in 
the Customer Inquiry screen, to help you find out when you deposited the receipt.

A receipt batch can contain only one deposit slip, but you can assign a number of receipt batches to the 
same deposit slip. If you post receipt batches that contain errors, Accounts Receivable creates a 
separate error batch for each deposit slip that contained incorrect transactions, and assigns the original 
deposit slip number to each error batch.
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Printing Deposit Slips

If you use Accounts Receivable to print deposit slips, you can print them before or after posting the 
associated receipt batches. Depending on the Receipt options selected for Accounts Receivable, you 
may need to print deposit slips before you can post the receipt batches to which they are assigned. (For 
information about options that affect printing of deposit slips, see "A/R Options Screen" (page 523).)

You can use the Deposit button on the A/R Receipt Entry screen to print a deposit slip for the batch you 
are working with. You can also use the Deposit Slips screen, available from the Transaction Reports 
folder, to print the slips.

You transfer information from the printed deposit slip to the preprinted form you use for the bank. You 
may also be able to adapt Accounts Receivable's deposit slip form so you can print directly on your 
bank's deposit slips.

Note: If you are entering a receipt for a Paya credit card transaction, you should process the credit card 
payment before you print the receipt. If the Allow Edit after Receipt Printed option is not selected in 
A/R options, the Charge and Quick Charge buttons are disabled after you print the receipt, and you 
cannot process the credit card payment.

About Applying Receipts to Details of Job-Related Invoices

If you use Sage 300 Project and Job Costing to manage contracts, the Project and Job Costing Apply 
Details screen lets you specify how to apply receipts to selected details of a job-related invoice. (For 
example, a customer may only partially pay for an invoice when some aspect of a project is in dispute.)

About Entering Receipts and Invoices at the Same Time

You can use the A/R Receipt Entry screen to enter invoices at the same time as you enter receipts for 
existing customers as well as for one-time customers.

In Sage 300 Accounts Receivable, you enter a miscellaneous receipt. Some other programs call this type 
of entry a "cash invoice."

Note: When you enter a miscellaneous receipt for a one-time customer, you leave the Customer 
Number field blank

When you specify Misc. Receipt in the Transaction Type field, Accounts Receivable displays a detail-
entry table where you can enter general ledger account distributions for the receipt, just as you do when 
adding an invoice using the A/R Invoice Entry screen.

Tip: If you prefer to view all the information for a detail, without scrolling, click the Accounts/Taxes 
button to enter the details using the A/R Detail Accounts/Taxes Screen (Receipts) screen.
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If the receipt is for an existing customer, you can also enter job-related details. To display the necessary 
job-related fields, you select the Job Related option on the A/R Receipt Entry screen before you enter 
any details.

For step-by-step instructions on entering miscellaneous receipts, see "Processing a Cash Sale or 
Miscellaneous Receipt" (page 216).

Tax Information for a Miscellaneous Receipt

Accounts Receivable calculates tax and updates Tax Services for miscellaneous receipts, as it does for 
invoices you enter using Invoice Entry.

 l To change the tax group or other tax information for the document, you use the A/R Document 
Taxes screen. (You click the Document Taxes button to display the Document Taxes screen.) For 
more information, see A/R Document Taxes Screen.

Tip: You can use a tax group that is from the one specified in the customer record.

 l To change tax information for the invoice details, you use the separate A/R Detail Accounts/Taxes 
screen. (You click the Accounts Taxes button to display the Detail Accounts/Taxes screen.) For 
more information, see A/R Detail Accounts/Taxes Screen (Receipts).

When you post the miscellaneous receipt, Accounts Receivable creates an invoice transaction as well as 
a receipt transaction. The entries are combined on the same posting journal.

About Processing Advance Credits for the Return of Goods

Accounts Receivable lets you issue an advance credit for goods that   a customer has returned, but which 
you have not yet received. 

When the customer pays the invoice, they reduce their payment by the   amount agreed for the returned 
goods. You then enter a receipt in Accounts   Receivable both for the customer's payment and for advance 
credit on the   returned goods. 

The advance credit offsets the full amount of the invoice, which appears   on the customer's next 
statement as fully paid. However   because you have actually received neither a payment nor the goods—it 
also restores the customer's   outstanding balance for the unpaid portion of the invoice. 

The advance credit amount appears as a debit on the customer's statement,   where it remains until you 
receive the returned goods.

When you receive the goods, you enter the real   credit note, offsetting the advance credit in the 
customer's account (and   on the customer's statement), and reducing sales.

If you are processing a receipt for a national account, Accounts Receivable   lets you choose whether to 
apply the advance credit to the national account   or a member customer. 
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About Entering Optional Fields on Receipts

If you use Sage 300 Transaction Analysis and Optional Field Creator and you have set up system-wide 
optional fields, you can define optional fields for the A/R Receipt Entry screen. You can assign these 
optional fields to all types of receipt transactions (receipts, prepayments, unapplied cash, apply 
document, and miscellaneous receipt transactions). For more information, see "A/R Optional Fields 
Screen" (page 519).

When you enter a new receipt, Accounts Receivable displays any receipt optional fields that you marked 
for automatic insertion, along with their default values. The Optional Fields option on the A/R Receipt 
Entry screen shows whether a selected receipt uses optional fields.

Note: The Optional Fields option is set automatically—you cannot change it. If you delete all the 
optional fields associated with the receipt, the program resets the Optional Fields option.

Assigning Optional Fields to Particular Receipts

To view the optional fields that are used on a selected receipt, click the Zoom  button beside the 

Optional Fields option. The A/R Optional Fields screen appears, where you can change the values for 
optional fields that appear as defaults, or delete them. You can also add any other optional fields that you 
have defined for receipts.

Note: If you define the same optional fields for customers and for receipts, the optional field values 
from the customer record are used as defaults when you enter a new receipt.

You can change the default value that appears for an optional field, as follows:

 l If the optional field is validated, you must specify a value that is defined for the optional field in 
Common Services.     

Note: If the optional field allows blanks, you can leave the value field blank.

 l If the optional field is not validated, you can enter any value that is consistent with the type of field 
(such as yes/no, text, number, date, or amount), providing the value you enter does not exceed the 
length permitted for the field. You can also leave the field blank.

Note: When you specify a value that is defined in Common Services, the description for the value is 
also displayed.

Updating General Ledger

When you post a receipt that contains optional field information, the optional field information specified for 
the receipt is passed to General Ledger and is included in the journal entry if:
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 l You specified in the optional field setup record that optional field information will be passed to the 
affected General Ledger account.

 l You used the same optional fields in the receipts as you assigned for transaction details in the 
General Ledger account record.

Depending on the settings for the optional field, affected General Ledger accounts can include:

 l Receivables Control

 l Prepayment

 l Bank

 l Receipt Discount

 l Adjustment

 l Miscellaneous Receipt account

 l Exchange Gain (or Realized Exchange Gain)

 l Exchange Loss (or Realized Exchange Loss)

 l Rounding

About Returning Customer Checks

Important! You cannot process a returned check in Accounts Receivable.

If a customer's check is returned by the bank (for example, for insufficient funds), you must use Bank 
Services to process the reversal. When you post the reversal, you can choose whether to reinstate the 
associated invoice in Accounts Receivable, if the invoice information still exists.

You cannot reinstate an invoice if the customer has no record in Accounts Receivable (for example, if you 
reverse a miscellaneous receipt for a one-time customer).

The Bank Services help provides instructions on using the Reverse Transactions screen.

To view the Bank Services help:

 1. Open Common Services > Bank Services > Bank Transactions > Reverse Transactions.

 2. In the Bank Services Reverse Transactions screen, press the F1 key.     

The Reverse Transactions help topic includes a link for step-by-step instructions on returning a check.

Note: If your Sage 300 system uses security, you must have authorization to use the Reverse 
Transactions screen in Bank Services.

You can use the Customer Inquiry screen in Accounts Receivable to display information about a returned 
customer check. For more information, see "Looking up a Returned Customer Check" (page 111).
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Adding, Editing, or Deleting a Receipt Batch

You can create a receipt batch from the A/R Receipt Batch List screen or the A/R Receipt Entry screen.

Before You Start

 l Assign a default bank code on the Transactions tab of the A/R Options screen. You cannot create 
receipt batches until you do this.

 l If you have a multicurrency ledger, determine the default currency code for the batch.

To create a receipt batch:

 1. Open Accounts Receivable > A/R Transactions > Receipt Batch List.

 2. Click New to open the A/R Receipt Entry screen and create a new batch simultaneously.

Note: You can also create a new batch from the receipt entry screens by clicking the New  button 

to the right of the Batch Number field.

 3. Beside the Batch Number field, enter a description for the batch.

 4. In the Batch Date field, enter a date for the new batch, or accept the session date that is displayed.

 5. Select a bank code. More...

You use only one bank code per batch because a batch can contain only one deposit slip.

If you have a multicurrency ledger, you can include receipts that use different currencies in the batch. 
However, you must ensure that the bank's statement currency is the same as your functional currency, 
and you must also select a bank code that accepts the currencies you want to use in the batch.

 6. For multicurrency ledgers, specify a default currency for the batch. More...

The default currency appears for new entries. Accounts Receivable lets you change the receipt 
currency for specific receipts in the batch.

 7. In the Deposit Number field, enter a deposit number for the batch. More...

 l To assign a new deposit number to the receipt batch, click the New  button beside the 
Deposit Number field to let the program assign the next deposit number specified on the 
A/R Options screen.

 l To assign an existing deposit number to the batch, use the Finder  to select an existing 
deposit number.
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Note: If you leave the Deposit Number field blank, the program assigns the next deposit number 
when you add the first receipt to the batch.

 8. Click the Zoom  button beside the Batch Number field.

The A/R Batch Information screen appears.

 9. Enter a default rate date, rate type, and exchange (bank) rate for the batch. More...

The rate type assigned to the bank in Bank Services is automatically displayed; the rate date and rate 
that appear are selected from the Currency screens in Common Services. You can select a different 
rate date, rate type, and bank rate.

 10. Click Close to return to the A/R Receipt Entry screen.

To open a receipt batch for editing or deleting:

 1. Open Accounts Receivable > A/R Transactions > Receipt Entry or Quick Receipt Entry.

 2. In the Batch Number field, enter the number of a refund batch.     

Tip: You can search for batch numbers using the Finder or the navigation buttons beside the Batch 
Number field.

 3. If you want to delete the batch, click Delete.

All transactions in the batch are deleted and the batch is listed as deleted on the Batch Status report. 
You cannot reuse the batch number.

After deleting a receipt batch

Clear the data for the deleted batch from Accounts Receivable. (Select the Clear Deleted And Posted 
Batches option on the A/R Clear History screen.)

Note: If a batch includes credit card transactions that have been settled in Paya, you cannot delete the 
batch.

Adding a Receipt to a Deposit Slip for Quick Deposit

On the A/R Quick Receipt Entry screen, you can enter sufficient information for cash, check, and other 
receipts so that you can print a deposit slip and take the money to the bank in a timely manner.
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Before You Start

 l Decide whether to add receipts to an existing deposit slip, if there is one, or start a new deposit 
slip.

To add a receipt to a deposit slip:

 1. Open Accounts Receivable > A/R Transactions > Quick Receipt Entry.

 2. Do one of the following:

 l Select an existing batch. Use the navigation buttons or the Finder  beside the Batch 
Number field to display the batch you want to use.

 l Create a new batch. Click theNew  button beside the Batch Number field, then enter the 
batch date, bank code, default currency (in a multicurrency ledger), and deposit number.

 3. Select a line on the deposit list, and then press Insert.

 4. In the Transaction Type field, specify the transaction type:

 l Receipt

 l Prepayment

 l Unapplied Cash

 l Miscellaneous Receipt

Note: In a new batch, Accounts Receivable displays the default transaction type you selected on the 
A/R Options screen.

 5. Specify the customer number, receipt type, check number (you can also let Accounts Receivable 
assign a number), receipt date, amount, payer name, description (of the receipt), fiscal year, and 
fiscal period.

 6. To begin a new line, press Insert.

 7. Continue adding the receipts you want to include on the same deposit slip.

 8. To print receipts, click Print Receipt. For more information, see "Printing Receipts" (page 342).

 9. To print the deposit slip, click Deposit. For more information, see "Printing the A/R Deposit Slips 
Report" (page 337).

 10. Click Close when you have finished entering receipts for deposit.
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After you complete the deposit slip

 l Print the deposit slip. For more information, see "Printing the A/R Deposit Slips Report" (page 337).

 l Use the A/R Receipt Entry screen to apply receipts in the deposit slip to documents in the 
customer's account.

Tip: You can open the A/R Receipt Entry screen by selecting a transaction line on the A/R Quick 
Receipt Entry screen, and then clicking Open.

Adding a Prepayment that You Will Apply Later

You can enter a prepayment without immediately applying it to an invoice.

To add a prepayment:

 1. Open Accounts Receivable > A/R Transactions > Receipt Entry or Quick Receipt Entry.

 2. Do one of the following:

 l Select an existing batch. Use the navigation buttons or the Finder  beside the Batch 
Number field to display the batch you want to work with.

 l Create a new batch. Click the New  button beside the Batch Number field, then enter 
the batch date, bank code, default currency (in a multicurrency ledger), and deposit number.

 3. Depending on which screen you are using, do one of the following:     

 l On the A/R Receipt Entry screen, click theNew  button beside the Entry Number field.

 l On the A/R Quick Receipt Entry screen, select a line on the deposit list, and then press 
Insert.

 4. In the Transaction Type field, select Prepayment as the transaction type.

 5. Specify the customer number, payer name, payment code, check or receipt number, date, amount, 
type of document to apply by (document number, order number, purchase order number, or 
shipment number), document number (to apply the prepayment to), description, year, and period.     

Note: If you use Payment Processing and want to process a credit card payment, you must select a 
payment code that uses the payment type SPS Credit Card before adding the receipt. After you 
select the payment code, the Processing Code field appears, along with a status field that displays 
information about the status of the credit card transaction. After you add the receipt, the Charge and 
Quick Charge buttons become available.

Tip: Click the Payment Code Finder  to see a list of payment codes and associated payment 

types.
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After adding a prepayment

 l If you use Payment Processing, click Charge or Quick Charge to process the credit card 
prepayment in Paya.

 l Post the prepayment. You must do so before you can apply the prepayment to the customer's 
account.

 l Apply the prepayment to the customer's account. For more information, see "Applying a Posted 
Prepayment, Unapplied Cash Transaction, Receipt, or Credit Note" (page 213).

Entering a Customer Receipt

Before You Start

 l Group receipts by bank account.

 l If you use multicurrency accounting, update currency information and exchange rates in Common 
Services.

 l Select Receipt options on the A/R Options screen, particularly:       

 l Allow Printing Of Deposit Slips. Select this option if you want to print deposit slips.

 l Create Deposit Slip When Receipt Batch Is Created. Select this option to create a deposit 
slip automatically for each new batch you add.

 l Allow Edit After Receipt Printed and Allow Edit After Deposit Slip Printed. Select these 
options to allow editing of the batch after you print a receipt or deposit slip.

For more information, see "A/R Options Screen" (page 523).

 l Select the correct print destination.

 l If you use optional fields, define the optional fields you want to use on receipts. For more 
information, see "A/R Optional Fields Screen" (page 519).

 l If you use Payment Processing, verify that a processing code exists for the bank to which you will 
deposit credit card receipts. If no processing code has been set up in Payment Processing that 
specifies the bank you select, you cannot process a credit card transaction.

To add a customer receipt:

 1. Open Accounts Receivable > A/R Transactions > Receipt Entry.

 2. Use the Batch Number field to do one of the following:     

 l Create a new receipt batch by clicking the New  button.

 l Select an existing open batch using the navigation buttons or the Finder .
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 3. If you use Payment Processing and want to process a credit card payment for the receipt, select a 
bank that matches the bank specified for the processing code you will use to process the credit 
card transaction.

Note: If no processing code has been set up in Payment Processing that specifies the bank you 
select, you will not be able to process the credit card transaction.

Tip: You can use the A/R Process Credit Card Payments screen to process credit card payments for 
multiple pending invoices (invoices with outstanding payments), and to create receipts for the 
processed payments. For more information, see "A/R Process Credit Card Payments Screen" (page 
632).

 4. Beside the Entry Number field, enter a description of the receipt transaction or other information 
you want to record.

 5. Select Receipt as the transaction type, if it is not already displayed as the default.

 6. Enter the date for the receipt, and, if necessary, change the fiscal year and period to which you are 
going to post the transaction.

 7. Enter customer information. More...

 a. Enter the customer number, and then press Tab.

 b. If the receipt is from someone other than the customer (for example, for a third-party check), 
do one of the following:

 i. On the A/R Receipt Entry screen, enter the name of the payer in the field next to the 
customer number.

 ii. On the A/R Quick Receipt Entry screen, enter the name of the payer in the Payer 
field.

 8. Accept the payment code that appears, if it is correct, or select a payment code. If you use 
Payment Processing and want to process a Paya credit card payment for the transaction, select a 
payment code that uses the SPS Credit Card payment type.

Tip: Click the Payment Code Finder  to see a list of payment codes and associated payment 

types.

If you select a payment code that uses the SPS Credit Card payment type, the Processing Code field 
appears, along with a status field that displays information about the status of the credit card 
transaction.

If a single processing code exists for the bank you selected, that code appears in the Processing Code 
field. Verify that the default selection is correct, or if no default appears, select a processing code that 
specifies the bank you selected for the batch.
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 9. Enter information about the payment. More...

 l In the Check/Receipt No. field, enter the check number or another number to identify the 
receipt.

Note: If you leave the field blank, Accounts Receivable assigns a number using the batch 
number and the entry number.

 l Enter an optional reference for the receipt.

 10. In the Receipt Amount field, enter the amount of the receipt.

Also, if you use multicurrrency accounting, enter currency information. More...

 a. Beside the Receipt Amount field, enter the code for the receipt currency.

 b. If you need to edit the exchange rate, rate type, or rate date for this receipt, click Rates.

 c. Click Close to return to the A/R Receipt Entry screen.

 11. If you are entering a partial receipt for a job-related document, choose an apply method for the 
receipt, and  apply the receipt, if necessary. For more information, see "Applying a Receipt to a Job-
Related Invoice" (page 211).

 12. Apply the receipt. For more information, see "Applying a New Receipt to a Posted Invoice or Debit 
Note" (page 210).

 13. Click Add.

After adding a customer receipt

 l If you use Payment Processing and selected a payment code that uses the payment type SPS Credit 
Card, click the Charge or Quick Charge button to process a credit card payment for the receipt.

 l Print receipts for the customer. For more information, see "Printing Receipts" (page 342).

 l Print the deposit slips report. For more information, see "Printing the A/R Deposit Slips Report" 
(page 337).

Processing a Credit Card Payment

If you use Payment Processing, you can use the A/R Receipt Entry screen to process a credit card 
payment for a receipt, prepayment, or miscellaneous receipt, or for unapplied cash.

Tip: You can use the A/R Process Credit Card Payments screen to process credit card payments for 
multiple pending invoices (invoices with outstanding payments), and to create receipts for the 
processed payments. For more information, see "A/R Process Credit Card Payments Screen" (page 632).

For information about using the A/R Invoice Entry screen to process a credit card prepayment, see 
"Entering a Prepayment with an Invoice" (page 177). 
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Before You Start

 l If you use Payment Processing, verify that a processing code exists for the bank to which you will 
deposit credit card receipts. If no processing code has been set up in Payment Processing that 
specifies the bank you select, you cannot process a credit card transaction.

 l Sage Exchange must be installed and running on the workstation you are using to process the 
payment.

 l You must have a working Internet connection.

To process a credit card payment:

 1. Open Accounts Receivable > A/R Transactions > Receipt Entry.

 2. On the A/R Receipt Entry screen, create or select the document for which you want to process a 
Paya credit card payment. 

Note: The transaction type for the document must be Receipt, Prepayment, Unapplied Cash, or 
Misc. Receipt.

 3. Select a payment code that uses the payment type SPS Credit Card.

Tip: Click the Payment Code Finder  to see a list of payment codes and associated payment 

types.

The Processing Code field appears, along with a status field that displays information about the status 
of the credit card transaction. More...

If a single processing code exists for the bank you selected, that code appears in the Processing Code 
field. If no default appears, you can select a processing code that specifies the bank you selected for the 
batch.

 4. Enter remaining transaction details, as usual, and then click the Add button.

The Charge and Quick Charge buttons become available.

 5. Click one of the following buttons:

 l Charge. If you click this button, you must complete the remaining steps in this procedure. More...

When you click Charge, the Process Credit Card screen appears. If a default credit card exists in 
the customer record that uses the processing code selected for the current transaction, that credit 
card is selected by default.
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 l Quick Charge. If you click this button, no further steps are required to process the payment. More...

Note: To use Quick Charge, information required for the transaction must already be entered in 
your system. For more information, see "About Quick Processing for Credit Card Transactions" 
(page 132).

 6. Select a saved credit card or enter details for a new credit card. More...

 l To select a saved credit card, use the Finder .

 l To enter details for a new card and save the card in the customer record, click the New  
button, and then add the card details on the Credit Card Information screen.

 l To enter details for a new credit card that will not be saved in the customer record, select 
Enter a Card for One-Time Use.

 7. Enter or review billing details. These may be different from the information in the Sage 300 customer 
record. 

Example: The customer may be using a company credit card, or may be authorized to use a card on 
behalf of the primary cardholder.

 8. Review the totals. More...

For some transactions, you can edit the amount in the Subtotal and Taxes fields. When you edit one of 
these fields, the amount in the other field is calculated automatically by subtracting the amount you 
entered from the total.

 9. Click Process Payment.

The Paya browser form appears.

 10. On the Paya browser form, enter or review credit card details. 

Tips: 
 l If you use a card reader device and did not select a saved credit card for this transaction, 

you can click Swipe Card to swipe a credit card.

 l Sage 300 automatically submits billing details for each transaction to Paya. If you want to 
review these details, click the Next button on the browser form. 

 11. Click Submit.

Paya processes the payment. The browser screen closes, and transaction details and a status 
message appear on the Process Credit Card screen.

 12. On the Process Credit Card screen, review transaction details and status.

 13. Close the Process Credit Card screen.

206Sage 300 2023 Accounts Receivable User's Guide



Processing Multiple Credit Card Payments

Use the A/R Process Credit Card Payments screen to process credit card payments for multiple pending 
invoices (invoices with outstanding payments), and to create receipts for the processed payments.

When you process payments, they are added to a receipt batch that is created automatically. If you 
process payments that use multiple processing codes, a separate receipt batch is created for each 
processing code.

Note: When you process credit card payments on the A/R Process Credit Card Payments screen, you 
cannot enter information for the payments. If you need full control over transaction details (such as 
billing information, order totals, and credit card details), use the Receipt Entry screen instead. For more 
information, see "A/R Receipt Entry Screen" (page 648).

Before You Start

 l For each customer from whom you want to process payments, ensure that the following required 
information and settings are specified:

 l On the A/R Credit Card Information screen, a credit card must be set up for the customer with 
the following options selected:

 l Approved for Automatic Payments

 l Use This as Default Card

Also, this credit card must use the same currency as the customer’s currency. More...

The currency for a credit card is determined by the Processing Code specified for the credit 
card on the A/R Credit Card Information screen.

The currency for a customer is determined by the Account Set specified for the customer on the 
Processing tab of the A/R Customers screen.

 l On the Processing tab of the A/R Customers screen, a payment code that uses the 
payment type SPS Credit Card must be specified for the customer.

 l If you want to allow terms discounts (as specified on invoices), select the Allow Terms Discount on 
Credit Card Receipts option on the PMT Options screen. More...

 l If this option is selected, terms discounts are allowed. A credit card payment can be processed 
for an invoice in the following situations:

 l The invoice due date is on or before the Invoices Due On or Before date.

 l A terms discount for the invoice is available on the Invoices Due On or Before date.
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 l If this option is not selected, terms discounts are not allowed. A credit card payment can be 
processed for an invoice only if the invoice due date is on or before the Invoices Due On or 
Before date.

To process credit card payments:

 1. Open Accounts Receivable > A/R Transactions > Process Credit Card Payments.

 2. In the Invoices Due On or Before field, specify a due date for invoices. More...

Invoices that are due on or before the date specified in this field appear in the table, allowing you to 
process payments for them.

Notes: 
 l This date is used as the batch date for receipt batches created when you process 

payments.

 l If you allow terms discounts for credit card payments, invoices with terms discounts do not only 
appear in the table if they are due on or before the specified date. They also appear if a terms 
discount is available on the specified date. For example:

An invoice for one of your customers is due on June 30, but it includes a terms discount if it is 
paid before June 10. In the Invoices Due On or Before field, you enter June 4. The invoice 
appears in the table, even though it is due after June 4, because the terms discount is available 
on June 4.

If you have an invoice with terms discounts that is set up to be paid in multiple payments (for 
example, three monthly installments), all the outstanding payments for the invoice appear in 
the table. For such invoices, take care not to process payment for all the outstanding 
payments.

 3. If you want to specify other criteria by which to filter invoices (such as customer number or 
processing code), enter information in the fields above the table. For more information about 
available filters, see "A/R Process Credit Card Payments Screen" (page 632).

 4. Click the Go  button.

Pending invoices that match the criteria you specified appear in the table. In the Apply column, "Yes" 
appears by default for all invoices.

 5. If you do not want to process payments for all invoices that appear in the table, set the value in the 
Apply column to "No" for invoices you want to exclude from processing. More...

 l To set the value in the Apply column, select a row, and then double-click the Apply column 
or press the spacebar.

 l If you want to set this value to "No" for all invoices, click the Apply None button.

 l If you want to set this value to "Yes" for all invoices again, click the Apply All button.
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 6. If you want to print receipts after you process payments and create receipts, select the Print 
Receipts After Processing Payments option. More...

If you select Print Receipts After Processing Payments, the A/R Receipts report screen opens after 
Sage 300 processes payments and creates receipts. By default, the numbers of the first and last 
Accounts Receivable batches created while processing payments are specified in the From and To 
batch number fields.

 7. Click Process Payments.

 l Paya processes payments for all documents that display "Yes" in the Apply column.

 l Accounts Receivable creates a receipt for each payment that is successfully processed.

 l Accounts Receivable creates a receipt batch with the date specified in the Invoices Due On 
or Before field used as the batch date. If you use multiple processing codes, a separate 
receipt batch is created for each processing code. 

 l When processing is complete, a message displays summary information about payments 
that were successfully processed. If any errors occur while processing payments and 
creating receipts, a message displays detailed information about each error.

Tip: If any payments were not processed, or if any receipts were not created, print this 
message to create a record of errors that you need to resolve.

 l If you select Print Receipts After Processing Payments, the A/R Receipts report screen 
opens after Sage 300 processes payments and creates receipts. By default, the numbers of 
the first and last Accounts Receivable batches created while processing payments are 
specified in the From and To batch number fields.

Voiding a Credit Card Payment

If you use Payment Processing, you can void a credit card payment in Sage 300 or by signing in to Sage 
Virtual Terminal. For more information about Payment Processing and Sage Virtual Terminal, see the 
Payment Processing help. 

Note: You can void a payment only if it has not been settled in Paya. Payments are typically settled 
within 48 hours. 

Before You Start

 l A credit card payment must have been processed in Paya, and must not have been settled. 
Payments are typically settled within 48 hours. 

 l Sage Exchange must be installed and running on the workstation you are using to void the 
payment.

 l You must have a working Internet connection.
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To void a credit card payment:

 1. On the A/R Invoice Entry screen or the A/R Receipt Entry screen, select the document for which a 
Paya credit card payment was processed.

 2. If you are using the A/R Invoice Entry screen, click Prepay to open the Prepayments screen.

 3. Click Void.

The Process Credit Card screen appears and displays details for the transaction.

 4. Click Void Sale.

 l If the payment has not been settled in Paya, it is voided.

 l If the payment has been settled in Paya, an error message informs you that it cannot be 
voided. If you want to refund the payment, you can process a refund on the A/R Refund Entry 
screen.

 5. Close the Process Credit Card screen.

Applying a New Receipt to a Posted Invoice or Debit Note

If you have unapplied receipts, you can apply them at any time to posted invoices or debit notes.

To apply a receipt:

 1. Open Accounts Receivable > A/R Transactions > Receipt Entry.

 2. Enter a new receipt. For more information, see "Entering a Customer Receipt" (page 202).     

Note: If you use Payment Processing and want to process a credit card payment, you must select a 
payment code that uses the payment type SPS Credit Card before adding the receipt. After you 
select the payment code, the Processing Code field appears, along with a status field that displays 
information about the status of the credit card transaction. After you add the receipt, the Charge and 
Quick Charge buttons become available.

Tip: Click the Payment Code Finder  to see a list of payment codes and associated payment 

types.

 3. Select the Select Mode option, unless you know the document number to which to apply the 
receipt.

Tip: If you select the Select Mode option, you can also select the Auto Apply option to let Accounts 
Receivable apply the document automatically to the document with the earliest due date in the 
customer's account.
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 4. If you do not select the Auto Apply option, select the document type (All, Invoice, Credit Note, 
Debit Note), list order (Document Number, Purchase Order Number, Due Date, Order Number, 
Document Date, Current Balance), and an optional starting number, balance, or date.

 5. Click the Go  button to display the customer's open documents of the selected type.

Note: If you selected the Auto Apply option and you are satisfied with the result, skip the next step.

 6. Double-click in the Apply column (changing the entry to Yes) for each document to which you want 
to apply the receipt.

To partially pay a document, type the amount to apply in the Applied Amount column.

Note: If you selected the Auto Apply option, Accounts Receivable displays Yes automatically for the 
documents it selected to pay. You can change the selection by double-clicking the Apply column in 
the row you want to change. You can also change the amount as described in this step.

If you apply an amount that is greater than the amount you actually received from the customer, you 
create a receipt with a debit balance. (You might do this, for instance, if you have not yet issued a credit 
note for the customer. When you process the credit note, later, you can apply it to the receipt to produce 
a net result of zero.)

If you apply an amount that is less than the amount you received from the customer, the unapplied 
portion is posted with the original receipt. You can then apply the unapplied portion of the posted 
receipt, later.

 7. If you use Payment Processing and selected a payment code that uses the payment type SPS Credit 
Card, click the Charge or Quick Charge button to process a credit card payment for the receipt.

 8. Click Save to apply the receipt.

Note: To cancel the application, click Close or select another entry number, and then click No on the 
message that appears asking whether you want to save your changes.

After you apply the receipt

Post the batch that contains the receipt.

Applying a Receipt to a Job-Related Invoice

If you have unapplied receipts for a job-related invoice, you can apply them at any time.
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Before You Start

 l Add the receipt, if you have not already added it. For more information, see "Entering a Customer 
Receipt" (page 202).

To apply amounts to details for different contracts, projects, categories, and resources:

 1. Open Accounts Receivable > A/R Transactions > Receipt Entry.

 2. Use the Batch Number field, to display the batch the contains the receipt you are going to apply.

 3. Use the Entry Number field to display the receipt.

 4. In the detail-entry table, for the job-related invoice that your customer is paying:

 a. Select Yes in the Apply column.

 b. Double-click in the Applied Amount column, and then type the amount to apply to the 
selected invoice.

 c. Click the Jobs button.

 5. On the Project and Job Costing Apply Details screen that appears:     

 a. In the Apply Method field, select a method to apply the amount to the contracts, projects, 
categories, and projects on the invoice. You can select one of the following methods:       

 l Top Down. More...

Select this method to apply an amount automatically to invoice details beginning with the 
first detail (contract-project-category-resource) on an invoice until the amount is fully 
applied.

If you are using this method to allocate a payment to an invoice that uses a multiple 
payment schedule, you may have to adjust the allocations manually.

Note: Discounts, if any, are applied to the last line only. If you want to allocate discounts 
proportionately, you should select the Prorate By Amount option.

 l Prorate By Amount. More...

Select this method to apply a receipt amount proportionately to all invoice details, based 
on the relative amounts of the details.

 b. Select any detail that is not being paid at this time, and then press the Delete key to remove 
it from the distribution.

 c. Click Close to return to the A/R Receipt Entry screen.

 6. Click Add or Save.
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 7. If you use Payment Processing and selected a payment code that uses the payment type SPS Credit 
Card:

 a. Click Charge or Quick Charge to process a credit card payment for the receipt.

 b. After processing the payment, click Save to save the receipt.

Applying a Posted Prepayment, Unapplied Cash Transaction, Receipt, or 
Credit Note

If you have unapplied documents, you can apply them at any time using the A/R Receipt Entry screen.

To apply a posted document:

 1. Open Accounts Receivable > A/R Transactions > Receipt Entry.

 2. Select an existing receipt batch or create a new receipt batch.

 3. Click the New  button beside the Entry Number field.

 4. Enter the customer number, entry description, date, year, and period.

 5. In the Transaction Type field, select Apply Document.

 6. In the Document Number field, type the number of the prepayment, unapplied cash, receipt, or 

credit note, or use the Finder  to select it.

The amount is automatically inserted and you cannot change it.

 7. Select the Select Mode option, unless you know the document number to which to apply the 
customer's payment or credit note.

Tip: If you select the Select Mode option, you can also select the Auto Apply option to let Accounts 
Receivable apply the document automatically to the document with the earliest due date in the 
customer's account.

 8. If you do not select the Auto Apply option, select the document type (All, Invoice, Credit Note, 
Debit Note), list order (Document Number, Purchase Order Number, Due Date, Order Number, 
Document Date, Current Balance), and an optional starting number, balance, or date.

 9. Click the Go  button to display the customer's open documents of the selected type.

Note: If you selected the Auto Apply option and you are satisfied with the result, skip the next step.

 10. Double-click in the Apply column (changing the entry to Yes) for each document to which you want to 
apply the prepayment, unapplied cash, or credit note.
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To partially pay a document, type the amount to apply in the Applied Amount column. You cannot apply 
more than the total amount of the applied document.

Note: If you selected the Auto Apply option, Accounts Receivable displays Yes automatically for the 
documents it selected to pay. You can change the selection by double-clicking the Apply column in 
the row you want to change. You can also change the amount as described in the next step.

 11. Click Save to apply the prepayment, unapplied cash, or credit note.

After you apply the document

 l You must post the receipt batch that contains the apply document transaction to update the 
accounts.

Adjusting a Document During Receipt Entry

You can adjust the amounts on receipt entries.

Before You Start

 l On the A/R Options screen, select the Allow Adjustments in Receipt Batches option. For more 
information, see "A/R Options Screen" (page 523).

To adjust a document during receipt entry:

 1. Open Accounts Receivable > A/R Transactions > Receipt Entry.

 2. Create a new entry, or select one for editing. For more information, see "Entering a Customer 
Receipt" (page 202).

 3. Click Add or Save.

 4. Double-click in the Apply column (changing the entry to Yes) for the document to which you are 
applying the receipt, and then:

 a. Double-click in the Applied Amount column, and then type the amount to apply to the document. 
You cannot apply more than the total amount of the applied document.

 b. Click Adjust.

The A/R Miscellaneous Adjustment Entry screen appears.

 5. Enter a reference and description for the adjustment.

 6. In the table, for each adjustment detail:
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 a. Enter a distribution code or general ledger account number 

Tip: You can also click Select Detail to select a particular detail from the document you are 
adjusting. (This button is available if the document is job-related.)

 b. Double-click in the Debit or Credit column (depending on the adjustment), and then type 
the adjustment amount for the detail.

 7. When finished, click Close to return to the A/R Receipt Entry screen.

 8. Click Save.

Viewing Document History when Applying a Receipt or a Credit Note

You can view the history for the documents to which you are applying a receipt or a credit note.

Before You Start

 l Select or create the receipt batch and the receipt entry.

To view the history of document while applying a receipt or credit note:

 1. Open Accounts Receivable > A/R Transactions > Receipt Entry.

 2. Select the document on the detail table.

 3. Choose Yes in the Apply column for the document line.

Note: Double-click in the Apply column to change the selection from No to Yes, or from Yes to No.

 4. Click History.

The A/R Document History screen appears, providing information about each document that was 
previously applied to the selected invoice, credit note, or debit note. More...

The following information is displayed for each document:

 l Transaction type.

 l Check/document number.

 l Transaction date.

 l Applied amount.

 l Transaction description.

 l Remitting customer number and name.

Note: You cannot change any of the information in the A/R Document History screen.

215Sage 300 2023 Accounts Receivable User's Guide



For more information, see A/R Document History Screen (Receipts).

 5. To see other columns or lines, click the arrows in the lower corners of the screen, or use the scroll 
bars.

 6. Click Close to return to the A/R Receipt Entry screen.

Editing Optional Fields for a Receipt

You can add optional fields to a receipt, or change the default values for the optional fields.

To check or to change the optional fields and values for a receipt:

 1. On the A/R Receipt Entry screen, click the Zoom  button beside the Optional Fields option.     

An Optional Fields screen appears, displaying any optional fields that are marked for automatic 
insertion on new receipts.

 2. Use this Optional Fields screen to add or delete optional fields for the receipt document. You can 
add any optional fields that are defined for receipts.   

You can change the default value that appears for an optional field, as follows:

 l If the optional field is validated, you must specify a value that is defined for the optional field 
in Common Services.     

Note: If the optional field allows blanks, you can leave the value field blank.

 l If the optional field is not validated, you can enter any value that is consistent with the type of 
field (such as yes/no, text, number, date, or amount), providing the value you enter does not 
exceed the length permitted for the field. You can also leave the field blank.

Note: When you specify a value that is defined in Common Services, the description for the value is 
also displayed.

Processing a Cash Sale or Miscellaneous Receipt

You add a miscellaneous receipt when you make a cash sale to a regular customer or when you receive 
a one-time payment from others.

If the payment is from a regular customer, Accounts Receivable generates a paid invoice for the sale 
when you post the receipt.

If you are entering a receipt for a one-time customer, for whom you do not create a customer record, 
Accounts Receivable does not create an invoice when you post the receipt.
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To add a cash invoice or miscellaneous receipt:

 1. Open Accounts Receivable > A/R Transactions > Receipt Entry.

Note: You can use the A/R Quick Receipt Entry screen to add a miscellaneous receipt to a deposit 
slip, but you must use the A/R Receipt Entry screen to distribute the receipt to general ledger 
accounts.

 2. Use the Batch Number field to do one of the following:     

 l Create a new receipt batch by clicking the New  button.

 l Select an existing batch using the navigation buttons or the Finder .

 3. Create a new miscellaneous receipt for the customer. More...

If you are using the A/R Receipt Entry screen:

 a. Click the New  button beside the Entry Number field.

 b. In the Transaction Type field, select Miscellaneous Receipt.

 c. If the receipt is from an existing customer, type the customer number or use the Finder  
beside the Customer Number field to select the customer.      

If you are using the A/R Quick Receipt Entry screen:

 a. Select the miscellaneous receipt from the list, or add a new line using Miscellaneous 
Receipt as the transaction type. (Click the down arrow in the Transaction Type column, and 
then click Miscellaneous Receipt.)

 b. If the receipt is from an existing customer, type the customer number for the detail in the 

Customer Number column, or use the Finder  on the Customer Number column 
heading to select the number.

 c. Click Open to open the A/R Receipt Entry screen. 

 4. Enter general information for the receipt entry. More...

 l A description for the entry.

 l Date and the year and period.

 l Payer name, if the payer is not an existing customer.
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 l Payment code.    

Note: If you use Payment Processing and want to process a credit card payment, you must 
select a payment code that uses the payment type SPS Credit Card before adding the receipt. 
After you select the payment code, the Processing Code field appears, along with a status field 
that displays information about the status of the credit card transaction. After you add the 
receipt, the Charge and Quick Charge buttons become available.

Tip: Click the Payment Code Finder  to see a list of payment codes and associated 

payment types.

For more information about payment codes, see "A/R Receipt Entry Screen" (page 648).

 l Check or receipt number.

Note: If you leave the Check/Receipt No. field blank, Accounts Receivable will assign a 
number automatically when you add the receipt.

 l Receipt amount and, for a multicurrency system, the currency.

 l Invoice number.

Note: You can also leave this field blank to let Accounts Receivable assign the invoice number. 

 l Tax group. More...

Use theFinder  to select the tax group for the payer, if no tax group is displayed.

Note: If you entered the code for an existing customer, the tax group specified in the customer 
record appears, but you can change it.

 5. Enter distribution details for the receipt. More...

 l If the receipt is job-related, select the Job Related option, and then use the job-related fields 
that appear to distribute the receipt to contracts, projects, categories, and resources, as 
required.

 l If the receipt is not job-related, for each distribution detail, enter the distribution code or the 
general ledger account number and the amount.

You can also type an optional reference and description.

 6. If you have a multicurrency ledger and you want to specify the exchange rate for the miscellaneous 
receipt:
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 a. Click Rates. 

 b. On the A/R Rate Override screen that appears, change the rate date and exchange rate, as 
necessary.

 c. Click OK.

 7. To check or change the taxes calculated for the document (including the tax reporting amount), or 
to change the tax group for the document, click Document Taxes.

 8. To check the taxes calculated for a distribution detail, or to enter them manually if tax is not 
calculated automatically for the receipt, select the detail, and then click Account/Tax.

 9. Click Add or Save.

 10. If you use Payment Processing and selected a payment code that uses the payment type SPS Credit 
Card, click the Charge or Quick Charge button to process a credit card payment for the receipt.

 11. Click Close to close the A/R Receipt Entry screen. 

After distributing the receipt

 l Post the receipt batch when you have finished adding receipt entries. For more information, see 
"Posting a Receipt Batch" (page 236).

 l Accounts Receivable creates a paid invoice when you post a miscellaneous receipt for an 
Accounts Receivable customer.

Advancing Credit to a Customer for Returned Goods

If a customer is returning goods, but you have not yet received the goods, you can advance credit to the 
customer.

To process an advance credit:

 1. Open Accounts Receivable > A/R Transactions > Receipt Entry.

 2. Use the Batch Number field to specify the open batch that contains the receipt, or create a new 
batch.

 3. Use the Entry Number field to display an existing receipt, or add a new receipt for the customer. 
For more information, see "Entering a Customer Receipt" (page 202).

 4. Click the Zoom  button beside the Advance Credit field.     

The A/R Advance Credit screen appears.

 5. For each claim for which you are issuing credit, press Insert to create a detail line, and then 
complete the fields in the detail lines. For more information, see A/R Advance Credit Screen.
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 6. Click Close to return to the A/R Receipt Entry screen, where you apply the receipt (including the 
advance credit), as usual.

 7. Click Save.

After adding the advance credit

 l The advance credit amount appears as a debit on the customer's statement, where it remains until 
you receive the returned goods.

 l When you receive the goods, enter the real credit note, offsetting the advance credit in the 
customer's account (and on the customer's statement), and reducing sales.

Refunds
You use the A/R Refund Entry screen to reimburse customers for credit balances, overpayments, or the 
return of goods. 

About Processing Refunds

You use the A/R Refund Entry screen to:

 l Enter cash or check refunds to customer accounts.

 l If you use Payment Processing, enter credit card refunds to customer accounts.

 l Print payment checks for customers.

Note: You can issue an advance credit for goods that a customer is returning. For more information, 
see "Advancing Credit to a Customer for Returned Goods" (page 219).

Entering Customer Refunds

Refund Entry lets you refund a customer using a combination of cash and check payments for a single 
refund. If you use Payment Processing, you can apply a refund to the credit card used for a transaction, 
or refund the customer using a cash or check payment.

 l For cash refunds, you specify a cash account (for example, Petty Cash) or a bank code to identify 
the bank.

 l For check refunds, you also specify a bank code.

 l For credit card refunds, you select a document with the payment type SPS Credit Card (which 
indicates that a Paya credit card transaction was processed for the document).

You can apply a single refund to several credit documents, and you can refund these credit documents 
using the same tender (cash or check) in which you received them.
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Allocating Job-Related Refunds

Accounts Receivable maintains the outstanding balance for each detail on job-related documents. 
Therefore, when you refund a job-related credit note or prepayment, you must specify how much to 
refund for each detail.

You can accept the allocation that Accounts Receivable calculates using the apply method specified for 
the refund, or you can use the Job Details screen to allocate amounts manually to specific details.

Printing Checks

If you are refunding by check, you can print:

 l A single check by clicking the Print Check button on the A/R Refund Entry screen when you enter 
the refund.

 l A range of checks by selecting a refund batch on the Refund Batch List screen, and then clicking 
the Print/Post button.

For more information on the steps for printing checks, see About Processing Refunds.

Posting Refunds

You can either post refunds and print refund checks at the same time, using the Refund Batch List 
screen, or you can post a range of refund batches (for which you have already printed checks), using the 
Post Batches screen.

When you post refunds, Accounts Receivable:

 l Updates Bank with the refund check information.

 l Updates Project and Job Costing for job-related refunds.

Note: If you use Payment Processing, you must process all credit card refunds in Paya before posting 
in Sage 300.

Multicurrency Ledgers

If you are adding a multicurrency refund, you specify the bank and the currency for each tender (cash or 
check) you use on the refund. You use one bank and one currency per tender, although you can issue a 
single refund that uses different tenders and currencies.

If you are refunding in a currency that is neither your functional currency or your customer's currency, you 
specify the rate type, rate date, and the exchange rate on the screen.

If you are refunding in your customer's currency and it is different from your functional currency, you use 
the Rates tab to specify the exchange rate for amounts you are refunding.
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Adding, Editing, or Deleting a Refund Batch

You use refund batches to contain refunds to customer accounts.

Before You Start

 l In Bank Services, on the Banks screen, for each bank you use to issue refunds, specify the check 
stock and check forms to use when refunding by check.

 l On the A/R Options screen, specify refund options for your Accounts Receivable system:         

 l On the Transactions tab, specify whether Accounts Receivable displays an error message, 
a warning, or no message when you try to process a refund using a check number that has 
been issued for the same bank.

 l On the Numbering tab, enter the prefix and next number to assign to refunds.

 l If you use Payment Processing and want to delete a refund batch that includes one or more Paya credit 
card refunds, you must void those refunds before you can delete the refund batch. For more 
information, see "Voiding a Credit Card Refund" (page 229).

Note: If a refund has been settled in Paya, you cannot void the refund or delete the batch.

To create a refund batch:

 1. Open Accounts Receivable > A/R Transactions > Refund Entry.

Note: You can also create batches from the A/R Refund Batch List screen. For more information, see 
"A/R Refund Batch List Screen" (page 672).

 2. Click the New  button beside the Batch Number field.

Accounts Receivable automatically assigns a number to each new batch starting with 1. You must use 
the assigned batch number.

 3. Enter a description and a date for the batch.

 4. Select the bank to which you will make the deposit.

 5. In a multicurrency ledger, select the currency for the batch.

You can view, edit, or delete an existing batch of refunds.
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To open a refund batch:

 1. Open Accounts Receivable > A/R Transactions > Refund Entry.

 2. In the Batch Number field, enter the number of a refund batch.     

Tip: You can search for batch numbers using the Finder  or the navigation buttons beside the 

Batch Number field.

To delete a refund batch:

 1. Open Accounts Receivable > A/R Transactions > Refund Batch List.

 2. Enter the number of the batch to be deleted.

 3. Click Delete.

All transactions in the batch are deleted and the batch is listed as deleted on the Batch Status report. 
You cannot reuse the batch number.

After deleting a refund batch

 l Clear the data for the deleted batch from Accounts Receivable. (Select the Clear Deleted And 
Posted Batches option on the A/R Clear History screen.)

Refunding a Customer

You can add refunds for customer accounts.

Before You Start

 l In Bank Services, on the Banks screen, for each bank you use to issue refunds, specify the check 
stock and check forms to use when refunding by check.

 l Update currency information and exchange rates in Common Services.

 l Identify the rate type, rate date, and exchange rate to use for each multicurrency refund you plan 
to add to the batch.

 l Create or select the refund batch to use.

 l If you use optional fields, define optional fields for refund transactions.

 l If you use Payment Processing and you are refunding a transaction paid by credit card:

 l A credit card payment must have been processed and settled in Paya, and the batch 
containing the transaction must have been posted in Sage 300.          
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Note: If the transaction you are refunding was entered in Order Entry, you must run Day End 
Processing before you can select the transaction on the A/R Refund Entry screen.

 l Sage Exchange must be installed and running on the workstation you are using to refund 
the payment.

 l You must have a working Internet connection.

To add a refund:

 1. Open Accounts Receivable > A/R Transactions > Refund Entry.

 2. Create a new refund batch or open an existing refund batch.

 3. Enter general information for the refund. More...

 a. Enter a description for the entry.

 b. In the Customer Number field, type or select the customer number. 

 c. In the Refund Number field, accept the ***NEW*** entry to let the program assign the 
refund number.

 d. Enter the date and the year and period for the refund, or accept the displayed information. 
(The program uses the session date and the current year and period as defaults for the 
refund.)

 4. Specify the payment type. More...

 a. If all or part of the refund is in cash, click the Cash Payment button, and then enter the bank 
or cash account and the currency for the cash refund. If you are refunding in a currency 
different from your functional currency, also specify the rate type, rate date, and the 
exchange rate for the refund.

 b. If all or part of the refund is by check, click the Check Payment button, and then enter the 
bank, currency, and check language for the refund. If you are refunding in a currency 
different from your functional currency, also specify the rate type, rate date, and the 
exchange rate for the refund.

Select the Print Check option if you are using Accounts Receivable to print the check. If you 
have issued a manual check, do not select the option, but enter the check number in the field 
provided. 

Note: When you add details for the cash refund later, the program updates the Check Amount 
field.

 5. In the Detail table, add refund details. More...

Note: When refunding a credit card payment, you can enter only a single detail line for the refund. 

For each detail:
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 a. Press the Insert key on your keyboard to insert a detail line.

 b. In the Document Number column, enter the number for the document you are refunding, or 
use the Finder to select it.

The program fills in information about the selected document, including the document type, 
original amount, current and pending balances, and whether the document is job related.

 c. In the Payment Type column:

 l If you are applying a credit to the card used for the original transaction, verify that the 
payment type SPS Credit Card is selected.

 l If you are issuing the refund by cash or check, double-click the Payment Type field 
and select the payment type.

 d. If you are applying the refund to a credit note paid by credit card, select the receipt number 
associated with the payment from the list in the Receipt No. field. 

 e. In the Payment Amount column, enter the amount you are refunding for the selected 
document. You can refund any amount up to the total for the original document.

 6. Click Add to add the refund entry.

The Credit button becomes available.

 7. If all or part of the refund is by credit card, apply the credit to the card. More...

 a. Click the Credit button.

The PMT Process Credit Card screen appears in Credit mode, with the card used for the original 
transaction selected. (You cannot select another card because you must apply the refund to the 
card used for the original transaction.)

 b. Click the Apply Credit button.

Paya applies the credit to the card used for the original transaction. Transaction details and a 
status message appear on the PMT Process Credit Card screen.

 c. Click Close to close the screen.

 8. Click Save to save the refund entry.

After adding the refund

 l Print the refund batch listing.

 l If you are refunding by check, print the check and post the refund batch. For more information, see:

 l "Printing a Single Refund Check" (page 226).

 l "Printing and Posting a Batch of Refunds" (page 237).
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Viewing Document History when Refunding a Customer

You can view details about transactions that have been applied to a document you select on the detail 
table of the A/R Refund Entry screen.

Before You Start

 l Select or create the refund batch and the refund entry.

To view the history of a credit note or prepayment:

 1. On the detail table on the A/R Refund Entry screen, select the document.

 2. Click History.              

The A/R Document History screen appears.

 3. To see other columns or lines, click the arrows in the lower corners of the screen, or use the scroll 
bars.

Note: You cannot change any of the information in this screen.

 4. Click Close to return to the A/R Refund Entry screen.

Printing a Single Refund Check

You can use the A/R Refund Entry screen to print a single refund check.

Note: After check information has been posted to Bank Services, you cannot edit the payment entry or 
reprint the check. If necessary, you can delete the payment entry (until you post it), which voids the 
check in Bank Services. If you delete a check before it is posted, Accounts Receivable voids the check 
in Bank Services.

Before You Start

 l Adapt the layout of the check forms shipped with Accounts Receivable to match your checks.

 l Use the A/R Refund Entry screen to add the refund you want to print.

 l In Bank Services, select the check form and enter the next check number for the payment bank.

To print a refund check:

 1. Open Accounts Receivable > A/R Transactions > Refund Entry.

 2. Add the check refund you want to print or display the refund you added before. For more 
information, see "Refunding a Customer" (page 223).
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 3. Click Check Payment, and then select the Print Check option if it is not already selected.

After you add a transaction with Print Check selected, the Print Check button becomes available for you 
to print the check. You cannot print the check until you add the transaction.

 4. Click Print Check.     

The A/R Print Checks screen appears. More...

Notes: 
 l The check stock is set in Bank Services, but you can change it here, if necessary.

 l An Advice file name appears only if you are printing separate payment advices.

 l The check status is "Not Printed." When a check (and advice, if printed) is printed 
successfully, the status changes to "Printed." If the check is printed, but you have not yet 
printed the advice, the status is "Advice Not Printed."

 5. Specify information for the check run, such as the check stock code, the check form, and the next 
check number to use. If you specify a check number that has been used before, Accounts 
Receivable may display a message, depending on your choice for the Check For Duplicate 
Checks option on the A/R Options screen.

If you are not ready to print this check, click Close. When a message appears warning you that not all 
checks have been printed, click Yes to leave the A/R Print Checks screen, cancel the check run, and 
void the printed checks. (None were printed.)

 6. Make sure your printer is ready, and then click Align to print an alignment check. More...

The alignment check prints Xs in place of numbers and letters on a check form, so you can see that the 
check forms are inserted properly in the printer.

Note: Alignment checks always print to your printer, no matter what print destination you selected for 
Sage 300.

 7. If you are satisfied with the alignment check, click Print to print the current check. 

When the check has printed, a message appears asking whether the check was printed successfully. 
Do one of the following:     

 l If the check was printed correctly, click Yes.       

If you are not printing a payment advice, Accounts Receivable posts the check information to 
Bank Services and closes the Print Checks screen, returning you to the A/R Refund Entry screen.

 l If you need to reprint the check, click No, and then reset the status of the check to Not 
Printed. More...

To change the status of the check, do one of the following:
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 l Double-click the Print Status column for the check number, or press Space in the 
Check Status column.          

If you printed Advices, then said No to the message that asked whether the advices were 
printed successfully, you will cycle through all three possible statuses by double-clicking.

 l Click Select Reprint Range.          

The Select Reprint Range screen appears, letting you specify a range of checks. Click OK 
to select the default range—which is for the one check you printed.

After resetting the status to Not Printed, click Print again. (Unless you are printing Checks 
then Advices, in which case the button will change to Reprint.)

 8. If you are also printing payment advices after printing checks (the choice of Checks Then Advices), 
a message appears when the check is successfully printed asking you to insert the advice stock in 
the printer and click OK. As for checks, you can confirm that you inserted the payment advice 
forms in the printer.

Once the advice has been printed, confirm that it was printed properly—as you did with the check. More...

Do one of the following:

 l If the advice printed correctly, click Yes.        

Accounts Receivable posts the check information to Bank Services, and closes the Print Checks 
screen, returning you to the A/R Refund Entry screen.

Note: You cannot edit the refund entry or reprint the check once the information is posted to 
Bank Services. If necessary, you can delete the payment entry, which voids the check in Bank 
Services.

 l If you need to reprint the advice, click No, and then reset the status of the check to Advice 
Not Printed. More...

To change the status of the check, do one of the following:

 l Double-click the Check Status column. You can reset the status to Not Printed (to 
reprint the check) or to Advice Not Printed (to reprint the advice only).

 l Click Select Reprint Range to reset the status to Advice Not Printed.

 l If the check did not print properly, but you cannot reprint it at this time, cancel the check run as 
follows:

 a. Click No when asked whether the check was printed successfully.

 b. Reset the check status to Not Printed.
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 c. Click Close.

A message appears stating that not all checks have been printed, and asking whether you 
want to cancel the check run.

 d. Click Yes to cancel the print run and void the current check number. (The number will 
otherwise be assigned a Void status when you reprint the check.)

Note: If you do not cancel the check run, Accounts Receivable sets the batch status to 
Check Printing In Progress, and you cannot edit the batch until you reset the status to 
Open.

After printing checks

 l Print the Batch Listing.

 l Post the Refund batch. For more information, see "A/R Refund Batch List Screen" (page 672).

Voiding a Refund Check

You can void printed refund checks.

To void a printed check:

 1. Open Accounts Receivable > A/R Transactions > Refund Entry.

 2. In the Batch Number field, specify the batch that contains the refund entry you want to cancel.

 3. In the Entry Number field, specify the refund entry you want to cancel.

 4. Select the check on the detail table.

 5. Click Void Check.

 6. Click Yes to void the check.

Voiding a Credit Card Refund

If you use Payment Processing, you can void a credit card refund in Sage 300 or by signing in to Sage 
Virtual Terminal. For more information about Payment Processing and Sage Virtual Terminal, see the 
Payment Processing help. 

Important! You can void a refund only if it has not been settled in Paya. Refunds are typically settled 
within 48 hours.
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Before You Start

 l The credit card refund must have been processed in Paya, and must not have been settled. 
Refunds are typically settled within 48 hours. 

 l Sage Exchange must be installed and running on the workstation you are using to void the refund.

 l You must have a working Internet connection.

To void a credit card refund:

 1. Open Accounts Receivable > A/R Transactions > Refund Entry.

Note: You can also open the A/R Refund Entry screen from the Refund Batch List screen. For more 
information, see "A/R Refund Batch List Screen" (page 672).

 2. On the A/R Refund Entry screen, select a  document for which a Paya credit card payment has 
been refunded.

 3. Click Void.

The Process Credit Card screen appears and displays details for the refunded transaction.

 4. Click Void Refund.

If the refund has not been settled in Paya, the refund is voided. 

If the refund has been settled in Paya, an error message informs you that the refund cannot be voided. 
In this case, the transaction is complete, and if you want to charge the customer's credit card, you must 
create a new transaction.

 5. Close the Process Credit Card screen.

Posting Batches
When you have finished entering transactions in a batch, you post it to add the information permanently 
to the customer records.

About Posting Batches

When you post batches in Accounts Receivable, you permanently update   the information stored for the 
customer accounts specified in the entries.   You can post invoice, cash, or adjustment batches at any 
time, and there   is no limit on the number of batches you can post at a time.

This section describes the posting procedure and the effects of posting, including the records affected, 
and the sequence numbers assigned to and reports created for posted transactions.
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Preparing to Post Batches

You take these steps to post batches:

 1. Print listings of the   batches you want to post.

 2. Print deposit slips for   receipt batches.

 3. On the Batch List screen, select the Ready To Post option for each batch you want to post.

 4. Back up  your data. 

 5. Post the batches using   the Post Batches screen, or use the Batch List screen to post batches 
individually.   

Effects of Posting

Posting updates customer transaction information. It also updates statistics in customer, group, and 
national account records, as well as in item and salesperson records, if you keep those statistics. If you 
use the option to create batches during   posting, posting also creates transactions for the general ledger 
accounts   affected by the transactions and creates General Ledger batches for them. 

Specifically, posting:

 l Creates a posting journal   with a unique posting sequence number.

 l Creates   general ledger entries from the posted transactions, if you select the   option to create the 
general ledger batches during posting.

 l Updates   the posting sequence numbers displayed for each type of batch on the A/R Options 
screen. If you create General Ledger transactions during posting, the process   also updates the 
sequence numbers for the General Ledger batches on the   Numbering tab of the A/R Options 
screen.

 l Creates   an error batch if errors are found in the entries.

 l Transfers   batch contents to the customer accounts. You can no longer edit the batch.  

 l Updates period-to-date   and year-to-date statistics in customer records and in item and 
salesperson   records if you use the options to keep item and salesperson statistics.  

For any transactions that are marked Job Related, Accounts Receivable also updates the specified 
contracts, projects, categories, and resources in the Project and Job Costing module. However, if the 
invoice will cause the amount billed for a project to exceed the fixed price for the project, the invoice is not 
posted and is placed in an error batch.

Posting retains all the entries in a batch (not only those that posted   successfully), and the batch total 
reflects all the batch entries. 
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Important! You cannot edit posted transactions. When you post a batch, its contents are transferred to 
the customer accounts and you can no longer edit the transactions. You must enter adjustments or 
apply debit notes or credit notes to change any transactions you have already posted.

Assigning Posting Sequence Numbers

Accounts Receivable assigns a posting sequence number to each transaction   during posting. The same 
sequence number is assigned to all transactions   that are posted together. Posting sequence numbers 
provide another way   to trace posted transactions back to source documents.

Each time you post batches, Accounts Receivable increases the posting   sequence number by 1, and 
updates the posting sequence numbers that are   displayed on the A/R Options screen. 

You can look up the current posting sequence numbers on the A/R Options screen.

Creating G/L Transactions for Posted Accounts Receivable Transactions

You can create general ledger transactions automatically during posting (if Accounts Receivable uses 
the Create G/L Transactions During Posting option), or later, using the Create G/L Batch screen.

Creating Posting Journals and the G/L Transactions Report

You can print listings for posted batches, as you can for open or ready-to-post batches.

Each time you post, Accounts Receivable creates a journal of the entries from the batches you posted 
together. These posting journals are an essential part of your audit trail, because they provide a record of 
all posted details and of the related general ledger distributions.

You can also print the G/L Transactions report each time you post batches. The report lists all the 
distributions that were created for general ledger accounts when you posted batches. 

You specify on the A/R options screen whether to create the general ledger transactions automatically 
each time you post batches or at a later time, using the Create G/L Batch screen. 

You should keep your audit trail of posted transactions up to date by printing and filing each posting 
journal as it is created, and by regularly printing and filing the G/L Transactions report and creating 
general ledger transactions.

Note: You must print the G/L Transactions report before using the Create G/L Batch screen to produce 
your general ledger transactions. When you create the general ledger batch, the information for the 
G/L Transactions report is deleted from Accounts Receivable.)
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Deleting Imported Batch Source Files after Posting

When you import and post a batch, the original file you imported still exists in the program where you 
created it. 

You should delete batches after you have imported and posted them, to avoid accidentally importing a 
batch twice.

Drilling Down to Posted Transactions

You can drill down from Sage 300 General Ledger to source documents   in Accounts Receivable, 
provided you do not clear the batches that contained   them. You can also reprint posted invoices and 
deposit slips.

If you also use Order Entry, you can drill down from Sage 300 General   Ledger and from Accounts 
Receivable to view the originating transaction   in Order Entry.

About Posting Recurring-Charge Batches

When you post a recurring charge batch, Accounts Receivable creates a posting journal of the 
transactions and updates the following records:

 l Customers. Accounts Receivable adds the amount and number of new recurring charges to the 
totals for the period in the customer’s account. It also enters the amount and document date of the 
last recurring charge that was posted for the customer.

 l Customer Groups. Accounts Receivable adds the total amount of the recurring charges invoiced 
to customers in the group and the number of recurring charge invoices created for the group to the 
group statistics. Use the Customer Groups screen to view this information.

 l National Accounts. Accounts Receivable adds  the total amount and number of recurring-charge 
invoices created for customers in the national account to the period statistics for the national 
account. It also enters the amount and document date of the last recurring charge invoice posted 
for any customer in the national account. Use the National Accounts screen to view this 
information.

General Ledger Transactions Created for Recurring Transactions

When you post recurring charge batches, Accounts Receivable creates transactions for the revenue 
accounts specified by the distribution code entered with each detail line on a recurring charge invoice, 
and for the affected accounts in the customer’s account set. Posting also creates balancing transactions 
for the corresponding receivables control accounts. Print the posting journal for the recurring charge 
batch or the G/L Transactions report to view this information.

About Posting Interest Batches

When you post interest batches, Accounts Receivable updates the following customer statistics:
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 l Customers. Accounts Receivable adds the amount and number of new interest charges to the 
totals for the period statistics in the customer’s account. It also enters the amount and document 
date of the last interest charge that was posted for the customer in the customer’s activity 
statistics.

 l Customer Groups. Accounts Receivable adds the total amount of interest charged to customers in 
the group and the number of interest invoices created for the group to the group statistics. Use the 
Customer Groups screen to view this information.

 l National Accounts. Accounts Receivable adds the total amount and number of interest invoices 
created for customers in the national account to the period statistics for the national account. It 
also enters the amount and document date of the last interest invoice posted for any customer in 
the national account in the activity statistics for the national account. Use the National Accounts 
screen to view this information.

Posting a Range of Batches

You use the A/R Post Batches screen to post a range of batches to customer accounts.

You can post all batches that are set Ready To Post, or you can specify a range of batches that are set 
Ready To Post.

Tip: 
You can also use batch list screens to post all batches that are set Ready To Post, as follows:

 l Invoice Batch List. Click Post All to post all unposted invoice batches.

 l Receipt Batch List. Click Post All to post all unposted receipt batches.

 l Adjustment Batch List. Click Post All to post all unposted adjustment batches.

 l Refund Batch List. Click Post All to post all unposted refund batches.

Before You Start

 l Decide on the batches you want to post. (Write down the batch numbers, if necessary.)

You can post all batches that are marked Ready To Post, or you can specify a range of batches that 
are marked Ready To Post.

 l Select Ready To Post on the Batch List screen for each batch you want to post.

Note: If you use Payment Processing, you must process all Paya credit card transactions in the 
batch before you can set it Ready To Post.

 l Print listings of the batches you want to post. If you use the option to force listings of batches, you 
cannot post batches until you print the batch listings for them.
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To post a range of batches:

 1. Open Accounts Receivable > A/R Transactions > Post Batches.

 2. Select the type of batch to post (invoice, receipt, adjustment, or refund).

You can post only one type of batch at a time.

 3. Select All Batches to post all the batches of the chosen type, or select Range and then specify the 
range numbers for the batches you want to post.

You can post a single batch, a range of batches, or all ready-to-post batches of the chosen type.

 4. Click Post.

After posting batches

 l Print posting journals.

 l Print the G/L Transactions report.

Important! You should keep your audit trail of posted transactions up to date by printing and filing each 
posting journal as it is created, and by regularly printing and filing the G/L Transactions report and 
creating general ledger transactions.

Posting an Adjustment Batch

You can post adjustment batches individually from the A/R Adjustment Batch List screen or the A/R 
Adjustment Entry screen.

For information about posting multiple batches, see "Posting a Range of Batches" (page 234).

Before You Start

Print listings of the batches you want to post. For more information, see "Printing Batch Listings" (page 
330).

To post an adjustment batch from the A/R Adjustment Batch List screen:

 1. Open Accounts Receivable > A/R Transactions > Adjustment Batch List.

 2. Select the batch you want to post.

 3. In the Ready To Post field for the selected batch, specify Yes.

 4. Click Post.
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To post an adjustment batch from the A/R Adjustment Entry screen:

 1. Open Accounts Receivable > A/R Transactions > Adjustment Entry.

 2. Create or modify an adjustment batch. For more information, see "Adding, Editing, or Deleting an 
Adjustment Batch" (page 140).

 3. Click Post.

Posting an Invoice Batch

You can post invoice batches individually from the A/R Invoice Batch List screen or the A/R Invoice Entry 
screen.

For information about posting multiple batches, see "Posting a Range of Batches" (page 234).

Before You Start

If the Force Listing Of All Batches option is selected on the A/R Options screen, you must print a listing 
of the batch you want to post. For more information, see "Printing Batch Listings" (page 330).

To post an invoice batch from the A/R Invoice Batch List screen:

 1. Open Accounts Receivable > A/R Transactions > Invoice Batch List.

 2. Select the batch you want to post.

 3. In the Ready To Post field for the selected batch, specify Yes.

 4. Click Post.

To post an invoice batch from the A/R Invoice Entry screen:

 1. Open Accounts Receivable > A/R Transactions > Invoice Entry.

 2. Create or modify an invoice batch. For more information, see "Adding, Editing, or Deleting an Invoice 
Batch" (page 168).

 3. Click Post.

Posting a Receipt Batch

You can post receipt batches individually from the A/R Receipt Batch List screen or the A/R Receipt Entry 
screen.

For information about posting multiple batches, see "Posting a Range of Batches" (page 234).
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Before You Start

If the Force Printing Of Deposit Slips option is selected on the A/R Options screen, you must print 
deposit slips for receipt batches. For more information, see "Printing the A/R Deposit Slips Report" (page 
337).

To post a receipt batch from the A/R Receipt Batch List screen:

 1. Open Accounts Receivable > A/R Transactions > Receipt Batch List.

 2. Select the batch you want to post.

 3. In the Ready To Post field for the selected batch, specify Yes.

 4. Click Post.

To post a receipt batch from the A/R Receipt Entry screen:

 1. Open Accounts Receivable > A/R Transactions > Receipt Entry.

 2. Create or modify a receipt batch. For more information, see "Adding, Editing, or Deleting a Receipt 
Batch" (page 198).

 3. Click Post.

Printing and Posting a Batch of Refunds

On the A/R Refund Batch List screen or the A/R Refund Entry screen, you can print an entire batch of 
refund checks, and then immediately post the batch.

Before You Start

 l If the Force Listing Of Batches option is selected on the A/R Options screen, you must print the 
batch listing before you can print and post refund checks. For more information, see "Printing Batch 
Listings" (page 330).

 l On the A/R Refund Batch List screen, select the Ready to Post option for the batch.

To print checks and post the refund information to customer accounts:

 1. Open Accounts Receivable > A/R Transactions > Refund Batch List or Refund Entry.

 2. Select the batch you want to post.

 3. Click Print/Post on the Refund Batch List screen, or click Post on the Refund Entry screen. More...

When you click either of these buttons, Accounts Receivable:
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 l If the Force Listing Of Batches option is selected on the A/R Options screen, makes sure 
that the batch listing has been printed. (You must print the batch listing before you can print 
and post the checks.)

 l Makes sure that the batch you selected is set Ready To Post, and, if it is not, asks whether 
you want to set it to Ready To Post and continue with posting.

 l Posts the batch immediately if all checks in the batch have been printed (or if the refund 
batch does not contain checks).

Otherwise, if there are checks to be printed, Accounts Receivable displays the A/R Print Checks 
screen.

 4. Review the settings on the A/R Print Checks screen before you proceed, and review the list of 
checks the program is ready to print. More...

You can change the following items if they are incorrect:

 l Check stock.

 l Next check number.

 l Number of leading checks. Although nothing will be printed on the leading checks, Bank 
Services needs the information to assign check numbers for the blank forms, to keep the 
audit trail correct.

 l Report file used to print the check and/or advice forms.

You cannot proceed with printing and posting checks without a valid check report file.

 5. Click Print.

If you are printing checks then advices (instead of checks only or combined check and advice forms), 
the program will tell you to insert the check stock in the printer before proceeding.

Note: Checks are printed in the order specified by the Sort Checks By option, on the A/R Options 
screen.

When printing is finished, Accounts Receivable asks whether the checks were printed correctly.

 6. Review the checks, then do one of the following:

 l If the checks printed correctly, click Yes.       

Accounts Receivable returns you to the Refund Batch List screen, and posts the refunds.

 l If the checks did not print correctly:       

 a. Click No.

 b. Click Select Reprint Range.
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 c. Specify a range of checks for reprinting.

 d. Click Reprint.

If you are printing advices after the checks, the program will start to print advices as soon as you click 
Yes to confirm the check printing. The program asks you to confirm that advices were printed correctly 
before it returns you to the Refund Batch List and posts the refunds to customer accounts.

When check printing is finished, Accounts Receivable posts the refund batch.

Note: Once the check data has been posted, you cannot reprint the checks or advices.

Document Inquiry
Use the A/R Document Inquiry screen to review information about all types of posted and pending 
transactions for Accounts Receivable customers and one-time customers that have no record in 
Accounts Receivable.

About Inquiring on Customers and Documents from Transaction Screens

The Inquiry  button appears on most Accounts Receivable transaction-entry screens, on the 

Customer Inquiry screen, on the Document Inquiry screen, and on the Customer List preview.

 l When the Inquiry button appears beside a Customer Number field, you can click the button to 
open the Customer Inquiry screen, where you can view a wide variety of information for the 
selected customer.     

For more information, see "A/R Customer Inquiry Screen" (page 408).

 l When the Inquiry button appears for a document number field or in the heading for a column that 
lists transaction numbers, you can click the button to open the Document Inquiry screen.     

The Document Inquiry screen displays detailed information for the document, including all the 
transactions that have been applied to the document.

For more information, see "A/R Document Inquiry Screen" (page 581).

You can also use the A/R Receipt Inquiry screen to look up receipts and you can use the A/R Refund 
Inquiry screen to look up refunds using various criteria. For more information, see:

 l "Looking Up Receipts" (page 241)

 l "Looking Up Refunds" (page 242)
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Filtering Document Inquiry Results for the Current Customer

On the A/R Document Inquiry screen, you can apply a customer filter so that only documents for the 
current customer are visible when you use the navigation buttons and the Document No. Finder.

To show only documents for the current customer:

 1. Open the A/R Document Inquiry screen. More...

Do one of the following:

 l Open Accounts Receivable > A/R Transactions > Document Inquiry.

 l On the A/R Customer Inquiry screen, click theInquiry  button beside the Document 
Number field.

 l On any Accounts Receivable transaction-entry screen, display a posted transaction, and 

then click the Inquiry  button beside the Document Number field.

 2. Display a document for the customer.

The program applies the customer filter to the customer number used in the current document.

Note: If you open the A/R Document Inquiry screen from another Accounts Receivable screen, the 
program automatically applies the filter for the current customer.

 3. On the Settings menu, click Set Customer Filter.

Note: 
The Set Customer Filter option is not available if:

 l The Document Number field is blank. You must select a document for the customer.

 l The customer filter is already applied to the current customer.

Tip: To remove the customer filter so that you can see documents for all customers, click Clear 
Customer Filter on the Settings menu.

Drilling Down from Document Inquiry to a Transaction Entry

On the A/R Document Inquiry screen, if you are viewing a document that is job-related or has associated 
retainage, you can see all the transactions that have been applied to individual document details that you 
select on the Details tab.

These steps explain how to drill down from an applied transaction detail to view the entire applied 
transaction—and all the information entered with it—in the original transaction entry screen.
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To drill down from applied transaction details to the original transaction-entry screen:

 1. Open the A/R Document Inquiry screen. More...

Do one of the following:

 l Open Accounts Receivable > A/R Transactions > Document Inquiry.

 l On the A/R Customer Inquiry screen, click theInquiry  button beside the Document 
Number field.

 l On any Accounts Receivable transaction-entry screen, display a posted transaction, and 

then click the Inquiry  button beside the Document Number field.

 2. On the Details tab, select a document detail.

Transactions applied to the detail are displayed in the Applied Transactions table.

Note: This table appears only for documents that are job-related or to which retainage applies.

 3. In the Applied Transactions table, double-click the applied transaction you want to view in the 
original entry screen.

Looking Up Receipts

On the A/R Receipt Inquiry screen, you can look up receipts based on a number of criteria, even if you do 
not know the customer number associated with the receipt you are trying to find.

Note: 
If you want to look up receipt information for a particular customer, use the A/R Document Inquiry 
screen or the A/R Customer Inquiry screen. For more information, see:

 l "A/R Document Inquiry Screen" (page 581).

 l "A/R Customer Inquiry Screen" (page 408).

Before You Start

 l Decide on the criteria you want to use to look for receipts.

To look up receipts:

 1. Open Accounts Receivable > A/R Transactions > Receipt Inquiry.

The A/R Receipt Inquiry screen appears.
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Note: By default, this screen displays all receipts.

 2. Specify criteria to limit the receipts that are displayed. More...

You can select the following criteria:

 l A range of bank codes to list receipts that were processed using one of the bank codes that 
fall within the given range.

 l A range of customer numbers to view receipts only for the customers in the specified range.

Note: To include miscellaneous receipts you must use blanks in the customer number range.

 l A receipt status (to include only receipts that are outstanding, cleared, or returned), or you 
can display all receipts that meet the other specified criteria.

 l A transaction type (to include only Unapplied Cash, Prepayment, or Receipt transaction 
types), or you can display all receipts that meet the other specified criteria.

 l A range of receipt dates to include only receipts that were entered within the specified date 
range.

 l A range of years and periods to include only receipts that were posted within the specified 
year and period range.

 l A range of receipt numbers to limit the list to the specified range of receipt numbers.

 3. Click the Go  button.

The list of receipts is refreshed to show only those that meet the specified criteria.

 4. To view information that shows how a particular receipt was applied, select the receipt, and then 
click Open.

 5. To view a receipt in the A/R Receipt Entry screen, select the receipt, and then click Document.

 6. To print the Receipt Inquiry report, click Print.

Looking Up Refunds

On the A/R Refund Inquiry screen, you can look up refunds based on a number of criteria, even if you do 
not know the customer number or the check number for the refund you are trying to find.

Note: 
To look up refund activity for a particular customer, use the A/R Document Inquiry screen or the 
A/R Customer Inquiry screen. For more information, see:

 l "A/R Document Inquiry Screen" (page 581).

 l "A/R Customer Inquiry Screen" (page 408).
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Before You Start

 l Decide on the criteria you want to use to look up refunds.

To look up refunds:

 1. Open Accounts Receivable > A/R Transactions > Refund Inquiry.

The A/R Refund Inquiry screen appears.

Note: By default, this screen displays all refunds.

 2. Specify criteria to limit the refunds that are displayed. More...

You can select the following criteria:

 l A range of bank codes to list refunds that were processed using one of the bank codes that 
fall within the given range.

 l A range of customer numbers to view refunds only for the customers in the specified range.

 l A status to include only refunds that are outstanding, cleared, or reversed, or you can display 
all refunds that meet the other specified criteria.

 l A payment type to include only Cash, Check, or Credit Card transaction types, or you can 
display all refunds that meet the other specified criteria.

 l A range of refund dates to include only refunds that were entered within the specified date 
range.

 l A range of years and periods to include only refunds that were posted within the specified 
year and period range.

 l A range of document numbers or check numbers to limit the list to the specified range of 
documents or checks.

 3. Click the Go  button.

The list of refunds is refreshed to show only those that meet the specified criteria.

 4. To view a refund in the A/R Refund Entry screen, select the refund on the list, and then click 
Document.
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Chapter 4: Periodic Processing in 
Accounts Receivable

Use Accounts Receivable Periodic Processing screens to perform tasks that are part of your regular 
period-end procedures, such as clearing history, creating general ledger batches, and deleting inactive 
records.

Periodic Processing Procedures
There are several Accounts Receivable screens you can use to complete the types of processing you do 
at specified intervals, such as at month end or period end, and to clear out obsolete data and records.

Here is an overview of periodic procedures you might follow:

 1. Update Accounts Receivable records, such as to enter changes of address, make corrections, and 
select the Inactive option for records you plan to delete.     

Use the screens in the A/R Customers and A/R Setup folders to revise these records.

 2. If you use the option to process recurring charges, create and post the recurring charge batches 
you need. You can also automatically update your recurring charge records, if necessary.     

Use the A/R Create Recurring Charge Batch screen in the A/R Periodic Processing folder to create 
each batch.

Use the A/R Update Recurring Charges screen in the A/R Periodic Processing folder to update 
transactions for a range of customers by a fixed amount or by a percentage.

 3. Create retainage invoices, debit notes, and credit notes to clear outstanding retainage amounts 
from the retainage control account.     

Use the A/R Create Retainage Batch screen in the A/R Periodic Processing folder to create batches 
automatically. You can also add retainage invoices, debit notes, and credit notes manually through the 
A/R Invoice Entry screen. (Select the Retainage option, then select Retainage Invoice, Retainage 
Debit Note, or Retainage Credit Note as the document type.)

 4. Post transactions that apply to the period. Print and file the posting journals.     

Use the A/R Invoice Entry screen, A/R Receipt Entry screen, and A/R Adjustment Entry screen.
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 5. Print reports to identify amounts that should be written off, and accounts that should be charged 
interest or that require other action.     

Use the A/R Customer Transactions report and A/R Aged Trial Balance report in the A/R Transaction 
Reports folder to print the reports.

 6. Create and post batches of adjustments, such as transactions to write off uncollectible accounts or 
to correct errors found when you reconcile bank statements.     

Use the A/R Adjustment Entry screen from the A/R Transactions folder and the A/R Create Write-Off 
Batch screen in the A/R Periodic Processing folder.

 7. Create and post interest batches.     

Use the A/R Create Interest Batch screen in the A/R Periodic Processing folder to create interest 
batches or use the A/R Invoice Entry screen to add interest charges one at a time.

 8. Print statements.     

Use the A/R Statements/Letters/Labels report in the A/R Customer Reports folder to print statements.

 9. If you have a multicurrency ledger, you may need to update exchange rates in Common Services 
and revalue multicurrency transactions and balances periodically, to reflect changes in exchange 
rates.     

Use the A/R Revaluation screen from the A/R Periodic Processing folder.

 10. If you do not use the option to create general ledger transactions during posting, create any 
outstanding general ledger transactions. (Use the A/R Create G/L Batch screen in the A/R Periodic 
Processing folder.)     

Print the G/L Transactions List, and then process the batches in Sage 300 General Ledger, if you use it, 
or post them manually to your other general ledger. Use the A/R G/L Transactions report in the 
A/R Transaction Reports folder to print reports of the transactions.

 11. Clear the paid transactions, customer comments, and statistics that you no longer need, and 
delete records that you classed as inactive and prepared for deletion.     

Use the A/R Clear History, A/R Delete Inactive Records, and A/R Clear Statistics screens in the 
Periodic Processing folder to clear this information.

Creating Batches of General Ledger Transactions in 
Accounts Receivable

Important! You use this screen to create general ledger batches only if Accounts Receivable does not 
create them during posting, as specified on the A/R G/L Integration screen.
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You use the A/R Create G/L Batch screen to create batches of general ledger transactions from the 
invoice, receipt, refund, and adjustment batches you post in Accounts Receivable.

If you use multicurrency accounting, you also use this screen to produce general ledger batches for 
transactions created using the Revaluation screen.

You must create all outstanding general ledger batches before you can clear posting journals or use the 
Year End screen.

Before You Start

 l Post all outstanding batches.

 l Print the G/L Transactions   report.

Note: You cannot print this report after you create the general ledger   batches.

To create G/L batches:

 1. Open Accounts Receivable > Periodic Processing > Create G/L Batch.

 2. Select the types of posted batches from which to create transactions.

You can create a general ledger batch that includes transactions from invoice batches, receipt batches, 
adjustment batches, refund batches, and revaluation batches.

 3. Select the posting sequence number through which to create transactions for each batch type.

 4. Click Process.

If you use Sage 300 General Ledger, Accounts Receivable either adds the new transactions to existing 
General Ledger batches or creates new batches, depending on your choice for the Create G/L Batches 
By option on the A/R G/L Integration screen.

If you do not use Sage 300 General Ledger, you see a message asking whether to append transactions 
to an existing batch file or to overwrite the file.

After creating a G/L batch

 l Post the batches inSage 300 General Ledger, if you use it, or in your other general ledger.

 l If you do not use Sage 300 General Ledger, delete the general ledger batch file from Accounts   
Receivable after you have transferred the transactions to your general   ledger.
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About Checking Data Integrity
You should check data integrity and back up your data whenever you add records that would be time-
consuming to enter a second time or perform other tasks that change your Accounts Receivable data.

Important! 
You should always check data integrity:

 l Before posting batches

 l After importing data

You check data integrity using the Data Integrity icon in Administrative Services.

A/R Integrity Checker

To Open this Screen

 1. Open Administrative Services > Data Integrity.

 2. Include Accounts Receivable in the Check Applications list.

 3. Click Application Options.

Overview

The A/R Integrity Checker lets you specify:

 l The type of data to check.

 l A range of customer records for which to check data.

 l Whether to fix minor errors during the check.

 l Whether to check for or delete orphan records.

For more information, see the System Manager help.

About Invoicing Interest
This topic describes the process of charging interest, after you   set up interest profiles.

Accounts Receivable allows you great flexibility in charging interest.   In a single interest batch you can 
charge interest to all your customers   using the method, overdue period, and rate specified for each 
customer.  
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You can charge your open-item customers interest on individual overdue invoices and debit notes or on 
overdue account balances. (Balance-forward customers are automatically charged interest on the 
account balance.)

You can round up interest charges to a minimum amount and you can compound   the charges (that is, 
charge interest on previous interest charges).

For more detailed information on how Accounts Receivable calculates   interest, see "About Calculating 
Interest Charges" (page 33).

You set all interest options when you define interest profiles. For more information, see   "A/R Interest 
Profiles Screen" (page 510).

Multicurrency Ledgers

If you use multicurrency accounting, you can specify a minimum interest   charge and annual interest rate 
for every currency used in your Accounts   Receivable system.

Creating Interest Batches

When you are ready to charge interest, you use the A/R Create Interest Batch screen to create batches of 
interest invoices.

You can select accounts to   charge by customer number, customer group, national account, and billing   
cycle, and you can have as many open interest batches as you need at any   time. 

For more information, see "A/R Create Interest Batch Screen" (page 469) and "Creating Interest Batches 
Automatically" (page 249).

Contents of Interest Invoices

Each interest batch contains one interest invoice for each selected   customer with an overdue balance or 
transaction.

An interest invoice includes one summary detail that shows the amount   charged and the number of the 
general ledger revenue account to which   you post interest income. You can edit the detail to enter a 
comment you   want to print with the detail on statements for the customer, or make   other changes you 
need.

The invoice description displays the total overdue balance on which   the interest charge was calculated, 
and the batch description lists the   type and range of records you specified for selecting customers to 
charge.   You can change both descriptions. You can also change the amount of the   interest charge.

If you use Sage 300 Transaction Analysis   and Optional Field Creator (a program that you purchase and 
activate separately),   you can generate interest batches that include optional fields defined   for invoices 
and invoice details.
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The program includes the following optional   fields on the interest invoices you generate using the 
A/R Create Interest   Batch screen:

 l All optional fields that   are marked for automatic insertion.

 l Any additional optional   fields you specified for the interest batch. 

Charging Interest on Payment Schedules

If you charge interest to a customer who was issued a multiple-payment   invoice (using a payment 
schedule), interest is calculated only on overdue   payments. However, only one interest charge is 
calculated for the customer   account, regardless of the number of overdue payments.

Assigning Interest Batch and Document Numbers

Each new interest batch uses the number of the next available invoice   batch. It also assigns document 
numbers to the invoices using the prefix   and beginning with the next number specified for interest 
invoices on   the A/R Options screen.

Posting Interest Batches

Although you can have as many open interest batches as you want at a   time, you may want to post each 
interest batch as you create it. This   is particularly important if you create other interest batches using 
ranges   of records that could include the same customers more than once.

When you post the interest batch, Accounts Receivable creates a posting   journal of the transactions and 
updates the customer accounts.

About Creating General Ledger Transactions for Interest Batches

When you post interest batches, Accounts Receivable creates transactions for the revenue accounts 
specified in the interest profiles for the customers who were charged interest. Posting also creates 
balancing transactions for the corresponding general ledger receivables control accounts.

Print the posting journal for the interest batches or the G/L Transactions report to view this information.

Creating Interest Batches Automatically
You use the A/R Create Interest Batch to create batches of interest charges for groups of customers. More...

You can select accounts to charge by customer number, customer group, national account, or billing 
cycle, and you can have as many open interest batches as you need at any time.
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You create interest invoices one batch at a time, but you can have   as many open batches of interest 
invoices as you need. 

Note: You can add interest invoices for one customer at a time using the A/R   Invoice Entry screen.

Before You Start

 l Create   at least one interest profile.

To create a batch of interest invoices:

 1. Open Accounts Receivable > Periodic Processing > Create Interest Batch.

 2. Type the run date.

 3. Select the year and period.

 4. Select the type of record   for which to create charges. 

 5. Specify the ranges for   the selected record type.

 6. If you use optional fields   in your system, specify the optional fields and values   you want to use.

 7. Click Process.

After creating a batch of interest invoices 

 l Edit interest batches   using the A/R Invoice   Entry   screen.

 l Post interest batches   using the A/R Invoice Batch List or the A/R Post Batches screen.

About Optional Fields for Interest Batches

Interest batches that you generate using the A/R Create Interest Batch screen can use optional fields 
defined for invoices and invoice details, if you use optional fields in your system.

You use two tabs on the Create Interest Batch screen to specify optional fields and values for invoices in 
a generated interest batch:

 l Optional Fields tab. This tab shows the invoice optional fields assigned to the interest batch.

 l Invoice Details tab. This tab shows the invoice details optional fields assigned to the interest 
batch.

Any optional fields that are set up for automatic insertion appear on these tabs, along with their default 
values, when you start a new interest batch.

Generally, you change the optional fields only if you want to do one of the following:
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 l Use a value that is different from the default values for the automatically inserted optional fields.

 l Include optional fields that are not inserted automatically.

If you delete an automatically inserted optional field, it is reinserted when you create the invoices, taking 
the values from the customer record or from the setup record.

Accounts Receivable assigns the following optional fields to interest invoices you create:

 l All optional fields that are marked for automatic insertion.

 l Any additional optional fields you specified for the interest batch.

Values Assigned to Optional Fields

Accounts Receivable assigns values to the optional fields on interest invoices, as follows:

 l If an optional field is specified for the interest batch, the value specified on the tab is used—even if it 
is blank.

 l If you deleted an automatically inserted invoice optional field from the Optional Fields tab, the program 
reassigns the field and a value as follows:

 l If the invoice optional field is assigned to the customer, the value from the customer record 
is used.

 l If the invoice optional field is assigned to the customer's ship-to location, the value from the 
ship-to location record is used. (If the optional field is assigned to both the customer and the 
ship-to location, the value from the ship-to location is used.) 

 l If the invoice optional field is not assigned to either the customer or the ship-to location, the 
value specified in the optional field setup record is used.

 l If you deleted an automatically inserted invoice details optional field from the Detail Optional Fields 
tab, the program reassigns the field using the value specified in the optional field setup record.

About Recurring Charge Batches
You can use the Create Recurring Charge Batch screen periodically to create a batch of recurring charge 
invoices for the customers and charges you select. Creating recurring charge batches saves you from 
having to enter an invoice for each recurring charge and customer manually.

You create one batch of recurring charge invoices at a time, but you can have as many open batches of 
recurring charge invoices as you need.

Note: Accounts Receivable does   not process recurring charges for customers whose records are 
inactive   or on hold.

251Sage 300 2023 Accounts Receivable User's Guide



Processing Recurring Charges

When you generate invoices, Accounts Receivable creates a new batch or adds the new transactions to 
an existing batch, depending on your choice for the Method option on the  A/R Create Recurring Charge 
Batch screen. If you choose to create a new batch, Accounts Receivable assigns the next available 
invoice batch number to the recurring charge batch, assigning the default invoice type specified on the 
A/R Options screen. 

Accounts Receivable also updates the Unposted Total Invoiced and Unposted Number Of Invoices 
fields in the recurring-charge record when you generate invoices for recurring charges. If you 
subsequently adjust the unposted invoices, Accounts Receivable updates these fields accordingly.

You edit recurring charge batches using the A/R Invoice Entry screen.

Item Prices Used in Recurring Charge Invoices

When generating item invoices, Create Recurring Charge Batch uses the item price specified in the 
recurring charge record (not from the item record).

Maximum Amounts

When the difference between the Amount Invoiced To Date and the Maximum Amount is more than the 
recurring charge, Accounts Receivable creates the invoice for the usual amount.

No invoices are created for recurring charges that have already reached the permitted amount in the 
Maximum Amount field in the recurring-charge record.

If no invoice is created, the program does not update the Last Invoiced date field.

Optional Fields Used with Recurring Charge Invoices

Optional fields defined for invoices and invoice details are used on recurring charge invoices. However, 
only the optional fields and values specified in the recurring charge records are used in the invoices.

Reminders to Create Recurring Charge Batches

If you assign to recurring charge records schedules that have a reminder to users, Accounts Receivable 
can remind users to process recurring transactions when they are due. Then, users can process the 
recurring transactions directly from the Reminder List in Common Services, rather than from the Create 
Recurring Charge Batch screen.

For more information about the Reminder List, see the System Manager help.
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Posting Recurring Charge Invoice Batches

Accounts Receivable updates statistical amounts for the last invoice posted in the recurring-charge 
record, and it adds the invoice amount to the Year To Date Total Invoiced and Year To Date Number Of 
Invoices field.

Updating Recurring Charges Automatically
You can use the A/R Update Recurring Charges form to increase or decrease summary recurring charge 
details automatically by a percentage or an amount for a range of customers.

Note: You can automatically update only recurring charge records that use summary invoices and for 
which you have selected the Calculate Taxes option.

Before You Start

 l Determine the range of customers whose recurring charge records you will update.

 l Select the Calculate Taxes option   in the recurring charge records that you want to update   
automatically.

 l Decide whether to increase or decrease charges by an amount or by a percentage.

To update recurring charges automatically:

 1. Open Accounts Receivable > Periodic Processing > Update Recurring Charges.

 2. Fill in the following   fields on the Update Recurring Charges screen:

 l Recurring Charge Code. Using the Finder, select the code for the recurring   charge you 
want to change. You can specify the same code more than once   on the Update Recurring 
Charges screen.

 l From/To   Cust. No. Using the Finder, select the range of customers for   whom you want to update 
the recurring charge.

You can update recurring charge records for all customers   sharing that code, or for a range of 
customers. Accounts Receivable lets   you choose from a list of customers who share the recurring 
charge code   you selected.

 l Change   By. Select either Percentage or Amount. This field, together   with the selection you 
make in the Increase/Decrease field, determines   how Accounts Receivable will update the 
details of the recurring charge.
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 l Increase/Decrease. Select Increase or Decrease. This field, together with   the selection you 
make in the Change By field, determines how Accounts   Receivable will update the details of 
the recurring charge.

 l Currency Code (if you have a multicurrency ledger). Note the following:

 l If you are changing   the details of the recurring charge by an amount, you must 
specify a currency.   Accounts Receivable updates recurring charge records only for 
customers   in the specified range who use the specified currency. 

 l If you are changing   the details of the recurring charge by a percentage, the 
currency field   is optional:

 l If you do not specify   a currency, Accounts Receivable updates recurring charges for 
all customers.

 l If you do specify   a currency, Accounts Receivable updates recurring charge records 
only   for customers using the specified currency.

 l Change In Distribution Amount.The value you enter in this field depends on your selection in the 
Change By field, as follows:

 l If you selected Percentage in the Change By field,   enter a percentage. For example, 
to increase a recurring charge of $1,000 by $125, you enter 12.5 in this column. You 
can use up to 5 decimal   places.

 l If you selected Amount in the Change By field,   enter an amount. In single currency 
ledgers, Accounts Receivable displays   decimals appropriate for the functional 
currency. In multicurrency ledgers,   Accounts Receivable displays decimals 
appropriate for the specified currency.  

 l Method. Specify the details to update in the range of records.

 l If you selected Percentage in the Change By field, select one of the following options:

 l All Details. Accounts Receivable will increase or decrease all of the recurring 
charge details by the percentage specified in the Change In Distribution Amount 
field.

 l Specific Distribution Code. Accounts Receivable will increase or decrease 
amounts for only details that use the specified distribution code by the 
percentage specified in the Change In Distribution Amount field.

 l If you selected Amount in the Change By field, select one of the following options:

 l Spread Evenly. Accounts Receivable will distribute the amount you specified in the 
Change In Distribution Amount field evenly for all the details of the recurring charge.

 l Prorate. Accounts Receivable will distribute the amount you specified in the Change 
In Distribution Amount field based on the current amount of each of the details.
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 l Specific Distribution Code. Accounts Receivable will increase or decrease amounts 
only for details that use the specified distribution code by the amount specified in the 
Change In Distribution Amount field.

 3. If you chose Specific   Distribution Code as the method, enter a distribution code or select it   using 
the Finder.

 4. If you want to change   the maximum amount specified in the recurring charge record, enter the   
amount by which to increase or decrease the maximum amount.

 5. Click Process to update   the specified recurring charges.

After updating recurring charges automatically

 l Print the Recurring Charges report. For instructions, see "Printing the A/R Recurring Charges 
Report" (page 307)

Invoicing Recurring Charges
You can use the Create Recurring Charge Batch screen periodically to create a batch of recurring charge 
invoices for the customers and charges you select. Creating recurring charge batches saves you from 
having to enter an invoice for each recurring charge and customer manually.

You create one batch of recurring charge invoices at a time, but you can have as many open batches of 
recurring charge invoices as you need.

Note: Accounts Receivable does   not process recurring charges for customers whose records are 
inactive   or on hold.

Tip: If you want to process recurring charges from the Reminder list, assign to recurring charge setup 
records  schedules that include a reminder. When the recurring charges are due, Sage 300 reminds 
you to process them. You can then process all recurring transactions assigned to a schedule right from 
the Reminder List.

Before You Start

 l Set up a recurring charge record for each customer you need to invoice on a recurring basis. 

For more information, see "Setting Up a Recurring Charge for a Customer" (page 96).

 l As necessary, update recurring-charge records.

You can update charges for individual customers using the Recurring Charge Setup screen (in the 
Customers folder). 
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If you want to update charges automatically for a range of customers, use the Update Recurring 
Charges screen (in the Periodic Processing folder). For more information, see "Updating Recurring 

Charges Automatically" (page 253).

To invoice recurring charges:

 1. Open Accounts Receivable > Periodic Processing > Create Recurring Charge Batch.

 2. Type the run date, which Accounts Receivable uses as the document date for the generated 
invoices.

 3. Specify the type of record by which to select recurring charges for invoicing. 

You can select by Recurring Charge Code, Customer Number, Customer Group, or National 
Account.

 4. Use the From and To fields to specify the range for the selected record type.

 5. Click Process.

After generating a batch of invoices

 l Print the invoice batch listing, selecting Recurring as the batch type.

 l Use the batch listing to verify the charges. 

 l Use the Invoice Entry screen to make any changes or corrections to the recurring charge invoices 
before posting them.

 l Reprint the listing if you edited the batch.

 l File the batch listing report.

 l Post the batch.

About Revaluing Multicurrency Transactions
Some accounting standard-setting bodies require that you take gains or losses due to fluctuating 
exchange rates into income  in the period in which they occur.

If you use multicurrency accounting in your Accounts Receivable ledger, you may need to revalue 
transactions at new exchange rates periodically to determine the value of receivables on specific dates, 
such as at financial statement dates.

The revaluation process recalculates the functional-equivalent values of all outstanding multicurrency 
Accounts Receivable documents, including details, at new exchange rates.
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In Sage 300, exchange gains and losses are treated as either permanent or temporary, depending on the 
exchange Gain/Loss Accounting Method specified for your Sage 300 system on the Company Profile 
screen in Common Services:

 l Recognized Gain or Loss. If you use this accounting method, revaluation transactions are 
considered permanent. 

With this accounting treatment, exchange gains and losses are recognized immediately when you 
revalue transactions, and they are not reversed in the next period.

 l Realized and Unrealized Gain/Loss. If you use this accounting method, revaluation transactions 
are considered temporary, or "unrealized," gains and losses. They are posted to General Ledger 
as reversing transactions, meaning that General Ledger simultaneously posts reversing 
transactions to the first day of the next fiscal period following the revalued period. In this way, 
revaluation has no permanent effect on the general ledger.

With this accounting treatment, realized exchange gains or losses are calculated only when 
transactions are settled—that is, when you post receipt to pay invoices and debit notes, or when you post 
credit notes to pay down invoices.

Accounts Receivable produces reversing entries for the unrealized exchange gain and loss accounts in 
the specified account sets. When you post the revaluation transactions to any fiscal period in Sage 300 
General Ledger or your other general ledger, they are automatically reversed in the next fiscal period.

These differences are explained more fully in the following sections.

Calculating Gains and Losses for the Realized and Unrealized Gain/Loss 
Method

If your Sage 300 system uses the Realized and Unrealized Gain/Loss method to revalue multicurrency 
amounts, Accounts Receivable calculates unrealized exchange gains or losses as follows:

Formula for calculating unrealized exchange gains or losses

 Source amount x Revaluation rate

Less: Functional amount

Equals: Unrealized exchange gain (loss)

When you post the revaluation batch in General Ledger, the program also posts a reversing entry to the 
first day of the next fiscal period.
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Example: 
You revalue a customer's account at a higher exchange rate, which results in a $10 increase in the 
account balance in functional currency.

Accounts Receivable creates a journal entry debiting the Receivables Control account and crediting 
the Unrealized Exchange Gain account for $10.

At the beginning the next fiscal period, you post a reversing entry in your general ledger, debiting the 
Unrealized Exchange Gain account and crediting the Receivables Control account for $10.

When you print the Customer Transactions report for the customer, both transactions appear for the 
period in which you posted the reversing revaluation transactions. Their net effect on the account balance 
is zero. The revaluation transaction is shown as type "GL."

Calculating Exchange Gains and Losses on Settlement

When you use the Realized and Unrealized Exchange Gain/Loss method to record exchange gains 
and losses, any gains or losses arising from differences in exchange rates at the time of settlement are 
called "realized" gains or losses.

When you apply multicurrency payments, credit notes, debit notes, or adjustments to another document, 
if the exchange rate used for the applied document is different from the current rate of the "apply-to" 
document, Accounts Receivable recognizes an exchange gain or loss, as follows:

Formula for calculating the exchange gain or loss to recognize:

 Source amount x Current rate of applied document

Less: Source amount x Current rate of apply-to document

Equals: Exchange gain (loss) or realized exchange gain (loss)

When you post the revaluation batch in General Ledger, no reversing entries are created for the next 
fiscal period.

Calculating Gains and Losses for the Recognized Exchange Gain/Loss 
Method

If you use the Recognized Exchange Gain/Loss method, when you post multicurrency receipts or credit 
notes in Accounts Receivable, you use the exchange rate in effect at the time.

Any difference between the original exchange rate for the invoice and the rate entered with the receipt or 
credit note is a realized gain or loss.

Accounts Receivable creates transactions for the realized exchange gain or loss accounts in your 
general ledger.
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Realized exchange gains or losses are also calculated when you post an adjustment that reduces the 
balance on an invoice or debit note to zero.

Revaluing Periods that Contain Backdated Documents

Sage 300 lets you post a multicurrency document that predates the last revaluation for the document 
currency, and it lets you apply the backdated document. An exchange gain or loss can arise.

The accounting method you use to record exchange gains and losses in your Sage 300 system 
determines how the revaluation process handles backdated documents:

 l Realized and Unrealized Gain/Loss Accounting Method. If you use this method, you can revalue 
the backdated document by running the Revaluation program again for the period to which you 
posted the document (process a backdated revaluation). For this accounting method, if you rerun 
revaluation for a period that contains a backdated document, you must also rerun all subsequent 
revaluations.

 l Recognized Gain/Loss Accounting Method. If you use this method, you can let the program 
automatically correct any exchange gains or losses for backdated documents and the documents 
to which they are applied.     

To automatically correct these exchange gains or losses, enter or accept a date in the Earliest 
Backdated Activity Date field on the Revaluation screen.

You can also choose to ignore the backdated document, for example, if it is not material or if you posted 
it to a period that does not coincide with the end of a reporting period. If you do not want the program to 
revalue backdated documents and activity when you perform a backdated revaluation, leave the 
Earliest Backdated Activity Date field blank on the Revaluation screen.

Accounts Receivable adjusts exchange gains and losses for backdated documents and documents 
affected by backdated activity as of the balance sheet dates:

 l If the current revaluation date is on or after the last revaluation date and there is a 
backdated document (or a document affected by backdated activity), the program revalues 
the document and creates adjustments as of the current revaluation date. The Earliest 
Backdated Activity Date field does not appear.

 l If the current revaluation date predates the last revaluation date and you are revaluing a 
backdated document or a document affected by backdated activity, Revaluation:       

 l Creates entries to recognize exchange gains or losses for backdated documents as 
of each revaluation date from the earliest backdated activity date to the last 
revaluation date.

 l Ignores any backdated documents with posting dates before the Earliest Backdated 
Activity Date.

 l If the revaluation occurs between the document date and settlement date, and the 
revaluation rate is different from the current rate for the settlement document, Revaluation 
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creates adjustments to:       

 l Update the document’s functional balance (including discount and retainage 
balances) for the revalued period.

 l Correct any exchange gains and losses recognized at the time of settlement for the 
period from the revaluation date to the settlement date.

Revaluing Documents with a Multiple Payment Schedule

If you use the Recognized Gain/Loss accounting method, when you revalue a document that uses a 
multiple payment schedule, Revaluation revalues each portion of the invoice that is due and applies the 
sum of the net gains (or losses) to the document.

Revaluing Outstanding Retainage

If you use multicurrency, when you run Revaluation, the program also revalues amounts outstanding in 
the retainage control account.

For revalued outstanding retainage, the program creates general ledger entries to adjust the retainage 
control account rather than the receivables control account.

If your Sage 300 system uses the Realized and Unrealized Gain/Loss accounting method to revalue 
multicurrency documents, the program also creates reversing entries for the next period.

The Revaluation Posting Journal includes a separate section for retainage, following the current 
revaluation of documents for each customer. If you include job-related details on the posting journal, a 
retainage section appears on the Summary page after the current job details.

Creating Provisional Revaluation Transactions

If you want to preview the effects of a revaluation before you process the revaluation, you can select the 
Provisional Revaluation option on the Create Revaluation Batch screen. This option produces a posting 
journal of the transactions that would be created if you processed a real revaluation using the same 
criteria as you used in the provisional run.

A posting sequence number is assigned each time you post a provisional revaluation. The number is 
printed with transactions in the Provisional Revaluation Posting Journal.

After checking the Provisional Revaluation Posting Journal, you can either do another provisional 
revaluation, specifying different criteria, or do a real revaluation, creating entries for your general ledger.

Revaluation Batches

You do not post revaluation batches in Accounts Receivable.
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During revaluation, Accounts Receivable creates a batch for Sage 300 General Ledger, if you use it, or 
(as an export batch) for your other general ledger.

If you do not have Sage 300 General Ledger in your company database, Accounts Receivable creates an 
export batch for your general ledger. If you import a revaluation batch into another general ledger, make 
sure that the revaluation transactions are reversed in the next fiscal period.

Note: Rounding differences may occur during revaluation. These exchange differences are 
automatically posted to the exchange rounding account when payments are posted.

Reporting Revaluation Transactions

You can print a list of revaluation transactions, using the Posting Journals screen and selecting the 
Revaluation option. You can also print the transactions on Accounts Receivable's G/L Transactions 
report, selecting Revaluation as the batch type, and on the batch listing in Sage 300 General Ledger, if 
you use it.

Revaluing Transactions in Other Currencies
If you use multicurrency accounting in your Accounts Receivable ledger, you may need to revalue 
transactions at new exchange rates periodically to determine the value of receivables on specific dates, 
such as at financial statement dates.

The revaluation process recalculates the functional-equivalent values of all outstanding multicurrency 
Accounts Receivable documents, including details, at new exchange rates.

Before You Start

 l Post all outstanding multicurrency transactions and update currency information in Common 
Services.

 l Determine the currencies to revalue and the rates to use.

 l Print the Provisional Revaluation Listing to view the transactions that would be created for the 
exchange gain and loss general ledger accounts. You can then make any necessary changes to 
your selections and to currency rates before you create the general ledger transactions.

To revalue transactions:

 1. Open Accounts Receivable > Periodic Processing > Revaluation.

 2. If this is a provisional revaluation, select the Provisional Revaluation option.

 3. Use the table to enter the currency code, revaluation date, rate type, rate date, and new exchange 
rate for each currency you want to revalue.
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 4. To change the optional fields and values for a particular line or to delete optional fields either double-
click in the Optional Fields column for the currency line, or select   the line, and then click the Optional 
Fields column heading. 

An Optional Fields screen opens, showing any   revaluation optional fields set up for automatic insertion 
and their default   values. 

You can edit the values for existing optional fields, or add or   delete optional fields for the detail. 
However, you can add only optional   fields that you set up for use in Revaluation.

 5. Click Process. 

After creating a revaluation batch

 l Use the Adjustment Entry screen to review or edit the entries you created.

 l Post the revaluation batch.

Writing Off Transactions
If you have a number of amounts to write off in various accounts, you can use the A/R Create Write-Off 
Batch screen to create batches of adjustment transactions that write off transactions or balances in all or 
a range of customer accounts. More...

You may want to use this screen to write off outstanding transactions or balances that are:

 l Too small to warrant the cost of collection, before deleting customer accounts.

 l Not yet due, but which are clearly not collectible (if the customer has become insolvent, for 
example).

You can also use this screen whenever you write off overdue amounts as bad debts (for example, at 
period end).

Tip: You can also enter adjustments to write off all or a portion of the outstanding balances on 
individual documents using the A/R Adjustment Entry screen, or enter adjustments to write off amounts 
from individual documents using the A/R Receipt Entry screen (if you use the Allow Adjustments In 
Receipt Batches option).

Before You Start

 l Decide on the type of transactions or balances to write off. You can write off outstanding 
transactions, overdue transactions, overdue balances, outstanding balances, or outstanding 
retainage.
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 l Decide on the type of customer account whose transactions or balance you will write off. You can 
write off balances for open item, balance forward, or all customers.

 l Decide whether to select amounts to write off by a range of amounts or by a percentage of the 
original document or account balance. For example, you might decide to write off all documents 
with an outstanding balance of between 0 and 5 dollars, or with overdue balances of up to 5 
percent of their original amounts.

To write off overdue or outstanding transactions:

 1. Open Accounts Receivable > Periodic Processing > Create Write-Off Batch.

 2. In the Run Date field, specify the date to use as the document date for all the adjustments in the 
write-off batch.

 3. In the Posting Date field, specify the date to which to post the batch. The posting date also 
determines the year and period to which the adjustments are posted in General Ledger.

 4. In the Write-Off Type field, specify whether to write off outstanding transactions, overdue 
transactions, overdue balances, outstanding balances, or outstanding retainage.

 5. Specify the As Of Date from which to age documents or balances to be written off, and (depending 
on the write-off type) specify the Days Outstanding or the Days Overdue.

 6. If you use multicurrency accounting, type the currency code.

 7. In the Account Type field, select a customer type or select All Customers.

 8. If you are writing off outstanding or overdue transactions, select the types of transactions to write 
off from the Include group of fields.

 9. For the Select By option, indicate whether to write off by amounts or percentages, and then enter 
the range of amounts or percentages.

 10. In the bottom Select By group of fields, specify the ranges of records from which to select 
transactions to write off.

 11. If you use adjustment optional fields, specify optional fields and values on the Optional Fields tab.

 12. Click Process.

After creating a write-off batch

 l Use the A/R Adjustment Entry screen to make any changes you need to the transactions created 
by the Create Write-Off Batch screen. For more information, see "A/R Adjustment Entry Screen" 
(page 569).

 l Print the batch listing.

 l Post the adjustment batch using the A/R Adjustment Batch List screen or the A/R Post Batches 
screen. For more information, see "A/R Adjustment Batch List Screen" (page 565) or "A/R Post 
Batches Screen" (page 631).

263Sage 300 2023 Accounts Receivable User's Guide



About Optional Fields for Write-Off Adjustments

If you use optional fields and you set up any optional fields for automatic   insertion on adjustments, they 
appear on the Optional Fields tab, along   with their default values. 

You can add or delete optional fields for the write-off batch. However,   you can add only optional fields 
that are defined for adjustments.   

When you process the write-off batch, Accounts Receivable assigns to the transactions   all the 
adjustment optional fields that are marked for automatic insertion   and any additional optional fields you 
specify on the Optional Fields   tab.

The generated adjustments use the optional field values specified for   the batch. If you deleted an optional 
field that was automatically inserted,   the program assigns the optional field to the transaction, and uses 
the   default value from the customer record, where the optional field is used   in the customer record, or 
from the optional field setup record.

Clearing Accounts Receivable History
You use the A/R Clear History screen to remove obsolete data from your Accounts Receivable system. More...

You can clear ranges of the following information:

 l Fully paid documents

 l Customer comments

 l Printed posting journals

 l Posting errors

 l Statement data

 l Deleted and posted batches

Important! After you clear posted batches, you can no longer drill down from the General Ledger to the 
Accounts Receivable transactions that they contained. Also, you can no longer reprint invoices or 
receipts.

Before You Start

 l Post all outstanding batches   that could affect records you want to clear.

 l Determine the dates through   which to clear transactions and comments and the highest posting 
sequence   number to clear. 
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 l Print reports of the data you want to clear. More...

 l Before clearing fully paid documents, print the Customer Transactions report for the documents 
you plan to clear, using the following settings:

 l As the first Select Customers By option, select Customer Number, and then specify 
the range of customer records you plan to clear.

 l Select the sorting options you want to use.

 l Select all the transaction types.

 l Select Include Applied Details and Print Customers with a Zero Balance.

 l Before clearing customer comments:

 l Print the Customers report, selecting the Comments option. 

 l Check your customer records to ensure that the expiration dates for comments you 
want to retain are later than the date through which you will clear comments.

 l Before clearing posting journals:

 l Print a copy of each posting journal you want to clear.

 l Create any outstanding general ledger transactions.

 l Before clearing posted batches:

 l Print the batch status report for the batches.

 l Review the batch dates, and then decide on the batch numbers to clear (for example, 
batches more than nine months old).

Note: When you delete batches, you lose the ability to drill down to the transactions from 
General Ledger.

 l Before clearing statement data, print or e-mail your customers the statements you want to 
clear.

To clear obsolete data:

 1. Open Accounts Receivable > Periodic Processing > Clear History.

 2. Select the types of records you want to clear.

 3. Specify the ranges for each type of record.

 4. Type the dates or fiscal year and period for which to clear data.

 5. Click Process.
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Clearing Statistics
You use the A/R Clear Statistics screen to remove obsolete statistical information from your Accounts 
Receivable system. More...

You can clear ranges of the following information:

 l Customer period statistics

 l Customer group period statistics

 l National account period statistics

 l Salesperson statistics

 l Item statistics

Note: The A/R Clear Statistics screen clears period statistics, not activity statistics. Accounts 
Receivable keeps activity statistics only for the current year to date and the previous year, and clears 
them automatically when you use the A/R Year End screen.

To clear statistics:

 1. Open Accounts Receivable > Periodic Processing > Clear Statistics.

 2. Select the types of statistics to clear.

 3. Specify the ranges of records for which to clear statistics.

 4. Type the dates or fiscal year and period through which to clear statistics for the records you 
specified.

 5. Click Process.

Deleting Inactive Records from Accounts Receivable
You use the A/R Delete Inactive Records screen to remove obsolete records from Accounts Receivable. 
Only records that are inactive within the range of dates you specify are deleted.

Before You Start

 l Assign Inactive status to all records you want to delete.

 l To identify existing inactive customer records, print the Customer List report.

To include only inactive customers on the report, select records by status, and then specify Inactive in 
the From and To fields.
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 l Before you delete a customer record, you must:

 l Clear all the customer’s fully paid documents. More...

You can use the Clear History and Clear Statistics screens to clear comments and statistics for 
the customers. However, the Delete Inactive Records   screen automatically deletes the 
comments and statistics for the customer   records it deletes.

 l Delete ship-to locations and recurring-charge records for the customer.

 l Before you delete a customer group, either delete or reassign any national accounts and customers 
assigned to the group. More...

To discover whether customers are still assigned   to the group, print the Customer Group List, selecting 
the Group Members option.

 l Before you delete a national account, delete all the customers assigned to the account, or assign them 
to other national accounts. More...

To identify the customers assigned to a national account, print the National Account List, selecting the 
Members option.

 l Before you delete inactive salesperson records, make sure that no sales splits are assigned to the 
salespersons in customer records and that no unposted transactions use the salesperson   
numbers you want to delete.

To delete inactive records:

 1. Open Accounts Receivable > Periodic Processing > Delete Inactive Records.

 2. Select the types   of records you want to delete.

 3. Specify the ranges for   each type of record.

 4. Type the range of dates   for which to delete records.

Tip: If you do not want to delete all the records of the types you select for   the same range of dates, 
use the screen more than once, as needed, to delete   each type of record for the relevant dates.

 5. Click Process.

After removing inactive records

 l Print reports for the   types of records you deleted to update your files with current information.
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About Year-End Processing
At the end of each fiscal year, use the A/R Year End screen to transfer current-year activity statistics for 
customer groups, national accounts, and customers to the previous year, in preparation for a new year. 
You may also want to follow the same procedures you use at the end of each period.

The Year End function performs the following tasks:

 l Checks whether billing cycles have been processed, and warns you if they are not completed. 

You can then cancel Year End to complete the processes you require.

 l If you select the Reset All Batches Numbers option, Year End resets the next batch number to 1 
for all batch types, and deletes the posted and deleted batches, so they no longer appear on the 
Batch Status report.

Important! If you reset batch numbers, you can no longer drill down to view transactions.

 l Moves the Average Days To Pay and the Total Days To Pay amounts to last year.

 l If you select the Clear Activity Statistics option, clears activity statistics. 

This step moves year-to-date   activity statistics to the last year's activity statistics, and sets year-to-date 
totals to zero. It also sets the largest invoice this year and the largest balance this year to zero.

 l If you select both the Clear Activity Statistics option and the Clear Invoices Paid And Days to 
Pay Counter option, resets the Total Days To Pay to "0" (zero) on the Statistics tab of the 
Customers, National Accounts, and Customer Groups screens, and resets the Total Days To Pay 
and Total Invoices Paid to "0" (zero)  on the Activity tab of the Customers and National Accounts 
screens.

 l If you select the Clear Total Recurring Charge Amount option, clears the total amount 
accumulated for each recurring charge, so that you can resume processing the charges in the new 
year.

Starting a New Fiscal Year
Starting a new fiscal year requires that you close the current year,   transferring current-year activity 
statistics for customer groups, national   accounts, and customers to the previous year. 

Tips: 
 l You can use the Year End screen at any time of year if you need to reset batch numbers or clear 

recurring-charge amounts. However, you must first complete all the steps listed in the "Before 
You Start" section.

 l We recommend that you clear activity statistics only at year end.
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Before You Start

 l For the year you are closing:

 l Process all billing   cycles (if you use them to perform tasks such as print statements, create   
recurring charges, and charge interest).

 l Post or delete all   outstanding batches.

 l Print any unprinted   invoices or deposit slips for posted batches.

 l Print all unprinted   posting journals to a file or a printer, then (optionally) use the Clear   
History screen to clear the data for older posting journals.

 l Create all outstanding   general ledger batches (if you do not use the option to create the 
batches   during posting), then print the G/L Transactions report.

 l Close all other Sage 300 Accounts Receivable screens, and ask other users to leave Accounts   
Receivable. 

To start a new fiscal year:

 1. Open Accounts Receivable > Periodic Processing > Year End.

 2. Select the tasks you want to perform during year-end processing. You can select:

 l Reset All Batch Numbers. Select this option if you want to start batch numbers at "1" again. This 
option resets the batch numbers for all types of batches.

Important! If you reset batch numbers, you can no longer drill down to view transactions.

You can have up to   999,999,999 of each type of batch in Accounts Receivable. You do not need   
to reset batch numbers, except to meet a requirement in your   company.

 l Clear Activity Statistics. Select this option if you want to enter zeros in the current-year 
fields on the Activity tabs in the Customers and National Accounts screens, and to transfer 
current-year statistical information to the corresponding   fields for the previous year.                        

Note: When you select this   option, the Clear Invoices Paid And Days To Pay Counter option 
appears.

 l Clear Total Recurring Charge Amounts. Select this option to set the Year To Date Total 
Invoice and Number Of Invoices to zero in all recurring-charge   records.

 l Clear Invoices Paid And Days To Pay Counter. You see this option only if you selected the 
Clear Activity Statistics option.       

Select this option   if you want to enter "0" (zero) in the Total Invoices Paid and Total Days   To Pay 
fields on the Activity tab in the Customers and National Accounts   screens. 
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Do not select the option if you want to include previous-year documents in the numbers you use 
to calculate the entry in the Average Days To Pay   field for the account.

 3. Click Process.     

If a message appears, telling you that there are outstanding billing cycles to process and asking 
whether you want to continue:

 l Click Yes if you do not do any processing by billing cycle.

 l Click No to cancel year-end processing, and then complete the tasks you need to process by 
billing cycle.

 4. When finished, click Close.
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Chapter 5: Importing and Exporting 
Accounts Receivable Data

You can import and export a variety of Accounts Receivable records and transactions in a number of 
common formats.

About Importing and Exporting Accounts Receivable 
Records
If you have an accounts receivable system other than Sage 300, you may be able to transfer records from 
it directly into Sage 300 Accounts Receivable by importing them.

You can also export records from a Sage 300 Accounts Receivable database, edit them in a spreadsheet 
or other program to change codes, amounts, and other information, then import them into a new 
Accounts Receivable system you are setting up.

You can import and export the following Accounts Receivable records:

 l Account sets

 l Billing cycles

 l Customer groups

 l Customers

 l Distribution codes

 l Dunning messages

 l Interest profiles

 l Items

 l National accounts

 l Receipt types

 l Recurring charges

 l Salespersons

 l Ship-to locations

 l Terms codes
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For examples, you can:

 l Export customer records to a spreadsheet for statistical analysis.

 l Export all customer records with the same account set to a spreadsheet, change their credit limits, 
then import them back into Accounts Receivable.

Tip: If you routinely make the same change to a large number of records, we recommend creating a 
macro to make the changes.

You can import and export data to different types of file, including:

 l Microsoft Excel

 l Microsoft Access

 l Comma Separated Values

 l Continuous ASCII

 l ODBC

 l XML

For instructions on importing, see "Importing Records into Accounts Receivable" (page 274).

For instructions on exporting, see "Exporting Accounts Receivable Data" (page 274).

For information about importing and exporting Accounts Receivable transactions, see "About Importing 
and Exporting Transactions" (page 272).

About Importing and Exporting Transactions
You can import invoice, receipt, refund, and adjustment batches created in non-Sage 300 programs and 
in remote Sage 300 subledgers.

Accounts Receivable treats imported batches as regular batches and, if the option to allow editing of 
imported batches is selected on the A/R Options screen, you can edit imported batches using the 
transaction-entry screens.

You can also export transaction batches from Accounts Receivable to other programs. For example, you 
could export data to a spreadsheet for analysis. You can also export batches of recurring transactions to 
import later.

Accounts Receivable can create export files in several formats, including Microsoft Excel, Microsoft 
Access, Comma Separated Values, ODBC, and XML formats. You select the format when you export the 
data.
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You can also create files to be imported in any of these programs or formats, provided you structure the 
data in a way that Accounts Receivable can read. During the import process, Accounts Receivable 
checks the data in the external file, and cancels the process if it finds certain types of errors.

Tip: To see exactly how to format records for importing, we suggest that you first export records from 
the sample data that comes with Accounts Receivable, specifying the format in which you plan to 
import.

Sage 300 provides a tool you can use to see which fields you can import to and export from any record in 
Accounts Receivable. For more information, see "Viewing a List of Fields You Can Import and Export" (page 
275).

For more information about file formats, using scripts and criteria, and the steps to import and export 
data, see the System Manager help.

For information on importing and exporting setup records, and customer, customer group, and national 
account records, see "About Importing and Exporting Accounts Receivable Records" (page 271).

Importing Batches

Warning! Incorrect importing can damage your data. Do not import accounting data without 
appropriate manual accounting control and verification procedures.

When importing invoices, receipts, refunds, and adjustments, you must first select the destination batch 
in Accounts Receivable. For example, open the Invoice Entry screen, and then select an existing batch or 
create a new batch.

To import, click File > Import, and then specify the file to import. You can import only one batch at a time, 
and you must specify the format in which the file was created.

If you use multicurrency accounting, you can import a receipt batch only into another receipt batch whose 
bank uses the same currencies as the receipts in the imported batch.

When importing batches of invoices, receipts, refunds, and adjustments, you can insert records, only.

The Insert And Update and Update Only options are not available for transactions.

After importing a batch, always print the batch listing and check it carefully against your original 
documents. We suggest that you also delete the batch in the program where you created it to avoid 
accidentally importing it twice.

Exporting Batches

To export a batch, create or select the batch, and then click File > Export on transaction entry screens.
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You do not have to export an entire batch each time. You can set criteria to export a range of 
transactions, and you can specify the transaction information to export to your other program. For 
example, when you export customer records, you can choose from three different portions of the data—
Customer, Statistics, and Comment.

Note: Statistics appears in the list only if the Allow Edit Of Statistics option is selected on the 
A/R Options screen.

Important! If you export batches that you plan to import back into Accounts Receivable, you should 
change the document numbers in the exported batch before importing it, so that you do not import 
duplicate document numbers that you cannot post in Accounts Receivable.

Importing Records into Accounts Receivable
You can transfer records from another accounts receivable system into Sage 300 Accounts Receivable.

For information on the file formats and file layouts that Sage 300 accepts, see the System Manager help.

To import account information or transactions:

 1. Create the file you want to import.

 2. Open the Accounts Receivable screen in which you maintain the data you want to import. 

For example, to import customer accounts, open the A/R Customers screen.

 3. On the File menu, click Import.

 4. On the screen that appears, enter the file that contains the information you want to import, and 
specify the file type.

 5. If you previously created a template for importing, click Load Template, and then select the 
template file.

 6. Choose the fields that you want to import, and select from any other options that appear.

Tip: If you frequently import information using the same settings, you can create an export template 
by clicking Save Template. The next time you import the data, you can load the template rather than 
manually specifying settings.

 7. Click OK to begin importing.

Exporting Accounts Receivable Data
You can export records from a Sage 300 Accounts Receivable database.
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To export Accounts Receivable data:

 1. Open the screen or screen that displays the kind of data that you want to export.

 2. If necessary, create the records you want to export. For example, to export an invoice batch, 
create the batch in the A/R Invoice Entry screen.

 3. On the File menu, click Export.

 4. On the screen that appears, select the type of information to export, or choose Load Template to 
use an export template you created previously that matches the information you want to export.

 5. To limit the range of records to export, click Set Criteria, and then specify the criteria to use for 
each field.     

For example, if you wanted to export only active customer records to an Excel file, you would set Status 
= Active, so that inactive customers are excluded from the exported file.

 6. In the next screen, enter the export file name and file type.     

Tip: If you frequently export information using the same settings, you can create an export template 
by clicking Save Template. The next time you export the data, you can load the template rather than 
manually specifying settings.

 7. Click OK to begin exporting.

Viewing a List of Fields You Can Import and Export
You can display and print a report that lists the fields you can import or export for Accounts Receivable 
records, including transaction batches. The report also indicates key fields.

To display a list of the fields you can import and export:

 1. Open the record or transaction-entry screen for the type of record or transaction you want to import 
or export.

 2. For transaction fields, display an existing batch using the Batch Number field.

 3. On the File menu, click Import or Export.

 4. If a File Import/Export Selection screen appears (for example, if you clicked Import or Export on the 
Customers screen), select the type of record to import or export, and then click OK.

 5. On the screen that appears, click Display Import Fields or Display Export Fields to display the 
name, type, and length of each field in the record that you can import or export.
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Chapter 6: Printing Accounts Receivable 
Reports

Use Accounts Receivable reports screens to print reports of Accounts Receivable customers, setup 
records, and transactions.

Accounts Receivable provides numerous sorting and selecting options on a full range of reports, journals, 
and lists.

About Accounts Receivable Reports
You can print a wide variety of reports that provide you with up-to-date information and a source of 
backup information in case your Accounts Receivable data is damaged. 

This topic briefly describes the reports you can print in Accounts Receivable. 

Setup Reports

You can print a report showing the information entered to define each of the records you create when 
setting up or updating your Accounts Receivable system. 

If you keep item and salesperson statistics, you can also print statistical reports for items and 
salespersons.

Any time you add, delete, or change setup records or customer records, you should print and file the 
corresponding reports, to keep your printed records up to date.

Use screens in the A/R Setup Reports folder to print these reports.

Customer Reports

You can print lists and statistical reports for customers, customer groups, and national accounts. 

Use screens in the A/R Customer Reports folder to print these reports.

Transaction Reports

Accounts Receivable produces a complete range of reports of the transactions you enter and post. These 
reports include batch listings, posting journals, error reports, batch status reports, invoices, deposit slips, 
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and the G/L Transactions report. 

All of these reports are important parts of your audit trail of Accounts Receivable transactions. You should 
regularly print these reports, check them carefully, and file them in a secure place.

If you use Accounts Receivable to print invoices, credit notes, debit notes, and deposit slips, you should 
also establish procedures for ensuring that you print and check each one, and keep copies in your files.

Accounts Receivable also provides three important analytical reports that you can use to interpret, 
analyze, and summarize your data, including the Aged Trial Balance, Customer Transactions, and Item 
Sales History reports. 

To print the reports, use screens in the A/R Transaction Reports folder.

Aged Trial Balance

Use the Aged Trial Balance report to review and analyze outstanding receivables. You normally print this 
report at period end, before you charge interest, write off amounts, print statements, or clear paid 
transactions. You also print the report at other times when you need precise information about your 
outstanding and overdue receivables.

You can print the report with full transaction details or limit it to customer account balances. It can show 
you the amounts that were outstanding or overdue on past dates, as well as amounts that will be 
outstanding or overdue on future dates.

The Aged Trial Balance report groups transactions and balances by their document dates or due dates 
into the aging categories you specify. You can also choose to include zero balances, paid transactions, 
and applied details, and you can limit the report to customers whose accounts are over their credit limits.

If you use multicurrency accounting, you can also print the report in functional currency or in the 
customers’ currencies.

Customer Transactions

The Customer Transactions report serves as an audit trail of posted transactions in your customer 
accounts, within the range of dates you specify. Use the report to obtain an overview of your customer 
accounts in any period for which you have Accounts Receivable data.

You can report the details of any combination of invoices, debit notes, credit notes, interest, unapplied 
cash, and prepayments. You can also choose to include zero balances and applied details, and print a 
total for each transaction type.

You can optionally include extra information (customer contact, phone number, and credit limit), and 
three or four blank lines for writing comments or notes. 

If you use multicurrency accounting, you can also print the report in functional currency or in the 
customers’ currencies.
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Item Sales History

The Item Sales History report tracks item sales, returns, costs, and profit margins in any of the periods for 
which you keep item statistics. Use the report to identify successful items, items with a high rate of return, 
and items that do not sell well.

The report also lists the actual cost and gross margin (total sales amount minus actual costs) for each 
item, as well as the percentage of the sales total that is the gross profit.

You print this report only if you added items to your Accounts Receivable data and you use the Keep 
(item) Statistics option on the A/R Options screen. 

About Print Destinations
There are several ways to print reports in Sage 300, depending on your needs. Before you print, you can 
select a print destination to:

 l Print to a physical printer, to create permanent copies of the information.

 l Print to a preview on your screen, for quick review.

 l Print to a file that you can save, print later, import into another program, or transfer to other 
electronic media.

 l Print to e-mail, to send a report as an e-mail attachment.

Note: To change the print destination for forms and reports, you must have Change Print Destination 
security authorization for Administrative Services.

You select print destinations from the Sage 300 desktop. For more information, see "Selecting a Print 
Destination" (page 278).

Important! When you print to any destination, the report’s status is updated to Printed.

Tips: 
If you use Preview as your print destination, you can print or export the report from the preview screen 
in the following ways:

 l To print the report on your printer, click Print  on the SAP Crystal Reports® menu bar.

 l To export the report to a file, click Export  on the SAP Crystal Reports® menu bar. (You can 
select Crystal Reports, PDF, Excel, RTF, or CSV as the export format.)

Selecting a Print Destination

You can print reports to a printer, to the screen, to a file, or as an attachment to an e-mail message.
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Note: If you are not assigned to a security group that has authorization to change the print destination, 
the only destination available is a physical printer.

To select a print destination:

 1. On the Sage 300 Desktop, click Print Destination.

 2. Select a print destination:

 l Printer. Print to a physical printer. More...

Note: If you have multiple printers, you can specify the one to use when you print. For more 
information, see "Selecting a Printer for Reports" (page 280).

Tip: If you want to confirm the destination printer, page size, and orientation each time you print 
a report, on the Desktop, click View > Print Preferences, and then select Confirm on print.

 l Preview. Display reports in a preview screen. More...

Note: From the preview screen, you can do things such as saving the report to a file, or printing 
the report to a physical printer.

 l File. Print to a file. More...

When you print, you specify details about the file to create, including:

 l Format (for example, PDF, DOC, or XLS).

 l Destination.

 l Name.

 l Location.

 l E-mail. Print reports as attachments to e-mail messages. More...

You specify the type of file to create:

 l Adobe Acrobat (PDF). You can open PDF files with Adobe Acrobat Reader (available 
as a free download from the Adobe Software website).

 l Rich Text Format (RTF). You can open RTF files with most Windows and Linux word 
processing programs.

When you print a report, Sage 300 creates a PDF or RTF version of the report and attaches the 
report file to a new e-mail message.

 3. Click OK.
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Selecting a Printer for Reports

When your print destination is Printer, Sage 300 prints reports to the Windows default printer, unless you 
have assigned a specific printer to a report.

The ability to assign different printers to different reports at print time means that you are not limited to 
printing to the default printer. For example, you can use a different printer to print item labels than you use 
to print inventory worksheets.

To assign a specific report to a specific printer:

 1. Open the report screen that you want to assign to a printer.

 2. On the report screen, click File > Print Setup.

The program displays the Windows default printer, but you can change the printer for a specific report.

 3. Select the Specific Printer option, and then select from the list the printer to use for this report.

The printer list includes all printers that have been added to the Printers and Faxes list in Windows.

 4. Select a paper source if you want to use a particular paper tray or paper stock for this report.

 5. Click OK to close the Print Setup screen.

To clear the assigned printer for a specific report:

 1. On the Sage 300 Desktop, do one of the following:

 l Select (highlight) the icon for the report, and then click Object > Restore Defaults.

 l Right-click the icon for the report, and then click Restore Defaults on the list that appears.

 2. In the Restore Defaults screen, select the Print Settings option, and then click OK.

The print setup for that report is reverted to the desktop default.

To have the program prompt you to specify a printer and print options each time you 
print:

On the Sage 300 Desktop, click View > Print Preferences, and then select Confirm on print.

Printing Tips
You can select a print destination for a report that is different from the default print destination, and you 
can save personalized settings for printing certain reports in Accounts Receivable.
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Report Printing Options

You can print Sage 300 data in a variety of reports to view key information. Printed reports also serve as a 
source of backup information in case your data is damaged on your computer.

Sage 300 provides four destinations for printing reports. You can:

 l Print to a physical printer, to create permanent copies of the information.

 l Print to a preview on your screen, for quick review.

 l Print to a file that you can save, print later, import into another program, or transfer to other 
electronic media.

 l Print to e-mail, to send a report as an e-mail attachment.

For instructions on specifying the print destination for Sage 300 reports, see "Selecting a Print Destination" 
(page 278).

If you print reports to a physical printer, you can also specify a particular printer to use for printing a 
report. For instructions, see "Selecting a Printer for Reports" (page 280).

Saving Default Report Settings

Sage 300 lets you save report settings as defaults for printing certain Accounts Receivable reports, 
including Aged Trial Balance, Aged Retainage, Customers, and Customer Transactions reports, as well 
as Statements, Letters, and Labels.

To save current settings as defaults:

 1. Open the Accounts Receivable report screen for which you want to save printing settings.

 2. Select the default settings to use whenever you print this report.

 3. On the menu, click Settings > Save Settings As Defaults.

To clear saved settings:

 1. Open the Accounts Receivable report screen for which you want to reset printing settings.

 2. On the menu, click Settings > Clear Saved Settings.

Printing Customer Reports
Use the screens in the A/R Customer Reports folder to print lists of the customer groups, national 
accounts, customers, ship-to locations, and recurring charges in your Accounts Receivable system.

You can also print statistics reports for customer groups, national accounts, and customers.
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Printing Activity Statistics Reports

You can print an Activity Statistics report for customers and for national accounts, if you use national 
accounts in your Accounts Receivable system.

The reports list information about the sales and payment history for the current year to date and previous 
fiscal year for the customer records and national accounts in your Accounts Receivable system. 

For more information, see "A/R Activity Statistics Reports" (page 455).

When to Print

Print the report when you need to check on account activity, such as the last time a customer's check was 
returned to you NSF, the average number of days it takes a customer to pay invoices, the last time a 
customer was charged interest on an overdue document or account balance, or the date a customer's 
balance was last revalued (if your Accounts Receivable system uses multicurrency accounting).

Before You Start

 l Verify the print destination and, if necessary, turn on and connect the printer.

To print the A/R Customer Activity Statistics report:

 1. Open Accounts Receivable > A/R Customer Reports > Customers.

 2. From the Report Type list, select Customer Activity   Statistics.

 3. Select an account type.

 4. If you use multicurrency   accounting, specify whether to print amounts in customer currency or your 
company's functional currency.

 5. Specify up to four selection   criteria. If you do not specify selection criteria, the report   includes all 
customer records for the account type you select. 

 6. Specify up to four sorting  criteria. If you   do not specify sorting criteria, the report sorts customer 
records   by customer number.

 7. Click Print.

 l If you are printing to a physical printer, the Print window appears. Confirm your printer 
selection and the number of copies to print, and then click OK. Otherwise, click Cancel or 
Setup.

 l If you are printing to the screen (preview), the report appears in a new window. You can print 
the report or export it to a file.     

Note: For Web-based clients, the preview screen appears first when you click the Print button.
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 l If you are printing to a file, the Export window appears. Specify the file format (for example, PDF, 
DOC, or XLS). Also, specify a destination for the file:

 l Application. View the report in an application that can open files of the specified format 
(for example, if you specify PDF as the file format, the report opens in Adobe Acrobat). 
You can then save the file.

 l Disk file. Save the report to a location you specify.

 l Microsoft Mail. Send the report as an e-mail attachment.

You can enter the name of a non-existent file or directory to be created by the system when you 
print. When you print to a file, the report is assigned a unique name, for example, CS1000.TXT.

 l If you are printing to e-mail, an e-mail message appears with the report attached.

To print the A/R National Account Activity Statistics report:

 1. Open Accounts Receivable > A/R Customer Reports > Customers.

 2. From the Report Type list, select National Account Activity   Statistics.

 3. If you use multicurrency   accounting, specify whether to print amounts in customer currency or your 
company's functional currency.

 4. Select a range of national   account numbers.

 5. Click Print.

 l If you are printing to a physical printer, the Print window appears. Confirm your printer 
selection and the number of copies to print, and then click OK. Otherwise, click Cancel or 
Setup.

 l If you are printing to the screen (preview), the report appears in a new window. You can print 
the report or export it to a file.     

Note: For Web-based clients, the preview screen appears first when you click the Print button.

 l If you are printing to a file, the Export window appears. Specify the file format (for example, PDF, 
DOC, or XLS). Also, specify a destination for the file:

 l Application. View the report in an application that can open files of the specified format 
(for example, if you specify PDF as the file format, the report opens in Adobe Acrobat). 
You can then save the file.

 l Disk file. Save the report to a location you specify.

 l Microsoft Mail. Send the report as an e-mail attachment.

You can enter the name of a non-existent file or directory to be created by the system when you 
print. When you print to a file, the report is assigned a unique name, for example, CS1000.TXT.

 l If you are printing to e-mail, an e-mail message appears with the report attached.
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Printing the A/R Customer Group List Report

You use the A/R Customer Groups screen to print the Customer Group List report and the Customer 
Group Statistics report.

 l The Customer Group List  report lists the information entered to define the customer groups used in 
your Accounts Receivable system, and the customers assigned to each group.

 l The Customer Group Statistics report lists the total amount of invoices, receipts, discounts,   debit 
and credit notes, write-offs and adjustments, interest charges,   and returned checks you have 
recorded for a customer group during the period covered by the report.

For more information, see "A/R Customer Groups Report" (page 452).

Before You Start

 l Verify the print destination and, if necessary, turn on and connect the printer.

When to Print

Print the A/R Customer Group List report when you add, change, or delete customer groups.

To print the A/R Customer Group List report:

 1. Open Accounts Receivable > A/R Customer Reports > Customer Groups.

 2. From the Report Type list, select Customer Group List.

 3. Specify whether to include customer group profile, members, and/or optional fields in the report.

 4. Select a range of customer groups to include in the report.

 5. Click Print.

 l If you are printing to a physical printer, the Print window appears. Confirm your printer 
selection and the number of copies to print, and then click OK. Otherwise, click Cancel or 
Setup.

 l If you are printing to the screen (preview), the report appears in a new window. You can print 
the report or export it to a file.     

Note: For Web-based clients, the preview screen appears first when you click the Print button.

 l If you are printing to a file, the Export window appears. Specify the file format (for example, PDF, 
DOC, or XLS). Also, specify a destination for the file:

 l Application. View the report in an application that can open files of the specified format 
(for example, if you specify PDF as the file format, the report opens in Adobe Acrobat). 
You can then save the file.
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 l Disk file. Save the report to a location you specify.

 l Microsoft Mail. Send the report as an e-mail attachment.

You can enter the name of a non-existent file or directory to be created by the system when you 
print. When you print to a file, the report is assigned a unique name, for example, CS1000.TXT.

 l If you are printing to e-mail, an e-mail message appears with the report attached.

Printing the A/R Customers Report

The Customers report is one of four reports you can print using the A/R Customers report screen. It lists 
the information entered in Accounts Receivable to define the customer records used in your system.

For more information, see "A/R Customers Report" (page 454).

When to Print

Print the report after adding or revising   customer accounts, before deleting inactive customers, and when 
you need   a summary of customer addresses, profiles, comments, or recurring charges.

Before You Start

 l Verify the print destination and, if necessary, turn on and connect the printer.

To print the A/R Customers report:

 1. Open Accounts Receivable > A/R Customer Reports > Customers.

 2. From the Report Type list, select Customers.

 3. Select an account type.

 4. Under Include, specify whether to include the customers' address, profile, comments, optional   
fields, and/or information about recurring charges on the report.

 l If you include comments,   select a range of follow-up dates for which to include comments.

 l If you use Payment Processing, you can also include customers' credit card details.

 5. Specify up to four selection   criteria. If you do not specify selection criteria, the report   includes all 
customer records for the account type you select. 

 6. Specify up to four sorting  criteria. If you   do not specify sorting criteria, the report sorts customer 
records   by customer number.

 7. Click Print.

 l If you are printing to a physical printer, the Print window appears. Confirm your printer 
selection and the number of copies to print, and then click OK. Otherwise, click Cancel or 
Setup.
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 l If you are printing to the screen (preview), the report appears in a new window. You can print 
the report or export it to a file.     

Note: For Web-based clients, the preview screen appears first when you click the Print button.

 l If you are printing to a file, the Export window appears. Specify the file format (for example, PDF, 
DOC, or XLS). Also, specify a destination for the file:

 l Application. View the report in an application that can open files of the specified format 
(for example, if you specify PDF as the file format, the report opens in Adobe Acrobat). 
You can then save the file.

 l Disk file. Save the report to a location you specify.

 l Microsoft Mail. Send the report as an e-mail attachment.

You can enter the name of a non-existent file or directory to be created by the system when you 
print. When you print to a file, the report is assigned a unique name, for example, CS1000.TXT.

 l If you are printing to e-mail, an e-mail message appears with the report attached.

Printing the A/R Customer Comments Report

The Customer Comments report lists comments from your customer records for a range of follow-up 
dates you specify.

For more information, see "A/R Customer Comments Report" (page 457).

When to Print

Print the report when you need a report   of customer comments. 

Before You Start

 l Verify the print destination and, if necessary, turn on and connect the printer.

To print the A/R Customer Comments report:

 1. Open Accounts Receivable > A/R Customer Reports > Customers.

 2. From the Report Type list, select Customer Comments.

 3. Select an account type.

 4. Select a range of follow-up dates for which to include comments.

 5. Specify up to four selection   criteria. If you do not specify selection criteria, the report   includes all 
customer records for the account type you select. 
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 6. Specify up to four sorting  criteria. If you   do not specify sorting criteria, the report sorts customer 
records   by customer number.

 7. Click Print.

 l If you are printing to a physical printer, the Print window appears. Confirm your printer 
selection and the number of copies to print, and then click OK. Otherwise, click Cancel or 
Setup.

 l If you are printing to the screen (preview), the report appears in a new window. You can print 
the report or export it to a file.     

Note: For Web-based clients, the preview screen appears first when you click the Print button.

 l If you are printing to a file, the Export window appears. Specify the file format (for example, PDF, 
DOC, or XLS). Also, specify a destination for the file:

 l Application. View the report in an application that can open files of the specified format 
(for example, if you specify PDF as the file format, the report opens in Adobe Acrobat). 
You can then save the file.

 l Disk file. Save the report to a location you specify.

 l Microsoft Mail. Send the report as an e-mail attachment.

You can enter the name of a non-existent file or directory to be created by the system when you 
print. When you print to a file, the report is assigned a unique name, for example, CS1000.TXT.

 l If you are printing to e-mail, an e-mail message appears with the report attached.

Printing a List of Customers

You can use the A/R Customer List screen to create lists of customers based on criteria that you specify. 
It is a powerful   tool that provides field-level selection and analysis of your customer   database, allowing 
you to create specialized reports about your customers.

For more information about the A/R Customer List screen, see "A/R Customer List Screen" (page 404).

Note: If you want to print a report of customer records in your Accounts Receivable   system, use the 
A/R Customers report. For more information, see "A/R Customers Report" (page 454).

Before You Start

 l Verify the print destination and, if necessary, turn on and connect the printer.

287Sage 300 2023 Accounts Receivable User's Guide



To print the A/R Customer List report:

 1. Open Accounts Receivable > A/R Customers > Customer List.

 2. Under Customer Range, specify up to seven selection criteria that determine customer records to 
include in the report.

 3. Under Credit Limit, specify optional credit limit criteria.

 4. If you want to include customer contact information in the report, select the Contact Information 
option.

 5. If you want the report to include customers with no balance in their accounts, select   the option 
Customers With Zero A/R Balance.

 6. Click Process to generate   and display the list.

The Customer List Preview window appears, and displays a list of customers that match the criteria you 
specified.

 7. Click Print.

 l If you are printing to a physical printer, the Print window appears. Confirm your printer 
selection and the number of copies to print, and then click OK. Otherwise, click Cancel or 
Setup.

 l If you are printing to the screen (preview), the report appears in a new window. You can print 
the report or export it to a file.     

Note: For Web-based clients, the preview screen appears first when you click the Print button.

 l If you are printing to a file, the Export window appears. Specify the file format (for example, PDF, 
DOC, or XLS). Also, specify a destination for the file:

 l Application. View the report in an application that can open files of the specified format 
(for example, if you specify PDF as the file format, the report opens in Adobe Acrobat). 
You can then save the file.

 l Disk file. Save the report to a location you specify.

 l Microsoft Mail. Send the report as an e-mail attachment.

You can enter the name of a non-existent file or directory to be created by the system when you 
print. When you print to a file, the report is assigned a unique name, for example, CS1000.TXT.

 l If you are printing to e-mail, an e-mail message appears with the report attached.

 8. Click Close to return   to the A/R Customer List Criteria screen.

Printing a List of Inactive Customer Accounts

You can use the A/R Customer List screen to generate a list of customers   with Inactive status, and 
include account balance information on   the list.
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For more information about using the A/R Customer List screen, see "A/R Customer List Screen" (page 
404).

Before You Start

 l Verify the print destination and, if necessary, turn on and connect the printer.

To print a list of inactive customer accounts:

 1. Open Accounts Receivable > A/R Customers > Customer List.

 2. From the first Select By list, select Status, and from the From list that appears, select Inactive.

 3. From the second Select By   list, select A/R Balance, accepting the default entries in the   From and 
To lists that appear.

 4. Under Include, select   the Customers With Zero A/R Balance option.

 5. Click Process.

The Customer List Preview screen appears and displays customer accounts that match the criteria you 
specified. 

 6. Make note of any accounts that do not have zero balances so   that you can collect any outstanding 
amounts, or write off small or uncollectible   amounts.

 7. Click Print.

 l If you are printing to a physical printer, the Print window appears. Confirm your printer 
selection and the number of copies to print, and then click OK. Otherwise, click Cancel or 
Setup.

 l If you are printing to the screen (preview), the report appears in a new window. You can print 
the report or export it to a file.     

Note: For Web-based clients, the preview screen appears first when you click the Print button.

 l If you are printing to a file, the Export window appears. Specify the file format (for example, PDF, 
DOC, or XLS). Also, specify a destination for the file:

 l Application. View the report in an application that can open files of the specified format 
(for example, if you specify PDF as the file format, the report opens in Adobe Acrobat). 
You can then save the file.

 l Disk file. Save the report to a location you specify.

 l Microsoft Mail. Send the report as an e-mail attachment.

You can enter the name of a non-existent file or directory to be created by the system when you 
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print. When you print to a file, the report is assigned a unique name, for example, CS1000.TXT.

 l If you are printing to e-mail, an e-mail message appears with the report attached.

 8. Click Close to return   to the A/R Customer List screen.

Printing a List of Overdue Customer Accounts

You can use the A/R Customer List screen to generate a list of customers by overdue amount, using 
aging criteria to determine transactions that are overdue.

For more information about using the A/R Customer List screen, see "A/R Customer List Screen" (page 
404).

Before You Start

 l Verify the print destination and, if necessary, turn on and connect the printer.

To print a list of overdue customer accounts:

 1. Open Accounts Receivable > A/R Customers > Customer List.

 2. From the first Select By list, specify initial report criteria as needed, such as range of customer 
numbers, customer groups, and/or account sets.

 3. From next Select By   list, select Overdue Amount., and in the From and To fields   that appear, 
specify a range of overdue amounts that customers must owe   to be included on the report.

 4. Use the remaining Select   By lists to specify additional criteria as needed. 

 5. Under Aging, select options to   determine the transactions that are current and those that are 
overdue. More...

 l Age By. Select   Due Date to age overdue amounts by their document due dates.

 l Age As Of. Specify   the date as of which to age transactions. The program assigns each 
transaction   to an aging period by calculating the number of days between its due date   and 
the Age As Of date.

 l Cutoff Date. Specify   the latest due date that a transaction can have to be included on the   
report. (The report includes only transactions with a due date on or before   the cutoff date you 
specify.)

 l Include Prepayments. Select this option to take customer prepayments into account when 
calculating   overdue balances.

 6. Under Include, select the Contact Information   option to include the name, telephone number, and 
e-mail address of each   customer contact in the report.
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 7. Click Process.

The Customer List Preview screen appears and displays customer accounts that match the criteria you 
specified. 

 8. Click Print.

 l If you are printing to a physical printer, the Print window appears. Confirm your printer 
selection and the number of copies to print, and then click OK. Otherwise, click Cancel or 
Setup.

 l If you are printing to the screen (preview), the report appears in a new window. You can print 
the report or export it to a file.     

Note: For Web-based clients, the preview screen appears first when you click the Print button.

 l If you are printing to a file, the Export window appears. Specify the file format (for example, PDF, 
DOC, or XLS). Also, specify a destination for the file:

 l Application. View the report in an application that can open files of the specified format 
(for example, if you specify PDF as the file format, the report opens in Adobe Acrobat). 
You can then save the file.

 l Disk file. Save the report to a location you specify.

 l Microsoft Mail. Send the report as an e-mail attachment.

You can enter the name of a non-existent file or directory to be created by the system when you 
print. When you print to a file, the report is assigned a unique name, for example, CS1000.TXT.

 l If you are printing to e-mail, an e-mail message appears with the report attached.

 9. Click Close to return   to the A/R Customer List screen.

Printing Customer Statements

You use the Statements/Letters/Labels screen to print statements, for customers and national accounts.

About Printing Statements

You can print a wide variety of Accounts Receivable information on statements   for your customers. You 
can also print form letters and labels using information   from your customer records.

When printing, you can use several options to select customers,   and you can use any of the formats you 
developed to print each type of   form. You can also specify the set of dunning messages to use and the   
dates and aging periods by which to select and group transactions, as   well as whether to include fully 
paid transactions and applied transactions.

Also, because Accounts Receivable keeps complete details of statements   that you print, you can reprint 
the statements   at any time. For more information, see "Reprinting Statements" (page 297).
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Statements for Open-Item Customers

Statements for open-item customers list all outstanding transactions   in the account. You can choose to 
include applied transactions and paid   transactions at printing time. 

The Open Item Statement Type option offers selections that let you produce   statements for open-item 
customers in different formats, including a format   that resembles the statement used for balance-forward 
customers. For more   information about the formats, see "A/R Statements / Letters / Labels Report" (page 
461).

You can choose to include in the statement run only customers that have   balances outstanding for a 
number of days that you specify.

Statements for Balance-Forward Customers

Statements for balance-forward customers resemble credit card statements.   They show the balance 
forward, the transactions that changed the customer’s   balance during the period, and the current 
balance. 

Only totals for current invoices, credit notes, debit notes, and customer   payments appear on the 
statement. Applied transactions and discount amounts   do not appear. 

You can choose to include in the statement run only customers that have   balances outstanding for a 
number of days that you specify.

Statements for National Accounts

When you print a national account statement using the default selections, the report lists transactions   of 
the associated customers, with a total for the national account but   no subtotals by affiliate.

If you need the subtotals, select Customer   Number as the first sorting option, and then sort by national 
account. This selection   provides individual customer statements, followed by a summary sheet   for the 
national account. 

Customizing Statement Forms, Letters, Labels, and Checks

You use the Statements/Letters/Labels screen to print customer statements,   letters, and labels.  Accounts 
Receivable includes the following   sample report formats you can use to print   these documents:

 l ARSTMT10.RPT.  This format is designed for printing statements on plain paper. The form 
includes a tear-off section on the right-hand side of the report.

 l ARSTMT11.RPT. This format is also designed for printing statements on plain paper. The form 
includes a number of enhancements over ARSTMT10.RPT, but it does not have a tear-off section.

 l ARSTMTPRE.RPT. This format is designed for printing statements on preprinted forms. It does 
not print company information which is normally included on preprinted forms.
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You may be able to use the sample formats as they are, adapt them to   fit your current forms, or create 
new formats. For example, you can set   up a format that lets you print addresses either from the customer 
records   or from ship-to records. For information about how to customize forms,   see the SAP Crystal 
Reports® documentation. 

After you print statements, customer records are updated.   You can see the last statement date and 
balance for a customer on the   Activity tab of the A/R Customers screen, and on the A/R Customer Inquiry 
screen.

If you print statements by billing cycle, the statement date is entered   for the billing cycle on the A/R Billing 
Cycles screen and printed on the A/R Billing   Cycles report.

Printing Customer Statements

Use the Statements/Letters/Labels screen to print statements, letters, or labels for a customer or national 
account.

If you need additional   copies of statements, or if earlier processing was halted, you can click the Reprint   
button to open the A/R Reprint Statements screen. 

For more information, see "Reprinting Statements" (page 297).

Before You Start

 l Update account information   by entering, importing, and posting batches.

 l If you have not finished   printing the previous statement run, you must do so before printing a   new 
set of statements.

 l Make sure the Print Statements   option is selected in the customer or national account record for 
which   you want to print statements.

 l Verify the print destination and, if necessary, turn on and connect the printer.

To print customer statements:

 1. Open Accounts Receivable > A/R Customer Reports > Statements/Letters/Labels.

 2. Select the Statement option.

 3. To select a statement format, click the Browse button to the right of the Use statement field, and then 
select a form.

For information about the standard business forms included with Accounts Receivable, see 
"Customizable Formats for Printed Accounts Receivable Forms" (page 57).
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Tip: You can print optional fields on customer statements. For an example of how to print     customer 
optional fields on statements, see the sample statement    ARSTMT10.RPT.

 4. Select a delivery method. More...

 l Print   Destination. Send statements to the default print destination you selected for the 
company.

 l Customer. Send statements via the method specified in customer records.

If you select Customer, also select the codes for the e-mail messages you want to send with statements   
that are e-mailed.

 5. If you use national accounts and you want to print statements for the national accounts, instead of 
for the individual customers assigned to each account, select the National Account Statements 
option.

Individual customer statements are not printed for   members of national accounts for this statement run, 
or future statement   runs, if you select this option.

 6. Specify the run date and cutoff date, or accept the default dates. More...

 l Run Date. This is the date that appears on the statements. The program also uses this date 
to assign transactions or balances to aging periods. For example, if you choose to age 
documents by their due dates (for the Age By option), the program assigns each transaction 
to an aging   period by calculating the number of days between its due date and the   run date.

 l Cutoff Date. The report normally includes  only transactions or balances that have a 
document date before or on the   cutoff date you specify. (Occasionally, a document posted 
after the cutoff date   may appear for some open item statement types. For example, if you 
apply   a posted credit note before the cutoff date to an invoice posted after   the cutoff date, the 
invoice may appear on the statement with a negative   amount.)

 7. Specify whether to age transactions by due date or document date.

 8. On the Select tab, specify selection and sorting criteria.

 l If you do not specify selection criteria, the report   includes all customer records or national 
accounts with the account type   you select.

 l If you do not specify sorting criteria, the report   orders the records by national account 
number (if you print national account   statements), by customer number, then by document 
number and document   date.

 9. On the Criteria tab, specify additional criteria   to use when printing the statements. More...

 a. To include or exclude accounts by their balances, select the Select Customers Based On 
Balance Type option. You can list accounts   with debit balances, credit balances, or zero 
balances.

 b. Specify whether to sort documents by document number or document date. 
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 c. If you selected All Customers or   Open Item as the account type, select the format to use for the 
statements from the Open Item Statement Type list. More...

 l Version   5.1, 5.2, and 5.3 Format. Select this option if you want to continue printing 
customer statements in a familiar format.   You can then select the following additional 
options:

 l Include Paid Transactions For Open Item Accounts. Select this option to include 
transactions that have been paid, but have not yet been cleared. 

This option applies to open   item-type customers and national accounts, and to 
current period (that is, for the period after statements were last printed)    transactions 
for balance forward-type accounts.

 l Include Applied   Details For Open Item Accounts. Select this option to include all   
the documents—such as receipts, prepayments, unapplied cash, and credit notes—
that were applied to each reported invoice for open item accounts. If   you do not 
select this option, the statement shows only the balance owing   for each invoice and 
the unapplied balance for each credit note.

The statement will not include fully applied receipts, unapplied cash, and 
prepayments if the invoices   to which they were applied were paid in full in the 
current period.

 l Balance   Forward.Accounts Receivable   prints a statement that is similar to 
statements used for balance forward   customers. However, while the balance forward 
is printed, the last balance forward date is not printed.

 l Transaction   Current Outstanding Balances. Accounts Receivable prints a list of all 
transactions that have a current outstanding balance. Fully paid transactions are not 
included.

 l Transaction   Opening Balances Showing Applied Details. Accounts Receivable prints a 
list of:

 l New transactions that   have never been included on a statement.

 l Older transactions   that remained unpaid on the last statement, or that have had 
activity   since the last statement printing. 

 l The details of any transactions that have been applied to transactions. Note that 
applied   details that were printed on earlier statements are not included.

 l Transaction   Opening Balances and New Transactions. Accounts Receivable prints a list 
of all transactions that:
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 l Remained outstanding balance on the last statement.

 l Are new, and have not been previously printed.

 d. To select customers with balances, select the Select Customers With Balances option, 
and then specify the minimum number   of days that customer balances must be outstanding 
to be included in the statement run. 

 e. Accept the default aging periods (from the Statement tab of the A/R Options screen) or 
change them if necessary.

 f. In the Dunning Messages field, select the code that identifies the set of dunning messages 
to print on the statements. If you do not select a code, Accounts Receivable prints the 
default dunning message entered on the Statement tab of the A/R Options screen for each 
customer or national account. 

Accounts Receivable prints the dunning message for the oldest aging period in which there are 
outstanding transactions.

 10. Click Print.

 l If you are printing to a physical printer, the Print window appears. Confirm your printer 
selection and the number of copies to print, and then click OK. Otherwise, click Cancel or 
Setup.

 l If you are printing to the screen (preview), the report appears in a new window. You can print 
the report or export it to a file.     

Note: For Web-based clients, the preview screen appears first when you click the Print button.

 l If you are printing to a file, the Export window appears. Specify the file format (for example, PDF, 
DOC, or XLS). Also, specify a destination for the file:

 l Application. View the report in an application that can open files of the specified format 
(for example, if you specify PDF as the file format, the report opens in Adobe Acrobat). 
You can then save the file.

 l Disk file. Save the report to a location you specify.

 l Microsoft Mail. Send the report as an e-mail attachment.

You can enter the name of a non-existent file or directory to be created by the system when you 
print. When you print to a file, the report is assigned a unique name, for example, CS1000.TXT.

 l If you are printing to e-mail, an e-mail message appears with the report attached.

After printing customer statements

 l Print labels   for the letters that you are posting. For more information, see "Printing Accounts 
Receivable Labels" (page 298).
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Reprinting Statements

Because Accounts Receivable maintains complete details of your statements,   you can reprint customer 
statements using the A/R Reprint Statements screen.   

You can reprint a statement because you want another copy, or you can   reprint a whole range of 
statements if you did not finish a statement   run. 

Notes: 
 l You can have one outstanding statement run at a time. 

 l You must complete   the previous statement run before beginning another one.

 l You   cannot use the A/R Reprint Statements screen to print a statement with irregular   dates. The 
dates must be the same as you used on the original statement.

Before You Start

 l Verify the print destination and, if necessary, turn on and connect the printer.

To reprint statements:

 1. Open Accounts Receivable > A/R Customer Reports > Statements/Letters/Labels.

 2. Click the Reprint button.

 3. Select options   to identify the statements to reprint.

 4. Click Print.

 l If you are printing to a physical printer, the Print window appears. Confirm your printer 
selection and the number of copies to print, and then click OK. Otherwise, click Cancel or 
Setup.

 l If you are printing to the screen (preview), the report appears in a new window. You can print 
the report or export it to a file.     

Note: For Web-based clients, the preview screen appears first when you click the Print button.

 l If you are printing to a file, the Export window appears. Specify the file format (for example, PDF, 
DOC, or XLS). Also, specify a destination for the file:

 l Application. View the report in an application that can open files of the specified format 
(for example, if you specify PDF as the file format, the report opens in Adobe Acrobat). 
You can then save the file.

 l Disk file. Save the report to a location you specify.

 l Microsoft Mail. Send the report as an e-mail attachment.
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You can enter the name of a non-existent file or directory to be created by the system when you 
print. When you print to a file, the report is assigned a unique name, for example, CS1000.TXT.

 l If you are printing to e-mail, an e-mail message appears with the report attached.

Printing Accounts Receivable Labels

You use the A/R Labels screen to print labels, either for customers’ addresses or for their ship-to 
locations. 

Use the A/R Labels report screen to print labels either for customers’   addresses or for their ship-to 
addresses. 

For more information about this report, see "A/R Labels Report" (page 462).

Before You Start

 l Ensure that there is sufficient label stock in the printer.

 l Determine which format to use to print the labels.

 l Make sure your print destination is set to Printer.

To print labels:

 1. Open Accounts Receivable > A/R Customer Reports > Labels.

 2. To select a report format, click the Browse button to the right of the Use Label field, and then 
select a report.

For information about the standard business forms included with Accounts Receivable, see 
"Customizable Formats for Printed Accounts Receivable Forms" (page 57).

 3. On the Print list, specify whether to print the customer address or ship-to location address.

 4. On the Select By list, specify whether to print labels for a range of customers, or for a range of 
customers and documents.

 5. Select a range of customers for which to print labels.

 6. If you selected Customer/Document Number on the Select By list, specify a range of document 
numbers for which to print labels.

 7. Specify the number of labels to print for each address.

 8. Click Print.

 l If you are printing to a physical printer, the Print window appears. Confirm your printer 
selection and the number of copies to print, and then click OK. Otherwise, click Cancel or 
Setup.
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 l If you are printing to the screen (preview), the report appears in a new window. You can print 
the report or export it to a file.     

Note: For Web-based clients, the preview screen appears first when you click the Print button.

 l If you are printing to a file, the Export window appears. Specify the file format (for example, PDF, 
DOC, or XLS). Also, specify a destination for the file:

 l Application. View the report in an application that can open files of the specified format 
(for example, if you specify PDF as the file format, the report opens in Adobe Acrobat). 
You can then save the file.

 l Disk file. Save the report to a location you specify.

 l Microsoft Mail. Send the report as an e-mail attachment.

You can enter the name of a non-existent file or directory to be created by the system when you 
print. When you print to a file, the report is assigned a unique name, for example, CS1000.TXT.

 l If you are printing to e-mail, an e-mail message appears with the report attached.

Printing Letters and Labels

You can print letters and mailing labels for the customers and national accounts in your Accounts 
Receivable system. For example, you might want to send letters to your customers for advertising or 
collection purposes. More...

Accounts Receivable comes with a sample dunning letter and a sample mailing label form, that you can 
use or change to suit your company’s requirements.

You can send letters to customers who have balances outstanding more than 90 days.

Notes: 
 l Letters and labels are printed for a customer or national account only if the Print Statements 

option is selected for the customer or national account.

 l You use the A/R Statements/Letters/Labels screen to print labels for addresses in customer 
records. To print labels for customer ship-to addresses (for example, to affix on shipments of 
goods), you use the A/R Labels screen. For more information, see "A/R Labels Report" (page 
462).

Before You Start

 l Ensure that there is sufficient stock in the printer.

 l Determine which report format to use to print the letters or the labels.

 l Make sure your print destination is set to Printer.
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To print letters:

 1. Open Accounts Receivable > A/R Customer Reports > Statements/Letters/Labels.

 2. Select Letter as the type of document to print.

 3. Select the following general options:     

 l Use Letter. Use the Browse button to select the report form to use for the letters, if the 
correct one does not already appear in the field.

 l Delivery Method. Select a delivery method for letters, as follows:       

 l Print Destination. Select this method to send the letters to the default print destination 
you selected on the company desktop.

 l Customer. Select this method to send the letters via the method specified in your 
customer records.

 l E-mail Message. This field appears when you select Customer for the Delivery Method. 
Select the code for the e-mail messages you want to send with e-mailed letters.

 l Use Aging. Select this option if you want to send the letter only to customers that meet 
specified aging criteria (customers that have an aged balance). If you do not select this 
option, letters are printed for all customers, including those who have current balances.

When you select the Use Aging option, additional fields appear that let you specify the cutoff date 
and how to age customer balances:

 l Cutoff Date. If you are using aging criteria to select customers, specify a cutoff date. 
Letters or labels are printed only for customers whose balances are overdue on the 
cutoff date by the number of days specified on the Criteria tab.

 l Age By. Specify whether to evaluate age by due date or document date.

 l Run Date. This is the date that appears on the letters.

 4. On the Select tab, select only the options you need to define the range of customers and to print 
the information you want to include:     

 l Account Type. You can choose to print letters or labels for open item or balance forward 
customers only, or for all customers.

 l Select By. Specify up to four selection criteria to select the customer for whom to print the 
letter.

For the first selection, choose from Customer Number, National Account, Customer Group, Billing 
Cycle, and Short Name.

For the remaining three selection criteria choose from the above options, plus Territory, Account 
Set, Currency Code (multicurrency ledgers only), Current Balance, Current Functional Balance 
(multicurrency ledgers only), Customer Name, Salesperson, Short Name, Start Date, Zip/Postal 
Code, and customer optional fields (if any). 
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If you do not specify selection criteria, Accounts Receivable prints letters for all customers with 
the account type you select.

 l Sort By. Specify up to four orders by which to sort the letters, choosing from Territory, 
National Account, Customer Group, Billing Cycle, Account Set, Currency Code 
(multicurrency ledgers only), Current Balance, Current Functional Balance (multicurrency 
ledgers only), Customer Name, Salesperson, Short Name, and Zip/Postal Code.

If you do not specify sorting criteria, the letters are sorted by customer number, then by document 
number and document date.

 5. On the Criteria tab, specify additional criteria to use when printing the statements:

 l Select Customers Based On Balance Type. Select this option to include or exclude 
accounts by their balances. You can list accounts with debit balances, credit balances, or 
zero balances.

 l Select Customers With Balances [X] Days and Later. This option appears only if the Use 
Aging option is selected. If you select this option, specify the minimum number of days that 
customer balances must be outstanding to print a letter for the customer.

Note: If you specify less than 90 days, letters will only be sent to customers who have balances 
outstanding more than 90 days.

 l Use Aging Periods. The default aging periods from the A/R Options screen appear here if 
you selected the Use Aging option. If you are printing a customized letter that uses aging 
periods, these fields can be used to provide additional information for customers.

 6. Click Print. More...

 l If you are printing to a physical printer, the Print window appears. Confirm your printer 
selection and the number of copies to print, and then click OK. Otherwise, click Cancel or 
Setup.

 l If you are printing to the screen (preview), the report appears in a new window. You can print 
the report or export it to a file.     

Note: For Web-based clients, the preview screen appears first when you click the Print button.

 l If you are printing to a file, the Export window appears. Specify the file format (for example, PDF, 
DOC, or XLS). Also, specify a destination for the file:

 l Application. View the report in an application that can open files of the specified format 
(for example, if you specify PDF as the file format, the report opens in Adobe Acrobat). 
You can then save the file.

 l Disk file. Save the report to a location you specify.

 l Microsoft Mail. Send the report as an e-mail attachment.
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You can enter the name of a non-existent file or directory to be created by the system when you 
print. When you print to a file, the report is assigned a unique name, for example, CS1000.TXT.

 l If you are printing to e-mail, an e-mail message appears with the report attached.

To print labels:

 1. Open Accounts Receivable > A/R Customer Reports > Statements/Letters/Labels.

 2. Select Label as the type of document to print.

 3. Select the following general options:     

 l Use Label. Use the Browse button to select the report form to use for the labels, if the correct 
one does not already appear in the field.

 l Use Aging. Select this option if you want to send the letter only to customers that meet 
specified aging criteria (customers that have an aged balance). If you do not select this 
option, labels are printed for all customers, including those who have current balances.       

When you select the Use Aging option, additional fields appear that let you specify the cutoff date 
and how to age customer balances:

 l Cutoff Date. If you are using aging criteria to select customers, specify a cutoff date. 
Letters or labels are printed only for customers whose balances are overdue on the 
cutoff date by the number of days specified on the Criteria tab.

 l Age By. Specify whether to evaluate age by due date or document date.

 l Run Date. This is the date that appears on the letters.

 4. On the Select tab, select only the options required to define the range of customers for whom to print 
labels:     

 l Account Type. You can choose to print letters or labels for Open Item or Balance Forward 
customers only, or All Customers.

 l Select By. Specify up to four selection criteria to select the customer for whom to print the 
letter.       

For the first selection, choose from Customer Number, National Account, Customer Group, Billing 
Cycle, and Short Name.

For the remaining three selection criteria choose from the above options, plus Territory, Account 
Set, Currency Code (multicurrency ledgers only), Current Balance, Current Functional Balance 
(multicurrency ledgers only), Customer Name, Salesperson, Short Name, Start Date, Zip/Postal 
Code, and customer optional fields (if any). 

If you do not specify selection criteria, Accounts Receivable prints labels for all customers with the 
account type you select.
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 l Sort By. Specify up to four orders by which to sort the letters, choosing from Territory, 
National Account, Customer Group, Billing Cycle, Account Set, Currency Code 
(multicurrency ledgers only), Current Balance, Current Functional Balance (multicurrency 
ledgers only), Customer Name, Salesperson, Short Name, and Zip/Postal Code.

If you do not specify sorting criteria, the letters are sorted by customer number, then by document 
number and document date.

 5. On the Criteria tab, specify additional criteria to use when printing the statements:     

 l Select Customers Based On Balance Type. Select this option to include or exclude 
accounts by their balances. You can list accounts with debit balances, credit balances, or 
zero balances.

 l Select Customers With Balances [X] Days and Later. This option appears only if the Use 
Aging option is selected. If you select this option, specify the minimum number of days that 
customer balances must be outstanding to print a letter for the customer.       

Note: If you specify less than 90 days, letters will only be sent to customers who have balances 
outstanding more than 90 days.

 l Use Aging Periods. The default aging periods from the A/R Options screen appear here if 
you selected the Use Aging option. If you are printing a customized letter that uses aging 
periods, these fields can be used to provide additional information for customers.

 6. Click Print. More...

 l If you are printing to a physical printer, the Print window appears. Confirm your printer 
selection and the number of copies to print, and then click OK. Otherwise, click Cancel or 
Setup.

 l If you are printing to the screen (preview), the report appears in a new window. You can print 
the report or export it to a file.     

Note: For Web-based clients, the preview screen appears first when you click the Print button.

 l If you are printing to a file, the Export window appears. Specify the file format (for example, PDF, 
DOC, or XLS). Also, specify a destination for the file:

 l Application. View the report in an application that can open files of the specified format 
(for example, if you specify PDF as the file format, the report opens in Adobe Acrobat). 
You can then save the file.

 l Disk file. Save the report to a location you specify.

 l Microsoft Mail. Send the report as an e-mail attachment.

You can enter the name of a non-existent file or directory to be created by the system when you 
print. When you print to a file, the report is assigned a unique name, for example, CS1000.TXT.

 l If you are printing to e-mail, an e-mail message appears with the report attached.
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Printing the A/R National Accounts Report

The National Account report is one of three reports you can print using the A/R National Accounts report 
screen. The report lists the information entered in Accounts Receivable to define the national accounts 
used in your system, and the customers assigned to each national account.

Note: You can print this report only if you use national accounts in your   Accounts Receivable system.

For more information, see "A/R National Accounts Report" (page 458).

When to Print

Print the report when you add, change, or delete national accounts. 

Before You Start

 l Verify the print destination and, if necessary, turn on and connect the printer.

To print the A/R National Accounts report:

 1. Open Accounts Receivable > A/R Customer Reports > National Accounts.

 2. From the Report Type list, select National Account List.

 3. Under Include, specify whether to include address, profile, member, and/or optional field 
information in the report.

 4. Select a range of national account numbers to include in the report.

 5. Click Print.

 l If you are printing to a physical printer, the Print window appears. Confirm your printer 
selection and the number of copies to print, and then click OK. Otherwise, click Cancel or 
Setup.

 l If you are printing to the screen (preview), the report appears in a new window. You can print 
the report or export it to a file.     

Note: For Web-based clients, the preview screen appears first when you click the Print button.

 l If you are printing to a file, the Export window appears. Specify the file format (for example, PDF, 
DOC, or XLS). Also, specify a destination for the file:

 l Application. View the report in an application that can open files of the specified format 
(for example, if you specify PDF as the file format, the report opens in Adobe Acrobat). 
You can then save the file.

 l Disk file. Save the report to a location you specify.

 l Microsoft Mail. Send the report as an e-mail attachment.
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You can enter the name of a non-existent file or directory to be created by the system when you 
print. When you print to a file, the report is assigned a unique name, for example, CS1000.TXT.

 l If you are printing to e-mail, an e-mail message appears with the report attached.

Printing A/R Period Statistics Reports

The Period Statistics reports list the total amount of invoices, receipts, discounts, debit and credit notes, 
write-offs and adjustments, interest charges, and returned checks you have recorded for a given 
customer, customer group, or national account during the period covered by the report. 

The reports list statistics for the type of year and period you selected for customer, group, and national 
account statistics on the A/R Options screen.

For more information, see "A/R Period Statistics Reports" (page 456).

When to Print

Print the report when you need a summary of statistics, such as at the   end of each reporting period.

Before You Start

 l Verify the print destination and, if necessary, turn on and connect the printer.

To print the A/R Customer Period Statistics report:

 1. Open Accounts Receivable > A/R Customer Reports > Customers.

 2. From the Report Type list, select Customer Period Statistics.

 3. Select the   account type, currency (if you use multicurrency accounting), whether   to include the 
number of documents that make up the total amount for each   type of transaction listed on the 
report, the years and periods for which   to include transactions, and up to four selection and sorting 
criteria.

 4. Click Print.

 l If you are printing to a physical printer, the Print window appears. Confirm your printer 
selection and the number of copies to print, and then click OK. Otherwise, click Cancel or 
Setup.

 l If you are printing to the screen (preview), the report appears in a new window. You can print 
the report or export it to a file.     

Note: For Web-based clients, the preview screen appears first when you click the Print button.

 l If you are printing to a file, the Export window appears. Specify the file format (for example, PDF, 
DOC, or XLS). Also, specify a destination for the file:
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 l Application. View the report in an application that can open files of the specified format 
(for example, if you specify PDF as the file format, the report opens in Adobe Acrobat). 
You can then save the file.

 l Disk file. Save the report to a location you specify.

 l Microsoft Mail. Send the report as an e-mail attachment.

You can enter the name of a non-existent file or directory to be created by the system when you 
print. When you print to a file, the report is assigned a unique name, for example, CS1000.TXT.

 l If you are printing to e-mail, an e-mail message appears with the report attached.

To print the A/R Customer Group Period Statistics report:

 1. Open Accounts Receivable > A/R Customer Reports > Customer Groups.

 2. From the Report Type list, select Customer Group Statistics.

 3. Specify whether   to include the number of documents that make up the total amount for each   type 
of transaction listed on the report.

 4. Select the ranges of groups,   years, and periods to include.

 5. Click Print.

 l If you are printing to a physical printer, the Print window appears. Confirm your printer 
selection and the number of copies to print, and then click OK. Otherwise, click Cancel or 
Setup.

 l If you are printing to the screen (preview), the report appears in a new window. You can print 
the report or export it to a file.     

Note: For Web-based clients, the preview screen appears first when you click the Print button.

 l If you are printing to a file, the Export window appears. Specify the file format (for example, PDF, 
DOC, or XLS). Also, specify a destination for the file:

 l Application. View the report in an application that can open files of the specified format 
(for example, if you specify PDF as the file format, the report opens in Adobe Acrobat). 
You can then save the file.

 l Disk file. Save the report to a location you specify.

 l Microsoft Mail. Send the report as an e-mail attachment.

You can enter the name of a non-existent file or directory to be created by the system when you 
print. When you print to a file, the report is assigned a unique name, for example, CS1000.TXT.

 l If you are printing to e-mail, an e-mail message appears with the report attached.
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To print the A/R National Account Period Statistics report:

 1. Open Accounts Receivable > A/R Customer Reports > National Accounts.

 2. From the Report Type list, select National Account Period Statistics.

 3. Specify whether to include the number of documents that make up the total   amount for each type 
of transaction listed on the report.

 4. Select   the ranges of national accounts, years, and periods to include.

 5. Click Print.

 l If you are printing to a physical printer, the Print window appears. Confirm your printer 
selection and the number of copies to print, and then click OK. Otherwise, click Cancel or 
Setup.

 l If you are printing to the screen (preview), the report appears in a new window. You can print 
the report or export it to a file.     

Note: For Web-based clients, the preview screen appears first when you click the Print button.

 l If you are printing to a file, the Export window appears. Specify the file format (for example, PDF, 
DOC, or XLS). Also, specify a destination for the file:

 l Application. View the report in an application that can open files of the specified format 
(for example, if you specify PDF as the file format, the report opens in Adobe Acrobat). 
You can then save the file.

 l Disk file. Save the report to a location you specify.

 l Microsoft Mail. Send the report as an e-mail attachment.

You can enter the name of a non-existent file or directory to be created by the system when you 
print. When you print to a file, the report is assigned a unique name, for example, CS1000.TXT.

 l If you are printing to e-mail, an e-mail message appears with the report attached.

Printing the A/R Recurring Charges Report

The Recurring Charges report lists the customers, dates, terms, amounts, distribution codes, and 
summary details entered for the recurring charges you regularly invoice to customers.

Note: You can print this report only if   you select the Process Recurring Charges option on the 
A/R Options screen.

For more information, see "A/R Recurring Charges Report" (page 459).

When to Print

Print the report when you add, change, or delete recurring charges.
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Before You Start

 l Verify the print destination and, if necessary, turn on and connect the printer.

To print the A/R Recurring Charges report:

 1. Open Accounts Receivable > A/R Customer Reports > Recurring Charges.

 2. Select a range of recurring   charge codes.

 3. Select a range of customer   numbers. 

 4. Under Include, specify additional information to include in the report. You can include schedules, 
sales split information, and optional fields.

 5. Click Print.

 l If you are printing to a physical printer, the Print window appears. Confirm your printer 
selection and the number of copies to print, and then click OK. Otherwise, click Cancel or 
Setup.

 l If you are printing to the screen (preview), the report appears in a new window. You can print 
the report or export it to a file.     

Note: For Web-based clients, the preview screen appears first when you click the Print button.

 l If you are printing to a file, the Export window appears. Specify the file format (for example, PDF, 
DOC, or XLS). Also, specify a destination for the file:

 l Application. View the report in an application that can open files of the specified format 
(for example, if you specify PDF as the file format, the report opens in Adobe Acrobat). 
You can then save the file.

 l Disk file. Save the report to a location you specify.

 l Microsoft Mail. Send the report as an e-mail attachment.

You can enter the name of a non-existent file or directory to be created by the system when you 
print. When you print to a file, the report is assigned a unique name, for example, CS1000.TXT.

 l If you are printing to e-mail, an e-mail message appears with the report attached.

Printing the A/R Ship-To Locations Report

The A/R Ship-To Locations report lists the ship-to locations (alternate addresses) used by your 
customers.

For more information, see "A/R Ship-To Locations Report" (page 459).

When to Print

Print the report when you add, change, or delete ship-to locations. 
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Before You Start

 l Verify the print destination and, if necessary, turn on and connect the printer.

To print the report:

 1. Open Accounts Receivable > A/R Customer Reports > Ship-To Locations.

 2. Specify whether to include address information (address, telephone and fax numbers, short name, 
and   contact), profiles (price list, territory code, shipping instructions,   and tax information), and/or 
optional fields for the ship-to locations.

 3. Select a range of customer numbers to include in the report.

 4. Click Print.

 l If you are printing to a physical printer, the Print window appears. Confirm your printer 
selection and the number of copies to print, and then click OK. Otherwise, click Cancel or 
Setup.

 l If you are printing to the screen (preview), the report appears in a new window. You can print 
the report or export it to a file.     

Note: For Web-based clients, the preview screen appears first when you click the Print button.

 l If you are printing to a file, the Export window appears. Specify the file format (for example, PDF, 
DOC, or XLS). Also, specify a destination for the file:

 l Application. View the report in an application that can open files of the specified format 
(for example, if you specify PDF as the file format, the report opens in Adobe Acrobat). 
You can then save the file.

 l Disk file. Save the report to a location you specify.

 l Microsoft Mail. Send the report as an e-mail attachment.

You can enter the name of a non-existent file or directory to be created by the system when you 
print. When you print to a file, the report is assigned a unique name, for example, CS1000.TXT.

 l If you are printing to e-mail, an e-mail message appears with the report attached.

Printing Setup Reports
Use the screens in the A/R Setup Reports folder to print reports of Accounts Receivable options and 
setup records.

309Sage 300 2023 Accounts Receivable User's Guide



Printing the A/R Account Sets Report

The Account Sets report lists the descriptions and   numbers of the general ledger accounts used in the 
account sets in your   Accounts Receivable system.

For more information, see "A/R Account Sets Report" (page 553).

When to Print

Print the report when you add, change, or   delete account sets. 

Before You Start

 l Verify the print destination and, if necessary, turn on and connect the printer.

To print the A/R Account Sets report:

 1. Open Accounts Receivable > A/R Setup Reports > Account Sets.

 2. Select the range of account sets to print. The default range includes all account sets.

 3. Click Print.

 l If you are printing to a physical printer, the Print window appears. Confirm your printer 
selection and the number of copies to print, and then click OK. Otherwise, click Cancel or 
Setup.

 l If you are printing to the screen (preview), the report appears in a new window. You can print 
the report or export it to a file.     

Note: For Web-based clients, the preview screen appears first when you click the Print button.

 l If you are printing to a file, the Export window appears. Specify the file format (for example, PDF, 
DOC, or XLS). Also, specify a destination for the file:

 l Application. View the report in an application that can open files of the specified format 
(for example, if you specify PDF as the file format, the report opens in Adobe Acrobat). 
You can then save the file.

 l Disk file. Save the report to a location you specify.

 l Microsoft Mail. Send the report as an e-mail attachment.

You can enter the name of a non-existent file or directory to be created by the system when you 
print. When you print to a file, the report is assigned a unique name, for example, CS1000.TXT.

 l If you are printing to e-mail, an e-mail message appears with the report attached.

310Sage 300 2023 Accounts Receivable User's Guide



Printing the A/R Billing Cycles Report

The Billing Cycles report lists the billing cycle records used in your Accounts Receivable system to 
specify the time intervals at which you charge interest, print statements, and write off transactions for the 
customers in each cycle. If you charge interest by billing cycle, the frequency is also used in calculating 
interest.

For more information, see "A/R Billing Cycles Report" (page 554).

When to Print

Print the Billing Cycles report when you add, change, or delete billing cycles.

Before You Start

 l Verify the print destination and, if necessary, turn on and connect the printer.

To print the A/R Billing Cycles report:

 1. Open Accounts Receivable > A/R Setup Reports > Billing Cycles.

 2. Select the range of billing cycles to print.

 3. Click Print.

 l If you are printing to a physical printer, the Print window appears. Confirm your printer 
selection and the number of copies to print, and then click OK. Otherwise, click Cancel or 
Setup.

 l If you are printing to the screen (preview), the report appears in a new window. You can print 
the report or export it to a file.     

Note: For Web-based clients, the preview screen appears first when you click the Print button.

 l If you are printing to a file, the Export window appears. Specify the file format (for example, PDF, 
DOC, or XLS). Also, specify a destination for the file:

 l Application. View the report in an application that can open files of the specified format 
(for example, if you specify PDF as the file format, the report opens in Adobe Acrobat). 
You can then save the file.

 l Disk file. Save the report to a location you specify.

 l Microsoft Mail. Send the report as an e-mail attachment.

You can enter the name of a non-existent file or directory to be created by the system when you 
print. When you print to a file, the report is assigned a unique name, for example, CS1000.TXT.

 l If you are printing to e-mail, an e-mail message appears with the report attached.
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Printing the A/R Comment Types Report

The Comment Types report lists the comment types that are set up for use with Accounts Receivable 
customer records.

For more information, see "A/R Comment Types Report" (page 555).

When to Print

Print the report when you add, change,   or delete comment type records. 

Before You Start

 l Verify the print destination and, if necessary, turn on and connect the printer.

To print the A/R Comment Types report:

 1. Open Accounts Receivable > A/R Setup Reports > Comment Types.

 2. Select the range of comment   types to print. The default range includes all comment types.

 3. Click Print.

 l If you are printing to a physical printer, the Print window appears. Confirm your printer 
selection and the number of copies to print, and then click OK. Otherwise, click Cancel or 
Setup.

 l If you are printing to the screen (preview), the report appears in a new window. You can print 
the report or export it to a file.     

Note: For Web-based clients, the preview screen appears first when you click the Print button.

 l If you are printing to a file, the Export window appears. Specify the file format (for example, PDF, 
DOC, or XLS). Also, specify a destination for the file:

 l Application. View the report in an application that can open files of the specified format 
(for example, if you specify PDF as the file format, the report opens in Adobe Acrobat). 
You can then save the file.

 l Disk file. Save the report to a location you specify.

 l Microsoft Mail. Send the report as an e-mail attachment.

You can enter the name of a non-existent file or directory to be created by the system when you 
print. When you print to a file, the report is assigned a unique name, for example, CS1000.TXT.

 l If you are printing to e-mail, an e-mail message appears with the report attached.

312Sage 300 2023 Accounts Receivable User's Guide



Printing the A/R Distribution Codes Report

The Distribution Codes report lists the descriptions and numbers of the general ledger accounts used in 
the distribution codes in your Accounts Receivable system.

For more information, see "A/R Distribution Codes Report" (page 556).

When to Print

Print the report after adding, modifying, or deleting distribution codes.

Before You Start

 l Verify the print destination and, if necessary, turn on and connect the printer.

To print the A/R Distribution Codes report:

 1. Open Accounts Receivable > A/R Setup Reports > Distribution Codes.

 2. Select the range of distribution codes to print.

 3. Click Print.

 l If you are printing to a physical printer, the Print window appears. Confirm your printer 
selection and the number of copies to print, and then click OK. Otherwise, click Cancel or 
Setup.

 l If you are printing to the screen (preview), the report appears in a new window. You can print 
the report or export it to a file.     

Note: For Web-based clients, the preview screen appears first when you click the Print button.

 l If you are printing to a file, the Export window appears. Specify the file format (for example, PDF, 
DOC, or XLS). Also, specify a destination for the file:

 l Application. View the report in an application that can open files of the specified format 
(for example, if you specify PDF as the file format, the report opens in Adobe Acrobat). 
You can then save the file.

 l Disk file. Save the report to a location you specify.

 l Microsoft Mail. Send the report as an e-mail attachment.

You can enter the name of a non-existent file or directory to be created by the system when you 
print. When you print to a file, the report is assigned a unique name, for example, CS1000.TXT.

 l If you are printing to e-mail, an e-mail message appears with the report attached.
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Printing the A/R Dunning Messages Report

The Dunning Messages report lists the sets of messages or comments you print on customer statements, 
usually regarding the status of the account. You can assign a different message for each of the five 
periods into which Accounts Receivable ages (groups) transactions by date on statements and on the 
Customer Transactions, Aged Trial Balance, and Overdue Receivables   reports.

For more information, see "A/R Dunning Messages Report" (page 556).

When to Print

Print the report when you add, change, or delete dunning messages.

Before You Start

 l Verify the print destination and, if necessary, turn on and connect the printer.

To print the A/R Dunning Messages report:

 1. Open Accounts Receivable > A/R Setup Reports > Dunning Messages.

 2. Click Print.

 l If you are printing to a physical printer, the Print window appears. Confirm your printer 
selection and the number of copies to print, and then click OK. Otherwise, click Cancel or 
Setup.

 l If you are printing to the screen (preview), the report appears in a new window. You can print 
the report or export it to a file.     

Note: For Web-based clients, the preview screen appears first when you click the Print button.

 l If you are printing to a file, the Export window appears. Specify the file format (for example, PDF, 
DOC, or XLS). Also, specify a destination for the file:

 l Application. View the report in an application that can open files of the specified format 
(for example, if you specify PDF as the file format, the report opens in Adobe Acrobat). 
You can then save the file.

 l Disk file. Save the report to a location you specify.

 l Microsoft Mail. Send the report as an e-mail attachment.

You can enter the name of a non-existent file or directory to be created by the system when you 
print. When you print to a file, the report is assigned a unique name, for example, CS1000.TXT.

 l If you are printing to e-mail, an e-mail message appears with the report attached.
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Printing the A/R E-mail Messages Report

The E-mail Messages report lists the messages you send to customers with e-mailed statements and 
invoices.

For more information, see "A/R E-mail Messages Report" (page 557).

When to Print

Print the report when you add, change, or delete e-mail messages. 

Before You Start

 l Verify the print destination and, if necessary, turn on and connect the printer.

To print the A/R E-mail Messages report:

 1. Open Accounts Receivable > A/R Setup Reports > E-mail Messages.

 2. Click Print.

 l If you are printing to a physical printer, the Print window appears. Confirm your printer 
selection and the number of copies to print, and then click OK. Otherwise, click Cancel or 
Setup.

 l If you are printing to the screen (preview), the report appears in a new window. You can print 
the report or export it to a file.     

Note: For Web-based clients, the preview screen appears first when you click the Print button.

 l If you are printing to a file, the Export window appears. Specify the file format (for example, PDF, 
DOC, or XLS). Also, specify a destination for the file:

 l Application. View the report in an application that can open files of the specified format 
(for example, if you specify PDF as the file format, the report opens in Adobe Acrobat). 
You can then save the file.

 l Disk file. Save the report to a location you specify.

 l Microsoft Mail. Send the report as an e-mail attachment.

You can enter the name of a non-existent file or directory to be created by the system when you 
print. When you print to a file, the report is assigned a unique name, for example, CS1000.TXT.

 l If you are printing to e-mail, an e-mail message appears with the report attached.
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Printing the A/R G/L Integration Report

The G/L Integration report lists the options and other information entered on the G/L Integration screen 
that determine how your Accounts Receivable system interacts with General Ledger.

For more information about this report, see "A/R G/L Integration Report" (page 558).

When to Print

Print the report when you change the G/L Integration options for Accounts Receivable.

Before You Start

 l Verify the print destination and, if necessary, turn on and connect the printer.

To print the A/R G/L Integration report:

 1. Open Accounts Receivable > A/R Setup Reports > G/L Integration.

 2. Click Print.

 l If you are printing to a physical printer, the Print window appears. Confirm your printer 
selection and the number of copies to print, and then click OK. Otherwise, click Cancel or 
Setup.

 l If you are printing to the screen (preview), the report appears in a new window. You can print 
the report or export it to a file.     

Note: For Web-based clients, the preview screen appears first when you click the Print button.

 l If you are printing to a file, the Export window appears. Specify the file format (for example, PDF, 
DOC, or XLS). Also, specify a destination for the file:

 l Application. View the report in an application that can open files of the specified format 
(for example, if you specify PDF as the file format, the report opens in Adobe Acrobat). 
You can then save the file.

 l Disk file. Save the report to a location you specify.

 l Microsoft Mail. Send the report as an e-mail attachment.

You can enter the name of a non-existent file or directory to be created by the system when you 
print. When you print to a file, the report is assigned a unique name, for example, CS1000.TXT.

 l If you are printing to e-mail, an e-mail message appears with the report attached.
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Printing the A/R Interest Profiles Report

The Interest Profiles report lists the information entered to define the interest profiles used in your 
Accounts Receivable system. 

You assign an interest profile to each customer record to specify the method, timing, and rates used to 
charge interest on the customer's overdue documents or balance.

For more information, see "A/R Interest Profiles Report" (page 559).

When to Print

Print the report when you add, change, or delete interest profiles.

Before You Start

 l Verify the print destination and, if necessary, turn on and connect the printer.

To print the A/R Interest Profiles report:

 1. Open Accounts Receivable > A/R Setup Reports > Interest Profiles.

 2. Select the range of interest   profile codes to include on the report.

 3. Click Print.

 l If you are printing to a physical printer, the Print window appears. Confirm your printer 
selection and the number of copies to print, and then click OK. Otherwise, click Cancel or 
Setup.

 l If you are printing to the screen (preview), the report appears in a new window. You can print 
the report or export it to a file.     

Note: For Web-based clients, the preview screen appears first when you click the Print button.

 l If you are printing to a file, the Export window appears. Specify the file format (for example, PDF, 
DOC, or XLS). Also, specify a destination for the file:

 l Application. View the report in an application that can open files of the specified format 
(for example, if you specify PDF as the file format, the report opens in Adobe Acrobat). 
You can then save the file.

 l Disk file. Save the report to a location you specify.

 l Microsoft Mail. Send the report as an e-mail attachment.

You can enter the name of a non-existent file or directory to be created by the system when you 
print. When you print to a file, the report is assigned a unique name, for example, CS1000.TXT.

 l If you are printing to e-mail, an e-mail message appears with the report attached.
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Printing the A/R Items Report

The A/R Items report lists information about the inventory items (goods or services) used in your 
Accounts Receivable system.

For more information, see "A/R Items Report" (page 560).

When to Print

Print the report when you add, change, or delete items.

Before You Start

 l Verify the print destination and, if necessary, turn on and connect the printer.

To print the A/R Items report:

 1. Open Accounts Receivable > A/R Setup Reports > Items.

 2. Specify whether to include item cost, item comments, and/or tax information.

 3. Select a range of items to include in the report.

 4. If you use multicurrency accounting, select a range of currency codes to include in the report.

 5. Click Print.

 l If you are printing to a physical printer, the Print window appears. Confirm your printer 
selection and the number of copies to print, and then click OK. Otherwise, click Cancel or 
Setup.

 l If you are printing to the screen (preview), the report appears in a new window. You can print 
the report or export it to a file.     

Note: For Web-based clients, the preview screen appears first when you click the Print button.

 l If you are printing to a file, the Export window appears. Specify the file format (for example, PDF, 
DOC, or XLS). Also, specify a destination for the file:

 l Application. View the report in an application that can open files of the specified format 
(for example, if you specify PDF as the file format, the report opens in Adobe Acrobat). 
You can then save the file.

 l Disk file. Save the report to a location you specify.

 l Microsoft Mail. Send the report as an e-mail attachment.

You can enter the name of a non-existent file or directory to be created by the system when you 
print. When you print to a file, the report is assigned a unique name, for example, CS1000.TXT.

 l If you are printing to e-mail, an e-mail message appears with the report attached.
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Printing the A/R Optional Fields Report

The Optional Fields report lists the optional fields defined for your Accounts Receivable system.

For more information, see "A/R Optional Fields Report" (page 561).

When to Print

Print the report when you add, delete, or change optional field records. 

Before You Start

 l Verify the print destination and, if necessary, turn on and connect the printer.

To print the A/R Optional Fields report:

 1. Open Accounts Receivable > A/R Setup Reports > Optional Fields .

 2. If you want to view settings for each optional field on the report, select the View Settings option.

 3. Click Print.

 l If you are printing to a physical printer, the Print window appears. Confirm your printer 
selection and the number of copies to print, and then click OK. Otherwise, click Cancel or 
Setup.

 l If you are printing to the screen (preview), the report appears in a new window. You can print 
the report or export it to a file.     

Note: For Web-based clients, the preview screen appears first when you click the Print button.

 l If you are printing to a file, the Export window appears. Specify the file format (for example, PDF, 
DOC, or XLS). Also, specify a destination for the file:

 l Application. View the report in an application that can open files of the specified format 
(for example, if you specify PDF as the file format, the report opens in Adobe Acrobat). 
You can then save the file.

 l Disk file. Save the report to a location you specify.

 l Microsoft Mail. Send the report as an e-mail attachment.

You can enter the name of a non-existent file or directory to be created by the system when you 
print. When you print to a file, the report is assigned a unique name, for example, CS1000.TXT.

 l If you are printing to e-mail, an e-mail message appears with the report attached.
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Printing the A/R Options Report

The Options report lists the options selected and other information entered on the A/R Options screen to 
specify how your Accounts Receivable system operates.

For more information, see "A/R Options Report" (page 561).

When to Print

Print the report when you change your selections for Accounts Receivable   options.

Before You Start

 l Verify the print destination and, if necessary, turn on and connect the printer.

To print the A/R Options report:

 1. Open Accounts Receivable > A/R Setup Reports > Options.

 2. Click Print.

 l If you are printing to a physical printer, the Print window appears. Confirm your printer 
selection and the number of copies to print, and then click OK. Otherwise, click Cancel or 
Setup.

 l If you are printing to the screen (preview), the report appears in a new window. You can print 
the report or export it to a file.     

Note: For Web-based clients, the preview screen appears first when you click the Print button.

 l If you are printing to a file, the Export window appears. Specify the file format (for example, PDF, 
DOC, or XLS). Also, specify a destination for the file:

 l Application. View the report in an application that can open files of the specified format 
(for example, if you specify PDF as the file format, the report opens in Adobe Acrobat). 
You can then save the file.

 l Disk file. Save the report to a location you specify.

 l Microsoft Mail. Send the report as an e-mail attachment.

You can enter the name of a non-existent file or directory to be created by the system when you 
print. When you print to a file, the report is assigned a unique name, for example, CS1000.TXT.

 l If you are printing to e-mail, an e-mail message appears with the report attached.
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Printing the A/R Payment Codes Report

The Payment Codes report lists the codes, descriptions, and methods of payment used in your Accounts 
Receivable system.

For more information, see "A/R Payment Codes Report" (page 562).

When to Print

Print the report when you add, change, or delete payment codes. 

Before You Start

 l Verify the print destination and, if necessary, turn on and connect the printer.

To print the A/R Payment Codes report:

 1. Open Accounts Receivable > A/R Setup Reports > Payment Codes.

 2. Click Print.

 l If you are printing to a physical printer, the Print window appears. Confirm your printer 
selection and the number of copies to print, and then click OK. Otherwise, click Cancel or 
Setup.

 l If you are printing to the screen (preview), the report appears in a new window. You can print 
the report or export it to a file.     

Note: For Web-based clients, the preview screen appears first when you click the Print button.

 l If you are printing to a file, the Export window appears. Specify the file format (for example, PDF, 
DOC, or XLS). Also, specify a destination for the file:

 l Application. View the report in an application that can open files of the specified format 
(for example, if you specify PDF as the file format, the report opens in Adobe Acrobat). 
You can then save the file.

 l Disk file. Save the report to a location you specify.

 l Microsoft Mail. Send the report as an e-mail attachment.

You can enter the name of a non-existent file or directory to be created by the system when you 
print. When you print to a file, the report is assigned a unique name, for example, CS1000.TXT.

 l If you are printing to e-mail, an e-mail message appears with the report attached.

Printing the A/R Salespersons Reports

You can print two reports using the Salespersons report screen:
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 l The Salespersons Profile report lists the salesperson numbers, salesperson names, employee 
numbers, and annual sales targets entered in the salesperson records in your Accounts 
Receivable system. 

 l The Salesperson Statistics report lists the total amount of invoices, receipts, discounts, debit and 
credit notes, write-offs and adjustments, interest charges, and returned checks you have recorded 
for selected salespersons. 

Note: You can print the Salesperson Statistics report only if Accounts Receivable uses the option to 
keep salesperson statistics.

For more information, see "A/R Salespersons Report" (page 563).

When to Print

Print the report when you add, change, or delete salesperson records. 

Before You Start

 l Verify the print destination and, if necessary, turn on and connect the printer.

To print the A/R Salesperson Statistics report:

 1. Open Accounts Receivable > A/R Setup Reports > Salespersons.

 2. From the Report Type list, select Salesperson Statistics.

 3. Select a range of salesperson   numbers to include on the report.

 4. Select ranges of years and periods for which to report   statistics. Accounts Receivable uses the 
types of year and periods specified   for salesperson statistics on the A/R Options screen.

 5. Click Print.

 l If you are printing to a physical printer, the Print window appears. Confirm your printer 
selection and the number of copies to print, and then click OK. Otherwise, click Cancel or 
Setup.

 l If you are printing to the screen (preview), the report appears in a new window. You can print 
the report or export it to a file.     

Note: For Web-based clients, the preview screen appears first when you click the Print button.

 l If you are printing to a file, the Export window appears. Specify the file format (for example, PDF, 
DOC, or XLS). Also, specify a destination for the file:

 l Application. View the report in an application that can open files of the specified format 
(for example, if you specify PDF as the file format, the report opens in Adobe Acrobat). 
You can then save the file.
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 l Disk file. Save the report to a location you specify.

 l Microsoft Mail. Send the report as an e-mail attachment.

You can enter the name of a non-existent file or directory to be created by the system when you 
print. When you print to a file, the report is assigned a unique name, for example, CS1000.TXT.

 l If you are printing to e-mail, an e-mail message appears with the report attached.

To print the A/R Salesperson Profile report:

 1. Open Accounts Receivable > A/R Setup Reports > Salespersons.

 2. From the Report Type list, select Salesperson Profile.

 3. Select a range of salesperson numbers to include on the report.

 4. If you want to view commission rates for salespersons, select the Include Commission Rates 
option.

 5. Click Print.

 l If you are printing to a physical printer, the Print window appears. Confirm your printer 
selection and the number of copies to print, and then click OK. Otherwise, click Cancel or 
Setup.

 l If you are printing to the screen (preview), the report appears in a new window. You can print 
the report or export it to a file.     

Note: For Web-based clients, the preview screen appears first when you click the Print button.

 l If you are printing to a file, the Export window appears. Specify the file format (for example, PDF, 
DOC, or XLS). Also, specify a destination for the file:

 l Application. View the report in an application that can open files of the specified format 
(for example, if you specify PDF as the file format, the report opens in Adobe Acrobat). 
You can then save the file.

 l Disk file. Save the report to a location you specify.

 l Microsoft Mail. Send the report as an e-mail attachment.

You can enter the name of a non-existent file or directory to be created by the system when you 
print. When you print to a file, the report is assigned a unique name, for example, CS1000.TXT.

 l If you are printing to e-mail, an e-mail message appears with the report attached.

Printing the A/R Terms Codes Report

The Terms Codes report lists the information entered for each terms code to specify how to calculate due 
dates, discount amounts, and discount periods on invoices that use the code.

For more information, see "A/R Terms Codes Report" (page 564).
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When to Print

Print the report when you add, change, or delete terms codes. 

Before You Start

 l Verify the print destination and, if necessary, turn on and connect the printer.

To print the A/R Terms Codes report:

 1. Open Accounts Receivable > A/R Setup Reports > Terms Codes.

 2. Select the range of terms   codes to include in the report.

 3. If you have created terms codes that use multiple payment schedules, select the Include Multiple   
Payment Schedules option.

 4. Click Print.

 l If you are printing to a physical printer, the Print window appears. Confirm your printer 
selection and the number of copies to print, and then click OK. Otherwise, click Cancel or 
Setup.

 l If you are printing to the screen (preview), the report appears in a new window. You can print 
the report or export it to a file.     

Note: For Web-based clients, the preview screen appears first when you click the Print button.

 l If you are printing to a file, the Export window appears. Specify the file format (for example, PDF, 
DOC, or XLS). Also, specify a destination for the file:

 l Application. View the report in an application that can open files of the specified format 
(for example, if you specify PDF as the file format, the report opens in Adobe Acrobat). 
You can then save the file.

 l Disk file. Save the report to a location you specify.

 l Microsoft Mail. Send the report as an e-mail attachment.

You can enter the name of a non-existent file or directory to be created by the system when you 
print. When you print to a file, the report is assigned a unique name, for example, CS1000.TXT.

 l If you are printing to e-mail, an e-mail message appears with the report attached.

Printing Transactions Reports
Use the screens in the A/R Transactions Reports folder to print a variety of transaction reports to maintain 
your audit trail and to analyze Accounts Receivable data.
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Printing the A/R Aged Retainage Report

The Aged Retainage report lists outstanding retainage amounts.

Note: It does not include retainage that has been invoiced or applied to a debit note or a credit note.

In multicurrency ledgers, you can print the report in your functional currency or in the customer currencies 
used in posted transactions.

For more information, see "A/R Aged Retainage Report" (page 690).

When to Print

Print the report periodically, or whenever you want to analyze outstanding retainage. 

Before You Start

 l Verify the print destination and, if necessary, turn on and connect the printer.

To print the A/R Aged Retainage report:

 1. Open Accounts Receivable > A/R Transaction Reports > Aged Retainage.

 2. Select report options. More...

 l Report Type. You can choose the following options:

 l Aged Retainage By Due Date. Print a report that shows all outstanding retainage 
amounts that are due for each aging period, including Future and Current.     

For job-related documents, if one of the document details is due in a future period, the 
outstanding retainage amount for that detail appears  in the Future period.

 l Future Retainage By Due Date. Print a report that shows outstanding retainage 
amounts that are due in future aging periods, beginning with the Age As Of date.

 l Overdue Retainage By Due Date. Print a report that shows only outstanding 
retainage amounts that became overdue in each aging period.

 l Age As Of. Specify the date on which to report the retainage. The program uses this date to 
assign retainage to an aging period by calculating the number of days between its due date 
and the date entered in the Age As Of field.

 l Cutoff By. The report includes only those transactions or balances that have a due date before or 
on the cutoff date you specify. There are three methods for selecting a cutoff date:

 l Document Date. Select this option to include documents based on their document 
date (regardless of the fiscal period to which you assigned them). Enter a date in the 
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Cutoff Date field. If you enter zeros for the month, day, and year, the report includes all 
transactions, regardless of date.

 l Posting Date. Select this option to include documents based on their posting date. 
Enter a date in the Cutoff Date field. If you enter zeros for the month,   day, and year, 
the report includes all transactions, regardless of date.

 l Year/Period. Use this method if you want to include all transactions up to the end of a 
fiscal period. Make your selections in the Year and Period fields.

 l Print Transactions In. Indicate whether to print a summary or a detailed report, and whether 
to print the detailed version of the report by document   date (Detail By Document Date), by 
due date (Detail By Retainage Due Date),   or by document number (Detail By Document).

 l Use Aging Periods. Aging periods are used to group outstanding retainage amount. The 
aging   periods entered on the A/R Options screen appear, but you can assign different   
periods for individual reports.

 l On the Aged Retainage   By Due Date report, all outstanding   retainage amounts are 
grouped according to the dates on which they become   due.

 l On the Overdue Retainage   By Due Date reports, overdue   outstanding retainage 
amounts are grouped according to the dates on which   they became due.

 l On the Future Retainage   By Due Date report, outstanding retainage amounts are 
grouped according   to the future dates at which they will become due. 

 l Select By. Specify up to four selection criteria, to indicate the customer accounts   to list on 
the report. If you do not specify selection criteria, the report   includes amounts for all 
customers that use the account type you select.

 l Sort By. You   can choose up to four orders by which to list (sort) records for the report.   If you 
do not specify sorting criteria, the report orders the records   by customer number.

 l Title. If   you want to include titles for each sorted group, select this option   for groups of 
records you are sorting by.

 l Total. If you want to include totals for each sorted group, select this option for groups of 
records you are sorting by.

 l Include Taxes. Select this option to include tax information on the report.

 l Print Amounts In. Use this option to select the currency for the report. You can list 
transaction amounts in the customer currency or the   functional currency.

If you list transactions in the functional currency,   and you have performed a revaluation, the report 
shows the new functional   amounts.

 3. Click Print.

 l If you are printing to a physical printer, the Print window appears. Confirm your printer 
selection and the number of copies to print, and then click OK. Otherwise, click Cancel or 
Setup.
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 l If you are printing to the screen (preview), the report appears in a new window. You can print 
the report or export it to a file.     

Note: For Web-based clients, the preview screen appears first when you click the Print button.

 l If you are printing to a file, the Export window appears. Specify the file format (for example, PDF, 
DOC, or XLS). Also, specify a destination for the file:

 l Application. View the report in an application that can open files of the specified format 
(for example, if you specify PDF as the file format, the report opens in Adobe Acrobat). 
You can then save the file.

 l Disk file. Save the report to a location you specify.

 l Microsoft Mail. Send the report as an e-mail attachment.

You can enter the name of a non-existent file or directory to be created by the system when you 
print. When you print to a file, the report is assigned a unique name, for example, CS1000.TXT.

 l If you are printing to e-mail, an e-mail message appears with the report attached.

Printing the A/R Aged Trial Balance Report

The Aged Trial Balance report groups outstanding transactions or balances into a current period and four 
aging periods by document date or due date. Use the report to analyze your receivables.

You can print the report in detailed form, listing all outstanding documents for each customer, or 
summary form, printing one line for each customer number, including the current balance and the 
balance in each aging period.

If you use optional fields as selection criteria for this report, you can specify the ranges of values from 
which to select records for printing. The report then includes only customers that use the specified 
optional fields, whose values fall within the specified range.

For more information, see "A/R Aged Trial Balance Report" (page 691).

When to Print

Print the Aged Trial Balance report when you need a listing of the status of your receivables on a given 
date, or when you want to identify documents or balances you may need to write off.

Before You Start

 l Verify the print destination and, if necessary, turn on and connect the printer.
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To print the A/R Aged Trial Balance report:

 1. Open Accounts Receivable > A/R Transaction Reports > Aged Trial Balance.

 2. Select report options. More...

 l Report Type. You can age outstanding documents or balances by their due dates (Aged 
Trial   Balance by Due Date) or document dates (Aged Trial Balance by Document   Date).

 l Age As Of. Specify the date on which to report the receivables. The program uses   this date 
to assign transactions or balances to aging periods. For example,   if you print the Aged Trial 
Balance by Due Date report, the program assigns each   transaction to an aging period by 
calculating the number of days between   its due date and the Age As Of date.

 l Cutoff By. The report includes only transactions or balances for which the document   date, 
posting date, or year/period (depending on your selection for this   field) is before or on the 
cutoff date you specify. 

There are three methods for selecting a cutoff date:

 l Document Date. Select this option to include documents based on their   document 
date (regardless of the fiscal period to which you assigned them).   Enter a date in the 
Cutoff Date field. If you enter zeros for the month,   day, and year, the report includes all 
transactions, regardless of date.

 l Posting Date. Select this option to include documents based on their   posting date. 
Enter a date in the Cutoff Date field. If you enter zeros   for the month, day, and year, 
the report includes all transactions, regardless   of date.

 l Year/Period. Use this method if you want to include all transactions   up to the end of a 
fiscal period. Make your selections in the Year and   Period fields.

 l Account Type.   You can list only Open Item or Balance Forward customers, or All 
Customers.

 l Print Transactions In. Indicate whether to print a summary or detailed   report, and whether to 
print the detailed version of the report by document   date (Detail by Document Date) or by 
document number (Detail by Document).

 l Use Aging Periods. The aging periods entered on the A/R Options screen appear, but you 
can assign   different periods for individual reports, if you want.

 l Select Customers By. Specify up to four selection criteria  to indicate the customer accounts 
to list on the report.

If you do not specify selection criteria, the report   includes all customer records with the account 
type you select.

 l Sort Customers By.  Specify up to four criteria by which to sort records in the report. 

If you do not specify sorting criteria, the report   orders the records by customer number.

 l Title. If you want   to include titles for each sorted group, select this option for groups   of 
records you are sorting by.
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 l Total. If you want to include totals for   each sorted group, select this option for groups of 
records you are sorting by.

 l Include. Select options to include various types of customer information in the report.

 l Select Transaction   Types. Select the types of transactions   to include on the report.

Note: If you select Adjustment, adjustments are listed separately   from the transactions to 
which they were applied.

 l Show. Select options to specify information that will appear on the report.

 l Applied Details. Include all the documents such as receipts   and credit notes that were 
applied to each reported invoice. If you do   not select this option, the report shows only 
the balance owing for each   outstanding transaction. 

 l Fully Paid  Transactions. List documents that are fully   paid, but not yet cleared from 
Accounts Receivable.

If you select this option, you can specify the earliest   date for which to show fully paid 
transactions, if you want to see only   recent fully paid transactions.

 l Aged   Retainage. Select this option   to include aged retainage balances for each 
customer. (This option appears   only if you are printing the report by due date.)

 l Sort Transactions By Transaction   Type. Select   this option if you want to sort transactions 
by type for each customer.

 l Print Amounts In.   If you use multicurrency accounting, select the currency for the report. 
You can list transaction   amounts in the customer currency or your company's functional 
currency.

If you list transactions in the functional currency,   and you have performed a revaluation, the report 
shows the new functional   amounts.

 3. Click Print.

 l If you are printing to a physical printer, the Print window appears. Confirm your printer 
selection and the number of copies to print, and then click OK. Otherwise, click Cancel or 
Setup.

 l If you are printing to the screen (preview), the report appears in a new window. You can print 
the report or export it to a file.     

Note: For Web-based clients, the preview screen appears first when you click the Print button.

 l If you are printing to a file, the Export window appears. Specify the file format (for example, PDF, 
DOC, or XLS). Also, specify a destination for the file:

 l Application. View the report in an application that can open files of the specified format 
(for example, if you specify PDF as the file format, the report opens in Adobe Acrobat). 
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You can then save the file.

 l Disk file. Save the report to a location you specify.

 l Microsoft Mail. Send the report as an e-mail attachment.

You can enter the name of a non-existent file or directory to be created by the system when you 
print. When you print to a file, the report is assigned a unique name, for example, CS1000.TXT.

 l If you are printing to e-mail, an e-mail message appears with the report attached.

Printing Batch Listings

A batch listing is the printed record of the transactions in an open or posted batch.

You can print batch listings for invoice, receipt, refund, and adjustment batches that have been entered, 
imported, generated, or created by another Sage 300 program for Accounts Receivable (External 
batches). More...

The invoice batch listing includes debit notes and credit notes, as well as batches of interest charges and 
recurring charges. The adjustment batch listing includes batches of write-off transactions produced by 
the A/R Create Write-Off Batch screen. You can choose to include details of adjustments you made on 
receipts when you print receipt batch listings.

Notes: 
 l You cannot print batch listings for deleted batches.

 l When you list a batch, its status changes to "Printed" on the Batch Status report and in the 
transaction-entry screens.

When to Print

You should print batch listings after entering, importing, generating, or editing a batch, at any time before 
posting the batch, then file the listings with your other audit trail records.

If you select the Force Listing Of All Batches option on the A/R Options screen, you must print all batch 
listings to a printer or file before you can post the batches.

Before You Start

 l Verify the print destination and, if necessary, turn on and connect the printer.

 l Determine which batches to list.

330Sage 300 2023 Accounts Receivable User's Guide



To print batch listings:

 1. Do one of the following:

 l Open Accounts Receivable > A/R Transaction Reports > Batch Listing.

 l On the Batch List screen, click Print.

 2. Select the type of batches for which to print listings. You can print invoice batches, receipt batches, 
or adjustment batches.

 3. Specify the range of batch numbers to print.

 4. Enter the range of batch creation dates. More...

Click the arrows beside the From and the To date fields in turn, display the required month, then click 
the date you want to use for the range. The default range prints all batches from the beginning of the 
current fiscal year to the session date.

 5. Select optional information you want to include. More...

You can select:

 l Reprint Previously Printed Batches. Select this option to include batches you printed 
before.

 l Show Comments. Select this option to include any comments entered with the transactions.

 l Show Adjustment Details.  Select this option to include adjustments on receipt batch 
listings.

 l Show Schedules.  Select this option to include multiple payment schedules on invoice batch 
listings.

 l Show Sales Split.  Select this option to include salesperson information on invoice batch 
listings.

 l Show Tax Details.  Select this option to  print tax details on invoice batch listings and on 
receipt batch listings.

 l Show Job Details.  Select this option to print details for projects, categories, and resources 
related to contracts you maintain in Project and Job Costing on all listings.

 l Show Optional Fields.  Select this option to include optional field information included with 
transactions, if you use optional fields.

 6. Select the types of batches to print. More...

You can select:

 l Entered. Batches created in Accounts Receivable.

 l Imported. Batches you have transferred to Accounts Receivable using the Import (batch) 
choice from the File menu. (These can be batches created by another Sage 300 Accounts 
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Receivable or by a non-Sage 300 program. They could also be recurring batches created in 
your own Accounts Receivable Ledger, then exported for later use.)

 l Generated. Batches created in Accounts Receivable, such as those containing interest or 
write-off transactions, or transactions that were rejected during posting.

 l Recurring. If you are printing invoice batches, you can also print listings of the batches 
created by the Create Recurring Charge Batch screen.

 l External. Batches that you create in other Sage 300 programs, then send to Accounts 
Receivable (for example, invoice batches that you generate in Project and Job Costing or 
Order Entry).

 l Retainage. Batches of retainage invoices. This option appears only if you use retainage 
accounting.

 7. Select the statuses of batches to print. More...

You can select:

 l Open. Unlisted batches, or edited batches that have not been relisted.

 l Ready To Post. Completed batches that are ready for posting.

 l Posted. Batches that have been posted.

 8. Click Print.

 l If you are printing to a physical printer, the Print window appears. Confirm your printer 
selection and the number of copies to print, and then click OK. Otherwise, click Cancel or 
Setup.

 l If you are printing to the screen (preview), the report appears in a new window. You can print 
the report or export it to a file.     

Note: For Web-based clients, the preview screen appears first when you click the Print button.

 l If you are printing to a file, the Export window appears. Specify the file format (for example, PDF, 
DOC, or XLS). Also, specify a destination for the file:

 l Application. View the report in an application that can open files of the specified format 
(for example, if you specify PDF as the file format, the report opens in Adobe Acrobat). 
You can then save the file.

 l Disk file. Save the report to a location you specify.

 l Microsoft Mail. Send the report as an e-mail attachment.

You can enter the name of a non-existent file or directory to be created by the system when you 
print. When you print to a file, the report is assigned a unique name, for example, CS1000.TXT.

 l If you are printing to e-mail, an e-mail message appears with the report attached.
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Tip: You can also print a batch listing for a selected batch from any transaction-entry screen by 
clicking File > Print Batch Listing Report.

After printing a batch listing

 l Verify contents, correct any errors, reprint the edited batches, and then file the listings.

 l Post the batches.

Printing the A/R Batch Status Report

The Batch Status report describes all unposted invoice, adjustment, refund, or receipt batches, and 
posted or deleted batches that have not yet been cleared from Accounts Receivable. The report is a 
valuable management tool to track batches, particularly when several operators are entering batches on 
a multi-user system.

When to Print

Print the report when you need batch information, and before clearing batch status information (details of 
posted and deleted batches), either after printing this report, or at period end.

Note: The A/R Year End screen clears batch status information automatically.

Before You Start

 l Verify the print destination and, if necessary, turn on and connect the printer.

 l Decide on the range of batch numbers, and creation dates, and the batch types and statuses to 
report.

To print the Batch Status report:

 1. Do one of the following:

 l Open Accounts Receivable > A/R Transaction Reports > Batch Status.

 l On the Batch List screen, click File > Print Batch Status Report.

 2. Select a type from the Batch Type list. The choices are Invoice Batches, Receipt Batches, Refund 
Batches, and Adjustment Batches.

 3. Select a range of batch numbers and dates. 

To select the date range, click the arrows beside the From and the To date fields in turn, display the 
required month, then click the date you want to use for the range.
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 4. Specify the type(s) of batches to include. More...

You can choose:

 l Entered. Batches created in Accounts Receivable.

 l Imported. Batches you have transferred to Accounts Receivable using the Import (batch) 
choice from the File menu. (These can be batches created by another Sage 300 Accounts 
Receivable or by a non-Sage 300 program. They could also be recurring batches created in 
your own Accounts Receivable Ledger, then exported for later use.)

 l Generated. Batches created in Accounts Receivable, such as to contain interest or write-off 
transactions, or transactions that were rejected during posting.

 l External. Batches created for Accounts Receivable by another program, such as invoice 
batches sent by Order Entry or by Project and Job Costing.

 l Recurring. When you print the report for invoice batches, you can also select Recurring.

 l Retainage. Batches of retainage invoices. This option appears only if you use retainage 
accounting.

 5. Specify the status of the batches to include. More...

You can choose:

 l Open. Unposted batches that you can edit.

 l Post In Progress. Batches for which posting has begun. You cannot edit or print the batch.

 l Deleted. Batches which were deleted.

 l Posted. Batches which have been posted.

 l Ready To Post. Completed batches that are ready for posting.

 6. Click Print.

 l If you are printing to a physical printer, the Print window appears. Confirm your printer 
selection and the number of copies to print, and then click OK. Otherwise, click Cancel or 
Setup.

 l If you are printing to the screen (preview), the report appears in a new window. You can print 
the report or export it to a file.     

Note: For Web-based clients, the preview screen appears first when you click the Print button.

 l If you are printing to a file, the Export window appears. Specify the file format (for example, PDF, 
DOC, or XLS). Also, specify a destination for the file:

 l Application. View the report in an application that can open files of the specified format 
(for example, if you specify PDF as the file format, the report opens in Adobe Acrobat). 
You can then save the file.

 l Disk file. Save the report to a location you specify.
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 l Microsoft Mail. Send the report as an e-mail attachment.

You can enter the name of a non-existent file or directory to be created by the system when you 
print. When you print to a file, the report is assigned a unique name, for example, CS1000.TXT.

 l If you are printing to e-mail, an e-mail message appears with the report attached.

Printing the A/R Customer Transactions Report

This report lists transactions that were posted to customer accounts during the current period and in the 
period for which you keep transaction history. Use the report to obtain an overview of the current status of 
your customer accounts.

Before You Start

 l Update account information by entering, importing, and posting outstanding batches.

 l Verify the print destination and, if necessary, turn on and connect the printer.

To print the report:

 1. Open Accounts Receivable > A/R Transaction Reports > Customer Transactions.

 2. In the Report Type field, specify whether to list transactions by document date (Customer Transactions 
by Document Date), by document number (Customer Transactions by Document Number), or by fiscal 
year and period (Customer Transactions by Fiscal Year and Period).

 3. Specify the range of documents to include on the report, as follows:     

 l From Document Date... To. If you are printing by document date or document number, 
indicate a range of dates for which to include transactions. Use this option when reporting 
transactions by document date or by document number.

 l From Year/Period... To. Specify the range of fiscal years and periods for which to report 
transactions. Documents entered and posted before or after the year and period range do 
not appear on the report. Use this option when you report transactions by fiscal year and 
period.

 4. Specify the customers for which to print the report, as follows:     

 l Account Type. You can list only Open Item or Balance Forward customers, or All 
Customers.

 l Select Customers By. Specify up to four selection criteria, to indicate the customer accounts 
to list on the report. For the first selection, choose from Customer Number, National Account, 
Customer Group, Billing Cycle, and Short Name.       
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For the remaining three selection criteria choose from the above, plus customer optional fields (if 
any), Territory, Account Set, Currency Code (multicurrency ledgers only), Customer Balance, 
Current Functional Balance (multicurrency ledgers only), Customer Name, Salesperson, Start 
Date.

If you do not specify selection criteria, the report includes all customer records with the account 
type you select.

 l Sort Customers By. You can choose up to four orders by which to list (sort) records for the 
report. You can sort by customer optional fields (if any), Territory, National Account, 
Customer Group, Billing Cycle, Account Set, Currency Code (multicurrency ledgers only), 
Current Balance, Current Functional Balance (multicurrency ledgers only), Customer Name, 
Salesperson, and Short Name. If you do not specify sorting criteria, the report orders the 
records by customer number.       

For the criteria you choose, you can also specify the following:

 l Title. If you want to include titles for each sorted group, select the Title option for 
groups of records you are sorting by.

 l Total. If you want to include totals for each sorted group, select the Total option for 
groups of records you are sorting by.

 5. Select additional information to include on the report, as follows:     

 l [Include] Contact/Phone/Credit. Select this option if you wish to list the customer's contact 
person and the customer's phone number and credit limit.

 l [Include] Space For Comments. Select this option to leave a blank space at the end of each 
customer record for your notes.

 l [Include] Customers With A Zero Balance. Select this option to include accounts with a 
zero balance, for example, to find out which customer accounts are dormant. Note that an 
account could have outstanding transactions even with a zero balance, for example, an 
offsetting invoice and credit note.

 l [Include] Totals By Transaction Type. Select this option to list a total for each transaction 
type (invoices, debit notes, credit notes, unapplied cash, interest, prepayments) after the 
listing for each customer.

 l Select Transaction Types. Select one or more transaction types to include on the report. 
The choices are Invoice, Debit Note, Credit Note, Interest, Unapplied Cash, Receipt, 
Prepayment, and Refund.

 l [Show] Applied Details. Select this option to include all the documents such as receipts and 
credit notes that were applied to each reported invoice. If you do not select this option, the 
statement shows only the balance owing for each document.

 l [Show] Fully Paid Transactions. Select this option to list documents that are fully paid, but 
not yet cleared from Accounts Receivable.
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 l Sort Transactions By Transaction Type. Select this option if you want to group transactions 
by type for each customer.

 l Print Amounts In. If you use multicurrency accounting, use this option to select the currency 
for the report. You can list transaction amounts in the customer currency or the functional 
currency.

 6. Click Print.

 l If you are printing to a physical printer, the Print window appears. Confirm your printer 
selection and the number of copies to print, and then click OK. Otherwise, click Cancel or 
Setup.

 l If you are printing to the screen (preview), the report appears in a new window. You can print 
the report or export it to a file.     

Note: For Web-based clients, the preview screen appears first when you click the Print button.

 l If you are printing to a file, the Export window appears. Specify the file format (for example, PDF, 
DOC, or XLS). Also, specify a destination for the file:

 l Application. View the report in an application that can open files of the specified format 
(for example, if you specify PDF as the file format, the report opens in Adobe Acrobat). 
You can then save the file.

 l Disk file. Save the report to a location you specify.

 l Microsoft Mail. Send the report as an e-mail attachment.

You can enter the name of a non-existent file or directory to be created by the system when you 
print. When you print to a file, the report is assigned a unique name, for example, CS1000.TXT.

 l If you are printing to e-mail, an e-mail message appears with the report attached.

Printing the A/R Deposit Slips Report

The Deposit Slips report lists receipts by deposit number, and groups the receipts by receipt type. In a 
multicurrency ledger, if a deposit includes multiple currencies, the deposits are also grouped by currency.

You can print this report only if you first selected the Allow Printing Of Deposit Slips option on the 
A/R Options screen.

If you select the Create Deposit Slip When Receipt Batch Is Created option (on the A/R Options 
screen), Accounts Receivable automatically assigns a unique deposit slip number to each receipt batch.

Tip: To simplify bank reconciliation at month end, you should prepare a separate deposit slip for each 
receipt batch, rather than combine receipts from more than one batch on a single deposit slip, or vice 
versa.
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When to Print

Print the report when you finish entering a batch of receipts for deposit and are ready to fill out a bank 
deposit slip.

Before You Start

 l Make sure the Allow Printing Of Deposit Slips option is selected on the A/R Options screen.

 l If you use Payment Processing, finish processing credit card payments before you print the deposit slip.

Warning! If the Allow Edit after Deposit Slip Printed option is not selected on the A/R options 
screen, the Charge and Quick Charge buttons are not available after you print the deposit slip, and 
you cannot process the credit card payments.

 l If necessary, change the format for the deposit slip you want to print.

 l Make sure your print destination is set to Printer.

To print the report:

 1. Do one of the following:

 l To print the deposit slip for the batch you are working on, click Deposit in a receipt entry 
screen.

 l To print a deposit slip for a batch you have selected, click Deposit in the Receipt Batch list.

 l To print a range of deposit slips or to print deposit slips after posting their batches, open 
Accounts Receivable > A/R Transaction Reports > Deposit Slips.

 2. In the Use Deposit Slip field, type the name of the format you use for printing deposit slips for the bank. 

You can also click the Browse button, search for the file you need, then double-click it, or highlight it, 
and then press the Enter key to select it.

The default deposit slip form, BKDPST01.RPT, is formatted for laser printers and includes cash and 
check receipts only. 

The form BKDPST02.RPT includes checks, cash, and the other receipt types you use. It also includes a 
form that helps you fill in an official bank deposit slip.

 3. Select additional options, as follows:

Reprint Previously Printed Deposit Slips. Select this option if you want to print new copies of deposit 
slips you printed before.

Bank Code. Accept the displayed bank code or type another bank code or select one from the Finder.
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Select the bank code that matches the bank code in the batches for which you want to print deposit 
slips. If other bank codes are used in the range of batches you specify, Accounts Receivable prints 
deposit slips only for the batches that use the bank code you enter in this field.

From Deposit Number/To Deposit Number. Enter the numbers for the first and last deposits in the 
range for which you want to print deposit slips. You can also select all deposit numbers, or choose the 
first and last deposits using the Finder.

 4. Click Print.

 l If you are printing to a physical printer, the Print window appears. Confirm your printer 
selection and the number of copies to print, and then click OK. Otherwise, click Cancel or 
Setup.

 l If you are printing to the screen (preview), the report appears in a new window. You can print 
the report or export it to a file.     

Note: For Web-based clients, the preview screen appears first when you click the Print button.

 l If you are printing to a file, the Export window appears. Specify the file format (for example, PDF, 
DOC, or XLS). Also, specify a destination for the file:

 l Application. View the report in an application that can open files of the specified format 
(for example, if you specify PDF as the file format, the report opens in Adobe Acrobat). 
You can then save the file.

 l Disk file. Save the report to a location you specify.

 l Microsoft Mail. Send the report as an e-mail attachment.

You can enter the name of a non-existent file or directory to be created by the system when you 
print. When you print to a file, the report is assigned a unique name, for example, CS1000.TXT.

 l If you are printing to e-mail, an e-mail message appears with the report attached.

Printing the A/R G/L Transactions Report

The G/L Transactions report is a list of the general ledger transactions created from all posted Accounts 
Receivable batches and revaluations (in multicurrency ledgers). 

If you do not use Sage 300 General Ledger, Accounts Receivable creates   the general ledger batches in a 
CSV (Comma Separated Values) file, tailored   to the Sage 300 General Ledger format. You can send the 
file to a remote   location that uses Sage 300 General Ledger, or modify the information   in the file to suit 
another general ledger program. 

You can print detailed or summary versions of the report. For more information, see "A/R G/L Transactions 
Report" (page 698).
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Before You Start

 l Verify the print destination and, if necessary, turn on and connect the printer.

To print the A/R G/L Transactions report:

 1. Open Accounts Receivable > A/R Transaction Reports > G/L Transactions.

 2. Under Select Batch Type, select options to specify batch types to include, and specify a range of 
posting sequences for each batch type you select.

 3. Select a report format and sort order.

 4. If you use multicurrency accounting, specify whether to print amounts in source currency or in your 
company's functional currency.

 5. Click Print.

 l If you are printing to a physical printer, the Print window appears. Confirm your printer 
selection and the number of copies to print, and then click OK. Otherwise, click Cancel or 
Setup.

 l If you are printing to the screen (preview), the report appears in a new window. You can print 
the report or export it to a file.     

Note: For Web-based clients, the preview screen appears first when you click the Print button.

 l If you are printing to a file, the Export window appears. Specify the file format (for example, PDF, 
DOC, or XLS). Also, specify a destination for the file:

 l Application. View the report in an application that can open files of the specified format 
(for example, if you specify PDF as the file format, the report opens in Adobe Acrobat). 
You can then save the file.

 l Disk file. Save the report to a location you specify.

 l Microsoft Mail. Send the report as an e-mail attachment.

You can enter the name of a non-existent file or directory to be created by the system when you 
print. When you print to a file, the report is assigned a unique name, for example, CS1000.TXT.

 l If you are printing to e-mail, an e-mail message appears with the report attached.

Printing Accounts Receivable Invoices

You can print copies of the invoices, credit notes, and debit notes you enter in Accounts Receivable if you 
use the Allow Printing of Invoices option on the Transactions tab of the A/R Options screen.

Sage 300 Accounts Receivable comes with two sample forms you can use to print invoices on plain 
paper: ARDINVO.RPT for laser printers and ARDOTINV.RPT for dot-matrix printers. You can use these 
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sample forms or change them to suit your company’s requirements (for example, to adapt the forms for 
credit notes and debit notes), as described in the online document Customizing Printed Forms.

When to Print

You can print an invoice, debit note, or credit note when you finish entering it, or print all the documents in 
an invoice batch or in a range of batches.

Before You Start

 l Select the Allow Printing of Invoices option on the Transactions tab of the A/R Options screen.

 l Enter the invoices you want to print.

 l Verify the print destination and, if necessary, turn on and connect the printer.

To print invoices:

 1. Do one of the following:

 l To print a single invoice after you add it, click Print Invoice on the A/R Invoice Entry screen.

 l To print a range of invoices, open Accounts Receivable > A/R Transaction Reports > 
Invoices.

 2. Make selections in the following fields:     

 l Reprint Previously Printed Invoices. Select this option to reprint invoices you printed 
before. 

Do not select this option if you want to print only invoices that you have not yet printed.       

 l Delivery Method. Select Print Destination to print the invoices to the current print 
destination, or Customer to use the delivery method specified in each customer record.

 l E-mail Message ID. This field appears when you select Customer as the print destination. 
Select the code for the invoice message you want to accompany e-mailed invoices.

 l Batch/Entry Number. Select a range of invoice batch numbers for which to print invoices. 
The number of the current batch is displayed by default when you print from Invoice Entry 
screen.

 l Document Number. Select a range of invoice numbers, credit note numbers, or debit note 
numbers to print. 

If you do not select a range, Accounts Receivable prints all the documents for the customer or 
batch numbers you specify. The number of the current invoice is displayed by default when you 
print from the Invoice Entry screen.
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If you print several document types at once, Accounts Receivable first sorts the document 
numbers alphabetically, then numerically, to determine which documents belong in the range you 
specify. For example, if you use the prefix CN for credit notes, DN for debit notes, and IN for 
invoices, and select a range from DN000000001 to IN000000010, the program would print all 
debit notes, and invoices IN000000001 to IN000000010, but would print no credit notes.

 3. To print a test copy of the invoice to check the alignment of the forms in your printer, click Align. 

You can repeat this step as often as you need, when the printing destination is Printer, to make sure the 
forms are correctly inserted in the printer.

 4. Click Print.

 l If you are printing to a physical printer, the Print window appears. Confirm your printer 
selection and the number of copies to print, and then click OK. Otherwise, click Cancel or 
Setup.

 l If you are printing to the screen (preview), the report appears in a new window. You can print 
the report or export it to a file.     

Note: For Web-based clients, the preview screen appears first when you click the Print button.

 l If you are printing to a file, the Export window appears. Specify the file format (for example, PDF, 
DOC, or XLS). Also, specify a destination for the file:

 l Application. View the report in an application that can open files of the specified format 
(for example, if you specify PDF as the file format, the report opens in Adobe Acrobat). 
You can then save the file.

 l Disk file. Save the report to a location you specify.

 l Microsoft Mail. Send the report as an e-mail attachment.

You can enter the name of a non-existent file or directory to be created by the system when you 
print. When you print to a file, the report is assigned a unique name, for example, CS1000.TXT.

 l If you are printing to e-mail, an e-mail message appears with the report attached.

Printing Receipts

You use the A/R Receipts screen to print or e-mail a formal acknowledgment that you have received a 
customer payment, including details about the documents that were paid and the method of payment. 

Tip: You can   also print a single receipt confirmation for a selected receipt using the A/R Receipt   Entry 
screen.

Accounts Receivable includes a sample form for laser printers that you can use to print receipts on plain 
paper: ARRCPT.RPT. You can use this sample form as is, or change it to suit your company’s 
requirements.
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Before You Start

 l If you use Payment Processing, finish processing the credit card payment before you print the receipt.

Warning! If the Allow Edit after Receipt Printed option is not selected on the A/R options screen, the 
Charge and Quick Charge buttons are not available after you print the receipt, and you cannot 
process the credit card payment.

 l Make sure your print destination is set to Printer.

To print customer receipts:

 1. To print a single receipt after you add it to a batch, click Print Receipt on the A/R Receipt Entry 
screen.

To print a range of receipts, use the A/R Receipts screen in the Transaction Reports folder.

 2. Make selections in the following fields:     

 l Use Receipt. Select the report form you want to use for the receipt.

 l Report Format. Specify whether to print the receipt in detailed or summary format.

 l Reprint Previously Printed Receipts. Select this option to reprint receipts you printed 
before. Do not select this option if you want to print only receipts that you have not yet 
printed.

 l Delivery Method. Select Print Destination (to print the invoices to the current print 
destination) or Customer (to use the delivery method specified in each customer record).

 l E-mail Message ID. This field appears if you select Customer in the Delivery Method field. 
Select the code for the receipt message you want to accompany e-mailed receipts.

 l Batch/Entry Number. Select a range of receipt batch numbers for which to print invoices. 
The number of the current batch is displayed by default when you print from the A/R Receipt 
Entry screen.

 l Customer/Document Number. Select a range of customers and document numbers for 
which to print receipt confirmations.

 l Customer/Check/Receipt Number. Select a range of customers and check /receipt numbers for 
which to print receipt confirmations.

If you do not select a range of documents or check/receipt numbers, Accounts Receivable prints 
receipt confirmations for all the documents or check/receipts for the customer or batch numbers 
you specify. The number of the current receipt is displayed by default when you print from the 
Receipt Entry screen.
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If you print several document types at once, Accounts Receivable first sorts the document 
numbers alphabetically, then numerically, to determine which documents belong in the range you 
specify.

 3. Click Print.

 l If you are printing to a physical printer, the Print window appears. Confirm your printer 
selection and the number of copies to print, and then click OK. Otherwise, click Cancel or 
Setup.

 l If you are printing to the screen (preview), the report appears in a new window. You can print 
the report or export it to a file.     

Note: For Web-based clients, the preview screen appears first when you click the Print button.

 l If you are printing to a file, the Export window appears. Specify the file format (for example, PDF, 
DOC, or XLS). Also, specify a destination for the file:

 l Application. View the report in an application that can open files of the specified format 
(for example, if you specify PDF as the file format, the report opens in Adobe Acrobat). 
You can then save the file.

 l Disk file. Save the report to a location you specify.

 l Microsoft Mail. Send the report as an e-mail attachment.

You can enter the name of a non-existent file or directory to be created by the system when you 
print. When you print to a file, the report is assigned a unique name, for example, CS1000.TXT.

 l If you are printing to e-mail, an e-mail message appears with the report attached.

Printing the A/R Item Sales History Report

The Item Sales History report lists the sales activity for the items in your Accounts Receivable system. 

Most of the information on this report is also available on the Statistics Tab of the Items screen. 

Note: This report contains figures only if you use the Keep Item Statistics option on the A/R Options 
screen.

For more information, see "A/R Item Sales History Report" (page 701).

When to Print

Print the report when you need to check on sales activity such as the   most recent date an item was sold, 
the quantity sold during a particular   period, the number of sales returns, or the profit margin for an item.
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Before You Start

 l Verify the print destination and, if necessary, turn on and connect the printer.

To print the A/R Item Sales History report:

 1. Open Accounts Receivable > A/R Transaction Reports > G/L Transactions.

 2. If you want to include   counts of the numbers of sales and sales returns posted for each item, select 
the Include Counts option.

 3. Specify ranges of item numbers, years, and periods for which to report sales history. 

 4. Click Print.

 l If you are printing to a physical printer, the Print window appears. Confirm your printer 
selection and the number of copies to print, and then click OK. Otherwise, click Cancel or 
Setup.

 l If you are printing to the screen (preview), the report appears in a new window. You can print 
the report or export it to a file.     

Note: For Web-based clients, the preview screen appears first when you click the Print button.

 l If you are printing to a file, the Export window appears. Specify the file format (for example, PDF, 
DOC, or XLS). Also, specify a destination for the file:

 l Application. View the report in an application that can open files of the specified format 
(for example, if you specify PDF as the file format, the report opens in Adobe Acrobat). 
You can then save the file.

 l Disk file. Save the report to a location you specify.

 l Microsoft Mail. Send the report as an e-mail attachment.

You can enter the name of a non-existent file or directory to be created by the system when you 
print. When you print to a file, the report is assigned a unique name, for example, CS1000.TXT.

 l If you are printing to e-mail, an e-mail message appears with the report attached.

Printing the A/R Posting Errors Report

Accounts Receivable creates the A/R Posting Errors report when you post batches that contain errors. 
The report lists the incorrect entries and explains why they could not be posted. It also lists the number of 
the batch into which each incorrect entry was placed.

You can print the report for invoice, receipt, refund, and adjustment   batch posting errors. You must 
correct all the entries that appear on   the error report before you can post them.

For more information, see "A/R Posting Errors Report" (page 703).
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When to Print

Print the report after posting a batch, when Accounts Receivable warns   you that an error batch has been 
created. 

Before You Start

 l Verify the print destination and, if necessary, turn on and connect the printer.

To print the A/R Posting Errors report:

 1. Open Accounts Receivable > A/R Transaction Reports > Posting Errors.

Note: You can also open the   A/R Posting Errors report screen by double-clicking in the Number Of 
Errors   column on the A/R Batch List screen.

 2. Select the type of error   report to print (Invoice, Receipt, Refund, or Adjustment).

 3. Select a range of posting   sequences.

 4. Click Print.

 l If you are printing to a physical printer, the Print window appears. Confirm your printer 
selection and the number of copies to print, and then click OK. Otherwise, click Cancel or 
Setup.

 l If you are printing to the screen (preview), the report appears in a new window. You can print 
the report or export it to a file.     

Note: For Web-based clients, the preview screen appears first when you click the Print button.

 l If you are printing to a file, the Export window appears. Specify the file format (for example, PDF, 
DOC, or XLS). Also, specify a destination for the file:

 l Application. View the report in an application that can open files of the specified format 
(for example, if you specify PDF as the file format, the report opens in Adobe Acrobat). 
You can then save the file.

 l Disk file. Save the report to a location you specify.

 l Microsoft Mail. Send the report as an e-mail attachment.

You can enter the name of a non-existent file or directory to be created by the system when you 
print. When you print to a file, the report is assigned a unique name, for example, CS1000.TXT.

 l If you are printing to e-mail, an e-mail message appears with the report attached.
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Printing Accounts Receivable Posting Journals

A posting journal is the printed record of the transactions in a group of batches that were posted together. 
It provides an audit trail of all uncleared details that were posted using the A/R Post Batches screen. 

You can print posting journals for invoice, receipt, refund, and adjustment batches. In multicurrency 
ledgers, you can also print posting journals of the transactions that are created when you revalue 
documents at new exchange rates. You can also print job-related details of transactions for contracts that 
you manage using Sage 300 Project and Job Costing.

Tip: You use the A/R Clear History screen to clear the data for the journals after printing them to a 
printer or file.

When to Print

You should print posting journals after each posting run, then file them with your other audit trail records. 

Note: You must print all outstanding posting journals before you can use the A/R Clear History screen 
to clear them or use the Year End screen to do year-end processing.

Before You Start

 l Post batches.

 l Decide whether to reprint posting journals you printed before.

 l Decide whether to list transactions by batch and entry number, customer number, document date, 
or document number.

 l Verify the print destination and, if necessary, turn on and connect the printer.

To print the report:

 1. Open Accounts Receivable > A/R Transaction Reports > Posting Journals.

Note: You can also open the Posting Journals report by double-clicking in the Posting Sequence 
Number column on the Batch List screen for the batch you need.

 2. From the Select Posting Journal options, select the type of journal to print: Invoice, Receipt, 
Refund, or Adjustment.        

The Invoice Posting Journal includes credit note and debit note transactions.

If you use multicurrency accounting, you can also select Revaluation or Provisional Revaluation.
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 3. Select a Sort By option to specify the order in which to list transactions on the posting journal:       

 l Batch/Entry. This option lists transactions in order by the batch and entry numbers they 
were assigned when you entered them.

 l Customer Number. This option lists transactions in order by their customer numbers.

 l Document Date. This option lists transactions in order by the dates that you entered when 
you created the transactions.         

The choice you can make varies with the type of journal you want to print. You select Check Date 
for this option when you are printing receipt posting journals. You select Adjustment Date when 
you are printing adjustment posting journals.

 l Document Number. This option lists invoices, credit notes, and debit notes by their 
document numbers. These can be document numbers you assigned, or the numbers that 
are assigned automatically by Accounts Receivable, using the prefix and next number 
entered for each document type on the A/R Options screen.         

 l Check Number. This option lists receipt transactions by the check or receipt number you 
entered with each transaction or by the numbers that are assigned by Accounts Receivable 
to transactions entered without numbers.

 l Adjustment Number. This option lists adjustment transactions by the adjustment number 
that Accounts Receivable assigns to the transactions when you create them. This option will 
order the transactions in the same order as sorting by batch and entry number, unless you 
create transaction batches in a non-sequential order. For example, if one person opens an 
adjustment batch but does not enter the adjustments until after a second person has opened 
a second batch and entered transactions, then the transactions in the second batch would 
be listed first.

 4. Use the From Posting Sequence and To Posting Sequence fields to specify the lowest and 
highest numbers in the range of posting sequences for which to print journals. More...       

A unique posting sequence number is assigned each time you post batches. These fields display the 
lowest and highest posting sequence numbers in your Accounts Receivable system for the type of 
journal you select. (You use the Clear History screen to clear posting sequences for the journals you 
have already printed to a printer or file.)

 5. Select additional options for the report, as follows:     

 l Reprint Previously Printed Journals. Select this option if you want to print additional copies 
of journals you printed before.       

Do not select the option if you want to print only the journals you have not already printed from the 
specified range of posting sequence numbers.

 l Include Job Details. Select this option to include the contract, project, category, and 
resource for each job-related transaction.
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 l Include Optional Fields. Select this option to include optional field information for each 
printed transaction. (The option is available only if you use optional fields with Accounts 
Receivable.)

 l Include G/L Ref./Desc.  Select this option to print the G/L reference and description with 
each transaction.

 6. Click Print.

 l If you are printing to a physical printer, the Print window appears. Confirm your printer 
selection and the number of copies to print, and then click OK. Otherwise, click Cancel or 
Setup.

 l If you are printing to the screen (preview), the report appears in a new window. You can print 
the report or export it to a file.     

Note: For Web-based clients, the preview screen appears first when you click the Print button.

 l If you are printing to a file, the Export window appears. Specify the file format (for example, PDF, 
DOC, or XLS). Also, specify a destination for the file:

 l Application. View the report in an application that can open files of the specified format 
(for example, if you specify PDF as the file format, the report opens in Adobe Acrobat). 
You can then save the file.

 l Disk file. Save the report to a location you specify.

 l Microsoft Mail. Send the report as an e-mail attachment.

You can enter the name of a non-existent file or directory to be created by the system when you 
print. When you print to a file, the report is assigned a unique name, for example, CS1000.TXT.

 l If you are printing to e-mail, an e-mail message appears with the report attached.
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Appendix A: Accounts Receivable 
Screen Guides

Learn how to find and use Sage 300 screens. Each screen guide includes navigation information, field 
help, and a list of tasks you can use the screen to perform.

Customer Screens
You use icons in the A/R Customers folder to add the following types of customer records:

 l Customer groups

 l National accounts (optional)

 l Customers

 l Ship-to locations

 l Recurring charges

A/R Customer Groups Screen

To Open this Screen

Open Accounts Receivable > A/R Customers > Customer Groups.

Related Tasks

 l "Adding, Modifying, and Deleting Customer Groups" (page 64)

Overview

Note: Depending on how your system is set up, this desktop screen may also be available as a web 
screen. For more information, see the Web Screens Getting Started Guide or the help for Sage 300 
web screens.
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You use the A/R Customer Groups screen to create customer groups to which you can assign customers. 
Use customer groups to:

 l Classify customer records by common characteristics.

 l Set default entries to speed up the task of adding records for customers and national accounts.

 l Select records for processing.

You can create as many customer groups as you want, but you must create at least one.

For an overview of customer groups, see "About Customer Groups" (page 61).

Credit Tab

You use the Credit tab to enter a credit limit and an overdue for the customer group. 

You also specify whether you can edit these limits for customers and national accounts you assign to the 
group.

Group Tab

You use the Group tab to:

 l Assign the account type, account set, terms code, billing cycle, and interest profile that will set the 
default selections for the customer and national account records you add to the group.

 l In multicurrency ledgers, specify the default rate type to assign for customers and national accounts 
who do not use the functional currency. 

Invoicing Tab

You use the Invoicing tab to:

 l Specify default salesperson splits for new customers you later add to the customer group.

 l Specify the default tax group and tax classes for customers in the customer group. The tax group 
can use a different currency than that specified for the account set.

Optional Fields Tab

Note: This tab appears only if you have activated Sage 300 Transaction Analysis and Optional Field 
Creator.

You use the Optional Fields tab to:

 l Assign to a customer group any optional fields that are defined for customers, national accounts, 
and customer groups. (You define optional customer fields using the Optional Fields screen in the 
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A/R Setup folder.)

 l Specify optional field values for the customer group. These values appear as defaults for new 
customer records that you add to the group, if you use the same optional fields in the customer 
record, unless the customer is also a member of a national account. (If the national account uses 
the same fields, the values from the national account are used as defaults for the customer.)

When you add a new customer group record, optional fields that you set up for automatic insertion in 
customer group, national account, and customer records automatically appear on this tab, along with 
their default values. For more information, see "About Customer Optional Fields" (page 80).

Statistics Tab

You use the Statistics tab to:

 l View the number and amount of all transactions processed for the customer group in the year and 
period you select.

 l View the total days to pay figure and displays the average days to pay figure for the group and 
period.

 l Change statistical information (if the Allow Edit Of (customer) Statistics option is selected on the 
Processing tab of the A/R Options screen).

Fields and Controls

Group Code

This code identifies the customer group.

To create a new customer group, type a unique code using up to three characters,   including letters and 
digits. 

To open an existing customer group record, type its code or use the Finder to select the code. 

Credit tab

Allow Edit of Credit Check

Use this option to indicate whether the customers   and national accounts assigned to the group must 
use the group's credit   options and limits. Select the option if they can use other options and limits.

You turn this option on or off at any time.
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Currency and Credit Limit Amount

You specify a credit limit if you selected the Total Outstanding Balance Exceeds the Credit Limit 
option. 

Type the standard credit limit your company offers to customers and   national accounts in the group. 

In a single currency system, you specify one amount. 

In a multicurrency system, use the currency table to specify a credit limit in each   currency used by 
customers in the group. (The customer currency is determined by the account set.)

Note: You can assign different limits for individual customers   and national accounts if you select the 
Allow Edit Of Credit   Limit option for the group.

Issue Credit Warning When A/R Transactions   [ ] Days and Later Exceeds Amount

Select this option if you want to generate a warning when you enter   transactions for a customer in the 
group whose overdue transactions exceed   a specified number of days and a specified amount. 

Example: If the option stipulates that transactions 90 days or more   cannot exceed 250.00, a credit 
check warning appears when you enter a   new transaction for a customer with transactions worth 
$300.00 that are   overdue by at least 90 days.

If you select this option, enter the number of days overdue and the   overdue limit (the amount that a 
customer's overdue transactions must   exceed to issue a warning). 

In a single currency system, specify one overdue limit. In a multicurrency   system, specify an overdue 
limit for each currency used.

Issue Credit Warning When Total Outstanding   Balance Exceeds the Credit Limit

Select this option to generate a warning when you add a transaction   for a customer whose outstanding 
balance is greater than a specified credit   limit. 

In a single currency system, you specify one credit limit for all the   members of the customer group.

In a multicurrency system, you use the currency table to specify a credit   limit for each currency used in 
the customer group.

If you selected options on the A/R Options screen to include pending transactions   during credit checks, 
pending transactions (for example, unposted transactions   in Accounts Receivable or Order Entry) are 
included in the calculation   of the outstanding balance.
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Overdue Limit

You specify an overdue limit if you selected the option Issue Credit Warning   When A/R Transactions [ 
] Days and Later Exceeds   Amount.

Type the total amount overdue transactions must exceed to   generate a credit warning when you enter a 
transaction for a customer   in the customer group.

In a single currency system, you specify one amount.

In a multicurrency system, specify an amount in the currency table for each currency used in the 
customer group.

This amount is used as the default for all customers in the group that   are not assigned to a national 
account.

Group tab

Account Set

The account set specifies the general ledger receivables control, payment   discounts, prepayment 
liability, retainage, and write-offs accounts to   which a customer's transactions are distributed. 

To select the account set, type its code in the Account Set field or   select it from the Finder.

For more information about account sets, see "About Account Sets" (page 21).

Account Type

The account type determines how you apply receipts to a customer's account:

 l For balance-forward accounts, you apply receipts to the customer's outstanding balance.

 l For open-item accounts, you apply receipts to specific documents by document number. 

To specify the account type, select it from the list. (You can also type O or use the Up Arrow on your 
keyboard to select Open Item, or type B or use the Down Arrow to select Balance Forward.)

Customer groups and national accounts determine the default account type for new customer records. 
You can select a different account type in a customer record, unless the customer is assigned to a 
national account. (You cannot change the account type for members of national accounts.)

For more information about account types, see "About Customer Account Types" (page 78).
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Billing Cycle

In the Billing Cycle field, type the code for the billing cycle to use for the customer, national account, or 
customer group, or use the Finder to select it.

For information about billing cycles, see "About Billing Cycles" (page 24).

Description

Enter a description (name) for the customer group.

Inactive

Select this option if you do not want to post any new transactions to the   customers or national accounts 
that are assigned to the group, usually   because you plan to delete the group. 

You can select Inactive status only if the accounts of the customers   and national accounts that belong 
to the group have zero balances and   no outstanding transactions. 

When a customer group is inactive, you cannot save changes to the customer   and national account 
records that use the group, except to select another   customer group. 

You can make the group active again at any time.

Interest Profile

You assign an interest profile to each customer, group, and national   account to specify the method and 
rates to use when charging interest   on overdue amounts, and the general ledger account to which you 
post interest   revenue.

Type the code to use in the Interest Profile field, or select it from   the Finder.

Note: You must assign an interest profile to every customer, group,   and national account. If you do 
not charge interest, assign an interest   profile with a zero rate.

Interest profiles are first assigned to customers and national accounts   by the customer group, but you 
can change to another profile in the customer   record. If you change a customer's group, the new 
group's interest profile   replaces the profile in the customer record, but you can change it as   well.

National account customers use the national account's interest profile,   and you can change a 
customer's profile only by changing the interest   profile for the corresponding national account. 

For information about interest profiles, see "About Interest Profiles" (page 32)
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Last Maintained

This information field displays the date   of the last change made to the customer group. You do not 
make an entry   in this field.

Print   Statements

Select this option if you plan to print statements for the customers   in this group.

This option is a default setting for new customers you add to this customer   group.

Rate Type

For multicurrency customers   or national accounts who do not use the functional currency, you specify   
the default rate type to use to convert transactions into the functional   currency. When entering 
transactions for the customer or national account,   you can change the rate type, if needed.

To specify the rate type, type its code or use the Finder to select it.   You must specify a rate type that is 
defined for the company in the Currency   screens in Common Services. 

Terms Code

You assign a terms code to each customer and customer group  to specify the payment terms to use on 
invoices for the customer. 

Note: You must assign a terms code to every   customer and customer group in Accounts Receivable.

For more information about customer payment terms, see "About Customer Payment Terms" (page 54)

Invoicing tab

Percentage

Type the percentage of the customer's transaction   totals to allocate to each salesperson. 

The percentages you assign must add up to 100%.

The salespersons and percentages you assign to a customer group record   appear as defaults when 
you add a new customer record for the customer   group.

The salespeople and percentages you assign to a customer record or ship-to   location appear as 
defaults on the Sales Split tab on the Invoice Entry   screen when you enter transactions for the customer 
or for the customer's   ship-to location, but you can change the information for a particular invoice,   credit 
note, or debit note. 
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Salesperson Code

Use the Salesperson Code column to specify the salespersons who are responsible   for the customer's 
account. You can type the code or select   it using the Finder.

You can select up to five salespeople, but you must select salesperson   codes that are defined in 
Accounts Receivable. 

The salespersons specified for the customer group appear as default   entries for new customer records 
you add to the group.

Salespersons specified for a customer appear as default entries for   new ship-to location records you 
add for the customer.

Salesperson Name

The Salesperson Name field displays the name entered in the Salespersons   record for each 
salesperson code. 

You cannot change any of the names on this tab. (Use the Salespersons   screen to change salesperson 
names.)

Tax Authority

Tax authorities are the types of taxes to which a customer may be subject. For example, state and 
provincial sales taxes are tax authorities,   as are GST and VAT. 

Tax authorities are determined by the customer's tax group, and you cannot   change them or add other 
authorities in the customer record. You can   change the tax classes or enter tax registration numbers 
only for tax authorities   in customer records.

You define and update records for tax authorities and enter other taxation   information in the Tax 
Services screens in Common Services. 

Tax Class

In the Tax Class field, type the number of the   tax class to use for the customer or customer group, or 
use the Finder to select it.

Tax classes identify the tax rates used to calculate taxes when you   enter invoices, debit notes, and 
credit notes for a customer. Each tax class identifies a tax rate.

Example: Assigning class 1   may charge a customer the full tax rate, class 2 may charge a lower rate,   
and class 3 may mean the customer is tax-exempt.
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Tax classes are determined by the tax authorities in the customer's   tax group. You can change only to 
another tax class that is assigned to   the corresponding tax authority in Tax Services.

You define and update tax classes and enter other taxation information   in the Tax Services screens in 
Common Services. 

Tax Group

In the Tax Group field, type the code   for the tax group you want to assign, or use the Finder to select it. 

You assign a tax group to each customer record to specify the taxing   authorities and classes that apply 
to the customer's invoices, debit notes,   and credit notes. 

Note: You must assign a tax group to every   customer record, whether taxes are levied in the 
customer's area or not.   

You define and update tax groups and enter other taxation information   in the Tax Services screens in 
Common Services. 

Optional Fields tab

Optional fields are available only if you use Transaction Analysis and Optional Field Creator.

You can accept the default optional fields that appear on the tab, or delete them. You can also   add 
different optional fields that you have set up for use with each  screen. 

For more information, see "About Optional Fields in Accounts Receivable" (page 41).

Statistics tab

Amount

Use the Amount column to view, edit, or add the   total amount of the invoices, receipts, credit notes, and 
other documents   that were processed for the customers and national accounts in the group   during the 
displayed period.

If you are entering statistics as part of the setup of your Accounts   Receivable ledger, do not include 
amounts you will post to the group's   customers when you enter historical and year-to-date Accounts 
Receivable   transactions.

Statistics are automatically updated as you post transactions to the   customers and national accounts in 
the group. You can also change the   amounts, as needed, if you use the Allow Edit Of (customer) 
Statistics   option on the Processing tab of the A/R Options screen. 
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Average Days to Pay

Accounts Receivable keeps track of the average number of days it takes   the customers and national 
accounts in a customer group to pay each invoice,   and displays the figure in the Average Days To Pay 
field. You cannot change the figure.

The figure for each period is calculated by dividing the total number   of days it took to pay the invoices 
that were fully paid in the period   by the number of invoices that were issued to the group's customers, 
both   in the displayed period and in prior periods. 

Count

Use the Count column to view, edit, or add the   total number of invoices, receipts, credit notes, and other 
transactions   that were processed for all the customers and national accounts in the   group during the 
displayed period.

If you are entering statistics as part of the setup of your Accounts   Receivable ledger, do not include 
amounts you will post for the group's   customers and national accounts when you enter historical and 
year-to-date   Accounts Receivable transactions.

Statistics are automatically updated as you post transactions to the   customers and national accounts in 
the group. You can also change the   numbers, as needed, if you use the Allow Edit Of (customer) 
Statistics   option on the Processing tab of the A/R Options screen. 

Period 

Select the fiscal period for which you are entering or viewing statistics.   

The type of period by which you keep statistics is determined by the   selection for the Period Type 
option for customer records on the Processing tab of the A/R Options screen. Period types include   
Weekly, Seven Days, Bi-weekly, Four Weeks, Monthly, Bi-monthly, Quarterly,   Semi-annually, and 
Fiscal Period. 

Total Days to Pay

Accounts Receivable records the length of time it takes the customers   and national accounts assigned 
to a customer group to fully pay each invoice,   then displays the total in the Total Days To Pay field. 

The total that appears for a period is the number of days it took the   group to pay all the invoices that 
were paid in full during the selected   period. 

359Sage 300 2023 Accounts Receivable User's Guide



Accounts Receivable automatically updates this total as you post transactions   to the customers and 
national accounts in the group. You can also change   the total, as needed, if you use the Allow Edit Of 
(customer) Statistics   option on the Processing tab of the A/R Options screen. 

Transaction Types

The Transaction Types column lists the types of   transactions for which totals and numbers are kept. 

You can edit, view, and add total amounts and numbers of invoices, receipts,   discounts, credit notes, 
debit notes, adjustments, write-offs, interest   charges, returned checks, and refunds posted to the 
accounts of all customers   and national accounts in the group. 

If you are entering statistics as part of the setup of your Accounts   Receivable ledger, do not include 
amounts you will post to customers in   the group when you enter historical and year-to-date Accounts 
Receivable   transactions. If you do, the transactions will be added twice to statistical   totals.

Year

Type or select the year for which you want to enter or view statistics.

The type of year by which you keep statistics is determined by your   choice for the Accumulate By 
option for   customer records on the Processing tab of the A/R Options   screen. 

YTD Average Days To Pay

Accounts Receivable keeps track of the average number of days it takes   the customers and national 
accounts in a customer group to pay each invoice, and  displays the average for the year in the YTD 
Average Days   To Pay field on the Statistics tab on the Customer Groups screen. You cannot   change 
the figure.

YTD Total Days To Pay

Accounts Receivable records the length of time it takes the customers   and national accounts assigned 
to a customer group to fully pay each invoice   for the year to date, and displays the total in the YTD Total 
Days To   Pay field. 

Accounts Receivable automatically updates this total as you post transactions   to the customers and 
national accounts in the group. You cannot change   this figure.
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A/R National Accounts Screen

To Open this Screen

Open Accounts Receivable > A/R Customers > National Accounts.

Related Tasks

 l "Adding, Modifying, and Deleting National Accounts" (page 70)

Overview

Note: Depending on how your system is set up, this desktop screen may also be available as a web 
screen. For more information, see the Web Screens Getting Started Guide or the help for Sage 300 
web screens.

If you use National Accounts Management (a separate package available from Sage 300), this screen 
lets you add records for national accounts to:

 l Group customers who are subsidiaries or branch offices of the same large company for processing 
and reporting.

 l Enter a name, telephone and fax numbers, and an e-mail address for a contact person for the 
national account.

 l Process a single payment from the head office and apply it to the subsidiary accounts.

 l Choose to print statements for the national account rather than for individual member customers.

 l Select options for customer records you assign to national accounts.

Activity Tab

Use the Activity tab to:

 l View current-year and previous-year account activity for the selected national account.

Account activity includes the current balance, the last statement balance, the number of outstanding 
invoices, the amount of the last invoice, and so on.)

 l Edit activity statistics when first setting up national accounts.

Address Tab

Use the Address tab to:
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 l Change the national account's customer group, address, contact name, telephone number, and fax 
number. More...

You can change the customer group assigned to a national account at any time. If you use 
multicurrency accounting, you will need to reselect the account set for the national account if you 
change to a customer group that uses an account set with a different currency from the national 
account.

You can change this information at any time. If you use information from this tab on the Address 
Information tab for the customers who are assigned to the national account, you will have to edit the 
customer records after the change to enter the new information.

 l Select On Hold or Inactive status for national accounts. More...

You can assign On Hold status or remove the status at any time. When a national account is on hold, 
the program warns you when you try to post transactions for customers in the account.

You can assign Inactive status to a national account only if all its customers have zero balances and no 
outstanding transactions.

Contact Tab

Use the Contact tab to enter a name, telephone number, fax number, and e-mail address for a contact 
person—separate from the information you have stored on the Address tab for the national account.

If you print statements for the national account, you can send statements to the contact's e-mail address, 
rather than to the company's e-mail address or billing address. (You select the delivery method on the 
Processing tab.)

If you use the Multiple Contacts (M/T) program, this tab includes a Multiple Contacts section that allows 
you to assign multiple contacts to a national account. For more information, see "Setting Up Multiple 
Contacts for Customers and National Accounts" (page 84).

Optional Fields Tab

Note: This tab appears only if you have activated Sage 300 Transaction Analysis and Optional Field 
Creator.

Use the Optional Fields tab to:

 l Assign to a national account any optional fields that are defined for customers, national accounts, 
and customer groups. (You define optional customer fields using the Optional Fields screen in the 
A/R Setup folder.

 l Specify optional field values for the national account. These values appear as defaults for new 
customer records that you add to the national account, if you use the same optional fields in the 
customer record.
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When you add a new national account record, optional fields that you set up for automatic insertion in 
customer group, national account, and customer records automatically appear on this tab, along with 
their default values. For more information, see "About Customer Optional Fields" (page 80).

Processing Tab

Use the Processing tab to:

 l Select the default account type (open item or balance forward) to assign to new customer records 
you add to the national account. 

 l Select the account set which, in multicurrency ledgers, identifies the currency for the national 
account and for all the customers that use the national account. 

 l Indicate whether you print statements for the national account. 

 l Specify a delivery method for sending statements to the national account.

 l Specify whether to issue a credit warning if transactions for the national account exceed the 
specified credit limit, or if overdue transactions exceed a specified amount for a specified period.

 l Specify a default credit limit and a default overdue limit for new customers that you assign to the 
national account (if the Allow Edit Of Credit Check is selected in customer group record). 

 l Enter credit bureau information for the national account, such as a credit bureau number, rating, 
and date.

 l In multicurrency ledgers, select the rate type to use when converting transactions for customers in 
the national account to the functional currency. 

 l Select the billing cycle and interest profile to assign to customer records that use the national 
account. 

Statistics Tab

Use the Statistics tab to:

 l View the number and amount of all transactions processed for the customers in the national 
account in the year and period you select.

 l View the total days to pay figure and displays the average days to pay figure for the national 
account and period.

 l Change statistical information (if the Allow Edit Of Statistics option is selected for customers, 
national accounts, and customer groups on the Processing tab of the A/R Options screen.

Fields and Controls

National Account Number

Identifies the national account in Accounts Receivable. 
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To create a new national account, enter a unique number of up to 12   characters. The number can 
include digits, letters, symbols, and blank   spaces. 

To open an existing national account record, type its number or choose   it from the Finder beside the 
National Account Number field. 

Activity tab

Amount

The Amount column shows the total amount   for each of the transaction types listed in the Statistics 
column. 

Accounts Receivable updates these amounts when you post transactions   to the account. 

You can change this figure if the Allow Edit Of Statistics option is selected for customers on   the 
Processing tab of the A/R Options screen. 

Average Days to Pay

This field shows the average number of days it has taken the customer to pay   all the invoices that were 
fully paid in the current year. 

The average days to pay  is calculated by dividing the Total Days To Pay figure by the Total Invoices 
Paid figure. You can alter the Average Days to Pay field only by editing   the other two fields.

Currency 

This field displays the currency assigned to the account set. 

You enter all invoices, debit notes, and credit notes for the customer or national account in the account 
set currency, but you can apply receipts from the customer or national account in other currencies.

Date

The Date column lists the   date each type of transaction (shown in the Statistics column)   was posted to 
the customer's account. 

Accounts Receivable updates these dates when you post transactions to   the customer's account. 

You can edit the dates if the   Allow Edit Of Statistics option is selected for customers on the Processing 
tab of the   A/R Options screen. 
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Last Statement Balance

This field displays   the balance that appeared on the last statement you printed for the account. 

You cannot edit the figure.

Last Statement Date

This field displays   the date on which you printed the last statement for this account. 

You   cannot edit the date.

National Account Status

The Account Status fields display the current status of the account —outstanding balance,   number of 
open invoices, last statement balance, and date of last statement—  as well as information you can edit, 
such as the highest balance this   year and last year, the largest invoice this year and last year, and the   
last invoice, receipt, credit note, debit note, adjustment, write-off,   interest charge, returned check, and 
discount taken. 

Activity statistics   also include the total number of days to pay invoices, the number of fully   paid invoices, 
and the average number of days to pay invoices.

Number   of Open Invoices

This field shows the current   number of open (unpaid) invoices in the account. 

You cannot edit the figure.

Outstanding Balance

This field displays the current net amount owed by a customer (or national account), including all 
invoices, credit notes, debit notes, receipts and adjustments posted to the account.

You cannot edit the figure.

Outstanding Retainage

This field shows the outstanding retainage balance for the customer   (or national account).

Statistics

The Activity tab lists the amount and date for the transactions with   the highest balance this year and last 
year; for the largest invoices this   year and last year; and for the last posted invoice, receipt, credit note,   
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debit note, adjustment, write-off, interest charge, returned check, discount   taken, and refund.

Accounts Receivable updates these figures each time you post transactions   for the account. 

You can edit the amounts and dates if the Allow Edit Of Statistics option is selected for customers on   
the Processing tab of the A/R Options screen.

Total Days to Pay

This field shows the total number of days the customer has taken to pay all outstanding   invoices that 
have been fully paid in the current year to date. 

Accounts Receivable updates this figure when you post transactions to   fully pay the customer's 
invoices. 

You can change this figure if the Allow Edit Of Statistics option is selected for customers on   the 
Processing tab of the A/R Options screen. 

Example: You want to change   the number because it has been inflated by unusual circumstances, 
and so gives   an inaccurate impression of the customer's payment record.

Important! If you are entering this number when setting up customer records, do not enter   figures 
from invoices and other transactions that you will post for the customer   when you enter historical and 
year-to-date Accounts Receivable transactions. Otherwise, these statistics will be distorted.

Total Invoices Paid

This is the total number of invoices that have been fully paid in the   current year to date. 

Accounts Receivable updates this figure when you post transactions to   fully pay invoices in the 
customer's account. 

You can change this figure if the Allow Edit Of Statistics option is selected for customers on   the 
Processing tab of the A/R Options screen. 

Important! If you are entering this number when setting up customer records, do not enter   figures 
from invoices and other transactions that you will post for the customer   when you enter historical and 
year-to-date Accounts Receivable transactions. Otherwise, these statistics will be distorted.

Address tab

Address
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The address in the customer record or national account is usually the   address that is printed on invoices 
and statements for the account. 

When customers belong to a national account, the address in the customer   record is usually the billing 
address for the national account. You   use ship-to locations to record the customer's actual address. 
You also   use ship-to locations if the customer has more than one address. 

City

Type the name of the city where the customer resides or where you ship goods.

You can enter the name of the city in other address lines. However, the customer address on your 
statements, letters, and labels may not appear correctly. Also, if you export data to use in other 
programs, the field is more useful when you use the field consistently for the city.

Country

Specify the name of the country where the business is located.

E-mail

Use this field to enter an e-mail address for the national account.   

Fax

You use this field to record the fax number, if any, for your customer, national   account, or ship-to 
location. 

The field includes area code parentheses and hyphens if you selected   the Format Phone Number 
option for the company in the Company Profile   screen in Common Services.

Group Code

Use this field to assign a customer group to a selected customer or national account. Type   the code or 
use the Finder to select it. 

You must specify a customer   group for each customer and national account.

You can change the customer group for a national account or for a customer at any time, unless the 
customer   belongs to a national account (in which case the customer record must use the customer   
group assigned to the national account). You can change the group for the customer only   by changing it 
for the national account. 
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In a multicurrency system, you can change the customer group to one that   uses a different currency. 
However, you must change the account set for a national account if the new group has an account set 
that uses a different currency from the national account.

If you change the customer group for an existing customer, the settings   in the customer record remain 
unchanged, except for the customer group.   

Inactive

Select this option if you do not want to post any new transactions to the   customers in the national 
account, usually because you plan to delete   the national account. 

You can select Inactive status only if all customers assigned to the   national account have an account 
balance of zero and no outstanding transactions.   

You can reactivate the national account at any time.

Last Maintained

This information displays the date   of the last change made to the national account. You do not make an 
entry   in this field.

Name

You use this field to record the name or a description of the national account. Type the name as you 
want it to appear in Accounts Receivable screens and on reports, using up   to 30 characters.

On Hold

Select the On Hold option if you want to place   a customer account on hold. 

When an account is on hold, you see a warning   when you start to enter an invoice for the customer. You 
can then choose   whether to continue entering the invoice. 

You can always enter and post invoices, credit notes, debit notes, receipts,   and prepayments, whether 
a customer account is on hold or not.

State/Prov.

This field contains the name of the state or province where the business   is located. You can type up to 
20 characters in the field, including spaces.
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Telephone

This field usually contains the telephone number at the place of business   of the customer, national 
account, or ship-to location. 

The field includes area code parentheses and hyphens if you selected   the Format Phone Number 
option for the company in the Company Profile   screen in Common Services.

Web Site

If the national account has a website, you can type its URL  in the Web Site field.

Zip/Postal Code

Type the zip code or postal code for the address.

Contact tab

Contact

This field usually contains the name of a contact person, position,   or department for the customer, ship-
to location, or national account.   

You can also leave the field blank or enter other information in it, using   up to 30 characters.

E-mail

Use this field for the e-mail address of your contact for this   national account. 

Fax

This field contains the fax number, if any, for your customer's contact   person. 

The field includes area code parentheses and hyphens if you selected   the Format Phone Number 
option for the company in the Company Profile   screen in Common Services.

Telephone

This field usually contains the telephone number at the place of business   of the customer or national 
account. 
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The field includes area code parentheses and hyphens if you selected   the Format Phone Number 
option for the company in the Company Profile   screen in Common Services.

Multiple Contacts

If you use the Multiple Contacts (M/T) program, this section appears on the Contact tab, allowing 
you to assign multiple contacts to a national account. For more information, see "Setting Up 
Multiple Contacts for Customers and National Accounts" (page 84).

Create New Contact

Click this button to create a new contact record and assign the new contact to the national account.

Show Documents For

This field displays All by default, and the table includes a column for each type of document that can be 
sent to contacts. If you select a specific program in this field, the table includes columns for only 
documents for the selected program.

View Contact Details

Select a contact in the table and then click this button to view and edit the contact's details.

Optional Fields tab

Optional fields are available only if you use Transaction Analysis and Optional Field Creator.

You can accept the default optional fields that appear on the tab, or delete them. You can also   add 
different optional fields that you have set up for use with each  screen. 

For more information, see "About Optional Fields in Accounts Receivable" (page 41).

Processing tab

Account Set

The account set specifies the general ledger receivables control, payment   discounts, prepayment 
liability, retainage, and write-offs accounts to   which a customer's transactions are distributed. 

To select the account set, type its code in the Account Set field or   select it from the Finder.

For more information about account sets, see "About Account Sets" (page 21).
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Account Type

The account type determines how you apply receipts to a customer's account:

 l For balance-forward accounts, you apply receipts to the customer's outstanding balance.

 l For open-item accounts, you apply receipts to specific documents by document number. 

To specify the account type, select it from the list. (You can also type O or use the Up Arrow on your 
keyboard to select Open Item, or type B or use the Down Arrow to select Balance Forward.)

Customer groups and national accounts determine the default account type for new customer records. 
You can select a different account type in a customer record, unless the customer is assigned to a 
national account. (You cannot change the account type for members of national accounts.)

For more information about account types, see "About Customer Account Types" (page 78).

Billing Cycle

In the Billing Cycle field, type the code for the billing cycle to use for the customer, national account, or 
customer group, or use the Finder to select it.

For information about billing cycles, see "About Billing Cycles" (page 24).

Credit Bureau Information

Use the Credit Bureau Information fields to enter   a credit bureau number and rating for the customer or 
national account.

Currency

This field displays the currency assigned to the account set. 

You enter all invoices, debit notes, and credit notes for the customer or national account in the account 
set currency, but you can apply receipts from the customer or national account in other currencies.

Date

If you record credit   bureau information for a customer or national account, you can also enter   the date 
on which the credit information was assigned. 

Change the date in this field whenever you change the credit   information. 

Delivery Method

Specify how invoices, receipts, statements, and letters are delivered to the national account:

371Sage 300 2023 Accounts Receivable User's Guide



 l Mail. Print to your usual print destination.

 l Email (national account). Print to a file and email the file to the email address specified for the 
national account on the Address tab.

 l Email (contact). Print to a file and email the file to the contact email address specified for the 
national account on the Contact tab.

 l Email (multiple contacts). If you use the Multiple Contacts (M/T) program, you can use this 
delivery method to print to a file and email the file to all the contact email addresses specified for 
the national account in the Multiple Contacts section on the Contact tab.

Note: If you select Customer as the delivery method when printing invoices, receipts, statements, 
and letters, the program uses the delivery method specified in the customer or national account 
record.

Interest Profile

You assign an interest profile to each customer, group, and national   account to specify the method and 
rates to use when charging interest   on overdue amounts, and the general ledger account to which you 
post interest   revenue.

Type the code to use in the Interest Profile field, or select it from   the Finder.

Note: You must assign an interest profile to every customer, group,   and national account. If you do 
not charge interest, assign an interest   profile with a zero rate.

Interest profiles are first assigned to customers and national accounts   by the customer group, but you 
can change to another profile in the customer   record. If you change a customer's group, the new 
group's interest profile   replaces the profile in the customer record, but you can change it as   well.

National account customers use the national account's interest profile,   and you can change a 
customer's profile only by changing the interest   profile for the corresponding national account. 

For information about interest profiles, see "About Interest Profiles" (page 32)

Issue Credit Warning When Total Outstanding   Balance Exceeds The Credit Limit Of [ ]

This option shows whether you will receive a warning when you enter   a transaction for a member 
customer when the total outstanding balance   for the national account is greater than a specified credit 
limit.

The option selection and credit limit for the customer group are used   as defaults when you assign a 
customer group to a new national account.   (In multicurrency ledgers, the credit limit amount specified 
for the national   account currency is used as the default.) 

372Sage 300 2023 Accounts Receivable User's Guide



You can change the option and credit limit for the national account   if you selected the Allow Edit Of 
Credit Check option for the customer   group.

Note: The   option to include pending transactions in credit checks does not apply to credit checks for 
national accounts.

Issue Credit Warning When A/R Transactions   [ ] Days And Later Exceeds [ ] 

This option lets you specify for members of the national account the   maximum amount that transactions 
can be overdue for a specified number   of days before generating a credit warning when you enter a 
transaction   for a member customer.

Example: If the option stipulates that transactions 90 days or more   cannot exceed 250.00, a credit 
check warning appears when you enter a   new transaction for a customer with transactions worth 
$300.00 that are   overdue by at least 90 days.

The option selection, aging period, and exceeding amount specified for   the customer group to which the 
national account is assigned appears as   the default for a new national account. (In a multicurrency 
ledger, the   exceeding amount for the national account currency is the default for   the national account.)

If you select the option, enter the number of days overdue and the amount   that a national account's 
overdue transactions must exceed to issue a   warning. 

The credit check information you specify for the national account is   used as the default when you add 
new customers to the national account.

You can change the option selection, aging period, and exceeding amount   if you selected Allow Edit Of 
Credit Check for the customer group. 

Number

In each customer or national account record, you can record a number   that is assigned for the business 
by a credit bureau. You can change this number at any time.

Print Statements

Select this option if you want to print the statements for this national   account, rather than for the 
individual member customers.

Note: You can indicate in the   customer records whether to print statements for the member 
customers   of the national account. However, once you print a statement for the national   account, you 
cannot also print separate statements for the member customers.   
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Rate Type

For multicurrency customers   or national accounts who do not use the functional currency, you specify   
the default rate type to use to convert transactions into the functional   currency. When entering 
transactions for the customer or national account,   you can change the rate type, if needed.

To specify the rate type, type its code or use the Finder to select it.   You must specify a rate type that is 
defined for the company in the Currency   screens in Common Services. 

Rating

In each customer or national account record, you can record a code that   indicates the account's credit 
rating, such as a rating that is assigned   by a credit bureau. 

You can enter a new rating at any time.

Statistics tab

Amount

Use the Amount column on the Statistics tab to view, edit, or add the   total amount of the invoices, 
receipts, credit notes, and other documents   that were processed for the customers and national 
accounts in the group   during the displayed period.

If you are entering statistics as part of the setup of your Accounts   Receivable ledger, do not include 
amounts you will post to the group's   customers when you enter historical and year-to-date Accounts 
Receivable   transactions.

Statistics are automatically updated as you post transactions to the   customers and national accounts in 
the group. 

You can change these   amounts if the Allow Edit Of Statistics option is selected for customers on   the 
Processing tab of the A/R Options screen. 

Average Days to Pay

Accounts Receivable keeps track of the average number of days it takes   each customer (or all the 
customers assigned to a customer group or national   account) to pay each invoice, and displays the 
figure in the Average Days  To Pay field.   You cannot change the figure.
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The figure for each period is calculated by dividing the total number   of days it took to pay the invoices 
that were fully paid in the period   by the number of invoices that were issued to the account, both in the   
displayed period and in prior periods. 

Count

Use the Count column on the Statistics tab to view, edit, or add the   total number of invoices, receipts, 
credit notes, and other transactions   that were processed for the account during the displayed period.

Important! If you are entering statistics as part of the setup of your Accounts   Receivable ledger, do 
not include amounts you will post for the customers   when you enter historical and year-to-date 
Accounts Receivable transactions.   If you do, the amounts will be added twice to the statistics.

Currency

If you use multicurrency accounting, period statistics are recorded   in the currency used by the customer 
or national account, as well as in   their equivalent values in the functional currency. You can choose 
whether   to view or edit statistics in the customer's currency or the functional   currency. 

Use this Currency field to select the currency   in which to display statistical totals.

Period 

Select the fiscal period for which you are entering or viewing statistics.   

The type of period by which you keep statistics is determined by the selection for the Period Type 
option for customers, customer groups, and national   accounts on the Processing tab of the A/R Options 
screen. (Period   types include Weekly, Seven Days, Bi-weekly, Four Weeks, Monthly, Bi-monthly,   
Quarterly, Semi-annually, and Fiscal Period.)

Total Days to Pay

Accounts Receivable records the length of time it takes a customer (or   all the customers assigned to a 
customer group or national account) to   fully pay each invoice, then displays the total in the Total Days 
To Pay   field on the Statistics tab on the Customers screen, the National Accounts   screen, and the 
Customer Groups screen. 

The total that appears for a period is the number of days it took to   pay all the invoices that were paid in 
full during the selected period.   

You can edit this total, as needed, to set up and update statistics.   
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Transaction Types

The Transaction Types column on the Statistics tab lists all the types of   transactions for which totals 
and numbers are kept. 

You can edit, view, and add total amounts and numbers of invoices, receipts,   discounts, credit notes, 
debit notes, adjustments, write-offs, interest   charges, returned checks, and refunds. 

Important! If you are entering statistics as part of the setup of your Accounts   Receivable ledger, do 
not include amounts you will post for the customers   when you enter historical and year-to-date 
Accounts Receivable transactions.   If you do, the amounts will be added twice to the statistics.

Year

Type or select the year for which you want to enter or view statistics.

The type of year by which you keep statistics is determined by the selection of Fiscal Year or Calendar 
Year for the Accumulate By option for   customers, customer groups, and national accounts on the   
Processing tab of the A/R Options screen. 

A/R Customers Screen

To Open this Screen

Open Accounts Receivable > A/R Customers > Customers.

Secondary Screens

 l A/R Credit Card Information Screen

Related Tasks

 l "Adding and Modifying Customer Records" (page 85)

 l "Adding a Multicurrency Customer" (page 89)

 l "Changing a Customer's Credit Limit" (page 88)
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Overview

Note: Depending on how your system is set up, this desktop screen may also be available as a web 
screen. For more information, see the Web Screens Getting Started Guide or the help for Sage 300 
web screens.

You use the A/R Customers screen to:

 l Add, edit, and delete customer records.

For an overview of the process of setting up customer records, see "About Setting Up Customer Records" 

(page 60). 

For background information on the types of information stored in a customer record, and how it is used 
in Accounts Receivable, see "About Accounts Receivable Customers" (page 73)

 l Add credit card information for a customer.

 l Add or view comments for following up with a customer.

 l View credit information and statistics for a customer.

Activity Tab

Use this tab to:

 l View current-year and previous-year account activity for the selected customer.

Account activity includes the current balance, the last statement balance, the number of outstanding 
invoices, the amount of the last-posted invoice, outstanding retainage, and so on.

 l Edit activity statistics when first setting up customer accounts.

Address Tab

Use this tab to look up or change the customer's national account, address, contact name, telephone 
number, e-mail address, fax number, start date, and territory code for the customer. More...

You cannot change the customer number, but you can change all other information on the Address tab 
with these restrictions:

 l National account. If you use National Accounts Management, you can assign a customer to a 
national account, change a customer's national account, or remove the national account.

If you use multicurrency accounting, you can change a customer's national account only to another 
national account that uses an account set with the same currency as the customer.

 l Group code. You can change the customer's group code at any time, provided that the customer 
does not belong to a national account. If the customer belongs to a national account, you can 
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change the group for the customer record only by changing it in the national account assigned to 
the customer.

If you use multicurrency accounting, you can change the customer's group to a group that uses an 
account set with a different currency, but you must select a tax group with the same currency as the new 
account set before you can save the change.

 l Inactive.You can select Inactive status for a customer record only if the account has a zero 
balance and no outstanding transactions. 

Comments Tab

Use this tab to:

 l Add or edit any number of comments to the customer record.

 l View a list of comments entered for the customer.

Contact Tab

Use this tab to view or enter a name, telephone number, fax number, and e-mail address for a contact 
person, separate from the information stored on the Address tab for the company.

If you use the Multiple Contacts (M/T) program, this tab includes a Multiple Contacts section that allows 
you to assign multiple contacts to a customer. For more information, see "Setting Up Multiple Contacts for 
Customers and National Accounts" (page 84).

Credit Card Tab

If you use Payment Processing, use this tab to add, edit, and delete credit cards for a customer.

When you add a new credit card or open a saved credit card, the Credit Card Information screen appears. 
You use it to set up or edit the credit card record, and to add or edit billing details and credit card details. 
For more information, see A/R Credit Card Information Screen.

Warning! 
Do not record any card details in the Comments field, including card number, expiration date, and CVV 
number. Storing details in this way can compromise credit card security and may constitute a violation 
of the Payment Card Industry Data Security Standard (PCI DSS). 

If a security breach occurs, merchants that do not comply with PCI DSS may be subject to fines, card 
replacement costs, forensic audits, and other penalties. 

For more information about how credit card information is used in Accounts Receivable, see "About 
Customer Credit Cards" (page 83)
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Invoicing Tab

Use the Invoicing tab to:

 l Select a Sage 300 Inventory Control price list and Sage 300 Order Entry customer type.

 l Indicate whether you allow partial shipments for this customer. (Order Entry creates invoices for 
partial shipments only if the customer record permits it.)

 l Indicate whether you can create backorders for the customer when you cannot ship the full order.

 l Specify whether Order Entry displays a warning, an error, or no message when you process an 
order or a shipment for a purchase order number that is already used in an order or a shipment for 
the customer.

 l Specify a default inventory location for Order Entry, if you use it.

 l Indicate whether you allow the customer to shop at your Web store through eTransact.

 l Specify the salespeople who are responsible for the account, and the percentage of each of the 
customer's transactions that you allocate to each salesperson. 

 l Specify the ship-via method and free-on-board point for the customer. If you choose not to set up a 
primary ship-to location for the customer, Accounts Receivable uses these details as the defaults 
when you set up a recurring charge or create an invoice for the customer. Order Entry also uses 
these details by default when you process an order for the customer.

 l Specify the tax group that identifies the tax authorities and classes used for the customer, and 
enter registration numbers, such as a tax-exemption number.

You can change your choices for these options at any time.

Optional Fields Tab

Note: This tab appears only if you have activated Sage 300 Transaction Analysis and Optional Field 
Creator.

You use this tab to:

 l Assign to a customer any optional fields that are defined for customers, national accounts, and 
customer groups. (You define optional customer fields using the Optional Fields screen in the 
A/R Setup folder.)

 l Specify optional field values for the customer. These values will also be used as defaults when you 
use the optional fields on invoices (unless you specify a ship-to location with a different value).

For more information, see "About Customer Optional Fields" (page 80).

Processing Tab

Use the Processing tab to specify:
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 l The customer's account type (open item or balance forward).

 l Whether you print statements for the customer.

 l The account set which, in multicurrency ledgers, identifies the customer's currency.

 l The billing cycle, interest profile, and terms code to use for the customer.

 l A default receipt type for receipts that you enter for this customer.

 l A delivery method for sending statements and invoices to the customer.

 l Whether to issue a credit warning if the customer's outstanding transactions exceed a specified 
credit limit, or if overdue transactions exceed a specified amount for a specified period.

 l The credit limit, and the maximum amount and days overdue, that you allow the customer, if the 
customer group lets you set individual credit limits.

 l The credit bureau information for the customer, such as a credit bureau number, rating, and date.

 l The rate type to use for converting transactions for the customer to the functional currency (in 
multicurrency ledgers).

Notes: 
If the customer is assigned to a national account on the Address tab:

 l You cannot change the account type, billing cycle, and interest profile. This information is 
supplied by the national account record.

 l The customer's account set must use the same currency as the national account's account set.

Statistics Tab

Use the Statistics tab to:

 l View the numbers and amounts of all transactions processed for the customer in the year and 
period you select.

 l View the total days to pay figure and the average days to pay figure for the account for a specified 
year and period.

 l Change statistical information if the Allow Edit Of (customer) Statistics option is selected on the 
Processing tab of the A/R Options screen.

Fields and Controls

Customer Name

Use this field to record the name of the customer, using up to 30 characters.

Type the name in the order in which you want it to appear in Accounts Receivable screens and on 
reports (for example, first name, followed by   surname).
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Customer Number

This number identifies the customer in Accounts Receivable.

To create a new customer record, enter a unique code of up to 12 characters, including letters, digits, 
symbols, and spaces.

To open an existing customer record, type the customer number, or use the Finder or the navigation 
buttons to select it.

To view comprehensive information for a selected customer in the Customer Inquiry screen, click the 

Inquiry  button beside the field.

Activity tab

Account Activity

The Account Status fields display the current status of the account —outstanding balance,   number of 
open invoices, last statement balance, and date of last statement—  as well as information you can edit, 
such as the highest balance this   year and last year, the largest invoice this year and last year, and the   
last invoice, receipt, credit note, debit note, adjustment, write-off,   interest charge, returned check, and 
discount taken. 

Activity statistics   also include the total number of days to pay invoices, the number of fully   paid invoices, 
and the average number of days to pay invoices.

Amount

The Amount column shows the total amount   for each of the transaction types listed in the Statistics 
column. 

Accounts Receivable updates these amounts when you post transactions   to the account. 

You can change this figure if the Allow Edit Of Statistics option is selected for customers on   the 
Processing tab of the A/R Options screen. 

Average Days to Pay

This field shows the average number of days it has taken the customer to pay   all the invoices that were 
fully paid in the current year. 
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The average days to pay  is calculated by dividing the Total Days To Pay figure by the Total Invoices 
Paid figure. You can alter the Average Days to Pay field only by editing   the other two fields.

Currency 

If you use multicurrency accounting, activity statistics are recorded   in the customer's currency as well 
as in their equivalent values in the   functional currency. You can choose whether to view or edit statistics   
in the customer currency or the functional currency. 

Use the Currency field on the Activity tab to select the currency in   which to display statistical totals.

Date

The Date column lists the   date each type of transaction (shown in the Statistics column)   was posted to 
the customer's account. 

Accounts Receivable updates these dates when you post transactions to   the customer's account. 

You can edit the dates if the   Allow Edit Of Statistics option is selected for customers on the Processing 
tab of the   A/R Options screen. 

Last Statement Balance

This field displays   the balance that appeared on the last statement you printed for the account. 

You cannot edit the figure.

Last Statement Date

This field displays   the date on which you printed the last statement for this account. 

You   cannot edit the date.

Open Invoice Count

This field shows the current number   of open (unpaid) invoices in the account. 

You cannot edit this figure.

Outstanding Balance

This field displays the current net amount owed by a customer (or national account), including all 
invoices, credit notes, debit notes, receipts and adjustments posted to the account.
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You cannot edit the figure.

Outstanding Retainage

This field shows the outstanding retainage balance for the customer   (or national account).

Statistics

The Activity tab lists the amount and date for the transactions with   the highest balance this year and last 
year; for the largest invoices this   year and last year; and for the last posted invoice, receipt, credit note,   
debit note, adjustment, write-off, interest charge, returned check, discount   taken, and refund.

Accounts Receivable updates these figures each time you post transactions   for the account. 

You can edit the amounts and dates if the Allow Edit Of Statistics option is selected for customers on   
the Processing tab of the A/R Options screen.

Field Name

This field shows the total number of days the customer has taken to pay all outstanding   invoices that 
have been fully paid in the current year to date. 

Accounts Receivable updates this figure when you post transactions to   fully pay the customer's 
invoices. 

You can change this figure if the Allow Edit Of Statistics option is selected for customers on   the 
Processing tab of the A/R Options screen. 

Example: You want to change   the number because it has been inflated by unusual circumstances, 
and so gives   an inaccurate impression of the customer's payment record.

Important! If you are entering this number when setting up customer records, do not enter   figures 
from invoices and other transactions that you will post for the customer   when you enter historical and 
year-to-date Accounts Receivable transactions. Otherwise, these statistics will be distorted.

Total Days to Pay

This field shows the total number of days the customer has taken to pay all outstanding   invoices that 
have been fully paid in the current year to date. 

Accounts Receivable updates this figure when you post transactions to   fully pay the customer's 
invoices. 
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You can change this figure if the Allow Edit Of Statistics option is selected for customers on   the 
Processing tab of the A/R Options screen. 

Example: You want to change   the number because it has been inflated by unusual circumstances, 
and so gives   an inaccurate impression of the customer's payment record.

Important! If you are entering this number when setting up customer records, do not enter   figures 
from invoices and other transactions that you will post for the customer   when you enter historical and 
year-to-date Accounts Receivable transactions. Otherwise, these statistics will be distorted.

Total Invoices Paid

This is the total number of invoices that have been fully paid in the   current year to date. 

Accounts Receivable updates this figure when you post transactions to   fully pay invoices in the 
customer's account. 

You can change this figure if the Allow Edit Of Statistics option is selected for customers on   the 
Processing tab of the A/R Options screen. 

Important! If you are entering this number when setting up customer records, do not enter   figures 
from invoices and other transactions that you will post for the customer   when you enter historical and 
year-to-date Accounts Receivable transactions. Otherwise, these statistics will be distorted.

Address tab

Address

The address in the customer record or national account is usually the   address that is printed on invoices 
and statements for the account. 

When customers belong to a national account, the address in the customer   record is usually the billing 
address for the national account. You   use ship-to locations to record the customer's actual address. 
You also   use ship-to locations if the customer has more than one address. 

Business Reg. No.

Enter the business registration number for the customer. This number is required for tax purposes in 
some jurisdictions (such as Malaysia and Singapore).
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City

Type the name of the city where the customer resides or where you ship goods.

You can enter the name of the city in other address lines. However, the customer address on your 
statements, letters, and labels may not appear correctly. Also, if you export data to use in other 
programs, the field is more useful when you use the field consistently for the city.

Country

Specify the name of the country where the business is located.

E-mail

You use this field to record your customer's   e-mail address. 

Fax

You use this field to record the fax number, if any, for your customer, national   account, or ship-to 
location. 

The field includes area code parentheses and hyphens if you selected   the Format Phone Number 
option for the company in the Company Profile   screen in Common Services.

Group Code

Use this field to assign a customer group to a selected customer or national account. Type   the code or 
use the Finder to select it. 

You must specify a customer   group for each customer and national account.

You can change the customer group for a national account or for a customer at any time, unless the 
customer   belongs to a national account (in which case the customer record must use the customer   
group assigned to the national account). You can change the group for the customer only   by changing it 
for the national account. 

In a multicurrency system, you can change the customer group to one that   uses a different currency. 
However, you must change the account set for a national account if the new group has an account set 
that uses a different currency from the national account.

If you change the customer group for an existing customer, the settings   in the customer record remain 
unchanged, except for the customer group.   
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Inactive

Click this option if you do not want to post any new transactions to the   customer's account, usually 
because you plan to delete the account. 

You can select Inactive status only if the account balance is zero and   there are no unposted or 
outstanding transactions. You can set a customer   record inactive if there are active recurring charges 
for the customer,   however.

You can make the account active again at any time.

On Hold

Select the On Hold option if you want to place   a customer account on hold. 

When an account is on hold, you see a warning   when you start to enter an invoice for the customer. You 
can then choose   whether to continue entering the invoice. 

You can always enter and post invoices, credit notes, debit notes, receipts,   and prepayments, whether 
a customer account is on hold or not.

Last Maintained

This information field displays the date   of the last change made to the customer record. You do not 
make an entry   in this field.

National Account Number

To assign a national account to a customer, enter the national account number in this field. (Leave the 
field blank if you do not use national accounts or the customer does not belong to a national account.)

Notes: 
 l In multicurrency ledgers, a customer's national account must use the same currency as the 

customer.

 l If you change a customer's national account, and there are documents posted to the 
customer's old national account, any related unposted documents will also be posted to the 
customer's old national account.

Example: You have posted an invoice to National Account NATACCT1 but have not yet posted 
the corresponding receipt. You change the customer's national account to NATACCT4. When 
you post the receipt to a national account, it is posted to NATACCT1.

386Sage 300 2023 Accounts Receivable User's Guide



Short Name

You can use this field to enter a short name for the customer. Short names are a means by which you 
can list customers in alphabetical   order or another order on reports, and still include the full customer   
name in the customer record.

Accounts Receivable   automatically assigns the first ten characters (including any spaces)   of the name 
entered in the Name field. You can type   another short name, or erase the default name and leave the 
field blank.   

Start Date

This field lets you record the date on which the customer first became   one of your company's accounts.

State/Prov.

This field contains the name of the state or province where the business   is located. You can type up to 
20 characters in the field, including spaces.

Telephone

This field usually contains the telephone number at the place of business   of the customer, national 
account, or ship-to location. 

The field includes area code parentheses and hyphens if you selected   the Format Phone Number 
option for the company in the Company Profile   screen in Common Services.

Territory Code

Use this field to store an optional two-character territory code that your company uses to identify   or sort 
customer accounts in a way that is not otherwise available in   Sage 300 Accounts Receivable. You can 
also assign a territory code   to the ship-to locations you create for the customer. 

You maintain the information associated with each territory code outside   Accounts Receivable, but you 
can use the code to select customers when   printing Accounts Receivable reports and statements.

Web Site

If the customer has a website, you can enter its URL in   this field.

Zip/Postal Code

Type the zip code or postal code for the address.
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Comments tab

Comment

You can enter up to 250 characters for each comment. 

You use one line on the table for each comment. To start a new comment   line, click the table, then 
press the Insert key on your keyboard.

To enter or edit text for a comment, or to view the text for an existing   comment, you use the Comment 
screen. 

To open the Comment screen, select the   line on the table, then click the Comment column heading.

Comment Type

You can select a comment type code if you want to classify the comment.   You can then filter comments 
by comment type code when you look up customer   information on the Customer Inquiry screen.

You can select any comment type code that has been set up using the   Comment Types screen in the 
A/R Setup folder.

Date Entered

Type the date on which you entered the comment, usually the current   date.

Expiration Date

Type the date on which you want to delete the comment.

Accounts Receivable displays a date based on your entry for the Default   Number Of Days To Keep 
Comments option on the A/R Options screen. You can change   the date.

You use the Clear Customer Comments option in the Clear History screen   to remove comments that 
have passed their expiration dates.

Follow-Up Date

Type the date on which you intend to check on the comment. 

You can specify a range of follow-up dates for comments and include   them on the Customer List.

User ID

Enter your user ID.
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Contact tab

Contact

This field usually contains the name of a contact person, position,   or department for the customer, ship-
to location, or national account.   

You can also leave the field blank or enter other information in it, using   up to 30 characters.

E-mail

You use this field to enter the   e-mail address of your contact for this customer. 

Fax

This field contains the fax number, if any, for your customer's contact   person. 

The field includes area code parentheses and hyphens if   the Format Phone Number option is selected 
for the company on the Company Profile   screen in Common Services.

Telephone

This field usually contains the telephone number at the place of business   of the customer, national 
account, or ship-to location. 

The field includes area code parentheses and hyphens if you selected   the Format Phone Number 
option for the company in the Company Profile   screen in Common Services.

Multiple Contacts

If you use the Multiple Contacts (M/T) program, this section appears on the Contact tab, allowing 
you to assign multiple contacts to a customer. For more information, see "Setting Up Multiple 
Contacts for Customers and National Accounts" (page 84).

Create New Contact

Click this button to create a new contact record and assign the new contact to the customer.

389Sage 300 2023 Accounts Receivable User's Guide



Show Documents For

This field displays All by default, and the table includes a column for each type of document that can be 
sent to contacts. If you select a specific program in this field, the table includes columns for only 
documents for the selected program.

View Contact Details

Select a contact in the table and then click this button to view and edit the contact's details.

Credit Card tab

This tab appears if you use Payment Processing. Use it to enter customer credit card information.

Bank

This field displays the bank that will be used to process transactions for the credit card. The bank that 
will be used is determined by the processing code selected for the card. (Processing codes specify a 
bank, currency, and merchant account.)

To select a different bank, double-click the card on the Credit Card tab, and on the Credit Card 
Information screen, select a processing code that specifies the bank you want to use.

Card ID

The Card ID is a short code you use to identify the card. For example, you might use "VISA" for a 
customer's Visa card.

Card Number

This field displays the credit card number, with the first 12 digits replaced with Xs. 

You enter and modify the credit card number in the Paya browser form, not in Sage 300. 

To change a credit card number, double-click the card on the Credit Card tab, and then click the Edit 
Card Details button to open the Paya browser form.

Cardholder Name

This field displays the name of the person to whom the card was issued, or the name of an additional 
person authorized to use the card. 
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When you process a credit card transaction, Address Verification Service (AVS) checks the information 
in this field against the information on record for the cardholder.

Currency

This field displays the currency that will be used to process transactions for the credit card. The 
currency that will be used is determined by the processing code selected for the card. (Processing 
codes specify a bank, currency, and merchant account.)

To select a different currency, double-click the card on the Credit Card tab, and then, on the Credit Card 
Information screen, select a processing code that specifies the currency you want to use.

Default

This field shows whether the credit card is the default card for a customer.

Description

This field displays a short description for the credit card. 

Example: A customer's corporate Visa card might have the description "Corporate Visa card."

Expiration Date

This field displays the expiration date for the credit card, in the screen at MM/YY.

You enter and modify the expiration date for a card in the Paya browser form, not in Sage 300.

To change an expiration date, double-click the card on the Credit Card tab, and then click the Edit Card 
Details button to open the Paya browser form.

Processing Code

This field displays the processing code, which specifies the bank, currency, and merchant account that 
will be used to process transactions for the credit card.

To select a different processing code, double-click the card on the Credit Card tab, and then select a 
processing code on the Credit Card Information screen.

Note: When you are processing a transaction for this credit card, if you select a bank or currency 
other than the one that was specified for this processing code, an error message informs you that the 
bank or currency does not match the one specified for the processing code.
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Status

This field displays the status of the credit card, which may be Active or Inactive.

To change the status of a credit card, double-click the card on the Credit Card tab, and then edit its 
status on the Credit Card Information screen.

Type

This field displays the credit card type, which is determined automatically by Paya after you enter the 
card number.

Invoicing tab

Allow Backorder Quantities

If the customer allows backorders (which arise when you do not have the quantity on hand to fully ship 
an order), select Allow Backorder Quantities.

If you select this option for a customer, and you:

 l Use the Calculate Backorder Quantitiesoption in Sage 300 Order Entry, Order Entry 
automatically calculates the backorder quantity when you ship an order for the customer.

 l Do not use Calculate Backorder Quantities, you can manually enter the backorder amount in 
Order Entry.

 l Use the option in Order Entry to commit backordered quantities, Order Entry also creates a 
commitment for the unfilled portion of the order.

If you do not select this option, no backorder quantity appears on orders for the customer in Order 
Entry. Also, Order Entry does not create a commitment for unfilled quantities on partial shipments.

Allow Partial Shipments

Select this option to allow partial shipments of items for a customer. (The   default setting is Yes.)

Order Entry lets you ship and invoice partial orders only for customers   for whom you allow partial 
shipments.

Allow Web Store Shopping

Select this option to allow a customer to shop at your Web store through   eTransact. (The default setting 
is No.)
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Salespersons

Use the salespersons field on the Invoicing tab in a customer record to:

 l Assign up to five salespeople to each customer record.                                         

To enter salesperson information, type the salesperson number or select it from the Finder, then type 
the percentage. To move to the next line, press Tab or click the next Salesperson Number field.

To delete a salesperson assignment, highlight the line, then press the Delete key on your keyboard.

 l Indicate the percentage of sales and returns totals to allocate to each sale.

The salesperson information you enter in a customer record appears for the customer in the Invoice 
Entry screen, where you can change the salesperson numbers and percentages as needed.

You do not have to enter salesperson information for customers, and you can change any salesperson 
information you enter in the record at any time.

Check for Duplicate POs

Use this option to specify whether Sage 300 Order Entry should display a message when you enter an 
order or a shipment for a purchase order number that is already used in an existing order or standalone 
shipment for the customer. (A standalone shipment is one that has no corresponding order.)

Select None if you do not want Order Entry to check for duplicate purchase order numbers.

If you want Order Entry to check whether you have already processed a specified purchase order, 
select the type of message you want to display. You can select one of the following messages:

 l Warning. If you select this option, Order Entry displays a warning message if the purchase order 
number is used on any existing orders or standalone shipments for the customer when you try to 
process an order or a shipment that uses the purchase order number. You can still process the 
duplicate order or shipment when you receive a warning.

 l Error. If you select this option, Order Entry displays an error message when you enter a duplicate 
order or standalone shipment for the customer, and you cannot post the duplicate order or 
shipment.

Note: This purchase order number is the customer's order number and is not generated in your Sage 
300 Purchase Orders program.

Customer Price List

Use the field to assign a Sage 300 Inventory Control price list to   the customer or location. You can also 
enter other information in the   field or leave it blank. 
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This field is not related to the price list, if any,   that you create in Accounts Receivable. 

Customer Type

Use the Customer Type field when you also use Sage 300 Order Entry to specify   the customer type to 
use when you are entering orders of the customer   in Order Entry. 

The customer type is not used by Accounts Receivable. 

FOB Point

Enter a description of the FOB point, using up to 30 characters.

Inventory Location

The inventory location you specify in this field is used as the default   for transactions you enter in Order 
Entry for the customer or ship-to   location, unless you specify a template for the transaction.

Percentage

Type the percentage of the customer's transaction   totals to allocate to each salesperson. 

The percentages you assign must add up to 100%.

The salespersons and percentages you assign to a customer group record   appear as defaults when 
you add a new customer record for the customer   group.

The salespeople and percentages you assign to a customer record or ship-to   location appear as 
defaults on the Sales Split tab on the Invoice Entry   screen when you enter transactions for the customer 
or for the customer's   ship-to location, but you can change the information for a particular invoice,   credit 
note, or debit note. 

Primary Ship-to

This field shows the primary ship-to location, if any has been designated   for a customer.

Accounts Receivable uses the shipping information from the primary ship-to   location record as default 
entries when you set up a recurring charge   record or create an invoice for the customer. Order Entry 
also uses this   information when you process an order for the customer.
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Registration Number

If your customer has a tax registration number for the particular   tax authority or tax class, type the 
number in the Registration Number   field.

Retainage Percentage (%)

You can specify on the customer record the default percentage to use   for calculating retainage on 
original documents. You can always change   the retainage percentage when you enter an invoice, debit 
note, or credit   note for the customer.

When you add a new customer record, the retainage percentage you specified   on the A/R Options 
screen appears as the default, but you can change it   for a particular customer.

Retainage Terms

You can specify on the customer record a default terms code to use for   original documents. You can 
always change the retainage terms when you   enter an invoice, debit note, or credit note for the 
customer.

When you add a new customer record, the retainage terms code you specified   on the A/R Options 
screen appears as the default, but you can change it   for a particular customer.

Retention Period

You can specify on the customer record the default retention period   to use on original documents. You 
can always change the retention period   when you enter an invoice, debit note, or credit note for the 
customer.

When you add a new customer record, the retention period you specified   on the A/R Options screen 
appears as the default, but you can change it   for a particular customer.

Salesperson Code

Use the Salesperson Code column to specify the salespersons who are responsible   for the customer's 
account. You can type the code or select   it using the Finder.

You can select up to five salespeople, but you must select salesperson   codes that are defined in 
Accounts Receivable. 

The salespersons specified for the customer group appear as default   entries for new customer records 
you add to the group.
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Salespersons specified for a customer appear as default entries for   new ship-to location records you 
add for the customer.

Salesperson Name

The Salesperson Name field displays the name entered in the Salespersons   record for each 
salesperson code. 

You cannot change any of the names on this tab. (Use the Salespersons   screen to change salesperson 
names.)

Ship Via

In the first Ship Via field:

 l If you use Order Entry, type a code that you have set up in Order Entry, or select it using the 
Finder.

 l If you do not use Order Entry, you can enter a code that you maintain elsewhere., using up to six 
alphanumeric characters.

 l You can also leave this field blank if you do not want to use a ship via code.

If you enter a ship-via code in the first field, the description for that code appears by default in the 
description field to the right of the ship-via code. Enter a description of the ship via method, using up to 
30 characters, or accept the description displayed.

Tax Authority

Tax authorities are the types of taxes to which a customer may be subject. For example, state and 
provincial sales taxes are tax authorities,   as are GST and VAT. 

Tax authorities are determined by the customer's tax group, and you cannot   change them or add other 
authorities in the customer record. You can   change the tax classes or enter tax registration numbers 
only for tax authorities   in customer records.

You define and update records for tax authorities and enter other taxation   information in the Tax 
Services screens in Common Services. 

Tax Class

In the Tax Class field, type the number of the   tax class to use for the customer or customer group, or 
use the Finder to select it.
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Tax classes identify the tax rates used to calculate taxes when you   enter invoices, debit notes, and 
credit notes for a customer. Each tax class identifies a tax rate.

Example: Assigning class 1   may charge a customer the full tax rate, class 2 may charge a lower rate,   
and class 3 may mean the customer is tax-exempt.

Tax classes are determined by the tax authorities in the customer's   tax group. You can change only to 
another tax class that is assigned to   the corresponding tax authority in Tax Services.

You define and update tax classes and enter other taxation information   in the Tax Services screens in 
Common Services. 

Tax Group

In the Tax Group field, type the code   for the tax group you want to assign, or use the Finder to select it. 

You assign a tax group to each customer record to specify the taxing   authorities and classes that apply 
to the customer's invoices, debit notes,   and credit notes. 

Note: You must assign a tax group to every   customer record, whether taxes are levied in the 
customer's area or not.   

You define and update tax groups and enter other taxation information   in the Tax Services screens in 
Common Services. 

Optional Fields tab

Optional fields are available only if you use Transaction Analysis and Optional Field Creator.

You can accept the default optional fields that appear on the tab, or delete them. You can also   add 
different optional fields that you have set up for use with each  screen. 

For more information, see "About Optional Fields in Accounts Receivable" (page 41).

Processing tab

Account Set

The account set specifies the general ledger receivables control, payment   discounts, prepayment 
liability, retainage, and write-offs accounts to   which a customer's transactions are distributed. 

To select the account set, type its code in the Account Set field or   select it from the Finder.

For more information about account sets, see "About Account Sets" (page 21).
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Account Type

The account type determines how you apply receipts to a customer's account:

 l For balance-forward accounts, you apply receipts to the customer's outstanding balance.

 l For open-item accounts, you apply receipts to specific documents by document number. 

To specify the account type, select it from the list. (You can also type O or use the Up Arrow on your 
keyboard to select Open Item, or type B or use the Down Arrow to select Balance Forward.)

Customer groups and national accounts determine the default account type for new customer records. 
You can select a different account type in a customer record, unless the customer is assigned to a 
national account. (You cannot change the account type for members of national accounts.)

For more information about account types, see "About Customer Account Types" (page 78).

Billing Cycle

In the Billing Cycle field, type the code for the billing cycle to use for the customer, national account, or 
customer group, or use the Finder to select it.

For information about billing cycles, see "About Billing Cycles" (page 24).

Check Language

Select the language in which you print refund checks for the customer.

The language you select is used only for the check amount when it is written out. 

Credit Bureau Information

Use the Credit Bureau Information fields to enter   a credit bureau number and rating for the customer or 
national account.

Currency

This field displays the currency assigned to the account set. 

You enter all invoices, debit notes, and credit notes for the customer or national account in the account 
set currency, but you can apply receipts from the customer or national account in other currencies.
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Date (Credit Bureau Information)

If you record credit   bureau information for a customer or national account, you can also enter   the date 
on which the credit information was assigned. 

Change the date in this field whenever you change the credit   information. 

Delivery Method

Specify how invoices, receipts, statements, and letters are delivered to the customer:

 l Mail. Print to your usual print destination.

 l Email (customer). Print to a file and email the file to the email address specified for the customer 
on the Address tab.

 l Email (contact). Print to a file and email the file to the contact email address specified for the 
customer on the Contact tab.

 l Email (multiple contacts). If you use the Multiple Contacts (M/T) program, you can use this 
delivery method to print to a file and email the file to all the contact email addresses specified for 
the customer in the Multiple Contacts section on the Contact tab.

Note: If you select Customer as the delivery method when printing invoices, receipts, statements, 
and letters, the program uses the delivery method specified in the customer or national account 
record.

Interest Profile

You assign an interest profile to each customer, group, and national   account to specify the method and 
rates to use when charging interest   on overdue amounts, and the general ledger account to which you 
post interest   revenue.

Type the code to use in the Interest Profile field, or select it from   the Finder.

Note: You must assign an interest profile to every customer, group,   and national account. If you do 
not charge interest, assign an interest   profile with a zero rate.

Interest profiles are first assigned to customers and national accounts   by the customer group, but you 
can change to another profile in the customer   record. If you change a customer's group, the new 
group's interest profile   replaces the profile in the customer record, but you can change it as   well.

National account customers use the national account's interest profile,   and you can change a 
customer's profile only by changing the interest   profile for the corresponding national account. 

For information about interest profiles, see "About Interest Profiles" (page 32)
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Issue Credit Warning When Total Outstanding   Balance Exceeds The Credit Limit Of [ ]

This option shows whether you will receive a warning when you enter   a transaction for the customer 
whose total outstanding balance is greater   than a specified credit limit.

If you select this warning for a customer, when you enter an order for   the customer in Order Entry, if the 
order would exceed the credit limit,   Order Entry displays a credit check screen, and a user with 
authorization   must override the limit before you can post the transaction.

If a customer belongs to a national account, the selection for the option   and the credit limit from the 
national account record appear as defaults.   Otherwise, the information from the customer group record 
appears. (In   multicurrency ledgers, the credit limit specified for the customer currency   is used.)

If you selected the Allow Edit Of Credit Check option for the customer   group, you can change the 
option and the credit limit amount for the customer.

If you selected options (on the A/R Options screen) to include pending   transactions in credit checks, the 
pending transactions are included in   the customer's outstanding balance when performing a credit 
check.

Issue Credit Warning When A/R Transactions   Overdue By [ ] Days Or More Exceed The 
Overdue Limit Of [ ]

This option shows the number of days overdue and the amount that overdue   transactions must exceed 
to generate a credit warning when you enter transactions.   

Example: If the option stipulates that transactions 90 days or more   cannot exceed 250.00, a credit 
check warning appears when you enter a   new transaction for a customer with transactions worth 
$300.00 that are   overdue by at least 90 days.

If you select this warning for a customer, when you enter an order for   the customer in Order Entry, if the 
order would exceed the overdue limit,   Order Entry displays a credit check screen, and a user with 
authorization   has to override the limit before you can post the transaction.

If the customer belongs to a national account, the information specified   in the national account record 
appears as the default. If the customer   does not belong to a national account, the information from the 
customer   group record is used. (In multicurrency ledgers, the overdue limit specified   for the customer 
currency is used.)

If you selected the Allow Edit Of Credit Check option for the customer   group, you can change the 
selection for the option, the aging period,   and the overdue limit for a customer.
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Number (Credit Bureau Information)

In each customer or national account record, you can record a number   that is assigned for the business 
by a credit bureau. You can change this number at any time.

Payment Code

Select the default payment code to use for receipts you enter for the customer. If you do not set a 
default payment code for a customer, Receipt Entry uses the default payment code from the 
A/R Options screen.

Note: To process credit card payments for a customer using quick processing buttons, or using the 
A/R Process Credit Card Payments screen, you must specify a payment code that uses the payment 
type SPS Credit Card.

Print Statements

Select this option if you want to print the statements for this customer.

If you have selected Print Statements for a national account, you cannot select the option or print 
separate statements for a member   customer of the national account.

Rate Type

For multicurrency customers   or national accounts who do not use the functional currency, you specify   
the default rate type to use to convert transactions into the functional   currency. When entering 
transactions for the customer or national account,   you can change the rate type, if needed.

To specify the rate type, type its code or use the Finder to select it.   You must specify a rate type that is 
defined for the company in the Currency   screens in Common Services. 

Rating (Credit Bureau Information)

In each customer or national account record, you can record a code that   indicates the account's credit 
rating, such as a rating that is assigned   by a credit bureau. 

You can enter a new rating at any time.

Terms Code

You assign a terms code to each customer and customer group  to specify the payment terms to use on 
invoices for the customer. 
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Note: You must assign a terms code to every   customer and customer group in Accounts Receivable.

For more information about customer payment terms, see "About Customer Payment Terms" (page 54)

Statistics tab

Amount

Use the Amount column to view, edit, or add the   total amount of the invoices, receipts, credit notes, and 
other documents   that were processed for the account during the displayed period.

In multicurrency ledgers, you can enter or view totals in either the   customer's currency or the functional 
currency for the ledger. Use the   Currency field to specify the currency to use.

If you are entering statistics as part of the setup of your Accounts   Receivable ledger, do not include 
amounts you will post to the account   when you enter historical and year-to-date Accounts Receivable 
transactions.   If you do, the amounts will be added twice to the statistics.

Average Days to Pay

Accounts Receivable keeps track of the average number of days it takes   each customer (or all the 
customers assigned to a customer group or national   account) to pay each invoice, and displays the 
figure in the Average Days  To Pay field.   You cannot change the figure.

The figure for each period is calculated by dividing the total number   of days it took to pay the invoices 
that were fully paid in the period   by the number of invoices that were issued to the account, both in the   
displayed period and in prior periods. 

Currency

If you use multicurrency accounting, period statistics are recorded   in the currency used by the customer 
or national account, as well as in   their equivalent values in the functional currency. You can choose 
whether   to view or edit statistics in the customer's currency or the functional   currency. 

Use this Currency field to select the currency   in which to display statistical totals.

Count

Use the Count column on the Statistics tab to view, edit, or add the   total number of invoices, receipts, 
credit notes, and other transactions   that were processed for the account during the displayed period.
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Important! If you are entering statistics as part of the setup of your Accounts   Receivable ledger, do 
not include amounts you will post for the customers   when you enter historical and year-to-date 
Accounts Receivable transactions.   If you do, the amounts will be added twice to the statistics.

Period 

Select the fiscal period for which you are entering or viewing statistics.   

The type of period by which you keep statistics is determined by the selection for the Period Type 
option for customers, customer groups, and national   accounts on the Processing tab of the A/R Options 
screen. (Period   types include Weekly, Seven Days, Bi-weekly, Four Weeks, Monthly, Bi-monthly,   
Quarterly, Semi-annually, and Fiscal Period.)

Total Days to Pay

Accounts Receivable records the length of time it takes a customer (or   all the customers assigned to a 
customer group or national account) to   fully pay each invoice, then displays the total in the Total Days 
To Pay   field on the Statistics tab on the Customers screen, the National Accounts   screen, and the 
Customer Groups screen. 

The total that appears for a period is the number of days it took to   pay all the invoices that were paid in 
full during the selected period.   

You can edit this total, as needed, to set up and update statistics.   

Transaction Types

The Transaction Types column on the Statistics tab lists all the types of   transactions for which totals 
and numbers are kept. 

You can edit, view, and add total amounts and numbers of invoices, receipts,   discounts, credit notes, 
debit notes, adjustments, write-offs, interest   charges, returned checks, and refunds. 

Important! If you are entering statistics as part of the setup of your Accounts   Receivable ledger, do 
not include amounts you will post for the customers   when you enter historical and year-to-date 
Accounts Receivable transactions.   If you do, the amounts will be added twice to the statistics.

Year

Type or select the year for which you want to enter or view statistics.
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The type of year by which you keep statistics is determined by the selection of Fiscal Year or Calendar 
Year for the Accumulate By option for   customers, customer groups, and national accounts on the   
Processing tab of the A/R Options screen. 

YTD Average Days to Pay

Accounts Receivable keeps track of the average number of days it takes   a customer to pay each 
invoice.

The program displays the average for the year in the YTD Average Days   To Pay field on the Statistics 
tab. You cannot change   the figure.

YTD Total Days To Pay

This is the total number of days the customer has taken to pay all outstanding   invoices that have been 
fully paid in the current year to date. 

Accounts Receivable updates this figure when you post transactions to   fully pay the customer's 
invoices. You cannot change this figure.

A/R Customer List Screen

To Open this Screen

Open Accounts Receivable > A/R Customers > Customer List.

Secondary Screens

 l A/R Customer List Preview Screen

Related Tasks

 l "Creating a Contact List for Following Up with Customers" (page 116)

 l "Creating a List of Customers for a Marketing Campaign" (page 119)

 l "Printing a List of Customers" (page 287)

 l "Printing a List of Inactive Customer Accounts" (page 288)

 l "Printing a List of Overdue Customer Accounts" (page 290)
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Overview

The Customer List is a powerful tool that provides field-level selection and analysis of your customer 
database. Use it to:

 l Filter and extract customer information from your Accounts Receivable database using criteria you 
specify. 

 l Preview the results of your query before you print a Customer List report. For more information, 
see A/R Customer List Preview Screen.

 l Drill down from the preview to all the information for a selected customer, helping you to 
communicate authoritatively with your customers. 

Example: Use the Customer List preview along with the Aged Trial Balance report when discussing 
collection matters with customers.

 l If you use optional fields, print a report by any optional field that you use to identify customers. 

 l Age amounts due or amounts overdue as of a specific due date or document date. 

 l Include credit information on the report, such as customer credit limits or the amount of credit 
remaining for each customer.

 l Save your selection criteria and other settings for reuse the next time you use the Customer List. 
(The Settings menu lets you save personal default settings, or clear your saved settings, as you 
require.)

Note: If you want a report of information kept in customer records for all customers or a range of 
customers, you print the Customers report. (For more information on the Customers report, see 
"A/R Customers Report" (page 454).)

Fields and Controls

Buttons

Process

Click the Process button to generate a preview list that uses your criteria. 

Accounts Receivable then displays the list in the Customer List Preview screen, where you can print the 
list.
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Aging

Fields in the Aging section are available only if you specified selection   criteria that can be aged 
(such as Current Due or Overdue Amt.).   

Aging fields do not generate any columns for the report.  They are used to determine amounts that 
are current and those that are   not current, or overdue.

Note: If your Sage 300 system uses security, you must have View Transaction   History security 
authorization.

Age As Of

Accounts Receivable uses this date to determine whether transactions are current   or overdue. For 
example, if you age amounts by due date, documents with   due dates after the Age As Of date are 
considered overdue.

Age By

Specify whether to age transactions by their Due Date or Document Date.

Cutoff Date

The report will include transactions or balances that have a due date   or a document date before or on 
the cutoff date you specify. 

Include Prepayments

Select this option to take customer prepayments into account when calculating   overdue and current 
balances.

Credit Limit

If your Sage 300 system uses security, you can select credit limit   options only if you have View 
Transaction History security authorization.

No Limit

Select this option if you want to include customers for which no credit   limit is specified in the customer 
record.
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No Credit Used

Select this option if you want to include customers that have not used   any of their credit limit. 

If you select this option, the report includes columns that show customers'   credit limits and their credit 
available.

More than 100 percent of the credit limit may be available if a customer has   outstanding credit notes.

Over Limit

Select this option to include customers whose balances exceed their   credit limit.

If you select this option, the report includes columns that show customers'   credit limits and their credit 
available.

(The credit available for these customers will be a negative number.)

Up To [...]% Available

Select this option if you want to include customers that have only the   specified percentage, or less, of 
their credit available. 

If you select this option, the report includes columns that show customers'   credit limits, credit available, 
and credit available as a percentage   of the credit limit.

Customer Range

Use these options to specify up to seven criteria, as well as ranges   of values for those criteria, for 
selecting customers to include on the   Customer List.

From / To

Use the From and To fields to define a range of values for the selection   criteria.

If a customer record matches criteria for the ranges you define for   all your selection criteria, the 
generated customer list will include   the customer.

Select By 

Use the Select By fields on the Customer List Criteria screen to specify   up to seven criteria for the 
Customer List report. The report will include   columns of information for the criteria that you specify, in 
the order   that you select them.
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In a multicurrency system, you specify amounts   for the preceding criteria in the customer currency. You 
can specify   additional criteria in functional currency.

Note: If you   use criteria specified in the customer currency, such as the A/R Balance,   and you define 
a range of amounts, the resulting report will include a   mix of currencies. Therefore, you should 
specify additional criteria to   limit the report to a single customer currency, or include Cust. Currency   
as one of your selection criteria.

Include

Use the Include options to print additional information that is not   captured, or that may be 
excluded, by your selection criteria.

Examples: 
 l If you specify Comment   Follow-Up or Comment Expiration as selection criteria, but you 

want to   include customers whose records have no comments for the range of dates   you 
specified, select Customers With No Comments.

 l If you specify A/R Balance   as criteria because you want to print customer balances on 
the report,   and you want to include customers with no account balance, select 
Customers   With Zero A/R Balance.

 l If you want to include   the name, telephone number, and e-mail address for a customer 
contact   person, select Contact Information.

A/R Customer Inquiry Screen

To Open this Screen

Do one of the following:

 l Open Accounts Receivable > A/R Customers > Customer Inquiry.

 l On the A/R Document Inquiry screen, click theInquiry  button beside the Customer Number 
field.

 l On the A/R Customer List Preview screen, double-click a customer number, or select a customer 
on the list, and then click the Customer No. column heading.

 l On any Accounts Receivable transaction-entry screen, display a transaction, and then click the 

Inquiry  button beside the Customer Number field.
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Related Tasks

 l "Checking a Customer's Credit Status" (page 107)

 l "Drilling Down from Customer Inquiry to a Transaction Entry" (page 112)

 l "Opening Document Inquiry from Customer Inquiry" (page 112)

 l "Looking Up Account Activity or Period Statistics for a Customer" (page 110)

 l "Looking Up Customer Receipt Activity" (page 108)

 l "Looking Up Pending Transactions for a Customer" (page 106)

 l "Looking Up Refund Activity for a Customer" (page 109)

 l "Showing and Hiding Tabs on the Customer Inquiry Screen" (page 103)

 l "Viewing Posted Documents for a Customer" (page 104)

 l "Viewing a Miscellaneous Receipt for a Non-Accounts-Receivable Customer" (page 108)

Overview

Use the A/R Customer Inquiry screen as a ready reference to all the information that exists for a customer 
in your Sage 300 system. More...
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Examples: 
You can:

 l Open a customer record for viewing or editing.

 l Check a customer's tax group or credit bureau information.

 l Check a customer's credit status, including pending, outstanding, and overdue balances.

 l Look up transaction activity for a specified customer. 

 l Look up miscellaneous receipts for unspecified customers.

 l View transactions that are pending in Accounts Receivable, as well as orders that are 
outstanding or shipped in Order Entry (if you use Sage 300 Order Entry).

 l Drill down to view source documents in Accounts Receivable entry screens by double-clicking 
lines on Customer Inquiry tabs.

 l Drill down from other transaction-related tabs to view documents on the original entry screen.

 l If your company uses Sage 300 Order Entry, look up item sales history. You can also drill down 
to view source entries in O/E Order Entry (from the OE Orders tab), O/E Invoice Entry (from the 
OE Invoices tab), and O/E Debit/Credit Entry (from the OE Debits/Credits tab).

 l If your company uses Sage 300 Inventory Control, view contract pricing for a customer.

 l View customer-related details, such as the customer's billing address, ship-to locations, or 
recurring charges.

 l Display comments from the customer record. 

 l Add new comments that are automatically saved to the customer record, or edit existing 
comments.

 l Open recurring charge records and ship-to records for editing.

 l Open the Document Inquiry screen to view complete document history for a posted document, 
including ship-to information, taxes, and exchange rates. 
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Tips: 
 l In a multicurrency system, display amounts in customer currency or in functional currency using 

the Amounts In field (in the top right corner of the screen).

 l You can simplify the information presented on the A/R Customer Inquiry screen. Simply hide 
tabs that you do not need to see, or display hidden tabs. For more information, see "Showing and 
Hiding Tabs on the Customer Inquiry Screen" (page 103).

 l Once you have opened the Customer Inquiry screen, you can leave it open. The program 
updates the screen automatically whenever you choose Customer Inquiry in another Accounts 
Receivable screen, even for a different customer.

 l Update the screen to include the latest changes that you or other users may have entered since 
you selected the current customer number. Click the Refresh button at the bottom left corner of 
the screen.

Organization of the A/R Customer Inquiry Tabs

The A/R Customer Inquiry screen presents a large amount of customer information on several thematic 
tabs, as follows:

 l Customer-related information. Information from the customer record, ship-to location record, and 
recurring charge records appears on the following tabs (in their order on the screen):     

 l "Address Tab" (page 413)

 l "Profile Tab" (page 421)

 l "Tax/Sales Tab" (page 425)

 l "Credit Status Tab" (page 414)

 l "Comments Tab" (page 413)

 l "Optional Fields Tab" (page 420)

 l "Ship-To Tab" (page 424)

 l "Recur. Charges Tab" (page 423)

 l "Activity/Stats Tab" (page 412)

Some of these tabs let you filter the information they display, and some let you open the associated 
record for editing.

 l Transaction-related information. This information appears on the following tabs:     

 l "Documents Tab" (page 415)

 l "Refunds Tab" (page 424)

 l "Receipts Tab" (page 422)
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 l "Adjustments Tab" (page 413)

 l "Pending Tab" (page 420)

 l Order Entry information. If your company uses Sage 300 Order Entry, the following tabs are also 
available

 l "OE Orders Tab" (page 417)

 l "OE Invoices Tab" (page 417)

 l "OE Sales Tab" (page 419)

You can double-click lines on these tabs to drill down to the original orders, shipments, invoices, debit 
notes, and credit notes in the Order Entry program.

 l Inventory Control information. If your company uses Sage 300 Inventory Control, an additional tab is 
available that lists items and categories for which you have set up contract pricing for the customer:

 l "IC Contract Pricing Tab" (page 416)

You can double-click any item number that appears on the OE Sales tab or on an IC-related tab to view 
the item record in Inventory Control.

Important! If your Sage 300 system uses security, you must have Transaction History Inquiry security 
authorization to view tabs that include transaction information, or to view the Credit Status tab and the 
Activity/Stats tab. You need additional security authorization to view the Order Entry (OE) and 
Inventory Control (IC) tabs.

Note: For your convenience, the remaining sections of this screen guide treat the tabs on the 
A/R Customer Inquiry screen in alphabetical order, rather than in the order they appear on the screen.

Activity/Stats Tab

Note: If your Sage 300 system uses security, you must have Transaction   History Inquiry security 
authorization to view this tab.

The Activity/Stats tab provides information that is similar to the Activity and Statistics tabs in the customer 
record. It summarizes the current status of a customer’s account, and shows the most recently posted 
transactions. More...

Some of the transactions shown on this tab are:

 l Current-year and previous-year account activity for a selected customer.     

Account activity includes the current balance, the last statement balance, the number of outstanding 
invoices, the amount of the last-posted invoice, outstanding retainage, and so on.
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 l The number and amount of all transactions processed for the customer in the year and period you 
select.

 l Total days to pay and average days to pay figures for the account and period.

To find out about looking up activity and period statistics using this tab, see "Looking Up Account Activity or 
Period Statistics for a Customer" (page 110).

Address Tab

The Address tab on the Customer Inquiry screen displays the customer address and contact information 
from the customer record. More...

In addition to the mailing address, this tab shows: 

 l Primary telephone and fax numbers.

 l Primary e-mail address

 l The name, telephone number, fax number, and e-mail address of the customer contact person.

 l A Web URL for the customer, if the customer has a Web site.

Adjustments Tab

Note: If your Sage 300 system uses security, you must have Transaction   History Inquiry security 
authorization to view this tab.

The Adjustments tab lists all posted adjustment transactions for a specified customer (including 
adjustments from write-off batches), along with the documents they adjusted. The tab lists one line of 
summary information for each adjustment. More...

You use the Adjustments tab to:

 l Specify whether to list adjustments by adjustment number or by (adjusted) document number, in 
ascending or descending order.

 l Drill down to view a selected adjustment in the A/R Adjustment Entry screen. (Double-click the 
adjustment number in the Adjustment No. column.)

 l Display complete document history for an adjusted document in the Document Inquiry screen. 
(Double-click the document number in the Document No. column.)

In a multicurrency system, you can specify whether to show the document amounts, due amounts, and 
taxes in the customer currency or in the source currency.

Comments Tab

The Comments tab displays all comments entered in the customer record for the selected customer. You 
can use it to:

413Sage 300 2023 Accounts Receivable User's Guide



 l Edit customer comments from the Customer Inquiry screen. The comments you enter are 
automatically saved in the customer record.

See "Adding or Editing a Customer Comment Using the Customer Inquiry Screen" (page 92) for more 
information.

 l List comments in ascending or descending order by the date they were entered.

 l Filter the comments to view only a certain type of comment and/or comments entered by or for a 
specific user.

Credit Status Tab

Note: If your Sage 300 system uses security, you must have Transaction   History Inquiry security 
authorization to view this tab.

You use the Credit Status tab on the Customer Inquiry screen to check a customer's credit status. More...

You can use this tab to check:

 l The balance outstanding in Accounts Receivable for the customer and the national account (if the 
customer is a member of a national account).

 l Balances pending for the customer in Accounts Receivable, Order Entry, or third-party programs 
that integrate with Accounts Receivable, if credit-check options include transactions pending in 
those programs.

 l Retainage outstanding for the customer, if you use retainage accounting in Accounts Receivable.

 l The amount of credit remaining (or exceeded) and any overdue balance that exceeds the 
threshold specified for the customer, depending on the credit warning options specified in the 
customer record and the national account record (if the customer is a member of a national 
account).

 l Outstanding transaction balances, aged according to the periods you specify.

 l The number of open invoices, the total invoices paid to date, and the total and average number of 
days to pay them.

For instructions on checking a customer's credit status, see "Checking a Customer's Credit Status" (page 
107)

Aging Outstanding Transactions

Accounts Receivable sorts outstanding transactions and balances into five periods: a current (not due) 
period and four aging periods. You specify the length of each aging period for your Accounts Receivable 
system on the A/R Options screen. However, you can assign any aging periods you want on this tab. More...

You can:
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 l Age transactions by their:     

 l Due date. Current transactions are those with due dates that are later than the Age As Of 
date. The first period starts with one day past the due date.

 l Document date. The first period includes transactions with document dates that are earlier 
than the Age As Of date. Current transactions are those with the same or later date than the 
Age As Of date.

 l Specify the date as of which you want to age transaction balances (such as by today's date or the 
last statement or billing date).

 l Specify a cutoff date, so you can include or exclude transactions that are more recent than the "As 
Of" date.

 l Specify whether to age amounts from prepayments that have not been applied to specific 
documents, or include them all in the current period.

Applied amounts are always included in the same aging periods as the documents to which they apply.

Documents Tab

Note: If your Sage 300 system uses security, you must have Transaction   History Inquiry security 
authorization to view this tab.

The Documents tab lists all transactions that are posted for the customer. Document details and history 
(applied transactions) are conveniently listed in separate tables on the same tab. 

You use this tab to look up information about the invoices, credit notes, debit notes, interest charges, 
receipts (including unapplied cash, prepayments, and miscellaneous receipts), and refunds that have 
been posted to a selected customer's account. More...

The Documents tab includes three information tables:

 l The top table lists all documents posted for the customer.

 l The middle table displays distribution details for a document you select in the top table.

 l The bottom table displays all the transactions that have been applied to the document you select in 
the top table.

The following types of transaction do not appear on this tab:

 l Apply Document transactions appear on the Receipts tab.

 l Adjustments appear on the Adjustments tab.

 l Transactions that are not yet posted are listed on the Pending tab.

When using the Documents tab, you can:
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 l Filter the list by document type.

 l Specify the order in which to list documents, and the number, date, or balance with which to start 
the list of documents.

 l Display amounts in your company's functional currency or in the customer's currency.

 l Choose whether to show fully paid documents.

 l Choose whether to show amounts from pending transactions that will be applied to documents 
when they are posted.

 l Drill down to view a selected document on the original Accounts Receivable entry screen.

 l Open the Document Inquiry screen to view complete document history for the specified document.

Note: If you change any display options on this tab, click the Go  button to update the list of 
documents. If you want to display recent changes that you or other users enter, click the Refresh 
button at any time.

For instructions on tasks you can perform this tab, see:

 l "Drilling Down from Customer Inquiry to a Transaction Entry" (page 112)

 l "Opening Document Inquiry from Customer Inquiry" (page 112)

 l "Viewing Posted Documents for a Customer" (page 104)

IC Contract Pricing Tab

Important! If your Sage 300 system uses security, you must have either Price List Maintenance or 
Price/Sales Analysis Inquiry security authorization for Inventory Control to view this tab.

The IC Contract Pricing tab appears only if your company uses Sage 300 Inventory Control. Use this tab 
to review and work with customer pricing contracts. More...

Use the IC Contract Pricing tab to:

 l View a list of the items and item categories from pricing contracts that are set up for the customer 
in Inventory Control. The tab displays one line of pricing information for each item or category.

 l Change the order of the listed items and categories.

 l Drill down from an item number on the tab to the item record in Inventory Control. (You double-
click the item number to open the I/C Item record.)

For information about contract pricing, see the Inventory Control help.
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OE Invoices Tab

Important! 
If your Sage 300 system uses security, you must have at least one of the following Order Entry security 
authorizations to view this tab: 

 l Transaction Inquiry or Invoice Entry (to view the invoice table)

 l Debit/Credit Entry (to view the debit/credit table).

The OE Invoices tab appears only if you use Sage 300 Order Entry. It lists invoices, debit notes, and 
credit notes that have been processed for a selected customer in Order Entry. More...

This tab lists invoices, debit notes, and credit notes on two information tables, as follows:

 l The first table includes one line of summary information for each invoice posted in Order Entry. 

 l The second table includes one line of summary information for each debit note or credit note 
posted in Order Entry.

Use the OE Invoices tab to:

 l Choose whether to display invoices or debit notes and credit notes that have been processed by 
Inventory Control Day End Processing. (Select the Show Day End-Processed Transactions option 
to include these transactions.)

 l Change the order that invoices or debit notes and credit notes are listed on the tab.

 l Double-click an invoice number, debit note number, or credit note number to open the Document 
Inquiry screen, where you can view additional details for the invoice, debit note, or credit note.

 l Double-click an order number to view the original order in the O/E Order Entry screen.

 l Double-click a shipment number to view the shipment on the O/E Shipment Entry screen.

 l Double-click an item number to view the item record in Inventory Control.

 l View amounts in the functional currency or in the customer's currency, in multicurrency ledgers.

OE Orders Tab

Important! 
If your Sage 300 system uses security, you must have at least one of the following Order Entry security 
authorizations to view this tab:

 l Transaction Inquiry or Order Entry (to view the order table)

 l Shipment Entry (to view the shipment table).

The OE Orders tab appears only if your company also uses Sage 300 Order Entry. It lists orders and 
shipments that have been processed for a selected customer in Order Entry. More...

This tab lists orders and shipments on two information tables, as follows:
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 l The top table lists O/E orders processed for the customer, using one line of summary information 
for each order. More...

Each line includes the following information for an order:

 l Order number. (You double-click the order number if you want to drill down to view the order 
in Order Entry.)

 l Order type.

 l On hold status.

 l Description entered with the order.

 l Reference entered with the order (if any).

 l Amount of the order.

 l Date of the order.

 l PO number (if any).

 l Location from which the order is to be shipped.

 l Comment entered with the order (if any).

 l The second table lists O/E shipments processed for the customer, using one line of summary 
information for each shipment. More...

Each line includes the following information for a shipment:

 l Shipment number. (You double-click the shipment number if you want to drill down to view 
the shipment in Order Entry.)

 l Whether the shipment has been invoiced.

 l Description entered with the shipment.

 l Reference entered with the shipment (if any).

 l Amount of the shipment.

 l Date of the shipment, and the date the shipment was posted.

 l PO number (if any).

 l Location from which the order was shipped.

 l The customer's territory code.

 l Shipping details, including the FOB point, ship-to location, and ship via information.

 l Comment entered for the shipment (if any).

Use the OE Orders tab to:

 l View a summary of the orders and shipments entered for a selected customer in Order Entry.

 l Filter the list of orders by type, or list all orders.
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 l Drill down from a selected order to view the information that was entered with the order in O/E 
Order Entry. (Double-click an order number in the Order Number column to display the order in 
O/E Order Entry.)

 l Drill down from a selected shipment to view the information that was entered with the shipment in 
O/E Shipment Entry. (Double-click a shipment number in the Shipment Number column to display 
the shipment in O/E Shipment Entry.)

 l Choose whether to display orders that are on hold. (Select Show On-Hold Orders to include them 
in the list.)

 l Choose whether to display shipments that have been invoiced. (Select Show Invoiced Shipments 
to include them.)

 l List orders and shipments in ascending or descending order.

 l View amounts in the functional currency or in the customer's currency, in multicurrency ledgers.

OE Sales Tab

Important! 
If your Sage 300 system uses security, you must have at least one of the following security 
authorizations to view this tab:

 l Order Entry Transaction Inquiry

 l Inventory Control Day End Processing or Transaction Inquiry

The OE Sales tab is available only if you use Sage 300 Order Entry. It provides a sales history of items 
sold to a selected customer and processed through Order Entry. More...

The OE Sales tab includes two information tables, as follows:

 l The top table lists all the items sold to a selected customer and invoiced through Order Entry. 

The program displays one line for each item and period, including the year and period that the item was 
last sold, the quantity and the number of invoices (Sales Count) on which sales of the item were 
recorded, the sales amount and the cost of sales, as well as the number and sales amount for any 
returns. 

To see a list of the Order Entry invoices on which the items were included, you select the item line in the 
top table.

 l The second table displays the list of sales invoices for the item and period line you select in the top 
table. (The Sales Count column in the top table indicates the number of invoices that will appear in 
the list.)

The program includes one line of summary information for each invoice.

Use the OE Sales tab to:
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 l View sales history for items sold to a selected customer, including a detailed transaction history for 
each item.

 l Change the order of items displayed on the list.

 l View amounts in the functional currency or in the customer's currency, in multicurrency ledgers. 

 l Double-click a transaction number to open the Document Inquiry screen, where you can view 
additional details for the transaction or drill down to the original entry screen in Order Entry.

 l Double-click an order number to view the order on the O/E Order Entry screen.

 l Double-click a shipment number to view the shipment on the O/E Shipment Entry screen.

 l Double-click an item number to view the item record in Inventory Control. 

Optional Fields Tab

The Optional Fields tab displays the optional fields assigned to the customer. 

If you need to add, edit, or delete customer optional fields, you must do so in the customer record .

Pending Tab

Important! 
If your Sage 300 system uses security, you must have at least one of the following Accounts 
Receivable security authorizations to view this tab: Invoice Inquiry, Receipt Inquiry, Adjustment 
Inquiry, or Refund Inquiry.

You must have inquiry authorization for the particular type of transaction you want to see. For example, 
if you have only Invoice Inquiry authorization, you do not see the options to display receipts, 
adjustments, and refunds, and these transactions do not appear on the tab. 

The Pending tab lists all transactions that are entered or generated, but not posted, for an Accounts 
Receivable customer. It also lets you view posted miscellaneous receipts for customers that have no 
customer record in Accounts Receivable. More...

The tab includes two information tables, as follows:

 l The top table lists transactions pending for a selected customer, displaying one line of summary 
information for each transaction. To see the distribution details for a particular transaction, you 
select the transaction line in the top table.      

Summary information can include header information, document totals, taxes, and retainage amounts 
from transactions, and the batch status of the batches that contain the transactions.

 l The second table displays the distribution details for a single transaction you select in the top 
table.

Use the Pending tab to:
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 l View a list of transactions pending for a customer in Accounts Receivable. 

 l View the distribution details for a selected pending transaction. 

 l Filter the list to include only certain types of transactions, so that you can quickly find a particular 
transaction. 

 l Specify a sort order for the list of pending documents.

 l Display amounts in your functional currency or in the customer's currency, if you have a 
multicurrency ledger.

 l Drill down to an Accounts Receivable transaction entry screen, where you can view the 
information that will be posted for a selected transaction.      

To drill down to a transaction-entry screen, in the top table, double-click in the Document No. column for 
the transaction you want to view.

Note: If you drill down to a transaction that is pending in an open batch—and you have security 
authorization to edit the particular type of transaction—you can edit or delete the transaction.

 l If your company uses Sage 300 Order Entry, drill down from a shipment number or an order 
number to view the shipment or the order in the originating Order Entry transaction screen.

 l Open the Document Inquiry screen to view detailed information for a document to which the 
pending document applies.

For instructions on looking up pending transactions for a customer, see "Looking Up Pending Transactions 
for a Customer" (page 106)

Profile Tab

The Profile tab displays a variety of identifying, processing, and invoicing information from the customer 
record. More...

This tab displays the customer's:

 l Short name, group code, territory, on hold and inactive statuses, start date and date the customer 
record was last maintained (from the Address tab on the Customers screen).

If the customer is a member of a national account, the program displays the national account code and 
description right below the customer number and description, at the top of the Customer Inquiry screen.

 l Account set, account type, terms code, billing cycle, interest profile, payment code, delivery 
method, and check language (from the Processing tab in the customer record).

Also, if your Accounts Receivable system is multicurrency, the exchange rate type appears on the 
Profile tab. The program displays the customer's currency in the top right corner of the Customer Inquiry 
screen.
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 l Price list, customer type, inventory location, shipping information, and retainage information (from 
the Invoicing tab on the Customers screen).     

Shipping information includes the primary ship-to code, FOB point, ship via code, and options to allow 
partial shipments, allow Web store shopping, and allow backorder quantities.

If you use retainage accounting in Accounts Receivable, the Profile tab displays the retainage 
percentage, retention period, and retainage terms from the Invoicing tab in the customer record.

Receipts Tab

Note: If your Sage 300 system uses security, you must have Transaction   History Inquiry security 
authorization to view this tab.

The Receipts tab lists all customer payments that are posted for an Accounts Receivable customer, 
including information about the documents to which the receipt was applied. It also lets you view posted 
miscellaneous receipts for customers that have no customer record in Accounts Receivable. More...

The Receipts tab includes two display tables:

 l The top table on the tab lists the receipts posted for the customer. It provides one line of summary 
information for each receipt, including information from Bank Services about when the receipt 
cleared the bank, and whether it was returned. 

In multicurrency ledgers, for customer's that use a different currency than your functional currency, the 
tab shows receipt amounts in the customer currency or in the functional currency, as you specify. It also 
shows receipt amounts in the bank currency. If the customer paid in another (third) currency, the tab 
also shows exchange information for that currency in the Tax Reporting columns.

 l The second table displays a list of transactions applied to a receipt selected in the top table. 
Accounts Receivable displays one line of information for each applied transaction. 

Use the Receipts tab to:

 l View a list of receipts that have been posted to a customer's account.

 l View a list of transactions to which a selected receipt has been applied.      

You select the receipt in the top table, then view the applied documents in the second table on the tab.

 l Filter the list to include only receipts that have a certain status, so that you can easily find those 
that have been cleared or returned by the bank, or those that remain outstanding. 

 l List the receipts in order of receipt date or check /receipt number, and display the list in ascending 
or descending order.

 l Display amounts in your functional currency or in the customer's currency, if you have a 
multicurrency ledger. 
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 l Drill down to a selected receipt on the A/R Receipt Entry screen, where you can view all the 
information entered for the receipt, or even print a copy of the receipt.      

To drill down to the A/R Receipt Entry screen, in the top table, double-click in the Check/Receipt No. 
column for the receipt you want to display.

 l Open the Document Inquiry screen to view detailed information for a document to which the 
receipt was applied. 

For information on tasks that you can perform using this tab, see:

 l "Looking Up Customer Receipt Activity" (page 108)

 l "Looking up a Returned Customer Check" (page 111)

 l "Viewing a Miscellaneous Receipt for a Non-Accounts-Receivable Customer" (page 108)

Recur. Charges Tab

The Recur. Charges tab displays information for recurring charges that are set up for your customers. More...

The Recur. Charges tab includes two information tables that you use as follows:

 l The top table lists all the recurring charges for a selected customer, using one line for each 
recurring charge. 

You use the top table to review header information, estimated taxes, totals, and statistics from recurring 
charge records. 

To see the distribution details for a particular recurring charge, you select the line in the top table.

 l The second table displays all the details for a single recurring charge that you select in the top 
table.

Use the Recur. Charges tab to: 

 l View on a single tab all the setup information for a customer's recurring charges. 

 l Change the order of the listed recurring charges.

 l Drill down to an order in Order Entry, if the recurring charge record includes an Order Entry order 
number. (On the top table, double-click the order number.)

 l Open a recurring charge setup record for editing or viewing. (On the top table, double-click the 
particular recurring charge code.)

 l View optional fields assigned to the recurring charge code. (On the top table, double-click in the 
Optional Fields column for the recurring charge.)

 l View optional fields assigned to any detail of a recurring charge. (On the second table, double-
click in the Optional Fields column for the recurring charge.)
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Refunds Tab

Note: If your Sage 300 system uses security, you must have Transaction   History Inquiry security 
authorization to view this tab.

The Refunds tab lists all refunds that are posted for a customer, including information about the 
documents that were refunded. More...

The tab includes two information tables that you use as follows:

 l The top table lists all the refunds for the customer, displaying one line of summary information for 
each refund. 

You use the top table to review header information, optional fields, exchange rates, and totals for 
refunds, and, if a refund was by check, whether the check has cleared the bank.

To see the transactions to which a selected refund applies, you select the refund line in the top table.

 l The second table displays all the transactions for a refund selected in the top table.

Use the Refunds tab to: 

 l List refunds in ascending or descending order. 

 l Specify a check number to begin the list, or display all refunds posted to the customer's account.

 l View amounts in the functional currency or in the customer's currency, in multicurrency ledgers. 
When displaying amounts in the functional currency, if the customer's currency is different from 
your functional currency, you can see the exchange rates used to convert transactions.

 l Drill down to view refunds on the A/R Refund Entry screen.      

To drill down to the A/R Refund Entry screen, select the refund line on the table, and then click the 
Batch/Entry No. column heading.

 l Open the Document Inquiry screen to view document history for a particular refund or applied 
document.      

To display document history for a particular refund, either double-click the refund document number, or 

select the line on the table, and then click the Inquiry  button.

For instruction on looking up refunds, see "Looking Up Refund Activity for a Customer" (page 109).

Ship-To Tab

The Ship-To tab on the Customer Inquiry screen lists all the ship-to locations that have been set up for a 
customer. More...

Use this tab to: 
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 l Easily identify the primary ship-to location for a customer. (If a ship-to location has been marked as 
the primary ship-to location, its code and description appear in the Primary Ship-To fields at the top 
of the tab.)

 l Change the order of the listed ship-to locations.

 l View information for all of the customer's ship-to locations on a single tab, including the ship-to 
address and contact information, as well as the price list tax group, inventory location, FOB point 
and shipping instructions used for each location.

 l Open a ship-to location record for editing. (To open a ship-to location record, double-click the ship-
to location line on the Ship-To tab.)

 l View any optional fields assigned to a ship-to location. (Double-click in the Optional Fields column 
for the ship-to location to display the optional fields in a separate screen.)

Tax/Sales Tab

The Tax/Sales tab displays information about a customer's tax status and sales. More...

The tab displays the following information: 

 l The customer's tax group.  

 l For each tax authority in the tax group, the customer's tax status and tax registration number.

 l Salesperson information, including the sales percentage for each salesperson.

 l Credit bureau information for the customer. 

 l The customer's credit limit and the extent to which transactions for the customer can be overdue 
before triggering credit warnings. (You view the customer's current credit status on the adjacent 
Credit Status tab.)

You cannot change any information on this tab.

If you need to change the customer's tax information, sales split, credit bureau information, or credit 

warnings, click the Drilldown  button beside the Customer No. field to open the customer record for 

editing. (Note that you need Customer Maintenance security authorization to edit customer records.)

A/R Recurring Charges Screen

To Open this Screen

Open Accounts Receivable > A/R Customers > Recurring Charges.
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Secondary Screens

 l A/R Customer Information Screen

 l A/R Detail Accounts/Taxes Screen

 l A/R Ship-To Information Screen

Related Tasks

 l "Invoicing a Recurring Charge Manually" (page 181)

 l "Invoicing Recurring Charges" (page 255)

 l "Setting Up a Recurring Charge for a Customer" (page 96)

 l "Updating Recurring Charges Automatically" (page 253)

Overview

You use the A/R Recurring Charges screen to:

 l Create records of the standard invoices you issue to your customers.

 l Manually create an invoice for a recurring charge, if necessary.

Recurring charges can be for a single item such as rent, or for standing orders or services that are almost 
identical from month to month. 

You can set up recurring charges for summary and item invoice types.

You can enter recurring charges whose details sum to a zero amount.

Recurring charges are identified by code as well as by customer number, so you can generate a batch of 
a single recurring charge type, such as rent.

You can also include recurring charges in the Reminder List, so that System Manager can remind a 
specific user, or all users, to process the charges when they become due. For more information about 
reminders, see the System Manager help.

Detail Tab

Use the Detail tab to:

 l Enter the details of the recurring charge.

 l Open a separate screen (Detail Accounts/Taxes) to view or edit the tax class and tax included 
status for a detail.
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Accounts Receivable generates summary invoices for recurring charges. Rather than enter item 
numbers, you assign a distribution code or general ledger revenue account to each detail line and enter a 
description and amount in the recurring charge record.

To view or to change tax information for a particular detail, highlight the detail, then either click the 
Account/Tax button or press the F9 key to open the Detail Accounts/Taxes screen.

Invoice Tab

Use the Invoice tab to specify the following information for a recurring charge:

 l The starting date.

 l The expiration type, and, depending on the type you specify:

 l The expiration date, if there is one.

 l A maximum amount that you can invoice for the recurring charge, if there is a maximum.

 l A maximum number of invoices.

 l Assign a schedule for invoicing the charge. For information about setting up schedules for 
recurring transactions, see the System Manager help.

 l Select a ship-to location for the charge, if needed.

 l Assign payment terms and tax information for the charge.

 l Enter purchase order and sales order numbers, if any, as well as special instructions and shipping 
information for the charge.

Note: Some settings on the Invoice tab (starting and expiration dates, and maximum amount) affect 
the creation of invoices in recurring charge batches. For more information, see "A/R Create Recurring 
Charge Batch Screen" (page 473).

Optional Fields Tab

Note: The Optional Fields tab appears only if you use Sage 300 Transaction Analysis and Optional 
Field Creator and you have defined invoice optional fields. 

Use the Optional Fields tab to:

 l Assign optional fields to a recurring charge.     

The program displays optional fields that are set up for automatic insertion on invoices, but you can 
change them or add other optional fields defined for Accounts Receivable invoices. (Recurring charges 
use the same optional fields you set up for invoices.)

Accounts Receivable displays default values for the invoice optional fields, as follows:
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 l If you assigned exactly the same optional fields to the customer and ship-to location records 
as you defined for invoices, the program displays the optional field values from the ship-to 
location on the Optional Fields tab.

 l If the optional fields in the ship-to location record and the customer record are different from 
each other, the optional field values from the customer record appear as defaults for the 
invoice.

 l If an optional field is defined for invoices, but is not assigned either to the customer or the 
ship-to location, the program displays the value specified for the optional field in the 
Optional Fields record.

 l Change the value that appears for an optional field. More...

You can change the default value that appears for an optional field, as follows:

 l If the optional field is validated, you must specify a value that is defined for the optional field 
in Common Services.     

Note: If the optional field allows blanks, you can leave the value field blank.

 l If the optional field is not validated, you can enter any value that is consistent with the type 
of field (such as yes/no, text, number, date, or amount), providing the value you enter does 
not exceed the length permitted for the field. You can also leave the field blank.

Note: When you specify a value that is defined in Common Services, the description for the value is 
also displayed.

Sales Split Tab

Use the Sales Split tab to assign the salespeople, if any, who are responsible for the recurring charge.

Statistics Tab

Use the Statistics tab to:

 l View the number and amount of posted and unposted invoices created for the recurring charge. 
You can edit these fields to include historical amounts.

 l View the year-to-date number and amount of invoices created for the recurring charge. Accounts 
Receivable updates these amounts when you post the invoices, and you cannot change them.

 l View information about the last invoice posted for the recurring charge , including the date, 
amount, invoice and entry numbers, as well as the batch number and posting sequence of the 
batch that contained the last invoice.

Tax/Totals Tab

Use the Tax/Totals tab to:
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 l Assign the tax group for the recurring charge.

 l Check the tax authorities, customer tax class, and the totals for the recurring charge.

 l Change the customer tax class for the recurring charge.

Important! If the Calculate Tax option is selected on the Tax/Totals tab, tax amounts appear on the 
Tax/Totals tab. They are not necessarily the amounts that will be calculated for the invoice (tax rates 
can change in the interim), but they provide an estimate of the taxes that may be due.

Fields and Controls

Buttons

Account/Tax

Click this button to view and edit the information for a detail (including tax information) in a separate 
screen. For more information, see A/R Detail Accounts/Taxes Screen (Invoices).

Add/Save

Click the Add button to add a new transaction. The button name then changes to Save.

If you edit a transaction you added previously, click Save to record your changes.

Close

Click this button to close the screen.

Tip: 
You can also close the screen in the following ways:

 l Click the top left corner of the screen.

 l Click File > Close.

Create Invoice

Click this button to create an invoice manually for a recurring charge.

Example: You might need to create an invoice manually if you accidentally delete an invoice from a 
recurring charge batch, or if you need to create an additional invoice for some other reason.
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Delete

Click this button to delete a selected record, account, batch, or transaction.

Note: 
 l After you delete a batch or a document in a batch, you cannot reuse its entry number.

 l Deleted transactions are reported on the batch listing and posting journal for the batch. 

 l Deleted batches are also reported on the Batch Status report.

Customer Number

Enter the number of the customer for whom you are creating this recurring charge.

Tip: To view address information for this customer, click the Zoom  button beside the field. For 
more information, see A/R Customer Information Screen.

Recurring Charge Code

Enter the code for the recurring charge or select an existing code from the Finder. 

To define a new record, type the code you want to use. The code can be up to 16 characters long.

You can use the same recurring charge code for charges with different customers.

Example: You can create monthly RENT charges for one group of customers, and quarterly RENT for 
another group. 

You can specify a range of one or more codes when you create a batch of recurring charges.

Detail Tab

Amount

This is the amount for the detail you are entering.

If you use multicurrency accounting, you enter the amount in the customer's currency.
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Notes: 
If you use Project and Job Costing, be aware that:

 l You can use only billable projects on Accounts Receivable invoices. (You cannot use non-
billable or no-charge projects.)

 l On summary invoices for cost plus and fixed price projects, whether you can enter an amount for a 
detail depends on the project accounting method and the billing type used by the selected category, 
as follows:

 l For a fixed price project or a cost plus project that uses the Completed Project, Total 
Cost Percentage Complete, or Labor Hours Percentage accounting method, you can 
enter an amount (including zero).

 l For cost plus project that uses a Category Percentage Complete, Billings And Costs, 
or Accrual-Basis accounting method, you can enter an amount (including zero) only if 
the specified category is billable. If the category is no charge or non-billable, the 
program sets the amount to zero, and you cannot change it.

Description

When you enter a distribution code, the program displays the description for the code.

You can use the displayed description or type another description for the detail.

Discountable

You use this option to specify whether a selected detail is subject to the invoice discount. 

Example: If you do not give discounts on freight charges, you can exempt a freight detail from the 
invoice discount.

To indicate that a detail is not discountable, you clear the Discountable option for the detail on the 
Detail Accounts/Taxes screen, or select No for the option on the detail table.

Dist. Code

The distribution code identifies the general ledger revenue account for the detail. If you prefer, you can 
enter the general ledger account number manually.

If you are using the Accounts/Taxes screen (select a detail line, and then click Accounts/Taxes or 
press F9), the description for the code also appears.
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Invoice Type

Specify the type of details to use on invoices that you generate for this recurring charge:

 l Summary. This type of detail includes just enough information to update your receivables 
records and general ledger revenue account. Use summary details when you do not maintain an 
inventory or when you update inventory information outside of Accounts Receivable.

 l Item. This type of detail lets you use a price list when entering details, and update receivables 
records as well as the revenue, inventory, and cost of goods sold general ledger accounts (the 
last two accounts are optional).

Optional Fields

This field indicates whether optional fields are assigned to the document detail. If any invoice details 
optional fields are set for automatic insertion on invoices, the field will be selected when you add a new 
detail to an invoice, credit note, debit note, or recurring charge.

If you use exactly the same optional fields in customer records and on invoices, the program assigns 
the optional field values used in the customer record to transaction details that you add in the Invoice 
Entry and Recurring Charges screens.

You can accept or delete the optional fields that appear as defaults, and you can add other optional 
fields that you have set up for invoice details. You can also change the optional field values used in 
document details.

For job-related details:

 l If the invoice details optional fields used on an invoice detail are identical to those assigned to the 
contract, Accounts Receivable uses the optional field values from the contract as default values 
for the details.

 l If you assign to a job-related detail an optional field that is not assigned to the contract, the 
program displays the default value for the invoice details optional field. You can also change the 
values, as you can for any invoice, credit note, or debit note.

For more information, see:

 l "Editing Optional Fields for an Invoice Detail" (page 179)

 l "About Optional Fields for Job-Related Transactions" (page 44)

Revenue Account

This field appears on the Detail Accounts/Taxes screen and on the Detail tab.

If you did not enter a distribution code, or if you want to change the revenue account for this detail, enter 
the general ledger revenue account number to which you post transactions entered for the customer.
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Tax Base

This is the amount (before included taxes) that will be used to calculate tax for each tax authority.

Invoice Tab

Account Set

The account set from the customer record appears in this field as the default. It specifies the general 
ledger receivables control, payment discounts, prepayment liability, retainage, and write-offs accounts 
to which the transaction will be distributed.

You can change the account set for a particular invoice or recurring charge record. If you use 
multicurrency, however, the new account set must use the same currency as the customer's account 
set.

Amt. Invoiced to Date

This field includes amounts from all invoices generated for the recurring charge since the last time you 
used the Clear Total Recurring Charge Amounts option on the Year End screen.

Amt. Last Invoiced

This field displays the amount of the last invoice created for this customer and recurring charge code.

Currency

The customer's currency appears in this field when you enter the customer number in a multicurrency 
system.

Current Amount

If the recurring charge uses the Maximum Amount expiration type, the program displays in this field the 
sum of the unposted and posted total invoiced amounts from the Statistics tab.

Current Count

If the recurring charge uses the Number Of Invoices expiration type, the program displays in this field 
the sum of the unposted and posted number of invoices from the Statistics tab.
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Description

This description appears with the document information on the Invoice Batch Listing and the Invoice 
Posting Journal.

Expiration Type

Use this field to specify whether to restrict invoices beyond a specific date, a maximum amount, or a 
specified number of invoices.

Depending on your choice for the expiration type, you enter additional information about the recurring 
charge, as follows:

 l If you select Specific Date, you also enter an expiration date for the recurring charge. Accounts 
Receivable does not create any invoices for the recurring charge after its expiration date. The 
program warns you when it creates the final invoice before the recurring charge expires, so that 
you can update the recurring charge record, if necessary.

 l If you select Maximum Amount, you must also specify the maximum amount for the recurring 
charge. Once you have invoiced the maximum amount, Accounts Receivable creates no more 
invoices for the recurring charge.

 l If you select Number of Invoices, specify the number of invoices to process for the recurring 
charge. Once the specified number of invoices has been created, Accounts Receivable creates 
no additional invoices.

 l If you select No Expiration, Accounts Receivable creates invoices indefinitely for the recurring 
charge.

Inactive

If you want to prevent this charge from being used but do not want to delete it, you can make it inactive. 
Accounts Receivable displays the system date at the time you selected the option, so that later you can 
find out when the record was made inactive.

You can reactivate the recurring charge at any time.

Invoice Subtotal

This field shows the recurring charge total before tax is included.

Job Related

Select the Job Related option if the recurring charge is for a project you are managing using Sage 300 
Project and Job Costing.
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When you select the option, additional fields appear in the detail-entry table to let you enter job-related 
information.

When you post invoices generated for the recurring charge, Accounts Receivable updates the specified 
contract, project, category, and (if required) the resource in Project and Job Costing.

Last Generated

Accounts Receivable automatically updates this field when you generate an invoice for the recurring 
charge. You cannot change the date.

Last Invoiced

The program updates this field when you create a recurring charge batch that includes this recurring 
charge for a customer.

If no invoice is created because the maximum amount for the charge has already been invoiced, the 
program does not update the field.

Last Maintained

This field displays the date of the last change to this recurring charge record.

Max. Amount

This field displays the maximum amount that can be charged on this recurring charge. 

If the new charge plus the Amt. Invoiced To Date exceeds the maximum amount, an invoice is not 
created.

Next Invoice Date

Accounts Receivable updates this field when you generate an invoice using the Create Recurring 
Charge Batch screen, or when you change the schedule for the recurring charge. You cannot change 
the date.

The program uses the Last Generated date together with the schedule to determine when the next 
invoice should be generated.

Order Number

The order number is supplied by Sage 300 Order Entry, if you use it. You can enter an order number or 
other information in the field, or leave it blank.
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You can list documents by order number in Finders and for receipt application, and you can use the 
number as the reference or description in G/L transaction batches.

PO Number

If the customer has a purchase order number, you can enter it in this field. You can also use this field for 
another purpose, or leave it blank.

You can list documents by purchase order number in Finders and for receipt application, and you can 
use the number as the reference or description in G/L transaction batches.

Rate Type

The rate type is a code for the kind of rate to use when converting multicurrency amounts to functional 
currency. Examples of rate types might be "spot rate," "average rate," and "contract rate."

You must type a valid rate type or select one from the Finder.

You define rate types using the Currency Rate Types screen in Common Services.

Schedule Code

Enter the code for the schedule that you want to attach to this record. (The schedule determines when 
the recurring charge is to be processed.)

If you want to create a new schedule or modify an existing one, click the Zoom  button to the right of 

the Schedule Code field. You can use up to 15 characters to create the new code.

Note: To create or modify a schedule, you must have security authorization to maintain schedules.

For more information about setting up schedules for recurring transactions, see the System Manager 
help.

Ship Via

This field displays the information entered in the primary ship-to location record, if one exists for the 
customer, unless you enter a different ship-to location.

If no ship-to location is used on this recurring charge record, the shipping details from the customer 
record appear.
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You can enter a different ship via method, if necessary. If you use Order Entry, type a code that you 
have set up in Order Entry or select it using the Finder. If you do not use Order Entry, you can enter a 
code that you maintain elsewhere.

You can also leave the Ship Via field blank.

Ship-To

This field appears on the Recurring Charges setup screen and on the Invoice Entry transaction screen. 

You use it as follows if you want to ship goods to an address that is different from the customer's billing 
address:

 l On the Recurring Charges screen, you must select an existing ship-to location that you have 

defined for the customer. You can click the Zoom  button beside the Ship-To field to view 
shipping information for the document.

 l On the Invoice Entry screen, you can elect an existing ship-to location that you have defined for 

the customer, or click the Zoom  button beside the Ship-To field to open a separate screen 
where you can enter an address and other shipping information for the document.

Note: To specify a different ship-to address for an invoice you generate for the recurring charge, you 
change the Ship-To code on the Invoice Entry screen.

Special Instructions

This field displays any special instructions entered in the ship-to location record. 

You can type different special instructions for the recurring charge.

Start Date

Enter the date on which the charge comes into effect.

Accounts Receivable creates invoices only when the run date is between the start and expiration dates 
specified for the recurring charge.

Terms

Accounts Receivable uses the terms code you specify with an invoice to calculate the due date and the 
discount period and discount amount for the document.

The customer's default terms code appears when you enter the customer number for the invoice, but 
you can change to any other terms code you have defined in Accounts Receivable.
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If you use a terms code that includes multiple payments, a payment schedule is set up that includes 
separate due date and discount information for each payment. You can edit that information on the 
Payment Schedule tab of the screen. (This tab appears only if you have a multiple payment schedule.)

You can change the due date, discount date, amount, and rate at any time until you post the invoice.

Optional Fields Tab

Optional Field and description

Any invoice optional fields that are set up for automatic insertion appear, along with their descriptions, 
as defaults on the Optional Fields tab.

You can add different optional fields, providing they are defined for invoices on the A/R Optional Fields 
screen. When you select an optional field code, the program displays the description from the optional 
field setup record.

You can also delete optional fields that appear as defaults. However, if an optional field is required, do 
not delete it. You cannot add the transaction until you enter a value for the optional field.

Value and description

Default values appear for invoice optional fields, as follows:

 l If you assigned the same optional fields to the customer and ship-to location records as you 
defined for invoices, the optional field values for the ship-to location appear on the Optional 
Fields tab.

 l If the optional fields in the ship-to location record and the customer record are different from each 
other, the optional field values from the customer record appear as defaults for the invoice.

 l If an optional field is defined for invoices, but is not assigned either to the customer or the ship-to 
location, the program displays the value specified for the optional field in the Optional Fields 
record.

You can change the default value that appears for an optional field, as follows:

 l If the optional field is validated, you must specify a value that is defined for the optional field in 
Common Services.     

Note: If the optional field allows blanks, you can leave the value field blank.

 l If the optional field is not validated, you can enter any value that is consistent with the type of field 
(such as yes/no, text, number, date, or amount), providing the value you enter does not exceed 
the length permitted for the field. You can also leave the field blank.
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Note: When you specify a value that is defined in Common Services, the description for the value is 
also displayed.

The description for the value appears automatically. You cannot change it.

Sales Split Tab

Percent Split

Enter the percentage of the sale that you want assigned to this salesperson. You do not have to assign 
salespeople to a document, but, if you do, the percentages you assign must total 100.

Salesperson Code

If salesperson numbers are assigned to the customer record, they are displayed here. You can change 
the salesperson numbers, but only to other numbers you have defined using the Salespersons screen.

You can also delete any of the salespersons assigned to the document, or add others. You do not have 
to assign salespeople to a document, but, if you do, the percentages you assign must total 100.

Salesperson Name

This is the name of the salesperson from the salesperson record.

Statistics Tab

Batch Number (Last Invoice Posted)

Accounts Receivable updates this field when you post an invoice for the recurring charge.

Entry Number (Last Invoice Posted)

Accounts Receivable updates this field when you post an invoice for the recurring charge.

Invoice Amount (Last Invoice Posted)

Accounts Receivable updates this field when you post an invoice for the recurring charge. You cannot 
change it.
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Invoice Date (Last Invoice Posted)

Accounts Receivable updates this field when you post an invoice for the recurring charge. You cannot 
change it.

Invoice Number (Last Invoice Posted)

Accounts Receivable updates this field when you post an invoice for the recurring charge. You cannot 
change it.

Number of Invoices (Posted)

Accounts Receivable updates this field when you post an invoice for the recurring charge.

If the recurring charge uses Number of Invoices as the expiration type, the program uses this field, 
together with the Unposted Number of Invoices field, to determine if the limit has been reached.

Important! We recommend that you change the entry in this field only when upgrading from a prior 
version. Editing the field does not affect the year-to-date amount.

Number of Invoices (Unposted)

Accounts Receivable updates this field when you generate an invoice for the recurring charge, 
providing a gauge of the number of open documents generated for the recurring charge code. When 
you post the invoice, the amount is transferred to the [Posted] Number of Invoices field.

If the recurring charge uses Number of Invoices as the expiration type, the program uses this field, 
together with the Posted Number of Invoices field, to determine if the limit has been reached.

Important! We recommend that you change the entry in this field only when upgrading from a prior 
version.

Number of Invoices (Year To Date)

Accounts Receivable updates this field when you post an invoice for the recurring charge. You cannot 
change it.

Accounts Receivable clears this field when you process year end.
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Posting Sequence (Last Invoice Posted)

Accounts Receivable updates this field when you post an invoice for the recurring charge. You cannot 
change it.

Total Invoiced (Posted)

Accounts Receivable updates this field when you post an invoice for the recurring charge. You cannot 
change it.

If the recurring charge uses Maximum Amount as the expiration type, the program uses this field, 
together with the Unposted Total Invoiced field, to determine if the limit has been reached.

Important! We recommend that you change the entry in this field only when upgrading from a prior 
version. Editing the field does not affect the year-to-date amount.

Total Invoiced (Unposted)

Accounts Receivable updates this field when you generate an invoice for the recurring charge, 
providing a gauge of the amount of open documents generated for the recurring charge code. When 
you post the invoice, the amount is transferred to the Posted Total Invoiced field.

If the recurring charge uses Maximum Amount as the expiration type, the program uses this field, 
together with the Posted Total Invoiced field, to determine if the limit has been reached.

Important! We recommend that you change the entry in this field only when upgrading from a prior 
version.

Total Invoiced (Year To Date)

Accounts Receivable updates this field when you post an invoice for the recurring charge. You cannot 
change it.

Accounts Receivable clears this field when you process year end.

Tax/Totals Tab

Calculate Tax

Select this option to calculate taxes for the invoice automatically when you create a recurring charge 
batch.

Do not select this option if:
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 l Tax is already included in the amount of the recurring charge.

 l The charge is not taxable.

 l You want to enter taxes manually.

Customer Tax Class

The customer tax class is assigned in the customer record and is displayed as the default in this field.

However, for many tax authorities, the tax class varies depending on the purpose of the goods or 
services being purchased. If necessary, you can change the tax class for the document on the 
Tax/Totals tab.

Estimated Tax Withheld

The total estimated amount that your customer will withhold for a transaction to be remitted to a tax 
authority on your behalf.

Invoice Subtotal

This field shows the recurring charge total before tax is included.

Tax Authority

The tax authorities for the tax group assigned to the customer are listed on the Tax/Totals tab. They are 
also shown for each detail in the Accounts/Taxes screen.

To change the tax authority for a customer, you must change the tax group on the customer record.

Tax Base

This is the amount (before included taxes) that will be used to calculate tax for each tax authority.

Tax Group

Tax groups specify the authorities that tax the customer and assign the customer's tax classes in each 
authority. (Tax classes determine the specific classification for a tax, such as which rate is applied or 
whether the customer is exempt.)

You assign a tax group to each customer and ship-to location, to assign the taxes for the document.

The customer's tax group is displayed when you enter the customer number. If you select a ship-to 
location, the tax group for the ship-to location replaces the customer's group.
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If you need to change tax rates or amounts for a document, you can assign a different tax group or 
change the tax class or taxable status for the customer (on the Totals tab) or any of the detail lines you 
enter with the document. To change the tax rates, use the Tax Services screens in Common Services.

In multicurrency ledgers, you can change the tax group to one that uses a different currency than the 
customer.

Total Estimated Tax Withheld

The total estimated amount that your customer will withhold for a transaction to be remitted to tax 
authorities on your behalf.

A/R Ship-To Locations Screen

To Open this Screen

Open Accounts Receivable > A/R Customers > Ship-To Locations.

Related Tasks

 l "Looking Up Ship-To Locations for a Customer" (page 101)

Overview

Note: Depending on how your system is set up, this desktop screen may also be available as a web 
screen. For more information, see the Web Screens Getting Started Guide or the help for Sage 300 
web screens.

You use the A/R Ship-To Locations screen to store an almost unlimited number of ship-to locations for 
your customers, which you can select when entering invoices or defining recurring-charge records. You 
can use this screen to:

 l View a list of ship-to locations assigned to a customer, including the name, address, and zip or 
postal code at each of the shipping locations defined for a customer. You can also see whether 
you have designated a primary ship-to location for the customer.

 l Add addresses to which customers want you to send the goods they order. (Invoices and 
statements are sent to the address entered in the customer record.)

 l Enter a name, e-mail address, phone number, and fax number for a contact person.

 l Edit or delete existing ship-to locations.
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 l Designate an inventory location that Order Entry uses as the default location when you specify the 
ship-to location in a transaction in Order Entry.

 l Designate a primary ship-to location for a customer. More...

When you designate a ship-to location as the primary ship-to location for a customer, Accounts 
Receivable uses the shipping details (including the ship-via code and FOB point) from that ship-to 
location record as default entries when you set up a recurring charge or create an invoice for that 
customer. Order Entry also uses these defaults when you process an order for the customer.

 l Assign optional fields that are set up for use with ship-to locations. 

Ship-To Locations List

When you open the A/R Ship-To Locations screen (by double-clicking the Ship-To Locations icon in the 
Customers folder), an initial screen appears that lists all ship-to locations for a specified customer. The 
list provides a convenient summary of the ship-to locations added to Accounts Receivable for the 
customer.

You must drill down to the detailed Ship-To Locations screen to add or edit a ship-to location for a 
specified customer, as follows:

 l If you want to add a ship-to location, you click the New button to open the detailed screen where 
you enter all the details for the new ship-to location record.

 l If you want to edit an existing ship-to location record, either double-click the location on the table, 
or select the location, and then click Open.

Address Tab

Use the Address tab to change the ship-to location's address, contact name, telephone number, e-mail 
address, fax number, and territory code. It also lets you select a ship-to location as the primary ship-to 
location for a customer.

Contact Tab

Use the Contact tab to enter the name, telephone number, fax number, and e-mail address for a contact 
person at the ship-to location.

Invoicing Tab

Use the Invoicing tab to:

 l Enter an optional shipping method or carrier and shipping instructions, including an FOB point, for 
the ship-to location.

 l Assign a tax group and tax classes for the location and enter any tax numbers. 
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 l Specify the salespeople who are responsible for the customer's account at the ship-to location, 
and the percentage of each of the customer's transactions that you allocate to each salesperson. 
You can change any of the salesperson information in the ship-to location record at any time. 

When you select the ship-to location in the Invoice Entry screen, the salesperson information entered is 
used for the document. You can make any changes you need for the transaction in the Invoice Entry 
screen. 

 l Designate an inventory location that Order Entry will use as the default location when you specify 
the ship-to location in a transaction in Order Entry.

Optional Fields Tab

Note: This tab appears only if you have activated Sage 300 Transaction Analysis and Optional Field 
Creator.

Use the Optional Fields tab to:

 l Assign ship-to location optional fields to store additional information that you want to keep with 
particular ship-to location records. (You define ship-to location optional fields using the Optional 
Fields screen in the A/R Setup folder.)

If any optional fields are set for automatic insertion in ship-to location records, they appear on the tab, 
along with their default values, when you add a new ship-to location record.

If you set up the same optional fields for ship-to locations as for customers, national accounts and 
customer groups, the program uses the values from the customer record as default values for the 
optional fields in the ship-to location record. You can accept or change the optional field values.

 l Enter values for the optional fields that are assigned to the screen. 

If you use exactly the same optional fields for invoices, customers, and ship-to locations, when you 
select a ship-to location for a document on the Invoice Entry screen, the optional field values from the 
ship-to location record are used for the document.

Fields and Controls

Buttons

Close

Click Close to close the screen.
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Delete

Use this button to delete a ship-to location for a customer.

If you are working with a list of ship-to locations (on the screen that opens when you choose the Ship-To 
Locations icon), specify the customer number, select the location on the table, and then click Delete.

If you are working with a ship-to locations record (on the screen that opens when you click Open or New 
on the initial screen), specify the customer number and the ship-to location, and then click Delete.

New

To create a new ship-to location record for a customer, specify the customer number, and then click 
New.

Open

This button is available on the screen that opens when you choose the Ship-To Locations icon.

To view a specific ship-to location record, specify the customer number, select the location on the table, 
and then click Open.

Customer Number

Type the number of the customer for whom you are adding, editing or   viewing a ship-to location, or use 
the Finder or the navigation buttons   beside the Customer Number field to select the number. 

Ship-To Location

This field contains a code that is used to identify the ship-to location. 

If you are adding a new ship-to location record, you type a code of up to six characters in this field, and 
then type a description in the adjacent field.

Each of the location codes for a single customer must be unique, but you   can use the same codes for 
different customers. This means you can use   standard codes to represent cities or suburbs, or location 
types for offices,   stores, warehouses, or factories.

You select the code in the Invoice Entry screen and the Recurring Charges screen to assign a ship-to 
location   to a document. 
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Address Tab

This tab is available on the screen that appears when you click Open or New on the initial 
A/R Ship-To Locations screen.

Address

The address in the customer record or national account is usually the   address that is printed on invoices 
and statements for the account. 

When customers belong to a national account, the address in the customer   record is usually the billing 
address for the national account. You   use ship-to locations to record the customer's actual address. 
You also   use ship-to locations if the customer has more than one address. 

City

Type the name of the city where the customer resides or where you ship goods.

You can enter the name of the city in other address lines. However, the customer address on your 
statements, letters, and labels may not appear correctly. Also, if you export data to use in other 
programs, the field is more useful when you use the field consistently for the city.

Country

Specify the name of the country where the business is located.

Fax Number

You use this field to record the fax number, if any, for your customer, national   account, or ship-to 
location. 

The field includes area code parentheses and hyphens if you selected   the Format Phone Number 
option for the company in the Company Profile   screen in Common Services.

Inactive

Select this option if you do not want to use the ship-to location, usually   because you plan to delete the 
record and do not want to assign it to   transactions you enter for the customer in the Invoice Entry 
screen. 
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Note: You cannot set the ship-to location inactive if any unposted   documents use the ship-to code. 
Therefore, before you set the record Inactive,   assign a different ship-to code to any unposted 
documents that use the   ship-to location. 

Last Maintained

This information field displays the date   of the last change made to the ship-to location. You do not make 
an entry   in this field.

Primary Ship-To

Select the Primary Ship-To option to designate a particular ship-to location as the primary ship-to 
location for a customer.

Accounts Receivable then uses the shipping information from this ship-to location record as the default 
entries when you set up a recurring charge record or create an invoice for the customer. Order Entry 
also uses these   defaults when you process an order for the customer.

State/Prov.

This field contains the name of the state or province where the business   is located. You can type up to 
20 characters in the field, including spaces.

Telephone

This field usually contains the telephone number at the place of business   of the customer, national 
account, or ship-to location. 

The field includes area code parentheses and hyphens if you selected   the Format Phone Number 
option for the company in the Company Profile   screen in Common Services.

Territory Code

Use this field to store an optional two-character territory code that your company uses to identify   or sort 
customer accounts in a way that is not otherwise available in   Sage 300 Accounts Receivable. You can 
also assign a territory code   to the ship-to locations you create for the customer. 

You maintain the information associated with each territory code outside   Accounts Receivable, but you 
can use the code to select customers when   printing Accounts Receivable reports and statements.

Zip/Postal Code

Type the zip code or postal code for the address.
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Contact Tab

This tab is available on the screen that appears when you click Open or New on the initial 
A/R Ship-To Locations screen.

Contact

This field usually contains the name of a contact person, position,   or department for the customer, ship-
to location, or national account.   

You can also leave the field blank or enter other information in it, using   up to 30 characters.

E-mail

You use the E-mail field to enter   the e-mail address for your contact at the ship-to location.

Fax

You use the Fax field to enter the fax number, if any, for your contact at the   ship-to location. 

The field includes area code parentheses and hyphens if you selected   the Format Phone Number 
option for the company in the Company Profile   screen in Common Services.

Telephone

This field usually contains the telephone number at the place of business   of the customer or national 
account. 

The field includes area code parentheses and hyphens if you selected   the Format Phone Number 
option for the company in the Company Profile   screen in Common Services.

Invoicing Tab

This tab is available on the screen that appears when you click Open or New on the initial 
A/R Ship-To Locations screen.

Salespersons

Use the salespersons fields on the Invoicing tab to:
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 l Assign up to five salespeople to each location.

 l Indicate the percentage of sales and returns totals to allocate to each sale.

To enter salesperson information, type the salesperson number or select it from the Finder, then type 
the percentage. 

To move to the next line, press Tab or click the next Salesperson Number field.

To delete a salesperson assignment, highlight the line, then press the Delete key on your keyboard.

The salesperson information you enter in a ship-to location record appears in the Invoice Entry screen 
when you specify the location. You can change the salesperson numbers and percentages as needed 
for particular invoices.

You do not have to enter salesperson information for ship-to locations, and you can change any 
salesperson information you enter in the record at any time.

Customer Price List

Use the field to assign a Sage 300 Inventory Control price list to   the customer or location. You can also 
enter other information in the   field or leave it blank. 

This field is not related to the price list, if any,   that you create in Accounts Receivable. 

FOB Point

Enter a description of the FOB point, using up to 30 characters.

Inventory Location

The inventory location you specify in this field is used as the default   for transactions you enter in Order 
Entry for the customer or ship-to   location, unless you specify a template for the transaction.

Percentage

Type the percentage of the customer's transaction   totals to allocate to each salesperson. 

The percentages you assign must add up to 100%.

The salespersons and percentages you assign to a customer group record   appear as defaults when 
you add a new customer record for the customer   group.

The salespeople and percentages you assign to a customer record or ship-to   location appear as 
defaults on the Sales Split tab on the Invoice Entry   screen when you enter transactions for the customer 
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or for the customer's   ship-to location, but you can change the information for a particular invoice,   credit 
note, or debit note. 

Salesperson Name

The Salesperson Name field displays the name entered in the Salespersons   record for each 
salesperson code. 

You cannot change any of the names on this tab. (Use the Salespersons   screen to change salesperson 
names.)

Salesperson Code

Use the Salesperson Code column to specify the salespersons who are responsible   for the customer's 
account. You can type the code or select   it using the Finder.

You can select up to five salespeople, but you must select salesperson   codes that are defined in 
Accounts Receivable. 

The salespersons specified for the customer group appear as default   entries for new customer records 
you add to the group.

Salespersons specified for a customer appear as default entries for   new ship-to location records you 
add for the customer.

Ship Via

This is the method you use to ship goods to the ship-to location, such   as courier or air freight. You can 
specify a ship via code that you set   up in Order Entry or that you maintain elsewhere, or you can leave 
the   field blank. You can also enter a description of up to 30 characters to   describe the ship-via method.

If you use Sage 300 Order Entry, you can type a code that you have set up in   Order Entry or select it 
using the Finder. If you do not use Order Entry,   you can enter a code that you maintain elsewhere. You 
can use up to 6   characters for the ship via code. 

You can change this information when you are entering an invoice that   uses the location. You can also 
print the ship via information on invoices.

Special Instructions

You can enter any delivery information in the Special Instructions field,   such as "Deliver before 3:00 
p.m." or "Use small truck   for deliveries." You can also use the field to record other information   for the 
location. 
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You can enter up to 30 characters of special instructions. You can change   this information when you 
are entering an invoice that uses the location,   and you can print it on invoices. 

Tax Group

Enter the tax group and tax information for all goods being shipped   to this location. Customers are often 
subject to different taxes if the   goods are shipped to different states or countries.

Once you select the tax group, make sure that the tax class for each   taxing authority is correct for the 
ship-to location, and enter any registration   numbers that apply.

Optional Fields Tab

This tab is available on the screen that appears when you click Open or New on the initial 
A/R Ship-To Locations screen.

Optional fields are available only if you use Transaction Analysis and Optional Field Creator.

You can accept the default optional fields that appear on the tab, or delete them. You can also   add 
different optional fields that you have set up for use with each  screen. 

For more information, see "About Optional Fields in Accounts Receivable" (page 41).

Customer Reports Screens
Use the screens in the A/R Customer Reports folder to print lists of the customer groups, national 
accounts, customers, ship-to locations, and recurring charges in your Accounts Receivable system.

You can also print statistics reports for customer groups, national accounts, and customers.

A/R Customer Groups Report

To Open this Screen

Open Accounts Receivable > A/R Customer Reports > Customer Groups.
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Related Tasks

 l "Printing the A/R Customer Group List Report" (page 284)

 l "Printing A/R Period Statistics Reports" (page 305)

Overview

You use the A/R Customer Groups screen to print the Customer Group List report and the Customer 
Group Statistics report.

 l The Customer Group List  report lists the information entered to define the customer groups used in 
your Accounts Receivable system, and the customers assigned to each group.

 l The Customer Group Statistics report lists the total amount of invoices, receipts, discounts,   debit 
and credit notes, write-offs and adjustments, interest charges,   and returned checks you have 
recorded for a customer group during the period covered by the report.

When to Print

Print the report when you add, change, or delete customer groups.

Information Printed on This Report

The Customer Groups report can include the following information for each customer group in the 
specified range, depending on the options you select at print time:

 l If you select Include Profile, the report lists the account type, account set, interest profile, and 
credit limit for each customer group, as well as the selection for the Allow Edit Of Credit Check 
option.

 l If you select Include Group Members, the report includes the telephone number and contact 
person for each of the member customers, for quick reference.

 l If you select the Include Optional Fields, the report also includes the optional fields and values 
assigned to each customer group.

 l If you use multicurrency accounting, the report lists the currencies used by the group, as well as 
the credit limit for each currency.

 l If you select Customer Group Statistics as the report type, the report provides the same 
information as the Customer Period Statistics report, but shows totals by customer groups instead 
of by customer.
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A/R Customers Report

To Open this Screen

Open Accounts Receivable > A/R Customer Reports > Customers.

Related Tasks

 l "Printing the A/R Customers Report" (page 285)

Overview

Note: Depending on how your system is set up, this desktop screen may also be available as a web 
screen. For more information, see the Web Screens Getting Started Guide or the help for Sage 300 
web screens.

The Customers report is one of four reports you can print using the A/R Customers report screen. It lists 
the information entered in Accounts Receivable to define the customer records used in your system.

For information about the other reports you can print using the Customers screen, see "A/R Customer 
Comments Report" (page 457), "A/R Activity Statistics Reports" (page 455), and "A/R Period Statistics 
Reports" (page 456).         

Tip: If you want to produce a specialized report of customers using selection criteria, use the 
A/R Customer List screen. For more information, see "A/R Customer List Screen" (page 404)

When to Print

Print the report after adding or revising customer accounts, before deleting inactive customers, and when 
you need a summary of customer addresses, profiles, comments, or recurring charges.

Information Printed on This Report

 l If you select the Include Address option, the customer's address, short name, telephone and fax 
numbers, and contact.

 l If you select the Include Profile option:

 l The customer's group, national account (if any), start date, currency, account set, billing 
cycle, terms code, credit limit and credit information, Print Statements option, interest 
profile, price list, customer type, territory, and business registration number.
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 l Tax group, authorities, classes, and registration numbers.

 l Salesperson numbers and sales splits.

 l If you select the Include Comments option and there are comments in customer records, the 
comments and dates from the customer records.

 l If you select the Include Recurring Charges option and you have set up recurring charges for 
customers, recurring charge information.

 l If you select the Optional Fields option, the report also includes the optional fields and values 
assigned to each customer.

 l If you use Payment Processing and you select the Include Credit Cards option, customer credit 
card details.

A/R Activity Statistics Reports

To Open this Screen

Open the report screen for the type of statistics you want to print:

 l Open Accounts Receivable > A/R Customer Reports > Customers.

 l Open Accounts Receivable > A/R Customer Reports > National Accounts.

Related Tasks

 l "Printing Activity Statistics Reports" (page 282)

Overview

You can print an Activity Statistics report for customers and for national accounts, if you use national 
accounts in your Accounts Receivable system.

The reports list information about the sales and payment history for the current year to date and previous 
fiscal year for the customer records and national accounts in your Accounts Receivable system. 

Note: Most of the information on this report is also available on the Activity Statistics tabs of the 
Customers and National Accounts screens.

When to Print

Print the report when you need to check on customer account activity, such as:

 l The last time a customer’s check was returned to you NSF.

 l The average number of days it takes a customer to pay invoices.
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 l The last time a customer was charged interest on an overdue document or account balance.

 l The date a customer’s balance was last revalued (if your Accounts Receivable system uses 
multicurrency accounting).

Information Printed on This Report

The Activity Statistics report lists the following information:

 l Outstanding balance, number of invoices in the system, number of paid invoices, the total days to 
pay invoices, and the date and balance of the last statement.

 l Last posting date.

 l Last amounts and dates for invoices, credit notes, debit notes, receipts, discounts, adjustments, 
write-offs, returned checks, and interest charges.

 l Current-year and last-year amounts and dates for the largest invoice and largest balance.

A/R Period Statistics Reports

To Open this Screen

Open the report screen for the type of statistics you want to print:

 l Open Accounts Receivable > A/R Customer Reports > Customers.

 l Open Accounts Receivable > A/R Customer Reports > Customer Groups.

 l Open Accounts Receivable > A/R Customer Reports > National Accounts.

Related Tasks

 l "Printing A/R Period Statistics Reports" (page 305)

Overview

The Period Statistics reports list the total amount of invoices, receipts, discounts, debit and credit notes, 
write-offs and adjustments, interest charges, and returned checks you have recorded for a given 
customer, customer group, or national account during the period covered by the report. 

The reports list statistics for the type of year and period you selected for customer, group, and national 
account statistics on the A/R Options screen.

Note: The information on this report is also available on the Statistics tabs of the Customers, Customer 
Groups, and National Accounts screens.
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When to Print

Print the report when you need a summary of customer statistics (for example, at the end of each period).

Information Printed on This Report

The Period Statistics reports list the following information:

 l The totals for each type of transaction in the years and periods selected for the report.

 l If selected for the report, the number of each type of transaction (document) posted in the selected 
years and periods.

 l Totals for all periods by customer, customer group, or national account, depending on the type of 
report.

A/R Customer Comments Report

To Open this Screen

Open Accounts Receivable > A/R Customer Reports > Customers.

Related Tasks

 l "Printing the A/R Customer Comments Report" (page 286)

Overview

The Customer Comments report lists comments from your customer records for a range of follow-up 
dates you specify.

When to Print

Print the report as a reference when you add, change, or delete customer comments, so that you can 
take timely action by the follow-up date.

Information Printed on This Report

The Customer Comments report lists the following information for each customer in the specified range:

 l Customer name and customer number for customer records that include comments.

 l Comments and comment date, follow-up date, and expiration date for comments entered in the 
customer record.

457Sage 300 2023 Accounts Receivable User's Guide



A/R National Accounts Report

To Open this Screen

Open Accounts Receivable > A/R Customer Reports > National Accounts.

Related Tasks

 l "Printing the A/R National Accounts Report" (page 304)

Overview

The National Account report is one of three reports you can print using the A/R National Accounts report 
screen. The report lists the information entered in Accounts Receivable to define the national accounts 
used in your system, and the customers assigned to each national account.

Note: You can print this report only if you use national accounts in your   Accounts Receivable system.

For information about the other reports you can print for national accounts, see "Printing Activity Statistics 
Reports" (page 282) and "Printing A/R Period Statistics Reports" (page 305).         

When to Print

Print the report when you add, change, or delete national accounts.

Information Printed on This Report

The National Account report lists the following information for each national account in the specified 
range, depending on options you select at print time:

 l If you select Include Address, the address, telephone and fax numbers, and contact.

 l If you select Include Profile, the national account's address, contact, telephone and fax numbers, 
customer group, account type, currency (multicurrency ledgers only), account set, billing cycle, 
credit limit and credit information, Print Statements option, and interest profile.

 l If you select Include Optional Fields, the report also includes the optional fields and values 
assigned to the account.

 l If you select Include Members, information for each customer assigned to the national account, 
including the customer number, name, telephone number, and contact name.
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A/R Ship-To Locations Report

To Open this Screen

Open Accounts Receivable > A/R Customer Reports > Ship-To Locations.

Related Tasks

 l "Printing the A/R Ship-To Locations Report" (page 308)

Overview

The A/R Ship-To Locations report lists the ship-to locations (alternate addresses) used by your 
customers.

When to Print

Print the report when you add, change, or delete ship-to locations.

Information Printed on This Report

The Ship-To Locations report can include the following information for each ship-to location in the 
specified range, depending on the options you select at print time:

 l If you select Include Address, the customer name, address, telephone and fax numbers, short 
name, and contact.

 l If you select Include Profile, the price list code, territory code, shipping instructions, tax group, tax 
status and registration numbers, and salesperson information.

 l If you select Include Optional Fieldsoption, the optional fields and values assigned to the ship-to 
location.

A/R Recurring Charges Report

To Open this Screen

Open Accounts Receivable > A/R Customer Reports > Recurring Charges.
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Related Tasks

 l "Printing the A/R Recurring Charges Report" (page 307)

Overview

The Recurring Charges report lists the customers, dates, terms, amounts, distribution codes, and 
summary details entered for the recurring charges you regularly invoice to customers.

Note: You can print this report only if   you select the Process Recurring Charges option on the 
A/R Options screen.

Note: You can print this report only if the Process Recurring Charges option is selected on the 
A/R Options screen.

When to Print

Print the report as a record whenever you add, change, or delete recurring charges.

Information Printed on This Report

The Recurring Charges report can include the following information for each recurring charge in the 
specified range, depending on options you select at print time:

 l The code and description for the charge.

 l The customer number and name that uses the charge.

 l The last run date, start date, and expiration date for the charge.

 l The maximum amount, total invoiced to date, and amount of last invoice issued for the charge and 
customer.

 l The distribution details entered for the charge.

 l If you select Include Schedule, the schedule code and description assigned to the recurring 
charge.

 l If you select Include Sales Split, the name, code, and percentage of sales for each salesperson  
assigned to the recurring charge.

 l If you select Include Optional Fields, the optional fields and values assigned to each recurring 
charge.
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A/R Statements / Letters / Labels Report

To Open this Screen

Open Accounts Receivable > A/R Customer Reports > Statements/Letters/Labels.

Related Tasks

 l "Printing Customer Statements" (page 293)

 l "Reprinting Statements" (page 297)

 l "Printing Letters and Labels" (page 299)

Overview

Note: Depending on how your system is set up, this desktop screen may also be available as a web 
screen. For more information, see the Web Screens Getting Started Guide or the help for Sage 300 
web screens.

Use the Statements/Letters/Labels screen to print statements, letters, or labels for a customer or national 
account.

Important! You can print a statement, letter, or label for a customer or national account only if the Print 
Statements option is selected in the record for the customer or national account.

You can print and reprint statements for Accounts Receivable customers and national accounts. More...

When you print statements for national accounts, the program includes with the national account 
statement additional pages for each member customer for whom you selected the Print Statement option 
in the customer record.

For an overview of statement printing, see "About Printing Statements" (page 291).

You can also print form letters and mailing labels from your Accounts Receivable data. 

Sage 300 Accounts Receivable comes with a sample statement, formatted for laser printers. You can use 
the statement as is, or you can use Crystal Reports to create custom statements or to adapt the formats 
that come with Accounts Receivable.

A sample letter and label format are also included.

The sample letter format that comes with Accounts Receivable prints letters for customer accounts that 
are overdue by at least 90 days or a longer period (say, 120 days) that you specify.
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Note: You can use the Statements/Letters/Labels screen to print labels for addresses in customer 
records. To print labels for customer ship-to addresses (for example, to affix on shipments of goods), 
you use the A/R Labels report screen. For more information, see "A/R Labels Report" (page 462).

When to Print

Print statements at the end of billing cycles, and send them to your customers to show the status of their 
accounts and to request payment. 

Information Printed on This Report

Statements, letters, and labels (any reports printed using the database query used by the default 
statement that comes with Accounts Receivable) can include the following features and information:

 l Your company's name, address, phone numbers, contact person, and telephone numbers.

 l The customer's name and address, from the customer account or ship-to location.

 l Customer credit limit and credit available.

 l For each transaction, the document number, document date, transaction type, reference number 
(for an invoice) or applied document number (for a transaction matched to an invoice), due date, 
and current amount of the transaction.

 l The dunning message specified on the A/R Options screen or selected for the statements, if you 
added message sets in the Dunning Messages screen.

 l The number of days in each aging period, and totals for each period. The transactions are aged by 
due date. You can age documents by document date, and include current transactions.

 l The previous balance, credits and new charges since the last statement, and the new balance.

A/R Labels Report

To Open this Screen

Open Accounts Receivable > A/R Customer Reports > Labels.

Related Tasks

 l "Printing Accounts Receivable Labels" (page 298)
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Overview

Note: Depending on how your system is set up, this desktop screen may also be available as a web 
screen. For more information, see the Web Screens Getting Started Guide or the help for Sage 300 
web screens.

You use the A/R Labels screen to print labels, either for customers’ addresses or for their ship-to 
locations. 

You can also use the Statements/Letters/Labels screen to print labels for customer addresses, but not for 
ship-to locations.

You can use one of the label formats that come with Accounts Receivable (ARLABELAVERY5162.RPT 
or ARLABELAVERY5160.RPT), or you can create your own custom format.

When to Print

Print labels when you need to deliver envelopes or packages to your customers.

Information Printed on This Report

Labels include address information from customer records or from ship-to location records, depending on 
the option you select for printing.

Periodic Processing Screens
Use Accounts Receivable Periodic Processing screens to perform tasks that are part of your regular 
period-end procedures, such as clearing history, creating general ledger batches, and deleting inactive 
records.

A/R Clear History Screen

To Open this Screen

Open Accounts Receivable > Periodic Processing > Clear History.

Related Tasks

 l "Clearing Accounts Receivable History" (page 264)
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Overview

You use the Clear History screen to remove obsolete data from your Accounts Receivable system.

You can clear ranges of the following information:

 l Fully paid documents

 l Customer comments

 l Printed posting journals

 l Posting errors

 l Deleted and posted batches

 l Statement data

If you use Payment Processing, clearing a receipt also clears credit card information associated with the 
receipt.

Fields and Controls

Customer Comments

Select this option to clear comments from customer records, and then:

 1. Specify the range of customer numbers for the records from which to clear comments (entered in 
the Customers screen).

 2. In the Through field, specify the date through which you want to clear comments.

Accounts Receivable clears comments that reached their expiration dates (specified in the customer 
records) on or before the Clear Customer Comments Through date for the specified range of customers.

Deleted and Posted Batches

Select this option to clear deleted and posted batches, and then:

 1. Select types of deleted and posted batches to clear.

 2. For each type of batch you select, in the Through Batch field, specify the number of the latest 
batch through which you want to clear.         

Note: By default, the Through Batch field displays the most recent (highest) batch number.

Accounts Receivable clears deleted and posted batches through the specified batch numbers.
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Note: After you delete a posted batch, you can no longer drill down to the transactions from General 
Ledger, view them in the Batch List screens, or reprint invoices or deposit slips for the batch.

Fully Paid Documents

Select this option to clear fully paid documents, and then:

 l Specify the range of customers for which to clear fully paid documents.

 l In the Through field, specify the date through which you want to clear fully paid documents.

Accounts Receivable clears invoices, credit notes, and debit notes that were fully paid on the Clear 
Transactions Through date if:

 l The balance for each document is zero.

 l The receipt that paid a document has cleared the bank account and has been reconciled for at 
least 45 days.

Accounts Receivable also removes all receipts and refunds associated with the fully paid documents.

Note: Clearing fully paid documents removes the transactions throughout your Accounts Receivable 
system. Once cleared, they no longer appear in any inquiry screens, on printed reports (including 
aging reports), or in Finders.

Posting Errors

Select this option to clear posting error batches, and then:

 1. Select the types of posting error batches to clear.

 2. For each type of batch you select, in the Through Posting Seq. No. field, specify the number of 
the latest posting sequence through which you want to clear.         

Note: By default, the Through Posting Seq. No. field displays the most recent (highest) posting 
sequence number.

Accounts Receivable clears posting error batches through the specified posting sequence numbers.

Printed Posting Journals

Select this option to clear posting journals. Enter details in the fields to the right of this option:

 l Select the types of posting journals to clear.

 l For each type of journal you select, in the Through Posting Seq. No. field, specify the number of 
the latest posting sequence through which you want to clear.         
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Note: By default, the Through Posting Seq. No. field displays the most recent (highest) posting 
sequence number.

Accounts Receivable clears posting journals through the specified posting sequence numbers, provided 
that you have:

 l Printed the journals to a printer or a file.

 l Created any outstanding general ledger transactions.

Important! After clearing journals, you can no longer print them, but the information in them is 
retained in the customer accounts and still appears on other reports.

Statement Data Through

Select this option to clear data that is used to reprint statements. In the field to the right of this option, 
specify the date through which to clear statement data.

Accounts Receivable clears statement data through the specified date.

A/R Clear Statistics Screen

To Open this Screen

Open Accounts Receivable > Periodic Processing > Clear Statistics.

Related Tasks

 l "Clearing Statistics" (page 266)

Overview

You use the Clear Statistics screen to remove obsolete statistics from your Accounts Receivable system.

You can clear ranges of the following information:

 l Customer period statistics

 l Customer group period statistics

 l National account period statistics

 l Salesperson statistics

 l Item statistics
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Note: The A/R Clear Statistics screen clears period statistics, not activity statistics. Activity statistics 
are kept only for the current year to date and the previous year, and are cleared when you use the Year 
End screen.

Fields and Controls

Buttons

Process

Click Process to clear statistics for the types and ranges of records and dates that you specified.

Close

Click Close to close the screen.

Clear Statistics

Specify the type of statistics to clear:

 l Customer Statistics.

 l Customer Group Statistics.

 l National Account Statistics.

 l Salesperson Statistics.

 l Item Statistics.

You can select as many types as you need at a time.

If you do not want to clear all types of statistics for the same periods, use the A/R Clear Statistics screen 
as many times as necessary to clear statistics separately for different ranges of customers, customer 
groups, and so on.

(Clear Statistics) From / To

Use these fields to specify the ranges of records for which to clear statistics

(Clear Statistics) Through Year / Period

The Through Year and Period fields appear beside the options to clear statistics that you select.
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Use them to specify the year and period up to which to clear statistics from the ranges of records you 
selected.

If you do not want to clear all types of statistics for the same periods, use the A/R Clear Statistics screen 
as many times as necessary to clear statistics separately for different ranges of customers, customer 
groups, and so on.

A/R Create G/L Batch Screen

To Open this Screen

Open Accounts Receivable > Periodic Processing > Create G/L Batch.

Related Tasks

 l "Creating Batches of General Ledger Transactions in Accounts Receivable" (page 245)

Overview

Note: Depending on how your system is set up, this desktop screen may also be available as a web 
screen. For more information, see the Web Screens Getting Started Guide or the help for Sage 300 
web screens.

You use the A/R Create G/L Batch screen to:

 l Create general ledger transactions from outstanding posted invoice, receipt, and adjustment 
batches.

 l If you use multicurrency accounting, create general ledger transactions when you revalue 
accounts at new exchange rates.

Note: You use this screen only if you do not create general ledger transactions during posting.

You post the General Ledger batches in Sage 300 General Ledger, if you use it, or in your other general 
ledger system.

Important! If you try to post a G/L batch to a period that is locked for General Ledger, the transactions 
are placed in an error batch. Therefore, make it a practice to create and post General Ledger batches 
for outstanding Accounts Receivable transactions before locking a period for General Ledger.
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Fields and Controls

Buttons

Process

Click Process to create a batch of transactions for General Ledger.

Close

Click Close to close the screen.

Create G/L Transactions From

Specify the types of batches for which you want to create general ledger transactions.

You must select at least one batch type, and you can select them all at once.

Through Posting Sequence

Specify the posting sequence number up to which you want to create general ledger transactions.

The last posting sequence number used for each type of batch is displayed. You can use this number or 
type the number of an earlier sequence.

General ledger transactions are created for the batches in the posting sequence you specify and for any 
earlier posting sequence numbers for which you have not yet created general ledger transactions.

A/R Create Interest Batch Screen

To Open this Screen

Open Accounts Receivable > Periodic Processing > Create Interest Batch.

Related Tasks

 l "Creating Interest Batches Automatically" (page 249)
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Overview

Note: Depending on how your system is set up, this desktop screen may also be available as a web 
screen. For more information, see the Web Screens Getting Started Guide or the help for Sage 300 
web screens.

You use the A/R Create Interest Batch screen to create batches of interest invoices for ranges of:

 l Customer numbers.

 l Customer groups.

 l National accounts (if you use them).

 l Billing cycles.

You create one batch of interest invoices at a time, but you can have as many open batches of interest 
invoices as you need.

You can also add interest invoices for one customer at a time in the Invoice Entry screen.

Note: You edit interest batches using the A/R Invoice Entry screen.

Fields and Controls

Buttons

Process

Click Process to create a batch of interest invoices, as you specified.

Close

Click Close to close the screen.

Detail Optional Fields Tab

Optional Field and Description (interest invoice details)

Invoice details optional fields that are assigned to the interest batch appear on the Optional Fields tab, 
along with the description from the optional field setup record.

When you start a new interest batch, any invoice optional fields that are set up for automatic insertion 
initially appear on this tab, along with their default values.
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You can change the optional fields and their values. However, if you delete an automatically inserted 
optional field, it will be reinserted when you create the invoices, and will use the value specified in the 
optional field setup record.

Value and Description

The program uses the default values from the setup record when optional fields are added to the 
Optional Fields tab (for interest invoices and write-off adjustments) or to the Optional Fields screen (for 
interest invoice details), but you can change the values for a particular batch.

Value Set

If an optional field is a required field, it must contain a value before you can save an entry.

The Value Set field indicates Yes if Accounts Receivable has already set a value—including an 
acceptable blank—for the field.

Optional Fields Tab

Optional Field and Description (interest invoice)

Invoice optional fields that are assigned to the interest batch appear on the Optional Fields tab.

When you start a new interest batch, any invoice optional fields that are set up for automatic insertion 
initially appear on this tab, along with their default values.

You can change the optional fields and their values. However, if you delete an automatically inserted 
optional field, it will be reinserted when you create the invoices, and will use the default value from the 
customer record, if the field is used for the customer record, or from the setup record. For more 
information, see "About Optional Fields for Interest Batches" (page 250).

Value and Description

The program uses the default values from the setup record when optional fields are added to the 
Optional Fields tab (for interest invoices and write-off adjustments) or to the Optional Fields screen (for 
interest invoice details), but you can change the values for a particular batch.

Value Set

If an optional field is a required field, it must contain a value before you can save an entry.
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The Value Set field indicates Yes if Accounts Receivable has already set a value—including an 
acceptable blank—for the field.

Options Tab

Age Document Balance

Select the Age Document Balance option if you want to calculate interest based on balances that 
existed as of the run date specified for the interest batch. This means that any transactions, including 
customer payments, dated after the run date are excluded from interest calculations.

If you do not select this option, the program calculates interest based on the current balance.

(Whether interest is calculated for the customer balance or for each document depends on the 
customer's account type and interest profile.)

From / To

Use the Finders for the From and To fields to specify the range from which to select customers for 
whom you are creating interest invoices.

Posting Date

Use this field to specify the date to post the interest invoices to General Ledger. The posting date 
determines the year and period to which the interest invoices are posted.

Accounts Receivable uses posting dates, rather than document dates, to select open documents for 
revaluation, so that exchange adjustments are posted to the correct fiscal year and period.

The default date that appears can be the document date, the batch date, or the session date, depending 
on the selection for the Default Posting Date option on the A/R Options screen.

Run Date

Enter the date to assign as the document date for all the interest invoices in the batch.

Interest is charged on all invoices and debit notes that were overdue by at least the number of days 
specified in the interest profile, as of the run date you specify.

Select By

Specify the type of record by which to select accounts on which to charge interest, as follows:
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 l Customer Number.  Create interest invoices for customers with overdue accounts in the range 
of customer numbers you specify.

 l Billing Cycle. Create invoices for all the customers with overdue accounts who use the billing 
cycles you specify. (This choice updates billing cycle records when you post the interest batch.)

 l Customer Group and National Account. Create invoices for all the customers with overdue 
accounts who use the customer groups or national accounts you specify.

Year/Period

The posting date you specify determines the fiscal year and period to which to post the interest invoices 
in General Ledger.

A/R Create Recurring Charge Batch Screen

To Open this Screen

Open Accounts Receivable > Periodic Processing > Create Recurring Charge Batch.

Related Tasks

 l "Invoicing Recurring Charges" (page 255)

 l "Invoicing a Recurring Charge Manually" (page 181)

 l "Setting Up a Recurring Charge for a Customer" (page 96)

Overview

You use the A/R Create Recurring Charge Batch screen to create recurring charge invoices for the 
customers and charges you select.

The program creates a new invoice batch with the next available invoice batch number.

You edit recurring charge batches using the Invoice Entry screen.

Note: Accounts Receivable does not process recurring charges for customers whose records are 
inactive or on hold.

Starting and Expiration Dates

On the Recurring Charges screen, you can specify a starting date and an expiration date for a recurring 
charge.
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When you create a recurring charge batch, an invoice is created for a recurring charge only if the batch 
creation date is between the starting date and the expiration date for the charge.

Maximum Amounts

On the Recurring Charges screen, you can specify a maximum amount for a recurring charge.

If an invoice for the full amount of the recurring charge would put the total invoiced for the charge over the 
maximum amount, an invoice is created for only the outstanding amount, instead of the full amount.

Fields and Controls

Buttons

Process

Click Process to create a batch of invoices for the recurring charges, as you specified.

Close

Click Close to close the screen.

From/To

Enter the range of records from which to select:

 l To specify a range of records, enter the lowest code (or number) in the range in the From field, 
and the highest code in the To field.

 l To specify a single record, enter its code in both fields.

 l To select all records, leave the From field blank and the To field showing Zs.

Method

Use this field to specify whether to create a new batch or add the invoices to an existing batch, as 
follows:

 l If you select Default, Accounts Receivable adds the invoices to an open invoice batch that has 
the same run date. If no batch has the same run date, it creates a new batch.

 l If you select Create A New Batch, Accounts Receivable creates a new batch of recurring charge 
transactions.
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 l If you select Add To An Existing Batch, Accounts Receivable displays an additional field with a 
Finder. Click the Finder to select an existing batch to which to add the invoices.

Run Date

Accounts Receivable processes all recurring charges up to the specified run date. The run date is used 
as the document date for all the invoices in the recurring charge batch, and when you post the batch, it is 
entered as the Last Run Date in the recurring-charge records you processed.

When you use the Create Recurring Charge Batch screen to create invoices for recurring charges, 
Accounts Receivable uses the session date as the default. You can enter a different date.

Select By

Choose the type of record by which to select the accounts for which to create recurring charge invoices. 
You can choose:

 l Recurring Charge Code. To create invoices for customers assigned to the range of recurring-
charge codes you specify. Other charges assigned to the customers are ignored if you do not 
include their recurring-charge codes in the range of codes.

 l Customer Number. To create invoices for customers to whom recurring charges are assigned in 
the range of customer numbers you specify.

 l Customer Group or National Account. To create invoices for all the customers to whom 
recurring charges are assigned and who use the customer groups or national accounts you 
specify.

When you select recurring charges by customer number or customer group, Accounts Receivable 
creates invoices for all recurring charges for the customer.

A/R Create Retainage Batch Screen

To Open this Screen

Open Accounts Receivable > Periodic Processing > Create Retainage Batch.

Related Tasks

 l "Invoicing Customers for Outstanding Retainage" (page 181)
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Overview

You use the A/R Create Retainage Batch screen periodically to create a batch of retainage invoices, 
debit notes, and credit notes for the customers, document numbers, customer groups, or national 
accounts you select.

Note: Accounts Receivable uses the Summary detail type for processing outstanding retainage.

Fields and Controls

Buttons

Close

Click Close to close the screen.

Process

Click Process to process outstanding retainage and create a batch of retainage documents.

Document Type

Specify the types of original retainage documents for which you are now processing outstanding 
retainage amounts. 

Number of Days In Advance To Generate Retainage Documents

Specify the number of days in advance of the retainage due date that retainage documents can be 
created.

Example: If you specify 7 as the number of days in advance, Accounts Receivable processes 
outstanding retainage that is due within seven days of the run date.

Run Date

Accounts Receivable processes all outstanding retainage amounts that are due up to and including the 
specified run date. 

Accounts Receivable uses the session date as the default run date, but you can enter a different date.
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Note: For job-related documents, retainage amounts and due dates are specified at the detail level. 
The program processes only details that are due.

Select By

Choose the type of record by which to select outstanding retainage for processing:

 l Customer Number. Process outstanding retainage for all the customers in the range of customer 
numbers you specify.

 l Document Number. Process outstanding retainage for all the original retainage documents in 
the range of document numbers you specify.

 l Customer Group or National Account. Process outstanding retainage for all customers who 
belong to the customer groups or national accounts within the range you specify.

From / To

Specify the range of records from which to select outstanding retainage for processing.

Tips: 
 l To specify a single record, type its code in both fields. 

 l To select all records, leave the From field blank and the To field showing Zs.

A/R Create Write-Off Batch Screen

To Open this Screen

Open Accounts Receivable > Periodic Processing > Create Write-Off Batch.

Related Tasks

 l "Writing Off Transactions" (page 262)

Overview

You use the A/R Create Write-Off Batch screen to:

 l Create batches of adjustment transactions to write off the outstanding or overdue transactions or 
balances that you specify.

 l Create a new adjustment batch with the next available adjustment batch number.
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Alternatively, you can use the following Accounts Receivable screens to enter adjustments for individual 
documents:

 l Use the A/R Adjustment Entry screen to write off all or a portion of the outstanding balances on 
individual documents adjustments.

 l Use the A/R Receipt Entry screen to write off small amounts from individual documents (if you use 
the Allow Adjustments In Receipt Batches option).

Note: You use the A/R Adjustment Entry screen to make any changes you need to the transactions 
created by the Create Write-Off Batch screen.

Multicurrency Ledgers

In multicurrency ledgers, write-off transactions are created in the customer's currency, using the 
exchange rate in effect for each currency at the time the batch is created. Realized exchange gains or 
losses result if you write off transactions at different exchange rates from the rates at which the 
transactions were entered.

Fields and Controls

Buttons

Close

Click Close to close the screen.

Process

Click Process to process outstanding retainage and create a batch of retainage documents.

Rates

Click Rates to open the Rate Override screen, where you can view or edit currency exchange 
information.

Optional Fields Tab

Optional Field and Description (write-off adjustments)

Adjustment optional fields that are assigned to the interest batch appear on the Optional Fields tab.
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When you start a new interest batch, any adjustment optional fields that are set up for automatic 
insertion initially appear on this tab, along with their default values.

You can change the optional fields and their values.

The generated write-off adjustments will use the optional field values specified for the batch. If you 
deleted an optional field that was automatically inserted, the adjustments will include the optional field 
using the default value from the customer records, where the optional field is used in the customer 
record, or from the optional field setup record.

Value and Description

The program uses the default values from the setup record when optional fields are added to the 
Optional Fields tab (for interest invoices and write-off adjustments) or to the Optional Fields screen (for 
interest invoice details), but you can change the values for a particular batch.

Value Set

If an optional field is a required field, it must contain a value before you can save an entry.

The Value Set field indicates Yes if Accounts Receivable has already set a value—including an 
acceptable blank—for the field.

Options Tab

Account Type

Specify whether to create write-off transactions for balance-forward customers, open-item customers, 
or all customers.

As Of Date

Type the date from which to age (count back) to select the documents or balances to be written off.

Currency

If you use multicurrency accounting, type the code for the currency in which to create write-off 
transactions. Write-off transactions are created only for customers that use the specified currency.

Days Outstanding/Days Overdue

The name of this field varies according to your selection for the Write-Off Type field, as follows:
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 l If you selected Outstanding Transactions or Outstanding Balances as the write-off type, the field 
name is Days Outstanding. 

 l If you selected Overdue Transactions or Overdue Balances, the field name is Days Overdue.

Type the number of days to count back from the As Of Date to determine the most recent document 
date for which to select transactions to write off.

Example: If the As Of Date is June 1 and you enter 120 in the Days Outstanding (or Days Overdue) 
field, amounts will be selected if they were outstanding (or overdue) on February 2.

Include

Select the types of documents to include when writing off outstanding or overdue transactions. Your 
choices vary, depending on the write-off type you selected.

You can write off unapplied cash transactions and prepayments only when you are writing off 
outstanding transactions.

If you are writing off overdue transactions, you can write off credit notes and debit notes only if you 
selected By Date for the Age Credit Notes And Debit Notes option on the A/R Options screen.

Note: You do not select document types when writing off outstanding or overdue balances.

Posting Date

The posting date determines the fiscal year and period to which the transactions will be posted in 
General Ledger.

Accounts Receivable uses posting dates, rather than document dates, to select open documents for 
revaluation, so that exchange adjustments are posted to the correct fiscal year and period.

The default date that appears can be the document date, the batch date, or the session date, depending 
on the selection for the Default Posting Date option on the A/R Options screen.

Run Date

Accounts Receivable uses the run date as the document date for all the adjustments in the write-off 
batch.

The session date appears as the default run date when you create a new write-off batch. You can enter 
a different date.
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Select By (amount)

Specify whether to select amounts to write off by:

 l Amount. A specific range of amounts.

 l Percent. A percentage of the original document balance or account balance.

In the From and To fields, enter the range of amounts or percentages by which to select amounts to 
write off.

Example: Enter 0 (zero) in the From field and 5 in the To field to write off all documents with an 
outstanding or overdue balance of between 0 and 5 dollars, or with outstanding or overdue balances 
of up to 5 percent of their original amounts.

Select By (criteria)

Specify filters (criteria) to use to select transactions or balances to write off, and then enter a range for 
each filter.

As the first selection criterion, you can choose Customer Number, National Account, Customer 
Group, Billing Cycle, or Short Name.

For the remaining criteria, you can choose from the above options as well as Account Set, Customer 
Name, Salesperson, and Territory Code.

If you do not specify any selection criteria, Accounts Receivable creates the batch for all customers of 
the specified customer type and currency (if you use multicurrency accounting).

Write-Off Type

Specify whether to select documents to write off by document date or due date, and whether to select 
single documents or all documents in the specified customer accounts. You can choose:

 l Outstanding Transactions. Write off documents with amounts that had been owing on the As Of 
Date for longer than the Days To Age period you specify.

 l Overdue Transactions. Write off documents with overdue balances, by due date (using the due 
date instead of the document date, as above).

 l Overdue Balances. Write off all selected documents in customer accounts with overdue 
balances, by due date.

 l Outstanding Balances. Write off all selected documents in customer accounts with outstanding 
balances, by document date.
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 l Outstanding Retainage. Write off small or uncollectible retainage amounts from invoices, debit 
notes, and credit notes owing on the As Of Date for longer than the Days To Age period you 
specify.

Year/Period

The Year/Period field appears beside the Posting Date field. 

The posting date you enter determines the fiscal year and period to which to post the write-off 
adjustments. 

A/R Delete Inactive Records Screen

To Open this Screen

Open Accounts Receivable > Periodic Processing > Delete Inactive Records.

Related Tasks

 l "Deleting Inactive Records from Accounts Receivable" (page 266)

Overview

You use the A/R Delete Inactive Records screen to remove obsolete customer, group, national account, 
salesperson, recurring charge, and ship-to location records from Accounts Receivable.

Note: You can remove only records that have Inactive status, and had that status in the range of dates 
you specify.

Fields and Controls

Delete These Records

Select the types of records to delete.

You can delete all records of the selected type, or use the From and To fields to specify ranges of 
inactive customers, customer groups, national accounts, salespersons, recurring charges, and ship-to 
locations.
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From/To

Enter the range of records from which to select:

 l To specify a range of records, enter the lowest number or code in the From field and the highest 
number or code in the To field.

 l To specify a single record, enter its number or code in both fields.

 l To select all records, leave the From field blank and the To field showing Zs.

Inactive Dates

Specify the range of dates from which to delete inactive records. 

All records must currently have Inactive status and must also have had that status assigned to them 
within the range of dates you specify. (That is, the Inactive date in the record must be a date in the 
specified range.)

A/R Revaluation Screen

To Open this Screen

Open Accounts Receivable > Periodic Processing > Revaluation.

Secondary Screens

 l A/R Revaluation History Screen

Related Tasks

 l "Revaluing Transactions in Other Currencies" (page 261)

Overview

You use the A/R Revaluation screen in multicurrency ledgers to:

 l Revalue multicurrency transactions at new exchange rates to determine the current value of 
receivables on specific dates.

 l Provisionally create revaluation transactions to check the entries that would be created for the 
exchange gain and loss general ledger accounts if you revalued the accounts at the specified 
rates. (Select Provisional Revaluation.)
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 l Create revaluation transactions for the general ledger exchange gain and loss accounts and for 
the customer accounts.

 l Open a separate screen to view historical revaluations for a selected currency. (Click the History 
button.)

Fields and Controls

Currency Code

Type the currency code for which you want to specify revaluation options, or choose it from the Finder.

The revaluation process selects only transactions that are in the specified currency.

Note: You cannot specify the same currency code more than once for a single revaluation. If you want 
to revalue different ranges of records for the same currency code, revalue each range separately.

Earliest Backdated Activity Date

This field is available only if all of the following conditions are true:

 l You use the Recognized Gain/Loss accounting method for your Sage 300 system.

 l You are revaluing a period that you revalued before.

 l There is a backdated transaction in the period. 

The field identifies the earliest backdated document to revalue.

If you leave this field blank, the program does not adjust the balances for the backdated transaction and 
associated documents. 

Example: You might leave the field blank if the revaluation is not for the end of a reporting period, and 
the change will be captured in a subsequent revaluation.

Optional Fields (revaluation)

The Optional Fields column on the detail table indicates whether any optional fields are assigned to the 
revaluation. The program sets the value for each line that you fill in on the table. If any revaluation 
optional fields are set up for automatic insertion, when you first add a detail line, the program sets the 
field to Yes.
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To change the optional fields and values for a particular line, or to delete optional fields, either double-
click in the Optional Fields column for the line or select the line, then click the Optional Fields column 
heading.

A separate Optional Fields screen then opens, showing any revaluation optional fields set up for 
automatic insertion, along with their default values. You can edit the values for existing optional fields, or 
add or delete optional fields for the detail. However, you can add only optional fields that are set up for 
use in revaluation transactions.

Provisional Revaluation

Select the Provisional Revaluation option if you want to preview revaluation transactions to check them 
before they are posted to the general ledger accounts. 

After creating provisional revaluation transactions, print the Provisional Revaluation Posting Journal to 
check the effects of the revaluation before you do an actual revaluation and create general ledger 
transactions.

Rate

Type the rate at which to revalue transactions for the specified currency code, or select a rate from the 
Finder.

Rate Date

Type the date to use to select the exchange rate at which to revalue transactions for the specified 
currency code.

Rate Type

Type the rate type, or choose a rate type from the Finder. (The rate type determines which currency 
table will be used.)

Revaluation Date

Type the date to use to select transactions to revalue.

The revaluation process selects open transactions with document dates that are on or before the date 
you specify.
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A/R Year End Screen

To Open this Screen

Open Accounts Receivable > Periodic Processing > Year End.

Related Tasks

 l "Starting a New Fiscal Year" (page 268)

Overview

Note: Depending on how your system is set up, this desktop screen may also be available as a web 
screen. For more information, see the Web Screens Getting Started Guide or the help for Sage 300 
web screens.

You use the A/R Year End screen to:

 l Reset batch numbers, so that the next batch you create of any type will use number 1.

 l Move customer and national account activity statistics for the current year into the previous year, 
and zero the statistical totals for the new year.

 l Set Year To Date Total Invoiced fields in recurring charge records to zero.

 l Reset to 0 (zero) the number in the Total Days to Pay and Total Invoices Paid fields in customer 
and national account activity statistics.

Fields and Controls

Buttons

Process

Click Process to create a new year and, if specified, reset batch numbers and clear statistics and 
invoices.

Close

Click Close to close the screen.
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Clear Activity Statistics

Select this option to enter zeros in the current-year fields on the Activity Statistics tabs in the 
A/R Customers and A/R National Accounts screens, and to transfer current-year statistical information 
to the corresponding fields for the previous year.

When you select this option, the Clear Invoices Paid And Days To Pay Counter option appears.

Clear Invoices Paid And Days To Pay Counter

Select this option to enter 0 (zero) in the Invoices Paid and Days To Pay fields on the Activity tab in the 
A/R Customers and A/R National Accounts screens.

Do not use the option if you want to include previous-year documents in the numbers you use to 
calculate the entry in the Average Days To Pay field for the account.

Note: This option appears only if you select the Clear Activity Statistics option first. You cannot clear 
these figures if you do not also clear the other activity statistics.

Clear Total Recurring Charge Amount

Select this option to set the amount in the Amount Invoiced To Date field in all recurring-charge records 
to zero.

Reset All Batch Numbers

Select this option when you want to start batch numbers at "1" again.

The option resets the batch numbers for all types of batches.

You can have up to 999,999,999 of each type of batch in Accounts Receivable. 

Note: You do not need to reset batch numbers, except to meet a particular requirement in your 
company.

A/R Update Recurring Charges Screen

To Open this Screen

Open Accounts Receivable > Periodic Processing > Update Recurring Charges.
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Related Tasks

 l "Updating Recurring Charges Automatically" (page 253)

Overview

You use the A/R Update Recurring Charges screen to update recurring charge records for summary 
invoices automatically. You can:

 l Increase or decrease recurring charge details by a percentage or by an amount for a range of 
customers or recurring charge records.

 l Change the maximum amounts in the recurring charge records in the specified range.

Note: You update recurring charge records for item invoices in the recurring charge record itself.

Fields and Controls

Buttons

Process

Click Process to update the recurring charges as you specified.

Clear

Click Clear to restore the default filter criteria for this screen.

Close

Click Close to close the screen.

Change By

Select Percentage or Amount. Together with your selections in the Increase/Decrease and Method 
fields, this field determines how Accounts Receivable updates the details of the recurring charge.

Change In Distribution Amount

The value you enter in this field depends on your selection in the Change By field, as follows:
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 l If you selected Percentage, enter a percentage. 

For example, to increase a recurring charge of $1,000 by $125, you enter 12.5 in this column. You can 
use up to five decimal places.

 l If you selected Amount, enter an amount.

In single currency ledgers, Accounts Receivable displays decimals appropriate for the functional 
currency.

In multicurrency ledgers, Accounts Receivable displays decimals appropriate for the specified 
currency.

Change in Max. Amount

If you want to change the maximum amount in the recurring charge record, enter the amount by which to 
increase or decrease the maximum amount. 

Currency Code 

This field appears only if you have a multicurrency Accounts Receivable ledger. 

If you are changing the details of the recurring charge by an amount, you must specify a currency. 
Accounts Receivable updates recurring charge records only for customers in the specified range who 
use the specified currency. 

If you are changing the details of the recurring charge by a percentage, the currency field is optional.

If you do not specify a currency, Accounts Receivable updates recurring charges for all customers.

If you do specify a currency, Accounts Receivable updates recurring charge records only for customers 
using the specified currency.

Distribution Code

If you specify Specific Distribution Code in the Method field, you must specify a distribution code in this 
field.

From/To Cust. No. 

Using the Finder, select the range of customers for whom you want to update the recurring charge.

You can update recurring charge records for all customers sharing that code, or for a range of 
customers. Accounts Receivable lets you choose from a list of customers who share the recurring 
charge code you selected.
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Increase/Decrease

Specify whether to increase or decrease the recurring charge. 

Together with the selection you make in the Change By and Method fields, this field determines how 
Accounts Receivable updates the details of the recurring charge. 

Method

You use this field to specify how to update the details in the selected records. 

If you selected Percentage in the Change By field, select one of the following methods:

 l All Details. Accounts Receivable increases or decreases all of the recurring charge details by the 
percentage you specify in the Change In Distribution Amount field.

 l Specific Distribution Code. Accounts Receivable increases or decreases amounts for only 
details that use the specified distribution code by the percentage you specify in the Change In 
Distribution Amount field.

If you selected Amount in the Change By field, select one of the following methods:

 l Spread Evenly. Accounts Receivable distributes the amount you specify in the Change In 
Distribution Amount field evenly for all the details of the recurring charge.

 l Prorate. Accounts Receivable distributes the amount you specify in the Change In Distribution 
Amount field based on the current amount of each of the details.

 l Specific Distribution Code. Accounts Receivable increases or decreases amounts only for 
details that use the specified distribution code by the amount you specify in the Change In 
Distribution Amount field.

Recurring Charge Code

Using the Finder, select the code for the recurring charge you want to change. You can specify the 
same code more than once on the Update Recurring Charges screen.

Setup Screens
Use Accounts Receivable Setup screens to set up records and options that determine how Accounts 
Receivable:

 l Processes transactions.

 l Interacts with General Ledger and other Sage 300 modules.
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A/R Account Sets Screen

To Open this Screen

Open Accounts Receivable > A/R Setup >        Account Sets.

Related Tasks

 l "Adding or Modifying Account Sets" (page 22)

Overview

Note: Depending on how your system is set up, this desktop screen may also be available as a web 
screen. For more information, see the Web Screens Getting Started Guide or the help for Sage 300 
web screens.

You use the A/R Account Sets screen to create groups of general ledger account numbers that you can 
use to:

 l Categorize customer transactions by the general ledger accounts to which they are posted in 
general ledger. (These accounts are receivables control, payment discounts, prepayment liability, 
retainage control, and write-offs.)

 l Designate different types of receivables, or customers in different geographical areas.

 l Specify the currency used by customers assigned to the account set in a multicurrency ledger.

 l Enter account numbers in multicurrency account sets (that do not use the functional currency) for 
exchange gains and losses and rounding differences that arise when converting to your functional 
currency from customer currencies and the tax reporting currencies.

You must create at least one account set before you can add customer records.

You can change the accounts in the account set at any time.

Fields and Controls

Account Set Code

Type a unique code, up to six characters, to identify the account set.
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Currency Code

If you use multicurrency accounting, you assign a currency code to each account set to identify the 
currency used by the customers you will assign to the set. 

You must assign a currency code that has been defined in Common Services. 

Note: After you add an account set, you cannot change its currency.

Description

Type a description of the account set, using up to 60 characters.

Exchange Gain

If you have a multicurrency system, enter the Exchange Gain account for the account set.

Exchange Gain is an income statement account to which you post differences arising from fluctuating 
exchange rates when you revalue a transaction at a new exchange rate or when you apply a payment to 
it.

A gain occurs when changes in the exchange rate cause an increase in the functional-equivalent 
amount your customer owes you.

Exchange Loss

If you have a multicurrency system, enter the Exchange Loss account for the account set.

Exchange Loss is an income statement account to which you post differences arising from fluctuating 
exchange rates when you revalue a transaction at a new exchange rate or when you apply a payment to 
it.

A loss occurs when changes in the exchange rate cause an decrease in the functional-equivalent 
amount your customer owes you.

Exchange Rounding

If you have a multicurrency system, enter the Exchange Rounding account for the account set.

Exchange Rounding is an income statement account that is updated with differences that arise when 
amounts are converted to the functional currency from source currencies and tax reporting currencies.
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Inactive

Select this option if you do not want to assign the account set to any customers.

Normally, you use this option when you decide to delete an account set, and want to ensure that it is not 
assigned to any additional customer accounts. You can change the option at any time.

You cannot assign inactive account sets to customer records. You also cannot save changes to 
customer records that use an inactive account set, unless you first assign the records to an active 
account set.

Last Maintained

This information field displays the date of the last change made to the account set. You do not make an 
entry in this field.

Prepayment Liability

Enter the Prepayment Liability account for the account set.

Prepayment Liability is a liability account to which prepayments are credited. The account is debited 
when prepayments are applied to invoices or refunded.

Receipt Discounts

Enter the Receipt Discounts account for the account set.

Receipt Discounts is an expense account to which customer discounts taken for early payment are 
debited when you post receipt transactions that include discounts.

The account number you specify should be in the expenses or cost of goods sold section of your 
general ledger chart of accounts.

Receivables Control

Enter the Receivables Control account for the account set.

Receivables Control is an asset account to which you post the total amount receivable from all 
customers assigned to the account set.

Accounts Receivable creates transactions to debit the account when you post invoices for sales, 
interest charges, and recurring charges, and when you apply debit notes. The account is credited when 
invoices are paid, credit notes are applied, and amounts are written off.
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Control accounts contain only totals, whereas the information stored by the Accounts Receivable 
program contains details at the transaction distribution level.

If all transactions are processed correctly, the total of all receivable balances in the Accounts 
Receivable system equals the total of the balances in the receivable control accounts in your general 
ledger.

Retainage

Enter the Retainage account for the account set.

Retainage is an asset account that accumulates outstanding retainage amounts until you clear the 
amounts by processing retainage invoices, retainage debit notes, and retainage credit notes.

Note: This account is used only if you use retainage accounting.

Unrealized Exchange Gain

Note: This account is available only if you use the Realized and Unrealized Gain/Loss accounting 
method in Sage 300.

If you have a multicurrency system, enter the Unrealized Exchange Gain account for the account set.

Unrealized Exchange Gain is the income statement account to which you post the amount by which a 
multicurrency transaction increases in its functional equivalent value when you revalue it at a new 
exchange rate.

A gain occurs when a change in the value of a transaction benefits you.

The gain is unrealized because the transaction is not settled. (That is, it has an outstanding balance, 
and the exchange rate for the transaction can continue to change until it is fully paid or written off.)

Unrealized Exchange Loss

Note: This account is available only if you use the Realized and Unrealized Gain/Loss accounting 
method in Sage 300.

If you have a multicurrency system, enter the Unrealized Exchange Loss account for the account set.

Unrealized Exchange Loss is the income statement accounts to which you post the amount by which a 
multicurrency transaction decreases in its functional equivalent value when you revalue it at a new 
exchange rate.

A loss occurs when the change in value of a transaction favors your customer.
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The loss is unrealized because the transaction is not settled. (That is, it has an outstanding balance, and 
the exchange rate for the transaction can continue to change until it is fully paid or written off.)

Write-Offs

Enter the Write-Offs account for the account set.

Write-Offs is the expense account to which amounts are debited when you write off transactions and 
balances. The Create Write Off Batch screen automatically produces transactions for this account.

A/R Billing Cycles Screen

To Open this Screen

Open Accounts Receivable > A/R Setup >        Billing Cycles.

Related Tasks

 l "Adding or Modifying Billing Cycles" (page 24)

Overview

Note: Depending on how your system is set up, this desktop screen may also be available as a web 
screen. For more information, see the Web Screens Getting Started Guide or the help for Sage 300 
web screens.

You use the A/R Billing Cycles screen to set up a variety of billing cycles to:

 l Group customers for which you process billing tasks periodically, such as: charge interest, print 
statements, clear paid transactions, and print several Accounts Receivable reports, by regular 
time intervals.

 l Calculate interest on overdue balances, and invoice customers for interest and recurring charges 
at the same frequency.

 l Keep records of dates on which interest were last invoiced and statements last printed.

 l Be notified if interest invoices for a cycle are overdue.

 l Choose not to print statements or charge interest for a particular billing cycle.

 l Print the name and address to which you want customers in the billing cycle to send their 
payments.

You must create at least one billing cycle before you can add customer records.
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Fields and Controls

Address

Enter the remit-to address to which customers in the billing cycle should send payments. You can also 
print this address on the statement forms you use for the billing cycle.

If you do not enter a remittance address for a billing cycle, no return address will be printed on 
statements for the billing cycle, unless you have assigned a return address to the form you use to print 
statements for the cycle.

Billing Cycle

Type a code, using up to six characters, to identify the billing cycle.

Description

Type a description of the billing cycle.

Frequency

Enter the length of the billing cycle in number of days.

Example: If you charge interest and send statements to customers once a month, you would enter 30 
days as the frequency.

Inactive

Select this option if you do not want to assign the billing cycle to any customers.

Normally, you use this option when you decide to delete a billing cycle, and want to ensure no further 
customer accounts are assigned to it. You can change this option any time.

You cannot assign inactive billing cycle codes to customer records. Also, you cannot save changes to 
customer records that use an inactive billing cycle, unless you first assign an active billing cycle code to 
the records.
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Interest Last Invoiced

The information kept for each billing cycle includes the date you last posted interest charges for the 
cycle, if you created the charges by billing cycle in the Create Interest Batch screen.

Last Maintained

This information field displays the date of the last change made to the billing cycle. You do not make an 
entry in this field.

Remit To

Enter the name to which customers in the billing cycle should send payments. You can also print this 
name on the statement forms you use when you print statements by billing cycle.

Note: You can also enter a remittance address in the Address field.

Statements Last Printed

The information kept for each billing cycle includes the dates on which you last printed statements (if 
you printed statements by billing cycle).

A/R Comment Types Screen

To Open this Screen

Open Accounts Receivable > A/R Setup > Comment Types.

Overview

Note: Depending on how your system is set up, this desktop screen may also be available as a web 
screen. For more information, see the Web Screens Getting Started Guide or the help for Sage 300 
web screens.

You use the A/R Comment Types screen to set up codes for each type of comment that you enter for 
customers. For example, you might set up codes for comments regarding:

 l Collections

 l Warranties

 l Promises to the customer

 l Other types of comments that salespeople or accounting personnel need to follow up
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Note: The Customer Inquiry screen lets you filter customer comments by comment type and user ID.

A/R Distribution Codes Screen

To Open this Screen

Open Accounts Receivable > A/R Setup >        Distribution Codes.

Related Tasks

 l "Adding or Modifying Distribution Codes" (page 26)

Overview

Note: Depending on how your system is set up, this desktop screen may also be available as a web 
screen. For more information, see the Web Screens Getting Started Guide or the help for Sage 300 
web screens.

You use the A/R Distribution Codes screen to define codes to identify the general ledger Revenue, 
Inventory, and Cost of Goods Sold accounts to use in sales transactions.

Distribution codes are a quick method of specifying the revenue, inventory, and cost of goods sold 
general ledger accounts to which you post data from sales transactions.

You can define as many distribution codes as you need to represent the various combinations of general 
ledger accounts to which you post sales data.

You can also use distribution codes if you do not use an Accounts Receivable item list. In this case, each 
distribution code identifies only a general ledger revenue account. When entering non-item transactions, 
you can either select the appropriate distribution code or select the number of the revenue account to 
use.

You also assign distribution codes to each invoice detail you enter in a recurring charge record.

Fields and Controls

Description

Type a description of the distribution code.
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Discountable

Specify a Discountable status for the distribution code, so that when you use the code in an invoice, 
credit note, or debit note detail, the status appears as the default for the detail.

Distribution Code

Type a code, using up to six characters, to identify the distribution code.

General Ledger Account Numbers

Enter the general ledger account numbers for the revenue, inventory, and cost of goods sold accounts 
to which amounts posted to the distribution code are distributed.

If you plan to assign the distribution code to an item record and you want to create transactions for 
inventory and cost of goods sold, enter numbers for all three general ledger accounts (revenue, 
inventory, and cost of goods sold).

If you will use the distribution code for creating summary invoices (invoices that do not use item 
numbers for invoice detail entry), enter the general ledger account number only for the revenue account. 
Accounts Receivable does not create transactions for inventory and cost of goods sold from summary 
invoices.

Inactive

Select this option if you do not want to assign the distribution code to any customers.

Normally you use this option when you decide to delete a distribution code, and want to ensure that it is 
not assigned to any additional customer accounts. You can change your entry any time.

You cannot assign inactive distribution codes to customer records. Also, you cannot save changes to 
customer records that use an inactive distribution code, unless you first assign an active distribution 
code to the records.

Last Maintained

This information field displays the date of the last change made to the distribution code. You do not 
make an entry in this field.
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A/R Dunning Messages Screen

To Open this Screen

Open Accounts Receivable > A/R Setup >        Dunning Messages.

Related Tasks

 l "Adding or Modifying Dunning Messages" (page 28)

Overview

Note: Depending on how your system is set up, this desktop screen may also be available as a web 
screen. For more information, see the Web Screens Getting Started Guide or the help for Sage 300 
web screens.

You use the A/R Dunning Messages screen to:

 l Add any number of sets of messages to print on statements to customers.

 l Specify which message in a set to use for each aging period.

If you use only one set of messages, you enter them on the Statement tab of the A/R Options screen. You 
also use the Statement tab of the A/R Options screen to specify the aging periods you see in the 
A/R Dunning Messages screen.

Fields and Controls

Description

Type a description for the set of dunning messages.

Dunning Message Code

Type a code for the dunning message set you are creating, or type the name of the statement format or 
letter format for which you are creating this set of dunning messages. (You can select the statement 
name using the Finder.) 

You select a dunning message set when you print statements.
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Accounts Receivable uses the dunning messages defined on  the A/R Options screen for all formats 
unless you define new sets.

Dunning Messages

Enter a message of up to 45 characters to print on customer statements or letters for each aging period. 
The message relating to the customer’s oldest outstanding transaction will be printed.

Example: The current period might contain the message, "Thank you for keeping your account 
current," while the message for the first overdue period (such as 1 to 30 days) might be "Please settle 
your account immediately."

Inactive

Select this option if you do not want to use the dunning messages on any statements or letters.

Normally, you use this status when you decide to delete a set of dunning messages or when want to 
temporarily stop using it. You can change the selection any time.

Last Maintained

This information field displays the date of the last change made to the set of dunning messages. You do 
not make an entry in this field.

A/R E-mail Messages Screen

To Open this Screen

Open Accounts Receivable > A/R Setup >        E-mail Messages.

Related Tasks

 l "Adding or Modifying an E-mail Message" (page 30)

Overview

Note: Depending on how your system is set up, this desktop screen may also be available as a web 
screen. For more information, see the Web Screens Getting Started Guide or the help for Sage 300 
web screens.

You use the A/R E-mail Messages screen to:
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 l Create messages to send with e-mailed statements, letters, receipt confirmations, and invoices.

 l Use variables (field names) from your company database so that the e-mailed messages will 
include customer- or company-specific information. For more information, see "E-mail Message 
Variables" (page 31).

You identify each e-mail message with a unique 16-character Message ID code. When you select 
Customer as the Delivery Method in the Statements/Letters/Labels screen and the A/R Invoices screen, 
you can select the Message ID for the message you want to send with the statement, letter, invoice, or 
receipt confirmation.

Fields and Controls

Description

Enter a description for the message, using up to 60 characters.

E-mail Subject

Enter the subject line you want to use for the message. 

Note: You can use field names, preceded by a dollar sign to insert customer- or company-specific 
information in the subject line of the messages.

Inactive

Select this field only if you do not want to use this message with e-mailed messages.

Last Maintained

This information field shows the last time you modified this e-mail message. You do not change it.

Message (unlabeled text field)

Type your message in this field.

Note: You can use field names, preceded by a dollar sign to insert customer- or company-specific 
information in the message text.

Message ID

Enter a code to identify this message, using up to 16 characters.
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Message Type

Select Statement (E-mail), Invoice (E-mail), Receipt (E-mail), or Letter (E-mail), depending on the 
purpose and method of delivery of this message.

A/R G/L Integration Screen

To Open this Screen

Open Accounts Receivable > A/R Setup >        G/L Integration.

Secondary Screens

 l "A/R G/L Integration Detail Screen" (page 508)

Related Tasks

 l "Selecting General Ledger Integration Options for Accounts Receivable" (page 16)

 l "Assigning Information to G/L Transaction Fields" (page 17)

Overview

Note: Depending on how your system is set up, this desktop screen may also be available as a web 
screen. For more information, see the Web Screens Getting Started Guide or the help for Sage 300 
web screens.

You use the A/R G/L Integration screen to:

 l Specify how Accounts Receivable produces and maintains information from posted transactions 
for General Ledger. (Use the Integration tab.)

 l Define source codes to identify different types of Accounts Receivable transactions created for 
General Ledger.

 l View the last posting sequence number for each type of batch posted to General Ledger.

 l Specify what data to include in the G/L Entry Description, G/L Detail Reference, G/L Detail 
Description, and G/L Detail Comment fields for general ledger transactions. (Use the Transactions 
tab.)
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Sage 300 Accounts Receivable produces general ledger transactions from all batches you post. Each 
general ledger transaction includes all the information you need to accurately update receivables data in 
your general ledger.

If you use Sage 300 General Ledger, Accounts Receivable creates batches of receivables transactions 
right in General Ledger, where you can edit and post them. If you use another general ledger system or 
your Sage 300 General Ledger system is at another location, Accounts Receivable creates batches you 
can import into another application, or print, then enter manually into your general ledger.

Integration Tab

This tab lets you control how and when GL transactions are created. More...

Use the Integration tab to:

 l Specify whether to add general ledger transactions to the G/L batch each time you post, or to 
create the transactions at a later date.

 l Choose whether to add new transactions to the existing G/L batch, if an open batch exists, or 
create a separate G/L batch when you create G/L transactions. You can also choose to post new 
batches automatically. (This option applies only if you use Sage 300 General Ledger with 
Accounts Receivable at the same location.)

 l Choose whether to consolidate the G/L batch when you post, or always enter full transaction 
details in the batch.

 l Look up the posting sequence number to be assigned the next time you post invoices, receipt, or 
adjustments, or the next time you revalue transactions, if you use multicurrency accounting.

Before changing the Create G/L Transaction option to create transactions during posting (if it was set to 
create transactions using the Create G/L Batch icon), print an up-to-date copy of the G/L Transactions 
report, then create any outstanding transactions.

Any change to your selections for the Consolidate G/L Batches option or the data to include in the G/L 
Entry Description, G/L Detail Reference, G/L Detail Description, and G/L Detail Comment fields applies 
only to transactions posted after the change, and has no effect on transactions already in a general 
ledger batch.

Transactions Tab

Use the Transactions tab to specify the type of information to use in the transaction description, detail 
reference, detail description, and detail comment fields for general ledger transactions. More...

This information also appears on Accounts Receivable posting journals and on General Ledger’s Journal 
Entry screen and reports.
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You can assign one or more pieces of information (segments) to each field, provided that the combined 
length of the segments and separators does not exceed 60 characters. Fields exceeding this limit will be 
truncated when you post general ledger transactions.

The segments you can select depend on the type of transaction to which you are assigning information 
and whether the information is for the transaction header or the details. This ensures that the information 
passed to General Ledger is relevant for each type of transaction. For example, you can assign the ship-
to information from invoice details to any of the General Ledger fields.

When you create general ledger transactions, if no data exists in the source transaction field, the field will 
be blank in the general ledger transaction. For example, if you assigned the original transaction 
description to the G/L Entry Description field, but there is no description for a particular entry, the field will 
be blank in the G/L transaction.

Fields and Controls

Integration Tab

Consolidate G/L Batches

Use this option to specify whether to combine transaction details for the same general ledger account 
into single details, or to send every Accounts Receivable transaction detail to General Ledger.

Important! If you consolidate transactions, you lose the ability to drill down to them from General 
Ledger.

You can choose:

 l Do Not Consolidate. All the details posted in Accounts Receivable are included in the General 
Ledger transaction batch. You maintain the ability to drill down to the transactions from General 
Ledger.

 l Consolidate by Posting Sequence, Account and Fiscal Period. All the details with the same 
posting sequence, account number and fiscal period are combined into one detail. The posting 
date for consolidated entries is the last date of the fiscal period.           

You will not be able to drill down to the transactions from General Ledger.

 l Consolidate by Posting Sequence, Account, Fiscal Period, and Source. All the details with the 
same posting sequence, account number, fiscal period, and source code are combined into one 
detail. The posting date for consolidated entries is the last date of the fiscal period.           

You will not be able to drill down to the transactions from General Ledger.
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Create G/L Transactions By

This option applies only if you use Sage 300 General Ledger with Accounts Receivable.

You can create transactions by:

 l Adding to an Existing Batch. Choose this option if you want to add new general ledger 
transactions to existing batches.

 l Creating a New Batch. Choose this option if you want to produce a new general ledger batch 
each time you create general ledger transactions.

 l Creating and Posting a New Batch. Choose this option if you want to create and automatically 
post a new general ledger batch when you create general ledger transactions.

Note: If you try to post a G/L batch to a period that is locked for General Ledger, the transactions are 
placed in an error batch. Therefore, make it a practice to create and post General Ledger batches for 
outstanding Accounts Receivable transactions before locking a period for General Ledger.

Accounts Receivable automatically creates separate general ledger batches for the different types of 
transactions you can post (invoices, receipts, adjustments) and for revaluation transactions (if you use 
multicurrency accounting).

If you do not use Sage 300 General Ledger, all general ledger transactions are added to the same 
general ledger batch, regardless of the type of transaction and your choice for this option. You are 
asked to whether to add the transactions to the existing batch or overwrite the batch. Always choose to 
add to an existing batch.

Create G/L Transactions During Posting/On Request Using Create G/L Batch Icon

Use this option to specify when to create general ledger transactions.

You can create transactions for the general ledger when you post Accounts Receivable batches, or you 
can create a batch of general ledger transactions using the A/R Create G/L Batch icon.

You can change your selection at any time.

Important! If you use the option to create the batch during posting in Accounts Receivable, you 
cannot print the G/L Transactions report.

If you have been using the A/R Create G/L Batch icon to create the transactions, be sure to print a copy 
of the latest G/L Transactions report, and then create any outstanding transactions before you change 
this option.
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G/L Source Codes

Use the Source Type fields in this section to define the source code for each type of Accounts 
Receivable transaction, if you prefer not to use the default source codes.

The source code is a combination of the source ledger code (AR, which you cannot change) and the 
source type code, which you can specify for all the different types of transactions you can process in 
Accounts Receivable, including revaluation.

The source codes are used to identify transactions in General Ledger.

Note: The default source code for receipts is the same as for receipt reversals. Refunds use the 
same default source code as refund reversals.

G/L Transactions Generated Through

This field shows the posting sequence number for each type of transaction batch for which general 
ledger transactions have been created.

You use this information when you use On Request Using Create G/L Batch Icon for the Create G/L 
Transactions option, to find out whether you have created all outstanding general ledger transactions.

If general ledger transactions are up to date, the posting sequence numbers in this field are the same as 
the posting sequence numbers for each batch type on the Integration tab of the A/R G/L Integration 
screen.

Transactions Tab

G/L Detail Comment

This field displays, for each detail transaction type, the comment information that will appear with 
unconsolidated details on the G/L Transactions report and in the general ledger batch.

To include different information as the comment for a selected transaction type, click the Open button, 
or double-click the Comment field you want to change, then enter the information on the G/L Integration 
Detail screen that appears.

G/L Detail Description

This field displays, for each detail transaction type, the information that will appear with unconsolidated 
details in the Description column on the A/R G/L Transactions report and in the Description field in the 
general ledger batch.
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Note: If consolidate details during posting, the description is "CONSOL" for all the transactions in 
General Ledger.

To edit the information for a selected transaction type, click the Open button or double-click the field 
you want to change, and then enter the information on the G/L Integration Detail screen that appears.

G/L Detail Reference

This field displays, for each detail transaction type, the information that will appear with unconsolidated 
details in the Reference column on the A/R G/L Transactions report and in the Reference field in the 
general ledger batch.

Note: If you consolidate details during posting, the reference is blank for all the transactions in 
General Ledger.

To edit the information for a selected transaction type, click the Open button or double-click the field 
you want to change, and then enter the information on the G/L Integration Detail screen that appears.

G/L Entry Description

This field displays, for each entry transaction type, the information that will appear as the entry 
description on the G/L Transactions report and in the general ledger batch.

To edit the information for a selected transaction type, click the Open button or double-click the field 
you want to change, and then enter the information on the G/L Integration Detail screen that appears.

Transaction Type

This column shows the transaction types for which you can assign information for general ledger 
transactions.

To edit the information for a selected transaction type, click the Open button or double-click the field 
you want to change, and then enter the information on the G/L Integration Detail screen that appears.

A/R G/L Integration Detail Screen

To Open this Screen

 1. Open Accounts Receivable > A/R Setup > G/L Integration.

 2. On the Transactions tab, select a transaction type, and then click Open.
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Overview

This screen lets you specify data to include in the following fields for general ledger transactions:

 l G/L Entry Description.

 l G/L Detail Reference.

 l G/L Detail Description.

 l G/L Detail Comment fields.

Fields and Controls

Choose segments from list

This list shows the segments of transaction information that can be assigned to the G/L field.

To assign a segment to the G/L field, select the segment in this list, and then click Include.

Notes: 
 l The segments that appear on the list depend on the transaction type.

 l You can assign a maximum of five segments to a G/L Transaction field, providing that the 
combination does not exceed 60 characters. If the assigned information exceeds this number 
of characters (including separators), it will be truncated when the transaction is posted.

Example

This field shows how the selected segments and separator will appear for the G/L field.

G/L Transaction Field

Select the G/L field for which you are adding information. You can assign the following information:

 l For document headers (transaction entries), you can assign the information to be used for the 
G/L entry description.         

You can also assign the information to be used for details that are created for a document when it is 
passed to General Ledger (for example, summary tax details or summary rounding details).

Because these details are created for a transaction as a whole, the information assigned to their detail 
description, reference, and comment fields is taken from the entry rather than a document detail.

 l For transaction details, you can assign the information to be used for the detail description, detail 
reference, and detail comment.
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The segments you can assign to the field depend on the transaction type.

Segment Separator

If you are assigning more than one segment to the G/L field, select the character you want to use to 
separate the segments.

Segments currently used

This list shows the segments of transaction information that are assigned to the G/L field.

To remove a segment from the G/L field, select the segment in this list, and then click Exclude.

Transaction Type

Select the type of transaction entry or detail for which you are entering information for G/L fields.

A/R Interest Profiles Screen

To Open this Screen

Open Accounts Receivable > A/R Setup >        Interest Profiles.

Related Tasks

 l "Adding or Modifying Interest Profiles" (page 34)

Overview

Note: Depending on how your system is set up, this desktop screen may also be available as a web 
screen. For more information, see the Web Screens Getting Started Guide or the help for Sage 300 
web screens.

You use the A/R Interest Profiles screen to:

 l Specify how you charge interest on overdue accounts, including:

 l Whether to charge by overdue invoice or account balance

 l The number of days overdue before interest is charged

 l Whether to compound outstanding interest charges
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 l The minimum interest charge

 l Whether to round up interest charges to a minimum amount

 l The annual interest rate

 l For multicurrency accounting, the minimum interest charge and annual interest rate for 
each currency.

 l Assign the general ledger account to which you post revenue from interest charges.

 l Specify a prefix for interest invoice numbers.

You must add at least one interest profile in Accounts Receivable before you can add customer records, 
and you must assign an interest profile to each customer. If you do not charge interest to customers, 
assign them to an interest profile with 0 (zero) as the annual rate.

You can set up as many interest profiles in Accounts Receivable as you need for the ways and rates with 
which you assess interest charges. For information about how Accounts Receivable calculates interest 
on outstanding documents or balances, see "About Calculating Interest Charges" (page 33).

Fields and Controls

Annual Interest Rate

Enter the total annual rate at which you charge interest. You enter the rate as a percentage. 

Example: To charge interest at 12% per year, enter 12 as the annual interest rate.

Calculate Interest by Document/Balance

Choose the method by which you calculate interest charges on open-item accounts. You can charge 
interest on overdue invoices or overdue balances. For more information, see "About Calculating Interest 
Charges" (page 33).

Note: Balance-forward accounts are always charged interest on overdue balances.

Charge Interest on Accounts [ ] Days Overdue

Enter the number of days an account must be overdue before it is charged interest.
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Compound Interest

Select this option if you include previous interest charges in the overdue total on which you charge 
interest.

Currency Code

If you use multicurrency accounting, enter the currency code for each currency that is assigned to a 
customer who uses the interest profile, then enter the minimum interest charge and annual interest rate 
for each currency.

Description

Type a description of the interest profile.

Inactive

Select this option if you do not want to assign the interest profile to any customers.

You primarily use this option when you decide to delete an interest profile, and want to ensure no further 
customer accounts are assigned to it. You can change your entry any time.

You cannot assign inactive interest profiles to customer records. Also, you cannot save changes to 
customer records that use an inactive interest profile, unless you first assign an active interest profile to 
the records.

Interest Income Account

Enter the number of the general ledger account to which you post revenue from interest charges.

Interest Profile Code

Enter a code to identify the interest profile, using up to six characters.

Last Maintained

This is an information field in which the program displays the date of the last change made to the profile. 
You do not make an entry in this field.

Minimum Interest Charge

Enter the minimum amount you charge as interest. Interest charges below this amount are either not 
invoiced or are rounded up to this amount, depending on your choice for the Round Up To Minimum 
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option.

Example: 
If the minimum interest charge is $1.00, an amount of $0.98 is rounded up to $1.00, if you use the 
option to round up.

If you do not use the option, no interest is charged, because the $0.98 amount is less than the 
minimum amount of $1.00.

Round Up to Minimum

Select this option to round up interest charges to the minimum amount you charge as interest. 

Do not select the option if you have no minimum interest charge or if you charge interest regardless of 
the amount.

Example: 
If the minimum interest charge is $1.00, an amount of $0.98 is rounded up to $1.00, if you use the 
option to round up.

If you do not use the option, no interest is charged, because the $0.98 amount is less than the 
minimum amount of $1.00.

A/R Items Screen

To Open this Screen

Open Accounts Receivable > A/R Setup >        Items.

Related Tasks

 l "Adding or Modifying an Item" (page 38)

Overview

You use the A/R Items screen to:

 l Create a list of the items you sell, so you can use item numbers when filling out invoice details.

 l Specify the item cost, so invoicing will create transactions for inventory and cost of goods sold 
accounts.
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 l Specify a default distribution code or the particular accounts to update when you use an item in a 
transaction.

 l Specify the tax authorities and tax classes for items, to simplify tax calculation on invoices.

For more information, see "About Accounts Receivable Items" (page 36).

Item Tab

Use the Item tab to:

 l Enter a commodity code for the item (for VAT reporting).

 l Assign an optional distribution code to identify the general ledger accounts to update when 
transactions are posted for the item number.

 l Type a comment of up to 256 characters that you can display when entering details for the item 
number and print on invoices.

Pricing Tab

Use the Pricing tab to:

 l Enter costs and prices for the units in which you sell the item.

 l Enter an alternate tax base amount for items when tax is not calculated on the item price or cost.

 l In multicurrency systems, enter units of measure, costs, and prices for each currency in which you 
sell the item.

Statistics Tab

The Statistics tab appears only if you selected the Keep Item Statistics option on the A/R Options 
screen.

Use the Statistics tab to:

 l Enter sales, returns, and costs of goods sold amounts for each unit of measure and year and 
period in which you have sold the item.

 l Look up the gross margin and quantity sold for the item and unit of measure in the current year to 
date.

 l Look up the date on which the item was last sold by a particular unit of measure.

In multicurrency systems, item statistics are kept only in functional currency. If you use the same unit of 
measure for more than one currency, the amounts sold of the unit in each currency are combined in the 
statistics kept for the item.

Tax Status Tab

Use the Tax Status tab to:
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 l Assign the tax authorities and tax classes that are used to calculate taxes when you enter item 
details.

 l Indicate whether tax is included in the item price in each authority and tax class.

Fields and Controls

Item Tab

Comment

Use the Item Information tab on the Items screen to enter information about an item, such as usage 
guidelines or special handling instructions. The information can be displayed during invoice entry, and 
printed on invoices.

Tip: You press the Enter key to start a new line of comments. If you want comments on a single line, 
just keep typing, and the text will scroll within the comments screen.

You can select the Use Item Comment As Default option on the A/R Options screen to display 
comments automatically from an item record when you are entering invoices that use the item number.

Commodity Number

Use for VAT (value-added tax) reporting, or for your own reference.

Description

Enter a description (name) for the item.

Discountable

Accounts Receivable lets you select a discountable status for an item code. 

When you use the item code for a detail on the Invoice Entry screen, the detail line uses the same 
Discountable option that you selected for the item.

Note: If you change the distribution code for the detail line, the discountable status may also change.

Distribution Code

Enter the distribution code that identifies the revenue, inventory, and cost of goods sold accounts to 
which you distribute transaction amounts posted for the item.
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If you want to use accounts that are not used in an existing distribution code, leave the Distribution 
Code field blank, and then enter the account numbers individually in the Revenue Account, Inventory 
Account, and COGS Account fields.

Revenue / Inventory / Cost Of Goods Sold

You use these fields to enter the revenue, inventory, and cost of goods sold accounts to update when 
you post a transaction for an item, if you do not want to use a distribution code to identify the General 
Ledger accounts.

Inactive

Select this option if you do not want to enter any further transactions that use the item number.

You must delete any unposted invoice details that use an inactive item number, or assign another item 
number to the details.

You can change your selection any time.

Item Number

Enter a code to identify the item, using up to sixteen characters.

Last Maintained

This information field displays the date of the last change made to the item record. You do not make an 
entry in this field.

Pricing Tab

Alternate Tax Base

The alternate tax base is the amount on which to calculate taxes for a tax authority that levies tax on an 
alternate amount, rather than on a selling price or standard cost.

If the tax authority does not use alternate amounts for the tax base, Accounts Receivable ignores this 
field.
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Currency

If you use multicurrency accounting, enter the currency codes for the currencies in which you sell the 
item, then enter pricing information for each currency code. You create one line of prices for each 
currency and each unit of measure in which you sell. 

Example: If you sell goods by the pound and by the kilo in each of two currencies, add four lines, 
each of which specifies the cost and selling price for one currency and one unit of measure.

Remember to include the functional currency, if applicable, and to enter cost and price amounts in the 
currency identified by the code.

Item Cost

Enter the cost of the item per the unit of measure and in the currency you specified for this line.

Ignore this field if you are entering a non-inventory item. If you omit the item cost, Accounts Receivable 
posts only to the revenue account, and not to inventory and cost of goods sold.

Item Price

Enter the price of the item per the unit of measure and in the currency you specified for this line.

Unit of Measure

Enter the name of the unit in which you sell the item, such as each, dozen, or box.

You create one line of costs and prices for each unit of measure and each currency in which you sell. 

Example: If you sell goods by the pound and by the kilo in each of two currencies, add four lines, 
each of which specifies the cost and selling price for one unit of measure in one currency.

Statistics Tab

Cost of Goods Sold

If adding historical figures, enter the total amount of costs of goods sold for the item during the 
displayed period.

Do not include amounts that will be posted to the item when you enter historical and year-to-date 
Accounts Receivable transactions.

Amounts are in the functional currency.
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Date Last Sold

Accounts Receivable displays the date of the last sale posted for this item. You cannot enter this date 
during setup, except by posting transactions for the item. The figure is entered by Accounts Receivable 
only when you post a document that uses the item number.

Gross Margin (display only)

Accounts Receivable automatically calculates the gross margin for the unit of measure, year, and 
period by subtracting the cost of goods sold from the total sales.

Amounts are in the functional currency.

Quantity Sold

Accounts Receivable automatically enters and updates the quantity sold of the item in the selected unit 
of measure, year, and period from posted transactions. 

You cannot create this figure yourself simply by entering item statistics for prior periods during setup.

Returns Amount and Count

If adding historical figures, enter the total amount of returns of the item during the displayed period, and 
enter the number of invoices for which the item was returned in the period.

Do not include returns that will be posted to the item when you enter historical and year-to-date 
Accounts Receivable transactions.

Amounts are in the functional currency.

Sales Amount and Count

If adding historical figures, enter the total amount of sales of the item during the displayed period, and 
enter the number of invoices on which the item was sold in the period.

Do not include sales that will be posted to the item when you enter historical and year-to-date Accounts 
Receivable transactions.

Amounts are in the functional currency.

Unit of Measure

Statistics are kept for each unit of measure in which you sell the item. (Item statistics do not convert one 
unit of measure to another.)
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Enter the unit of measure for which you want statistics.

Year and Period

Enter or select the fiscal year for which you want to view or enter statistics (if you are just setting up your 
system). Enter or select the fiscal period for which you want to view or enter statistics.

For each period, you can enter the amount and number of each item’s sales, returns, and cost of goods 
sold.

Tax Status Tab

Tax Authority

Enter the codes that identify each government body that levies tax on sales of the item, or choose the 
codes from the Finder. For example, if the item was eligible for federal and county taxes, you would add 
two lines—one for each authority.

You must select a tax authority that is defined in the Tax Services screens in Common Services.

Tax Class

Enter the code that identifies the tax status for the item in the associated jurisdiction, or choose the code 
from the Finder. Tax classes are defined in Tax Services, which are a part of Common Services.

The tax class you select must be assigned to the corresponding tax authority in Tax Services.

Tax Included

Specify whether the selling price includes the tax.

A/R Optional Fields Screen

To Open this Screen

Open Accounts Receivable > A/R Setup >        Optional Fields.

Secondary Screens

 l "A/R Optional Field Settings Screen" (page 522)
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Related Tasks

 l "Adding or Modifying Optional Fields" (page 45)

Overview

Note: Depending on how your system is set up, this desktop screen may also be available as a web 
screen. For more information, see the Web Screens Getting Started Guide or the help for Sage 300 
web screens.

Note: Optional fields are available if you use Transaction Analysis and Optional Field Creator.

You use the A/R Optional Fields setup screen to define optional fields that store custom information with 
records and transactions.

Fields and Controls

Buttons

Settings

This button is available if you are adding optional fields for a type of transaction or for transaction 
details.

Click Settings to open the Settings screen, where you specify whether the selected optional field will be 
included with transactions sent to General Ledger and other subledgers.

Auto Insert

Select Yes in this field if you want the program to display the optional field and its default value when 
you set up new records or enter transactions.

Select No if you do not want the optional field to appear automatically.

Example: If you define Transit Number as an optional field for invoices and you select Yes in the Auto 
Insert field, the Transit Number field appears automatically in Invoice Entry when you start a new 
transaction.
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Default Value and Description

Type or select the value to display as the default for the optional field.

If the optional field you selected requires validation, you must select a value that is defined for the 
optional field in Common Services. However, if the optional field allows blanks, you can leave the 
default value field blank.

If the optional field does not use validation, you can do one of the following:

 l Select a value that is defined for the optional field in Common Services.

 l Leave the field blank.

 l Enter a combination of alphanumeric or special characters and spaces. The entry must be 
consistent with the type of field (text, number, date, amount, and so on) and must not exceed the 
number of characters specified for the optional field. In a Yes/No field, you can enter only Yes or 
No.

When you specify a value that is defined in Common Services, the program displays the description for 
the value.

Optional Field and Description

Use the Finder to select the optional field codes you want to use for each type.

You can define an unlimited number of optional fields for each type, providing the optional fields are set 
up in Common Services for use in your system.

Note: If you want to retain optional field information from Accounts Receivable transactions when you 
create batches for General Ledger, you must use the same optional fields for transactions in 
Accounts Receivable as you use in General Ledger.

When you select an optional field code, the program displays the description for the optional field.

Optional Fields For

Specify the type of optional field you are defining. You can select:

 l Customers, National Accounts, and Customer Groups (or Customers and Customer Groups, if 
you do not use Sage 300 National Accounts)

 l Ship-to Locations

 l Invoices (invoice headers)

 l Invoice Details

 l Adjustments 
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 l Receipts

 l Revaluation

 l Refunds

Required

You select this option for an optional field if all the records or transactions to which you are adding the 
field must use the field.

If you make an optional field a required field, it must also be inserted automatically in new records or 
transactions. (You must use the Auto Insert option for the field.)

Value Set

Double-click the Value Set column to show whether or not the optional field has a default value.

This column has two purposes:

 l You must set the Value Set field to Yes if you want to set a default value for the optional field.

 l The Yes flag provides information to the transaction-entry clerk, letting them know if the field 
contains default information.

A/R Optional Field Settings Screen

To Open this Screen

 1. Open Accounts Receivable > A/R Setup > Optional Fields.

 2. Select an optional field that is for use with transactions, and then click Settings.

Overview

You can - and should - restrict the flow of information that is passed to General Ledger when you post 
transactions that use optional fields.

This screen lets you specify groups of accounts for which values for an optional field can be passed to 
General Ledger. (The optional fields used in a transaction must also match the transaction details 
optional fields used for an account in order to be passed to General Ledger.)

This screen lists the groups of accounts that are affected when you post transactions of the type for which 
you are defining the optional field. Select from the list all the account groups for which you want to pass 
values to General Ledger when you post transactions that include the optional field.
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Note: While all account groups are initially selected for new optional fields, you need to consider 
carefully the purpose of the optional field you are defining. You should send values to General Ledger 
only for optional fields that require financial analysis, and only to accounts where they are required. For 
example, you might want to send optional fields that contain customer numbers or sales territories only 
to revenue accounts.

You do not need to send optional field information for analysis that is performed only in Accounts 
Receivable. If you routinely send all the optional fields you use in Accounts Receivable transactions, your 
General Ledger may become hard to use, and you may also considerably slow down processing.

If you use Sage 300 Project and Job Costing, you can also specify whether optional field information for 
job-related transactions will be passed to Project and Job Costing, if the optional fields match those used 
for billings or costs in that program.

A/R Options Screen

To Open this Screen

Open Accounts Receivable > A/R Setup >        Options.

Related Tasks

 l "Selecting Accounts Receivable Processing Options" (page 13)

 l "Setting Up a Multicurrency Accounts Receivable System" (page 13)

 l "Setting Up Accounts Receivable" (page 3)

Overview

Note: Depending on how your system is set up, this desktop screen may also be available as a web 
screen. For more information, see the Web Screens Getting Started Guide or the help for Sage 300 
web screens.

You use the A/R Options screen to select or to change options that determine how your Accounts 
Receivable system processes transactions and stores information about your customers.

Note: You use the G/L Integration screen to select options that govern the interaction between 
Accounts Receivable and General Ledger, including when and how General Ledger transactions are 
processed.
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Company Tab

Use the Company tab to change the contact name, telephone number, and fax number for your Accounts 
Receivable department.

Note: You use the Company Profile screen in Common Services to change the company name and 
address and to change the contact name, telephone number, and fax number at the company level, 
and to specify a format for phone numbers.

Numbering Tab

Use the Numbering tab to set options for assigning numbers to transactions. More...

You can:

 l Choose the prefixes and next numbers to assign when you add invoices, debit notes, credit notes, 
interest invoices, recurring charges, receipts, prepayments, unapplied cash, and adjustment 
transactions, or you can allow Accounts Receivable to assign them automatically.      

These numbers include a prefix (up to 6 letters) followed by a sequence number. The prefix you assign 
must be unique and cannot be used for any other type of Accounts Receivable document. For more 
information, see "About Document Numbers for Invoices, Debit Notes, and Credit Notes" (page 11).

You can change these prefixes and next numbers at any time.

 l Restrict the length of the number to be assigned to invoices, debit notes, credit notes, interest 
invoices, recurring charges, receipts, prepayments, unapplied cash, and adjustment transactions. 
You can use a maximum length of 22 characters, including prefixes.

This tab also displays the numbers that will be assigned to the next invoice, receipt, adjustment, and 
revaluation posting sequences, and the next invoice, receipt, and adjustment batches.

Processing Tab

Use the Processing tab to set options for processing transactions. More...

You can:

 l Indicate whether your Accounts Receivable system uses multicurrency accounting.     

For more information, see "About Document Numbers for Invoices, Debit Notes, and Credit Notes" (page 

11).

 l Change settings that determine whether you want to invoice recurring charges, require batch 
listings (before posting), and edit imported batches.

 l Indicate how Accounts Receivable accumulates and processes customer statistics.
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 l Change settings that determine whether to keep statistics for items and salespersons and, if so, 
the type of year and period by which you accumulate the statistics.

 l Specify whether to include pending transactions from Accounts Receivable, Order Entry, and 
other programs when performing credit checks.

 l Use retainage accounting in Accounts Receivable.

Retainage Tab

Note: The Retainage tab appears only if the Retainage Accounting option is selected on the 
Processing tab.

Use the Retainage tab to specify default retainage settings that are used when you add new customer 
records.

Accounts Receivable uses the retainage settings from customer records as defaults when you enter 
invoices, credit notes, or debit notes.

You can change settings for particular customers and documents.

Statement Tab

Use the Statement tab to set options for customer statements. More...

You can:

 l Specify the number of days in each of the four aging periods used by Accounts Receivable to sort 
transactions and account balances for charging interest and reporting purposes.

 l Enter the message (dunning message) you want to print on customer statements with balances in 
each of the four aging categories.

 l Specify whether to print statements for customer accounts with balances of zero.

 l Select the method of assigning unapplied transactions to aging categories when reporting them on 
customer statements and reports. You can include unapplied credit notes and debit notes, and 
unapplied cash and prepayments in either the Current aging period or in the aging period with the 
oldest balance.

Transactions Tab

Use the Transactions tab to set options for processing invoices, receipts, and refunds. More...

You can:
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 l Select options for invoice entry and printing, specifying whether to:

 l Automatically insert comments from the item record on item detail lines.

 l Display item costs during detail entry.

 l Use Accounts Receivable to print invoices, credit notes, and debit notes.

 l Allow editing of documents after you have printed them.

 l Select a default invoice type and a default tax calculation method for invoices.

 l Select information to appear when you enter or print invoices.

 l Select options for receipt entry and printing of deposit slips, specifying whether to:

 l Use Sage 300 to print deposit slips.

 l Allow editing of receipt batches after deposit slips have been printed for them.

 l Prevent posting of receipt batches for which no deposit slips have been printed.

 l Allow entry of adjustment transactions in receipt batches.

 l Assign the default payment code, transaction type, bank code, and Payments Acceptance 
bank code for your company.

 l Specify the order in which to list documents when applying receipts and credit notes in the 
A/R Receipt Entry screen. (See "About Specifying Document Order in Receipt Entry" (page 
10).)

 l Select options for processing refunds. You can:

 l Specify whether to check for duplicate check numbers when you process check refunds for 
customers.

 l Specify the order in which to print refund checks.

Fields and Controls

Company Tab

Use the Company tab to specify contact information for a company for the Accounts Receivable 
administration.

Note: To change the company name and address, or to change the contact information at the 
company level, use the Company Profile screen in Common Services.

Contact Name

Enter the name of the contact.
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Telephone

Enter the phone number of the contact.

Fax Number

Enter the fax number of the contact.

Numbering Tab

Document Type

The Document Type column lists the types of documents to which you can assign the next document 
number.

Length

Accounts Receivable lets you set separate document number lengths for invoices, credit notes, debit 
notes, interest invoices, and recurring charge invoices, prepayments, unapplied cash, adjustment, and 
receipt transactions to be assigned automatically by Accounts Receivable.

Use this column to restrict the length of these document numbers to a maximum of 22 characters, 
including prefixes.

Next Number (for document numbers)

This column on the Numbering tab displays the number that Accounts Receivable will assign to the next 
invoice, credit note, debit note, interest invoice, recurring charge invoice, prepayment, receipt, 
unapplied cash, adjustment, and refund transaction.

You can enter the next number to assign to each document type.

If you assign document numbers automatically, Accounts Receivable assigns a unique number to each 
document you add to an invoice batch. The number is a combination of a prefix you enter to identify the 
transaction type, and a number that is assigned sequentially, starting with the number you specify.

You can change the next number at any time. However, you must be sure not to assign a number and 
prefix you have used before. You cannot post duplicate document numbers in Accounts Receivable.

527Sage 300 2023 Accounts Receivable User's Guide



Prefix (for document numbers)

If you plan to use Accounts Receivable to assign document numbers automatically and you want to 
continue with the document numbers in your previous receivables system, use the Prefix fields on the 
Numbering tab to enter the prefixes you use to assign document numbers to invoices, credit notes, and 
debit notes, invoices for interest and recurring charges, receipts, prepayments, unapplied cash 
transactions, adjustments, and refunds.

You can use up to six characters in each prefix and you must use a different prefix for each type of 
document. You can also use the default prefixes which appear automatically.

If you assign document numbers automatically, Accounts Receivable assigns a unique number to each 
invoice, credit note, debit note, interest charge and recurring charge you add to an invoice batch. The 
number is a combination of a prefix you enter to identify the transaction type, and a number that is 
assigned sequentially, starting with the number you specify (in the Next Number field).

You can change the prefixes at any time, but you must not assign a prefix that will duplicate document 
numbers assigned to other documents. (You cannot post two transactions with the same document 
number in Accounts Receivable.)

Processing Tab

Accumulate By

This option lets you choose whether to report period statistics by fiscal year or calendar year. The 
starting date for statistics depends on your choice:

 l Calendar year. The starting date is January 1st.

 l Fiscal year. The starting date is the first day of your fiscal year.

This option also lets you specify the period type to use in the Period Type field.

Use the Customers, National Accounts, Customer Groups, and Items screens, and the Salespersons 
screen to review statistics. You can also print reports of statistics.

Allow Edit Of External Batches

This option lets you revise information in batches that you generate for Accounts Receivable in other 
Sage 300 programs, such as Order Entry or Project and Job Costing.

Note: Do not use the option if you want to ensure that external batches are posted without changes.
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You can change your choice for this option at any time, using it to increase your auditing and 
supervisory control of external batches, and reducing the possibility of errors from accidental editing.

Allow Edit Of Imported Batches

This option lets you revise information in batches that are imported from other programs. 

Note: Do not use the option if you want to ensure that imported batches are posted without changes.

You can change your choice for this option at any time, using it to increase your auditing and 
supervisory control of imported batches, and reducing the possibility of errors from accidental editing.

Allow Edit Of Statistics

Accounts Receivable automatically accumulates statistics from the transactions you post to customer 
accounts, and displays them in the Customers, National Accounts, and Customer Groups screens. You 
can also choose to keep item and salesperson statistics.

This option lets you enter statistics during setup and revise the statistics that Accounts Receivable 
keeps when you post transactions.

You may want to turn on the option while you are setting up your Accounts Receivable system, 
particularly if you are creating the system partway through an accounting year. You can then enter more 
complete receivables records by adding the statistics from your previous system.

Once your system is operating, you can turn off the option because the program automatically updates 
the statistics when you post invoice, adjustment, and receipt transactions.

You may also decide to use the option to edit customer group and national account statistics when you 
change a customer’s group or national account, or to edit a particular statistic because unusual 
circumstances have exaggerated the amount (such as a single invoice that remained unpaid for a long 
period in an otherwise satisfactory account).

Default Number of Days To Keep Customer Comments

This option lets you specify a default number of days to retain comments in customer records.

The number of days you enter determines the default expiration date that appears in the Customers 
screen when you enter comments in a customer record, but you can change the date in the customer 
record.

When you use the Clear History screen to clear (delete) obsolete customer comments, the screen 
clears only comments that reached their expiration dates on or before the clearing date you specify in 
Clear History.
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Force Listing Of All Batches

Choose this option if you want to make sure that copies of all invoice, receipt, and adjustment batches 
are printed before posting. When you use the option, you cannot post batches until you print listings for 
them, and you must print new listings for batches you edit.

Even if you do not use this option, you can print batch listings. You can also print posting journals that 
provide complete information about the contents of all posted batches.

Include Pending A/R Transactions in Credit Check

Select this option if you want to include pending (unposted) Accounts Receivable transactions during 
credit checks to determine whether customer balances exceed their credit limits.

Include Pending O/E Transactions in Credit Check

Select this option if you want to include pending transactions from Order Entry (for example, orders that 
have not been shipped, or shipments that have not been invoiced) during credit checks to determine 
whether customer balances exceed their credit limits.

Include Other Pending Transactions in Credit Checks

Select this option if you want programs from other software manufacturers (third-party products) that 
you use with Sage 300 to include unposted transactions during credit checks.

Include Tax In Statistics

Use this option if you want to include tax amounts in the invoice totals that are kept for each customer, 
national account, or customer group, and for items and salespersons (if you select the options to 
accumulate statistics for items and salespersons). Some tax authorities such as VAT (value-added tax) 
require that you include taxes in statistics.

If you do not use the option, only before-tax totals are added to statistics.

You can change your selections for the options to include taxes in totals at any time, but the change 
takes effect only on new transactions. Accounts Receivable cannot adjust previously existing statistics 
to add or subtract tax amounts, and you cannot make meaningful comparisons of statistics created 
before and after the change.
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Keep Customer, National Account, and Customer Group Statistics

This option lets you keep statistics for customers, national accounts, and customer groups, including 
the total number of invoices, receipts, adjustments, credit notes, debit notes, discounts, interest 
charges, returned checks, and write-offs posted for each account.

You can change your choice for this option at any time. However, if you turn the option off, then turn it 
on again, statistics from transactions posted while the option was off will not be included in the totals in 
the account records.

Keep Item Statistics

This option lets you keep statistics from transactions posted for items, including the total amount and 
number of sales and returns, total cost of goods sold, gross margin, and quantity sold, and the date of 
the last sale of the item.

You can change your choice for this option at any time. However, if you turn the option off, then turn it 
on again, statistics from transactions posted while the option was off will not be included in the totals in 
the item records.

Keep Salesperson Statistics

This option lets you keep statistics for individual salespersons, including the total number of invoices, 
receipts, credit notes, debit notes, discounts, and write-offs posted to each salesperson number.

You can change your choice for this option at any time. However, if you turn the option off, then turn it 
on again, statistics from transactions posted while the option was off will not be included in the totals in 
the salesperson records.

Multicurrency Option

You can turn on the Multicurrency option for Accounts Receivable at any time. But, once you turn it on 
(and save your changes), you cannot turn it off.

The Multicurrency option does not appear on this tab unless it is selected for your company in the 
Company Profile screen in Common Services.

You can mix multicurrency and single currency applications. 

Example: You can post transactions from a multicurrency Accounts Receivable system to a single-
currency Sage 300 General Ledger.
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Period Type

This option lets you choose whether to report period statistics by fiscal year or calendar year. The 
starting date for statistics depends on your choice:

 l Calendar year. The starting date is January 1st.

 l Fiscal year. The starting date is the first day of your fiscal year.

You can also specify the period type to use:

 l Weekly

 l Seven Days

 l Bi-Weekly

 l Four Weeks

 l Monthly

 l Bi-Monthly

 l Quarterly

 l Semi-Annually

 l Fiscal Period

Important! You should not change the type of year and period by which you keep statistics partway 
through a year, because this will cause figures to be distorted in some periods and you will have to 
make corrections in all records for which you keep statistics. If you need to change the type of year 
and period by which you keep statistics, do so only at year end.

Use the Customers, National Accounts, Customer Groups, and Items screens, and the Salespersons 
screen to review statistics. You can also print reports of statistics.

Process Recurring Charges

Select this option if you want to be able to invoice customers automatically for standard amounts that 
are due on a regular basis, such as monthly rent.

Then, you use the Recurring Charges setup screen to define the recurring charges you use and assign 
them to your customers. 

You use the Create Recurring Charge Batch screen to create an invoice batch for each charge when it 
is due.

You can change your choice for this option at any time. 
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After you have defined recurring charges, the information is retained in Accounts Receivable, even if 
you turn off the Process Recurring Charges option, and is still available if you turn on the option again.

Retainage Accounting option

You set the option to use retainage accounting on the Processing tab of the A/R Options screen.

When you select the Retainage Accounting option, the Retainage tab becomes available to let you 
specify retainage processing options.

You can turn off the Retainage Accounting option, later, only if there are no unposted retainage batches 
and no outstanding retainage amounts.

Retainage Tab

Base Retainage Amount On

Select whether retainage will be calculated on the document total before tax or after tax is included.

Default Retainage Exchange Rate

If you use multicurrency, specify whether to use the current exchange rate or the exchange rate used 
for the original document as the default for retainage documents.

Default Retainage Percentage (optional)

Enter the percentage of the document total to withhold on invoices, credit notes, and debit notes.

This percentage appears as the default when you add new customers, but you can change the 
retainage (or holdback) percentage for particular customers in the customer record.

Default Retention Period (optional)

Enter the number of days from the original document date that the customer can withhold the retained 
amount. The program determines the default retainage due date by adding the retention period to the 
original document date.

The default retention period is used for new customer records, but you can specify different ones for 
individual customers. You can also change the retention period on invoices.

Last Invoiced (display only)

The Retainage tab displays the date that you ran Create Retainage Batch from the Reminder List.
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Number of Days in Advance to Create Retainage Documents

Enter the number of days before the retainage due date that you can generate retainage documents 
using the Create Retainage Batch screen.

Example: If you enter 5, you can generate the retainage invoice five days before the retainage is due.

Report Tax

To report tax, the program posts tax amounts to a tax liability account and updates the tax tracking 
reports. The timing of the tax liability on retainage documents depends on the tax authority.

Some tax authorities require that you report tax on retainage when you post a retainage document; 
others let you report tax when you post an original document to which retainage applies.

This option lets you specify when to report tax on retainage. You can make the following selections for 
this option:

 l At Time Of Original Document More...

If you select this option, the program calculates and reports tax on retainage when you post an original 
document that includes retainage.

You can then use the Base Retainage Amount On field to specify whether to base retainage on 
amounts before tax or after tax.

 l As Per Tax Authority More...

If you select this option, the program calculates tax when you post an original document, but reports 
the tax as required by each tax authority.

The tax reporting requirements for each tax authority are specified by the Report Tax On Retainage 
Document option, in Tax Services:

 l If the tax authority specifies At Time Of Original Document or No Reporting for tax on 
retainage, the tax amount is calculated and the tax tracking reports are updated 
immediately when you post original documents.              

Note: You can select No Reporting for a tax authority only if you also use At Time Of 
Original Document for the Report Tax option in Accounts Receivable.

 l If the tax authority specifies At Time Of Retainage Document, the tax amount is 
calculated when you post the original document, but it is not reported until you post the 
retainage document.

When you specify As Per Tax Authority, retainage amounts are based on amounts before tax for all 
tax authorities and customers.
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Schedule To Use For Automatic Creation Of Retainage Documents (optional)

Enter or use the Finder to select the code for the schedule you want to use to process retainage from 
the Reminder List.

If the schedule does not yet exist in Common Services, you can click the Zoom  button beside the 

field, then create the schedule using the Schedules screen that opens. You can also click the Zoom 
button after entering a schedule code to view information about the schedule.

Use Separate Document Numbering When Creating Retainage Documents (optional)

Select this option to use a separate numbering system to identify retainage documents that you 
generate using the Create Retainage Batch screen.

When you select the option, the retainage document numbering table becomes available, letting you 
specify the next number, length, and prefix to assign to retainage invoices, credit notes, and debit 
notes.

If you do not select the option, the program will assign the next invoice, credit note, or debit note number 
specified on the document numbering table on the Numbering tab.

Statement Tab

Age Credit Notes/Debit Notes As Current or By Date

Your selection for this option determines the aging category in which to place unapplied credit notes 
and debit notes when listing them on customer statements or in reports and inquiry screens.

You can include all unapplied credit notes and debit notes in the Current aging period, or you can place 
them in the aging period that corresponds to their document dates.

The option has no effect on credit notes and debit notes when they have been applied to specific 
document numbers. Applied amounts for these transactions are always included in the same aging 
periods as the documents to which they apply.

Your selection also affects the types of transactions you can select to write off using the Create Write-
Off Batch screen. If you age credit notes and debit notes in the current (not due) period, you cannot 
select them when you are writing off overdue transactions.

Age Receipts, Unapplied Cash, and Prepayments As Current or By Date

Specify how to assign receipts, unapplied cash (payments), and prepayments to aging periods:
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 l As Current. Receipts, unapplied cash, and prepayments are included in the current aging 
period. The notes will not be used in calculating interest charges.

 l By Date. Receipts, unapplied cash, and prepayments are included in the aging period that 
contains the document date.

Aging Periods

Use the Aging fields to set the default periods into which Accounts Receivable groups outstanding 
transactions or balances for the Overdue Receivables and Aged Trial Balance reports, customer 
statements, and the Customer Inquiry screen.

You can change the lengths of the periods for an individual report or statement run when you are about 
to print reports or review customer activity. You can also change the default periods at any time.

Dunning Messages

Type the default messages to print on customer statements or in dunning letters. 

On each statement, Accounts Receivable prints the message that is assigned to the aging period that 
contains the oldest outstanding balance in the customer’s account.

You can enter additional sets of messages (using the Dunning Messages screen), and select from 
those messages when using the Statements / Letters / Labels screen.

Print Zero-Balance Statements

Select this option to allow statement printing for customers with no balance outstanding (for example, to 
provide your customers with records of their current account statuses).

When you select this option, and then select the Select Customers Based On Balance Type option in 
the Statements/Letters/Labels screen, you can choose whether to include zero-balance accounts for an 
individual printing run.

Do not choose the option if you print statements only for customers who have a balance owing or a 
credit balance. This choice will filter out zero-balance accounts from the ranges of criteria you specify to 
print statements from the Statements/Letters/Labels screen.

Transactions Tab

Allow Adjustments In Receipt Batches

Select this option if you want to allow adjustments or the write-off of small amounts while entering 
receipt batches (rather than having to enter the adjustment transactions separately in the 
A/R Adjustment Entry screen).
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The adjustments become part of the receipt batches to which you added them. If you want to edit an 
adjustment you added to a receipt batch, you edit it in the A/R Receipt Entry screens, rather than in the 
A/R Adjustment Entry screen.

Example: You might use this option when the amount of a check you receive to pay an invoice differs 
slightly from the invoice total. You can quickly write off the difference when you enter the receipt.

You can change your choice for this option at any time.

Allow Edit After Deposit Slip Printed

Select this option if you want to be able to edit or delete receipt batches after printing deposit slips for 
them. If you do not use the option, you cannot save any changes or corrections to receipt batches after 
you have printed their deposit slips.

Tip: To select the Ready To Post option for a batch after printing its deposit slip, post the batch 
through the Receipt Batch List screen.

This option  lets you maintain supervisory control over existing deposit slips, turning on the option to 
allow authorized changes to the batches, then turning it off again to prevent changes that have not been 
approved.

Note: If you use Payment Processing to process credit card transactions and you do not select this 
option, you must process payment for credit card transactions before printing a deposit slip. (If you 
print a deposit slip before processing the payment, the Charge and Quick Charge buttons on the 
A/R Receipt Entry screen are not available and you cannot process the payment.)

You can change your choice for this option at any time.

Allow Edit After Invoice Printed

Select this option to allow changes or deletions in invoice batches after you have printed invoices, credit 
notes, and debit notes for them.

Do not select this option if you always want posted invoices to match printed invoices. You can still 
make changes to the documents that you have not printed and you can add new documents to the 
batch.

Your choice for this option does not apply to batch header information. You can change the batch date 
or description at any time until you post the batch.
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Allow Edit After Receipt Printed

Select this option if you want to be able to edit or delete receipt batches after printing receipt 
confirmations for them.

If you do not select the option, you cannot save any changes or corrections to receipt batches after you 
have printed confirmations for receipts contained in the batch.

Note: If you use Payment Processing to process credit card transactions and you do not select this 
option, you must process payment for credit card transactions before printing a receipt confirmation. 
(If you print a receipt confirmation before processing the payment, the Charge and Quick Charge 
buttons on the A/R Receipt Entry screen are not available and you cannot process the payment.)

You can change your choice for this option at any time.

Allow Printing Of Deposit Slips

Select this option if you normally print deposit slips when you enter receipt batches, and want to use 
Accounts Receivable to print the slips.

You can then use the deposit slips to verify batch contents to the receipts or documents from which you 
entered the receipts, and as source documents for filling out the deposit slips you take to the bank.

If you have deposit slip screens that are acceptable to your bank and that you can use in your printer, 
you may also be able to use Accounts Receivable to print on the deposit slips you take to the bank.

Choosing the option does not force you to print deposit slips. 

Tip: To ensure that you do print deposit slips before you post batches, select the Force Printing Of 
Deposit Slips option. When you choose this option, you cannot post receipt batches until you have 
printed their deposit slips.

You can change your choice for this option at any time.

Allow Printing Of Invoices

Use this option if you want to use Accounts Receivable to print invoices, credit notes, and debit notes 
using laser-printed or preprinted screens.

This option does not force you to print the documents. You choose whether to print them when you 
enter them in the Invoice Entry screen, or using the Invoice Printing screen. Using the Invoice Printing 
screen, you can print the documents even after you have posted the batches that contain them.

If you do not select the option, you cannot print invoices from Accounts Receivable.
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Calculate Taxes Automatically

Select this option to use automatic tax calculation as the default tax calculation method for invoices.

You can change the tax calculation method for individual invoices in Invoice Entry.

Calculate Tax Reporting Amounts Automatically

If you report taxes in a currency different from your customers' currencies or your functional currency, 
invoices must show the tax amount in the tax reporting currency, along with the exchange rate used for 
the conversion.

Select this option if you want to use automatic tax calculation as the default method for calculating tax 
reporting amounts on invoices. You can change the calculation method for particular invoices in Invoice 
Entry.

Check For Duplicate Checks

Select whether to display an error, a warning, or no message when you attempt to issue a refund check 
that uses the same number as an existing check for the same bank.

Create Deposit Slip When Receipt Batch is Created

Select this option if you want to create a new deposit slip whenever you add a new receipt batch.

Do not select the option if you plan to consolidate receipt batches on one deposit slip (for example, if 
several clerks enter receipt batches to which you will assign a single deposit slip each day).

Default Bank Code

Use this option to select the code for the bank account to which you most often deposit receipts. You 
then have to enter a bank code with receipts only when you are using a bank that is different from the 
default bank.

Use the Finder (press F5) to display the list of bank codes from which to choose. You must use one of 
the bank codes defined in the Bank Services screen in Common Services. You can change your choice 
for this option at any time.

You must select a default bank code in this field before you can create receipt batches in the 
A/R Receipt Entry screen.

Default Detail Tax Class to 1

Select this option if you want to use 1 as the default tax class for details on new summary invoices.
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If you do not select this option, Accounts Receivable uses the customer tax class (from the Invoice 
Entry Taxes tab) as the default for new summary details.

Regardless of your selection for this option, on item invoices, Accounts Receivable uses the tax class 
set for the item

Default Invoice Type

Select the type of invoice batch you most commonly use to appear as the default in Invoice Entry. You 
can choose Summary or Item.

Default Order Of Open Documents

Choose the order in which you want documents (transactions) to appear when you use Select mode to 
apply cash, checks, or other receipts or credit notes to customer accounts in the A/R Receipt Entry 
screen. (You can change the list order when you use the A/R Receipt Entry screen, if necessary.)

You can choose to list open documents by Document Number, Purchase Order Number, Due Date, 
Order Number, Document Date, Current Balance, or Original Doc. No. (If you use retainage accounting 
in Accounts Receivable, listing documents by their original document number will make it easier to 
apply retainage payments when you receive these amounts from customers.)

You can change your choice for this option at any time.

Default Payment Code

Select the payment method, such as cash or check, that you want to appear as the default payment 
type when you enter receipt or refund transactions.

Normally, you specify the type of receipt or payment you process most often, so that you have to enter 
the payment type only when it is different from the most common type.

When you are setting up your Accounts Receivable system, you can choose Cash, Check, or Credit 
Card as the default payment type. If you want to select a different default type, you must first use the 
Payment Codes screen to add the type.

You can change your choice for this option at any time.

Default Posting Date (Invoices)

Your selection for this option determines the date that appears as the default posting date on the 
A/R Invoice Entry screen.
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The posting date is the date that a document is posted to General Ledger, and it may be different from 
the document date. This distinction is particularly useful if you post a document to a different year or 
period from the document date. 

Example: Accounts Receivable uses posting dates, rather than document dates, to select open 
documents for revaluation, so that exchange adjustments are posted to the correct fiscal year and 
period.

You can select Document Date, Batch Date, or Session Date as the default posting date.

You can change the posting date for particular transactions when you enter or edit them.

Note: If you consolidate G/L transactions, the posting date for consolidated entries is the last date of 
the fiscal period.

Default Posting Date (Receipts)

Your selection for this option determines the date that appears as the default posting date on 
A/R receipt entry screens.

The posting date is the date that a document is posted to General Ledger, and it may be different from 
the document date. This distinction is particularly useful if you post a document to a different year or 
period from the document date. 

Example: Accounts Receivable uses posting dates, rather than document dates, to select open 
documents for revaluation, so that exchange adjustments are posted to the correct fiscal year and 
period.

You can select Document Date, Batch Date, or Session Date as the default posting date.

You can change the posting date for particular transactions when you enter or edit them.

Note: If you consolidate G/L transactions, the posting date for consolidated entries is the last date of 
the fiscal period.

Default Transaction Type

This is the type of transaction (receipt, prepayment, unapplied cash, apply document, or miscellaneous 
receipt) you want to appear as the default type in the A/R Receipt Entry screens when you are entering 
transactions. 

You normally choose the type of transaction you process most often, so that you have to enter the 
transaction type only when it is different from the usual type.
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Force Printing Of Deposit Slips

Choose this option to make sure that you print deposit slips for receipt batches before posting them.

This option applies only to receipt batches that include deposit slips and does not affect receipt batches 
that are used only to apply previously posted documents to other documents.

You can change your choice for this option at any time.

Include Pending Transactions

Your selection for this option determines whether transactions from open (unposted) batches are 
included when Accounts Receivable calculates pending amounts for Receipt Entry.

You can include unposted receipts, unposted receipts and adjustments, or all transactions, or you can 
choose to include none of them.

Payments Acceptance Bank Code

Specify the code for the bank account to which you post receipts for online payments received through 
Payments Acceptance. (This field works like the Default Bank Code field, but for online payments.)

We recommend that you use the Payments Acceptance Bank Account as a "clearing" account. After an 
online payment service provider has deposited funds in your bank account, transfer the related receipts 
(using Bank Transfers) to your real bank account, and then perform bank reconciliation. For a detailed 
example of the steps in this process, see Sage Knowledgebase article 106222.

You must specify a bank code in this field before you can download receipts for online payments. You 
can change this bank code at any time.

Show Item Cost (on invoices)

If you use a price list for invoice entry, you can use this option to display the extended item cost (number 
of units x cost per unit) when you are adding item details in the Invoice Entry screen. 

You cannot change costs in the Invoice Entry screen and you cannot print the costs on invoices.

Sort Checks By

This option lets you set the order in which to print batches of refund checks.

You can print refund checks by one of the following characteristics:
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 l Transaction Entry Number

 l Customer Number

 l Payee Name

 l Payee Country

 l Payee Zip/Postal Code

Use Item Comment As Default (on invoices)

Use this option to display any comments you have entered in item records automatically when you are 
entering item details on an invoice, credit note, or debit note.

If you do not use the option, no item comments are displayed during transaction entry, but you can type 
a comment of up to 250 characters for each detail line you add to a document. You can also choose to 
include the comments on the printed documents.

A/R Payment Codes Screen

To Open this Screen

Open Accounts Receivable > A/R Setup >        Payment Codes.

Related Tasks

 l "Selecting Accounts Receivable Processing Options" (page 13)

Overview

Note: Depending on how your system is set up, this desktop screen may also be available as a web 
screen. For more information, see the Web Screens Getting Started Guide or the help for Sage 300 
web screens.

You use the Payment Codes screen to:

 l Group receipts and refunds in Accounts Receivable by type: Cash, Check, Credit Card, and Other.

 l If you use Payment Processing, group receipts and refunds in Accounts Receivable by the SPS 
Credit Card payment type.

 l Group amounts by the type of receipt on deposit slips.
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Payment codes are used to identify the types of payments you process, such as cash, checks, credit 
cards. For example, your company may use different codes for payments made by credit card—one to 
identify each of three credit cards you accept.

Payment Codes for Credit Card Transactions

If you use Payment Processing, the SPS Credit Card payment type lets you define payment codes you 
will use for Paya credit card transactions. To process a credit card payment for a transaction in Paya, you 
must select a payment code with the SPS Credit Card payment type for the transaction. 

For example, you might create a VISA payment code with the payment type SPS Credit Card, to be used 
when you process Visa card transactions in Paya.

If you do not use Payment Processing, or if there are credit card transactions for which you do not 
process payment in Sage 300, you can also create payment codes that use the Credit Card payment 
type.

"Other" Payment Type

The Other payment type lets you define payment codes other than for cash, check, or credit card. For 
example, you might create an EFT code for electronic fund transfers.

Fields and Controls

Description

Enter a description for the payment code (for example, the name of the credit card).

Inactive

Select this option if you do not want to use the payment code.

This option is used primarily when you have decided to delete a payment code and want to make sure it 
is not assigned to any additional transactions.

Note: Before you can make a payment code inactive, you must assign another payment code to any 
unposted receipt transactions that use the inactive payment code.

Last Maintained

This field displays the date of the last change made to the payment code.
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Payment Code

Enter a code to identify the customer payment type, using up to 12 characters.

Payment Type

Specify the method of payment for this type of receipt:

 l Cash.

 l Check.

 l Credit Card.

 l SPS Credit Card.

Note: This payment type is available only if you use Payment Processing. You must select this 
payment type for each payment code you will use when processing Paya credit card transactions.

 l Other.

A/R Salespersons Screen

To Open this Screen

Open Accounts Receivable > A/R Setup >        Salespersons.

Related Tasks

 l "Adding or Modifying Salesperson Records" (page 50)

 l "Adding Salesperson Commission Rates" (page 54)

Overview

Note: Depending on how your system is set up, this desktop screen may also be available as a web 
screen. For more information, see the Web Screens Getting Started Guide or the help for Sage 300 
web screens.

You use the A/R Salespersons screen to:

 l Identify salespersons by name or employee number on transactions and reports, and keep 
statistics.

 l Specify an annual sales target (quota) for each salesperson.
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 l Specify whether the salesperson earns commissions.

 l Specify up to five rates that Sage 300 Order Entry can use to calculate sales commissions. (For 
more information on how commissions are calculated and the options you use to track 
commissions, see the Sage 300 Order Entry help.)

 l Keep track of the total amount and number of invoices, receipts, credit notes, debit notes, 
discounts, and write-offs for the salesperson (if you use the option to keep salesperson statistics).

 l Review sales statistics for the salesperson in the current year and period, the year to date, or 
previous years and periods (if you use the option to keep salesperson statistics).

The salesperson number identifies the salesperson on transactions and reports. You can also enter an 
employee number and annual sales target or quota for each salesperson.

Commission Tab

If you use Order Entry, use the Commission tab to add or edit commission rates for salespersons. More...

If you track commissions in Order Entry, that program calculates commissions for invoices when you run 
Day End Processing, and accumulates them for the Salesperson Commissions report.

For information on how Order Entry calculates sales commissions, see the Order Entry help.

Note: Order Entry uses the salespersons' rates specified on the Commission tab only if the 
commission rates for the Inventory Control categories are zero.

You can change rates for salespersons' commissions at any time. However, the new rates and rate 
ranges will have no effect on amounts that have already been accumulated since the commissions were 
last cleared.

Statistics Tab

If you use the Keep Salesperson Statistics option (on the A/R Options screen), Accounts Receivable 
automatically updates the total amounts and numbers of invoices, receipts, credit notes, debit notes, 
discounts, and write-offs in salesperson records when you post transactions.

If you also use the option to edit salesperson statistics, you can enter statistics for the year to date and for 
prior years for each salesperson during setup, and edit or review the statistics, as needed, on the 
Statistics tab.

Fields and Controls

Annual Sales Target
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Enter the amount of the sales target or quota for the salesperson in the current year. You can also leave 
this field blank or enter a figure that you use for other purposes.

Employee Number

Enter the employee number assigned to the salesperson in your payroll records. This is an optional field 
and you can leave it blank or enter other information in it.

Inactive

Select this option when you do not want to assign the salesperson number to any customer records or 
allocate document totals to it in the Invoice Entry screen.

If you make a salesperson record inactive, you must edit any customer records, ship-to locations, and 
transactions that use the inactive number. You cannot save changes to customer records or ship-to 
locations, or post batches that contain inactive salesperson numbers.

Last Maintained

This is an information field in which the program displays the date of the last change made to the 
salesperson record. You do not make an entry in this field.

Name

Enter the salesperson’s name in the order you want it to appear on Accounts Receivable screens and 
reports (usually first name followed by last name).

Salesperson Number

Enter a number (code) to identify the salesperson, using up to six characters.

Commission Tab

Paid Commissions

If the salesperson is paid commissions, select this option.

Fields appear for you to enter rates and sales amount ranges. (These rates are not used for item 
categories that have a commission rate.)
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Number of Commission Rates

Select a number from 1 to 5, depending on the number of commission rates that apply to the 
salesperson. The fields you do not need are cleared from the screen.

For each rate, type the total sales amount up to which the rate applies. The program inserts the upper 
amount from each rate as the lower amount for the next rate.

These rates are used on sales of Inventory Control items in categories that use zero commission rates.

On Sales Of

Type the total sales amount up to which the corresponding commission rate applies.

Rate

Type the salesperson's commission rate for the range of sales amounts.

Order Entry applies this rate to the sales amount or margin, depending on how you track commissions 
in Order Entry.

Statistics Tab

Amount

If adding historical data, enter the total amount of the transactions that were processed by or for the 
salesperson during the displayed period.

Do not include the amounts and numbers of invoices and other types of transactions you will post for 
the salesperson when you enter historical and year-to-date Accounts Receivable transactions. If you 
do, transactions totals will be included twice.

Count

If adding historical data, enter the total number of invoices, receipts, credit notes, debit notes, 
discounts, and write-offs that were processed by or for the salesperson during the displayed period.

Do not include the amounts and numbers of invoices and other types of transactions you will post for 
the salesperson when you enter historical and year-to-date Accounts Receivable transactions. If you 
do, transactions totals will be included twice.
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Period

Type or select the fiscal period for which you are entering statistics (or for which you want to view 
statistics).

Year

Type or select the fiscal year for which you are entering statistics (or for which you want to view 
statistics).

A/R Terms Screen

To Open this Screen

Open Accounts Receivable > A/R Setup >        Terms.

Related Tasks

 l "Adding or Modifying Terms Codes" (page 56)

Overview

Note: Depending on how your system is set up, this desktop screen may also be available as a web 
screen. For more information, see the Web Screens Getting Started Guide or the help for Sage 300 
web screens.

You use the A/R Terms screen to define the payment terms, discount periods, and discount percentages 
you allow your customers.

You must define at least one set of terms before you can add customer records or transactions.

Fields and Controls

Calculate Base for Discount With Tax

Specify whether or not to include tax amounts in the invoice total when calculating the discount amount 
for invoices, as follows:
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 l Included. Select this option if you allow a discount on taxes.

 l Excluded. Select this option if you do not allow a discount on taxes or you do not charge taxes to 
your customers.

You can change the discount amount on individual invoices, as required.

Description

Enter a description (name) for the terms code.

Discount Date Table

Select this option if you use standard discount periods for invoices entered within specified ranges of 
days. (For more information, see the help for the Range field.)

Standard due dates are similar to "day of the month due," except they do not restrict you to a single due 
date. For example, you can use standard discount dates to assign invoices to the 15th or 30th of each 
month.

You define standard due dates with a table that lets you specify a discount date for each of up to four 
ranges of days on which invoices were issued. You can also specify discount dates that are one or more 
months later than invoice dates.

Discount Percent

Enter the amount of the discount, expressed as a percentage of the total due.

Discount Type

Select the method you use to calculate the discount dates for transactions:

 l Days from invoice date. Select this option if discount dates are calculated as a particular number 
of days from the document date.

 l End of next month. Select this option if the discount date is the last day of the next month, 
regardless of the document date or the number of days in the month.

 l Day of next month. Type the number of the day of the next month that is the discount date.

 l Days from day of next month. Type the number of days from a specific day of the next month.         

Example: If the discount date is 10 days after the first of the month, enter 10 in the Number Of Days 
field, and 1 in the Day Of Month field.

 l Due date table. Select this option if you use standard discount dates for invoices entered within 
specified ranges of days.
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Due Date Table

Select this option if you use standard due date periods for invoices entered within specified ranges of 
days. (For more information, see the help for the Range field.)

Standard due dates are similar to "day of the month due," except they do not restrict you to a single due 
date. 

Example: You can use standard due dates to assign invoices to the 15th or 30th of each month. 
Standard dates are designed for businesses that enter invoices throughout the month, but print and 
mail invoices only on specific days of the month.

You define standard due dates with a table that lets you specify a due date for each of up to four ranges 
of days on which invoices were issued. You can also specify due dates that are one or more months 
later.

Due Date Type

Select the method you use to calculate the due dates for transactions:

 l Days from invoice date. Select this option if invoices are due by a particular number of days from 
the document date.

 l End of next month. Select this option if invoices are due on the last day of the next month, 
regardless of the document date or the number of days in the month.

 l Day of next month. Type the number of the day of the next month that is the due date. 

Example: If invoices are due on the fifteenth of each month, you type 15.

 l Days from day of next month. Type the number of days from a specific day of the next month.         

Example: If the due date is 30 days after the first of the month, type 30 in the Number Of Days field, 
and type 1 in the Day Of Month field.

 l Due date table. Select this option if you use standard due dates for invoices entered within 
specified ranges of days.

Inactive

Select this option if you do not want to assign the terms code to any customers.

You primarily use the option when you decide to delete a terms code, and want to ensure it is not 
assigned to any additional customer accounts. You can change your entry any time.
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You cannot assign inactive terms codes to customer records. Also, you cannot save changes to 
customer records and national accounts that use the inactive code, unless you first assign an active 
terms code to the records.

Last Maintained

This information field displays the date of the last change made to the terms code. You do not make an 
entry in this field.

Multiple Payment Schedule

Select this option to define a terms code that allows installment payments. 
When you select this option, the terms table expands to accommodate additional payments (otherwise, 
only a single line is displayed).

Number of Days / Day of Month (discount)

This column appears in the payment schedule to the right of the Discount Percent column by default. Its 
name depends on your selection for the Discount Type field:

 l Number of Days. This column indicates that the discount period expires the specified number of 
days from the invoice date or number of days from Day of Next Month.

 l Day of Month Due. This column displays the day of the next month on which the discount 
expires.

Number of Days / Day of Month (due)

This column appears in the payment schedule to the left of the Discount Percent column by default. Its 
name depends on your selection for the Due Date Type field:

 l Number of Days. This column indicates that the due date is the specified number of days from 
the invoice date or number of days from Day of Next Month.

 l Day of Month Due. This column displays the day of the next month that payment is due.

Payment Number

If you selected Multiple Payment Schedule, enter as many periods as you want. 

Press the Insert key to add payment numbers. Accounts Receivable automatically numbers payments, 
starting with 1.

Note: Make sure the numbers entered in the other columns are greater than zero. 
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Percent Due

Enter the percentage of the balance that is due for each payment number. 

The total of amounts entered in this column must always equal 100.

Range

For each standard due date or discount date, you must define a range of days, using the following fields:

 l Starting Day. First day in range.

 l Ending Day. Last day in range.

 l Add Months. Specify a due date or discount period that is one or more months later than the 
invoice date.

 l Day of Month. Specify the day of the month that is the due date or the end of the discount period.

Terms Code

Enter a code to identify the terms, using up to six characters.

Setup Reports Screens
Use the screens in the A/R Setup Reports folder to print reports of Accounts Receivable options and 
setup records.

A/R Account Sets Report

To Open this Screen

Open Accounts Receivable > A/R Setup Reports > Account Sets.

Related Tasks

 l "Printing the A/R Account Sets Report" (page 310)

Overview

The Account Sets report lists the descriptions and   numbers of the general ledger accounts used in the 
account sets in your   Accounts Receivable system.
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When to Print

Print this report when you add, change, or delete control account sets.

Information Printed on This Report

For each account set, the report lists:

 l The account numbers for your general ledger receivables control, receipt discounts, prepayment 
liability, and write-offs accounts. 

If you use retainage accounting in your Accounts Receivable ledger, the report also lists the retainage 
account used by each account set.

 l The range of account sets printed.

If you use multicurrency accounting, the report also lists:

 l The currency code for the currency used by the customers assigned to this account set.

 l The unrealized and realized exchange gain and loss general ledger accounts (if the account set is 
in a currency other than the functional currency).

 l The exchange rounding account that is updated with differences that arise when converting 
amounts to the functional currency from source currencies and tax reporting currencies.

A/R Billing Cycles Report

To Open this Screen

Open Accounts Receivable > A/R Setup Reports > Billing Cycles.

Related Tasks

 l "Printing the A/R Billing Cycles Report" (page 311)

Overview

The Billing Cycles report lists the billing cycle records used in your Accounts Receivable system to 
specify the time intervals at which you charge interest, print statements, and write off transactions for the 
customers in each cycle. If you charge interest by billing cycle, the frequency is also used in calculating 
interest.

When to Print

Print the report whenever you add, modify, or delete billing cycle codes.
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Information Printed on This Report

The Billing Cycles report includes the following information:

 l The range of billing cycles selected.

 l The frequency of the billing cycle (in days).

 l The most recent dates on which you printed statements and posted invoices for interest, if you 
used billing cycles as one of the criteria for selecting customer records when you created interest 
invoices or printed statements.

 l The address to which customers assigned to the billing cycle send their payments. You can print 
the remittance address on statements and invoices.

A/R Comment Types Report

To Open this Screen

Open Accounts Receivable > A/R Setup Reports > Comment Types.

Related Tasks

 l "Printing the A/R Comment Types Report" (page 312)

Overview

The Comment Types report lists the comment types that are set up for use with Accounts Receivable 
customer records.

When to Print

Print the report when you add, change, or delete comment type records.

Information Printed on This Report

The Comment Types report lists the following information for each comment type:

 l The comment type code.

 l The description entered for the code.

 l The date that the comment type record was last changed.

 l The date that the comment type record was set Inactive.
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A/R Distribution Codes Report

To Open this Screen

Open Accounts Receivable > A/R Setup Reports > Distribution Codes.

Related Tasks

 l "Printing the A/R Distribution Codes Report" (page 313)

Overview

The Distribution Codes report lists the descriptions and numbers of the general ledger accounts used in 
the distribution codes in your Accounts Receivable system.

When to Print

Print the report when you add, change, or delete distribution codes.

Information Printed on This Report

The Distribution Codes report lists the following information for each distribution code in the selected 
range:

 l The revenue account, to which detail amounts are credited (or debited) when an invoice, credit 
note, debit note, or other adjustment is posted.

 l If used, the inventory account, to which item costs are credited when sold and debited if returned, 
reflecting the fact that the item has been moved out of or back into inventory.

 l If used, the cost of goods sold account, to which item costs are debited when sold and credited if 
returned, offsetting the corresponding credit or debit to the inventory account.

A/R Dunning Messages Report

To Open this Screen

Open Accounts Receivable > A/R Setup Reports > Dunning Messages.
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Related Tasks

 l "Printing the A/R Dunning Messages Report" (page 314)

Overview

The Dunning Messages report lists the sets of messages or comments you print on customer statements, 
usually regarding the status of the account. You can assign a different message for each of the five 
periods into which Accounts Receivable ages (groups) transactions by date on statements and on the 
Customer Transactions, Aged Trial Balance, and Overdue Receivables   reports.

When to Print

Print the report when you add, change, or delete dunning messages.

Information Printed on This Report

The Dunning Messages report lists the following information:

 l The default set of messages entered on the A/R Options screen.

 l The sets of dunning messages entered on the A/R Dunning Messages screen.

 l The five aging periods into which Accounts Receivable ages (groups) transactions by date on 
statements and reports. 

You assign the periods on the Statement tab on the A/R Options screen, and use the assigned periods 
for all sets of dunning messages, as well as for statements and the Customer Transactions report.

A/R E-mail Messages Report

To Open this Screen

Open Accounts Receivable > A/R Setup Reports > E-mail Messages.

Related Tasks

 l "Printing the A/R E-mail Messages Report" (page 315)

Overview

The E-mail Messages report lists the messages you send to customers with e-mailed statements and 
invoices.
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When to Print

Print the report when you add, change, or delete e-mail messages.

Information Printed on This Report

The E-mail Messages report lists the following information for each message in the printed range:

 l The messages you created using the E-mail Messages screen are listed by message type 
(statement and invoice).

 l Each message is printed along with its message ID, description, and subject line.

A/R G/L Integration Report

To Open this Screen

Open Accounts Receivable > A/R Setup Reports > G/L Integration.

Related Tasks

 l "Printing the A/R G/L Integration Report" (page 316)

Overview

The G/L Integration report lists the options and other information entered on the G/L Integration screen 
that determine how your Accounts Receivable system interacts with General Ledger.

When to Print

Print this report whenever you change G/L Integration options for Accounts Receivable.

Information Printed on This Report

The G/L Integration report lists the following information:

 l The options selected on the G/L Integration screen.

 l The posting sequences through which you have created general ledger transactions.

 l The segments and separators to be used for the reference, description, and comment fields for 
each type of transaction created for general ledger (specified on the Transactions tab of the G/L 
Integration screen).
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A/R Interest Profiles Report

To Open this Screen

Open Accounts Receivable > A/R Setup Reports > Interest Profiles.

Related Tasks

 l "Printing the A/R Interest Profiles Report" (page 317)

Overview

The Interest Profiles report lists the information entered to define the interest profiles used in your 
Accounts Receivable system. 

You assign an interest profile to each customer record to specify the method, timing, and rates used to 
charge interest on the customer's overdue documents or balance.

When to Print

Print the report when you add, change, or delete interest profiles.

Information Printed on This Report

The Interest Profiles report includes the following information:

 l The general ledger interest income account that is credited when you post revenue from interest 
charged to customers assigned to the interest profile.

 l A Charge Interest On column that indicates whether the profile charges interest on overdue 
documents  (invoices and debit notes) or on overdue account balances.

 l A Charge Interest On Accounts column that lists the number of days a document or account 
balance must be overdue to be charged interest.

 l A Compound Interest column that indicates whether interest charges are compounded (that is, 
whether interest is charged on previous interest charges that are unpaid and overdue).

 l If the interest profile specifies a minimum interest charge (shown in the Minimum Interest column) 
and rounds lesser charges up to the minimum amount, "Yes" appears in the Round Up To 
Minimum column. Otherwise, no interest is charged if the calculated amount is less than the 
specified minimum.

If you use multicurrency accounting, you can assign a different minimum interest charge and annual 
interest rate for each currency used by the customers assigned to the profile. The report lists the 
minimum charge and annual rate for each currency code.
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A/R Items Report

To Open this Screen

Open Accounts Receivable > A/R Setup Reports > Items.

Related Tasks

 l "Printing the A/R Items Report" (page 318)

Overview

The A/R Items report lists information about the inventory items (goods or services) used in your 
Accounts Receivable system.

When to Print

Print the report when you add, change, or delete items.

Information Printed on This Report

The information on the Items report varies according to your printing selections:

 l The item description, commodity and distribution codes, unit(s) of measure and selling price(s) 
appear regardless of which options you select.

 l If you select Include Item Cost, the cost for each item appears.

 l If you select Include Tax Information, the report lists the tax authorities that apply to the item, its 
tax status, and whether tax is included in the item selling price.

 l The Alternate Tax Base column shows the amount on which to calculate tax for the item and unit of 
measure if the tax authority charges tax on a basis other than price or cost.

 l Each unit of measure by which you sell the item (for example, you may sell cable by the foot or by 
the spool), and the selling price for each unit of measure.

 l If you use multicurrency accounting, the units of measure and selling prices for each currency.

 l If you select Include Item Comments, the report includes any comments entered in item records.
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A/R Optional Fields Report

To Open this Screen

Open Accounts Receivable > A/R Setup Reports > Optional Fields.

Related Tasks

 l "Printing the A/R Optional Fields Report" (page 319)

Overview

The Optional Fields report lists the optional fields defined for your Accounts Receivable system.

When to Print

Print this report when you add, delete, or modify optional field setup records.

Information Printed on This Report

The Optional Fields report includes the following information, depending on the options you select at print 
time:

 l The optional field code and description.

 l The default value for the optional field in Accounts Receivable.

 l Whether the optional field is marked for automatic insertion in the records or transactions for which 
it was defined.

 l Optional field settings, if you choose to include them. (The settings specify the types of accounts to 
which optional fields will be passed and whether optional fields will be passed to Project and Job 
Costing.)

 l The number of optional field records set up for each type of optional field.

A/R Options Report

To Open this Screen

Open Accounts Receivable > A/R Setup Reports > Options.
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Related Tasks

 l "Printing the A/R Options Report" (page 320)

Overview

The Options report lists the options selected and other information entered on the A/R Options screen to 
specify how your Accounts Receivable system operates.

When to Print

Print the report when you change Accounts Receivable options.

Information Printed on This Report

The Options report lists the following information:

 l Your selections for each option on the A/R Options screen.

 l The default set of dunning messages.

 l The prefixes and next numbers to assign to invoices, credit notes, debit notes, interest invoices, 
recurring charge invoices, prepayments, refund, and unapplied cash transactions.

 l The numbers that will be assigned to the next invoice, receipt, refund, and adjustment batch you 
create and the next posting sequence for each batch type.

A/R Payment Codes Report

To Open this Screen

Open Accounts Receivable > A/R Setup Reports > Payment Codes.

Related Tasks

 l "Printing the A/R Payment Codes Report" (page 321)

Overview

The Payment Codes report lists the codes, descriptions, and methods of payment used in your Accounts 
Receivable system.

When to Print

Print this report when you add, change, or delete payment codes.
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Information Printed on This Report

The Payment Codes report lists the following information for each payment code:

 l The payment method (such as Cash, Check, or the name of a credit card).

 l The description.

 l The payment type  that appears in the Payment Code fields in Accounts Receivable (Cash, Check, 
Credit Card, SPS Credit Card, or Other).

 l The date the payment code record was last edited.

 l For inactive payment codes, the date on which Inactive status was selected.

A/R Salespersons Report

To Open this Screen

Open Accounts Receivable > A/R Setup Reports > Salespersons.

Related Tasks

 l "Printing the A/R Salespersons Reports" (page 321)

Overview

You can print two reports using the Salespersons report screen:

 l The Salespersons Profile report lists the salesperson numbers, salesperson names, employee 
numbers, and annual sales targets entered in the salesperson records in your Accounts 
Receivable system. 

 l The Salesperson Statistics report lists the total amount of invoices, receipts, discounts, debit and 
credit notes, write-offs and adjustments, interest charges, and returned checks you have recorded 
for selected salespersons. 

Note: You can print the Salesperson Statistics report only if Accounts Receivable uses the option to 
keep salesperson statistics.

When to Print

Print the Salespersons Profile report when you add, change, or delete salesperson records.

Print the Salespersons Statistics report when you need a summary of salespersons statistics (for 
example, at the end of each period).
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Information Printed on This Report

The Salespersons Profile report lists the following information:

 l The range of salesperson codes you selected.

 l For each salesperson, the salesperson number, name, employee number, and annual sales 
target.

The Salesperson Statistics report includes:

 l Total amounts of invoices, receipts, credit notes, debit notes, discounts, and write-offs posted for 
each salesperson number in the selected years and periods. 

Periods in which no transactions were posted for a salesperson are omitted from the report.

 l Numbers of invoices, credit notes, and debit notes posted for each salesperson number in the 
selected years and periods.

A/R Terms Codes Report

To Open this Screen

Open Accounts Receivable > A/R Setup Reports > Terms.

Related Tasks

 l "Printing the A/R Terms Codes Report" (page 323)

Overview

The Terms Codes report lists the information entered for each terms code to specify how to calculate due 
dates, discount amounts, and discount periods on invoices that use the code.

When to Print

Print the report when you add, change, or delete terms codes.

Information Printed on This Report

The Terms Codes report lists the following information:

 l The range of terms codes you chose to print on the report.

 l The terms code and description, and date the terms record was last edited.
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 l The method used to determine the due dates for invoices assigned to the terms code. You can 
calculate due dates using a number of days from the invoice date, the end of the next month, a day 
of the next month, a number of days from a day of the next month, or using a due date table.

 l Discount information including the method used to determine the discount period, whether to 
include tax in the base for discount calculations, and the discount percentage.

 l If the terms code uses a table to calculate due dates or discount dates, the report lists the 
information entered to set up the table.

 l The details of multiple payment schedules, if used and if you selected the Include Multiple 
Payment Schedules option for the report.

A/R Transactions Screens
Use Accounts Receivable transaction entry screens to record, edit, post, and inquire on the following 
types of transactions:

 l Invoices, debit notes, credit notes

 l Receipts

 l Refunds

 l Adjustments

A/R Adjustment Batch List Screen

To Open this Screen

Open Accounts Receivable > A/R Transactions > Adjustment Batch List.

Related Tasks

 l "Printing Batch Listings" (page 330)

 l "Printing Accounts Receivable Posting Journals" (page 347)

 l "Printing the A/R Posting Errors Report" (page 345)

 l "Printing the A/R Batch Status Report" (page 333)

 l "Posting a Range of Batches" (page 234)

Overview

This screen lets you:
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 l View a list of adjustment batches, beginning with the batch number you specify and including 
batches created on the Create Write-Off Batch screen. More...

The list includes the following information about each batch:

 l Batch number.

 l Batch date.

 l Batch description.

 l Number of entries.

 l Total amount.

 l Whether a batch has been printed.    

Notes: 
 l Open batches for which listings have been printed are marked Yes.

 l If you edit a printed batch, its status reverts to Open until you reprint the batch 
listing.

 l Posting sequence number.

 l Number of errors.

 l Date the batch was last edited.

 l Type (indicates how the batch was created).

 l Status. More...

A batch can have one of the following statuses:

 l Open. You can edit the batch.

 l Ready To Post. The batch can be posted. You cannot edit the batch unless you first 
change its status.

 l Post In Progress. Posting has started for the batch. You cannot edit or print it.

 l Deleted. The batch was removed from Accounts Receivable before posting. You 
cannot view the batch or reuse the batch number.

 l Posted. Transactions in the batch have been added to customer accounts. You 
cannot edit the batch, but you can print a listing for it.

 l Create a new adjustment batch.

 l Select an existing batch to edit or delete.

 l Mark a batch Ready To Post.

 l Post individual adjustment batches.

 l Post all unposted batches that are set Ready To Post.
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Fields and Controls

Buttons

Close

Click this button to close the screen.

Tip: 
You can also close the screen in the following ways:

 l Click the top left corner of the screen.

 l Click File > Close.

Delete

Click this button to delete a batch. 

All transactions in the batch are deleted and the batch is   listed as deleted on the A/R Batch Status 
report. You cannot reuse the batch   number. 

Tip: To delete a posted batch, or to clear   the data for a deleted batch, use the Clear Deleted And 
Posted   Batches option on the A/R Clear History screen.

New

Click this button to open the A/R Adjustment Entry screen, which you can use to create a new 
adjustment batch. For more information, see "Adding, Editing, or Deleting an Adjustment Batch" (page 
140).

Open

Click this button to open the selected batch in the main entry screen.

Post

Click this button to post the selected batch. For more information, see "Posting an Adjustment Batch" 
(page 235).
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Post All

Click this button to post all unposted adjustment batches that are set Ready To Post. For more 
information, see "Posting a Range of Batches" (page 234).

Print

Click this button to print a batch listing. For more information, see "Printing Batch Listings" (page 330).

Refresh

Click this button to update the information in the batch list. For example, if you have chosen not to show 
posted/deleted batches and another user has posted or deleted a batch, the batch will disappear from 
the list when you click Refresh.

Batch Number

If you want the list to begin with a specific batch, specify the batch number in this field.

Ready To Post

Indicates whether a batch is ready to post. To change the setting for a batch, double-click this field.

This field has three main purposes:

 l It prevents you from accidentally posting batches before they are ready.

 l It lets you post a range of batches, even if batches that are not ready to post are in the range.

 l It prevents you from making changes to batches that are set to Ready To Post.

Notes: 
 l Before you can post a batch, the batch must be set to Ready To Post.

 l If you are posting a single batch, you can select Ready To Post during posting.

 l You cannot delete a batch for which the Ready To Post option is selected.

Show Posted and Deleted Batches

To list only batches with a status of Open or Ready To Post, clear this option.
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A/R Adjustment Entry Screen

To Open this Screen

Open Accounts Receivable > A/R Transactions > Adjustment Entry.

Related Tasks

 l "Adjusting a Posted Transaction" (page 142)

 l "Adding, Editing, or Deleting an Adjustment Batch" (page 140)

 l "Deleting an Adjustment" (page 143)

 l "Posting an Adjustment Batch" (page 235)

 l "About Returning Customer Checks" (page 197)

Overview

You use the A/R Adjustment Entry screen to:

 l Enter adjustments to open and fully paid documents in customer accounts. 

Note: You can use Adjustment Entry to adjust fully paid documents only if you have not yet cleared 
the documents from Accounts Receivable.

 l Adjust posted receipts to write off small overpayments.

 l Enter adjustments to posted job-related invoices, credit notes, and debit notes that will update the 
projects in Sage 300 Project and Job Costing.

 l Edit batches of adjustments that were created by the Create Write-Off Batch screen, created 
during posting (when adjustment batches contain errors), and imported from other accounting 
programs.

 l Post adjustment batches.

Tip: You can also use the A/R Receipt Entry screen to enter adjustments to documents to which you 
are applying receipts or credit notes, if the Allow Adjustments In Receipt Batches option is selected 
on the A/R Options screen).

Document Tab

Use the Document to:
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 l Specify the customer number.

 l Specify the document number and the payment number for the document you want to adjust.

 l Open a Finder to select a detail for adjustment. (Click the Select Detail button.)

 l Use the detail table to add details that did not exist on the original document, or to enter debit or 
credit amounts to modify existing details.

Optional Fields Tab

Note: The Optional Fields tab appears on the A/R Adjustment Entry screen only if you use Sage 300 
Transaction Analysis and Optional Field Creator. 

Use the Optional Fields tab to review and edit optional fields used for an adjustment. More...

If any adjustment optional fields were set up for automatic insertion, they appear on the tab, along with 
their default values, when you add a new adjustment entry.

You can add any other optional fields that are defined for adjustments, and you can delete any that are 
assigned automatically, except Required fields.

Default values for the optional fields appear, as follows:

 l If an optional field assigned to the current adjustment was also used on the document you are 
adjusting, the program displays the values from the original document.

 l If an optional field assigned to the current adjustment was not used on the original document, but it 
is assigned to the customer record, Accounts Receivable displays the default value from the 
customer record.

 l If an optional field assigned to the current adjustment was neither used on the original document 
nor assigned to the customer, the program uses the default value from the optional field record.

You can change the default value that appears for an optional field, as follows:

 l If the optional field is validated, you must specify a value that is defined for the optional field in 
Common Services.     

Note: If the optional field allows blanks, you can leave the value field blank.

 l If the optional field is not validated, you can enter any value that is consistent with the type of field 
(such as yes/no, text, number, date, or amount), providing the value you enter does not exceed the 
length permitted for the field. You can also leave the field blank.

Note: When you specify a value that is defined in Common Services, the description for the value is 
also displayed.
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Rates Tab

Note: The Rates tab appears only in multicurrency Accounts Receivable systems when you enter an 
adjustment for a customer that does not use your functional currency.

You use the tab to specify the rate type, rate date, and exchange rate for the adjustment.

You can also use the tab to check the exchange rate that was used on the document you are adjusting.

Retainage Tab

Note: The Retainage tab appears only if you use retainage accounting in your Accounts Receivable 
System.

Use the tab to enter retainage terms and (if you use multicurrency) the retainage exchange rate.

You add or adjust retainage for particular document details on the detail-entry table on the Document tab.

Fields and Controls

Buttons

Post

Click this button to post the adjustment batch that is currently displayed.

Note: This button allows you to post one adjustment batch at a time. For information about posting 
multiple batches, see "Posting a Range of Batches" (page 234).

Batch Date

This is usually the date on which the adjustment batch was created.

Accounts Receivable displays the session date as the default batch date when you create a new batch. 
You can type a different date in the field, or select a date using the calendar. (Click the button beside the 
Batch Date field to display the calendar.)

You can also change the date any time before you post the batch, provided the Ready To Post option is 
not selected.
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Note: You must enter a date that is within the fiscal calendar defined for your Accounts Receivable 
system in Common Services. 

Batch Number

Use this field to:

 l Create a new batch. 

 l Open an existing batch or view descriptive information for a batch.

In the field to the right of the Batch Number field, enter a description for the batch using up to 30 
characters. The description helps you identify the batch in the Adjustment Batch List screen and in 
Finder lists of adjustment batches. You can change the description any time before you post the batch, 
provided the Ready To Post option is not selected.

For more information, see "Adding, Editing, or Deleting an Adjustment Batch" (page 140).

Tip: To view descriptive information for an existing batch, click the Zoom  button beside the Batch 
Number field. 

Entered By

This field displays the name of the person who entered the transaction.

No. of Entries

This field displays the number of entries in the selected batch.

Total Amount

This field displays the total for the batch.

Document Tab

Adjust Line Number

Use the Finder on this field to select the document detail you want to adjust.
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Adjustment Date

The adjustment date identifies the default fiscal year and period to display for the transaction and is 
used to determine the aging period into which the adjustment is placed on statements and reports.

You can print posting journals by adjustment date.

This date is shown as the Document Date on other reports that include adjustment transactions.

Adjustment Number

This is an internal number that is assigned sequentially by Accounts Receivable to identify the 
sequence in which all adjustment transactions are entered. It is not associated with the batch number.

Adjustment Total

This field displays the net total of the adjustment details in the entry. If you are entering an adjustment to 
transfer an amount from one account to another, the adjustment total should be zero.

Category

Note: This field appears only if the document you are adjusting is job-related.

Enter or use the Finder to select the Project and Job Costing category for the contract and project that 
you are adjusting. You can use only categories that are assigned to the specified contract and project in 
Project and Job Costing.

You can enter or select categories depending on the project type and accounting method. You cannot 
specify a category for:

 l Cost plus projects that use a Total Cost Percentage Complete or Labor Cost Percentage 
Complete accounting method.

 l Fixed price projects.

Whether you can specify a category also depends on the billing type used by the category. A category 
must be billable to be used in an Accounts Receivable invoice.

Contract

Note: This field appears only if the document you are adjusting is job-related.

Enter or use the Finder to select the Project and Job Costing contract that you want to adjust. 
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You can select only contracts that are assigned to the specified customer, and that are either Open or 
On Hold. 

You cannot enter transactions for a contract that has never been opened.

Cost Class

Note: This field appears only if the document you are adjusting is job-related.

Accounts Receivable displays the cost class associated with the selected category in Sage 300 Project 
and Job Costing.

Customer Number

Identifies the customer whose account will be adjusted when you post the transaction. 

The customer number determines the currency for the adjustment and the list of documents that appear 
in the Finder for the Document Number field.

Tip: To view comprehensive information for the customer, click the Inquiry  button beside the 
Customer Number field. The Customer Inquiry screen appears, with the current customer selected, 
and all the information available in Accounts Receivable displayed on several tabs.

Debit/Credit

Enter the amount of the adjustment detail.

Tips: 
 l Enter a debit to increase the balance in an asset, cost of sales, or expense account, or to 

decrease the balance of a revenue account.

 l Enter a credit to decrease the balance of an asset, cost of sales, or expense account, or to 
increase the balance of a revenue account.

If you use multicurrency accounting, you enter the amount in the customer's currency.

Description

Type a description of the reference you entered in the Reference field, or a description of the 
transaction. 

This description appears with the entry on the batch listing and posting journal. 
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If Description is used for the G/L Reference Field or G/L Description Field options on the 
A/R G/L Integration screen, this description appears on the G/L Transactions report and in the general 
ledger batch (if you do not consolidate general ledger transactions during posting in Accounts 
Receivable).

Distribution Code

This is a code of up to six characters that identifies the default general ledger revenue account to which 
you will post the adjustment.

When you enter a distribution code, the revenue account number appears automatically in the Account 
column, but you can enter another account number. 

You can omit the distribution code, and just type the general ledger account number.

Document Balance

Displays the current balance in the document for which you are entering an adjustment.

Document Number

Type the number of the document to adjust, or select it from the Finder. 

You must enter a valid document number for the customer, and the document must still exist in your 
Accounts Receivable data. (That is, you cannot specify a fully paid document that you have already 
cleared from Accounts Receivable.)

If Document Number is used for the G/L Entry Description, G/L Detail Reference, or G/L Detail 
Description options on the A/R G/L Integration screen, the document number appears on the 
G/L Transactions report and in the general ledger batch (if you do not consolidate general ledger 
transactions during posting in Accounts Receivable).

Tip: After you specify a document, you can click the Inquiry  button beside the Document Number 
field to view comprehensive Accounts Receivable information for the document in the Document 
Inquiry screen.

Entry Number

This is a number that Accounts Receivable assigns automatically to each new entry you create. 

An entry number identifies the sequence in which an entry was added to a batch and, along with the 
batch number, forms part of the audit trail for the transaction.
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To select an existing entry for editing or deleting, type its number in the Entry Number field, or select 
the number using the Finder.

To add a new entry, click the New button beside the Entry Number  field.

Note: If you delete an entry, you cannot reuse its number.

In the field to the right of the Entry number field, enter a description for the entry. This description can be 
up to 30 characters long, and appears with the entry number in the Finder list for the Entry Number field.

G/L Account

This is the general ledger account to which you will post the adjustment detail. 

If you use Sage 300 General Ledger, you can select the account number from the Finder. 

If you entered a distribution code, the corresponding general ledger account number appears 
automatically in this field, but you can type a different account number.

Job Related

This display-only field indicates whether the document you are adjusting is for a contract that you 
administer using Sage 300 Project and Job Costing.

When you select job-related invoices, credit notes, and debit notes, the A/R Adjustment Entry screen 
displays a different set of fields letting you enter the contract, project, category, and resource, as 
required for the adjustment.

The Select Details button also becomes available, letting you select a particular detail for adjustment.

Payment Balance

When you adjust a payment for an invoice that uses a multiple payment schedule, the Payment 
Balance field displays the outstanding balance for the invoice.

If the document you are adjusting does not have a multiple payment schedule, the payment balance is 
the same as the document balance.

Payment Number

When you adjust a payment for an invoice that uses a multiple payment schedule, this field identifies 
the payment number you are adjusting. Type the payment number, if applicable. 

If the selected document does not use a payment schedule, the payment number is always "1."
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Posting Date

The posting date records the date the adjustment transaction is actually posted to General Ledger.

Accounts Receivable uses the posting date to select the fiscal year and period to which to post the 
transaction. (You cannot edit the year or period directly.)

The default posting date depends on the selection for the Default Posting Date option on the 
A/R Options screen, but you can change the posting date. 

Notes: 
 l You cannot use a posting date that is earlier than the posting date for the document you are 

adjusting.

 l If you consolidate G/L transactions, the posting date for consolidated entries is the last date of 
the fiscal period.

Project

Note: This field appears only if the document you are adjusting is job-related.

Type the code for the project that you are adjusting, or use the Finder to select it. You can use only 
projects that you have assigned to the specified contract.

When you post the transaction, the program adjusts the billed amounts for the affected projects. 
(Transactions are not moved from one project to another in Project and Job Costing.)

Reference

Type an optional reference for the transaction, such as a purchase order number or check number. 

If Reference is used for the G/L Reference Field or G/L Description Field options on the A/R G/L 
Integration screen, this information appears on the G/L Transactions report and in the general ledger 
batch (if you do not consolidate general ledger transactions during posting in Accounts Receivable).

Resource

Note: This field appears only if the document you are adjusting is job-related.

If required, select the code for the resource affected by this adjustment—for example, an employee code 
or an equipment code.

You can enter a resource only if:
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 l You have assigned the resource to the specified project in Project and Job Costing.

 l The specified project is a time and materials project.

 l The specified contract is a standard contract.

You cannot specify a resource for a basic contract or for a standard contract where the specified project 
is fixed price or cost plus.

Retainage Balance

Accounts Receivable displays the outstanding retainage balance for the document on the Document 
tab.

Retainage Debit/Credit

If you are adjusting an original document, you can add or edit the Retainage Debit or Retainage Credit 
field, even if the original detail did not include retainage.

Note: If you are adding a detail that did not exist on the original invoice to which retainage applies, 
you must enter the retainage amount manually in the Retainage Debit or Retainage Credit field. 
Accounts Receivable does not calculate the retainage amount for adjustment details automatically.

Enter the debit or credit as a positive number. If you enter a retainage debit or retainage credit amount 
using a negative number, the program moves the amount to the retainage credit or retainage debit field.

Tips: 
 l If the document you are adjusting included retainage, you can edit the original retainage debit 

or retainage credit, and the retainage due date for a detail. You cannot change the terms code 
or the retainage exchange rate option.

 l You can adjust retainage and add or change document details on the same adjustment 
document. (The program creates two journal entries: one for the retainage adjustment, and the 
other for the detail adjustment.)

 l The program does not display these fields when you adjust a retainage invoice, debit note, or 
credit note that you posted to clear outstanding retainage.

Retainage Due Date

If retainage was taken on the detail you are adjusting, the program displays the retainage due date from 
the original document. 

You cannot change the retainage due date for posted details.
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If you are adding retainage to a document that did not include retainage, you must enter a retainage due 
date for the retainage detail.

Year/Period

This field displays the fiscal year and period to which the adjustment will be posted.

Accounts Receivable automatically displays the fiscal year and period that contains the date you enter 
in the Posting Date field. You cannot change this field except by changing the posting date.

Optional Fields Tab

Optional Field and Optional Field Description

Any optional fields that are set up for automatic insertion in adjustment entries appear, along with their 
descriptions, as defaults on the Optional Fields tab.

You can add different optional fields that you define for adjustments using the A/R Optional Fields 
screen. When you select an optional field code, the program displays the description from the optional 
field setup record.

You can also delete optional fields that appear as defaults. However, if an optional field is required for 
adjustments, do not delete it. You cannot add the adjustment until you enter a value for the optional 
field.

Value and Value Description

If you select an adjustment optional field that has a default value, the program automatically displays an 
entry in the Value field. 

You can change the value. However, if the optional field requires validation, you must select a value 
that is defined for the optional field in Common Services (unless the optional field allows blanks).

Accounts Receivable also displays the description for a specified optional field value. You cannot 
change the description for the adjustment transaction. (You can change the description for a value only 
in the optional field setup record.)

Note: If an optional field is a required field, you cannot save the transaction until you enter a value.

Value Set

If an optional field is a required field, it must contain a value before you can save an entry.
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The Value Set field indicates Yes if Accounts Receivable has already set a value—including an 
acceptable blank—for the field.

Rates Tab

Currency

Accounts Receivable displays the currency for the specified customer in this field.

Exchange Rate

This field displays the current exchange rate for the specified currency, rate type, and rate date. If 
necessary, you can type a different rate or select a rate from the Finder. (Accounts Receivable selects 
the rate to display from the Currency screens in Common Services.)

Rate Date

Accounts Receivable uses the exchange rate specified for this date in Common Services to convert 
amounts from the customer currency to your functional currency.

It displays the batch date as the default date in this field, but you can enter a different rate date. If you 
enter a new date, Accounts Receivable displays the exchange rate associated with that date.

Rate Type

The code specified in this field determines the type of rate used to converting a multicurrency amount to 
functional currency. 

Example: Rate types might be "spot rate," "average rate," or "contract rate."

You must type a valid rate type. or select one from the Finder. (Rate types are defined in the Currency 
Rate Types screen in Common Services.)

Retainage Tab

Retainage Exchange Rate

If you use multicurrency accounting, specify whether to use the current exchange rate or the exchange 
rate used for the original document when you process the retainage document.
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Note: The Retainage Exchange Rate field does not appear if the original document included 
retainage. In this case, Adjustment Entry uses the retainage exchange rate setting from the original 
document.

Retainage Terms

If retainage was taken on the document you are adjusting, the program displays the retainage terms 
from the original document.

If you are adding retainage to a document that did not include retainage, you must enter a terms code to 
use for the retainage document when you process it.

A/R Document Inquiry Screen

To Open this Screen

Do one of the following:

 l Open Accounts Receivable > A/R Transactions > Document Inquiry.

 l On the A/R Customer Inquiry screen, click theInquiry  button beside the Document Number 
field.

 l On any Accounts Receivable transaction-entry screen, display a posted transaction, and then 

click the Inquiry  button beside the Document Number field.

Overview

This screen lets you:

 l Set a customer filter to display only documents for the current customer when you use the Finder 
or the navigation buttons for the Document No. field. For more information, see "Filtering 
Document Inquiry Results for the Current Customer" (page 240).     

Note: If you open the A/R Document Inquiry screen from another Accounts Receivable screen, the 
program automatically applies the filter for the current customer.

 l In a multicurrency system, display amounts in customer currency or in functional currency.

 l Open the A/R Customer Inquiry screen to see customer information that is not available on the 
A/R Document Inquiry screen, or to search for a document number. More...
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If you want to view a document and you know the customer number, but you do not know the specific 
document number, use the A/R Customer Inquiry screen as an initial point of investigation. This screen 
lists transactions on separate tabs, according to transaction type. The tabs let you filter and sort the 
transactions, which can help you to identify the transaction you want. For more information, see "A/R 

Customer Inquiry Screen" (page 408).

 l Print a copy of the original invoice, debit note, credit note, receipt, or interest charge directly from 
the A/R Document Inquiry screen. (Click the Print A/R Invoice, Print O/E Invoice, or Print Receipt 
button in the lower left corner of the screen.)

 l Drill down to view the batch header for the batch that contains the current document.

 l Drill down to view documents in the original transaction entry screens.

 l View transactions that have been applied to the current document.

 l If the selected document is job-related, or if it includes retainage, see how transactions were 
applied on a detail basis.

 l If you use Order Entry, drill down from order numbers and shipment numbers to view the original 
order or shipment in Order Entry.

Most of the information for a document is displayed on one of several thematic tabs. However, some 
information and features are available from any tab on this screen, including:

 l The document's transaction type, customer number and description, and national account code (if 
the customer is a member of a national account).

 l An Amounts In field that lets you display amounts in customer currency or functional currency, if 
your ledger is multicurrency.

 l A Print button that lets you easily print a copy of the document.

Tip: Once you have opened the A/R Document Inquiry screen, leave it open. When you open 
Document Inquiry from another Accounts Receivable screen, the program updates the information for 
the current document.

Bank Tab

This tab appears only for transactions that involve customer payments or refunds, and lets you view:

 l The code and description for the bank to which the payment or refund was processed.

 l The check or receipt number for the document.

 l Exchange information, for multicurrency documents.

Details Tab

This tab displays information about the details of a document. More...

The Details tab displays the following information:
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 l General information about the details of a selected document. This includes the number and 
type of details, and whether the document is job-related or includes retainage.

 l A list of the distribution details for the selected document.

The main table on the Details tab presents one line of summary information for each detail. The 
information that appears varies according to the type of document you are viewing. For example, 
information for an invoice detail includes the detail amount, applied amount, current balance, and the 
G/L account affected. It may also include an adjustment amount, discountable status, and retainage 
information (as applicable).

If the document is job-related, detail information also includes the contract, project, category, and 
resource affected.

If you use optional fields, an Optional Fields column indicates whether optional fields were assigned to 
the details.

Note: If the Optional Fields column indicates Yes for the transaction, you can double-click in the 
column to open a separate screen that displays the optional fields for the detail.

 l A list of all the transactions applied to a selected detail, if the document is job-related or 
includes retainage.

When you select a detail in the top table, applied transaction details appear in a secondary table at the 
bottom of the tab.

Note: You can view an applied transaction in the original transaction-entry screen. For more 
information, see "Drilling Down from Document Inquiry to a Transaction Entry" (page 240).

If your Sage 300 system uses security, you must have Transaction History Inquiry security authorization 
to view the Details tab.

Header Tab

This tab displays header-level information for a selected document. More...

The Header tab displays various information, including:

 l The source application (such as AR or OE) where the originating document was entered or 
generated.

 l Information about the Accounts Receivable batch in which the document was posted, as well as 
the entry number and document date of the document.

 l Reference numbers (such as the customer's PO number) and numbers of originating documents 
(O/E order number and shipment number, or, for retainage documents, the original document 
number).
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 l Ship Via code and shipping instructions.

 l The customer's group code and account set.

 l The document terms and discounts applied to the document.

 l Retainage information.

 l The document total, applied amount, and current balance, and an indication of whether the 
document is fully paid.

The Header tab lets you:

 l View general information about a specific document and the batch in which it was posted.

 l Drill down to the Accounts Receivable batch information screen. To do this, click the Drilldown  
button beside the Batch No. field.

 l Drill down to view the document as it was entered in the Accounts Receivable transaction entry 

screen. To do this, click the Drilldown  button beside the Entry No. field.

 l In multicurrency ledgers, view amounts in the customer currency or in your company's functional 
currency. You specify the currency in the Amounts In field.

Optional Fields Tab

This tab displays the optional fields that were assigned to the document header, including the values 
entered for the optional fields. You cannot change any of the information on this tab.

Note: Optional fields that were assigned to the individual details of the transaction are displayed on the 
Details tab.

Rates Tab

This tab appears only in multicurrency ledgers, if the customer's currency is not the same as the 
functional currency. It displays currency and exchange information for the document. More...

The Rates tab displays information in the following groups:

 l Customer Currency. These fields display the customer's currency, the rate type, the rate date, the 
exchange rate used to convert from the customer's currency, and whether an override was used to 
apply the exchange rate.

 l Bank Currency. These fields appear if the receipt currency is not the same as the functional 
currency. These fields display the bank's currency, as well as the rate type, the rate date, the 
exchange rate used to convert to the bank's currency, and whether an override was used to apply 
the rate to the document.

 l Tax Reporting Currency. These fields appear if the tax group specified for the document uses a 
different currency than the customer's currency. These fields display the tax group's currency, the 
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rate type, the rate date, the exchange rate used to convert to the tax reporting currency, and 
whether an override was used to apply the exchange rate.

Salespersons Tab

This tab appears only for invoices and credit notes. It displays the salespersons responsible for the sale, 
including the percentage of the sale allocated to each salesperson on the invoice or the credit note.

Ship-To Tab

This tab appears only for invoices and credit notes. It displays:

 l The customer's address from the customer record.

 l The address to which items on the document were shipped.

 l The Ship-To code, if a ship-to code was specified for the document.

To view additional details, such as contact information, salesperson distributions, and the tax group 

associated with the ship-to location, click the Drilldown  button beside the Ship-To field. The program 

displays the ship-to location record for the code.

Taxes Tab

This tab appears only for invoices and credit notes (not interest invoices). It displays information about 
taxes for the document.More...

The Taxes tab displays the following information about the taxes that applied to the document:

 l The tax group and tax authorities that applied to the transaction.

 l Whether the tax was calculated automatically. (The Calculate Tax option is selected, unless taxes 
were entered manually.)

 l The tax amount calculated or entered for each tax authority, as well as the tax class and tax base 
used for the calculation of the tax.

 l The total tax amount for the document.

 l If the transaction is subject to withholding taxes, for each tax authority the tab displays the 
estimated amount that your customer will withhold to be remitted to the tax authority on your 
behalf.

 l If the tax group specified for the document uses a different currency than the customer's currency, 
the tab includes exchange information used to calculate the tax reporting amount, and it also 
indicates whether this amount was calculated automatically or entered manually.

 l In multicurrency ledgers, view amounts in the customer currency or in your company's functional 
currency. You specify the currency in the Amounts In field.
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Transactions Tab

This tab lists all the transactions that have been applied to the selected document. More...

The Transactions tab lets you:

 l View one line of summary information for each applied transaction.

 l Open the A/R Document Inquiry screen to display document history for a selected applied transaction. 
You can do this in the following ways:

 l Select the applied transaction on the table, and then click the Inquiry  button.

 l Double-click the Ref. Document Number field in the transaction line.

A/R Invoice Batch List Screen

To Open this Screen

Open Accounts Receivable > A/R Transactions > Invoice Batch List.

Related Tasks

 l "Printing Batch Listings" (page 330)

 l "Printing Accounts Receivable Posting Journals" (page 347)

 l "Printing the A/R Posting Errors Report" (page 345)

 l "Printing the A/R Batch Status Report" (page 333)

 l "Posting a Range of Batches" (page 234)

Overview

Note: Depending on how your system is set up, this desktop screen may also be available as a web 
screen. For more information, see the Web Screens Getting Started Guide or the help for Sage 300 
web screens.

This screen lets you:

 l View a list of invoice batches, beginning with the batch number you specify and including batches 
created on the Create Recurring Charge Batch and Create Interest Batch screens. More...

The list includes the following information about each batch:
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 l Batch number.

 l Batch date.

 l Batch description.

 l Number of entries.

 l Total amount.

 l Whether a batch has been printed.    

Notes: 
 l Open batches for which listings have been printed are marked Yes.

 l If you edit a printed batch, its status reverts to Open until you reprint the batch 
listing.

 l Posting sequence number.

 l Number of errors.

 l Date the batch was last edited.

 l Type (indicates how the batch was created).

 l Status. More...

A batch can have one of the following statuses:

 l Open. You can edit the batch.

 l Ready To Post. The batch can be posted. You cannot edit the batch unless you first 
change its status.

 l Post In Progress. Posting has started for the batch. You cannot edit or print it.

 l Deleted. The batch was removed from Accounts Receivable before posting. You 
cannot view the batch or reuse the batch number.

 l Posted. Transactions in the batch have been added to customer accounts. You 
cannot edit the batch, but you can print a listing for it.

 l Create a new invoice batch.

 l Select an existing batch to edit or delete.

 l Mark a batch Ready To Post.

Note: If you use Payment Processing, you must process all Paya credit card transactions included in 
a batch before you can mark the batch Ready To Post.

 l Post individual invoice batches.
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 l Print batch reports:

 l Batch Listing.

 l Batch Status.

 l Post all unposted batches that are set Ready To Post.

Fields and Controls

Buttons

Add Missing Payment Links

If you use Payments Acceptance to accept payments from your customers through online payment 
service providers (such as PayPal and Stripe), a Pay Now button is normally added to invoices during 
posting. If this does not happen for some reason, you can update the invoices after posting to add the 
Pay Now button. To do so, select the batch that includes the invoices you want to update, and click Add 
Missing Payment Links.

Close

Click this button to close the screen.

Tip: 
You can also close the screen in the following ways:

 l Click the top left corner of the screen.

 l Click File > Close.

Delete

Click this button to delete a batch.

All transactions in the batch are deleted and the batch is listed as deleted on the A/R Batch Status 
report. You cannot reuse the batch number.

Tip: To delete a posted batch, or to clear the data for a deleted batch, use the Clear Deleted And 
Posted Batches option on the A/R Clear History screen.
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New

Click this button to open the A/R Invoice Entry screen, which you can use to create a new invoice batch. 
For more information, see "Adding, Editing, or Deleting an Invoice Batch" (page 168).

Open

Click this button to open the selected batch in the main entry screen.

Post

Click this button to post the selected batch. For more information, see "Posting an Invoice Batch" (page 
236).

Post All

Click this button to post all unposted invoice batches that are set Ready To Post. For more information, 
see "Posting a Range of Batches" (page 234).

Print

Click this button to print a batch listing. For more information, see "Printing Batch Listings" (page 330).

Refresh

Click this button to update the information in the batch list. For example, if you have chosen not to show 
posted/deleted batches and another user has posted or deleted a batch, the batch will disappear from 
the list when you click Refresh.

Batch Number

If you want the list to begin with a specific batch, specify the batch number in this field.

Ready To Post

Indicates whether a batch is ready to post. To change the setting for a batch, double-click this field.

This field has three main purposes:

 l It prevents you from accidentally posting batches before they are ready.

 l It lets you post a range of batches, even if batches that are not ready to post are in the range.

 l It prevents you from making changes to batches that are set to Ready To Post.
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Notes: 
 l Before you can post a batch, the batch must be set to Ready To Post.

 l If you are posting a single batch, you can select Ready To Post during posting.

 l You cannot delete a batch for which the Ready To Post option is selected.

Show Posted and Deleted Batches

To list only batches with a status of Open or Ready To Post, clear this option.

A/R Invoice Entry Screen

To Open this Screen

Open Accounts Receivable > A/R Transactions > Invoice Entry.

Secondary Screens

 l A/R Batch Information Screen

 l A/R Detail Accounts/Taxes Screen

 l A/R Prepayments Screen

 l A/R Prepayments Batch Information Screen

 l A/R Ship-To Location Information Screen

Related Tasks

 l "Adding a Detail Using the A/R Detail Accounts/Taxes Screen" (page 175)

 l "Allocating a Sale to Salespersons" (page 179)

 l "Adding, Editing, or Deleting an Invoice Batch" (page 168)

 l "Editing Exchange Rate Information on an Invoice" (page 180)

 l "Editing Optional Fields for an Invoice Detail" (page 179)

 l "Editing Taxes on an Invoice, Debit Note, or Credit Note" (page 175)

 l "Entering a Debit Note or a Credit Note" (page 183)

 l "Entering a Prepayment with an Invoice" (page 177)

590Sage 300 2023 Accounts Receivable User's Guide

../../../../../../Content/Transactions/POPUPS/InvoiceEntry/BatchInformation.htm
../../../../../../Content/Transactions/POPUPS/InvoiceEntry/DetailAccountsTaxes.htm
../../../../../../Content/Transactions/POPUPS/InvoiceEntry/Prepayments.htm
../../../../../../Content/Transactions/POPUPS/InvoiceEntry/PrepaymentsBatchInformation.htm
../../../../../../Content/Transactions/POPUPS/InvoiceEntry/ShipToLocationInformation.htm


 l "About Entering Receipts and Invoices at the Same Time" (page 194)

 l "Invoicing a Customer" (page 170)

 l "Invoicing a Recurring Charge Manually" (page 181)

 l "Invoicing Customers for Outstanding Retainage" (page 181)

 l "Posting an Invoice Batch" (page 236)

 l "Reversing an Invoice Issued in Error" (page 186)

Overview

Note: Depending on how your system is set up, this desktop screen may also be available as a web 
screen. For more information, see the Web Screens Getting Started Guide or the help for Sage 300 
web screens.

Use the A/R Invoice Entry screen to:

 l Enter invoices, credit notes, and debit notes that update projects in Project and Job Costing, if you 
use that program to manage your contracts.

 l Enter prepayments with invoices.

 l If you use Payment Processing, process or void a credit card prepayment in Paya.

 l Edit invoices, credit notes, debit notes, and invoices in batches created in Accounts Receivable or 
imported from other accounting programs.

 l Post an invoice batch.

 l Open the Customer Inquiry screen to view a wide variety of information for the specified customer.

For more information, see "About Inquiring on Customers and Documents from Transaction Screens" (page 
239)

 l Print a batch listing for a selected batch by clicking File > Print Batch Listing Report.

Document Tab

You use the Document tab to:

 l Specify general information for a new document, including the customer number, document type 
(invoice, credit note, debit note, or interest charge), and document number.

 l Specify a ship-to location for the document.

 l Enter, edit, or delete details for the document.

 l Open a separate A/R Detail Accounts/Taxes screen on which you can edit detail or tax information 
for a selected detail.
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 l Open a separate Prepayments screen to record a prepayment.

 l Open a separate A/R Customer Inquiry screen to view all the details available in your Sage 300 
system for a specified customer.

Optional Fields Tab

Note: This tab appears if you use Sage 300 Transaction Analysis and Optional Field Creator and you 
have defined optional fields for Accounts Receivable invoices.

You use the Optional Fields tab to:

 l Check or change the optional fields used on an invoice, debit note, or credit note.     

Accounts Receivable displays the optional fields that you set up for automatic insertion on invoices, but 
you can change them or add other optional fields defined for Accounts Receivable invoices.

Note: You define and assign different optional fields invoice details, which you view and edit for each 
detail using the detail Optional Fields screen.

 l Check or change the value used for an invoice optional field. More...

Default values appear for the optional fields, as follows:

 l If you assigned exactly the same optional fields to the customer and ship-to location records 
as you defined for invoices, the optional field values for the ship-to location appear on the 
Optional Fields tab.

 l If the ship-to location record and the customer record use different optional fields, the 
optional field values from the customer record appear as defaults for the invoice.

 l If an optional field is defined for invoices, but is not assigned either to the customer or the 
ship-to location, the program displays the value specified for the optional field in the 
Optional Fields record.

Rates Tab

Note: This tab appears only if you use multicurrency accounting and you are entering a document for a 
customer who does not use the functional currency.

You use the Rates tab to change the rate type, rate date, and exchange rate for converting the document 
amount from the customer's currency to the functional currency.

Retainage Tab

Note: This tab appears if the Retainage Accounting option is selected for Accounts Receivable (on the 
A/R Options screen) and you selected the Retainage option on the Invoice Entry Document tab.
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You use the Retainage tab to specify how to process retainage for the invoice, debit note, or credit note 
you are entering. More...

Accounts Receivable displays the retainage percentage, retainage rate, and the retainage terms from the 
customer record. Unless the document is job-related, you can change these retainage factors for a 
particular document.

If the document is job-related, you can change only the retainage rate and retainage terms on this tab. 
You enter job-related retainage amounts, retention periods, and retainage due dates with each job detail.

Accounts Receivable calculates and displays the retainage amount and retainage due date for the 
selected document, but you can change them, whether or not the document is job-related.

Sales Split Tab

You use the Sales Split tab to allocate document totals to salespeople. 

You can assign portions of each transaction you enter in the Invoice Entry screen to each salesperson 
who is responsible for the customer account or sale. 

You can assign up to five salespersons per transaction.

If you track statistics for sales staff, Accounts Receivable uses this information to update the statistics 
when you post the transaction.

Taxes Tab

You use the Taxes tab to:

 l Assign the tax group for the document.

 l Check the tax authorities, customer tax class, tax base, and tax amount for the document.

 l Change the customer tax class for the document.

 l Recalculate the tax amount when you change the customer tax class for the invoice.

 l Recalculate the tax reporting amounts when you change the tax group for the document.

Tax Reporting Amounts

If you assign a tax group that uses a different currency from the customer currency, additional fields 
appear on the tab.

Use the Calculate Tax Reporting option to specify whether Accounts Receivable will calculate the tax 
reporting amounts for the document and its details. If you turn off the option, you must enter the tax 
amount for each authority, both for the document and for the details.
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The fields in the Tax Reporting Currency Rates section show the currency for the tax group (which you 
cannot change), and they let you enter the rate date, rate type, and exchange rate for converting the tax 
reporting amount.

If you enter the tax reporting amounts manually, use the Derive Rate button (in the Tax Reporting 
Currency Rates section) to compute the exchange rate for the tax reporting currency.

Terms Tab

Use the Terms tab to:

 l Enter terms for the invoice, if they are different from the terms in the customer record.

 l Edit multiple payment schedules that are calculated for invoices.

Note: A multiple payment schedule appears for an invoice only when you select a terms code that 
uses the Multiple Payment Schedule option.

Accounts Receivable adds a payment schedule to the Terms tab if you assign a terms code that uses a 
multiple payment schedule (for a number of payments over a period of time, such as six monthly 
payments).

The payment schedule divides the invoice total into the number of payments specified by the terms code. 
Each payment has its own due date, payment amount, and discount period, which is displayed on the 
tab. If you want, you can change any dates on the schedule, as well as increase or decrease the number 
of payments.

Tip: You can print payment schedules on batch listings if you select the Show Schedules option on the 
Batch Listing screen.

Totals Tab

Use the Totals tab to check the totals for the document, including the document, tax, prepayment, and 
discount amounts, as well as the total amount due.

Fields and Controls

Buttons

Add/Save

Click the Add button to add a new transaction. The button name then changes to Save.

If you edit a transaction you added previously, click Save to record your changes.
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Account/Tax

Click this button to open a separate screen on which you can edit detail or tax information for a selected 
detail. 

For more information, see A/R Detail Accounts/Taxes Screen (Invoices).

Calculate Taxes

If you clear the Calculate Tax option on the Taxes tab, the Calculate Taxes button appears on the 
Taxes tab.

Click this button to recalculate the tax amount when you change the customer tax class for the invoice.

Close

Click this button to close the screen.

Tip: 
You can also close the screen in the following ways:

 l Click the top left corner of the screen.

 l Click File > Close.

Delete

Click this button to delete a selected record, account, batch, or transaction.

Note: 
 l After you delete a batch or a document in a batch, you cannot reuse its entry number.

 l Deleted transactions are reported on the batch listing and posting journal for the batch. 

 l Deleted batches are also reported on the Batch Status report.

Derive Rate

The Derive Rate button appears on the Taxes tab on the Invoice Entry screen and on the Document 
Taxes screen in Receipt Entry (for miscellaneous payments), if you specified a tax group for the 
document that uses a different currency than the customer's currency.

After entering the taxes and tax reporting amounts for the tax authorities, click the Derive Rate button to 
let the program compute the implicit exchange rate between the customer currency and the tax 
reporting currency.
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Distribute Taxes

If you clear the Calculate Tax option on the Taxes tab, the Distribute Taxes button appears on the 
Taxes tab and the Document tab.

Click this button to prorate the tax you entered and allocate amounts to the invoice details.

For original documents to which retainage applies, the tax amounts are also prorated for the retainage 
tax base and retainage tax amount.

Note: 
 l You cannot prorate a tax amount to an authority that uses an exempt tax class.

 l When you click the Distribute Taxes button, the program replaces any tax amounts you may 
have entered manually for the details.

Post

Click this button to post the invoice batch that is currently displayed.

Note: This button allows you to post one invoice batch at a time. For information about posting 
multiple batches, see "Posting a Range of Batches" (page 234).

Prepay

Click this button to enter a prepayment. 

For more information, see A/R Prepayments Screen.

Print Invoice

Click this button to print invoices. 

For more information, see "Printing Accounts Receivable Invoices" (page 340).

Batch Date

You use the batch date as part of your audit trail and to select batches to print on the batch listing and 
batch status reports. The batch date is also used as the default document date when you create a new 
transaction.

Accounts Receivable displays the session date as the default batch date when you create a new batch, 
but you can change it.
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You can type a different date in the field, or select a date using the calendar. (Click the button beside the 
Batch Date field to display the calendar.)

Batch Number and description

Accounts Receivable automatically assigns a number to each new batch, and to each entry you add to a 
batch, starting with 1.

The batch number is a permanent part of the information stored for each invoice, debit note or credit 
note.

If your A/R G/L Integration options specify batch numbers as the description or reference for general 
ledger transactions, the batch number appears with the transaction on Accounts Receivable reports, 
such as posting journals and the G/L Transactions report.

You can use batch and entry numbers to trace transactions through the Accounts Receivable system 
and, if you use the numbers as the descriptions or references for G/L transactions, into your general 
ledger (unless you consolidate the transactions during posting in Accounts Receivable).

Use the Batch Number field to:

 l Create a new batch. 

 l Select the number of an existing batch you want to edit. 

For information about creating or displaying invoice batches, see "Adding, Editing, or Deleting an Invoice 
Batch" (page 168).

To view descriptive information for a batch, click the Zoom  button beside the Batch Number field. 

For more information, see A/R Batch Information Screen (Invoices).

Entered By

This field displays the name of the person who entered the transaction.

No. of Entries

This field displays the number of entries in the selected batch.

Total Amount

This field displays the total for the batch.
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Document Tab

Account Set

The account set from the customer record appears in this field as the default. It specifies the general 
ledger receivables control, payment discounts, prepayment liability, retainage, and write-offs accounts 
to which the transaction will be distributed.

You can change the account set for a particular invoice or recurring charge record. If you use 
multicurrency, however, the new account set must use the same currency as the customer's account 
set.

Apply-To Document

For credit notes and debit notes, you can enter the number of the document to which the note applies. If 
the note applies to several invoices, or is issued on account (for example, as a purchase volume 
rebate), you do not enter an invoice number here. You apply the credit note or debit note later, using the 
A/R Receipt Entry screen.

You can also enter the number of a document that you have not yet posted in Accounts Receivable. 
Accounts Receivable does not apply the credit note or debit note when you post it, but you can apply it 
using the A/R Receipt Entry screen.

When you select an apply-to document in multicurrency ledgers, you also see the exchange rate at 
which the document was posted. You normally enter the credit note or debit note at the same exchange 
rate.

Currency

The customer's currency appears when you enter the customer number in a multicurrency system.

You use the Rates tab to change the rate type, rate date, and exchange rate for an entry that is not in 
the functional currency. You cannot change the currency code.

Customer Number

The customer number identifies the customer whose account will be updated when you post the 
document. The customer number also determines the billing address and sets the default tax group and 
payment terms.

In multicurrency systems, the customer number also determines the currency of the document.
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Tips: 
 l To view comprehensive Accounts Receivable information for the customer, click the Inquiry  

button beside the Customer Number field. The Customer Inquiry screen appears, with the current 
customer selected.

Description

This description appears with the document information on the Invoice Batch Listing and the Invoice 
Posting Journal.

Detail Type

Specify the detail type to use for the invoice (initially, the default detail type specified on the A/R Options 
screen is selected):

 l Summary. This type of detail includes just enough information to update your receivables 
records and general ledger revenue account. Use summary details when you do not maintain an 
inventory or when you update inventory information outside of Accounts Receivable.

 l Item. This type of detail lets you use a price list when entering details, and update receivables 
records as well as the revenue, inventory, and cost of goods sold general ledger accounts (the 
last two accounts are optional).

Notes: 
 l You can change the detail type until you add the invoice to the batch.

 l Interest and retainage invoices always use the summary detail type.

Document Date

This field sets the default due date and discount period, if any, for an invoice. It also sets the aging date 
from which invoices, credit notes, and debit notes are aged on statements and reports. (You can 
choose whether to age credit notes and debit notes by document date or treat them as current 
transactions. Invoices are always aged by date.)

You can also print posting journals by document date.

To select a date using the calendar, click the button beside the Document Date field.

Doc. Type

You use the Invoice Entry screen to enter invoices, credit notes, debit notes, and interest invoices. 
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Note: You can add interest charges only on summary invoices.

If you use retainage accounting and you selected the Retainage option for the invoice, you can also 
enter retainage invoices, retainage credit notes, and retainage debit notes.

You can add all document types to a single batch, or use separate batches for each type.

Document Number

The document number is assigned using the prefix and next number specified on the A/R Options 
screen for the document type, or you can type a document number. You can use a document number 
only once.

You can print posting journals by document number.

Entry Number

An entry number is the number that is assigned automatically by Accounts Receivable to each new 
entry you create. An entry number identifies the sequence in which an entry was added to a batch and, 
along with the batch number, forms part of its audit trail for the transaction.

To add a new entry, click the New   button beside the Entry Number field.

To select an existing entry for editing or deleting, type its number in the Entry Number field, or choose 
the number from the Finder. You can also use the navigation buttons to move quickly through the 
entries in the batch to the one you need.

Note: If you delete an entry, you cannot reuse its number.

Job Related

Select the Job Related option if this document is for a project you are managing using Sage 300 Project 
and Job Costing.

When you select the option, additional fields appear in the detail table to let you enter job-related 
information.

When you post the document, Accounts Receivable updates the specified contract, project, category, 
and (if required) the resource in Project and Job Costing.

Printed

This field indicates whether you have printed a copy of the invoice, credit note, or debit note.

600Sage 300 2023 Accounts Receivable User's Guide



Order Number

The order number is supplied by Sage 300 Order Entry, if you use it. You can enter an order number or 
other information in the field, or leave it blank.

You can list documents by order number in Finders and for receipt application, and you can use the 
number as the reference or description in G/L transaction batches.

PO Number

If the customer has a purchase order number, you can enter it in this field. You can also use this field for 
another purpose, or leave it blank.

You can list documents by purchase order number in Finders and for receipt application, and you can 
use the number as the reference or description in G/L transaction batches.

Posting Date

Use this field to specify the date that a selected document is posted to General Ledger. The posting 
date also determines the year and period to which the transaction is posted. The default posting date 
can be the document date, the batch date, or the session date, depending on the selection for the 
Default Posting Date option on the A/R Options screen.

Accounts Receivable uses posting dates, rather than document dates, to select open documents for 
revaluation, so that exchange adjustments are posted to the correct fiscal year and period.

Notes: 
 l If you are entering a retainage document, the posting date cannot be earlier than the posting 

date of the original document.

 l If you consolidate G/L transactions, the posting date for consolidated entries is the last date of 
the fiscal period.

Retainage

This option appears in Invoice Entry only if you selected the Retainage Accounting option for your 
Accounts Receivable system.

You select the Retainage option to indicate that retainage applies to the document you are entering. A 
Retainage tab appears, on which you specify how to process retainage for this invoice, debit note, or 
credit note.
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Shipment Number

Enter the shipment number, if you know it.

When you post the invoice, Accounts Receivable matches the invoice to any posted prepayments that 
use the shipment number.

Ship-To Location

This field appears on the Recurring Charges setup screen and on the Invoice Entry transaction screen. 

You use it as follows if you want to ship goods to an address that is different from the customer's billing 
address:

 l On the Recurring Charges screen, you must select an existing ship-to location that you have 

defined for the customer. You can click the Zoom  button beside the Ship-To field to view 
shipping information for the document.

 l On the Invoice Entry screen, you can elect an existing ship-to location that you have defined for 

the customer, or click the Zoom  button beside the Ship-To field to open a separate screen 
where you can enter an address and other shipping information for the document.

Ship Via

This field displays the information entered in the primary ship-to location record, if one exists for the 
customer, unless you enter a different ship-to location.

If no ship-to location is used on this invoice, the shipping details from the customer record appear.

You can enter a different ship via method, if necessary. If you use Order Entry, type a code that you 
have set up in Order Entry or select it using the Finder. If you do not use Order Entry, you can enter a 
code that you maintain elsewhere.

You can also leave the Ship Via field blank if you wish.

Year/Period

Accounts Receivable displays the fiscal year and period to which the document will be posted.

Accounts Receivable automatically displays the fiscal year and period that contains the date you enter 
in the Posting Date field. You cannot change this field except by changing the posting date.

Detail Table (Summary details)

Amount
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This is the amount for the detail you are entering.

If you use multicurrency accounting, you enter the amount in the customer's currency.

Notes: 
If you use Project and Job Costing, be aware that:

 l You can use only billable projects on Accounts Receivable invoices. (You cannot use non-
billable or no-charge projects.)

 l On summary invoices for cost plus and fixed price projects, whether you can enter an amount for a 
detail depends on the project accounting method and the billing type used by the selected 
category, as follows:

 l For a fixed price project or a cost plus project that uses the Completed Project, Total 
Cost Percentage Complete, or Labor Hours Percentage accounting method, you can 
enter an amount (including zero).

 l For cost plus project that uses a Category Percentage Complete, Billings And Costs, 
or Accrual-Basis accounting method, you can enter an amount (including zero) only if 
the specified category is billable. If the category is no charge or non-billable, the 
program sets the amount to zero, and you cannot change it.

Comment

The Comment field contains the comments you enter with a document detail. You can include up to 
250 characters in each comment.

If the Use Item Comment As Default option is selected on the A/R Options screen, Accounts 
Receivable displays any comment that is entered in the item record. You can use or change the 
displayed comment.

To print the comment with the detail when you print the invoice, debit note, or credit note, do one of the 
following:

 l On the Document tab's detail table, enter Yes in the Print Comment field for the detail line.

 l On the Detail Accounts/Taxes screen, select the Print Comment option.

Description

When you enter a distribution code, the program displays the description for the code.

You can use the displayed description or type another description for the detail.
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Discountable

You use this option to specify whether a selected detail is subject to the invoice discount. 

Example: If you do not give discounts on freight charges, you can exempt a freight detail from the 
invoice discount.

To indicate that a detail is not discountable, you clear the Discountable option for the detail on the 
Detail Accounts/Taxes screen, or select No for the option on the detail table.

Dist. Code

This field displays the distribution code from the item record for item details. However, you can change 
the code for an individual invoice, credit note, or debit note.

The distribution code determines the general ledger revenue account and, if you use them, the 
inventory and cost of goods sold accounts for the detail. If you prefer, you can directly enter the account 
number for the general ledger account.

Notes: 
 l Summary details use only the revenue and receivables control account.

 l Item details can post transactions to inventory and cost of goods sold accounts.

If you use the Accounts/Taxes screen (select a detail line, then click Accounts/Taxes or press F9), the 
description for the code also appears.

Export Declaration Number

If you have an export declaration number for a specific invoice detail, enter it in this field. If you have an 
export declaration number for the whole invoice, enter it on the Taxes tab.

Optional Fields

This field indicates whether optional fields are assigned to the document detail. If any invoice details 
optional fields are set for automatic insertion on invoices, the field will be selected when you add a new 
detail to an invoice, credit note, debit note, or recurring charge.

If you use exactly the same optional fields in customer records and on invoices, the program assigns 
the optional field values used in the customer record to transaction details that you add in the Invoice 
Entry and Recurring Charges screens.
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You can accept or delete the optional fields that appear as defaults, and you can add other optional 
fields that you have set up for invoice details. You can also change the optional field values used in 
document details.

For job-related details:

 l If the invoice details optional fields used on an invoice detail are identical to those assigned to 
the contract, Accounts Receivable uses the optional field values from the contract as default 
values for the details.

 l If you assign to a job-related detail an optional field that is not assigned to the contract, the 
program displays the default value for the invoice details optional field. You can also change the 
values, as you can for any invoice, credit note, or debit note.

For more information, see:

 l "Editing Optional Fields for an Invoice Detail" (page 179)

 l "About Optional Fields for Job-Related Transactions" (page 44)

Print Comment

This field lets you specify whether to print on the invoice, credit note, or debit note the comments you 
enter with a detail.

To print a detail comment on the invoice, credit note, or debit note, change the Print Comment field to 
Yes by doing one of the following:

 l Double-click the field.

 l Highlight the field, and then press the Spacebar.

Retainage %

The program uses the retainage percentage to calculate the retainage amount for a detail on an original 
invoice, credit note, or debit note.

You can enter a different retainage percentage in the Retainage Percentage (%) field. When you enter 
a new percentage, the program recalculates the retainage amount for the detail.

Retainage Amount

The retainage amount is the amount the customer can withhold for an original document detail until the 
end of the retention period, when retainage is invoiced.

To calculate the retainage amount, the program multiples the extended detail amount (or the extended 
amount plus tax, if you include taxes in retainage) by the retainage percentage.
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You can enter a new retainage amount, if necessary. When you enter an amount to replace a 
calculated amount, the program recalculates the retainage percentage.

The retainage amount is subtracted from the detail amount to calculate the amount due.

Retainage Due Date

The program calculates the retainage due date (the date the outstanding retainage is due for invoicing) 
by adding the number of days in the retention period to the original document date. You can enter a 
different due date.

Retention Period

The retention period is the number of days following the document date that retainage for the document 
detail will be due.

The program uses the retention period to calculate the due date for the retainage. When you change 
the retention period, the program recalculates the retainage due date, and vice versa.

Revenue Account

If you did not enter a distribution code, or if you want to change the revenue account for this detail, enter 
the account number for the general ledger revenue account to which you post transactions entered for 
the customer.

The account description for the revenue account you enter appears in the Account Description column.

These fields appear on the Detail Accounts/Taxes screen for both summary and item invoices. They 
also appear on the Document tab for summary invoices.

For job-related invoices, for most project types and accounting methods, Accounts Receivable displays 
the Billings account from the project in the Revenue Account field. For projects using the Accrual Basis 
accounting method, the program displays the project's Revenue account.

You can change the account only for a:

 l Time and material project.

 l Cost plus project that uses a Billings And Costs or Accrual Basis accounting method.

For all other cost plus projects and for fixed price projects, the program displays the Billings account, 
and you cannot change it.

Detail Table (Item details)

Comment
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The Comment field contains the comments you enter with a document detail. You can include up to 
250 characters in each comment.

If the Use Item Comment As Default option is selected on the A/R Options screen, Accounts 
Receivable displays any comment that is entered in the item record. You can use or change the 
displayed comment.

To print the comment with the detail when you print the invoice, debit note, or credit note, do one of the 
following:

 l On the Document tab's detail table, enter Yes in the Print Comment field for the detail line.

 l On the Detail Accounts/Taxes screen, select the Print Comment option.

Description

When you enter an item number, the description from the item record is displayed.

You can use the displayed description or type another description for the detail.

Discountable

You use this option to specify whether a selected detail is subject to the invoice discount. 

Example: If you do not give discounts on freight charges, you can exempt a freight detail from the 
invoice discount.

To indicate that a detail is not discountable, you clear the Discountable option for the detail on the 
Detail Accounts/Taxes screen, or select No for the option on the detail table.

Dist. Code

This field displays the distribution code from the item record for item details. However, you can change 
the code for an individual invoice, credit note, or debit note.

The distribution code determines the general ledger revenue account and, if you use them, the 
inventory and cost of goods sold accounts for the detail. If you prefer, you can directly enter the account 
number for the general ledger account.

Notes: 
 l Summary details use only the revenue and receivables control account.

 l Item details can post transactions to inventory and cost of goods sold accounts.
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If you use the Accounts/Taxes screen (select a detail line, then click Accounts/Taxes or press F9), the 
description for the code also appears.

Export Declaration Number

If you have an export declaration number for a specific invoice detail, enter it in this field. If you have an 
export declaration number for the whole invoice, enter it on the Taxes tab.

Extended Amt.

The extended amount is the price multiplied by the quantity in the unit of measure you selected. You 
cannot change the extended amount, except by changing the unit of measure, quantity, or price.

If you want to enter some units at different prices, add a separate detail line for each price.

Extended Cost

The extended cost is the item cost (from the A/R item record) multiplied by the quantity specified for an 
item detail line.

Note: You see item costs only if the Show Item Cost option is selected on the A/R Options screen.

Item No.

This field specifies the item number for the detail.

For invoices that are not related to a job or contract that you manage using Project and Job Costing:

 l You must choose an item number from your Accounts Receivable item list to add a detail to an 
invoice, credit note, or debit note.

 l If you do not have an item list, or if your item list does not contain the items you want to use, 
either add the items in the Items screen, or select (or create) a batch for summary invoice details 
and enter this document as a summary detail type.

For job-related invoices, the field displays the A/R item number from the specified resource (for 
standard contracts) or category (for basic contracts) as the default. You can select a different A/R item 
number only for time and material projects. If you change the A/R item number, the item number must 
be a valid item number in Accounts Receivable, and the unit of measure must be a valid unit of 
measure both for the new item number and the customer’s currency.
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Optional Fields

This field indicates whether optional fields are assigned to the document detail. If any invoice details 
optional fields are set for automatic insertion on invoices, the field will be selected when you add a new 
detail to an invoice, credit note, debit note, or recurring charge.

If you use exactly the same optional fields in customer records and on invoices, the program assigns 
the optional field values used in the customer record to transaction details that you add in the Invoice 
Entry and Recurring Charges screens.

You can accept or delete the optional fields that appear as defaults, and you can add other optional 
fields that you have set up for invoice details. You can also change the optional field values used in 
document details.

For job-related details:

 l If the invoice details optional fields used on an invoice detail are identical to those assigned to 
the contract, Accounts Receivable uses the optional field values from the contract as default 
values for the details.

 l If you assign to a job-related detail an optional field that is not assigned to the contract, the 
program displays the default value for the invoice details optional field. You can also change the 
values, as you can for any invoice, credit note, or debit note.

For more information, see:

 l "Editing Optional Fields for an Invoice Detail" (page 179)

 l "About Optional Fields for Job-Related Transactions" (page 44)

Print Comment

This field lets you specify whether to print on the invoice, credit note, or debit note the comments you 
enter with a detail.

To print a detail comment on the invoice, credit note, or debit note, change the Print Comment field to 
Yes by doing one of the following:

 l Double-click the field.

 l Highlight the field, and then press the Spacebar.

Quantity

When you enter an item detail, you must enter the quantity (number of units) for the detail. Accounts 
Receivable uses the quantity you enter to calculate the extended amount for the detail line.
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Retainage %

The program uses the retainage percentage to calculate the retainage amount for a detail on an original 
invoice, credit note, or debit note.

You can enter a different retainage percentage in the Retainage Percentage (%) field. When you enter 
a new percentage, the program recalculates the retainage amount for the detail.

Retainage Amount

The retainage amount is the amount the customer can withhold for an original document detail until the 
end of the retention period, when retainage is invoiced.

To calculate the retainage amount, the program multiples the extended detail amount (or the extended 
amount plus tax, if you include taxes in retainage) by the retainage percentage.

You can enter a new retainage amount, if necessary. When you enter an amount to replace a 
calculated amount, the program recalculates the retainage percentage.

The retainage amount is subtracted from the detail amount to calculate the amount due.

Retainage Due Date

The program calculates the retainage due date (the date the outstanding retainage is due for invoicing) 
by adding the number of days in the retention period to the original document date. You can enter a 
different due date.

Retention Period

The retention period is the number of days following the document date that retainage for the document 
detail will be due.

The program uses the retention period to calculate the due date for the retainage. When you change 
the retention period, the program recalculates the retainage due date, and vice versa.

UOM

This field specified a unit of measure, such as EACH or DOZEN—or HOURS or FRT, if these are non-
inventory items.

Item lists can store separate prices for each unit of measure by which you sell an item. When you 
specify the unit of measure and the quantity, Accounts Receivable displays the price and the extended 
amount.
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Accounts Receivable also displays the extended item cost if the Show Item Cost option is selected on 
the A/R Options screen.

On job-related invoices, for time and materials projects, Accounts Receivable displays the unit of 
measure for the specified resource (for standard projects) or category (for basic projects) as the 
default.

Unit Price

When you enter an item detail, this field displays the price entered in the item record for the selected 
unit of measure and for the customer's currency (if you use multicurrency accounting). You can change 
the price for a detail line if the invoice is not job-related.

You can also change the price for job-related item invoices, depending on the billing type used for the 
project resource, as follows:

 l For a basic project, you can enter a unit price for an invoice detail.

 l For a standard project:

 l If the specified resource is billable, you can enter a unit price for the detail (including 
zero).

 l If the specified resource is either no charge or non-billable, the program sets the unit price 
to zero, and you cannot change it.

Note: You cannot enter details for projects and categories that are non-billable or no charge.

Detail Table (Job-Related details)

Amount

This is the amount for the detail you are entering.

If you use multicurrency accounting, you enter the amount in the customer's currency.
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Notes: 
If you use Project and Job Costing, be aware that:

 l You can use only billable projects on Accounts Receivable invoices. (You cannot use non-
billable or no-charge projects.)

 l On summary invoices for cost plus and fixed price projects, whether you can enter an amount for a 
detail depends on the project accounting method and the billing type used by the selected 
category, as follows:

 l For a fixed price project or a cost plus project that uses the Completed Project, Total 
Cost Percentage Complete, or Labor Hours Percentage accounting method, you can 
enter an amount (including zero).

 l For cost plus project that uses a Category Percentage Complete, Billings And Costs, 
or Accrual-Basis accounting method, you can enter an amount (including zero) only if 
the specified category is billable. If the category is no charge or non-billable, the 
program sets the amount to zero, and you cannot change it.

Billing Type

You can enter details only for billable projects and categories. However, you can change the billing type 
for individual details as follows:

 l For a basic time and materials project:     

 l You can change the billing type for the detail to No Charge or Non-billable.

 l If a detail is billable, you can change the billing rate.

 l If a detail is no charge or non-billable, the program sets the billing rate to zero and you 
cannot change it.

 l For a standard time and materials project:     

 l The billing type for the resource determines the billing type for the detail.

 l If the resource is billable, you can change the billing type for the detail to No Charge or 
Non-billable.

 l If the resource is no charge or non-billable, the billing type for the detail is also no charge 
or non-billable, and you cannot change it.

 l If a detail is billable, you can change the billing rate.

 l If a detail is no charge or non-billable, the program sets the billing rate to zero and you 
cannot change it.

 l For a fixed price project, the billing type field is blank. All details are billable.
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 l For a cost plus project, the billing type field is blank. The program sets the billing type for the 
detail, depending on the project accounting method, as follows:     

 l For the Completed Project, Total Cost Percentage Complete, or Labor Hours Percentage 
Complete accounting methods, the detail is billable.

 l For the Category Percentage Complete, Billings And Costs, or Accrual-Basis accounting 
methods, the billing type for the specified category determines whether you can enter the 
detail. The category must be billable to enter the detail.

Category

You must specify a category for time and material projects, and for cost plus projects that use the 
Category Percentage Complete, Billings And Costs, and Accrual-Basis accounting methods.

If you are adding the invoice in Accounts Receivable, use the Finder to select the category for the 
contract and project affected by this transaction, if required. More...

To use the Finder to select a category assigned to the specified project:

 1. Do one of the following:

 l Highlight the detail line, then click the Category column heading.

 l On the detail line, click the Category field once, then click the Finder  that appears in 
the Category field.

 2. Highlight the category you want to use in the detail, click Select, and then click Close.

You can specify categories depending on the project type and accounting method.

The Finder shows only categories that you have assigned to the specified contract and project.

Note: If the current invoice was generated in Project and Job Costing, you cannot change the 
category.

You cannot specify a category for:

 l Cost plus projects using a Completed Project, Total Cost Percentage Complete, or Labor Cost 
Percentage Complete accounting method.

 l Fixed price projects.

You can use only billable categories in document details.
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COGS Account

On invoices for time and materials projects, the program displays the cost of goods sold account from 
the item’s distribution code as the default COGS account for the detail.

Contract

All job-related invoices must specify a contract number.

If you are adding the invoice in Accounts Receivable, specify the number of the contract affected by this 
transaction, if you know it. Alternatively, you can use the Finder to select the number. More...

To use the Finder to select a contract that use the same currency as the specified 
customer:

 1. Do one of the following:

 l Highlight the detail line, then click the Contract column heading.

 l On the detail line, click the Contract field once, then click the Finder  that appears in the 
Contract field.

 2. Highlight the contract you want to use in the detail, click Select, and then click Close.

Notes: 
 l If the selected invoice was generated in Project and Job Costing, you cannot change the 

contract.

 l You can select only contracts that have an Open or On Hold status in Project and Job Costing. 
If the contract is on hold, the program warns you. You cannot use a contract that is on hold if it 
has never been opened.

Cost Class

Accounts Receivable displays the cost class associated with the selected category in Sage 300 Project 
and Job Costing.

Date

This field is for the date you incurred the expense. (If the detail is for a subcontractor charge, it is the 
date subcontractor performed the work.)

Accounts Receivable displays the invoice date as the default for this field. You can edit the Date field 
only for time and material projects.
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Description

On item invoices, the program displays the description from the item record when you enter an item 
number for the detail.

On summary invoices, the program displays the description for the distribution code when you enter a 
distribution code.

You can use the displayed description or type another description for the detail.

Export Declaration Number

If you have an export declaration number for a specific invoice detail, enter it in this field. If you have an 
export declaration number for the whole invoice, enter it on the Taxes tab.

Inventory

Accounts Receivable displays the inventory account and description associated with the distribution 
code you entered for this detail. You can change the account number if necessary.

Note: This field is available for Item invoices only.

Item No.

This field specifies the item number for the detail.

For invoices that are not related to a job or contract that you manage using Project and Job Costing:

 l You must choose an item number from your Accounts Receivable item list to add a detail to an 
invoice, credit note, or debit note.

 l If you do not have an item list, or if your item list does not contain the items you want to use, 
either add the items in the Items screen, or select (or create) a batch for summary invoice details 
and enter this document as a summary detail type.

For job-related invoices, the field displays the A/R item number from the specified resource (for 
standard contracts) or category (for basic contracts) as the default. You can select a different A/R item 
number only for time and material projects. If you change the A/R item number, the item number must 
be a valid item number in Accounts Receivable, and the unit of measure must be a valid unit of 
measure both for the new item number and the customer’s currency.
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Optional Fields

This field indicates whether optional fields are assigned to the document detail. If any invoice details 
optional fields are set for automatic insertion on invoices, the field will be selected when you add a new 
detail to an invoice, credit note, debit note, or recurring charge.

If you use exactly the same optional fields in customer records and on invoices, the program assigns 
the optional field values used in the customer record to transaction details that you add in the Invoice 
Entry and Recurring Charges screens.

You can accept or delete the optional fields that appear as defaults, and you can add other optional 
fields that you have set up for invoice details. You can also change the optional field values used in 
document details.

For job-related details:

 l If the invoice details optional fields used on an invoice detail are identical to those assigned to 
the contract, Accounts Receivable uses the optional field values from the contract as default 
values for the details.

 l If you assign to a job-related detail an optional field that is not assigned to the contract, the 
program displays the default value for the invoice details optional field. You can also change the 
values, as you can for any invoice, credit note, or debit note.

For more information, see:

 l "Editing Optional Fields for an Invoice Detail" (page 179)

 l "About Optional Fields for Job-Related Transactions" (page 44)

Project

Each detail on a job-related invoice must identify a project that is assigned to the specified contract.

If you are adding the invoice in Accounts Receivable, use the Finder to select the project you are billing. 
More...

To use the Finder to view the projects assigned to the contract specified in a detail:

 1. Do one of the following:

 l Highlight the detail line, then click the Project column heading.

 l On the detail line, click the Project field once, then click the Finder  that appears in the 
Project field.

 2. Highlight the project you want to use in the detail, click Select, and then click Close.
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If you are invoicing a customer other than the contract customer, the customer specified on the invoice 
must use the same currency as the contract customer.

Note: If the current invoice was generated in Project and Job Costing, you cannot change the 
project.

To use a project on an invoice, the project must be:

 l Billable.

 l Consistent with the invoice type:    

 l To enter details for time and material projects, use item invoices.

 l To enter details for fixed price or cost plus projects, use summary invoices.

 l Open, On Hold (if it was previously opened), or Completed (if it uses a Completed Project 
accounting method).

 l Not closed to costs.

Quantity

When you enter an item detail, you must enter the quantity (number of units) for the detail. Accounts 
Receivable uses the quantity you enter to calculate the extended amount for the detail line.

Resource

If you are adding the document in Accounts Receivable, you must specify a resource that you have 
assigned to the specified project in Project and Job Costing. Use the Finder to select the code for the 
resource whose use the transaction is recording (for example, an employee code or an equipment 
code). More...

To use the Finder to view the resource assigned to the specified project and 
category:

 1. Do one of the following:

 l Highlight the detail line, then click the Resource column heading.

 l On the detail line, click the Resource field once, then click the Finder  that appears in 
the Resource field.

 2. Highlight the resource you want to use in the detail, click Select, and then click Close.

Note: If the current invoice was generated in Project and Job Costing, you cannot change the 
resource.
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You are required to enter resources only for details that specify a time and materials project for a 
standard contract.

For a basic contract or for a fixed price or cost plus project, you can enter a resource code or leave the 
field blank. Note, however:

 l For a cost plus project that uses the Billings And Costs, Accrual-Basis, or Category Percentage 
Complete accounting method, you cannot enter the code for an employee whose record is 
inactive in Project and Job Costing or in Sage 300 Canadian or US Payroll.

 l For a fixed price project or for a cost plus project that uses the Total Cost Percentage Complete, 
Labor Hours Percentage Complete, or Completed Project accounting method, you can enter any 
code, or you can leave the field blank. (Billing for projects using these accounting methods is 
determined at the project level.)

Retainage %

The program uses the retainage percentage to calculate the retainage amount for a detail on an original 
invoice, credit note, or debit note.

You can enter a different retainage percentage in the Retainage Percentage (%) field. When you enter 
a new percentage, the program recalculates the retainage amount for the detail.

Retainage Amount

The retainage amount is the amount the customer can withhold for an original document detail until the 
end of the retention period, when retainage is invoiced.

To calculate the retainage amount, the program multiples the extended detail amount (or the extended 
amount plus tax, if you include taxes in retainage) by the retainage percentage.

You can enter a new retainage amount, if necessary. When you enter an amount to replace a 
calculated amount, the program recalculates the retainage percentage.

The retainage amount is subtracted from the detail amount to calculate the amount due.

Retainage Due Date

The program calculates the retainage due date (the date the outstanding retainage is due for invoicing) 
by adding the number of days in the retention period to the original document date. You can enter a 
different due date.
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Retention Period

The retention period is the number of days following the document date that retainage for the document 
detail will be due.

The program uses the retention period to calculate the due date for the retainage. When you change 
the retention period, the program recalculates the retainage due date, and vice versa.

Revenue Account

If you did not enter a distribution code, or if you want to change the revenue account for this detail, enter 
the account number for the general ledger revenue account to which you post transactions entered for 
the customer.

The account description for the revenue account you enter appears in the Account Description column.

These fields appear on the Detail Accounts/Taxes screen for both summary and item invoices. They 
also appear on the Document tab for summary invoices.

For job-related invoices, for most project types and accounting methods, Accounts Receivable displays 
the Billings account from the project in the Revenue Account field. For projects using the Accrual Basis 
accounting method, the program displays the project's Revenue account.

You can change the account only for a:

 l Time and material project.

 l Cost plus project that uses a Billings And Costs or Accrual Basis accounting method.

For all other cost plus projects and for fixed price projects, the program displays the Billings account, 
and you cannot change it.

UOM

This field specified a unit of measure, such as EACH or DOZEN—or HOURS or FRT, if these are non-
inventory items.

Item lists can store separate prices for each unit of measure by which you sell an item. When you 
specify the unit of measure and the quantity, Accounts Receivable displays the price and the extended 
amount.

Accounts Receivable also displays the extended item cost if the Show Item Cost option is selected on 
the A/R Options screen.
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On job-related invoices, for time and materials projects, Accounts Receivable displays the unit of 
measure for the specified resource (for standard projects) or category (for basic projects) as the 
default.

Unit Price

When you enter an item detail, this field displays the price entered in the item record for the selected 
unit of measure and for the customer's currency (if you use multicurrency accounting). You can change 
the price for a detail line if the invoice is not job-related.

You can also change the price for job-related item invoices, depending on the billing type used for the 
project resource, as follows:

 l For a basic project, you can enter a unit price for an invoice detail.

 l For a standard project:

 l If the specified resource is billable, you can enter a unit price for the detail (including 
zero).

 l If the specified resource is either no charge or non-billable, the program sets the unit price 
to zero, and you cannot change it.

Note: You cannot enter details for projects and categories that are non-billable or no charge.

Optional Fields Tab

This tab is available only if you use Sage 300 Transaction Analysis and Optional Field Creator.

Optional Field and description

Any invoice optional fields that are set up for automatic insertion appear, along with their descriptions, 
as defaults on the Optional Fields tab.

You can add different optional fields, providing they are defined for invoices on the A/R Optional Fields 
screen. When you select an optional field code, the program displays the description from the optional 
field setup record.

You can also delete optional fields that appear as defaults. However, if an optional field is required, do 
not delete it. You cannot add the transaction until you enter a value for the optional field.

Value and description

Default values appear for invoice optional fields, as follows:
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 l If you assigned the same optional fields to the customer and ship-to location records as you 
defined for invoices, the optional field values for the ship-to location appear on the Optional 
Fields tab.

 l If the optional fields in the ship-to location record and the customer record are different from each 
other, the optional field values from the customer record appear as defaults for the invoice.

 l If an optional field is defined for invoices, but is not assigned either to the customer or the ship-to 
location, the program displays the value specified for the optional field in the Optional Fields 
record.

You can change the default value that appears for an optional field, as follows:

 l If the optional field is validated, you must specify a value that is defined for the optional field in 
Common Services.     

Note: If the optional field allows blanks, you can leave the value field blank.

 l If the optional field is not validated, you can enter any value that is consistent with the type of field 
(such as yes/no, text, number, date, or amount), providing the value you enter does not exceed 
the length permitted for the field. You can also leave the field blank.

Note: When you specify a value that is defined in Common Services, the description for the value is 
also displayed.

The description for the value appears automatically. You cannot change it.

Value Set

If an optional field is a required field, it must contain a value before you can save an entry.

The Value Set field indicates Yes if Accounts Receivable has already set a value—including an 
acceptable blank—for the field.

Rates Tab

This tab is available only for multicurrency ledgers.

Exchange Rate

This is the exchange rate currently in effect for the specified currency and the displayed rate type and 
rate date.

You can change the rate if necessary. (Accounts Receivable selects the rate to display from the 
Currency screens in Common Services.)
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Rate Date

Accounts Receivable uses the exchange rate specified for this date in Common Services to convert 
amounts from the customer currency to your functional currency.

Accounts Receivable displays the document date as the default rate date, but you can enter a different 
date. If you enter a new date, Accounts Receivable displays the exchange rate associated with that 
date.

Rate Type

The rate type is a code for the kind of rate to use when converting multicurrency amounts to functional 
currency. Examples of rate types might be "spot rate," "average rate," and "contract rate."

You must type a valid rate type or select one from the Finder.

You define rate types using the Currency Rate Types screen in Common Services.

Retainage Tab

This tab is available only if the Retainage option is selected.

Retainage %

The program displays the retainage percentage used to calculate the retainage amount for the 
document.

It is a weighted average percentage, based on the sum of the details.

Retainage Amount

The program displays the sum of the retainage for all details in this field.

You cannot change the field.

Retainage Rate

Specify the method the program will use to determine the exchange rate for the retainage document 
when you eventually process it:

 l Use Original Document Exchange Rate. Use the same rate as the document you are 
processing.
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 l Use Current Exchange Rate. Use the rate in effect when you process the retainage document 
invoicing the customer for the outstanding retainage.

Retainage Terms

You can use different terms for retainage documents (used to invoice for outstanding retainage) than 
you used for the original document from which the retainage was taken.

If retainage terms are specified in the customer record, the retainage terms code from the customer 
record is used as the default retainage terms code for the invoice. If no retainage terms code is 
specified in the customer record, the customer’s usual terms code is used as the default.

Sales Split Tab

Percent Split

Enter the percentage of the sale that you want assigned to this salesperson. You do not have to assign 
salespeople to a document, but, if you do, the percentages you assign must total 100.

Salesperson Name

This is the name of the salesperson from the salesperson record.

Salesperson Number

If salesperson numbers are assigned to the customer record, they are displayed here. You can change 
the salesperson numbers, but only to other numbers you have defined using the Salespersons screen.

You can also delete any of the salespersons assigned to the document, or add others. You do not have 
to assign salespeople to a document, but, if you do, the percentages you assign must total 100.

Taxes Tab

Calculate Tax

Select this option if you want Accounts Receivable to calculate sales taxes automatically for you.

If you clear this option (for example, if you are adding details that already include tax or are not taxable):

 l Taxes are not automatically calculated.

 l Tax amounts are not recalculated when you change the tax group or tax classes on invoices, 
credit notes, or debit notes. You must enter the tax amount manually for each tax authority.
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 l The following buttons are available:           

 l Calculate Taxes.

 l Distribute Taxes.

Calculate Tax Reporting

This option appears if the currency used by the tax group is different from the customer's currency.

Select the Calculate Tax Reporting option if you want Accounts Receivable to calculate the tax 
reporting amounts automatically using the Tax Reporting Currency Rate information you specify.

Do not select the option if you want to enter the tax reporting information manually for the document and 
detail lines. The sum of the detail amounts must equal the total for each tax authority on the Taxes tab. 
However, you do not need to enter the tax amounts for the detail if you enter the tax amounts for the 
document, and then distribute the amounts to details using the Distribute Taxes button.

If you enter tax reporting amounts manually, you can:

 l Click the Distribute Taxes button to prorate the total tax reporting amounts you enter for each tax 
authority on the Taxes tab to the document details.

 l Click the Derive Rates button to compute the exchange rate used to convert tax amounts to the 
tax reporting currency based on the tax reporting amounts you entered on the Taxes tab.

Currency Code

This field appears in the Tax Reporting Currency Rate section on the Taxes tab if the currency for the 
tax group you specified for the document is different from the customer's currency.

The program displays the currency code for the tax group, and you cannot change it.

Customer Tax Class

The customer tax class is assigned in the customer record and is displayed as the default in this field.

However, for many tax authorities, the tax class varies depending on the purpose of the goods or 
services being purchased. If necessary, you can change the tax class for the document on the Taxes 
tab.

Estimated Tax Withheld

The total estimated amount that your customer will withhold for a transaction to be remitted to a tax 
authority on your behalf.
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Exchange Rate

Accounts Receivable uses this exchange rate to calculate the tax reporting amount in the tax reporting 
currency.

The program displays the exchange rate specified for the tax reporting currency, rate type, and rate 
date in Common Services, but you can change it.

Export Declaration Number

If the invoice includes goods for which an export declaration form has been created, enter the number 
of the export declaration.

Tip: You can also enter export declaration numbers for specific invoice details, on the Details table on 
the Document tab.

Rate Date

Accounts Receivable uses the exchange rate specified for this date in Common Services to convert 
amounts from the customer currency to your functional currency.

Accounts Receivable displays the document date as the default rate date, but you can enter a different 
date. If you enter a new date, Accounts Receivable displays the exchange rate associated with that 
date.

Rate Type

The rate type is a code for the kind of rate to use when converting multicurrency amounts to functional 
currency. Examples of rate types might be "spot rate," "average rate," and "contract rate."

You must type a valid rate type or select one from the Finder.

You define rate types using the Currency Rate Types screen in Common Services.

Retainage Tax Amount

This column appears only for original invoices, debit notes, and credit notes to which retainage applies. 
It shows the total amount of tax calculated for retainage for the document.

Retainage tax amounts are computed using the Retainage Tax Base and the tax rate for each tax 
authority.
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Retainage Tax Base

This field appears on original documents to which retainage applies. It shows the amount (before 
included taxes) used to calculate tax on retainage, if the tax will be reported when you post the 
retainage document.

Two factors determine when tax on retainage is reported:

 l The selection for the Report Tax option for Accounts Receivable.     

You select from the following alternatives for this option on the Retainage tab of the A/R Options 
screen:

 l At Time Of Original Document. If you select this option, Accounts Receivable calculates 
and posts tax on retainage when you post the original document, regardless of the tax 
reporting options you select in Tax Services for the tax authority.

 l As Per Tax Authority. If you select this option, Accounts Receivable respects the 
selection for the Report Tax On Retainage Document option for the tax authority.

 l The setting for the Report Tax On Retainage option for the tax authority, in Tax Services.     

The tax authority may specify that no tax on retainage will be calculated (No Reporting), or that tax will 
be calculated and posted either when you post the original document or when you post the retainage 
document.

A retainage tax base does not apply if tax on retainage is reported when you post the original document.

You can change the amount if you do not select the Calculate Tax option.

Tax Amount

The amount of tax calculated for the tax authority on an invoice for which the program calculates tax 
automatically.

If you are entering taxes manually, the total you enter for the tax authority on the Taxes tab must match 
the sum of the taxes you enter for the document details.

Tax Authority

The tax authorities for the tax group assigned to the customer are listed on the Taxes tab.

They are also shown for each detail in the Accounts/Taxes screen.

To change the tax authority for a customer, you must change the tax group on the customer record.
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Tax Base

The amount (before included taxes) used as the base for calculating sales tax for the tax authority.

On original documents to which retainage applies, if the tax on retainage will be reported when you post 
the retainage document, this is the amount before tax (or the cost, depending on the tax authority) less 
retainage.

Tax Group

Tax groups specify the authorities that tax the customer and assign the customer's tax classes in each 
authority. (Tax classes determine the specific classification for a tax, such as which rate is applied or 
whether the customer is exempt.)

You assign a tax group to each customer and ship-to location, to assign the taxes for the document.

The customer's tax group is displayed when you enter the customer number. If you select a ship-to 
location, the tax group for the ship-to location replaces the customer's group.

You can assign a different tax group or change the tax class or taxable status for the customer (on the 
Totals tab) or any of the detail lines you enter with the document. To change the tax rates for an 
authority, however, you must use the Tax Services screens in Common Services.

In multicurrency ledgers, if you change the tax group to one that uses a different currency than the 
customer, you can choose whether to let the program calculate the tax reporting amount, and you can 
change the tax type, rate date, and exchange rate for the tax reporting currency.

Tax Reporting Amount

This field appears on the Taxes tab only if you assigned to the document a tax group that uses a 
currency different from the customer's currency. It shows the total tax amount for the tax authority 
converted to the tax reporting currency using the exchange rate specified for the tax reporting currency.

If you do not select the Calculate Tax Reporting option, when you enter original invoices, debit notes, 
and credit notes, you must enter the tax reporting amounts for each tax authority listed on the Taxes 
tab. The sum of the tax reporting amount entered for the details must equal the totals shown for each 
tax authority on the Taxes tab.

To prorate tax reporting amounts you enter manually on the Taxes tab to the document details on 
original documents, click the Distribute Taxes button.

Tax Reporting Total

This field appears only if the currency for the tax group is different from the customer's currency.
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It shows the amount of tax to be reported on tax tracking reports for all the tax authorities listed on the 
invoice.

Terms Tab

Amount Due

This is the amount due for the particular payment. The amount for each payment is calculated from the 
percentage that is specified in the terms code. You can change payment amounts as needed, but the 
total of all payments in a schedule must equal the invoice total.

As Of Date

The As Of Date is the date from which the terms are calculated. Accounts Receivable automatically 
displays the document date, but you can type another date.

Example: If the first payment is not due for six months (so you would consider the first invoice date as 

six months from today), add six months to the As of Date, then click the Go  button to recalculate 
the schedule dates.

Disc. Amount

This is the amount of the discount the customer can take if payment is made by the discount date.

While the discount period is in effect, the discount amount is displayed for the payment when you are 
applying receipts to the invoice (in Receipt Entry).

If the invoice includes a multiple payment schedule, a separate discount amount is calculated for each 
payment.

You can change the discount amounts at any time until you post the invoice.

Note: You must enter a discount date before you can enter a discount amount.

Disc. Base

This field appears on the Terms tab of the Invoice Entry screen. The program displays the document 
amount as the default, but you can change it.

The program multiples the discount base by the discount percentage to determine the discount amount.
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Disc. Date

This is the date by which payment must be made to qualify for the early payment discount (if you offer 
one). If a discount is available, Accounts Receivable displays the invoice total net of the discount when 
you apply receipts to the invoice during the discount period.

Discount dates are calculated for multiple payment schedules only if the terms code includes discount 
information. However, you can enter discounts in an individual multiple payment schedule, if you want.

You can allow a discount on an invoice only if the terms code permits discounts.

You can change the discount amount and period at any time until you post the invoice.

Note that you must enter a discount date before you can enter a discount amount or a discount 
percentage.

Disc. %

This is the percentage amount of any discount that is permitted by the terms code assigned to an 
invoice. You must enter a discount date before you can enter a percentage.

If the invoice includes a multiple payment schedule, a separate discount percentage is assigned for 
each payment.

You can change the discount percentages at any time until you post the invoice.

Due Date

This is the due date for the particular payment. It is used to age outstanding payments on customer 
statements and aging reports. You can change due dates at any time until you post the invoice.

Payment Number

Each of the payments on a multiple payment schedule is assigned a sequence number.

You specify the payment number when applying receipts or entering adjustments to an invoice with a 
multiple payment schedule.

Terms

Accounts Receivable uses the terms code you specify with an invoice to calculate the due date and the 
discount period and discount amount for the document.

The customer's default terms code appears when you enter the customer number for the invoice, but 
you can change to any other terms code you have defined in Accounts Receivable.
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If you use a terms code that includes multiple payments, a payment schedule is set up that includes 
separate due date and discount information for each payment. You can edit that information on the 
Payment Schedule tab of the screen. (This tab appears only if you have a multiple payment schedule.)

You can change the due date, discount date, amount, and rate at any time until you post the invoice.

Totals Tab

Amount due

This is the amount due for the invoice. The amount shown includes taxes, discounts, and any 
prepayment made.

Document Amount

This amount is the sum of all the details before taxes that are not included in prices.

Document Total

This amount is the sum of the details including all taxes.

Less Estimated Tax Withheld

The total estimated amount that your customer will withhold for a transaction to be remitted to tax 
authorities on your behalf.

Less Discount

To calculate the amount for this field, the program uses the terms and due date entered for the invoice.

This discount, together with any prepayment entered with the invoice, is subtracted from the document 
total to calculate the amount due.

Less Prepayment

This is the amount of any prepayment entered with the invoice.

This amount, together with the discount amount, is subtracted from the document total to calculate the 
amount due.
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Less Retainage

Accounts Receivable displays the amount of retainage to be withheld from the document amount.

Plus Taxes

This field displays the total amount of taxes not already included in detail prices.

This amount is added to the document amount in calculating the document total.

A/R Post Batches Screen

To Open this Screen

Open Accounts Receivable > A/R Transactions > Post Batches.

Related Tasks

 l "Posting a Range of Batches" (page 234).

Overview

Note: Depending on how your system is set up, this desktop screen may also be available as a web 
screen. For more information, see the Web Screens Getting Started Guide or the help for Sage 300 
web screens.

This screen lets you post batches of invoices, receipts, refunds, and adjustments to customer accounts. 
For more information, see "About Posting Batches" (page 230).

Note: You can post batches only if they are set Ready To Post.

Fields and Controls

Batch Type

Specify the type of batch you want to post:

 l Invoice.

 l Receipt.
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 l Adjustment.

 l Refund.

Note: You can post only one type of batch at a time.

From/To Batch

If you are selecting a range of batch numbers, specify the starting and ending batch numbers in the 
range.

Post the Following Batches

Specify whether to post all open batches of the type you have selected, or a range of batches.

Notes: 
 l Batches that are not set Ready To Post (in a Batch List screen) will not be posted.

 l If the Force Listing of All Batches option is selected on the A/R Options screen, you must print 
listings of the batches.

 l If the Force Printing Of Deposit Slips option is selected on the A/R Options screen, you must 
print deposit slips for receipt batches.

A/R Process Credit Card Payments Screen

To Open this Screen

Open Accounts Receivable > A/R Transactions > Process Credit Card Payments.

Related Tasks

 l "Processing Multiple Credit Card Payments" (page 207)

Overview

Note: Depending on how your system is set up, this desktop screen may also be available as a web 
screen. For more information, see the Web Screens Getting Started Guide or the help for Sage 300 
web screens.

Use the A/R Process Credit Card Payments screen to process credit card payments for multiple pending 
invoices (invoices with outstanding payments), and to create receipts for the processed payments.
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When you process payments, they are added to a receipt batch that is created automatically. If you 
process payments that use multiple processing codes, a separate receipt batch is created for each 
processing code.

Note: The date specified in the Invoices Due On or Before field is used as the batch date for these 
receipt batches.

Selecting Documents

By default, this screen displays all pending invoices that are due on or before the date specified in the 
Invoices Due On or Before field.

Note: 
If you allow terms discounts for credit card payments, invoices with terms discounts do not only appear 
in the table if they are due on or before the specified date. They also appear if a terms discount is 
available on the specified date. For example:

An invoice for one of your customers is due on June 30, but it includes a terms discount if it is paid 
before June 10. In the Invoices Due On or Before field, you enter June 4. The invoice appears in the 
table, even though it is due after June 4, because the terms discount is available on June 4.

If you have an invoice with terms discounts that is set up to be paid in multiple payments (for example, 
three monthly installments), all the outstanding payments for the invoice appear in the table. For such 
invoices, take care not to process payment for all the outstanding payments.

If you want to process payments for a range of invoices, you can use the filters on the A/R Process Credit 

Card Payments screen to specify criteria, and then click the Go  button to see documents that match 

the criteria you specified.

In the Apply column, "Yes" appears by default for each document. If you do not want to process payment 
for a document, double-click the row or press the spacebar to select "No."

Tip: If you want to process payments for a small number of the documents that appear in the table, 
modify your filter criteria to produce a smaller set of results, or click the Apply None button, and then 
manually select the documents for which you want to process payments.

If you want to print receipts after processing payments, select the Print Receipts After Processing 
Payments option.

Processing Payments and Creating Receipts

After selecting documents and specifying print options, click the Process Payments button to process 
payments and create receipts for the documents you selected.
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 l Paya processes payments for all documents that display "Yes" in the Apply column.

 l Accounts Receivable creates a receipt for each payment that is successfully processed.

 l Accounts Receivable creates a receipt batch with the date specified in the Invoices Due On or 
Before field used as the batch date. If you use multiple processing codes, a separate receipt batch 
is created for each processing code. 

 l When processing is complete, a message displays summary information about payments that 
were successfully processed. If any errors occur while processing payments and creating receipts, 
a message displays detailed information about each error.

Tip: If any payments were not processed, or if any receipts were not created, print this message to 
create a record of errors that you need to resolve.

 l If you select Print Receipts After Processing Payments, the A/R Receipts report screen opens 
after Sage 300 processes payments and creates receipts. By default, the numbers of the first and 
last Accounts Receivable batches created while processing payments are specified in the From 
and To batch number fields.

Fields and Controls

Buttons

Apply All

This button becomes available after you click Apply None, or after you manually set the value in the 
Apply column to "No" for all documents.

Click Apply All to set the value in the Apply column to "Yes" for all documents in the table.

Apply None

Click Apply None to set the value in the Apply column to "No" for all documents in the table.

Close

Click Close to close the screen.

Process Payments

Click Process Payments to process payments and create receipts.

 l Paya processes payments for all documents that display "Yes" in the Apply column.

 l Accounts Receivable creates a receipt for each payment that is successfully processed.
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 l Accounts Receivable creates a receipt batch with the date specified in the Invoices Due On or 
Before field used as the batch date. If you use multiple processing codes, a separate receipt 
batch is created for each processing code. 

 l When processing is complete, a message displays summary information about payments that 
were successfully processed. If any errors occur while processing payments and creating 
receipts, a message displays detailed information about each error.

Tip: If any payments were not processed, or if any receipts were not created, print this message to 
create a record of errors that you need to resolve.

 l If you select Print Receipts After Processing Payments, the A/R Receipts report screen opens 
after Sage 300 processes payments and creates receipts. By default, the numbers of the first 
and last Accounts Receivable batches created while processing payments are specified in the 
From and To batch number fields.

Restore Defaults

Click Restore Defaults to restore default values in the From/To fields (that is, to reset filters so that all 
pending invoices appear in the table).

From/To Customer Number

Specify a range of customer numbers for which to view pending invoices, or accept the default entries in 
these fields to view pending invoices for all customers.

From/To Customer Group

Specify a range of customer groups for which to view pending invoices, or accept the default entries in 
these fields to view pending invoices for all customer groups.

From/To Invoice Number

Specify a range of invoice numbers for which to view pending invoices, or accept the default entries in 
these fields to view all pending invoices that are due on or before the date specified in the Invoices Due 
On or Before field.

From/To Processing Code

A processing code specifies the bank, currency, and merchant account that will be used to process a 
credit card transaction.
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If you use multiple processing codes, you can specify a single processing code or range of processing 
codes for which to view pending invoices, or accept the default entries in these fields to view pending 
invoices for all processing codes.

If you process payments that use multiple processing codes, a separate Accounts Receivable receipt 
batch is created for each processing code. 

From/To Terms Code

Specify a range of terms codes for which to view pending invoices, or accept the default entries in these 
fields to view pending invoices for all terms codes.

Invoices Due On or Before

Invoices that are due on or before the date specified in this field appear in the table, allowing you to 
process payments for them.

Notes: 
 l This date is used as the batch date for receipt batches created when you process payments.

 l If you allow terms discounts for credit card payments, invoices with terms discounts do not only 
appear in the table if they are due on or before the specified date. They also appear if a terms 
discount is available on the specified date. For example:

An invoice for one of your customers is due on June 30, but it includes a terms discount if it is paid 
before June 10. In the Invoices Due On or Before field, you enter June 4. The invoice appears in 
the table, even though it is due after June 4, because the terms discount is available on June 4.

If you have an invoice with terms discounts that is set up to be paid in multiple payments (for 
example, three monthly installments), all the outstanding payments for the invoice appear in the 
table. For such invoices, take care not to process payment for all the outstanding payments.

Print Receipts After Processing Payments

Select this option if you want to print receipts for the selected documents after you process payments 
and create receipts.

If you select Print Receipts After Processing Payments, the A/R Receipts report screen opens after 
Sage 300 processes payments and creates receipts. By default, the numbers of the first and last 
Accounts Receivable batches created while processing payments are specified in the From and To 
batch number fields.
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Table

If you want to process payments for a range of invoices, you can use the filters on the A/R Process 

Credit Card Payments screen to specify criteria, and then click the Go  button to see 

documents that match the criteria you specified.

In the Apply column, "Yes" appears by default for each document. If you do not want to process 
payment for a document, double-click the row or press the spacebar to select "No."

Tip: If you want to process payments for a small number of the documents that appear in the 
table, modify your filter criteria to produce a smaller set of results, or click the Apply None 
button, and then manually select the documents for which you want to process payments.

A/R Quick Receipt Entry Screen

To Open this Screen

Open Accounts Receivable > A/R Transactions > Quick Receipt Entry.

Secondary Screens

 l A/R Batch Information Screen

 l A/R Rate Override Screen

Related Tasks

 l "Adding a Prepayment that You Will Apply Later" (page 201)

 l "Adding a Receipt to a Deposit Slip for Quick Deposit" (page 199)

 l "Advancing Credit to a Customer for Returned Goods" (page 219)

 l "Adding, Editing, or Deleting a Receipt Batch" (page 198)

 l "Adding, Editing, or Deleting a Receipt Batch" (page 198)

Overview

Use the Quick Receipt Entry screen to enter sufficient information for cash, check, and other receipts so 
that you can print a deposit slip and take the money to the bank in a timely manner. 

You can apply receipts to invoices and debit notes, later, using the A/R Receipt Entry screen.
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Fields and Controls

Buttons

Close

Click this button to close the screen.

Tip: 
You can also close the screen in the following ways:

 l Click the top left corner of the screen.

 l Click File > Close.

Deposit

Click this button to print a deposit slip for a receipt batch. 

For more information, see "Printing the A/R Deposit Slips Report" (page 337).

Open

Click this button to display a selected receipt in the A/R Receipt Entry screen. 

For more information, see "A/R Receipt Entry Screen" (page 648).

Print Receipt

Click this button to print a receipt for a selected customer payment. 

For more information, see "Printing Receipts" (page 342).

Rates

Click this button to edit currency conversion information for a selected receipt. 

For more information, see A/R Rate Override Screen (Receipts).
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Account Set

The customer's account set appears as the default in this field, but you can change the account set to 
another one that uses the customer's currency.

Note: You cannot specify an account set for apply transactions, for miscellaneous receipts that have 
no customer number, or for adjustments you make in Receipt Entry.

Advance Credit

This field appears if you select Receipt as the transaction type. It displays the total credit you are 
advancing to your customer on the current receipt.

You use the Zoom  button beside the field to open the Advance Credit screen, which lets you 

process an advance credit to a customer for goods that they have returned, but which you have not yet 
received. For more information, see "About Processing Advance Credits for the Return of Goods" (page 
195).

On the customer's statement, the invoice to which advance credit is applied appears as fully paid. 
However, because the advance "credit" is actually a separately numbered debit document, it remains 
on the statement, reflecting the customer's true unpaid balance, until you issue a credit note when the 
goods are received.

Amount

This is the amount of the check or other receipt.

In a multicurrency ledger, the amount is in the currency in which it was paid. The program displays the 
default batch currency for a new receipt, but you can select a different currency using the Finder for the 
field.

Apply Prepayment To

You enter a number in this field only for Prepayment transactions.

Enter the number of the invoice, debit note, purchase order, or sales order to which a prepayment 
applies, if you know it.

The document number you specify does not have to exist in Accounts Receivable. Later, when you 
enter and post the specified document (or the document that contains the specified purchase order 
number or order number), Accounts Receivable applies the prepayment to the document during 
posting.
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You do not have to enter a number in this field.

Note: If you do enter a number, you can click the Inquiry  button beside the Document Number 
field to view comprehensive Accounts Receivable information for the apply-to document in the 
Document Inquiry screen.

Bank

When you add a new receipt batch, this field initially shows the code and description for the default bank 
specified on the A/R Options screen.

You can enter or select a different bank code, if necessary.

Notes: 
 l If you have a multicurrency ledger and you plan to enter receipts that use different currencies, 

the bank must use the same currencies as the entries in the receipt batch. 

 l The statement currency for the bank must be your functional currency.

Check/Receipt Number

You enter a check number with each payment by check.

If the payment is not by check, you can enter another reference number, or you can leave the field blank 
to let Accounts Receivable assign a number that consists of the batch number and the entry number.

Customer Number

Identifies the customer account to which to post a receipt. You can type the customer number or select it 
from the Finder for the Customer Number field.

Tip: To view comprehensive Accounts Receivable information for a selected customer, click the 

Inquiry  button beside the Customer Number field. The Customer Inquiry screen appears, with the 
current customer selected.

Default Currency

Accounts Receivable lets you specify a default currency for the batch, which is used as the default for 
the receipts you add to the batch.

You can change the currency for a particular receipt, and you can use a variety of currencies in the 
same receipt batch.
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Deposit Number

When you create a new receipt batch, you assign a deposit number to the batch. You can:

 l Create a new deposit number for the receipt batch. Click the New  button beside the 
Deposit Number field to let the program assign the next deposit number specified on the AR 
Options screen.

 l Assign an existing deposit number to the batch. Use the Finder to select an existing deposit 
number (for example, to consolidate a number of receipt batches into one bank deposit). 
Accounts Receivable lets you assign a single deposit slip to multiple batches.

If the option Create Deposit Slip When Receipt Batch Is Created is selected on the A/R Options 
screen, you can leave the field blank and let the program assign the next deposit number when you add 
the first receipt to the batch.

If the option to create a deposit slip is not selected, you must assign or create a deposit slip manually 
before you can save a receipt, prepayment, unapplied cash transaction, or miscellaneous receipt. 

Tip: You do not have to create a deposit slip if the batch contains only apply document transactions.

You cannot edit the number once you add the first receipt to a batch.

Description

This field can contain an optional description of the entry, up to 30 characters long.

Optional Fields

This field indicates whether optional fields are assigned to the currently selected receipt. If any receipt 
optional fields are set up for automatic insertion, this field is selected when you add a new receipt entry.

To view or edit optional fields for the current transaction on the Optional Fields screen, click the Zoom 

 button beside the field.

If you assigned exactly the same optional fields to the customer record as you defined for receipts, the 
optional field values from the customer record appear.

If an optional field is defined for receipts, but is not assigned to the customer, the program displays the 
value specified in the Optional Fields record.

For information about assigning optional fields to receipts, see "Editing Optional Fields for a Receipt" 
(page 216).
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Payer Name

When you enter a customer number, Accounts Receivable displays the  payer name from the customer 
record. You can enter another name, such as the name on a third-party check.

Payment Code

Payment codes identify the types of payments you process, such as cash or checks.

You use payment codes on the A/R Receipt Entry screen and on the Prepayments screen (in Invoice 
Entry) to categorize receipts for the deposit slip. For example, your company may define three different 
codes for payments made by credit card—one type to identify each of the three credit cards you accept.

Tip: Click the Payment Code Finder  to see a list of payment codes and associated payment 
types.

If you use Payment Processing and want to process a credit card payment, you must select a payment 
code that uses the payment type SPS Credit Card before adding the document or prepayment. After 
you select the payment code, the Processing Code field appears, along with a status field that displays 
information about the status of the credit card transaction. After you add the document or prepayment, 
the Charge and Quick Charge buttons become available.

Payment Type

The program displays the payment type specified for the payment code you entered.

The payment type can be Cash, Check, Credit Card, or Other.

Receipt Date

Accounts Receivable uses the receipt date to:

 l Assign the receipt to aging periods on statements and reports, and to update statistics in 
customer records, as well as in salesperson records, if you keep salesperson statistics.

 l Calculate any early payment discount.

 l Report the number of days to pay.

The program uses the deposit date (entered on the A/R Receipt Entry screen or the Batch Information 
screen) as the default date for the receipt entry, but you can change it. For more information, see 
"A/R Receipt Entry Screen" (page 648) or A/R Batch Information Screen (Receipts).

This date is shown as the Document Date on reports that include receipts and apply document 
transactions.
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Transaction Type

You can specify the following transaction types for a receipt:

 l Receipt. More...

Receipts are payments for specific invoices. You apply them to the customers' accounts before you 
post the receipt batch. Receipts that are not fully applied are posted with an unapplied balance. You 
can apply the under-applied receipt, later, using an Apply Document transaction.

 l Prepayment. More...

Prepayments are cash on account that can be posted now and applied later to invoices.

 l Unapplied Cash. More...

You record an unapplied cash transaction when you receive a customer payment and you cannot 
identify an invoice to which it should be applied.

 l Miscellaneous Receipt. More...

Miscellaneous receipts are either:

 l Receipts that do not involve customer accounts, such as a payment for a long distance 
call, or a check from the sale of capital equipment.

 l A "cash receipt" from an existing customer. If you receive immediate payment for a sale, 
you can use a miscellaneous receipt to record both the receipt and the sale. When you 
post a miscellaneous receipt for an existing customer, Accounts Receivable creates an 
invoice using account distributions you enter with the receipt. It also assigns an invoice 
number using the prefix and next number specified for invoices on the A/R Options screen.

 l Apply Document. More...

You use Apply Document transactions to apply a posted prepayment, unapplied cash transaction, or 
credit note to outstanding documents in the customer's account. (You specify the outstanding 
document in the Document Number field.)

Note: When you apply credit notes that include retainage, only the original document balances are 
affected. Outstanding retainage amounts remain with original documents until you post retainage 
documents or adjustments to clear the outstanding retainage.

Year/Period

In Receipt Entry, the year and period are combined in one field. 

In the Quick Receipt Entry screen, the year and period are in separate fields that you can reach by 
pressing the Tab key or by clicking the field.
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Accounts Receivable automatically displays the fiscal year and period for the posting date you enter for 
a receipt. You cannot change the year or period except by changing the posting date.

A/R Receipt Batch List Screen

To Open this Screen

Open Accounts Receivable > A/R Transactions > Receipt Batch List.

Related Tasks

 l "Printing Batch Listings" (page 330)

 l "Printing Accounts Receivable Posting Journals" (page 347)

 l "Printing the A/R Posting Errors Report" (page 345)

 l "Printing the A/R Batch Status Report" (page 333)

 l "Posting a Range of Batches" (page 234)

Overview

Note: Depending on how your system is set up, this desktop screen may also be available as a web 
screen. For more information, see the Web Screens Getting Started Guide or the help for Sage 300 
web screens.

This screen lets you:

 l View a list of receipt batches, beginning with the batch number you specify. More...

The list includes the following information about each batch:

 l Batch number.

 l Batch date.

 l Batch description.

 l Number of entries.

 l Total amount.
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 l Whether a batch has been printed.    

Notes: 
 l Open batches for which listings have been printed are marked Yes.

 l If you edit a printed batch, its status reverts to Open until you reprint the batch 
listing.

 l Posting sequence number.

 l Number of errors.

 l Date the batch was last edited.

 l Type (indicates how the batch was created).

 l Status. More...

A batch can have one of the following statuses:

 l Open. You can edit the batch.

 l Ready To Post. The batch can be posted. You cannot edit the batch unless you first 
change its status.

 l Post In Progress. Posting has started for the batch. You cannot edit or print it.

 l Deleted. The batch was removed from Accounts Receivable before posting. You 
cannot view the batch or reuse the batch number.

 l Posted. Transactions in the batch have been added to customer accounts. You 
cannot edit the batch, but you can print a listing for it.

 l Bank (each batch is for a single bank).

 l Default currency (used for new receipts).

 l Whether a deposit slip has been printed.

 l Deposit (slip) number.

 l Adjustment amount.

 l Create a new receipt batch.

 l Select an existing batch to edit, post, or delete.

 l Mark a batch Ready To Post.

Note: If you use Payment Processing, you must process all Paya credit card transactions included in 
a batch before you can mark the batch Ready To Post.

 l Print deposit slips. (To print a deposit slip, select a batch on the list, and then click Deposit.)
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 l Print batch reports:

 l Batch Listing.

 l Batch Status.

 l Posting Journals.

 l Posting Errors.

 l Post all unposted batches that are set Ready To Post.

Fields and Controls

Buttons

Close

Click this button to close the screen.

Tip: 
You can also close the screen in the following ways:

 l Click the top left corner of the screen.

 l Click File > Close.

Delete

Click this button to delete a batch.

For more information, see "Adding, Editing, or Deleting a Receipt Batch" (page 198).

Deposit

Click this button to print a deposit slip for a receipt batch. 

For more information, see "Printing the A/R Deposit Slips Report" (page 337).

Get Online Payments

If you use Payments Acceptance to accept payments from your customers through online payment 
service providers (such as PayPal and Stripe), click this button to download receipts for online 
payments.
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When you click this button, receipts and bank entries are created for any online payments that have not 
yet been downloaded, as follows:

 l A receipt batch is created that includes a receipt for each online payment. The receipt batch is 
set up to post the receipts to the Payments Acceptance Bank Account specified on the A/R 
Options screen.

Note: Online payments made for Order Entry invoices are recorded as prepayments for the 
corresponding Accounts Receivable invoices.

We recommend that you use the Payments Acceptance Bank Account as a "clearing" account. After 
the provider has deposited the funds in your bank account, transfer the receipts (using Bank 
Transfers) to your real bank account, and then perform bank reconciliation. For a detailed example of 
the steps in this process, see Sage Knowledgebase article 106222.

 l For each online payment, a bank (withdrawal) entry is created for the amount of the processing 
fee charged by the provider. These bank entries are set up to be posted to the Charges Account 
specified on the Banks screen.

New

Click this button to open the A/R Receipt Entry screen, which you can use to create a new receipt batch.

For more information, see "Adding, Editing, or Deleting a Receipt Batch" (page 198).

Open

Click this button to open the selected batch in the main entry screen.

Post

Click this button to post the selected batch. For more information, see "Posting a Receipt Batch" (page 
236).

Post All

Click this button to post all unposted receipt batches that are set Ready To Post. For more information, 
see "Posting a Range of Batches" (page 234).

Print

Click this button to print a batch listing. For more information, see "Printing Batch Listings" (page 330).
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Refresh

Click this button to update the information in the batch list. For example, if you have chosen not to show 
posted/deleted batches and another user has posted or deleted a batch, the batch will disappear from 
the list when you click Refresh.

Batch Number

If you want the list to begin with a specific batch, specify the batch number in this field.

Ready To Post

Indicates whether a batch is ready to post. To change the setting for a batch, double-click this field.

This field has three main purposes:

 l It prevents you from accidentally posting batches before they are ready.

 l It lets you post a range of batches, even if batches that are not ready to post are in the range.

 l It prevents you from making changes to batches that are set to Ready To Post.

Notes: 
 l Before you can post a batch, the batch must be set to Ready To Post.

 l If you are posting a single batch, you can select Ready To Post during posting.

 l You cannot delete a batch for which the Ready To Post option is selected.

Show Posted and Deleted Batches

To list only batches with a status of Open or Ready To Post, clear this option.

A/R Receipt Entry Screen

To Open this Screen

Open Accounts Receivable > A/R Transactions > Receipt Entry.

648Sage 300 2023 Accounts Receivable User's Guide



Secondary Screens

 l A/R Advance Credit Screen

 l A/R Batch Information Screen

 l A/R Detail Accounts/Taxes Screen

 l A/R Detail Tax Withheld Screen

 l A/R Document History Screen

 l A/R Document Taxes Screen

 l A/R Miscellaneous Adjustment Entry Screen

 l A/R Project and Job Costing Apply Details Screen

 l A/R Rate Override Screen

 l A/R Tax Withheld Screen

Related Tasks

 l "Adding a Prepayment that You Will Apply Later" (page 201)

 l "Adding, Editing, or Deleting a Receipt Batch" (page 198)

 l "Adding a Receipt to a Deposit Slip for Quick Deposit" (page 199)

 l "Adjusting a Document During Receipt Entry" (page 214)

 l "Advancing Credit to a Customer for Returned Goods" (page 219)

 l "Applying a Posted Prepayment, Unapplied Cash Transaction, Receipt, or Credit Note" (page 213)

 l "Applying a New Receipt to a Posted Invoice or Debit Note" (page 210)

 l "Editing Optional Fields for a Receipt" (page 216)

 l "Processing a Cash Sale or Miscellaneous Receipt" (page 216)

 l "Posting a Receipt Batch" (page 236)

Overview

Note: Depending on how your system is set up, this desktop screen may also be available as a web 
screen. For more information, see the Web Screens Getting Started Guide or the help for Sage 300 
web screens.

You use the A/R Receipt Entry screen to:
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 l Enter cash, check, and other receipts directly into Accounts Receivable.

 l If you use Payment Processing, process credit card payments for receipts, prepayments, 
unapplied cash, and miscellaneous receipts.

Tip: You can use the A/R Process Credit Card Payments screen to process credit card payments for 
multiple pending invoices (invoices with outstanding payments), and to create receipts for the 
processed payments. For more information, see "A/R Process Credit Card Payments Screen" (page 
632).

 l Print deposit slips and receipt confirmations.

 l Apply posted credit notes to customer accounts.

 l Apply posted prepayments and unapplied cash to invoices (or other documents).

 l Enter receipts to update contracts you are tracking in Project and Job Costing. When you post a 
job-related customer payment, prepayment, or unapplied cash transaction, Accounts Receivable 
updates the total received for the contract in Project and Job Costing.

 l Distribute miscellaneous receipts from customers and others to general ledger accounts.     

When you post a miscellaneous receipt, Account Receivable updates the accounts and the tax tracking 
reports.

When you add a miscellaneous receipt for an Accounts Receivable customer, the program creates an 
invoice transaction at the same time, so you do not have to enter the invoice and receipt separately.

 l Process an advance credit to an invoice for goods that the customer is returning, but which have 
not yet arrived.

 l Write off amounts and enter other adjustments when you process customer payments, rather than 
adjusting the affected documents later using the A/R Adjustment Entry screen.

 l Review the transactions that have been applied to a selected invoice, credit note, or debit note.

 l Specify optional fields and values for receipts, if you use optional fields with your system.

 l Print a batch listing for a selected receipt batch. (Click File >  Print Batch Listing Report.)

 l Post a receipt batch.

Organization of the A/R Receipt Entry Screen

There are two main sections on the A/R Receipt Entry screen, which relate to the two main tasks you 
perform in this screen:

 l In the top portion of the screen, you enter general information about the receipt. 

 l In the lower portion of the screen, you select the options and enter the details you need to:     

 l Apply a new receipt, or a posted prepayment or and unapplied cash transaction, to an 
invoice, a credit note, or a debit note.
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 l Apply a credit note to an invoice or a debit note.

Receipts entered using the A/R Receipt Entry screen are available also on the Quick Receipt Entry 
screen, and vice versa. 

Note: The A/R Receipt Entry screen displays all the details for a single receipt on one screen. Only the 
fields you are required to fill out for the selected transaction type appear.

You can add all receipts to a batch before applying the deposits to specific invoices, or you can apply 
receipts as you enter them.

Tip: Use the Quick Receipt Entry screen to add receipts to a batch for quick deposit to your bank. Use 
the A/R Receipt Entry screen, later, to apply the receipts to other documents, and to distribute 
miscellaneous receipts to general ledger accounts.

For general information about processing receipts, see "About Processing Receipts" (page 190).

Fields and Controls

Buttons

Add/Save

Click the Add button to add a new transaction. The button name then changes to Save.

If you edit a transaction you added previously, click Save to record your changes.

Adjust

Click this button to write off differences between the amount your customer paid for an invoice and the 
amount the customer owed.

For more information, see A/R Miscellaneous Adjustment Entry Screen.

Charge

You can process a credit card payment by clicking Charge or Quick Charge. The difference between 
these buttons is the amount of information you must enter to complete the transaction:

 l Charge. Click this button to open the Process Credit Card screen and begin processing a credit 
card payment. You must enter all required information for the transaction.

 l Quick Charge. Click this button to process a credit card payment without entering any 
information.
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Note: To use this button, information required for the transaction must already be entered in your 
system. For more information, see "About Quick Processing for Credit Card Transactions" (page 132).

For more information, see "Processing a Credit Card Payment" (page 204).

Close

Click this button to close the screen.

Tip: 
You can also close the screen in the following ways:

 l Click the top left corner of the screen.

 l Click File > Close.

Delete

Click this button to delete a selected record, account, batch, or transaction.

Note: 
 l After you delete a batch or a document in a batch, you cannot reuse its entry number.

 l Deleted transactions are reported on the batch listing and posting journal for the batch. 

 l Deleted batches are also reported on the Batch Status report.

Deposit

Click this button to print a deposit slip for a receipt batch. 

For more information, see "Printing the A/R Deposit Slips Report" (page 337).

Jobs

Click this button to view details for a job-related receipt and specify how to apply the receipt to an 
invoice that uses different contracts, projects, categories, and resources. 

For more information, see "Applying a Receipt to a Job-Related Invoice" (page 211).

Post

Click this button to post the receipt batch that is currently displayed.
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Note: This button allows you to post one receipt batch at a time. For information about posting 
multiple batches, see "Posting a Range of Batches" (page 234).

Print Receipt

Click this button to print customer receipts. 

For more information, see "Printing Receipts" (page 342).

Quick Charge

You can process a credit card payment by clicking Charge or Quick Charge. The difference between 
these buttons is the amount of information you must enter to complete the transaction:

 l Charge. Click this button to open the Process Credit Card screen and begin processing a credit 
card payment. You must enter all required information for the transaction.

 l Quick Charge. Click this button to process a credit card payment without entering any 
information.

Note: To use this button, information required for the transaction must already be entered in your 
system. For more information, see "About Quick Processing for Credit Card Transactions" (page 132).

For more information, see "Processing a Credit Card Payment" (page 204).

Tax Withheld

Click this button to open the Tax Withheld screen, where you can view the total tax withheld for invoices 
in the entry.

This button appears only if you select Receipt or Apply Document in the Transaction Type field.

Void

Click this button to void a credit card payment. 

For more information, see "Voiding a Credit Card Payment" (page 209).

Account Set

The customer's account set appears as the default in this field, but you can change the account set to 
another one that uses the customer's currency.
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Note: You cannot specify an account set for apply transactions, for miscellaneous receipts that have 
no customer number, or for adjustments you make in Receipt Entry.

Advance Credit

This field appears if you select Receipt as the transaction type. It displays the total credit you are 
advancing to your customer on the current receipt.

You use the Zoom  button beside the field to open the Advance Credit screen, which lets you 

process an advance credit to a customer for goods that they have returned, but which you have not yet 
received. For more information, see "About Processing Advance Credits for the Return of Goods" (page 
195).

On the customer's statement, the invoice to which advance credit is applied appears as fully paid. 
However, because the advance "credit" is actually a separately numbered debit document, it remains 
on the statement, reflecting the customer's true unpaid balance, until you issue a credit note when the 
goods are received.

Apply By

This field appears for prepayments. You use it to specify the type of reference to use when selecting the 
document to which you are going to apply the prepayment.

You can select:

 l Document Number (invoice or debit note)

 l PO Number

 l Order Number

 l Shipment Number

Then, in the Apply To field, you specify the document number, PO number, order number, or shipment 
number.

Apply Document

You use Apply Document transactions to apply a posted prepayment, unapplied cash transaction, or 
credit note to outstanding documents in the customer's account. (You specify the outstanding document 
in the Document Number field.)
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Note: When you apply credit notes that include retainage, only the original document balances are 
affected. Outstanding retainage amounts remain with original documents until you post retainage 
documents or adjustments to clear the outstanding retainage.

Apply Method

Specify one of the following methods for applying partial customer payments to a number of invoices:

 l Top Down. Receipts are applied automatically to invoices beginning with the first invoice until the 
receipt is fully applied.         

Note: 
 l If you use this method to apply a receipt to an invoice that uses a multiple payment 

schedule, you may have to adjust the amounts manually. For invoices with a multiple 
payment schedule, you should prorate the receipt by amount.

 l Discounts, if any, are applied to the last allocated line only. If you wish to allocate 
discounts proportionately, prorate the receipt by amount.

 l Prorate By Amount. Payments are applied proportionately to all invoices, depending on their 
relative amounts.

To open a separate screen where you can apply a receipt to the details of a job-related invoice (for a 
contract that you manage using Sage 300 Project and Job Costing), select the invoice on the detail-
entry table, and then click Jobs.

Apply To

You enter a number in this field only for Prepayment transactions.

Enter the number of the invoice, debit note, purchase order, or sales order to which a prepayment 
applies, if you know it.

The document number you specify does not have to exist in Accounts Receivable. Later, when you 
enter and post the specified document (or the document that contains the specified purchase order 
number or order number), Accounts Receivable applies the prepayment to the document during 
posting.

You do not have to enter a number in this field.

Note: If you do enter a number, you can click the Inquiry  button beside the Document Number 
field to view comprehensive Accounts Receivable information for the apply-to document in the 
Document Inquiry screen.
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Auto Apply

When applying transactions using Select Mode, you click the Auto Apply option, and then click the Go 

 button to apply a receipt or apply-document transaction to a customer's account.

Accounts Receivable automatically applies the amount to outstanding invoices, debit notes, and interest 
charges for the customer, starting with the document with the earliest due date. If an amount is left over, 
it is applied to the document due next, and so on, until the amount is fully applied.

To apply additional posted credit notes, prepayments, partially applied receipts, and unapplied cash 
transactions together with the current receipt, change their Apply statuses to Yes in the table before you 

click the Go  button.

You can make any changes you need to the list after using the Auto Apply option.

Note: Clicking the Go  button does not change previously entered Apply statuses or amounts. If 
you made a mistake in applying amounts and want begin again, change the Apply statuses back to 

No, clear the Auto Apply check box, then click the Go  button to reset the table.

Bank

When you add a new receipt batch, this field initially shows the code and description for the default bank 
specified on the A/R Options screen.

You can enter or select a different bank code, if necessary.

Notes: 
 l If you have a multicurrency ledger and you plan to enter receipts that use different currencies, 

the bank must use the same currencies as the entries in the receipt batch. 

 l The statement currency for the bank must be your functional currency.

Batch Date

This is usually the date on which the batch was created.

The program uses the batch date as the default document date for new documents you add to the 
batch.

Accounts Receivable displays the session date as the default batch date when you create a new batch. 
You can type a different date in the field, or select a date using the calendar. (Click the icon beside the 
Batch Date field to display the calendar.)
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You can change the batch date any time before you post the batch, provided the Ready To Post option 
is not selected.

When you post the batch, the batch date becomes part of your audit trail. You use it to select batches to 
print on the batch listing and batch status reports.

Batch Number and description

Use this field to:

 l Create a new batch. 

 l Select the number of an existing batch you want to edit.

The batch number is a permanent part of the information stored for a receipt, and it appears with the 
transaction on Accounts Receivable reports, such as posting journals and the G/L Transactions report, 
if you use the option to use the numbers as the description or reference for general ledger transactions.

You can use batch and entry numbers to trace transactions through the Accounts Receivable system 
and, if you use the numbers as the descriptions or references for G/L transactions, in your general 
ledger (unless you consolidate the transactions during posting in Accounts Receivable).

For more information, see "Adding, Editing, or Deleting a Receipt Batch" (page 198).

Check/Receipt Number

You enter a check number with each payment by check.

If the payment is not by check, you can enter another reference number, or you can leave the field blank 
to let Accounts Receivable assign a number that consists of the batch number and the entry number.

Customer Amount

This field shows the amount of the receipt in the customer's currency. You apply this customer amount 
to the customer's account on the receipt application table on the A/R Receipt Entry screen.

In multicurrency ledgers, the receipt amount is converted from the bank currency to the customer 
currency using the exchange rate information contained on the Rate Override screen.

To change the exchange information for a selected receipt, open the Rate Override screen by clicking 
the Rates button at the bottom of the Receipt Entry or the Quick Receipt Entry screen.
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Customer Number

Identifies the customer account to which to post a receipt. You can type the customer number or select it 
from the Finder for the Customer Number field.

Tip: To view comprehensive Accounts Receivable information for a selected customer, click the 

Inquiry  button beside the Customer Number field. The Customer Inquiry screen appears, with the 
current customer selected.

Customer Unapplied

This field appears in multicurrency ledgers for customers who do not normally use the currency 
assigned to a receipt batch. 

The field shows how much of the selected receipt or credit note has not yet been applied to the 
customer's account, in the customer's currency. (The Receipt Unapplied field shows the unapplied 
amount in the receipt currency.)

Customer Undistributed

This field appears only for miscellaneous receipts in multicurrency ledgers.

It shows the undistributed amount in the customer currency. (The Receipt Undistributed field shows the 
undistributed amount in the receipt currency.)

Default Currency

Accounts Receivable lets you specify a default currency for the batch, which is used as the default for 
the receipts you add to the batch.

You can change the currency for a particular receipt, and you can use a variety of currencies in the 
same receipt batch.

Deposit Date

The deposit date is the date you deposit the receipts for the deposit number at the bank. The deposit 
number is printed on the deposit slip.

Accounts Receivable assigns the batch date as the default for this field, but you can change it.

Deposit Number

When you create a new receipt batch, you assign a deposit number to the batch. You can:
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 l Create a new deposit number for the receipt batch. Click the New  button beside the 
Deposit Number field to let the program assign the next deposit number specified on the AR 
Options screen.

 l Assign an existing deposit number to the batch. Use the Finder to select an existing deposit 
number (for example, to consolidate a number of receipt batches into one bank deposit). 
Accounts Receivable lets you assign a single deposit slip to multiple batches.

If the option Create Deposit Slip When Receipt Batch Is Created is selected on the A/R Options 
screen, you can leave the field blank and let the program assign the next deposit number when you add 
the first receipt to the batch.

If the option to create a deposit slip is not selected, you must assign or create a deposit slip manually 
before you can save a receipt, prepayment, unapplied cash transaction, or miscellaneous receipt. 

Tip: You do not have to create a deposit slip if the batch contains only apply document transactions.

You cannot edit the number once you add the first receipt to a batch.

Description

This field can contain an optional description of the entry, up to 30 characters long.

Document Number

When you add a transaction (except for Apply Document transactions) in either Receipt Entry or Quick 
Receipt Entry, a document number is assigned to the transaction. The number is determined by the 
prefix and next number entered for the receipt transaction type on the Numbering tab of the A/R Options 
screen.

When entering an Apply Document transaction, use the Document Number field to select a 
prepayment, unapplied cash, or credit note transaction to apply to an account. 

You must use a valid document number from the customer's account. 

Note: If you want to view comprehensive Accounts Receivable information for the specified 

document, click the Inquiry  button beside the Document Number field. The Document Inquiry 
screen appears, with the current document selected.

Document Type

Use this field to specify the type of document to which to apply the current receipt or credit document.
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If you are entering a Receipt transaction, you can apply the receipt to invoices, debit notes, and credit 
notes.

If you are entering an Apply Document transaction, you can apply a selected credit document only to 
invoices and debit notes.

Entered By

This field displays the name of the person who entered the transaction.

Entry Number

Use this field to open an existing receipt by entering the entry number for the receipt.

Invoice Number

When you add the miscellaneous receipt, Accounts Receivable assigns the number using the prefix and 
next number specified on the A/R Options screen for invoices, or you can type an invoice number.

If you are viewing a posted miscellaneous receipt, you can click the Inquiry  button beside the 

Document Number field to view comprehensive Accounts Receivable information for the invoice in the 
Document Inquiry screen.

Note: You can use an invoice number only once.

No. of Entries

This field displays the number of entries in the selected batch.

Optional Fields

This field indicates whether optional fields are assigned to the currently selected receipt. If any receipt 
optional fields are set up for automatic insertion, this field is selected when you add a new receipt entry.

To view or edit optional fields for the current transaction on the Optional Fields screen, click the Zoom 

 button beside the field.

If you assigned exactly the same optional fields to the customer record as you defined for receipts, the 
optional field values from the customer record appear.

If an optional field is defined for receipts, but is not assigned to the customer, the program displays the 
value specified in the Optional Fields record.
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For information about assigning optional fields to receipts, see "Editing Optional Fields for a Receipt" 
(page 216).

Order By

Use this field when applying receipts in Select Mode to specify the order by which to list the customer's 
documents. You can choose Document Number, PO Number, Due Date, Order Number, Document 
Date, Current Balance, or Original Document Number. 

Tip: If you use retainage accounting, listing documents by their original document number makes it 
easier to apply retainage payments when you receive these amounts from customers.

You set the default order for this field using the Default Order Of Open Documents option on the 
A/R Options screen.

Payer Name

When you enter a customer number, Accounts Receivable displays the  payer name from the customer 
record. You can enter another name, such as the name on a third-party check.

Payment Code

Payment codes identify the types of payments you process, such as cash or checks.

You use payment codes on the A/R Receipt Entry screen and on the Prepayments screen (in Invoice 
Entry) to categorize receipts for the deposit slip. For example, your company may define three different 
codes for payments made by credit card—one type to identify each of the three credit cards you accept.

Tip: Click the Payment Code Finder  to see a list of payment codes and associated payment 
types.

If you use Payment Processing and want to process a credit card payment, you must select a payment 
code that uses the payment type SPS Credit Card before adding the document or prepayment. After 
you select the payment code, the Processing Code field appears, along with a status field that displays 
information about the status of the credit card transaction. After you add the document or prepayment, 
the Charge and Quick Charge buttons become available.

Posting Date

The posting date is used to record the date the document was applied to another transaction and when 
it is posted to General Ledger. It does not affect the determination of the discount or the days to pay 
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statistics.

Accounts Receivable also uses this date to select the default fiscal year and period to which the 
transaction is posted. (You cannot change to another year or period.)

The default posting date that appears depends on your choice for the Default Posting Date option on 
the A/R Options screen.

Note: If you consolidate G/L transactions, the posting date for consolidated entries is the last date of 
the fiscal period.

Processing Code

The Processing Code field becomes available after you select a payment code that uses the SPS 
Credit Card payment type. 

A processing code specifies the bank, currency, and merchant account that will be used to process a 
credit card transaction.

Verify that the Processing Code field displays the correct processing code. If you need to change it, 

type the code or use the Finder  to select a code.

Note: The bank and currency for the batch and transaction must match the bank and currency 
specified for the processing code you select.

Receipt Amount

This is the amount of the check or other receipt.

In a multicurrency ledger, the amount is in the currency in which it was paid. The program displays the 
default batch currency for a new receipt, but you can select a different currency using the Finder for the 
field.

Receipt Date

Accounts Receivable uses the receipt date to:

 l Assign the receipt to aging periods on statements and reports, and to update statistics in 
customer records, as well as in salesperson records, if you keep salesperson statistics.

 l Calculate any early payment discount.

 l Report the number of days to pay.
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The program uses the deposit date (entered on the A/R Receipt Entry screen or the Batch Information 
screen) as the default date for the receipt entry, but you can change it. For more information, see 
"A/R Receipt Entry Screen" (page 648) or A/R Batch Information Screen (Receipts).

This date is shown as the Document Date on reports that include receipts and apply document 
transactions.

Receipt Undistributed

This field appears only for miscellaneous receipts.

It shows the amount of the receipt that has not been distributed to general ledger accounts. In a 
multicurrency ledger, the amount is shown in the receipt currency. The Customer Undistributed field 
shows the equivalent amount in the customer's currency.

Use the field to check that you have distributed the correct amount before posting the batch. You cannot 
post the receipt until the undistributed amount is zero.

Reference

For transaction types other than Miscellaneous Receipt, you can use this field to store additional 
information (such as the EFT number) that you want to keep with the transaction.

For Miscellaneous Receipt transactions, enter an optional reference for the distribution.

This reference appears with the distribution in the General Ledger batch, if you select the Type-Posting 
Seq.-Batch-Entry No. (Number) option for the G/L Reference Field option on the G/L Integration 
screen, and you do not consolidate general ledger transactions during posting.

Select Mode

The mode you select when applying receipts and credit notes determines the method by which you 
select the documents to pay.

Select Mode lets you order the list of documents outstanding for the customer, so you can easily mark 
the ones to pay. You can specify the type of document to display and the order in which to list 
documents of the selected type. You can also see any transactions that are pending against the 
customer's open documents in other unposted batches or entries.

You must turn on Select Mode to use the Auto Apply option when applying receipts to the accounts of 
balance-forward customers.

663Sage 300 2023 Accounts Receivable User's Guide

../../../../../../Content/Transactions/POPUPS/ReceiptEntry/BatchInformation.htm


If you do not use Select Mode, you apply receipts directly to document numbers by typing each 
document number to which you will apply an amount, or by selecting it from the Finder. You cannot see 
pending transactions or use the Auto Apply option.

Starting [Number/Date/Balance]

The name of this field varies according to your selection in the Order By field.

Use the field to type the number, amount, or date of the first record you want to see in the list of the 
customer's open documents.

Note: When you display documents for a national account, they are listed first by customer number, 
then by the method you specify in the Starting field.

Status

If you use Payment Processing, the Status field displays the status of a Paya credit card transaction, 
such as Not Charged or Charge Pending.

If the transaction has been processed, this field displays the authorization code for the transaction. You 
can use this code to look up the transaction in Sage Virtual Terminal.

Tax Group

Tax groups specify the authorities that tax the customer and assign the customer's tax classes in each 
authority. (Tax classes determine the specific classification for a tax, such as which rate is applied or 
whether the customer is exempt.)

The customer's tax group appears in the field when you enter the customer number. You can assign a 
different tax group, or you can change the tax information for the document on the Document Taxes 
screen. You can also change the detail tax class or tax included status for any of the detail lines you 
enter with the document.

To change the tax rates for a tax authority, however, you must use the Tax Services screens in 
Common Services.

In multicurrency ledgers, if you change the tax group to one that uses a different currency than the 
customer, you can choose whether to let the program calculate the tax reporting amount, and you can 
change the tax type, rate date, and exchange rate for the tax reporting currency.

Total Amount

This field displays the total for the batch.
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Total Tax

The program displays the total tax calculated or entered for all the details and tax authorities used on 
the document.

Transaction Type

You can specify the following transaction types for a receipt:

 l Receipt. More...

Receipts are payments for specific invoices. You apply them to the customers' accounts before you 
post the receipt batch. Receipts that are not fully applied are posted with an unapplied balance. You 
can apply the under-applied receipt, later, using an Apply Document transaction.

 l Prepayment. More...

Prepayments are cash on account that can be posted now and applied later to invoices.

 l Unapplied Cash. More...

You record an unapplied cash transaction when you receive a customer payment and you cannot 
identify an invoice to which it should be applied.

 l Miscellaneous Receipt. More...

Miscellaneous receipts are either:

 l Receipts that do not involve customer accounts, such as a payment for a long distance 
call, or a check from the sale of capital equipment.

 l A "cash receipt" from an existing customer. If you receive immediate payment for a sale, 
you can use a miscellaneous receipt to record both the receipt and the sale. When you 
post a miscellaneous receipt for an existing customer, Accounts Receivable creates an 
invoice using account distributions you enter with the receipt. It also assigns an invoice 
number using the prefix and next number specified for invoices on the A/R Options screen.

 l Apply Document. More...

You use Apply Document transactions to apply a posted prepayment, unapplied cash transaction, or 
credit note to outstanding documents in the customer's account. (You specify the outstanding 
document in the Document Number field.)

Note: When you apply credit notes that include retainage, only the original document balances are 
affected. Outstanding retainage amounts remain with original documents until you post retainage 
documents or adjustments to clear the outstanding retainage.
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Unapplied Amount

This field displays the amount of the selected receipt or credit note that has not been applied to a 
customer account. Confirm that this amount is correct before posting the batch.

Year/Period

In Receipt Entry, the year and period are combined in one field. 

In the Quick Receipt Entry screen, the year and period are in separate fields that you can reach by 
pressing the Tab key or by clicking the field.

Accounts Receivable automatically displays the fiscal year and period for the posting date you enter for 
a receipt. You cannot change the year or period except by changing the posting date.

Detail Table

Account

Type the number of the general ledger account for the distribution, if you did not enter a distribution 
code. You can also change the account number that is displayed after you enter the distribution code.

Adjustment Amount

This column displays the amount of an adjustment entered to the document in this receipt batch. You 
cannot change the amount in this column. 

You use the Adjust button to enter adjustments in receipt batches, but only if the Allow Adjustments in 
Receipt Batches is selected on the A/R Options screen.

Amount

Type the distribution amount for the selected miscellaneous receipt detail.

Applied Amount

Use this field to type the amount you want to apply to the document.

If you use the Auto Apply option, amounts are entered in this column automatically—until the selected 
transaction is fully applied—but you can change the amounts.
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If you apply an amount that is greater than the amount you received from the customer, you create a 
receipt with a debit balance, which can apply later.

Example: You might overapply a receipt if you have not yet issued a credit note for the customer. 
When you process the credit note, later, you can apply it to the receipt to produce a net result of zero.

If you apply an amount that is less than the amount you received from the customer, the unapplied 
portion is posted with the original receipt. You can then apply the unapplied portion of the posted 
receipt, later.

Apply

Use the Apply column to select the documents to which you want to apply the receipt or credit note.

Enter Yes beside each document the customer is paying by typing Y (or any other keyboard character) 
in the column or by double-clicking in the column beside the desired document.

Note: If another transaction has been applied to the document in another unposted batch or entry, 
you see "Pend" for the document in this column.

You must enter Yes in the Apply column for a document and select (highlight) the line for the document 
if you want to use the Adjust button to enter an adjustment to a document (if you use the option to enter 
adjustments in receipt batches) or use the History button to view the document's history.

Current Balance

This column displays the current balance in the document in the customer's account. The amount is 
calculated from the transactions that have been posted to the account, and does not include pending 
(unposted) transactions.

Discount Available

This column shows the amount of the discount that is available for the document, if any. You cannot 
change this amount, but you can enter a larger discount amount in the Discount Taken field.

Discount Date

This column lists the discount dates that were assigned to the documents when they were posted to 
Accounts Receivable.

If no discount applied to the document, the discount date is the same as the document date.
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Discount Taken

Use this column to enter the amount of any discount that applies to the document. You can enter an 
amount that is larger than the amount in the Discount Available column.

If the discount period has expired, this field displays zeros. If you still want to give the customer a 
discount, you can type in an amount that is the same as or less than the amount that was available.

Dist. Code

This field appears for Miscellaneous Receipt transactions.

Type a distribution code or select it using the Distribution Code Finder .

If no distribution code applies, skip the Dist. Code field, and enter the general ledger account number 
instead.

Document Date

The Document Date column lists the dates that were entered with the documents when they were 
posted to Accounts Receivable.

If you list documents by their document dates, the list begins with the document with the earliest (oldest) 
date.

If you also enter a starting document date in the Starting Document Date field, the list omits any 
documents with earlier dates.

Document Number

The Document Number column displays document numbers to which you can apply a receipt or credit 
note. Double-click in the Apply column for the document that the customer is paying at this time.

If you list documents by their document dates, the list begins with the document with the earliest (oldest) 
date.

If you also enter a starting document date in the Starting Document No. field, the list omits any 
documents with earlier dates.

Document Type

This column shows the type of document for each document listed on the receipt application table.
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Due Date

The Due Date column lists the due dates that were assigned to the documents when they were posted 
to Accounts Receivable.

If you list documents by their due dates, the list begins with the document with the earliest (oldest) due 
date. If you also enter a starting due date in the Starting Due Date field, the list omits any documents 
with earlier due dates.

Job Related

This display-only field appears in the application details table of the A/R Receipt Entry screen if you use 
Sage 300 Project and Job Costing.

The field indicates whether a document is job-related or not. (The program sets the entry in this field. 
You cannot change it.)

When you apply a receipt to a job-related document, the Jobs button becomes available, letting you 
open a separate Project and Job Costing Apply Details screen where you can change the apply method 
or the allocations for particular document details.

Net Balance

This column displays the document balance net of any unposted applied amount or discount.

Order Number

This column displays the order number, if any, that was entered with the document.

If you list documents by their order numbers, all the documents issued with a particular order number 
are displayed together, beginning with the lowest order number or the order number you specify in the 
Starting Order No. field.

Original Amount

This column displays the original document total.

Payment Number

This column displays the payment number for the corresponding document. This payment number is 1 
unless the document contains a multiple payment schedule, then it is the payment number for the 
document.
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Pending Adjustment Total

This column displays the total amount of unposted adjustments that have been entered for the 
document in any other unposted entries or receipt batches.

Pending Balance

The pending balance shown for a document is the amount that the document balance would be if all 
pending transactions were posted to it. 

You cannot type in this field. You can change the pending balance only by changing the pending 
amounts that have been applied to the document.

Note: You cannot apply an amount that is greater than the document's pending balance.

Pending Discount Total

This column displays the total amount of discounts taken for the document in the current entry and in 
other unposted entries in receipt batches.

Pending Payment Total

This column displays the total of any receipts that have been applied to the document in other unposted 
batches or entries.

PO Number

This column displays the purchase order number, if any, that was entered with the document.

If you list documents by their purchase order numbers, all the documents issued with a particular 
purchase order number are displayed together, beginning with the lowest purchase order number or the 
purchase order number you specify in the Starting PO No. field.

Tax Withheld

The amount that your customer has withheld for an invoice to be remitted to tax authorities on your 
behalf.

Double-click this field to open the Detail Tax Withheld screen, where you can view the tax withheld for 
each tax authority for the invoice.

This field shows a value for an invoice only if the Apply field is set to Yes for the invoice.
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A/R Receipt Inquiry Screen

To Open this Screen

Open Accounts Receivable > A/R Transactions > Receipt Inquiry.

Related Tasks

 l "Looking Up Receipts" (page 241)

Overview

This screen lets you:

 l Look up receipts using various criteria. For example, you can look up all the receipts deposited to a 
selected bank, or you can display information for a receipt for which you have only the receipt 
number.     

Note: You are not limited to viewing the receipts for one customer at a time, as you are when using 
the A/R Customer Inquiry screen.

 l Review document information that shows how the receipt was applied.     

Note: Because miscellaneous receipts are not applied to existing invoices or debit notes, there is no 
application history to view.

 l Drill down from a selected line on the list to view the original receipt in the A/R Receipt Entry 
screen.

Fields and Controls

Buttons

Close

Click this button to close the screen.

Tip: 
You can also close the screen in the following ways:

 l Click the top left corner of the screen.

 l Click File > Close.
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Document

Click this button to display a selected document in the A/R Receipt Entry screen.

Open

Click this button to open a separate window that displays detailed receipt information for the selected 
transaction. The information includes (but is not limited to) the customer number, receipt document 
number, and the documents to which the receipt is applied.

Print

Click this button to print a report of posted receipts using the criteria specified on the A/R Receipt 
Inquiry screen.

Note: The report prints to your usual print destination.

A/R Refund Batch List Screen

To Open this Screen

Open Accounts Receivable > A/R Transactions > Refund Batch List.

Related Tasks

 l "Printing Batch Listings" (page 330)

 l "Printing Accounts Receivable Posting Journals" (page 347)

 l "Printing the A/R Posting Errors Report" (page 345)

 l "Printing the A/R Batch Status Report" (page 333)

 l "Posting a Range of Batches" (page 234)

Overview

This screen lets you:

 l View a list of refund batches, beginning with the batch number you specify. More...

The list includes the following information about each batch:
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 l Batch number.

 l Batch date.

 l Batch description.

 l Number of entries.

 l Total amount.

 l Whether a batch has been printed.    

Notes: 
 l Open batches for which listings have been printed are marked Yes.

 l If you edit a printed batch, its status reverts to Open until you reprint the batch 
listing.

 l Posting sequence number.

 l Number of errors.

 l Date the batch was last edited.

 l Type (indicates how the batch was created).

 l Status. More...

A batch can have one of the following statuses:

 l Open. You can edit the batch.

 l Ready To Post. The batch can be posted. You cannot edit the batch unless you first 
change its status.

 l Post In Progress. Posting has started for the batch. You cannot edit or print it.

 l Deleted. The batch was removed from Accounts Receivable before posting. You 
cannot view the batch or reuse the batch number.

 l Posted. Transactions in the batch have been added to customer accounts. You 
cannot edit the batch, but you can print a listing for it.

 l Create a new refund batch.

 l Select an existing batch to edit, print checks for and post, or delete.

 l Mark a batch Ready To Post.

Note: If you use Payment Processing, you must process all Paya credit card transactions included in 
a batch before you can mark the batch Ready To Post.

 l Print and post all refund checks included in a batch.
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 l Print batch reports:     

 l Batch Listing.

 l Batch Status.

 l Post all unposted batches that are set Ready To Post.

Fields and Controls

Buttons

Close

Click this button to close the screen.

Tip: 
You can also close the screen in the following ways:

 l Click the top left corner of the screen.

 l Click File > Close.

Delete

Click this button to delete a batch. For more information, see "Adding, Editing, or Deleting a Refund 
Batch" (page 222).

New

Click this button to open the A/R Refund Entry screen, which you can use to create a new refund batch. 
For more information, see "Adding, Editing, or Deleting a Refund Batch" (page 222).

Open

Click this button to open the selected batch in the main entry screen.

Post All

Click this button to post all unposted refund batches that are set Ready To Post. For more information, 
see "Posting a Range of Batches" (page 234).
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Print

Click this button to print a batch listing. For more information, see "Printing Batch Listings" (page 330).

Print/Post

Click this button to post the selected batch, including checks. For more information, see "Printing and 
Posting a Batch of Refunds" (page 237).

Refresh

Click this button to update the information in the batch list. For example, if you have chosen not to show 
posted/deleted batches and another user has posted or deleted a batch, the batch will disappear from 
the list when you click Refresh.

Batch Number

If you want the list to begin with a specific batch, specify the batch number in this field.

Ready To Post

Indicates whether a batch is ready to post. To change the setting for a batch, double-click this field.

This field has three main purposes:

 l It prevents you from accidentally posting batches before they are ready.

 l It lets you post a range of batches, even if batches that are not ready to post are in the range.

 l It prevents you from making changes to batches that are set to Ready To Post.

Notes: 
 l Before you can post a batch, the batch must be set to Ready To Post.

 l If you are posting a single batch, you can select Ready To Post during posting.

 l You cannot delete a batch for which the Ready To Post option is selected.

Show Posted and Deleted Batches

To list only batches with a status of Open or Ready To Post, clear this option.
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A/R Refund Entry Screen

To Open this Screen

Open Accounts Receivable > A/R Transactions > Refund Entry.

Secondary Screens

 l A/R Batch Information Screen

 l A/R Cash Payment Screen

 l A/R Check Payment Screen

 l A/R Credit Card Bank Screen

 l A/R Document History Screen

 l A/R Job Details Screen

Related Tasks

 l "Adding, Editing, or Deleting a Refund Batch" (page 222)

 l "Printing and Posting a Batch of Refunds" (page 237)

 l "Printing a Single Refund Check" (page 226)

 l "Refunding a Customer" (page 223)

 l "Viewing Document History when Refunding a Customer" (page 226)

 l "Voiding a Refund Check" (page 229)

 l "Voiding a Credit Card Refund" (page 229)

Overview

You use the A/R Refund Entry screen to:

 l Refund credit notes, prepayments, and receipts, including job-related documents.

 l Reimburse customers by cash, check, or credit card.

 l Print a single refund check.

 l Print a batch of refund checks and then post the batch.
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 l Void a printed check.                 

If you make a mistake when writing a check, and print the check before realizing your error, you can 
easily void it using the A/R Refund Entry screen. (You do not have to void it through Bank Services.)

 l Void a credit card refund.                 

If you use Payment Processing and make a mistake when refunding a credit card payment, you can 
easily void it using the A/R Refund Entry screen.

 l Print a batch listing for a selected refund batch. (Click File > Print Batch Listing Report.)

Note: You do not use the A/R Refund Entry screen to enter returns.

Optional Fields Tab

Note: This tab appears if you use Sage 300 Transaction Analysis and Optional     Field Creator and you 
have defined optional fields for Accounts     Receivable refunds. For more information, see "About 
Optional Fields in Accounts Receivable" (page 41).

You use the Optional Fields tab to:

 l Check the optional fields used on a refund document. More...

Accounts Receivable displays the optional fields that you set up for automatic insertion on refunds, but 
you can change them or add other optional fields defined for Accounts Receivable refunds.

If you assigned exactly the same optional fields to the customer record as you defined for refunds, the 
optional field values from the customer record appear.

If an optional field is defined for refunds, but is not assigned to the customer, the program displays the 
value specified in the Optional Fields record.

 l Assign different optional fields to a document.

 l Check or change the value used for a refund optional field. More...

You can change the default value that appears for an optional field, as follows:

 l If the optional field is validated, you must specify a value that is defined for the optional field 
in Common Services.     

Note: If the optional field allows blanks, you can leave the value field blank.

 l If the optional field is not validated, you can enter any value that is consistent with the type 
of field (such as yes/no, text, number, date, or amount), providing the value you enter does 
not exceed the length permitted for the field. You can also leave the field blank.
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Note: When you specify a value that is defined in Common Services, the description for the value is 
also displayed.

Rates Tab

Note: This tab appears only if you use multicurrency accounting and you are entering a document for a 
customer that uses a currency different from your functional currency.

You use the Rates tab to change the rate type, rate date, and exchange rate for converting the document 
amount from the customer's currency to the functional currency.

Refund Tab

You use the Refund tab to:

 l Specify the customer number and document type for a new refund.

 l Enter the document number.

 l Enter details for the document. 

See "About Invoice Detail Types" (page 149) for more information.

 l Open separate screens on which you can enter the bank or cash account for cash refunds, the 
bank account for check and credit card refunds, and the currency (in multicurrency ledgers).

 l Edit or delete existing details.

Totals Tab

You use the Totals tab to check the totals for each type of tender (cash, check, and credit card) used in 
the refund, as well as their combined total.

The amounts are shown in the customer currency.

Fields and Controls

Buttons

Cash Payment

Click this button to view and change payment details for a cash refund. 

For more information, see A/R Cash Payment Screen.
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Check Payment

Click this button to view and change payment details for a check refund, including the check language 
and currency, and whether to print the check using Accounts Receivable. 

For more information, see A/R Check Payment Screen.

Credit/Void

If you use Payment Processing, the Credit button becomes available on the A/R Refund Entry screen 
after you add a refund for a document for which a Paya credit card payment has been processed and 
settled. (The document must use the payment type SPS Credit Card.)

You can refund a credit card transaction by cash, check, or credit card. If you want to apply a credit to 
the credit card that was used for the original transaction, click the Credit button to open the A/R Process 
Credit Card screen. On this screen, you verify the billing information and transaction totals, and then 
click Apply Credit to apply the credit.

If you need to void (cancel) the refund after processing it, you can click the Void button on the 
A/R Refund Entry screen. 

If the refund has not been settled in Paya, the refund is voided. 

If the refund has been settled in Paya, an error message informs you that the refund cannot be voided. 
In this case, the transaction is complete, and if you want to charge the customer's credit card, you must 
create a new transaction.

Delete

Click this button to delete a selected record, account, batch, or transaction.

Note: 
 l After you delete a batch or a document in a batch, you cannot reuse its entry number.

 l Deleted transactions are reported on the batch listing and posting journal for the batch. 

 l Deleted batches are also reported on the Batch Status report.

History

Click this button to view the transaction history of a credit note or prepayment. 

For more information, see A/R Document History Screen (Refunds)   .
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Jobs

When refunding a job-related credit note or prepayment, you can click this button to allocate amounts to 
specific details manually. 

For more information, see A/R Job Details Screen   .

Post

Click this button to print checks for the refund batch that is currently displayed, and then post the batch.

For information about posting multiple batches, see "Posting a Range of Batches" (page 234).

Print Check

Click this button to print a check for a selected refund. 

For more information, see "Printing a Single Refund Check" (page 226).

Save/Add

Click Save to save an existing record, account, batch, or transaction to which you have just made 
changes. 

If are entering a new record, account, batch, or transaction, this button is named Add.

Void Check

Click this button to void a printed check. 

For more information, see "Voiding a Refund Check" (page 229).

Batch Date

You use the batch date as part of your audit trail and to select batches to print on the batch listing and 
batch status reports. The batch date is also used as the default document date when you create a new 
document.

Accounts Receivable displays the session date as the default batch date when you create a new batch, 
but you can change it.

You can type a different date in the field, or select a date using the calendar. (Click the button beside the 
Batch Date field to display the calendar.)
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Batch Number and description

Use the Batch Number field to:

 l Create a new batch.

 l Select the number of an existing batch you want to edit.

For more information, see "Adding, Editing, or Deleting a Refund Batch" (page 222).

The batch number is a permanent part of the information stored for a refund, and it appears with the 
transaction on Accounts Receivable reports, such as posting journals and the A/R G/L Transactions 
report, if you use the option to use the numbers as the description or reference for general ledger 
transactions.

You can use batch and entry numbers to trace transactions through the Accounts Receivable system 
and, if you use the numbers as the descriptions or references for G/L transactions, into your general 
ledger (unless you consolidate the transactions during posting in Accounts Receivable).

Entered By

This field displays the name of the person who entered the transaction.

No. of Entries

This field displays the number of entries in the batch.

Total Amount

This field shows the net amount of transactions entered for the batch.

Optional Fields Tab

Optional Field and Description

The program displays as defaults any refund optional fields marked for automatic insertion, but you can 
change them or add any other optional fields that are defined for refunds.

Value and Description

Default values appear for refund optional fields, as follows:
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 l If you assigned the same optional fields to the customer and ship-to location records as you 
defined for refunds, the optional field values for the ship-to location appear on the Optional Fields 
tab.

 l If the optional fields in the ship-to location record and the customer record are different from each 
other, the optional field values from the customer record appear as defaults for the refund.

 l If an optional field is defined for refund, but is not assigned either to the customer or the ship-to 
location, the program displays the value specified for the optional field in the Optional Fields 
record.

You can change the default value that appears for an optional field, as follows:

 l If the optional field is validated, you must specify a value that is defined for the optional field in 
Common Services.     

Note: If the optional field allows blanks, you can leave the value field blank.

 l If the optional field is not validated, you can enter any value that is consistent with the type of field 
(such as yes/no, text, number, date, or amount), providing the value you enter does not exceed 
the length permitted for the field. You can also leave the field blank.

Note: When you specify a value that is defined in Common Services, the description for the value is 
also displayed.

The description for the value appears automatically. You cannot change it.

Rates Tab

Currency

This field displays the code for the customer's currency.

Exchange Rate

This field shows the exchange rate used to convert the refund from the customer currency to your 
functional currency.

The program displays the exchange rate specified in Common Services for the rate type and rate date 
used in the current refund, but you can change the rate, if necessary.
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Rate Date

Accounts Receivable uses the exchange rate specified in Common Services for this date to convert 
amounts from the customer currency to your functional currency.

The document date is used as the default rate date, but you can enter a different date. If you enter a 
new date, Accounts Receivable displays the exchange rate associated with that date.

Rate Type

This field displays the code for the kind of rate to use when converting multicurrency amounts to 
functional currency.

Example: Your company might use "spot rate," "average rate," and "contract rate" as rate types.

You must specify a rate type that has been defined in the Currency Rate Types screen in Common 
Services.

Refund Tab

Apply Method

Use this field to specify a default method for applying refunds to job-related receipts and credit notes 
that include multiple details. You can select one of the following methods:

 l Top Down. This method applies refunds beginning with the first detail until the refund is fully 
applied.

 l Prorate By Amount. This method applies a refund proportionately to document details, 
depending on their relative amounts.

Customer Cash Amount and Currency

If any refund details are to be paid in cash (you specified a cash payment type for at least one detail on 
the detail entry table), the total amount to be by cash appears in the customer's currency in the 
Customer Cash Amount field, along with the currency code.

Note: 
To view or edit the cash account from which the refund is to be paid, or to change the currency or 
exchange rate for the refund, click Cash Payment to open the Cash Payment screen.

For more information, see A/R Cash Payment Screen.
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Customer Check Amount and Currency

If any refund details are to be paid by check (you specified a check payment type for at least one detail), 
the total amount to be by check appears in the customer's currency in the Customer Check Amount 
field, along with the currency code.

Note: 
To view or edit the bank from which the refund is to be paid, to specify whether to print the check, or 
to change the currency or exchange rate for the check refund, click Check Payment to open the 
Check Payment screen.

For more information, see A/R Check Payment Screen.

Customer Credit Card Amount and Currency

If any refund details are to be paid by credit card (that is, you specified a credit payment type for at least 
one detail on the detail entry table), the total amount to be by credit card appears in the customer's 
currency in the Customer Credit Card Amount field, along with the code for the currency.

Customer Number

In the Customer Number field, type the customer number for the customer you are refunding, or select 
the number using the Finder.

Tip: To view comprehensive Accounts Receivable information for a specified customer, click the 

Inquiry  button beside the Customer Number field. The Customer Inquiry screen appears, with 
the current customer selected.

Entry Number and description

The entry number identifies a transaction on the batch listing and posting journal. Accounts Receivable 
assigns entry numbers sequentially within each batch, and you must use the assigned number.

You can see the assigned entry number in the A/R Refund Entry screen, or you can use the batch listing 
to check the entry numbers.

Use the space beside the Entry Number field to enter a description for the entry.

Posting Date

The posting date is the date the refund is posted to General Ledger.
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Accounts Receivable uses the posting date to select the fiscal year and period to which the refund is 
posted. (You cannot edit the year or period directly.)

The default posting date that appears depends on your choice for the Default Posting Date option on 
the A/R Options screen.

You can change the posting date, but you cannot use a posting date for a refund that is earlier than the 
posting date used on the document you are refunding.

Note: If you consolidate G/L transactions, the posting date for consolidated entries is the last date of 
the fiscal period.

Refund Number

The refund number is assigned using the prefix and next number specified for refunds on the 
A/R Options screen. You can type a refund number if you do not want the program to assign it. 
However, you can use a document number only once.

You can print posting journals by refund number.

Tip: To view comprehensive Accounts Receivable information for a specified document, click the 

Inquiry  button beside the Refund Number field. The Document Inquiry screen appears, with the 
current refund selected.

Refund Date

Accounts Receivable uses the date you enter with a refund to select the default fiscal year and period to 
display. You can change to another year or period.

If the refund includes details to be refunded by check refunds, the date is used as the transaction date 
for the refund check.

The date is also used to assign the refund to aging periods on statements and reports, and to update 
statistics in customer records.

This date appears as the Document Date on the Customer Inquiry screen and on reports that include 
refund transactions.

Remit To

When you enter a customer number, Accounts Receivable displays the customer name from the 
customer record in this field, and it uses the customer address for the remittance address.
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If you are sending the refund to someone else or to a different location, you can change the Remit To 

information. Click the Zoom  button beside the Remit To field, then type the correct information on 

the Remit To Information screen that appears.

When finished, click Close to return to the A/R Refund Entry screen.

Year/Period

Accounts Receivable displays the fiscal year and period to which the document will be posted.

Accounts Receivable automatically displays the fiscal year and period that contains the date you enter 
in the Posting Date field. You cannot change this field except by changing the posting date.

Detail Table

CC Bank

Enter the code for the bank from which you are refunding this detail.

If you are entering a detail that you are refunding to a credit card, double-click in this column to open the 
Credit Card Bank screen, where you enter the bank code and (in a multicurrency system) the currency 
for the detail.

For more information, see A/R Credit Card Bank Screen.

Current Balance

The Current Balance field shows the outstanding balance (the original amount less applied amounts) 
for the document you are refunding.

Customer Amount

This field appears only in multicurrency ledgers, if the customer uses a currency different from your 
functional currency.

It shows the amount you are refunding in the customer currency.

Doc. Date

The Document Date field shows the date for the selected document.
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Doc. Type

The Document Type field shows the type of document you selected.

Document Number

You can select only credit documents that you have posted for the customer or, if you are refunding a 
national account, that you have posted specifically for the national account.

Note: Credit documents include   credit notes, receipts, prepayments, or unapplied cash transactions.

Job Related

The Job Related field appears if you use Sage 300 Project and Job Costing.

If the document you are refunding is job-related, the field displays Yes.

For job-related documents that have more than one detail, you specify an Apply Method to distribute 
the refund amount to the document details.

Net Balance

This field shows the pending balance less the refund amount, displayed in the customer currency. The 
program calculates the outstanding balance after the refund for the selected detail.

Original Amount

The Original Amount field shows the original amount posted for the document you are refunding.

Payment Amount

In the Payment Amount field, enter the amount you are refunding in the customer currency.

Payment Type

Use this field to specify the payment type you are using to refund the selected detail:

 l Cash.

 l Check.
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 l SPS Credit Card (if you use Payment Processing).             

Note: 
 l Select the SPS Credit Card payment type only if you use Payment Processing. 

Otherwise, use the CC Bank field to process credit card refunds.

 l If you are processing a refund for a credit note, you must also use the Receipt No. field 
to select a receipt, prepayment, or unapplied cash transaction paid by SPS credit card.

After you add the refund, the Credit button becomes available. You use it to open the Process Credit 
Card screen, where you apply the refund to the card used for the original transaction.

The total amounts refunded appear elsewhere on the Refund tab as Customer Cash Amount, 
Customer Check Amount, and Credit Card Amount, according to the payment type.

Pending Balance

The Pending Balance field shows the current balance less any applied amounts that have not yet been 
posted (for pending receipts, adjustments, and refunds applied) for the document you are refunding.

Receipt No.

You can edit this field only if the document you selected was paid by SPS credit card.

In the Receipt No. field, select a receipt, prepayment, or unapplied cash transaction to which to apply a 
refund. 

Totals Tab

Cash Refund

The amount shown in the Cash Refund field is the total amount of the current refund that is paid in 
cash.

Check Refund

The amount shown in the Check Refund field is the total amount of the current refund that is paid by 
check.
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Credit Card Refund

The amount shown in the Credit Card Refund field is the total amount of the current transaction that is 
refunded to a credit card.

Total Refund

This field shows the total being refunded for all payment types for the current refund transaction.

A/R Refund Inquiry Screen

To Open this Screen

Open Accounts Receivable > A/R Transactions > Refund Inquiry.

Related Tasks

 l "Looking Up Refunds" (page 242)

Overview

This screen lets you:

 l Look up refunds using various criteria. For example, you can look up all the refunds paid from a 
selected bank, or you can display information for a refund for which you have only the refund 
number.     

Note: You are not limited to viewing the refunds for one customer at a time, as you are when using 
the A/R Customer Inquiry screen.

 l Drill down from a selected line on the list to view the original refund in the A/R Refund Entry 
screen.

Fields and Controls

Buttons

Close

Click this button to close the screen.
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Tip: 
You can also close the screen in the following ways:

 l Click the top left corner of the screen.

 l Click File > Close.

Document

Click this button to display a selected document in the A/R Refund Entry screen.

Open

Click this button to open a separate window that displays detailed refund information for the selected 
transaction. The information includes (but is not limited to) the customer number, refund document 
number, and the documents to which the refund is applied.

Print

Click this button to print a report of posted refunds using the criteria specified on the A/R Refund Inquiry 
screen.

Note: The report prints to your usual print destination.

Transactions Reports Screens
Use the screens in the A/R Transactions Reports folder to print a variety of transaction reports to maintain 
your audit trail and to analyze Accounts Receivable data.

A/R Aged Retainage Report

To Open this Screen

Open Accounts Receivable > A/R Transaction Reports > Aged Retainage.

Related Tasks

 l "Printing the A/R Aged Retainage Report" (page 325)
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Overview

Note: Depending on how your system is set up, this desktop screen may also be available as a web 
screen. For more information, see the Web Screens Getting Started Guide or the help for Sage 300 
web screens.

The Aged Retainage report lists outstanding retainage amounts.

Note: It does not include retainage that has been invoiced or applied to a debit note or a credit note.

In multicurrency ledgers, you can print the report in your functional currency or in the customer currencies 
used in posted transactions.

When to Print

Print the report periodically, or whenever you want to analyze outstanding retainage.

Information Printed on This Report

The Aged Retainage report lists the following information, depending on the options you select when you 
print the report:

 l The Aged Retainage By Due Date report includes six aging periods: the five aging periods you 
specify for the report, including the Current period, plus a Future period.

 l For job-related documents, each document detail has its own outstanding retainage amount and 
its own retainage due date. 

Therefore, the retainage amount printed on the report for a job related document may be broken out 
across several aging periods, depending on the retainage due dates of the document details. 

The Overdue Retainage By Due Date report may also include an amount in the Future aging period, if a 
job-related retainage amount for a document detail is due in a future period.

 l If you use optional fields as selection criteria for this report, you can specify the ranges of values 
from which to select records for printing. The report then includes only customers that use the 
specified optional fields, whose values fall within the specified range.

A/R Aged Trial Balance Report

To Open this Screen

Open Accounts Receivable > A/R Transaction Reports > Aged Trial Balance.

691Sage 300 2023 Accounts Receivable User's Guide



Related Tasks

 l "Printing the A/R Aged Trial Balance Report" (page 327)

Overview

Note: Depending on how your system is set up, this desktop screen may also be available as a web 
screen. For more information, see the Web Screens Getting Started Guide or the help for Sage 300 
web screens.

The Aged Trial Balance report groups outstanding transactions or balances into a current period and four 
aging periods by document date or due date. Use the report to analyze your receivables.

You can print the report in detailed form, listing all outstanding documents for each customer, or 
summary form, printing one line for each customer number, including the current balance and the 
balance in each aging period.

If you use optional fields as selection criteria for this report, you can specify the ranges of values from 
which to select records for printing. The report then includes only customers that use the specified 
optional fields, whose values fall within the specified range.

When to Print

Print the Aged Trial Balance report when you need a listing of the status of your receivables on a given 
date, such as at the end of a fiscal year or period, or when you want to identify documents or balances 
you may need to write off.

Information Printed on This Report

The Aged Trial Balance report includes the following information:

 l A Due Date/Applied Number/Applied Type column lists the due date for documents at the left, and 
the number and type of applied details at the right.

 l A Current column contains documents that are not yet due. Credit notes, debit notes, unapplied 
cash, and prepayments appear in this column if you select As Current for the Age Credit Notes 
And Debit Notes and Age Receipts, Unapplied Cash And Prepayments options on the A/R Options 
screen.

 l Each customer's contact person, telephone number, and credit limit (if you select the 
Contact/Phone/Credit option).

 l An extra space appears between each customer record if you select the Space for Comments 
option.
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 l You can include Adjustment transaction types on the Aged Trial Balance report. Adjustments are 
then listed separately on the report, as well as with the transactions that they are applied to. (You 
can identify adjustments by their "WO" document type.)

 l Aged retainage amounts for each customer, if you choose to include them, on reports you print by 
due date.

 l Fully paid transactions, if you choose to include them. You can also specify the earliest date for 
which to show fully paid transactions.

 l In a single currency ledger, or in a multicurrency ledger with Print Amounts In Functional 
Currency selected, subtotals appear if you sort by customer group, account set, billing cycle, 
national account, or an optional text field (not a Date or Amount field).

 l In a multicurrency ledger, if you select Print Amounts In Customer Currency, totals by currency 
code are printed. Also, if you sort first by account set, the report includes subtotals by account set.

 l The summary version of the report includes one line for each customer number, listing the current 
balance in the customer's account and the balance in each of four periods.

A/R Batch Listing Report

To Open this Screen

Open Accounts Receivable > A/R Transaction Reports > Batch Listing.

Related Tasks

 l "Printing Batch Listings" (page 330)

Overview

Note: Depending on how your system is set up, this desktop screen may also be available as a web 
screen. For more information, see the Web Screens Getting Started Guide or the help for Sage 300 
web screens.

This report lists batches of invoice, receipt, or adjustment transactions that have not yet been posted to 
customer accounts.

Tip: To enforce a strict audit trail, turn on the Force Listing Of All Batches option on the A/R Options 
screen. This option prevents you from posting any batches that have not been listed.
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When to Print

You should print a batch listing after entering, importing, generating, editing, or posting a batch, and then 
file it with your other audit trail records.

Information Printed on This Report

The Batch Listing can include the following information, depending on the options you select at print time:

 l Batch entry number. This is the number assigned to each transaction in the Invoice Entry screen, 
Receipt Entry screens, or Adjustment Entry screen. It is a permanent part of the information stored 
for an entry, and appears on the posting journals and on the unconsolidated G/L Transactions 
report. Use this number to select an unposted transaction for editing, and to trace the history of 
posted transactions.     

Note: If you apply a prepayment to an invoice in the Invoice Entry screen, Accounts Receivable 
assigns the prepayment an entry number in the receipt batch to which you assign it, and the 
prepayment appears on the receipt batch listing for the receipt batch.

 l The transaction type for each entry. More...

 l An invoice batch listing may contain the following transaction types:        

 l CR Credit Note

 l DB Debit Note

 l IN Invoice

 l IT Interest Charge

 l A receipt batch listing may contain the following transaction types:        

 l AD Adjustment

 l CF Applied Credit (from)

 l CT Applied Credit (to)

 l DF Applied Debit (from)

 l DT Applied Debit (to)

 l ED Earned Discount Taken

 l GL Gain or Loss (multicurrency ledgers)

 l PI Prepayment

 l PY Payment

 l UC Unapplied Cash

 l WO Write-Off
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 l An adjustment batch listing can contain adjustment and write-off transactions.

 l Job-related information. All types of batches can include information for each job-related transaction 
showing the contract, project, category, and resource affected by the transaction.

 l Optional fields. The report also include the optional field used with transactions if you select the 
option to show optional fields.

 l Additional information. Invoice batch listings also include:

 l Payment terms and due date for invoices.

 l A "t" to indicate payment terms that have been edited.

 l An "r" to indicate that the exchange rate has been edited (multicurrency ledgers only).

 l A "c" to indicate that the customer has exceeded the credit limit.

 l Any comments included on the invoice, when you select the Show Comments option for the 
report.

 l Information about payment schedules, if any, when you select the Show Schedules option for the 
report.

 l Salesperson information, if any, when you select the Show Sales Splits option for the report.

 l Summary pages.

 l Invoice batch listings include batch totals for the invoices, credit notes, debit notes, and 
interest charges entered, and a total for the batch.

 l Receipt batch listings include totals for adjustments entered in the batch, discounts taken, 
and receipts, and a total for the batch. 

In multicurrency ledgers, the summary also contains a summary by currency, listing the total 
amounts for each source currency in the batch.

 l Adjustment batch listings include totals of debits and credits, and a total for the batch.

 l If you select Job Details, a summary shows the amounts for each contract, project, and 
category affected by job-related transactions in the batch, and it also shows a total amount 
for each contract.

 l The final page lists the descriptions of symbols that appear on the report (for invoice batch listings only), 
and the number of entries and batches printed.

The receipt batch listing final page also lists the general ledger account debits and credits for 
adjustments entered in the batch.

 l Multicurrency information. For multicurrency ledgers, all listings show the currency, rate, and rate 
date for each transaction. On receipt batch listings, the report includes the currency, rate, and rate 
date for the bank account and the customer.
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A/R Batch Status Report

To Open this Screen

Open Accounts Receivable > A/R Transaction Reports > Batch Status.

Related Tasks

 l "Printing the A/R Batch Status Report" (page 333)

Overview

This report lists information about Accounts Receivable batches, including for each listed batch the 
number of entries, creation date, last editing date, status, type, posting sequence number (if any), 
number of errors, and total amount.

When to Print

Print the report as part of the transaction-entry cycle, to discover batches for which you need to print or 
reprint listings before posting, and batches that contain errors.

Information Printed on This Report

The report includes a summary that lists the number of entries, number of batches, and total amount for 
each type of batch and each batch status.

A/R Customer Transactions Report

To Open this Screen

Open Accounts Receivable > A/R Transaction Reports > Customer Transactions.

Related Tasks

 l "Printing the A/R Customer Transactions Report" (page 335)

696Sage 300 2023 Accounts Receivable User's Guide



Overview

Note: Depending on how your system is set up, this desktop screen may also be available as a web 
screen. For more information, see the Web Screens Getting Started Guide or the help for Sage 300 
web screens.

The Customer Transactions report lists transactions that were posted to customer accounts during the 
period you specify when you print the report. You can order the transactions by document date, by 
document number, or by fiscal year and period.

When to Print

Print the report when...

Information Printed on This Report

The Customer Transactions can include the following information, depending on the options you select at 
print time:

 l Days over. This column  refers to the number of days an invoice is overdue. It shows the payment 
habits of customers and highlights seriously overdue transactions that may require action or 
investigation.

 l Customer balance.

 l In a single currency ledger, or in a multicurrency ledger with Print Amounts In Functional 
Currency selected, subtotals appear if you sort by customer group, account set, billing cycle, 
national account, or an optional text field (not a Date or Amount field).

 l In a multicurrency ledger with Print Amounts In Customer Currency selected, totals by currency 
code appear. Also, if you sort first by account set, subtotals by account set appear.

 l If you use optional fields as selection criteria when printing the report, you can specify the ranges 
of values from which to select records for printing. The report then includes only customers that 
use the specified optional fields, whose values fall within the specified range.

A/R Deposit Slips Report

To Open this Screen

Open Accounts Receivable > A/R Transaction Reports > Deposit Slips.
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Related Tasks

 l "Printing the A/R Deposit Slips Report" (page 337)

Overview

The Deposit Slips report lists the deposit entries for a single deposit number, grouped by receipt type 
(checks, cash, and the other receipt types you use). It also includes a form that helps you fill in an official 
bank deposit slip.

Sample deposit slip forms (BKDPST01.RPT and BKDPST02.RPT) are included with System Manager. 
You can adapt the forms to suit your requirements.

When to Print

Print the Deposit Slips report when you finish entering a batch of receipts for deposit and are ready to fill 
out a bank deposit slip.

Information Printed on This Report

Deposit slips include the following information:

 l A summary sheet that lists:

 l The bank code, account number, date, batch number, and deposit slip number. In 
multicurrency ledgers, the currency is also listed.

 l For each receipt type, the customer number, payer name, check or other receipt number, 
and amount of each deposit.

 l Totals by receipt type.

 l A deposit slip form that totals deposits by payment type. If you use the BKDPST01.RPT form, only 
coins, bills, and checks are included on the deposit slip. If you use the form BKDPST02.RPT, all 
payment types are included on the deposit slip. If a deposit includes multiple currencies, a 
separate deposit slip is printed for each currency.

A/R G/L Transactions Report

To Open this Screen

Open Accounts Receivable > A/R Transaction Reports > G/L Transactions.
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Related Tasks

 l "Printing the A/R G/L Transactions Report" (page 339)

Overview

Note: Depending on how your system is set up, this desktop screen may also be available as a web 
screen. For more information, see the Web Screens Getting Started Guide or the help for Sage 300 
web screens.

The G/L Transactions report is a list of the general ledger transactions created from all posted Accounts 
Receivable batches and revaluations (in multicurrency ledgers). 

If you do not use Sage 300 General Ledger, Accounts Receivable creates   the general ledger batches in a 
CSV (Comma Separated Values) file, tailored   to the Sage 300 General Ledger format. You can send the 
file to a remote   location that uses Sage 300 General Ledger, or modify the information   in the file to suit 
another general ledger program. 

You can print detailed or summary versions of the report. The summary report lists one total for each 
account number.

When to Print

Print the report before using the A/R Clear History screen to clear printed posting journals, and before 
using the Year End screen.

Information Printed on This Report

The  G/L Transactions report can include the following information, depending on the options you select at 
print time:

 l The detailed report includes:

 l The batch and entry number. The entry number is assigned when the transaction is added 
to a batch, and is a permanent part of the record of the transaction.

 l The source code assigned during posting to identify the transaction types.

 l The information in the Reference and Description columns depends on your choices on the 
G/L Integration screen.

 l Total by sorting option.

 l The summary version of the report includes a single line for each account number, with the total 
debits and credits posted to the account.

 l Total debits and credits for the report.
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A/R Invoices Screen

To Open this Screen

Open Accounts Receivable > A/R Transaction Reports > Invoices.

Related Tasks

 l "Printing Accounts Receivable Invoices" (page 340)

Overview

Note: Depending on how your system is set up, this desktop screen may also be available as a web 
screen. For more information, see the Web Screens Getting Started Guide or the help for Sage 300 
web screens.

The A/R Invoices screen lets you print copies of Accounts Receivable invoices, credit notes, and debit 
notes for your customers, including documents that you may have printed before.

Note: You can print these documents if you use the Allow Printing Of Invoices option on the 
Transactions tab of the A/R Options screen.

If you select Customer for Delivery Method and a customer uses an email delivery method, Accounts 
Receivable emails the invoice as an attachment to the customer along with the message you specify in 
the Email Message ID field.

When to Print

Print an invoice, debit note, or credit note when you finish entering it, or print all the documents in an 
invoice batch or in a range of batches.

Information Printed on This Report

Invoices, credit notes, and debit notes may contain the following information:

 l A shipping address, if you specify a ship-to location for the customer when you enter the invoice.     

You can select a ship-to location that is set up for the customer, or use the Zoom button beside the 
Ship-To field to enter shipping information. Also use the Zoom button if you want to edit the information 
in a Ship-To Location record that is already set up for the customer.

 l The shipping method to use, if you enter ship via instructions as part of the ship-to information.
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 l Descriptions and/or comments entered with the invoice details on the Document tab of the Invoice 
Entry screen.

 l Special instructions, if you enter any as part of the ship-to information.

 l The remittance address, if any, specified in the customer's billing cycle. The address tells the 
customer where to send payments.

 l Information about payment schedules, if you print using the stock invoice forms (ARINVPRE.RPT, 
ARDOTINV.RPT, ARDINVO.RPT)

A/R Item Sales History Report

To Open this Screen

Open Accounts Receivable > A/R Transaction Reports > Item Sales History.

Related Tasks

 l "Printing the A/R Item Sales History Report" (page 344)

Overview

Note: Depending on how your system is set up, this desktop screen may also be available as a web 
screen. For more information, see the Web Screens Getting Started Guide or the help for Sage 300 
web screens.

The Item Sales History report lists the sales activity for the items in your Accounts Receivable system. 

Most of the information on this report is also available on the Statistics Tab of the Items screen. 

Note: This report contains figures only if you use the Keep Item Statistics option on the A/R Options 
screen.

When to Print

Print the report when you need to check on sales activity such as the most recent date an item was sold, 
the quantity sold during a particular period, the number of sales returns, or the profit margin for an item.

Information Printed on This Report

Amounts are shown for each unit of measure by which an item is sold, as follows:
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 l The Sales Amount column lists the item price multiplied by the quantity sold.

 l The Sales Returns column lists the item price multiplied by the quantity returned.

 l The Actual Cost column lists the item cost multiplied by the quantity sold.

 l The Margin column lists the difference between the sales amount and the actual cost (usually the 
profit).

 l The Margin Percent is calculated by dividing the margin amount by the sales amount.

The final page of the report is a summary that lists the total amount (for all items on the report) for each 
period covered by the report.

A/R Overdue Receivables Report

To Open this Screen

Open Accounts Receivable > A/R Transaction Reports > Aged Trial Balance.

Related Tasks

 l Printing the A/R Overdue Receivables Report

Overview

The A/R Overdue Receivables report groups outstanding transactions or balances into a current period 
and four aging periods by document date or due date. 

When to Print

Print the report whenever you need to analyze your overdue receivables.

Information Printed on This Report

The A/R Overdue Receivables can include the following information, depending on the options you select 
at print time:

 l A Due Date/Applied Number/Applied Type column lists the due date for documents at the left, and 
the number and type of applied details at the right.

 l A Current column contains documents that are not yet due. 
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If the As Current for the Age Credit Notes And Debit Notes and Age Receipts, Unapplied Cash And 
Prepayments options are selected on the A/R Options screen, credit notes, debit notes, unapplied 
cash, and prepayments appear in this column.

 l Each customer's telephone number, contact person, and credit limit (if you select the 
Contact/Phone/Credit option).

 l An extra space appears between each customer record if you select the Space for Comments 
option.

 l Aged retainage amounts for each customer, if you choose to include them, on reports you print by 
due date.

 l Fully paid transactions, if you choose to include them. You can also specify the earliest date for 
which to show fully paid transactions.

 l The summary version of the report includes one line for each customer number, listing the current 
balance in the customer's account and the balance in each of four periods.

 l For a single currency ledger and for a multicurrency ledger if you select the Print Amounts In 
Functional Currency option, subtotals appear if you sort by Customer Group, Account Set, 
Billing Cycle, National Account, or an optional text field (not a Date or Amount field).

 l In a multicurrency ledger if you select the Print Amounts In Functional Currency option, totals by 
currency code appear. Also, if you sort first by Account Set, subtotals by account set appear.

A/R Posting Errors Report

To Open this Screen

Open Accounts Receivable > A/R Transaction Reports > Posting Errors.

Related Tasks

 l "Printing the A/R Posting Errors Report" (page 345)

Overview

Note: Depending on how your system is set up, this desktop screen may also be available as a web 
screen. For more information, see the Web Screens Getting Started Guide or the help for Sage 300 
web screens.

Accounts Receivable creates the A/R Posting Errors report when you post batches that contain errors. 
The report lists the incorrect entries and explains why they could not be posted. It also lists the number of 
the batch into which each incorrect entry was placed.
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You can print the report for invoice, receipt, refund, and adjustment   batch posting errors. You must 
correct all the entries that appear on   the error report before you can post them.

When to Print

Print the report whenever you post a batch that contains errors, so that you have a record of the 
transactions that could not be posted.

Information Printed on This Report

The A/R Posting Errors report lists the following information:

 l The incorrect entries, listed in order by the posting sequence numbers assigned to their original 
batches, then by their original batch and entry numbers.

 l An explanation of the error in each entry.

A/R Posting Journals Screen

To Open this Screen

Open Accounts Receivable > A/R Transaction Reports > Posting Journals.

Related Tasks

 l "Printing Accounts Receivable Posting Journals" (page 347)

 l Printing the A/R Revaluation Posting Journal

Overview

A posting journal is the printed record of the transactions in a group of batches that were posted together.

Accounts Receivable posting journals provide an audit trail of all uncleared details that have been posted 
using the A/R Post Batches screen. (You use the A/R Clear History screen to clear the data for the 
journals after printing them to a printer or file.)

When to Print

Print a posting journal whenever you need a report of posted Accounts Receivable transactions.
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Information Printed on This Report

A/R posting journals can include the following information, depending on the type of posting journal you 
are printing and the options you select at print time:

 l The original batch and entry number for each transaction.

 l Tax information (appears only on the Invoice Posting Journal), including the base amount upon 
which each type of tax was calculated, as well as the total tax for each tax authority on each 
invoice, credit note, or debit note.

 l Optional field information, if you use optional fields and you choose the option to include this 
information on the report.

 l The Invoice Posting Journal includes details of prepayments that were posted before the invoice 
batch was posted.

 l The Receipt Posting Journal includes an Adjustment and a Discount column, to list any 
adjustments made to documents in the A/R Receipt Entry screens, and discounts taken when 
receipts were applied to documents.

 l The Adjustment Posting Journal includes a Debit and a Credit column, to list the general ledger 
account number or distribution code (representing general ledger account numbers) to which each 
debit or credit was posted.

 l A summary page.     

The Invoice Posting Journal summary page lists separate totals for invoices, debit notes, credit notes, 
cash payments (prepayments), and interest invoices.

The Receipt Posting Journal summary page lists totals for adjustments, discounts taken, and receipts.

The Adjustment Posting Journal summary page lists the totals of debits and credits.

 l A General Ledger Summary that lists the total amounts of the transactions that were created for 
each general ledger account used in the posted batches. These transactions are placed in the 
general ledger batches Accounts Receivable creates in Sage 300 General Ledger, if you use it, or 
in the batches that are produced for you to transfer to another general ledger system.     

The Invoice Posting Journal also includes a Prepayment Summary page that includes prepayments for 
invoices posted before you posted the invoice batch.

If you use multicurrency accounting, the posting journals include the following additional information:

 l The currency, exchange rate, and rate date for each transaction.

 l The total for the transaction (and the total tax, for invoice posting journals) in the functional 
currency as well as the source currency.

 l A Summary page which lists totals for each source currency used in the report, as well as 
the equivalent totals in the functional currency.
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A/R Receipts Screen

To Open this Screen

Open Accounts Receivable > A/R Transaction Reports > Receipts.

Related Tasks

 l "Printing Receipts" (page 342)

Overview

Note: Depending on how your system is set up, this desktop screen may also be available as a web 
screen. For more information, see the Web Screens Getting Started Guide or the help for Sage 300 
web screens.

You use the A/R Receipts screen to print or e-mail a formal acknowledgment that you have received a 
customer payment, including details about the documents that were paid and the method of payment. 

Tip: You can   also print a single receipt confirmation for a selected receipt using the A/R Receipt   Entry 
screen.

When to Print

Print receipts whenever you want to confirm your customers' payments.

Information Printed on This Report

Each receipt contains:

 l Header information, including your company information, the date the receipt is printed, the 
document number, whether the payment was made in cash or by check or credit card, the payer 
and the customer name (if different from the payer), the customer address.

 l A signature line where you can acknowledge receipt of the customer payment.

 l Detail information that shows information about the document(s) being paid, including the amount 
applied to each document and any discounts taken.

 l If you use Payment Processing, the credit card type, card number (last four digits with other digits 
masked), and authorization code for Paya credit card transactions.

 l Totals that show the total amount paid and the total amount remaining to be paid, in the customer 
currency and, if the payment was made in a different currency, in the receipt currency, also.
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If you use Customer as the print destination, for customers that use an email delivery method, Accounts 
Receivable emails to each customer a receipt confirmation along with the message you specify in the 
Email Message ID field.

A/R Revaluation Posting Journal

To Open this Screen

Do one of the following:

 l Open Accounts Receivable > A/R Transaction Reports > Posting Journals.

 l If you want to print a journal or provisional list while doing a revaluation:

 1. Open Accounts Receivable > A/R Periodic Processing > Revaluation.

 2. Click History.

 3. In the Currency Code field, type or use the Finder to select the currency code for the 
revaluation posting journal you want to print, and then press Tab.

 4. Click Print Posting Journal.

Related Tasks

 l Printing the A/R Revaluation Posting Journal

Overview

A Revaluation Posting Journal is the printed record of the transactions that are created for the general 
ledger exchange gain and loss accounts when you revalue multicurrency documents at new exchange 
rates. 

A Provisional Revaluation Listing lists the transactions that will be created when you post the revaluation.

Important! You must print all outstanding posting journals before you can clear them using the Clear 
History screen and before you can do year-end processing.

When to Print

You should print the Revaluation Posting Journal each time you revalue transactions. 

If you do a provisional revaluation, you should print the Provisional Revaluation Listing, and check the 
transactions that will be created when you post the revaluation.
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Information Printed on This Report

A Revaluation Posting Journal lists the following information:

 l The posting sequence number appears on the Revaluation Posting Journal.

 l The transactions created in each posting sequence are grouped and totaled by account set.

 l The journal includes a summary page, listing totals for each currency used in the report, the 
equivalent totals in the functional currency (both the original functional amount and the revalued 
amount), as well as the total unrealized exchange gain or loss for each currency.

 l A General Ledger Summary lists the total amounts of the transactions that were created for each 
source currency for the general ledger accounts used in the posted batches (the Receivables 
Control account and the unrealized exchange gain and loss accounts).
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Appendix B: Accounts Receivable 
Security Authorizations

If security is turned on for your Sage 300 system, the system administrator must assign users security 
authorization for Accounts Receivable screens.

For information on turning on security, setting up security groups, and assigning authorizations, refer to 
the System Manager help.

Note: To change the print destination for forms and reports, you must have Change Print Destination 
security authorization for Administrative Services.

To view records and to print reports in Accounts Receivable, you must belong to a security group with 
Common Inquiry authorization. Common Inquiry authorization by itself does not let you edit any Accounts 
Receivable records.

To edit records or perform processing tasks, the system administrator must grant the group access to 
additional tasks from the following list:

Security 
Authorization

Description

Adjustment 
Entry

Allows the same access as Adjustment Inquiry authorization, and also lets you 
create, edit, and delete batches in Adjustment Entry and Adjustment Batch List.
You can also do periodic processing using Create Write-Off Batch.
If you also have Set Adjustment Batch Ready To Post authorization, you can set 
batches ready to post in Adjustment Batch List.

Adjustment 
Inquiry

View and print adjustments in Adjustment Entry and Adjustment Batch List.
You can also print adjustment transaction reports in Batch Listing, Batch Status, 
Posting Journals, Posting Errors, and G/L Transactions.

Adjustment 
Posting

Allows the same access as Adjustment Inquiry authorization, and also lets you 
post adjustment batches in Post Batches and Adjustment Batch List.
This assignment also lets you send transactions to the General Ledger 

Accounts Receivable Security Authorizations
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Security 
Authorization

Description

automatically if the Create G/L Batches During Posting option is selected in the G/L 
Integration screen.
If you also have Set Adjustment Batch Ready To Post authorization, you can set 
batches ready to post in Adjustment Batch List.

Check Printing Print checks from Refund Entry and Refund Batch List.
To print checks, you must also have Refund Inquiry, Refund Entry, or Refund 
Posting authorization.

Clear History / 
Records / Stats

Do periodic processing in Clear History, Clear Statistics, and Delete Inactive 
Records.
Also, view customer and setup records, and print customer and setup reports.

Common 
Inquiry

View records and print reports for Customer Groups, National Accounts, 
Customers, and Ship-to Locations. Also, view setup screens and print setup 
reports.

Customer 
Analysis

View customer information in Customer Activity. Also, print Customer 
Transactions, Aged Trial Balance, and Aged Retainage reports and print 
statements, letters, and labels.

Customer 
Developer 
Inquiry

Supports the Inquiry feature in web screens. Developers of third-party 
programs, including macros, need to incorporate this resource in their security 
structures.

Customer 
Maintenance

Update records in Customer Groups, National Accounts, Customers, and Ship-
To Locations.

Dashboard View the Receivables Management Dashboard page.

Edit Credit 
Limit

Change a customer’s credit limit.
You must also have Customer Maintenance authorization to update customer 
records.

Export 
Processing

Export records using the File menu. You must also assign inquiry rights for the 
types of records you want to export. For example, to allow the exporting of 
receipt records, you must assign both Export Processing and Receipt Inquiry 
rights.
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Security 
Authorization

Description

Import 
Processing

Import records using the File menu. You must also assign update rights for the 
types of records you want to import. For example, to allow the importing of 
customer records, you must assign both Import Processing and Customer 
Maintenance rights.

Invoice Entry Allows the same access as Invoice Inquiry authorization, and also lets you:

 l Create, edit, and delete invoice transactions in the Invoice Batch List and 
Invoice Entry screens.

 l Create, edit, and delete records in Recurring Charges, and create batches of 
recurring charges in Create Recurring Charge Batch.

 l Do periodic processing using the Create Interest Batch, Create Retainage 
Batch, and Update Recurring Charges.

 l If you also have Receipt Entry authorization, you can enter prepayments in 
Invoice Entry.

 l If you have Set Invoice Batch Ready To Post authorization, also, you can set 
batches ready to post in Invoice Batch List.

Invoice Inquiry  l View and print:

 l Transactions in Invoice Batch List and Invoice Entry.

 l Records in Recurring Charges.

 l View invoice records in the Customer Activity screen.

 l Print transaction reports for invoices from the Batch Listing, Batch Status, 
Posting Journals, Posting Errors, G/L Transactions, and Invoices screens.

Invoice Posting Allows the same access as Invoice Inquiry authorization, and also lets you post 
invoice batches in Invoice Batch List and Post Batches.
This assignment also allows you to send transactions to the General Ledger 
automatically if the Create G/L Batches During Posting option is selected in the G/L 
Integration screen.
If you also have Set Invoice Batch Ready To Post authorization, you can set 
batches ready to post in Invoice Batch List.

Item 
Maintenance

View, update, and print item records in Items (Setup). Also, print Items setup 
reports and Item Sales History analytical reports.

Period End Do periodic processing in Create G/L Batch and Revaluation, and print 
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Security 
Authorization

Description

Maintenance revaluation transactions using Posting Journals and G/L Transactions.

Receipt Entry Allows the same access as Receipt Inquiry authorization, and also lets you 
create, edit, and delete transactions in Receipt Entry, Quick Receipt Entry, and 
Receipt Batch List.
You can also print deposit slips.
If you also have Set Receipt Batch Ready To Post authorization, you can set 
batches ready to post in Receipt Batch List.
If you use Payment Processing, you must have Receipt Entry authorization to pre-
authorize and process credit card transactions in Order Entry.

Receipt Inquiry  l View receipts in Receipt Batch List, Receipt Entry, and Quick Receipt Entry.

 l View receipt records in Customer Activity and Receipt Inquiry.

 l Print receipts.

 l Print transaction reports for receipts from Batch Listing, Batch Status, 
Posting Journals, Posting Errors, Receipt Inquiry, and G/L Transactions.

Receipt Posting Allows the same access as Receipt Inquiry authorization, and also lets you post 
receipt batches from Receipt Batch List or Post Batches.
This assignment also allows you to send transactions to the General Ledger 
automatically if the Create G/L Batches During Posting option is selected in the G/L 
Integration screen.
If you also have Set Receipt Batch Ready To Post authorization, you can set 
batches ready to post in Receipt Batch List.

Refund Entry Allows the same access as Refund Inquiry authorization, and also lets you 
create, edit, delete, and print transactions in Refund Entry and Refund Batch 
List.
If you also have Set Refund Batch Ready To Post authorization, you can set 
batches ready to post in Refund Batch List.

Refund Inquiry View refunds in Refund Batch List and Refund Entry. Also, print transaction 
reports for refunds from Batch Listing, Batch Status, Posting Journals, Posting 
Errors, and G/L Transactions.
You can also view refund transactions in Customer Activity.

Refund Posting Allows the same access as Refund Inquiry authorization, and also lets you post 
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Security 
Authorization

Description

refund batches from Refund Batch List and Post Batches.
This assignment also lets you send transactions to the General Ledger 
automatically if the Create G/L Batches During Posting option is selected in the G/L 
Integration screen.
If you also have Set Refund Batch Ready To Post authorization, you can set 
batches ready to post in Refund Batch List.

Note: You cannot set a refund batch Ready To Post if it contains unprinted 
checks. You require Check Printing authorization to print the checks.

Sage 300 
Inquiry

Query Accounts Receivable data in web screens.
If you also have Export Processing authorization for Accounts Receivable, print or 
export the results of these queries.

Salesperson 
Maintenance

View, update, and print records in Salespersons (Setup), and print 
Salespersons setup reports.
If you do not have access to Salesperson Maintenance, you can view assigned 
salespersons in the Customers screen, but you cannot edit or print salesperson 
information.

Set Adjustment 
Batch Ready 
To Post

Set adjustment batches ready to post.
You must also have Adjustment Entry or Adjustment Posting authorization to set an 
adjustment batch ready to post.

Set Invoice 
Batch Ready 
To Post

Set invoice batches ready to post.
You must also have Invoice Entry or Invoice Posting authorization to set an invoice 
batch ready to post.

Set Receipt 
Batch Ready 
To Post

Set receipt batches ready to post.
You must also have Receipt Entry or Receipt Posting authorization to set a receipt 
batch ready to post.

Set Refund 
Batch Ready 
To Post

Set refund batches ready to post.
You must also have Refund Entry or Refund Posting authorization to set a refund 
batch ready to post.

Setup 
Maintenance

Update and print setup options and records in Options, Account Sets, Billing 
Cycles, Distribution Codes, Dunning Messages, E-Mail Messages, G/L 
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Security 
Authorization

Description

Integration, Interest Profiles, Optional Fields, Payment Codes, and Terms.

Transaction 
History Inquiry

View customer information in Customer Activity.
If you also have Invoice Inquiry authorization, you can reprint posted invoices in 
Invoice Printing.

Transaction 
Optional Fields

Add or delete optional fields in Invoice Entry, Receipt Entry, Refund Entry, 
Adjustment Entry, and other Accounts Receivable functions that create 
transactions automatically.

Year End 
Maintenance

Do periodic processing in Year End.

Sage 300 Web 
API

Use the Sage 300 Web API to process GET, POST, PUT, PATCH, and DELETE 
requests.

Note: You must also have authorization to view and/or modify any records or 
transactions for which API requests will be processed.

714Sage 300 2023 Accounts Receivable User's Guide



Appendix C: Data Entry Tools, Tips, and 
Shortcuts

Use these tools and tips to speed up data entry in Sage 300.

Menu Commands
The following commands appear on the File, Settings (when available), and Help menus on Sage 300 
screens.

Note: Menu names and commands may differ by screen.

File Menu

Command Description Notes

Close Closes the current screen. You can also press Alt+F4 to close a screen.

Customize Lets you hide or display 
fields for users by UI Profile 
ID. 

Click File > Customize to hide fields on an open 
screen for users assigned to a UI Profile ID for that 
screen. 
When these fields are hidden, data that would normally 
appear in these fields cannot be printed.
For more information, see the help for the UI Profile 
Maintenance screen in the System Manager help.

Export Exports data records to 
other Sage 300 databases 
and non-Sage 300 
programs.

Click File > Export to export data. 
For example, you could export purchase statistics for 
use in spreadsheet or database software.

Note: You cannot export serial or lot numbers for kit 
components.

Import Imports data records from 
other databases and from 

Click File > Import to import data.
For example, you could use a spreadsheet to enter 

File Menu Commands
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Command Description Notes

non-Sage 300 programs. current requisitions         or purchase orders when setting 
up your system, and then import        the transactions later.

Note: You cannot import serial or lot numbers for kit 
components.

Print Prints the current report, list, 
or screen.

On screens with a corresponding report, click File > 
Print to open the report screen, which you use to 
select report options (if applicable) before printing the 
report.

Print Setup Selects a printer and sets 
printing options. 

Click File > Print Setup to set up your printer. You can 
select the default printer or select another from the list 
of installed printers.
For more information about print options, refer to your 
operating system documentation.

Save Saves the entries or 
changes you have made to 
the current screen.

If you have just entered a new record, Add appears 
instead of Save.

Settings Menu

Command Description Notes

Auto Clear Creates a new entry 
automatically when you post 
a transaction. 

Use the Auto Clear option to streamline data 
entry in transaction entry screens.

 l If Auto Clear is turned on, all fields are 
cleared each time you post a transaction, 
allowing you to immediately begin entering 
another transaction. 

 l If Auto Clear is turned off, transaction 
information remains on the screen after you 
post it. Click the New button to begin 
entering another transaction. 

Clear Saved 
Settings

Restores default settings for 
a report.

This command is available for screens and for 
some reports.

Settings Menu Commands
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Command Description Notes

Save Settings as 
Defaults

Saves the current report 
settings as personal 
defaults.

This command is available for screens and for 
some reports.

Help Menu

Command Description

About Displays version and copyright information for the current screen and program.

Contents Opens Help.

Using Help Opens Help to an introductory topic on how to use Help.

Help Menu Commands

Data Entry Tools and Shortcuts
Use these tools and shortcuts to speed up data entry in Sage 300.

Tool Shortcut 
Key

Description

 Alt + A Add or save a new record.

Calendar F4 
or 
Alt + Down 
Arrow

Display the calendar for a date field.

 Alt + C 
or 
Alt + F4

Close a screen or dialog box

 Del or 
Alt + D

Delete the selected row or record.

Drilldown n/a The Drilldown  button appears beside some data entry fields and in 

some column headings in transaction detail entry tables. Click it to 

Data Entry Tools and Shortcuts
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Tool Shortcut 
Key

Description

view details of the record or transaction in the corresponding field. More...

You can "drill down" both within Sage 300 programs and between 
separate programs. For example, you can drill down:

 l From General Ledger transactions to original transaction 
entries.

 l From Accounts Receivable to Order Entry.

 l From Accounts Payable to Purchase Orders.

 l From one transaction to an originating transaction (such as from 
a credit note to the invoice) within a program.

 Alt + E Open the Set Criteria dialog box to filter the list of records to display 
in the Finder.

Finder F5 The Finder  appears in some data entry fields, and in some table 

headings in transaction entry screens. Click it when you want to look 
up records you can select for a field. More...
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Tool Shortcut 
Key

Description

Use the Finder to search lists of codes maintained in         or used by Sage 
300 programs (such as document numbers, terms codes, and account 
set codes). You can use menu commands in the Finder to help you 
search, as follows:

 l On the Settings menu, select  Color options to          highlight a field 
using color for the text or for the background.

 l On the Settings menu, select Field Name as Column           Heading 
to use field descriptions or internal field names          as column 
headings.

 l On the Settings menu, use Columns options to specify columns 
that appear in the table. 

 l On the Global Settings menu, select the Go to Filter First option 
if you want the Finder to display the same filter settings you 
specified on the Find By list the next time you search this type of 
record.

You can also use the Auto Search option to locate a record quickly          in 
a long list. To do this, select Auto Search and the criteria by which          you 
want to search, and then begin typing the characters that start or are 
contained         in the field you are searching on.

Note: Records that appear in the Finder are restricted by          any 
selection criteria          you apply to this field.  If you cannot find the record 
you are          looking for with the Finder or the navigation buttons, check 
the Finder          to see whether any criteria are being used to limit the 
selection. If         necessary, remove the selection criteria. (For more 
information, see "Setting Finder Criteria" (page 722))

Tip: For additional instructions on using the Finder to select records, 
press F1 when the Finder screen appears.

Go F7 The Go  button appears on screens where you must enter 

information (such as filter criteria) before viewing records that match 
the information you enter. More...

For example, on some Statistics and Inquiries screens, you must 
select a range of years and periods and specify an item number or 
vendor number before you can view statistics. (If you use 
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Tool Shortcut 
Key

Description

multicurrency accounting, you must also specify a currency.) After 

specifying this information, you click the Go  button or press F7 to 

view statistics.

Navigation n/a Click the Previous and Next buttons to navigate through a list of 
existing records, or click the First and Last buttons to navigate to the 
first and last records. More...

Note: If you clicked the Set Criteria button on the Finder screen and 
specified criteria, only records that match the criteria you specified 
will appear when you use the navigation buttons. If a record does 
not appear, click the Finder  and check to see whether you have 
specified criteria that prevent the record from appearing.

New n/a Click the New  button or select New from a menu to begin creating 

a new record.

 Alt + S Save changes to the displayed record.

Zoom F9 Click the Zoom  button  or press the F9 key to view or enter 

supplementary information        for a transaction detail or for a field. More...

In any detail entry table, you can select a detail line and press F9 to 
open a screen that displays all the fields for a single detail,          including 
additional tax-related fields that do not appear on the detail          table. You 
can edit existing details, and even add new details for         the document.
Beside any field that displays a Zoom button, you can click the button (         
or select the field and then press F9) to open          a separate screen where 
you can view and enter supplementary information specific         to that 
field. 

Note: If another Zoom button appears on the detail screen, you can 
click it or press Shift+F9 to open the new detail screen. (If you simply 
press F9 again, the first detail screen closes.) This function is 
referred to as "Detail Zoom." To close the second detail screen, 
press Shift+F9 again.

After viewing or editing the information in the detail screen, you can 
press F9 to close the screen.
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Working with Detail Entry Tables
The first tab of each transaction entry screen in Sage 300 contains    a detail entry table that shows the 
document details in tabular format.

In most cases, you can enter all the necessary details for a document    right on the table.

Tip: If there are more columns than can be displayed at one time, you can     use the horizontal scroll bar 
at the bottom of a list to view the additional     columns. You can also rearrange the order of columns, or 
change column    widths, consistent with how you enter data. 

You can also view and edit all the fields for a single detail on a separate    Detail Items/Taxes screen. To 
view this screen, select a detail line and click the Item/Tax button below the table, or press F9. 

Note: You use the Detail Items/Taxes screen to view or change tax    information for a detail. Detail tax 
fields do not appear in the detail table.

To add details using the detail table, do one of the following:

 l If a blank line is highlighted,      tab to the Item Number field, then either type the item number or 
select     it from the Finder. Enter the remaining information for the detail.

 l To start a new line, press      Insert or tab through the end of the last line on the table. 

If you want       to insert a new line in a specific location, highlight the line above     the location, and then press 
Insert.

Note: A detail line is saved as you enter it on the detail entry table. 

To edit details using the detail table: 

 l Select the line you     want to edit, and then enter your changes on that line.

Note: For information about using your keyboard to move within a detail table, see "Keyboard Shortcuts 
for Detail Tables" (page 722)

To delete details using the detail table: 

 1. Select the line you     want to delete.

 2. Press the Delete key on     your keyboard.

 3. If you see a message asking     you to confirm the deletion, click Yes.
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To edit item information or detail tax information using the Detail Items/Taxes screen:

 1. Select the detail on the table, and  then either click the Item/Tax button, or press F9.

 2. Edit the item information and/or change     the Tax Class or Tax Included options for the detail.

Keyboard Shortcuts for Detail Tables
Use the following keyboard shortcuts to navigate in detail tables.

Key Menu Command Action

Ins/Insert New Insert a blank row to add a new record.

Del/Delete Delete Remove the selected row.

Up or Down Arrow  Go up or down one row.

Left or Right Arrow  Go left or right one column.

Pg        Up  Go to the top row in view.

Pg Dn  Go to the bottom row in view.

Home First Go to the first row in a list.

End Last Go to the last row in a list.

Tab or Enter; 
Shift+Tab        or 
Shift+Enter

 Go to the next or previous column in a list.

Keyboard Shortcuts for Detail Tables

Setting Finder Criteria
To help you search quickly through a long list of records, you can use criteria to restrict the records that 
are displayed in the Finder and when    you use the navigation buttons. 

However, at other times, if the Finder uses criteria, it    might not display all the records you expect to see.

To check or remove the criteria:

 1. Click the Finder .

 2. Click the Set Criteria button.
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 3. On the screen that appears, click the Clear button.

For instructions on setting criteria, click the Help button when the    Set Criteria screen appears.
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Appendix D: Support and Resources

Find support and resources to help get Sage 300 up and running quickly.

Finding Help and Documentation
You can find information about setting up and using Sage 300 in the Sage 300 help and in the product 
documentation included with this release.

Note: For technical support, visit our customer support website at https://support.na.sage.com or 
contact your Sage business partner.

Context-Sensitive Help

Sage 300 features context-sensitive help that you can use to quickly open and view articles and 
information directly from Sage 300 screens.

 l On the Sage 300 Desktop, press F1 to view help for the current screen.

 l On Sage 300 Web Screens, click the help menu at the top of the screen to see help articles and 
resources related to your current task.

Product Documentation

Sage 300 includes guides in printable PDF format, including the Installation and Administration Guide, 
Upgrade Guide, and other documentation related to installation and setup.

These guides are available in the Docs folder on the Sage 300 server, and online at:

 l https://cdn.na.sage.com/docs/en/customer/300erp/Sage300ERP_Documentation.htm.

To view the guides in the Docs folder:

 l On the Windows taskbar, click Start > Programs > Sage 300 > Documentation.

Support and Resources
Use the links below to find instructions,   software training, one-on-one support, technical specifications, or 
other   resources to get Sage 300 working smoothly for your business.
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Your Sage Business Partner is also an excellent resource to consult when you have questions about 
Sage 300.

How can we help you?

I'm setting up Sage 300 and need information or assistance

 l Sage 300 Resources online — https://cdn.na.sage.com/docs/en/customer/300erp/Sage300ERP_
Documentation.htm

Find and download user guides, technical specifications, and more.

 l Sage 300 Web Portal — www.sage.com/us/erp/sage-300

Find a business partner, get priority support, and more.

I'm looking for instructions to complete a task in Sage 300

While using Sage 300, you can get instructions directly from the software in the following ways:

 l Contextual Help  — To see topics related to your current task:

 l In the Sage 300 Desktop, press F1.

 l In Sage 300 Web Screens, click the help menu at the top of the screen.

 l Help Topics — To explore topics and information in the Sage 300 Desktop, click Help > Help 
Topics.

I think something is broken, or I'm getting error messages                 

Search our knowledge base for solutions to common issues, or contact us for one-on-one assistance.

 l Knowledge Base — https://support.na.sage.com

Find answers and solutions to FAQs and known software issues.

 l Customer Center — https://customers.sagenorthamerica.com/irj/portal/anonymous/login

Exclusive support for Sage customers.

 l Partner Center — https://partners.sagenorthamerica.com

Exclusive support for Sage partners.
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I'm looking for downloads, updates, or technical specifications                 

Find product updates, download resources, or review technical specifications for Sage 300.

 l Sage 300 Resources online — https://cdn.na.sage.com/docs/en/customer/300erp/Sage300ERP_
Documentation.htm

Find and download user guides, technical specifications, and more.

 l Sage Business Care — www.sage.com/us/erp/sage-business-care

Find links to support services, contact our support team, and learn how to guarantee your Sage 
software is always up to date.

I want to become a more skilled user of Sage 300

Find links to Sage software training, online communities, and more.

 l Sage University — https://sageu.csod.com/LMS/catalog/Welcome.aspx?tab_page_id=-67

Convenient, professional training options to help you achieve your business goals.

 l Sage Summit — www.sage.com/sage-summit

Connect with peers and experts at our annual conference.

 l Priority Software Support — www.sage.com/us/erp/sage-business-care

Learn how to get unlimited support by phone, e-mail, and live chat.

I want to share knowledge with other Sage 300 users                 

Find and share tips, tricks, and solutions online in the Sage 300 Community.

 l Sage 300 Community — http://sagecity.na.sage.com/support_communities/sage300_erp

Explore Sage 300 blogs, discussions, FAQs, resources, and more. 

 l Sage Summit — www.sage.com/sage-summit

Connect with peers and experts at our annual conference.
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I want to contact a Sage 300 representative                 

 l Support and Services — http://support.na.sage.com

Find links to support services, contact our support team, and learn how to guarantee your Sage 
software is always up to date.
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A

access to Accounts Receivable screens  709

account sets  21-22

Account Sets report  553

printing  310

Account Sets screen  491

fields and controls  491

account types  78

accounts  See national accounts

Accounts Receivable ledger, setting up  3

Accounts Receivable options  5

activity statistics    See also period statistics

clearing  268

for customers  408

national accounts  361

reports  282, 455

resetting at year end  486

addresses  See ship-to locations

Adjustment Batch List screen  565

fields and controls  567

Adjustment Entry screen  569

fields and controls  571

adjustments  139, 142

batches  140, 235

deleting  143

during Receipt Entry  650

entering manually  140

G/L journal entries for  129

job-related  140

optional fields  143

receipts  214

write-offs  262

advance credit  195, 219

Aged Retainage report  690

printing  325

Aged Trial Balance report  691

printing  327

aging  525

allocating sales  179

amounts

selecting currency in Customer Inquiry 
screen  411

Apply Document transactions  161

applying credit notes and debit notes  155

applying prepayments  213

applying receipts  10, 210-211, 213

to job-related invoices  194

ARCHECK.RPT  57

ARCHK01.RPT  58

ARCHK01A.RPT  59

Index
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ARCHK02.RPT  57

ARCHK03.RPT  57

ARCHK11.RPT  59

ARCHK11A.RPT  59

ARCHK14.RPT  57

ARDINVO.RPT  58

ARDOTINV.RPT  58

ARDPST01.RPT  58

ARDPST02.RPT  58

ARINVWWW.RPT  58

ARLBL01.RPT  58

ARLETT01.RPT  58

ARSTMT01.RPT  58

ARSTMT10.RPT  58

ARSTMTPRE.RPT  58

assigning codes  19

authorization to use A/R screens  709

B

backdated documents

revaluing at new exchange rates  259

balance forward accounts  78

charging interest on  79

printing statements for  79

bank codes  525

bank deposits  637, 650

Batch Listing report  693

printing  330

batch listings

adjustments  565

invoices  586

receipts  644

refunds  672

batch numbers  135

resetting at year-end  268

Batch Status report  696

printing  333

batches  133, 135

adjustments  140

clearing  464

credit notes  168

debit notes  168

general ledger  468

importing  272

invoices  168

listings  137, 330

listings, forcing  138

posting  230, 233-237, 631

receipts  198

recurring charges  251

refunds  222

revaluation  260

setting the next number for  524

tracking  137

types  134

billing cycles  24

Billing Cycles report  554

printing  311

Billing Cycles screen  495

fields and controls  496
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buttons

Drilldown  717

Finder  718

Go  719

Navigation  720

New  720

Zoom  720

C

calculating discounts  151

calculating taxes  151

cash

applying  650

depositing  637

cash invoices  See miscellaneous receipts

cash receipts  650

cash sales  216

charges, recurring  93, 96

checking data integrity  247

checks (receipts)  190

checks (refunds)

voiding  229

Clear History screen  463

fields and controls  464

Clear Statistics screen  466

fields and controls  467

codes  19

commands  717

Comment Types report  555

printing  312

Comment Types screen  497

comments

clearing  464

customer comments  79

customer comments, following up  116

items  513

reviewing on the Customer List Preview 
screen  121

commissions  52, 54

common inquiry authorization  709

company options  524

confirmations of receipts  650

contact information  362, 377

Create G/L Batch screen  468

fields and controls  469

Create Interest Batch screen  469

fields and controls  470

Create Recurring Charge Batch screen  473

fields and controls  474

Create Retainage Batch screen  475

fields and controls  476

Create Write-Off Batch screen  477

fields and controls  478

credit card information

clearing  464

credit card transactions

customer payments  650

prepayments  178, 201
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processing  190, 204, 207

quick processing  132

sales  204, 207

voiding  209

credit cards

adding  89

deleting  89

editing  89

processing payments  204, 207

refunds, voiding  229

credit checks  81

during invoice entry  155

options  524

credit for returned goods

advancing  219

credit information  81

extracting from customer records  405

credit limits  88

credit notes  145, 183

applying  155

batches  168

document numbers  11

G/L journal entries for  126

multicurrency  154

printing  700

taxes  175

credit statuses of customers  107

currency  6, 13

customer  411

exchange gains and losses  256

functional  411

revaluing transactions for changes in 
exchange rate  261

viewing amounts in Customer Inquiry 
screen  411

custom fields  See optional fields

customer accounts  73

activity  108, 110, 335

inactive  75

on hold  75

querying  408

viewing inactive  288

viewing overdue  290

Customer Activity Statistics report  455

printing  282

customer checks

returned  111

customer comments  524

clearing  464

reviewing on the Customer List Preview 
screen  121

Customer Comments report  457

printing  286

customer credit checks  81

during invoice entry  155

options  524

customer currency  411

Customer Group Period Statistics report  456

printing  305
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customer groups  61, 64, 66, See 
also customers

statistics  8, 524

Customer Groups report  452

printing  284

Customer Groups screen  350

fields and controls  352

customer information

extracting from A/R  405

Customer Inquiry screen  166, 408

customer comments, entering  92

customer credit statuses  107

exposing hidden tabs on  103

hiding tabs on  103

miscellaneous receipts  108

opening Document Inquiry  112

opening from other screens  239

pending transactions  106

Customer list Preview screen

columns, arranging  114

Customer List screen  404

fields and controls  405

customer lists  113-114

for following up with customers  116

for marketing campaigns  119

inactive customers  288

printing  287

reviewing customer comments  121

Customer Period Statistics report  456

printing  305

customer records  60, 85, 377

customer groups  62

multicurrency  89

customer statistics  82, 524

Customer Transactions report  696

printing  335

customers  60, 66, 73, See also national 
accounts

account types  78

comments  79

contacts  72, 84

credit cards  83, 110

credit information  81

credit limits  88

credit status  107

customer numbers  76

optional fields  80

payment terms  54, 56

queries  408

short names  77

statistics  8, 377

statistics, resetting at year-end  486

tax information  79

Customers report  454

printing  285

Customers screen  376

fields and controls  380

Customers screens

Customer Groups  350

Customer Inquiry  408
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Customer List  404

Customers  376

National Accounts  361

Recurring Charges  425

Ship-To Locations  443

customizing forms  57

D

data entry screens  722

data integrity  247

data, importing and exporting  271

exporting  274

importing  274

date tables

for discounts and due dates  549

debit notes  145, 183

applying  155

batches  168

document numbers  11

G/L journal entries for  126

multicurrency  154

printing  700

taxes  175

Delete Inactive Records screen  482

fields and controls  482

delivery instructions  443

deposit slips  637, 650

adding receipts to  199

listings, forcing  138

options  525

Deposit Slips report  697

printing  337

deposits  190

prepayments  201

Derive Rate button  594

detail entry tables  721

details

adding  721

deleting  721

editing  721

discount dates

tables  549

discounts  55, 151

distribution codes  26

Distribution Codes report  556

printing  313

Distribution Codes screen  498

fields and controls  498

document history  See history

document inquiry

drilling down to transaction entry  240

filtering  240

receipts  241

refunds  242

Document Inquiry screen  166, 581

opening  239

opening from Customer Inquiry  112

document numbers  11

options  524

retainage documents  525
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document order

specifying when applying receipts  10

documentation and help  724

documents  See transactions

drilldown

to Inventory Control  412

to Order Entry  412

to transaction entry screens  112

Drilldown button  717

due dates  55

tables  549

dunning messages  28, 500, 525

Dunning Messages report  556

printing  314

Dunning Messages screen  500

fields and controls  500

E

e-mail  30

printing reports as attachments to  278

variables  31

E-mail Messages report  557

printing  315

E-mail Messages screen  501

fields and controls  502

entry numbers  135

exchange gains and losses  257

creating transactions for general 
ledger  484

G/L journal entries for  129

exchange rates  180

fluctuation  261

revaluing transactions  483

exporting data  271, 274

fields  275

transactions  272

F

fields

importing and exporting  275

optional  41, 45

File menu commands  715

Close  715

Customize  715

Export  715

Import  715

Print  716

Print Setup  716

Save  716

filtering document inquiries  240

Finder button  718

setting criteria  722

fiscal periods, locked  131

FOB point

in recurring charge records  159

form letters  57, 461

function keys  717

functional currency  411
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G

G/L (general ledger)

account sets  22

accounts  15

integration with A/R  15-17, 43, 508

journal entries created by A/R  125

transactions, creating  245

transactions, for exchange gains and 
losses  484

transactions, for interest batches  249

G/L Integration Detail screen  508

fields and controls  509

G/L Integration report  558

printing  316

G/L Integration screen  503

fields and controls  505

G/L Transactions report  698

printing  339

gains (due to exchange differences)  256, 261

Go button  719

guides and documentation  724

H

Help menu  717

history  122

clearing  264, 463

customer inquiry  415

document inquiry  581

items  37

receipts  215

refunds  226

statistics  8

I

icons  717

importing data  271, 274

batches  272

fields  275

setup records  21

transactions  272

inactive customer accounts

deleting  266

listing  288

Inquiry  See also queries

Inquiry button  239

Installation and Administration Guide  724

installing Sage 300, documentation on  724

installment payments  55

schedules  549

integration (with General Ledger)  15-17, 43

integrity  See data integrity

Integrity Checker  247

interest

calculating  33

charging on balance forward accounts  79

charging on open item accounts  78

interest batches  249

G/L transactions created for  249

optional fields  250
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statistics  233

interest invoices  248

G/L journal entries for  127

interest profiles  32, 34, 511

Interest Profiles report  559

printing  317

Interest Profiles screen  510

fields and controls  511

Inventory Control

drill down from A/R Customer Inquiry  412

Invoice Batch List screen  586

fields and controls  588

Invoice Entry screen  590

fields and controls  594

invoices  145, 170

batches  168, 236

billing cycles  24

changing tax groups on  154

customer credit, checking  155

details  149, 175

document numbers  11

due dates  55

e-mail messages to include with  30

G/L journal entries for  125

information  146

interest  248-249

multicurrency  154

optional fields  44, 156, 179

options  525

prepayments  153, 177

printing  340

recurring charges  93, 96, 159, 181, 425

recurring charges, batches  233, 255

retainage  181

reversing  186

taxes  175

Invoices screen  700

Item Sales History report  701

printing  344

items  36, 38

comments  513, 524

list  513

prices in recurring charges  252

statistics  8, 524

Items report  560

printing  318

Items screen  513

fields and controls  515

J

job-related optional fields  44

job-related receipts  650

job-related retainage  161

journals  See posting journals

K

keyboard shortcuts

for detail tables  722

keys  717
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L

labels

printing  299

Labels report  462

printing  298

letters

e-mail messages to include with  30

printing  299

listing batches  137

locked fiscal periods  131

losses (due to exchange differences)  256, 
261

M

manual taxes

in recurring charge records  159

maximum amounts

and recurring charge entries  252

menus and commands  715, 717

File  715

Help  717

Settings  716

miscellaneous receipts  190, 194, 216, 650

distributing  650

G/L journal entries for  128

taxes  195

using Customer Inquiry to look up  108

multicurrency  6, 13

changing tax groups  154

credit notes  154

customer records  89

debit notes  154

exchange rates  180

gains and losses  256

invoices  154

item pricing  38

revaluing transactions  261, 483

Multicurrency option  524

multiple payment schedules  55, 549

multiple payments

assigning to invoices  150

N

National Account Activity Statistics report  455

printing  282

National Account Period Statistics report  456

printing  305

national accounts  66, 70, See also customers

contacts  72, 84

on hold  362

optional fields  362

statistics{seealso}statistics  361

National Accounts report  458

printing  304

National Accounts screen  361

fields and controls  363

Navigation buttons  720

New button  720

new year, starting  268
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non-inventory items  37

O

open item accounts  78

charging interest on  78

printing statements for  78

Optional Field Settings screen  522

optional fields  41, 45

adjustments  143

customers  80

interest batches  250

invoices  156

national accounts  362

passed to G/L  43

receipts  196, 216

recurring charges  95, 252, 427

ship-to locations  445

write-offs  264

Optional Fields report  561

printing  319

Optional Fields screen  519

fields and controls  520

optional fiels

invoices  179

options  13

changing for Accounts Receivable  5

for integrating with general ledger  16

for printing reports  281

invoices  525

multicurrency  524

receipts  525

refunds  525

retainage  525

Options report  561

printing  320

Options screen  523

fields and controls  526

Order Entry

drill down from A/R Customer Inquiry  412

outstanding retainage  163

overdue customer accounts  290

Overdue Receivables report  702

P

paid transactions  581

clearing  464

Paya  89, 544

payment codes  48

for credit card transactions  544

Payment Codes report  562

printing  321

Payment Codes screen  543

fields and controls  544

payment due dates  55

Payment Processing  89

options  525

payment schedules  549, 594
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payment terms  54, 56, 549

installment payments  55

payment types

SPS Credit Card  225

payments  594

assigning multiple payment 
schedules  150

pending transactions

including in credit checks  82

period end  244

period statistics    See also activity statistics

clearing  266

reports  456

periodic processing  244

year end  268

Periodic Processing screens

Clear History  463

Clear Statistics  466

Create G/L Batch  468

Create Interest Batch  469

Create Recurring Charge Batch  473

Create Retainage Batch  475

Create Write-Off Batch  477

Delete Inactive Records  482

Integrity Checker  247

Revaluation  483

Update Recurring Charges  487

Year End  486

permissions

types  709

Post Batches screen  631

fields and controls  631

posted transactions  412, 581

posting batches  230, 233-237, 631

forcing listings before posting  138

journal entries created by  125

posting date, default  525

posting errors

clearing  464

Posting Errors report  703

printing  345

posting journals

clearing  464

printing  138, 347

Posting Journals screen  704

posting sequence numbers  232

setting next number  524

prepayments  153, 177, 190

applying  213, 650

by credit card  650

G/L journal entries for  128

on account  201

previous-year data  122

price list for items  36

print destinations  278

e-mail attachment  278

file  278

physical printer  278

preview (on screen)  278

printed forms  57
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printer

assigning to a specific report  280

printer, physical

setting as print destination  278

printing

setting a print destination  278

printing reports  280

options  281

Process Credit Card Payments screen  632

fields and controls  634

program options  13

prorate by amount (method for applying 
receipts)  194

provisional revaluation  260

Q

queries

customers  408

filtering  240

receipts  241

refunds  242

Quick Receipt Entry screen  637

fields and controls  638

R

Realized and Unrealized Gain/Loss 
accounting method  259

Receipt Batch List screen  644

fields and controls  646

Receipt Entry screen  648

fields and controls  651

Receipt Inquiry screen  671

fields and controls  671

receipts  190, 202

adding to deposit slips  199

adjusting  214

advance credit  195

applying  10, 210-211, 213

batches  198, 236

cash  650

confirmations  650

distributing  216

G/L journal entries for  127

history  215

inquiry  241

job-related  650

miscellaneous  194, 216

optional fields  196, 216

options  525

printing  342

quick deposits  637

type, default  525

type, grouping by  543

Receipts screen  706

Recognized Gain/Loss accounting 
method  259

records, importing and exporting  271

exporting  274

importing  274
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recurring charges  93, 96, 159

batches  160, 233, 251, 255

details, adding using the Detail 
Accounts/Taxes screen  97

G/L journal entries for  127

invoicing manually  181

optional fields  95, 252

reminders  94

ship-to locations  94

updating automatically  253

Recurring Charges report  459

printing  307

Recurring Charges screen  425

fields and controls  429

Refund Batch List screen  672

fields and controls  674

Refund Entry screen  676

fields and controls  678

Refund Inquiry screen  689

fields and controls  689

refunds  220, 223

allocating job-related  221

batches  222, 237

checks, printing  226

history  226

inquiry  242

looking up refund activity for a 
customer  109

posting  221

voiding  229

reminders

to process recurring charges  94, 252

to process retainage documents  7

reports  276, 693, 703

credit notes  700

debit notes  700

print destinations  278, 280

printing options  281

printing to a destination  278

settings  281

Reports screens

Account Sets report  553

Aged Retainage report  690

Aged Trial Balance report  691

Batch Listing report  693

Batch Status report  696

Billing Cycles report  554

Comment Types report  555

Customer Comments report  457

Customer Groups report  452, 456

Customer Transactions report  696

Customers report  454-456

Deposit Slips report  697

Distribution Codes report  556

Dunning Messages report  556

E-mail Messages report  557

G/L Integration report  558

G/L Transactions report  698

Interest Profiles report  559

Invoices screen  700
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Item Sales History report  701

Items report  560

Labels report  462

National Accounts report  455-456, 458

Optional Fields report  561

Options report  561

Overdue Receivables report  702

Payment Codes report  562

Posting Errors report  703

Posting Journals screen  704

Receipts screen  706

Recurring Charges report  459

Revaluation Posting Journal  707

Salespersons report  563

Ship-To Locations report  459

Statements / Letters / Labels report  461

Terms Codes report  564

restricting access to Accounts Receivable 
data  709

retainage accounting  7, 161

document numbers  11

G/L journal entries  125

invoicing  161, 181

options  525

prerequisites  7

return customer checks  111, 197

returns

advancing credit  219

issuing credit before goods are 
received  195

revaluation  256

backdated documents  259

batches created for General Ledger  260

outstanding retainage  167, 260

provisional  260

transactions  261

Revaluation Posting Journal  707

Revaluation screen  483

fields and controls  484

reversing invoices  186

S

Sage Exchange  89

sales

history  701

sales splits  50, 153

statistics  524, 545

salespersons  50

commissions  52, 54

creating a customer list for a marketing 
campaign  119

statistics  8

Salespersons report  563

printing  321

Salespersons screen  545

fields and controls  546

schedules  594

for customer payments  549

screen guides  350

security authorizations  709
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Select Details button  142

sequence numbers

assigned to posted transactions  232

setting up Accounts Receivable  3

Settings menu commands  716

Auto Clear  716

Clear Saved Settings  716

Save Settings as Defaults  717

setup records

importing  21

Setup screens

Account Sets  491

Billing Cycles  495

Comment Types  497

Distribution Codes  498

Dunning Messages  500

E-mail Messages  501

G/L Integration  503

G/L Integration Detail  508

Interest Profiles  510

Items  513

Optional Field Settings  522

Optional Fields  519

Options  523

Payment Codes  543

Salespersons  545

Terms  549

ship-to locations  98, 100

customers  101

for recurring charges  94

optional fields  445

Ship-To Locations report  459

printing  308

Ship-To Locations screen  443

fields and controls  445

ship via code

in recurring charge records  159

shipping instructions  98

short names  77

shortcuts  717

slips, deposit  650

source codes

AR-AD  129

AR-CR  126

AR-DB  126

AR-ED  127

AR-GL  129

AR-IN  125, 127

AR-IT  127

AR-PI  128

AR-PY  127-128

AR-UC  129

SPS Credit Card payment type  225

statements

data, clearing  464

e-mail messages to include with  30

options  525

printing  78, 291, 293

reprinting  297
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Statements / Letters / Labels report  461

printing  293, 297, 299

statistics  8, See also period statistics

clearing  266

customer groups  8

customers  8, 82, 377

interest batches  233

items  8, 37

national accounts  8

options  524

resetting at year-end  486

salespersons  8

T

taxes  151, 175

information in customer records  79

retainage amounts  163

tax groups  79, 151

tax groups, changing on multicurrency 
documents  154

technical support  724

terms

codes  55

for payment  54, 56

Terms Codes report  564

printing  323

Terms screen  549

fields and controls  549

tools  717

top down (method for applying receipts)  194

Transaction screens

Adjustment Batch List  565

Adjustment Entry  569

Document Inquiry  581

Invoice Batch List  586

Invoice Entry  590

Post Batches  631

Process Credit Card Payments  632

Quick Receipt Entry  637

Receipt Batch List  644

Receipt Entry  648

Receipt Inquiry  671

Refund Batch List  672

Refund Entry  676

Refund Inquiry  689

transactions  138, 702

adjustments  139, 142

clearing paid transactions  464

creating for G/L  468

drill down from Customer Inquiry  112

historical  122

looking up for a customer  415

multicurrency  6, 13

posted  104

posted to customer accounts  335

posting journals  704

revaluing  261
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U

unapplied cash  650

unrealized gains and losses  257

Update Recurring Charges screen  487

fields and controls  488

Upgrade Guide  724

V

variables

in e-mail messages  31

W

write-offs  569

adjustments  262

during Receipt Entry  650

optional fields  264

outstanding retainage  163

Y

year-end processing  268

starting a new year  268

Year End screen  486

fields and controls  486

Z

Zoom button  720
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